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80.2 Modifier la voix de notes existantes

80.3 Combiner des voix dans des accords

80.4 Séparer des accords en voix

81 Voir aussi

81.1 Méthodes alternatives de saisie des notes

82 Accéder à des méthodes alternatives de saisie de notes

83 Saisir uniquement le rythme

84 Saisir uniquement la hauteur des notes

85 Saisir les notes en temps réel

85.1 Temps réel (métronome)

85.2 Temps réel (pédale)

85.2.1 Raccourci Avance en temps réel

86 Insérer des notes

86.1 Ajouter et supprimer des mesures

87 Ajouter des mesures

87.1 Menu contextuel mesure

87.2 Le panneau Propriétés

87.3 Barre d'outils de saisie des notes

87.4 Barre de menu

87.5 Insérer des mesures avec des raccourcis clavier

87.6 Ajouter des mesures à un cadre

88 Supprimer des mesures

88.1 Supprimer les dernières mesures vides

89 Voir aussi

89.1 Sélectionner des éléments

90 Sélectionner un seul élément

90.1 Éléments qui se chevauchent

90.2 Sélectionner un élément individuel composant une note

90.3 Différentes façons de sélectionner plusieurs notes dans un accord

91 Créer une Liste de sélections

91.1 Sélectionner plusieurs éléments de façon manuelle

91.2 Sélectionner automatiquement des éléments similaires

92 Créer une Sélection groupée

92.1 Effectuer une Sélection groupée en déplaçant la souris

92.2 Effectuer une Sélection groupée en cliquant

92.3 Effectuer une Sélection groupée avec le clavier

92.4 Effectuer une Sélection groupée à l'aide de commandes spéciales

93 Exclure des éléments d’une Sélection groupée

93.1 Éditer des notes et des silences

94 Vue d’ensemble

95 Effectuer des modifications dans le mode de saisie des notes

95.1 Modifier la durée d’une note en mode saisie de notes

95.2 Modifier la hauteur d’une note en mode saisie de notes

95.3 Remplacer des notes et des silences en mode saisie de notes

95.4 Effacer des notes en mode saisie de notes

95.5 Déplacer des notes en mode saisie de notes

96 Effectuer des modifications dans le mode normal

96.1 Effectuer des modifications dans le mode normal

96.1.1 Attribuer une durée spécifique à des notes sélectionnées

96.1.2 Augmenter ou diminuer la durée d’une note sélectionnée

96.1.3 Doubler ou réduire de moitié toutes les notes d’une sélection de groupe.

96.2 Modifier la hauteur des notes en mode normal

96.3 Supprimer des notes et silences en mode normal

96.4 Supprimer des notes et silences et les temps qui leur sont associés

96.5 Ajouter des liaisons de prolongation en mode normal

96.6 Modifier une voix en mode normal

96.6.1 Déplacer des notes sélectionnées dans une autre voix

96.6.2 Échanger le contenu de deux voix

97 Voir aussi

97.1 Copier et coller

98 Accéder aux commandes

99 Copier une Sélection groupée

100 Copier un élément individuel ou une Liste de sélections

101 Déplacer des éléments

102 Échanger une sélection avec le presse-papier

103 Répéter une sélection

104 Copier une Sélection groupée vers plusieurs portées

105 Coller avec une demi ou une double durée

106 Dupliquer des éléments individuels

107 Voir aussi

107.1 Utiliser les palettes

108 Vue d’ensemble

109 Accéder au panneau Palettes

110 Ajouter des objets palette dans la partition

110.1 Objets appliqués à des éléments individuels de la partition

110.2 Objets appliqués à des sélections groupées

110.3 Objets appliqués à des mesures complètes

111 Développer et réduire les palettes

112 Effectuer une recherche et naviguer dans les palettes

112.1 Effectuer une recherche

112.2 Naviguer

113 Accéder à davantage d’objets palette

114 Ajouter d’autres palettes

115 Voir aussi

115.1 Panneau des propriétés

116 Vue d'ensemble

117 Accéder au panneau Propriétés

118 Propriétés pour la partition

119 Propriétés pour les objets

119.1 Réglages de lecture

119.2 Réglages d’apparence

120 Propriétés pour les caractères au sein des objets Texte

121 Sauvegarder et restaurer les paramètres par défaut

121.1 Ajuster directement les éléments

122 Modifier la position des éléments

123 Modifier la forme des éléments

124 Utiliser les points d'ancrage

124.1 Déplacer les objets entre des points d'ancrage
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124.2 Déplacer une nuance à la position de "fin de durée"

125 Travailler avec les lignes

125.1 Modifier la plage d’une ligne

125.2 Créer des lignes diagonales

125.3 Éditer le texte d'une ligne de texte

126 Voir aussi

126.1 Parties

127 Ouvrir une partie

128 Fermer une partie

129 Créer des parties personnalisées

129.1 Révéler les instruments dans les parties par défaut

129.2 Créer une nouvelle partie

129.3 Choisir quelles voix apparaissent dans chaque partie

130 Appliquer des styles aux parties

131 Renommer, dupliquer et supprimer des parties

132 Exporter et imprimer des parties

133 Liens externes

133.1 Raccourcis clavier par défaut

134 Navigation

134.1 Navigation entre pages

134.2 Navigation dans la partition

135 Saisie des notes

135.1 Général

135.2 Durée des notes

135.3 Hauteur des notes

135.4 Tablature

136 Sélection

137 Édition

137.1 Général

137.2 Durée

137.3 Hauteur

137.4 Notation

137.5 Réglages manuels

138 Texte

138.1 Général

138.2 Mise en forme

138.3 Paroles

138.4 Symboles d’accords, chiffres romains d'analyse, numéros Nashville, basse chiffrée

139 Autres éléments de partition

140 Paramétrage et mise en forme de la partition

141 Opérations sur les fichiers

142 Interface utilisateur

142.1 Lecture

143 Notation : Instruments, portées et systèmes

143.1 Travailler avec les instruments

144 Vue d’ensemble

145 Ajouter et ranger les instruments

145.1 Accéder au panneau Instruments

145.2 Ajouter des instruments

145.3 Supprimer des instruments

145.4 Modifier l’ordre des instruments

146 Paramétrer les instruments

146.1 Masquer/afficher des instruments

146.2 Renommer les instruments

146.3 Remplacer des instruments

147 Ajouter et configurer des portées

147.1 Pour ajouter une portée à un instrument existant

147.2 Pour ajouter une portée liée à un instrument existant

147.3 Configurer une portée

148 Masquer une portée tout en conservant sa lecture

149 Supprimer des instruments et des portées

149.1 N'afficher les portées que si nécessaire

150 Vue d'ensemble

151 Masquer une portée vide dans un système (l'ensemble de ses mesures dans ce système)

151.1 Masquer toutes les portées vides

151.2 Empêcher des portées spécifiques d’être masquées

151.3 Portées temporaires

151.4 Choisir la portée à afficher quand toutes les portées d'un système sont vides

152 Masquer des mesures vides

152.1 Portées découpées

152.2 Ossia

152.3 Autres mesures invisibles

153 Rassembler et éclater

154 Rassembler

154.1 Combiner les notes de différentes voix d’une portée en une seule voix

154.2 Combiner les notes de plusieurs portées en plusieurs voix dans une même portée

155 Éclater

155.1 Copier un passage de plusieurs notes dans plusieurs portées

155.2 Séparer un passage d’accord en leur notes constitutives

156 Changer d'instrument en cours de partition

157 Ajouter un changement d’instrument

158 Travailler avec un changement d’instrument

158.1 Supprimer un changement d’instrument

158.2 Renommer un changement d’instrument

158.3 Changer d’instrument dans le Mélangeur

158.4 Changer le type de portée

159 Changer le type de portée

160 Vue d'ensemble

161 Ajouter un changement de style de portée

162 Régler les propriétés de la portée

162.1 Propriétés des Portées / Parties

163 Vue d’ensemble

164 Propriétés des portées

165 Propriétés avancées de style

165.1 Propriétés avancées de style communes aux quatre types de portées

165.2 Propriétés avancées de style : réglages pour les portées standard et de percussion (Type 1a, type 1b et type 3)

165.3 Propriétés avancées de style : réglages pour les portées standard (Type 1a, type 1b)

165.4 Propriétés avancées de style : réglages pour la portée tablature (Type 2)
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166 Propriétés des parties

166.1 Instrument

166.2 Noms

166.3 Tessiture/registre utilisable

166.4 Transposition

166.5 Propriétés des parties : réglages pour les cordes pincées uniquement (Type 1b et type 2)

167 Crochets de systèmes

168 Vue d'ensemble

169 Ajouter un crochet

170 Éditer les crochets

170.1 Modifier le type de crochet

170.2 Changer l’étendue de crochet

171 Supprimer un crochet

172 Personnaliser l’apparence du crochet

173 Notation : Rythme, temps et mesures

173.1 Indications de mesure

174 Vue d’ensemble

175 Fixer l’indication de mesure initiale de votre partition

176 Ajouter un changement d’indication de mesure dans votre partition

177 Supprimer une indication de mesure

178 Paramétrez la visibilité des indications de mesure

179 Créer un indicateur de mesure personnalisé

180 Ajouter une indication de mesure locale dans une seule portée

181 Redimensionner une indication de mesure

182 Propriétés des indications de mesure

182.1 Apparence

182.2 Groupes de ligatures

183 Style d’indications de mesure

183.1 Hampes et crochets de notes

184 Direction de hampe

184.1 Direction des hampes par défaut

184.2 Renverser la direction de la hampe

185 Modifier la longueur de hampe

186 Créer des notes sans hampe

187 Propriétés des hampes et crochets de notes

188 Styles des hampes et crochets de notes

189 Voir aussi

189.1 Ligatures

190 Aperçu

191 Paramétrer quelles notes sont liées par des ligatures

191.1 Régler le mode de ligature par défaut pour une indication de mesure

191.1.1 Accéder aux propriétés de l'indication de mesure

191.1.2 Groupes de ligatures

191.2 Remplacer la ligature par défaut d'une note ou d'un silence spécifique

191.3 Afficher des ligatures au-dessus des silences

191.4 Afficher des ligatures à travers des barres de mesure

192 Paramétrer l'apparence des ligatures

192.1 Ligatures progressives

192.2 Hauteur de ligature

193 Style des ligatures

194 Voir aussi

194.1 Regrouper les rythmes

195 Vue d’ensemble

196 Regrouper les rythmes

197 Voir aussi

197.1 Divisions irrégulières

198 Créer une division irrégulière

198.1 Division irrégulière simple

198.1.1 Dans le mode de saisie des notes

198.1.2 Dans le mode normal

198.2 Divisions irrégulières consécutives

198.3 Divisions irrégulières personnalisées

198.4 Divisions irrégulières imbriquées

199 Modifier l’affichage des divisions irrégulières

200 Propriétés des divisions irrégulières

201 Style des divisions irrégulières

201.1 Barres de mesure

202 Vue d'ensemble

203 Modifier ou ajouter des barres de mesure

203.1 Modifier le type de barre de mesure dans toutes les portées

203.2 Modifier le type de barre de mesure pour une seule portée

203.3 Ajouter des barres de mesures au sein d’une même mesure

204 Modifier la longueur de la barre de mesure

204.1 Étendre toutes les barres de mesures d’une portée

204.2 Étendre les barres de mesure sélectionnées dans une portée

204.3 Créer des barres de mesure partielles

204.4 Créer des barres de mesures uniquement entre portées (Mensurstrich)

205 Propriétés des barres de mesure

206 Style des barres de mesure

207 Voir aussi

207.1 Numérotation des mesures

208 Afficher et masquer la numérotation des mesures

208.1 Afficher automatiquement la numérotation des mesures

208.2 Afficher manuellement la numérotation des mesures

208.3 Masquer les numéros de mesures

209 Modifier la séquence de numérotation des mesures

209.1 Exclure une mesure du décompte

209.2 Modifier la numérotation d’une mesure

209.3 Réinitialiser la numérotation des mesures pour une nouvelle section

210 Ajuster la position des numéros de mesure

211 Propriétés des numéros de mesure

212 Style de numérotation des mesures

213 Voir aussi

213.1 Pauses de mesures et pauses multimesures

214 Pauses de mesure

214.1 Pour créer une ou plusieurs pause de mesure complète

214.2 Pour créer une pause de mesure complète dans une voix particulière

215 Pause multimesures
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215.1 Activer et désactiver les pauses multimesures

215.2 Interrompre les pauses multimesures

215.3 Propriétés des pauses multimesures

215.4 Style de pauses multimesures

216 Voir aussi

216.1 Anacrouse et notation non mesurée

217 Créer une anacrouse

217.1 Préciser la durée de l’anacrouse lors de la création d’une partition

217.2 Transformer une mesure en anacrouse

218 Créer une notation non mesurée

218.1 Insérer des notes et des silences

218.1.1 Utiliser un raccourci clavier

218.1.2 Utiliser le mode insertion

218.2 Joindre des mesures

218.3 Scinder une mesure

219 Voir aussi

219.1 Propriétés de la mesure

220 Ouvrir et utiliser la fenêtre de dialogue

221 Portées

222 Durée de la mesure

223 Autre

224 Voir aussi

225 Notation : Hauteur de note et tonalité

225.1 Clefs

226 Aperçu

227 Définition de la clef initiale d'une portée

228 Ajouter ou modifier une clef

228.1  Ajouter/modifier une clef de début

228.2  Ajouter/modifier une clef à l'intérieur d'une mesure

229 Supprimer

230 Contrôler la visibilité des clefs

230.1 Clefs standard

230.2 Clefs de précaution

231 Clefs et transposition

231.1 Utilisation des clefs d'octave

231.2 Utilisation de différentes clefs pour la transposition et la hauteur de concert

232 Propriétés des clefs

233 Style des clefs

233.1 Armures

234 Aperçu

235 Définir l'armure initiale de la partition

236 Ajouter un changement d'armure à la partition

237 Ajouter une armure locale à une seule portée

238 Sélectionner une armure pour une seule portée

239 Remplacer une armure existante

240 Supprimer une armure

241 Contrôler la visibilité des armures

242 Armures et instruments transpositeurs

242.1 Armure ouverte/atonale

243 Créer une armure personnalisée

244 Propriétés des armures

245 Style des armures

245.1 Menu Format → Style → Page

245.2 Menu Format → Style → Altérations

245.3 Menu Format → Style → Mesure

246 Voir également

246.1 Transposition

247 Aperçu

248 Transposer avec des raccourcis clavier

248.1 Transposer chromatiquement

248.2 Transposer diatoniquement

248.3 Transposer d'une octave

249 Utiliser la fenêtre de dialogue de transposition

249.1 Transposition chromatique

249.1.1 Pour transposer chromatiquement dans une tonalité spécifique

249.1.2 Pour transposer chromatiquement par intervalle

249.2 Transposition diatonique

250 Travailler avec des instruments transpositeurs

250.1 Tonalité écrite et tonalité réelle

250.2 Réglage de l'intervalle de transposition

250.3 Contrôle de l'enharmonie

251 Lignes d'octave

252 Vue d'ensemble

253 Ajouter une ligne d'octave à la partition

254 Propriétés des lignes d'octave

254.1 Onglet Style

254.2 Onglet Texte

255 Style des lignes d'octave

255.1 Têtes de note

256 Vue d'ensemble

256.1 Modèles de têtes de notes

256.2 Formes de têtes de notes

256.2.1 Facteur de hauteur

256.2.2 Facteur de durée

256.2.3 Facteur de type de tête de note

257 Modifier la forme des têtes de note

258 Ajouter des informations de hauteur aux notes

259 Modifier la direction d'une tête de note

260 Propriétés des têtes de note

261 Style et police de tête de note

262 Partager des têtes de note entre les voix

262.1 Supprimer les numéros de frette en double dans la tablature

263 Voir aussi

264 Liens externes

264.1 Ambitus

265 Ajouter un ambitus à votre partition

266 Modifier l'étendue d'un ambitus

267 Propriétés de l'ambitus
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267.1 Échanger les notes enharmoniques / Recalculer les altérations

268 Modifier manuellement l'écriture enharmonique de certaines notes

269 Modifier automatiquement toutes les notes d'une sélection

269.1 Échanger les notes enharmoniques

270 Notation : Symboles d’expression

270.1 Articulations

271 Aperçu

272 Ajouter des articulations dans votre partition

272.1 Raccourcis clavier

272.2 Barre d’outils

272.3 Palette Articulations

273 Lecture des articulations

274 Propriétés des articulations

275 Style des articulations

275.1 Options d'alignement

275.2 Options d'articulations combinées

276 Nuances

277 Ajouter des nuances à une partition

278 Propriétés des indicateurs de nuance

279 Lecture des nuances

280 Affectation des voix aux nuances

281 Positionner les indicateurs de nuance

281.1 Positionnement basé sur la voix

281.2 Centrer les indicateurs de nuance entre les portées

282 Combiner indicateur de nuance et texte

283 Style d'indicateurs de nuance

283.1 Éditer la police des indicateurs de nuance

283.2 Éditer le style de texte d'expression

284 Compatibilité de lecture des indicateurs de nuance

284.1 Marques de crescendo et diminuendo

285 Types de marques

286 Ajouter des marques de crescendo/diminuendo dans la partition

286.1 Palettes

286.2 Raccourcis clavier

287 Modifier l’apparence des marques de crescendo/diminuendo

287.1 Plage d’effet

287.2 Hauteur du symbole

287.3 Inclinaison du symbole

287.4 Autres réglages

288 Modifier la lecture des crescendos/diminuendos

289 Propriétés des marques de crescendo/diminuendo

289.1 Onglet style

289.2 Onglet texte

290 Style des marques de crescendo/diminuendo

290.1 Liaisons de phrasé

291 Aperçu

292 Ajouter une liaison de phrasé à votre partition

292.1 Ajouter une liaison de phrasé en mode normal

292.1.1 Méthode 1

292.1.2 Méthode 2

292.2 Ajouter une liaison de phrasé en mode saisie de notes

293 Créer des liaisons de phrasé multi-voix et inter-portées

294 Modifier l’apparence des liaisons de phrasé

295 Propriétés des liaisons de phrasé

296 Style des liaisons de phrasé

296.1 Respirations et pauses

297 Aperçu

298 Types de symboles de pauses

298.1 Point d’orgue et point d’arrêt

298.2 Respiration

298.3 Césure

299 Ajouter un symbole de pause à la partition

300 Modifier la lecture des symboles de pause

301 Propriétés des symboles de pause

302 Style des symboles de pause

302.1 Ornements

303 Aperçu

304 Ajouter un ornement à la partition

304.1 Ajouter un ornement

304.2 Ajouter une ligne d’ornement

305 Modifier l'intervalle d'un ornement (ajouter des altérations)

306 Propriétés des ornements

306.1 Visibilité des altérations

306.2 Position

306.3 Propriétés des altérations

307 Style des ornements

307.1 Arpèges et glissandos

308 Aperçu

309 Symboles d’arpège

309.1 Ajouter un arpège à votre partition

309.2 Étendre la hauteur du symbole d’arpège

309.3 Créer des arpèges multi-voix ou inter-portées

309.3.1 Arpèges multi-voix

309.3.2 Arpèges inter-portées

309.4 Modifier la lecture des arpèges

309.5 Style des symboles d’arpège

310 Symboles de glissando

310.1 Ajouter un glissando dans votre partition

310.2 Éditer la plage d’un glissando

310.3 Modifier l’apparence des glissandos

310.4 Modifier la lecture d’un glissando

310.5 Propriétés et style des glissandos

311 Symboles de bend

311.1 Types de bends

311.2 Ajouter un bend à votre partition

311.3 Changer l’apparence des bends

312 Fioritures

313 Aperçu
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314 Types de fioritures

315 Ajouter une fioriture à votre partition

315.1 Ajouter une fioriture à l’aide d’un raccourci clavier

315.2 Ajouter une fioriture à partir de la palette

316 Fioritures multiples

316.1 Fioritures en séquence

316.2 Accords de fioritures

317 Éditer les fioritures

317.1 Modifier la durée

317.2 Modifier la hauteur

317.3 Modifier la lecture des fioritures

318 Style des fioritures

318.1 Trémolos et roulements

319 Types de trémolos et roulements

319.1 Trémolo d’une seule note

319.2 Trémolos entre notes

319.3 Buzz roll

320 Ajouter un trémolo à une note seule

321 Ajouter un trémolo entre des notes/accords

322 Modifier l’apparence des symboles de trémolo

322.1 Autres lignes

323 Vue d’ensemble

324 Ajouter une ligne à la partition

325 Ajuster une ligne

326 Types de lignes

326.1 Lignes standard

326.2 Lignes de portée et de système

326.3 Lignes de tempo

326.4 Lignes relatives à la guitare

326.5 Lignes de trilles

327 Propriétés des lignes

327.1 Onglet Style

327.2 Onglet Texte

328 Style des lignes

328.1 Autres symboles

329 Vue d'ensemble

330 La palette Symboles

330.1 Afficher

330.2 Rechercher

331 Ajouter des symboles à votre partition

331.1 Ajouter un symbole

331.2 Joindre à d’autres symboles

331.3 Repositionner les symboles

331.4 Voir aussi

332 Notation : Répétitions

332.1 Barres de répétition

333 Aperçu

334 Ajouter des barres de répétition à votre partition

334.1 Répétitions simples

334.2 Répétitions avec fins multiples (reprises complexes)

335 Modifier la lecture des barres de répétition

336 Modifier l'apparence des barres de répétition

337 Propriétés des barres de répétitions

338 Style des barres de répétition

338.1 Alternatives de reprise

339 Aperçu

340 Ajouter une alternative de reprise à votre partition

341 Modifier l'apparence des alternatives de reprise

342 Modifier la lecture des alternatives de reprises

342.1 Exemple d'un paramétrage d'alternative de reprise complexe

343 Propriétés d'une alternative de reprise

344 Style des alternatives de reprise

344.1 Sauts et reprises

345 Aperçu

346 Types d'objets Sauts et Reprises

347 Ajouter un Saut ou une Reprise à votre partition

348 Modifier l'apparence des Sauts et Reprises

349 Modifier la lecture des Sauts et Reprises

350 Propriétés des Sauts et Reprises

351 Style des Sauts et Reprises

351.1 Répétition de mesure et répétitions multimesures

352 Aperçu

353 Ajouter une répétition de mesure ou une répétition multimesures à votre partition

354 Propriétés des répétitions de mesure

355 Style des répétitions de mesure

355.1 Lecture des répétitions

356 Activer et désactiver la lecture des répétitions

357 Notation spécialisée : Clavier

357.1 Pédale

358 Types de marques de pédale

358.1 En termes de représentation visuelle

358.2 En termes de fonction dans MuseScore

359 Ajouter une marque de pédale à la partition

360 Créer des changements de pédale

361 Propriétés de pédale

362 Style de pédale

362.1 Notation entre portées

363 Créer une notation entre portées

364 Changer l'apparence de la notation entre portées

365 Voir aussi

365.1 Notation pour accordéon

366 Ajouter des symboles accordéon à votre partition

367 Notation spécialisée : Guitare

367.1 Diagrammes d'accord de guitare

368 Aperçu

369 Ajouter un diagramme d'accord à votre partition

369.1 Symboles d'accord liés aux diagrammes d'accord

370 Créer un diagramme d'accord personnalisé
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370.1 Repères de doigts

370.2 Types de notation alternatifs

371 Apparence du diagramme d'accord

372 Propriétés du diagramme d'accord

372.1 Onglet Général

372.2 Onglet Paramètres

373 Style de diagramme d'accord

374 Voir également

374.1 Techniques de guitare

375 Ajouter un symbole de Barre de trémolo à votre partition

376 Ajouter un Slide de guitare (Glissando) à votre partition

376.1 Ajouter un Glissando (Slide)

376.2 Modifier les propriétés

376.3 Ajuster les points de début et de fin d'un Glissando (Slide)

377 Ajouter une Ligne de capodastre (en V4.0.2) ou Ligne de barré (en V4.1) à votre partition

378 Ajouter des symboles de "hammer-on" (liaison ascendante) et de "pull-off" (liaison descendante) à votre partition

379 Notation des harmoniques

379.1 Portée standard

379.2 Tablature

379.3 Paires portée/tablature

380 Notation du doigté de la guitare

381 Ajouter un symbole de Bend à votre partition

381.1 Ajouter un Bend

381.2 Modifier un Bend

381.3 Paramétrer la hauteur du Bend

381.4 Repositionner le Bend

382 Créer une portée de tablature

383 Aperçu

384 Types de portées de tablature

385 Ajouter une tablature à votre partition

385.1  Créer une tablature dans le cadre d'une Nouvelle partition

385.2  Ajouter une tablature à l'aide de la fenêtre de dialogue "Ajouter ou supprimer des instruments"

385.3 Changer une portée existante de standard à tablature

386 Créer une combinaison de portées standard et tablature

386.1  Créer des portées standard/tablature combinées à l'aide de l'assistant de Nouvelle partition

386.2  Créer des portées standard/tablature combinées à l'aide de la fenêtre de dialogue Instruments

387 Saisir et éditer la notation de tablature

388 Saisir avec le clavier de l'ordinateur

389 Saisir avec la souris de l'ordinateur

390 Sélectionner la durée de la note

391 Notation de tablature ancienne

392 Modifier la notation de la tablature

392.1 Modifier la hauteur

392.2 Déplacer le numéro de frette vers une autre corde

392.3 Modifier la durée

392.4 Notes étouffées (en croix) ou "Ghost notes"

393 Personnaliser une portée de tablature

394 Modifier le réglage d'accord

395 Ajouter ou supprimer des cordes

395.1 Ajouter une corde

395.2 Supprimer une corde

396 Marquer la corde non frettée "à vide"

397 Changer le nombre de frettes de l'instrument

398 Modifier le type de portée de tablature

398.1 Changer le type de portée depuis le panneau Instruments

398.2 Modifier le type de portée à partir des propriétés de portée/partie

399 Personnaliser l'apparence de la tablature

399.1 Propriétés de la portée tablature

399.2 Tablature staff style

400 Appliquer un capodastre

401 Aperçu

402 Appliquer un capodastre à votre partition

402.1 Pour appliquer un capodastre à une portée :

403 Ajuster les paramètres du capodastre

403.1 Activer ou désactiver le capodastre

403.2 Régler la position du capodastre

403.3 Spécifier le placement d'un capodastre partiel

403.4 Personnaliser l'apparence du texte du capodastre

403.5 Pour placer le texte du capodastre sous la portée :

404 Changer le réglage du capodastre en cours de partition

404.1 Bends de guitare

405 Ajouter des bends à votre partition

406 Remarques générales sur les bends dans MuseScore Studio

407 Appliquer un bend

407.1 Bend standard

407.2 Bend de fioriture

407.3 Pré-bend

407.4 Bend léger

407.5 Maintien

408 Modifier des bends

408.1 Modifier un bend dans la portée standard

408.2 Modifier un bend dans le panneau Propriétés

409 Ajouter des bends à des accords

410 Personnaliser le style des bends

410.1 Réglages alternatifs d'accord des cordes

411 Appliquer des instructions d'accord des cordes

412 Spécifier les réglages d'accord de cordes

413 Les réglages d'accord alternatifs affectent les positions de frette

414 Lire les hauteurs transposées sur la portée standard

415 Notation spécialisée : Harpe

416 Vue d’ensemble

417 Ajouter un diagramme de pédales de harpe à votre partition

418 Lire des diagrammes de pédales de harpe

418.1 Diagramme visuel

418.2 Diagramme textuel

419 Notation spécialisée : Percussion

419.1 Saisir et modifier la notation des percussions

420 Vue d’ensemble
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420.1 Types de portées de percussions

420.2 Ajouter une portée de percussion à votre partition

421 Saisir des notes et des silences dans des portées de percussions

421.1 Avec la souris et la palette de saisie de batterie

421.2 Avec des raccourcis clavier

421.3 Par l’intermédiaire d’une interface MIDI

421.4 Avec le clavier de piano virtuel

422 Personnaliser le set de batterie

423 Introduction

424 Personnaliser la définition du set de batterie [projet]

424.1 Sélectionner un son

424.2 Définir la note

424.2.1 Nom

424.2.2 Têtes de note

424.2.3 Autres propriétés

425 Sauvegarder et charger les définitions du set de batterie [projet]

425.1 Autres notations des percussions

426 Coups doubles

427 Lignes de pédale

428 Roulements

429 Sticking (doigté de batterie)

430 Notation alternative

430.1 Notation pour musique ancienne et Mensurstrich

431 Ajouter une indication mesurée à votre partition

431.1 Utiliser des symboles de notes mesurées

432 Travailler avec une musique non mesurée

433 Travailler avec une notation Mensurstrich

433.1 Ajouter des barres de mesure entre des portées

434 Afficher les valeurs de notes dépassant les frontières de mesure

434.1 Notation avec slashs

435 Remplir une sélection avec des slashs rythmiques

436 Créer une notation rythmique avec slashs

436.1 Rythmes d'accompagnement sur la portée

436.2 Afficher les rythmes au-dessus ou en dessous de la portée

437 Types de portées personnalisées

438 Vue d'ensemble

439 Personnaliser l'apparence des lignes de portée

440 Personnaliser l'apparence d'éléments générés

441 Personnaliser l'apparence des notes

441.1 Systèmes et types de têtes de notes

442 Modifier le type de portée en cours de partition

443 Liens externes

444 Texte

444.1 Saisir et éditer du texte

445 Vue d’ensemble

446 Types de texte

446.1 Objet Texte Musescore

446.2 Paramétrages de partition

447 Ajouter du texte à une partition

447.1 Depuis une palette

447.2 Depuis un menu

447.3 À l’aide d’un raccourci clavier

448 Supprimer des objets texte d'une partition

449 Éditer le contenu d'un objet Texte

449.1 Raccourcis clavier disponibles en mode édition de texte

449.2 Caractères spéciaux

450 Mettre en forme du texte

451 Vue d’ensemble

451.1 Niveaux de mise en forme

451.2 Apparence et fonction des objets Texte

452 Modifier la mise en forme des caractères

453 Modifier la mise en forme d'un objet Texte

453.1 Modifier le style utilisé par un objet Texte

453.2 Position

454 Modifier les valeurs dans un style

454.1 Modifier les valeurs des styles Personnalisé-1 à Personnalisé-12

455 Texte de portée, Texte de système et Texte d'expression

456 Vue d’ensemble

456.1 Similarités et différences entre Texte de portée et Texte de système

457 Ajouter un Texte de portée à votre partition

458 Ajouter un Texte d’expression à votre partition

459 Ajouter un Texte de système à votre partition

460 Répéter un Texte de système sur les autres portées

461 Propriétés

461.1 Fenêtre "Propriétés de Texte de portée"

461.2 Fenêtre "Propriétés de Texte de système"

462 Style

462.1 Indications de tempo

463 Vue d’ensemble

463.1 Utiliser des indications de métronome ou des équivalences rythmiques

463.2 Utiliser des lignes de changement de tempo

463.3 Utiliser les indications littérales de tempo

464 Ajouter des indications de tempo à votre partition

465 Modifier l’apparence

465.1 Ajouter des caractères simples

465.2 Ajouter des symboles professionnels

465.3 Lignes de changement de tempo

466 Modifier la lecture

466.1 Indication de métronome, équivalence rythmique et indication littérale de tempo

466.2 Ligne de changement de tempo

467 Répéter l’indication de tempo sur les autres portées

468 Propriétés des indications de tempo

469 Style de tempo

470 Liens externes

470.1 Paroles

471 Vue d’ensemble

472 Ajouter des paroles à votre partition

472.1 Saisir des syllabes
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472.2 Saisir un mélisme

472.3 Saisir des couplets multiples

472.4 Saisir des paroles attachées à des silences

472.5 Utiliser des caractères spéciaux dans les paroles

472.5.1 Élision

472.6 Saisir des caractères réservés

473 Éditer des paroles existantes

474 Supprimer des paroles

475 Saisir les paroles au-dessus de la portée

476 Modifier la numérotation des couplets

477 Copier des paroles

477.1 Copier des paroles dans MuseScore Studio

477.1.1 Copier vers le même couplet

477.1.2 Copier vers un couplet différent

477.2 Copier les paroles vers d’autres programmes

478 Propriétés des paroles

479 Style des paroles

479.1 Texte de paroles

479.2 Tirets de paroles

479.3 Mélisme

480 Doigtés

481 Types de doigtés

482 Ajouter un doigté à votre partition

482.1 Ajouter un élément doigté avec une palette

482.2 Ajouter un élément doigté à l’aide d’un raccourci clavier

482.3 Ajouter un élément doigté via le menu

483 Ajuster la position du doigté

484 Modifier l’apparence des éléments de doigté

485 Propriétés des éléments de doigté

486 Style des éléments de doigté

487 Voir aussi

487.1 Symboles d'accord

488 Vue d’ensemble

489 Ajouter un symbole d’accord dans une partition

489.1 Saisir un symbole d’accord

489.1.1 Nom des accords, altérations et formatage

489.1.2 Commandes de navigation

489.1.3 Syntaxe des symboles d’accord

489.1.4 Éditer un symbole d’accord

489.2 Saisir des chiffres romains d’analyse

489.2.1 Altérations des chiffres romains d'analyse et formatage

489.2.2 Exemples de chiffres romains d'analyse

489.3 Saisir un numéro Nashville

490 Vue d'ensemble de l'apparence et de la fonction

491 Aligner les symboles d’accord

491.1 Avec le menu Style

491.1.1 "Style pour symboles d'accord"

491.1.2 "Style de texte propre à certains objets"

491.2 Utiliser le panneau Propriétés

492 Transposer les symboles d’accord

492.1 Instruments transpositeurs

492.2 Fenêtre de dialogue Transposer

492.3 Autoriser la création automatique de symboles d'accord supplémentaires avec un capodastre (pas Nashville ni chiffres romains)

493 Modifier la notation des symboles d’accord (pas Nashville ni chiffres romains)

493.1 Systèmes de notation des accords

493.2 Mise en majuscule automatique

494 Modifier l’apparence

494.1 Police

494.2 Style de rendu des symboles d'accord et numéros Nashville (pas des chiffres romains d'analyse)

495 Modifier la lecture des symboles d’accord

495.1 Activer et désactiver la lecture

495.2 Personnaliser la lecture

495.3 Générer des accords d’interprétation dans une portée

496 Propriétés des symboles d’accord

497 Style des symboles d’accord

498 Liens externes

498.1 Basse chiffrée

499 Vue d’ensemble

500 Ajouter une indication de basse figurée à votre partition

500.1 Saisir un chiffre

500.2 Format de texte

500.2.1 Chiffres

500.2.2 Altérations

500.2.3 Formes combinées

500.2.4 Parenthèses

500.2.5 Éditer des indications existantes de basse chiffrée

500.3 Se déplacer entre notes, battements ou mesures

500.4 Fixer la durée

500.5 Saisir des lignes de prolongement

501 Propriétés des indications de basse chiffrée

502 Style des indications de basse chiffrée

503 Raccourcis clavier de basse chiffrée

503.1 Repères

504 Vue d’ensemble

505 Ajouter un repère à votre partition

505.1 Placer et nommer un repère de façon manuelle

505.2 Placer et nommer un repère automatique

506 Utiliser des numéros de mesure dans les repères

507 Remettre les repères dans l’ordre

508 Rechercher des repères

509 Répéter les repères dans les autres portées

510 Modifier l’apparence des repères

511 Propriétés des repères

512 Style des repères

513 Liens externes

513.1 En-tête et pied de page

514 Vue d’ensemble

515 Ajouter un en-tête ou un pied de page dans votre partition
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515.1 Saisir les informations

515.2 Utiliser des métadonnées

516 Modifier l'apparence des en-têtes et pieds de pages

517 Propriétés des en-têtes et pieds de pages

518 Style des en-têtes et pieds de pages

519 Voir aussi

519.1 Blocs de texte

520 Vue d’ensemble

521 Ajouter un bloc de texte à une partition

522 Modifier l’apparence des blocs de texte

523 Propriétés de texte dans un bloc de texte

524 Style de texte dans un bloc de texte

525 Voir aussi

526 Mise en page

526.1 Notions de mise en page

527 Aperçu

528 Définitions

528.1 Spatium / sp.

528.2 Portée

528.2.1 Hauteur de partition absolue finale

528.3 Portées de type piano

528.4 Système

528.5 Cadre

528.6 Marges

529 Positionner les éléments

530 Aperçu

531 Position par défaut

532 Auto-placement

532.1 Évitement vertical de collision

532.2 Évitement horizontal de collision

532.3 Alignement vertical

532.4 Désactiver l’auto-placement

533 Ajustement manuel

534 Alignement manuel

534.1 Taille et espacement de la partition

535 Vue d'ensemble

536 Paramètres de la page

536.1 Tailles de page et de marges

536.2 Échelle

536.3 Autres paramètres

536.4 Actions

537 Paramètres de style

537.1 Espacement horizontal

537.2 Espacement vertical

537.2.1 Marges de musique

537.2.2 Espacement entre portées à l’intérieur d’un système

537.2.3 Espacement entre systèmes

538 Propriétés de portée/partie

538.1 Espacement horizontal des systèmes

539 Aperçu

540 Fonctionnalités

540.1 Sauts de système

540.2 Étirement

540.3 Cadres horizontaux

540.4 Grouper des mesures dans le même système

541 Utilisation pratique

541.1 Placer moins de mesures dans un système

541.2 Placer davantage de mesures dans un système

541.3 Modifier l’espacement relatif des mesures au sein d’un système

541.4 Créer de l’espace entre mesures

541.5 Créer de l’espace au début ou à la fin d’un système

541.6 Ajuster la largeur du dernier système

541.7 Grouper des mesures

542 Espacement vertical des pages

543 Fonctionnalités

543.1 Sauts de page

543.2 Espaceurs

543.3 Cadres verticaux

543.4 Séparateurs de systèmes

544 Utilisation pratique

544.1 Placer moins de systèmes dans une page

544.2 Placer davantage de systèmes dans une page

544.3 Ajuster l’espacement sur les pages clairsemées

544.4 Ajuster l’espacement entre systèmes spécifiques

544.5 Ajuster l’espacement entre portées spécifiques

545 Utiliser des cadres pour ajouter du contenu

546 Vue d’ensemble

547 Usages des cadres

548 Ajouter des cadres avant, entre ou après un système

548.1 Cadres de texte

548.1.1 Ajouter un cadre de texte

548.1.2 Ajouter du texte

548.2 Cadres verticaux

548.2.1 Ajouter un cadre vertical

548.2.2 Ajouter du texte

548.2.3 Ajouter une image

548.2.4 Taille

548.3 Position et alignement du contenu

548.4 Espacement

549 Ajouter des cadres entre des mesures

549.1 Cadres horizontaux

549.1.1 Ajouter un cadre horizontal

549.1.2 Ajouter du texte

549.1.3 Ajouter une image

549.1.4 Taille

549.1.5 Espacement

549.1.6 Autre propriété du cadre horizontal

550 Voir aussi
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550.1 Utiliser des images

551 Utiliser des images

551.1 Importer des images

551.2 Sauvegarder des images dans des palettes

551.3 Copier des images importées

551.4 Ajuster des images

551.4.1 Changer la hauteur et la largeur de l'image

551.4.2 Échelle d'image

551.4.3 Ajuster la position d'une image

552 Propriétés d'image

553 Voir aussi

553.1 Utiliser des sections pour séparer mouvements ou chansons

554 Vue d’ensemble

554.1 Caractéristiques

554.2 Indications de tempo et armures

555 Ajouter un saut de section

556 Propriétés de saut de section

556.1 Pause de lecture

556.2 Nom des instruments

556.3 Numérotation des mesures

557 Gestion des fichiers

557.1 Ouvrir et enregistrer les partitions

558 Vue d’ensemble

559 Ouvrir une partition

559.1 Fichier → Ouvrir

559.2 Fichier → Partitions récentes

559.3 Onglet Accueil → Partitions

560 Formats d’importation de fichiers

561 Enregistrer une partition

561.1 Enregistrer sur l’ordinateur

561.2 Enregistrer dans le cloud

561.2.1 Nom

561.2.2 Visibilité

561.2.3 Jamais

561.2.4 Toujours

561.2.5 Tous les x enregistrements

562 Lien externe

562.1 Exportation de fichiers

563 Vue d’ensemble

564 Exporter votre partition

565 Formats de fichier

565.1 Formats graphiques

565.2 Formats audio

565.3 Format MIDI

565.4 Formats de notation musicale

565.5 Personnaliser les paramètres d’export

566 MIDI import

567 Travailler avec des fichiers MusicXML

568 Vue d’ensemble

569 Ouvrir un fichier MusicXML

570 Nettoyer une partition importée

570.1 Restaurer les hampes de notes

570.2 Restaurer les espaces devant les notes

570.3 Supprimer les sauts

570.4 Restaurer les styles de texte par défaut

570.5 Retour aux positions de texte par défaut

570.5.1 Cadre

570.5.2 Texte de partition

571 Préparer l’export d’une partition

571.1 Paramétrage d’export

572 Backup and recovered files

573 Propriétés des partitions

574 Vue d’ensemble

575 Modifier les propriétés de la partition

576 Ajouter de nouvelles propriétés

577 Accéder aux propriétés de votre partition

577.1 Score comparison

577.2 Publier sur musescore.com

578 Vue d’ensemble

578.1 Coûts et revenus de publication

578.2 Droits de publication

579 Créer un compte MuseScore

580 Sauvegarder uniquement sur musescore.com

581 Publier les partitions enregistrées localement

582 Visibilité dans le gestionnaire de partitions

583 Gérer la création de mp3 pendant la sauvegarde

583.1 Jamais

583.2 Toujours

583.3 Tous les x enregistrements

584 Partager sur Audio.com

585 Vue d’ensemble

586 Pour partager un fichier audio à partir de votre partition sur Audio.com

586.1 Pour partager sur Audio.com chaque fois que vous publiez une partition

587 Son et lecture sonore de la partition

587.1 Commandes de lecture

588 Vue d'ensemble

589 Commandes de lecture

589.1 Démarrer/arrêter la lecture

589.1.1 Pour reproduire toutes les parties instrumentales

589.1.2 Pour reproduire uniquement les parties instrumentales sélectionnées

589.1.3 Pour arrêter la lecture

589.2 Aller au début

589.3 Lire un passage en boucle

589.4 Utiliser le métronome

589.5 Position de lecture et moniteur de tempo

590 Autres commandes

590.1 Activer l'entrée MIDI

590.2 Jouer les reprises (répétitions)
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590.3 Jouer les symboles d'accord

590.4 Suivre la partition automatiquement

591 Liens externes

591.1 Mélangeur

592 Aperçu

593 Ouvrir le mélangeur

594 Contrôles du mélangeur

595 Son

595.1 Pour changer l'instrument d'un canal :

596 FX Audio

596.1 Pour ajouter un plugin FX Audio

596.2 Pour désactiver un effet VST

596.3 Pour supprimer un plugin VST

596.4 Muse Reverb

597 Aux sends

597.1 Pour afficher/masquer un emplacement Aux send

597.2 Pour supprimer un emplacement Aux send

598 Aux channels

598.1 Pour afficher/masquer les Aux channels

598.2 Pour ajouter un effet FX Audio à un Aux channel

598.3 Pour ajuster le niveau d’un Aux channel

598.4 Pour appliquer l’effet d’un ou plusieurs Aux channel à un instrument

599 Voir également

599.1 SoundFonts

600 Aperçu

601 Installer une SoundFont

601.1 Installer par glisser/déposer

601.2 Installer dans le répertoire de fichiers

601.3 Ajouter ou modifier le répertoire SoundFont

602 Utiliser les sons d'une SoundFont

602.1 Sélectionner des sons individuels

603 Éditer des Soundfonts

604 Désinstaller une SoundFont

605 Informations sur le lecteur Zerberus et les SFZ

606 Voir également

606.1 Installer les sons Muse Sounds

607 Installer les Muse Sounds via Muse Hub

608 Utiliser les Muse Sounds dans MuseScore Studio

609 Sons disponibles dans Muse Sounds

609.1 Choir (chœurs)

609.2 Strings (instruments à cordes)

609.3 Woodwinds (bois)

609.4 Brass (cuivres)

609.5 Percussions

609.6 Keys (claviers)

609.7 Harp

609.8 Guitars

610 Lien externe

610.1 Sound flags

611 Vue d'ensemble

611.1 Ajouter un sound flag

611.2 Utiliser un sound flag sans afficher de texte dans la partition

611.3 Supprimer un sound flag

611.4 Masquer les sound flags dans la partition

612 Options supplémentaires

612.1 Réinitialiser un sound flag

612.2 Sélectionnez des sons multiples dans un même sound flag

612.3 Modifier les portées qu'un sound flag affecte

612.4 Sons sans sound flags

613 Navigation avec le clavier d'ordinateur

613.1 Ajouter un sound flag avec le clavier

614 Voir aussi

614.1 Lecture avec capodastre

615 Aperçu

616 Ajouter une indication de capodastre à votre partition

616.1 Pour une partition à une seule portée

616.2 Pour un couple portée/tablature

617 Voir également

617.1 Lecture du swing

618 Aperçu

619 Ajouter une indication de jeu Swing ou Linéaire à votre partition

619.1 Pour ajouter une indication Swing

619.2 Pour ajouter une indication Linéaire

620 Modifier la lecture du swing

620.1 Ajuster le type et le degré de swing

620.2 Appliquer le swing à une seule portée

621 Working with MIDI

622 Travailler avec les plugins VST et VSTi

623 Introduction aux VST

624 Installer des VST

625 Activer, désactiver, supprimer et remplacer les plugins VST

625.1 Voir aussi

626 Personnalisation

626.1 Langue

627 Vue d'ensemble

627.1 Changer de langue

627.1.1 Mettre à jour les traductions

627.2 Voir aussi

628 Apparence

629 Vue d'ensemble

630 Thème et couleurs

631 Police de caractères

631.1 Barres d'outils et fenêtres

632 Espace de travail

633 Barres d’outils

633.1 Afficher et masquer les barres d’outils

633.2 Repositionner les barres d’outils

633.3 Personnaliser le contenu des barres d’outils
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634 Fenêtres et panneaux

634.1 Détacher ou ancrer les panneaux

634.2 Personnaliser le contenu des panneaux

635 Modèles et styles

636 Vue d’ensemble

637 Modèles

637.1 Enregistrer votre partition comme modèle

637.2 Créer une partition à partir de votre modèle

638 Fichiers de Style

638.1 Sauvegarder les paramètres de style de votre partition dans un fichier

638.2 Charger les paramètres d'un "profil général de style" à partir d’un fichier

638.3 Paramétrer un style par défaut pour votre partition

639 Palettes

640 Aperçu

641 Ajouter des palettes

642 Masquer et supprimer des palettes

643 Changer l’ordre des palettes

644 Personnaliser le contenu des palettes

644.1 Ajouter des éléments à partir de la fenêtre Palette principale

644.2 Ajouter des éléments à partir de votre partition (#add-score-elements)

644.3 Déplacer des éléments entre palettes

644.4 Supprimer des éléments d’une palette

644.5 Réinitialiser une palette

645 Sauvegarder et charger des palettes

646 Menu des palettes

647 Propriétés des palettes

648 Voir aussi

648.1 Espaces de travail

649 Vue d’ensemble

650 Créer un nouvel espace de travail

651 Supprimer un espace de travail

652 Changer d’espace de travail

652.1 Raccourcis clavier

653 Vue d'ensemble

654 Définir un raccourci

655 Réinitialiser et effacer les raccourcis

655.1 Réinitialiser un raccourci à sa valeur par défaut

655.2 Effacer un raccourci

656 Importer et exporter des raccourcis

656.1 Préférences

657 Général

658 Apparence

659 Canevas

660 Saisie de notes

661 Commandes d'un périphérique MIDI

662 Partition

663 Entrée/Sortie

664 Importation

665 Raccourcis

666 Mise à jour

667 Avancé

667.1 Plugins

668 Vue d’ensemble

669 Organiser les plugins

669.1 Installer un nouveau plugin

669.2 Mettre à jour un plugin existant

669.3 Activer et désactiver des plugins

670 Démarrer un plugin

671 Plugins préinstallés

672 Créer un plugin

673 Voir aussi

674 Support

674.1 Getting help

675 Overview

676 Learn

677 Forums

678 Issue tracker

679 GitHub

680 Mastering MuseScore

680.1 Revert to factory settings

681 Overview

682 Reverting to factory settings from the menu

683 Reverting to factory settings from the command line

683.1 Windows

683.2 macOS

683.3 Linux

684 Troubleshooting

685 Installation issues

686 Score issues

687 Display issues

688 Sound issues

689 Printing issues

689.1 Known incompatibilities

690 Annexes

690.1 Utilisation de la ligne de commande

690.1.1 Nom

690.1.2 Résumé

690.1.3 Description

690.1.4 Conversion par lot au format JSON

690.1.5 Environnement

690.1.6 Fichiers

690.1.7 Exemples

690.1.7.1 Convertir une partition en pdf à partir de la ligne de commande

690.1.7.2 Exécuter un lot de commande pour convertir plusieurs documents

690.1.7.3 Opération d’importation MIDI

690.1.8 Diagnostics

690.1.9 Voir aussi

690.1.10 Standards
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690.1.11 Historique

690.1.12 Auteurs

690.1.13 Avertissements

690.1.14 Bugs

690.2 Tous les raccourcis clavier

691 Schéma de clavier

692 Navigation

692.1 Page entre pages

692.2 Score navigation

693 Saisie des notes

693.1 Général

693.2 Durée des notes

693.3 Hauteur des notes

693.4 Tablature

694 Sélection

695 Édition

695.1 Général

695.2 Durée

695.3 Hauteur

695.4 Notation

695.5 Réglages manuels

696 Texte

696.1 Général

696.2 Mise en forme

696.3 Paroles

696.4 Symboles d’accords, chiffres romains d'analyse, numéros Nashville, basse chiffrée

697 Autres éléments de partition

698 Paramétrage et mise en forme de la partition

699 Opérations sur les fichiers

700 Interface utilisateur (UI)

700.1 Lecture

700.2 Accessibilité

700.3 Autres

701 Known incompatibilities

702 Modifications des percussions MDL

702.1 Mappage des sons

702.2 Notation

703 Mise à niveau depuis MuseScore 3.x

704 Vue d’ensemble

705 Raccourcis clavier

706 Autres modifications

707 Fonctionnalités manquantes

707.1 Upgrade from MuseScore 2.x or 1.x

707.2 Handbook for MuseScore 3.x

707.3 Handbook for MuseScore 2.x

707.4 Handbook for MuseScore 1.x

707.5 Glossaire

708 A

708.1 Accent

708.2 Acciaccatura

708.3 Accolade

708.4 Accord

708.5 Altération

708.6 Ambitus

708.7 Anacrouse

708.8 Ancre

708.9 Appoggiature

708.10 Armure

708.11 Armure de précaution

708.12 Arpège

708.13 Articulation

709 B

709.1 Barre de mesure

709.2 Barres de reprise

709.3 Bécarre

709.4 Bémol

709.5 Blanche

709.6 BPM

710 C

710.1 Capodastre (texte de)

710.2 Carrée ou brevis

710.3 Cent

710.4 Césure

710.5 Clef

710.6 Clef de précaution

710.7 Coda

710.8 Crescendo

710.9 Croche

710.10 Crochet de note

710.11 Crochet de système

711 D

711.1 Da capo (D.C.)

711.2 Decrescendo

711.3 Dièse

711.4 Diminuendo

711.5 Division irrégulière

711.6 Double bémol

711.7 Double dièse

711.8 Duolet

712 E

712.1 Échanger les notes enharmoniques

712.2 Éclater

712.3 Enharmonie

713 F

713.1 Fioriture

714 G

714.1 Ghost note

715 H
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715.1 Hampe

715.2 Hauteur des notes existantes

716 I

716.1 Indication de mesure

716.2 Indication de mesure de précaution

716.3 Indication de mesure locale

716.4 Indication de métronome

716.5 Instrument

716.6 Intercalé

716.7 Interligne de portée

716.8 Intervalle

717 L

717.1 Legato

717.2 Levée

717.3 Ligatures françaises

717.4 Ligne

717.5 Liaison de phrasé

717.6 Liaison de prolongation

717.7 Ligature

717.8 Lignes supplémentaires

717.9 Louré

718 M

718.1 Marcato

718.2 Martellato

718.3 Mélisme

718.4 Mesure

718.5 Mode édition, mode édition de texte

718.6 Mode Normal

718.7 Mode de saisie de notes

719 N

719.1 Noire

719.2 Notation entre portées

719.3 Notation slash

719.4 Note d'agrément ou note d'ornement

719.5 Notes enharmoniques

719.6 Note fantôme ou note morte

719.7 Nuance (symbole de)

720 O

720.1 OS (operating system)

720.2 Ossia

721 P

721.1 Partie

721.2 Partition

721.3 Pause multimesures

721.4 Piqué

721.5 Point d’arrêt

721.6 Point d’orgue

721.7 Portée

721.8 Portée de type piano

721.9 Précaution

721.10 Propriétés

722 Q

722.1 Quadruple croche

722.2 Quartolet

722.3 Quintolet

723 R

723.1 Rassembler

723.2 Recalculer les altérations

723.3 Répétition de mesure (symbole de)

723.4 Reprise (indication de)

723.5 Respiration

723.6 Ronde

724 S

724.1 Saisie pas à pas

724.2 Saut

724.3 Section

724.4 Segno

724.5 Séparateur de système

724.6 Sextolet

724.7 SF2

724.8 SF3

724.9 Silence

724.10 Slash (accord, tête de note)

724.11 SND (Single note dynamics)

724.12 Solmisation

724.13 SoundFont

724.14 sp.

724.15 Spatium

724.16 Staccato

724.17 Style

724.18 Système

724.19 Système d'exploitation

725 T

725.1 Tempo

725.2 Tenuto

725.3 Tête de note partagée

725.4 Texte

725.5 Tonalité écrite

725.6 Tonalité réelle

725.7 Transposition

725.8 Trémolo

725.9 Triolet

725.10 Triple croche

726 V

726.1 Vélocité

726.2 Voix

727 Liens externes

727.1 Table des matières
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728 Éditer le manuel

728.1 Recommandations pour l’écriture d’articles

728.2 Structure – Principes généraux

728.3 Titres

728.4 Contenu

728.5 Utiliser des médias non écrits

728.6 Faire des liens vers d’autres pages

728.7 Syntaxe

728.8 Laisser un message de révision

729 Présentation de MuseScore 4

729.1 Téléchargement et installation

729.1.1 Windows

729.1.2 macOS

729.1.3 Linux

729.2 Créez votre première partition

729.2.1 Vue d'ensemble

729.2.2 Créer rapidement une nouvelle partition

729.2.3 Saisir des informations sur la partition

729.2.4 Saisir des notes et des silences

729.2.5 Ajouter des objets à partir des palettes

729.2.6 Écouter le résultat

729.2.7 Réaliser des ajustements dans le panneau Propriétés

729.2.8 Insérer et supprimer des mesures

729.2.9 Enregistrer la partition

729.2.10 Exporter la partition

729.3 Nouvelles fonctionnalités de MuseScore Studio

729.3.1 Nouvelle interface utilisateur

729.3.2 Instruments et parties

729.3.3 Inspecteur

729.3.4 Nouveau support de lecture et d’instruments virtuels

729.3.5 Améliorations d’écriture

729.3.6 Enregistrement en ligne

729.3.7 Autres changements

730 Affichage et navigation

730.1 Accessibilité

730.1.1 Lecteurs d’écran

730.1.2 Accès clavier

730.1.3 Tutoriels vidéo

730.2 L'interface utilisateur

730.2.1 Barre de Menu

730.2.2 Onglet accueil

730.2.3 Onglet Partition

730.2.4 Onglet Publier

730.2.5 Menus contextuels

730.3 Naviguer dans votre partition

730.3.1 Défilement

730.3.2 Navigation entre éléments

730.3.3 Navigateur

730.3.4 Timeline

730.3.5 Affichages

730.3.6 Zoom

730.3.7 Chercher / Aller à

730.4 Timeline

730.4.1 Vue d’ensemble

730.4.2 Méta-éléments

730.4.3 Actions de base

730.4.4 Faire défiler la timeline

730.4.5 Actions sur les étiquettes

730.4.6 Zoomer

730.5 Braille

730.5.1 Vue d’ensemble

730.5.2 Voir le braille

730.5.3 Écrire en braille

731 Bases

731.1 Configurer votre partition

731.1.1 Vue d'ensemble

731.1.2 Instruments

731.1.3 Informations complémentaires sur la partition

731.1.4 Changer les instruments après la création de la partition

731.2 Saisir des notes et des silences

731.2.1 Vue d'ensemble

731.2.2 Saisir des notes

731.2.3 Saisir des accords

731.2.4 Saisir des silences

731.2.5 Saisir des altérations

731.2.6 Ajouter des liaisons de prolongation

731.2.7 Voir aussi

731.3 Travailler avec plusieurs voix

731.3.1 Vue d'ensemble

731.3.2 Saisir des notes et des silences dans différentes voix

731.3.3 Éditer les notes et silences dans plusieurs voix

731.3.4 Voir aussi

731.4 Méthodes alternatives de saisie des notes

731.4.1 Accéder à des méthodes alternatives de saisie de notes

731.4.2 Saisir uniquement le rythme

731.4.3 Saisir uniquement la hauteur des notes

731.4.4 Saisir les notes en temps réel

731.4.5 Insérer des notes

731.5 Ajouter et supprimer des mesures

731.5.1 Ajouter des mesures

731.5.2 Supprimer des mesures

731.5.3 Voir aussi

731.6 Sélectionner des éléments

731.6.1 Sélectionner un seul élément

731.6.2 Créer une liste de sélections

731.6.3 Créer une Sélection groupée

731.6.4 Exclure des éléments d’une Sélection groupée

731.7 Éditer des notes et des silences
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731.7.1 Vue d’ensemble

731.7.2 Effectuer des modifications dans le mode de saisie des notes

731.7.3 Effectuer des modifications dans le mode normal

731.7.4 Voir aussi

731.8 Copier et coller

731.8.1 Accéder aux commandes

731.8.2 Copier une Sélection groupée

731.8.3 Copier un élément individuel ou une Liste de sélections

731.8.4 Déplacer des éléments

731.8.5 Échanger une sélection avec le presse-papier

731.8.6 Répéter une sélection

731.8.7 Copier une Sélection groupée vers plusieurs portées

731.8.8 Coller avec une demi ou une double durée

731.8.9 Dupliquer des éléments individuels

731.8.10 Voir aussi

731.9 Utiliser les palettes

731.9.1 Vue d’ensemble

731.9.2 Accéder au panneau Palettes

731.9.3 Ajouter des objets palette dans la partition

731.9.4 Développer et réduire les palettes

731.9.5 Effectuer une recherche et naviguer dans les palettes

731.9.6 Accéder à davantage d’objets palette

731.9.7 Ajouter d’autres palettes

731.9.8 Voir aussi

731.10 Panneau des propriétés

731.10.1 Vue d'ensemble

731.10.2 Accéder au panneau Propriétés

731.10.3 Propriétés pour la partition

731.10.4 Propriétés pour les objets

731.10.5 Propriétés pour les caractères au sein des objets Texte

731.10.6 Sauvegarder et restaurer les paramètres par défaut

731.11 Ajuster directement les éléments

731.11.1 Modifier la position des éléments

731.11.2 Modifier la forme des éléments

731.11.3 Travailler avec les lignes

731.11.4 Voir aussi

731.12 Parties

731.12.1 Ouvrir une partie

731.12.2 Fermer une partie

731.12.3 Créer des parties personnalisées

731.12.4 Appliquer des styles aux parties

731.12.5 Renommer, dupliquer et supprimer des parties

731.12.6 Exporter et imprimer des parties

731.12.7 Liens externes

731.13 Raccourcis clavier par défaut

731.13.1 Navigation

731.13.2 Saisie des notes

731.13.3 Sélection

731.13.4 Édition

731.13.5 Texte

731.13.6 Autres éléments de partition

731.13.7 Paramétrage et mise en forme de la partition

731.13.8 Opérations sur les fichiers

731.13.9 Interface utilisateur

732 Notation : Instruments, portées et systèmes

732.1 Travailler avec les instruments

732.1.1 Vue d’ensemble

732.1.2 Ajouter et ranger les instruments

732.1.3 Paramétrer les instruments

732.1.4 Ajouter et ranger les instruments

732.1.5 Ajouter et configurer des portées

732.1.6 Masquer une portée tout en conservant sa lecture

732.1.7 Supprimer des portées

732.2 N'afficher les portées que si nécessaire

732.2.1 Vue d'ensemble

732.2.2 Masquer une portée vide dans un système

732.2.3 Masquer des mesures vides

732.3 Rassembler et éclater

732.3.1 Rassembler

732.3.2 Éclater

732.4 Changer d'instrument en cours de partition

732.4.1 Ajouter un changement d’instrument

732.4.2 Travailler avec un changement d’instrument

732.5 Changer le type de portée

732.5.1 Vue d'ensemble

732.5.2 Ajouter un changement de style de portée

732.5.3 Régler les propriétés de la portée

732.6 Propriétés des Portées / Parties

732.6.1 Vue d’ensemble

732.6.2 Propriétés des portées

732.6.3 Propriétés avancées de style

732.6.4 Propriétés des parties

732.7 Crochets de systèmes

732.7.1 Vue d'ensemble

732.7.2 Ajouter un crochet

732.7.3 Éditer les crochets

732.7.4 Supprimer un crochet

732.7.5 Personnaliser l’apparence du crochet

733 Notation : Rythme, temps et mesures

733.1 Indications de mesure

733.1.1 Vue d’ensemble

733.1.2 Fixer l’indication de mesure initiale de votre partition

733.1.3 Ajouter un changement d’indication de mesure dans votre partition

733.1.4 Supprimer une indication de mesure

733.1.5 Paramétrez la visibilité des indications de mesure

733.1.6 Créer un indicateur de mesure personnalisé

733.1.7 Ajouter une indication de mesure locale dans une seule portéeh4>

733.1.8 Redimensionner une indication de mesure
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733.1.9 Propriétés des indications de mesure

733.1.10 Style d’indications de mesure

733.2 Hampes et crochets de notes

733.2.1 Direction de hampe

733.2.2 Modifier la longueur de hampe

733.2.3 Créer des notes sans hampe

733.2.4 Propriétés des hampes et crochets de notes

733.2.5 Styles des hampes et crochets de notes

733.2.6 Voir aussi

733.3 Ligatures

733.3.1 Paramétrer à quelles notes attribuer des ligatures

733.3.2 Paramétrer l’apparence des ligatures

733.3.3 Propriétés des ligatures

733.3.4 Style des ligatures

733.4 Regrouper les rythmes

733.4.1 Vue d’ensemble

733.4.2 Regrouper les rythmes

733.4.3 Voir aussi

733.5 Divisions irrégulières

733.5.1 Créer une division irrégulière

733.5.2 Modifier l’affichage des divisions irrégulières

733.5.3 Propriétés des divisions irrégulières

733.5.4 Style des divisions irrégulières

733.6 Barres de mesure

733.6.1 Vue d'ensemble

733.6.2 Modifier ou ajouter des barres de mesure

733.6.3 Modifier la longueur de la barre de mesure

733.6.4 Propriétés des barres de mesure

733.6.5 Style des barres de mesure

733.6.6 Voir aussi

733.7 Numérotation des mesures

733.7.1 Afficher et masquer la numérotation des mesures

733.7.2 Modifier la séquence de numérotation des mesures

733.7.3 Ajuster la position des numéros de mesure

733.7.4 Propriétés des numéros de mesure

733.7.5 Style de numérotation des mesures

733.7.6 Voir aussi

733.8 Pauses de mesures et pauses multimesures

733.8.1 Pauses de mesure

733.8.2 Pauses multimesures

733.8.3 Voir aussi

733.9 Anacrouse et notation non mesurée

733.9.1 Créer une anacrouse

733.9.2 Créer une notation non mesurée

733.9.3 Voir aussi

733.10 Propriétés de la mesure

733.10.1 Ouvrir et utiliser la fenêtre de dialogue

733.10.2 Portées

733.10.3 Durée de la mesure

733.10.4 Autre

733.10.5 Voir aussi

734 Notation : Hauteur de note et tonalité

734.1 Clefs

734.1.1 Aperçu

734.1.2 Définition de la clef initiale d'une portée

734.1.3 Ajouter ou modifier une clef

734.1.4 Supprimer

734.1.5 Contrôler la visibilité des clefs

734.1.6 Clefs et transposition

734.1.7 Propriétés des clefs

734.1.8 Style des clefs

734.2 Armures

734.2.1 Aperçu

734.2.2 Définir l'armure initiale de la partition

734.2.3 Ajouter un changement d'armure à la partition

734.2.4 Ajouter une armure locale à une seule portée

734.2.5 Sélectionner une armure pour une seule portée

734.2.6 Remplacer une armure existante

734.2.7 Supprimer une armure

734.2.8 Contrôler la visibilité des armures

734.2.9 Armures et instruments transpositeurs

734.2.10 Créer une armure personnalisée

734.2.11 Propriétés des armures

734.2.12 Style des armures

734.2.13 Voir également

734.3 Transposition

734.3.1 Aperçu

734.3.2 Transposer avec des raccourcis clavier

734.3.3 Utiliser la fenêtre de dialogue de transposition

734.3.4 Travailler avec des instruments transpositeurs

734.4 Lignes d'octave

734.4.1 Vue d'ensemble

734.4.2 Ajouter une ligne d'octave à la partition

734.4.3 Propriétés des lignes d'octave

734.4.4 Style des lignes d'octave

734.5 Têtes de note

734.5.1 Vue d'ensemble

734.5.2 Modifier la forme des têtes de note

734.5.3 Ajouter des informations de hauteur aux notes

734.5.4 Modifier la direction d'une tête de note

734.5.5 Propriétés des têtes de note

734.5.6 Style et police des têtes de note

734.5.7 Partager des têtes de note entre les voix

734.5.8 Voir aussi

734.5.9 Liens externes

734.6 Ambitus

734.6.1 Ajouter un ambitus à votre partition

734.6.2 Modifier l'étendue d'un ambitus
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734.6.3 Propriétés de l'ambitus

734.7 Recalculer les altérations

734.7.1 Modifier manuellement l'écriture enharmonique de certaines notes

734.7.2 Modifier automatiquement toutes les notes d'une sélection

735 Notation : Symboles d’expression

735.1 Articulations

735.1.1 Aperçu

735.1.2 Ajouter des articulations dans votre partition

735.1.3 Lecture des articulations

735.1.4 Propriétés des articulations

735.1.5 Style des articulations

735.2 Nuances

735.2.1 Ajouter une nuance à votre partition

735.2.2 Changer l'apparence des indicateurs de nuance

735.2.3 Modifier la façon de jouer les nuances

735.2.4 Propriétés des indicateurs de nuance

735.2.5 Style des indicateurs de nuance

735.3 Marques de crescendo et diminuendo

735.3.1 Types de marques

735.3.2 Ajouter des marques de crescendo/diminuendo dans la partition

735.3.3 Modifier l’apparence des marques de crescendo/diminuendo

735.3.4 Modifier la lecture des crescendos/diminuendos

735.3.5 Propriétés des marques de crescendo/diminuendo

735.3.6 Style des marques de crescendo/diminuendo

735.4 Liaisons de phrasé

735.4.1 Aperçu

735.4.2 Ajouter une liaison de phrasé à votre partition

735.4.3 Créer des liaisons de phrasé multi-voix et inter-portées

735.4.4 Modifier l’apparence des liaisons de phrasé

735.4.5 Propriétés des liaisons de phrasé

735.4.6 Style des liaisons de phrasé

735.5 Respirations et pauses

735.5.1 Aperçu

735.5.2 Types de symboles de pauses

735.5.3 Ajouter un symbole de pause à la partition

735.5.4 Modifier la lecture des symboles de pause

735.5.5 Propriétés des symboles de pause

735.5.6 Pause style

735.6 Ornements

735.6.1 Aperçu

735.6.2 Ajouter un ornement à la partition

735.6.3 Ajouter des altérations aux ornements

735.6.4 Propriétés des ornements

735.6.5 Style des ornements

735.7 Arpèges et glissandos

735.7.1 Aperçu

735.7.2 Symboles d’arpège

735.7.3 Symboles de glissando

735.7.4 Symboles de Bend

735.8 Fioritures

735.8.1 Aperçu

735.8.2 Types de fioritures

735.8.3 Ajouter une fioriture à votre partition

735.8.4 Fioritures multiples

735.8.5 Éditer les fioritures

735.8.6 Style des fioritures

735.9 Trémolos et roulements

735.9.1 Types de trémolos et roulements

735.9.2 Ajouter un trémolo à une note seule

735.9.3 Ajouter un trémolo entre des notes/accords

735.9.4 Modifier l’apparence des symboles de trémolo

735.10 Autres lignes

735.10.1 Vue d’ensemble

735.10.2 Ajouter une ligne à la partition

735.10.3 Ajuster une ligne

735.10.4 Types de lignes

735.10.5 Propriétés des lignes

735.10.6 Style des lignes

735.11 Autres symboles

735.11.1 Vue d'ensemble

735.11.2 La palette Symboles

735.11.3 Ajouter des symboles à votre partition

736 Notation : Répétitions

736.1 Barres de répétition

736.1.1 Aperçu

736.1.2 Ajouter des barres de répétition à votre partition

736.1.3 Modifier la lecture des barres de répétition

736.1.4 Modifier l'apparence des barres de répétition

736.1.5 Propriétés des barres de répétitions

736.1.6 Style des barres de répétition

736.2 Alternatives de reprise

736.2.1 Aperçu

736.2.2 Ajouter une alternative de reprise à votre partition

736.2.3 Modifier l'apparence des alternatives de reprise

736.2.4 Modifier la lecture des alternatives de reprises

736.2.5 Propriétés d'une alternative de reprise

736.2.6 Style des alternatives de reprise

736.3 Sauts et reprises

736.3.1 Aperçu

736.3.2 Types d'objets Sauts et Reprises

736.3.3 Ajouter un Saut ou une Reprise à votre partition

736.3.4 Modifier l'apparence des Sauts et Reprises

736.3.5 Modifier la lecture des Sauts et Reprises

736.3.6 Propriétés des sauts et Reprises

736.3.7 Style des Sauts et Reprises

736.4 Répétition de mesure et répétitions multimesures

736.4.1 Aperçu

736.4.2 Ajouter une répétition de mesure ou une répétition multimesures à votre partition
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736.4.3 Propriétés des répétitions de mesure

736.4.4 Style des répétitions de mesure

736.5 Lecture des répétitions

736.5.1 Activer et désactiver la lecture des répétitions

737 Notation spécialisée : Clavier

737.1 Pédale

737.1.1 Types de marques de pédale

737.1.2 Ajouter une marque de pédale à la partition

737.1.3 Créer des changements de pédales

737.1.4 Propriétés de pédale

737.1.5 Style de pédale

737.2 Notation entre portées

737.2.1 Créer une notation entre portées

737.2.2 Changer l'apparence de la notation entre portées

737.3 Notation pour accordéon [VIDE]

737.3.1 Ajouter des symboles accordéon à votre partition

738 Notation spécialisée : Guitare

738.1 Diagrammes d'accord de guitare

738.1.1 Aperçu

738.1.2 Ajouter un diagramme d'accord à votre partition

738.1.3 Créer un diagramme d'accord personnalisé

738.1.4 Apparence du diagramme d'accord

738.1.5 Propriétés du diagramme d'accord

738.1.6 Style de diagramme d'accord

738.1.7 Voir également

738.2 Techniques de guitare

738.2.1 Ajouter un symbole de Bend à votre partition

738.2.2 Ajouter un symbole de Barre de trémolo à votre partition

738.2.3 Ajouter un Slide de guitare (Glissando) à votre partition

738.2.4 Ajouter une Ligne de capodastre (en V4.0.2) ou Ligne de barré (en V4.1) à votre partition

738.2.5 Ajouter des symboles de "hammer-on" (liaison ascendante) et de "pull-off" (liaison descendante) à votre partition

738.2.6 Notation des harmoniques

738.2.7 Notation du doigté de la guitare

738.3 Créer une portée de tablature

738.3.1 Aperçu

738.3.2 Types de portées de tablature

738.3.3 Ajouter une tablature à votre partition

738.3.4 Créer une combinaison de portées standard et tablature

738.4 Saisir et éditer la notation de tablature

738.4.1 Saisir avec le clavier de l'ordinateur

738.4.2 Saisir avec la souris de l'ordinateur

738.4.3 Sélectionner la durée de la note

738.4.4 Notation de tablature ancienne

738.4.5 Modifier la notation de la tablature

738.5 Personnaliser une portée de tablature

738.5.1 Modifier le réglage d'accord

738.5.2 Ajouter ou supprimer des cordes

738.5.3 Marquer la corde non frettée "à vide"

738.5.4 Changer le nombre de frettes de l'instrument

738.5.5 Modifier le type de portée de tablature

738.5.6 Personnaliser l'apparence de la tablature

738.6 Appliquer un capodastre

738.6.1 Aperçu

738.6.2 Appliquer un capodastre à votre partition

738.6.3 Ajuster les paramètres du capodastre

738.6.4 Changer le réglage du capodastre en cours de partition

738.7 Bends de guitare

738.7.1 Ajouter des bends à votre partition

738.7.2 Remarques générales sur les bends dans MusScore

738.7.3 Appliquer un bend

738.7.4 Modifier des bends

738.7.5 Ajouter des bends à des accords

738.7.6 Personnaliser le style des bends

738.8 Réglages alternatifs d'accord des cordes

738.8.1 Appliquer des instructions d'accord des cordes

738.8.2 Spécifier les réglages d'accord de cordes

738.8.3 Les réglages d'accord alternatifs affectent les positions de frette

738.8.4 Lire les hauteurs transposées sur la portée standard

739 Notation spécialisée : Harpe

739.1 Vue d'ensemble

739.2 Ajouter un diagramme de pédales de harpe à votre partition

739.3 Lire des diagrammes de pédales de harpe

740 Notation spécialisée : Percussions

740.1 Saisie et modification de la notation des percussions

740.1.1 Vue d’ensemble

740.1.2 Saisir des notes et des silences dans des portées de percussions

740.2 Personnalisation du set de batterie

740.2.1 Introduction

740.2.2 Personnaliser la définition du set de batterie [PROJET]

740.2.3 Sauvegarder et charger les définitions du set de batterie [PROJET]

740.3 Autres notations des percussions

740.3.1 Coups doubles

740.3.2 Lignes de pédale

740.3.3 Roulements

740.3.4 Sticking (doigté de batterie)

741 Notation alternative

741.1 Notation pour musique ancienne et Mensurstrich

741.1.1 Ajouter une indication mesurée à votre partition

741.1.2 Travailler avec une musique non mesurée

741.1.3 Travailler avec une notation Mensurstrich

741.1.4 Afficher les valeurs de notes dépassant les frontières de mesure

741.2 Notation avec des Slashs

741.2.1 Remplir une sélection avec des slashs rythmiques

741.2.2 Créer une notation rythmique avec slashs

741.3 Types de portées personnalisées

741.3.1 Vue d'ensemble

741.3.2 Personnaliser l'apparence des lignes de portée

741.3.3 Personnaliser l'apparence d'éléments générés

Manuel de MuseScore 4 https://musescore.org/fr/print/book/export/html/329209?toc=1#undefin...

22 sur 199 04/07/2025, 12:24



741.3.4 Personnaliser l'apparence des notes

741.3.5 Modifier le type de portée en cours de partition

741.3.6 Liens externes

742 Texte

742.1 Saisir et éditer du texte

742.1.1 Vue d’ensemble

742.1.2 Types de textes

742.1.3 Ajouter du texte à une partition

742.1.4 Supprimer des objets texte d'une partition

742.1.5 Éditer le contenu d'un objet Texte

742.2 Mettre en forme du texte

742.2.1 Vue d’ensemble

742.2.2 Modifier la mise en forme des caractères

742.2.3 Modifier la mise en forme d'un objet texte

742.2.4 Modifier les valeurs dans un style

742.3 Texte de portée, texte de système et texte d'expression

742.3.1 Vue d’ensemble

742.3.2 Ajouter un texte de portée à votre partition

742.3.3 Ajouter un texte d’expression à votre partition

742.3.4 Ajouter un texte de système à votre partition

742.3.5 Répéter un texte de système sur les autres portées

742.3.6 Propriétés

742.3.7 Style

742.4 Indications de tempo

742.4.1 Vue d’ensemble

742.4.2 Ajouter des indications de tempo à votre partition

742.4.3 Modifier l’apparence

742.4.4 Modifier la lecture

742.4.5 Répéter l’indication de tempo sur les autres portées

742.4.6 Propriétés des indications de tempo

742.4.7 Style de tempo

742.4.8 Liens externes

742.5 Paroles

742.5.1 Vue d’ensemble

742.5.2 Ajouter des paroles à votre partition

742.5.3 Éditer des paroles existantes

742.5.4 Supprimer des paroles

742.5.5 Saisir les paroles au-dessus de la portée

742.5.6 Modifier la numérotation des couplets

742.5.7 Copier des paroles

742.5.8 Propriétés des paroles

742.5.9 Style des paroles

742.6 Doigtés

742.6.1 Types de doigtés

742.6.2 Ajouter un doigté à votre partition

742.6.3 Ajuster la position du doigté

742.6.4 Modifier l’apparence des éléments de doigté

742.6.5 Propriétés des éléments de doigté

742.6.6 Style des éléments de doigté

742.6.7 Voir aussi

742.7 Symboles d'accord

742.7.1 Vue d’ensemble

742.7.2 Ajouter un symbole d’accord dans votre partition

742.7.3 Vue d'ensemble de l'apparence et de la fonction

742.7.4 Aligner les symboles d’accord

742.7.5 Transposer les symboles d’accord

742.7.6 Modifier la notation des symboles d’accord

742.7.7 Modifier l’apparence

742.7.8 Modifier la lecture des symboles d’accord

742.7.9 Propriétés des symboles d’accord

742.7.10 Style des symboles d’accord

742.7.11 Liens externes

742.8 Basse chiffrée

742.8.1 Vue d’ensemble

742.8.2 Ajouter une indication de basse figurée à votre partition

742.8.3 Propriétés des indications de basse chiffrée

742.8.4 Style des indications de basse chiffrée

742.8.5 Raccourcis clavier de basse chiffrée

742.9 Repères

742.9.1 Vue d’ensemble

742.9.2 Ajouter un repère à votre partition

742.9.3 Utiliser des numéros de mesure dans les repères

742.9.4 Remettre les repères dans l’ordre

742.9.5 Rechercher des repères

742.9.6 Répéter les repères dans les autres portées

742.9.7 Modifier l’apparence des repères

742.9.8 Propriétés des repères

742.9.9 Style des repères

742.9.10 Liens externes

742.10 En-tête et pied de page

742.10.1 Vue d’ensemble

742.10.2 Ajouter un en-tête ou un pied de page dans votre partition

742.10.3 Utiliser des métadonnées

742.10.4 Modifier la façon dont les en-têtes et pieds de pages sont affichés

742.10.5 Propriétés des en-têtes et pieds de pages

742.10.6 Style des en-têtes et pieds de pages

742.11 Blocs de texte

742.11.1 Vue d’ensemble

742.11.2 Ajouter un bloc de texte à une partition

742.11.3 Modifier l’apparence des blocs de texte

742.11.4 Propriétés du bloc de texte

742.11.5 Style de bloc de texte

742.11.6 Voir aussi

743 Mise en page

743.1 Notions de mise en page

743.1.1 Aperçu

743.1.2 Définitions

743.2 Positionner les éléments
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743.2.1 Aperçu

743.2.2 Position par défaut

743.2.3 Auto-placement

743.2.4 Ajustement manuel

743.2.5 Alignement manuel

743.3 Taille et espacement de la partition

743.3.1 Aperçu

743.3.2 Paramètres de page

743.3.3 Paramètres de style

743.3.4 Propriétés de portée/partie

743.4 Espacement horizontal des systèmes

743.4.1 Aperçu

743.4.2 Fonctionnalités

743.4.3 Utilisation pratique

743.5 Espacement vertical des pages

743.5.1 Fonctionnalités

743.5.2 Utilisation pratique

743.6 Utiliser des cadres pour ajouter du contenu

743.6.1 Vue d’ensemble

743.6.2 Usages des cadres

743.6.3 Ajouter des cadres avant, entre ou après un système

743.6.4 Ajouter des cadres entre des mesures

743.6.5 Voir aussi

743.7 Utiliser des images

743.7.1 Ajouter des images

743.7.2 Propriétés d'image

743.7.3 Voir aussi

743.8 Utiliser des sections pour séparer mouvements ou chansons

743.8.1 Vue d’ensemble

743.8.2 Ajouter un saut de section

743.8.3 Propriétés de saut de section

744 Son et lecture sonore de la partition

744.1 Commandes de lecture

744.1.1 Vue d'ensemble

744.1.2 Commandes de lecture

744.1.3 Autres commandes

744.1.4 Liens externes

744.2 Mélangeur

744.2.1 Aperçu

744.2.2 Ouvrir le mélangeur

744.2.3 Contrôles du mélangeur

744.2.4 Son

744.2.5 FX Audio

744.2.6 Aux sends

744.2.7 Aux channels

744.2.8 Voir également

744.3 SoundFonts

744.3.1 Aperçu

744.3.2 Installer une SoundFont

744.3.3 Utiliser les sons d'une SoundFont

744.3.4 Éditer des SoundFonts

744.3.5 Désinstaller une SoundFont

744.3.6 Informations sur le lecteur Zerberus et les SFZ

744.3.7 Voir également

744.4 Installer les sons Muse Sounds

744.4.1 Installer les Muse Sounds via Muse Hub

744.4.2 Utiliser les Muse Sounds dans MuseScore

744.4.3 Sons disponibles dans Muse Sounds

744.4.4 Lien externe

744.5 Lecture avec capodastre

744.5.1 Aperçu

744.5.2 Ajouter une indication de capodastre à votre partition

744.5.3 Voir également

744.6 Lecture du swing

744.6.1 Aperçu

744.6.2 Ajouter une indication de jeu Swing ou Linéaire à votre partition

744.6.3 Modifier la lecture du swing

744.7 Working with MIDI [EN, PROJET]

744.8 Travailler avec les plugins VST et VSTi

744.8.1 Introduction aux VST

744.8.2 Installer des VST

744.8.3 Activer, désactiver, supprimer et remplacer les plugins VST

745 Gestion des fichiers

745.1 Ouvrir et enregistrer les partitions

745.1.1 Vue d’ensemble

745.1.2 Ouvrir une partition

745.1.3 Formats d’importation de fichiers

745.1.4 Enregistrer une partition

745.1.5 Lien externe

745.2 Exportation de fichiers

745.2.1 Vue d’ensemble

745.2.2 Exporter votre partition

745.2.3 Formats de fichier

745.3 MIDI import [EN, PROJET]

745.4 Travailler avec des fichiers MusicXML

745.4.1 Vue d'ensemble

745.4.2 Ouvrir un fichier MusicXML

745.4.3 Nettoyer une partition importée

745.4.4 Préparer l'export d'une partition

745.5 Backup and recovered files [EN, PROJET]

745.6 Propriétés des partitions

745.6.1 Vue d’ensemble

745.6.2 Modifier les propriétés de la partition

745.6.3 Ajouter de nouvelles propriétés

745.6.4 Accéder aux propriétés de votre partition

745.7 Score comparison [EN, PROJET]

745.8 Publier sur musescore.com

745.8.1 Vue d’ensemble
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745.8.2 Créer un compte MuseScore

745.8.3 Sauvegarder uniquement sur Musescore.comh4>

745.8.4 Publier les partitions enregistrées localement

745.8.5 Visibilité dans le gestionnaire de partitions

745.8.6 Gérer la création de mp3 pendant la sauvegarde

745.9 Partager sur Audio.com

745.9.1 Vue d’ensemble

745.9.2 Pour partager un fichier audio à partir de votre partition sur Audio.com

746 Personnalisation

746.1 Langue

746.1.1 Vue d'ensemble

746.1.2 Changer de langue

746.1.3 Mettre à jour les traductions

746.1.4 Voir aussi
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746.2.1 Vue d'ensemble
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746.5.1 Aperçu
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746.5.5 Personnaliser le contenu des palettes

746.5.6 Sauvegarder et charger des palettes

746.5.7 Menu des palettes

746.5.8 Propriétés des palettes

746.5.9 Voir aussi

746.6 Espaces de travail

746.6.1 Vue d’ensemble
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746.7 Raccourcis clavier

746.7.1 Vue d'ensemble

746.7.2 Définir un raccourci

746.7.3 Réinitialiser et effacer les raccourcis

746.7.4 Importer et exporter des raccourcis

746.8 Préférences [PROJET]

746.8.1 Général
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746.8.3 Canevas

746.8.4 Saisie de notes

746.8.5 Commandes d'un périphérique MIDI

746.8.6 Partition

746.8.7 Entrée/Sortie

746.8.8 Importation
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746.8.10 Mise à jour

746.8.11 Avancé

746.9 Plugins

746.9.1 Vue d’ensemble

746.9.2 Organiser les plugins

746.9.3 Démarrer un plugin [PROJET]

746.9.4 Plugins préinstallés

746.9.5 Créer un plugin

746.9.6 Voir aussi

747 Support

747.1 Getting help [EN, PROJET]

747.1.1 Overview

747.1.2 Learn

747.1.3 Forums

747.1.4 Issue tracker

747.1.5 GitHub

747.1.6 Mastering MuseScore

747.2 Revert to factory settings [EN, PROJET]

747.2.1 Overview

747.2.2 Reverting to factory settings from the menu

747.2.3 Reverting to factory settings from the command line

747.3 Troubleshooting [EN, PROJET]

747.3.1 Installation issues

747.3.2 Score issues

747.3.3 Display issues

747.3.4 Sound issues

747.3.5 Printing issues

747.4 Known incompatibilities [EN, PROJET]

748 Annexes
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748.2 Known incompatibilities [EN, VIDE]
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748.3.4 Sélection

748.3.5 Édition
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748.4 Mise à niveau depuis MuseScore 3.x

748.4.1 Vue d'ensemble

748.4.2 Raccourcis clavier

748.4.3 Autres modifications

748.4.4 Fonctionnalités manquantes

748.5 Glossaire
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Manuel de MuseScore 4

À propos du manuel

Ce manuel concerne MuseScore version 4.0 et ultérieure. Si vous utilisez une version précédente, consultez le manuel correspondant à votre version :

Manuel de MuseScore 3
Manuel de MuseScore 2
Manuel de MuseScore 1

Ce manuel est maintenu et traduit par la communauté MuseScore. Les contributions sont les bienvenues ! En cas de doute, veuillez consulter la version originale en anglais du manuel , ou demander de l'aide dans le forum Questions
générales .

Si vous faites une mise à jour depuis MuseScore 3, consultez les pages suivantes (en anglais) :

Mise à niveau depuis MuseScore 3.x (inclut une liste des raccourcis clavier qui ont changé)
MuseScore 3 features not (yet) implemented in MuseScore 4

Explorer le manuel

Utilisez les liens ci-dessous pour explorer le contenu de chaque chapitre du manuel.

Pour rechercher des informations :

Essayez de parcourir le Glossaire illustré ou des notations musicales que vous êtes incapable de nommer.
Ouvrir la "Table des matières", utilisez la fonction "Rechercher dans la page (Ctrl/Cmd⌘ + F)" de votre navigateur Web, ou,
Utilisez cette syntaxe de recherche Google site:musescore.org votre sujet, par exemple site:musescore.org tempo , ou,

Utilisez la fonction de recherche comme indiqué sur la capture d'écran ci-dessous.

Si vous ne trouvez pas les informations dont vous avez besoin dans le manuel, vous pouvez demander de l'aide dans le forum Questions générales .

Téléchargez le manuel et créez un PDF

Vous pouvez consulter le manuel entier sous forme d'une seule page continue, et utilisez la fonction d'impression de votre navigateur pour transformer cette page en PDF pour une consultation hors ligne.

Liens vers les chapitres et la table des matières

Table des matières

À propos du manuel

Versions de MuseScore couvertes

Ce manuel est valide pour les versions MuseScore 4.0 et suivantes.

Si vous utilisez une version différente du programme, merci de consulter la manuel approprié à votre version :

Manuel MuseScore 3
Manuel MuseScore 2
Manuel MuseScore 1

Explorer le manuel

Parcourir les chapitres

Utilisez les liens de la page principale  pour explorer le contenu de chaque chapitre du manuel.

Il existe aussi une vue en page unique du manuel complet qui peut être utilisée avec l'outil de recherche de votre navigateur (raccourci : Ctrl+F ou Cmd+F sur macOS).

Faire une recherche dans le manuel

Pour faire une recherche dans le manuel, utilisez le champ de recherche dédié, situé en haut à droite de chaque page du manuel.

Si vous n'êtes pas sûr(e) de savoir ce qu'il faut chercher, essayer de parcourir le Glossaire. Il affiche des images pour vous aider à trouver des choses que vous ne savez pas nommer.

Vous pouvez aussi tenter une recherche sur le web en utilisant cette syntaxe spéciale pour n'inclure que les résultats de MuseScore.org  :

site:musescore.org votre sujet ici

Cela fonctionne avec la majorité des moteurs de recherche. Par exemple, recherche Google pour "site:musescore.org indicateurs tempo" .

Si vous continuez à ne pas trouver l'information, merci de demander de l'aide dans un Forum .

Lire dans une langue différente

La manuel est traduit en plusieurs langues mais les traductions ne sont pas toujours à jour avec la version anglo-saxonne. Les pages sont traduites de façon individuelles de façon à ce que toutes les pages soient accessibles dans toutes les
langues.

Pour lire le manuel dans une langue différente, utilisez le menu déroulant affiché en haut de chaque page, directement sous le champ de recherche. Si vous ne trouvez pas une langue particulière, c'est que la page n'a pas encore été traduite
dans cette langue.
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En cas de doute, merci de consulter la version anglaise du manuel  ou de demander de l'aide dans un des forums . Utilisez le forum Support and bug reports  si vous faites un post en anglais ; dans les autres cas, utilisez un des forums
appropriés à votre langue.

Télécharger le manuel

Pour conserver une copie du manuel dans votre ordinateur afin de le consulter hors ligne :

Visitez la vue en page unique du manuel complet
Ouvrez la fonction Imprimer de votre navigateur (raccourci : Ctrl+P or Cmd+P sur macOS)
Choisissez l'option Enregistrer au format PDF ou équivalent

Vérifiez que vous sauvegardez un fichier et non pas que vous imprimez une version papier.

Si vous avez besoin d'une version papier, il est préférable de suivre les étapes précédentes pour commencer à créer une version PDF puis de vérifier que le PDF est formaté correctement avant de l'imprimer sur une imprimante réelle. Le
manuel est plutôt long, aussi n'imprimez que ce qui est vraiment nécessaire.

Contribuer au manuel

Le manuel est mis à jour et traduit par la communauté MuseScore. Si vous souhaitez aider à en écrire le contenu, merci de lire Éditer le Manuel.

Si vous souhaitez contribuer à la traduction des pages, merci de lire How to translate the handbook  [en anglais].

Éditer le manuel

Recommandations pour l’écriture d’articles

Vous pourriez avoir envie de contribuer à l'écriture du manuel de MuseScore 4 – super ! Et bienvenue.
Cette page résume les recommandations à suivre pour vous permettre de commencer à écrire des articles. Merci de la lire avec attention avant d’éditer quoi que ce soit dans notre manuel. Ces informations sont destinées à vous aider mais,
en cas de doute dans n’importe quel domaine, n’hésitez pas poser vos questions dans le forum Documentation .

Structure – Principes généraux

Chaque page doit décrire un sujet de façon plus ou moins complète. Si vous sentez que la page devient trop longue, essayez de la diviser en pages séparées.
Toutes les pages ne sont pas identiques mais il est important de garder à l’esprit les conseils suivant de façon à faciliter la compréhension pour le lecteur :

Commencer avec une vue d’ensemble

Commencez la page avec une vue d’ensemble afin d’introduire le sujet avant d’entrer dans les détails. Cette partie n’a pas forcément besoin d’un titre de chapitre.

Établir une hiérarchie

Essayez d’imaginer ce que la plupart des utilisateurs peuvent chercher à réaliser et pourquoi ils peuvent avoir besoin de rechercher des informations dans le manuel. Fournissez les solutions pour les tâches les plus communes en début de
page. Celles qui sont moins usuelles peuvent être déplacées en bas de page.

Grouper les informations de façon logique

Les éléments qui sont en relation devraient être présentés ensemble. Cela peut parfois nécessiter de discuter de fonctionnalités peu utilisées en même temps que celles qui sont d’emploi courant, mais c’est ainsi.

Mettre en avant l’application par l’utilisateur plutôt que la description de l’interface utilisateur

Par exemple, une section "Créer des armures personnalisées" est préférable à "Utiliser la palette principale".

Créer un sommaire

Vérifiez que l’option "Generate a table of contents (toutes les langues)" [générer un sommaire] est cochée pour toutes les pages du manuel.

Titres

Afin d’assurer une homogénéité de style pour les pages rédigées par la communauté, des titres sont déjà fournis pour de nombreuses pages. Merci de respecter cette structuration. Pour les pages où ces titres manquent, vous êtes libres
d’en créer, dans un style similaire à ce qui a été utilisé dans les autres pages.

Pour des raisons d’accessibilité, les titres ne doivent jamais être écrits en caractères gras. Ils nécessitent d’être mis en forme comme des étiquettes à valeur sémantique.

Toutes les pages commencent par défaut avec un titre de niveau 1 (Titre 1). L’en-tête de la première section que vous saisirez sera toujours, par conséquent, de niveau 2 ((Titre 2). Assurez-vous de ne pas sauter de niveau (par exemple en
passant à un niveau 4 après un niveau 2).

Niveau Utilisation Syntaxe MarkDown

Titre 1 Style par défaut pour chaque titre de page. (non éditable par les contributeurs)

Titre 2 Style à utiliser pour le début de chaque section. ## Libellé du titre

Titre 3
Style à utiliser pour le début de chaque sous-section et pour introduire des
instructions en une seule étape (par exemple, lorsqu’une liste n’est pas
nécessaire).

### Libellé du titre

Titre 4
Style à utiliser avec modération si des sous-sections supplémentaires sont
nécessaires.

#### Libellé du titre

Enfin, essayez de toujours commencer vos titres par un verbe. Par exemple : "Ajouter des indications de mesure" plutôt que "Indications de mesure".

Contenu

De façon générale, le manuel MuseScore contient deux principaux types d’informations : descriptions et instructions pratiques.

Descriptions

Un contenu descriptif est utilisé pour expliquer les différentes zones du programme. Par exemple :
Une palette est un répertoire contenant des symboles musicaux qui peuvent être utilisés dans la partition. Les palettes par défaut de MuseScore contiennent des collections de symboles de la même famille mais vous pouvez personnaliser
les palettes pour afficher à peu près tout type de symbole, ligne ou objet texte.

Le contenu descriptif tend à être un peu plus long et « étoffé » que les instructions pratiques d’emploi mais nous vous demandons également d’utiliser, chaque fois que possible, un langage clair et compréhensible .

Instructions pratiques

Il s’agit ici d’expliquer comment réaliser une tâche spécifique. Les instructions doivent être aussi courtes et directes que possible, prenant généralement la forme de listes numérotées. Par exemple :
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Pour créer une nouvelle palette :

Ouvrez l’onglet palettes
Cliquez sur Ajouter des palettes
Cliquez sur Créer une palette personnalisée
Donnez un nom à votre nouvelle palette et cliquez sur Créer.

Remarquez que nous utilisons du texte en caractères gras pour nommer les composants de l’interface utilisateur, y compris les menus. Les raccourcis clavier comme Ctrl+S, sont mis en forme avec la balise <kbd> (voir Syntaxe).

Quand vous rédigez des instructions pratiques, veillez à :

N’utiliser que des listes numérotés (pas de points)
Commencer chaque instruction numérotée par un verbe
N’écrire qu’une tâche/consigne par élément numéroté.

Par exemple, au lieu d’écrire cela :

Ouvrez l’onglet palettes et cliquez sur Ajouter des palettes

écrivez ceci :

Ouvrez l’onglet palettes
Cliquez sur Ajouter des palettes

Pensez à inclure les raccourcis clavier dans les instructions pratiques, s’ils existent. C’est particulièrement important pour améliorer l'accessibilité du programme.

Utiliser des médias non écrits

L’utilisation d’un média non écrit est encouragée en complément des descriptions écrites. Cela comprend :

Des images GIF animées
Des copies d’écran des parties pertinente de l’interface utilisateur.

Créer des images GIF animées

Les images GIF animées apportent de nombreux avantages ^par rapport aux copies d’écran et aux vidéos dans le sens où elles illustrent dans un minimum de temps les actions requises pour accomplir une tâche particulière. Il existe de
nombreux outils disponibles pour créer des GIF ; nous recommandons toutefois le plan de travail suivant pour garantir une image claire et nette tout en minimisant le plus possible la taille du fichier (idéalement < 2 MB par GIF).
* Utilisez uniquement l’interface MuseScore et réglez son apparence en mode sombre avec surlignage bleu (pour permettre l’harmonisation tout au long du manuel)
* Planifiez et répétez à l’avance les clics de souris et les raccourcis clavier que vous utiliserez dans l’objectif de démontrer les étapes requises dans un temps aussi court que possible (idéalement : 10 sec.)
* Utilisez un outil libre tel que gifcap  pour enregistrer le contenu de votre écran
* Utilisez un outil libre tel que KeyCastr  pour enregistrer les touches de clavier (si nécessaire)
* Ne montrez que la partie de l’interface utilisateur nécessaire pour la démonstration de l’action.

Faire des liens vers d’autres pages

Il est vraiment utile de faire des liens vers les autres pages du manuel. Vous devriez le faire dès lors que vous mentionnez une partie différente de l’interface, voire pour vous référer à des versions antérieures du manuel.

Il existe un processus spécifique pour ajouter des liens vers d’autres pages du manuel, qui permet une redirection précise sans tenir compte de la langue dans lequel la page est écrite.

Utiliser la bonne syntaxe

Utilisez le format :
[node:######,title="Nom de la page de redirection"]

ou, pour faire un lien vers un titre spécifique à l’intérieur d’une page :
[node:######,fragment="balise-du-titre",title="Nom de la page de redirection"].

Faire le lien vers le numéro de code de la page et non vers son URL

Pour trouver le numéro de code (du nœud) de la page :

Ouvrez la page souhaitée dans votre navigateur
Cliquez sur l’icône "trois points" en haut et à droite de la page
Cliquez sur Éditer dans le menu contextuel qui s’affiche
Cliquez sur la barre de recherche de votre navigateur pour lire l’URL.

Vous trouverez le numéro de code de page dans l’adresse URL visible dans cet écran d’édition (oui, il n’apparaît que dans ce mode). Elle ressemblera à peu près à cela :

Vous pouvez utiliser le programme (bookmarlet) suivant comme « marque-page » dans vos favoris

javascript:void function()
{prompt("",`[node:${drupalSettings.path.currentPath.replace("node/","")}${document.querySelector("meta[property=\"og:title\"]").content?`,title="${document.querySelector("meta[property=\"og:title\"]").content}"`:""}${window.location.hash?
`,fragment="${decodeURIComponent(window.location.hash).replace("#","")}"`:""}]`)}();

Source : node,title,fragment bookmarklet .

Pour créer le favori :
1. Surlignez les lignes de code
2. Faites-les glisser vers votre barre de favoris
3. Renommez si besoin ce favori (exemple : "Lien page MuseScore")

Pour utiliser le favori :
1. Ouvrez la page à référencer dans votre navigateur
2. Cliquez sur le favori créé à l’étape précédente (exemple : "Lien page MuseScore"), ce qui affiche le lien de la page en syntaxe MarkDown
3. Copiez/collez ce lien dans la page que vous rédigez

Syntaxe

Le manuel est essentiellement écrit en langage MarkDown, avec quelques balises HTML autorisées.

Si vous n’êtes pas familier avec MarkDown, il n’est pas long à apprendre. Commencez par lire cette page .

Remarque : un compte MuseScore est requis pour voir correctement le contenu de cette page. Notez qu'il n'est plus possible d'utiliser de l’HTML filtré.

Quelques exemples pour débroussailler MarkDown :

Touches
<kbd><kbd>A</kbd></kbd> affiche A (voir Écrire des raccourcis clavier plus bas).

Combinaison de touches
<kbd><kbd>Maj</kbd>+<kbd>A</kbd></kbd> affiche Maj+A (voir Écrire des raccourcis clavier plus bas).

Boutons
<kbd><samp class="button">Propriétés de style avancé…</samp></kbd> affiche Propriétés de style avancé… mais cette forme particulière n’est normalement pas utilisée dans le manuel MuseScore 4 (utilisez à la place des caractères gras
pour du texte qui apparaît dans le programme).

Accès au Menu
__Fichier &rarr; Ouvrir__ affiche Fichier → Ouvrir

Images
<img src="URL image" alt="Description de l’image ou du nom de ficher" width="500px"/> peut être utilisé de façon alternative à la commande inline quand la largeur de l’image a besoin d’être spécifiée.

Écrire des raccourcis clavier

Utilisez la syntaxe <kbd> décrite plus haut et suivez les consignes suivantes :

Pour des raisons d’accessibilité, utilisez toujours des mots plutôt que des symboles dans les noms des touches espace, touches fléchées et touches spéciales.

Bon : Cmd+Espace ; Win+Entrée ; Maj+Tab

Mauvais : ⌘+  ; ⊞+⏎ ; ⇧+↹

Pour les touches qui représentent des caractères imprimables, utilisez le caractère approprié (par exemple : écrire $ et non Dollar).

Utilisez les abréviations communes comme Ctrl, Cmd, Echap, Suppr. N’abrégez pas les noms de touches qui ne sont pas habituellement abrégés (exemple : Page bas).

Manuel de MuseScore 4 https://musescore.org/fr/print/book/export/html/329209?toc=1#undefin...

28 sur 199 04/07/2025, 12:24

https://musescore.org/fr/print/book/export/html/329209?toc=1#undefined-syntax
https://musescore.org/fr/print/book/export/html/329209?toc=1#undefined-syntax
https://gifcap.dev/
https://gifcap.dev/
https://github.com/keycastr/keycastr
https://github.com/keycastr/keycastr
https://musescore.org/fr/node/339996
https://musescore.org/fr/node/339996
https://musescore.org/fr/node/350722
https://musescore.org/fr/node/350722


Sauf exception, préférez Entrée plutôt que Retour et Suppr au lieu de Retour arr..

Pour les combinaisons, saisissez les touches spéciales dans cet ordre : Win+Ctrl+Alt+Maj+Fn+… (Mac : Ctrl+Cmd+Option+Maj+Fn+…).

En cas de doute, consultez Raccourcis clavier par défaut pour voir la façon officielle d’écrire les noms des touches et leurs combinaisons.

Laisser un message de révision

Enfin, si vous avez modifié une page (que ce soit de façon importante ou non), laissez un message concis qui décrit brièvement les modifications apportées. Par exemple :

Ajout contenu sur xxx
Ajout images
Correction de contenu
Ajout de balises clavier.

Laissez cette information dans le champ Message dans le journal de révision (toutes langues) en fin de fenêtre Edit de chaque page :

Présentation de MuseScore 4

Téléchargement et installation

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

MuseScore Studio est un logiciel totalement libre. Ses utilisateurs n'ont pas l'obligation de souscrire à un service PRO ou PLUS pour l'utiliser. Musescore Studio est publié sous la licence publique GNU version 3 (voir détails de GPLv3 sur
http://www.gnu.org ). "Musescore Studio" est le nouveau nom de "MuseScore": voir online announcement  [en anglais].

De plus, les droits de redistribution aux amis et étudiants (du programme binaire non modifié) est accordé à tous - voir la page en anglais "you may give any of the versions of MuseScore on musescore.org to other people, or share it
internally via a server" sur https://musescore.org/en/faq#faq-20204  . Pour proposer légalement un service payant supplémentaire, lire les termes de GPLv3.

Pour choisir la version qui vous convient le mieux, voir le chapitre MuseScore, MuseScore 3, MuseScore 4  du manuel MS3 [en anglais].

Windows

Quelques éléments basiques de connaissances informatiques :

Afficher les informations de votre matériel informatique
Connaître le logiciel de votre machine Windows 32-bit et 64-bit
Apprendre comment Installer des programmes à partir de sources en ligne sur Windows 10

Base de connaissance en lien avec MuseScore Studio :

Lire les prérequis système minimum pour MuseScore Studio  pour voir s'il peut être supporté par votre ordinateur
Connaître les nouveaux sons d'instruments virtuels beaux et gratuits Muse Sounds pour Musescore Studio, créés par Muse Group. Musescore Studio permet aussi d'accéder à deux autres méthodes basiques de lecture de sons :
SoundFonts et VSTi.
En apprendre plus sur la fonctionnalité optionnelle Muse Hub  [en anglais] créée par Muse Group et décider si vous en avez besoin ou non. Notez simplement qu'il est nécessaire d’utiliser Muse Hub pour accéder aux Muse Sounds.

Une des façons de télécharger et d'installer MuseScore Studio pour Windows est de le faire directement depuis https://musescore.org/fr/download .

Après téléchargement, faites un double clic le fichier téléchargé.
Lisez attentivement le texte et suivez les étapes

Pour désinstaller le programme, voir Désinstaller ou supprimer des applications et des programmes dans Windows . Sentez-vous libre de laisser un message sur https://musescore.org/fr/forum  de façon à ce qu'on puisse en tenir compte
pour améliorer le produit.

macOS

Le lien de téléchargement est sur la page Téléchargement .

Linux

AppImage

Installation

La meilleure façon d'installer le programme est d'utiliser une AppImage :

Aller sur la page Téléchargement
Sous Linux → AppImage (recommended), cliquer sur le lien Téléchargement (64 bits) ou, pour les distributions les plus récentes de Linux, cliquez directement sur Télécharger AppImage
Quand le téléchargement et complet, faites un clic droit sur l'AppImage et sélectionnez Properties
Basculez à l'onglet Permissions
La prochaine étapes est différente selon votre gestionnaire de fichiers :

Nautilus-based (Nemo, Files, Caja) : cochez la case “Allow executing file as program” .
Dolphin : cochez la case "Is executable".
Thunar : cochez la case “Allow this file to run as a program”.
PCManFM : modifiez l'option “Execute” dans la liste déroulante à “Anyone”.

Quittez la fenêtre de dialogue.
Réaliser un clic droit dans le répertoire où l'AppImage est installé et sélectionnez Open in Terminal
Dans le Terminal tapez, ./[nom de fichier] install (le point et la barre oblique du début sont importants !)

Les étapes 7 et 8 assurent qu'une entrée MuseScore apparaisse dans le menu du système et qu'il soit lié à la nouvelle localisation de l'AppImage (/home/[nom d'utilisateur]/.local/bin). Les associations correctes de fichier sont également
réalisées automatiquement.

Remarque : à la place des étapes 7 et 8 (ci-dessus), vous pouvez, bien sûr, faire l'installation en utilisant le chemin absolu du fichier. Autrement dit :

Ouvrez le Terminal
Tapez [chemin du fichier] install

Astuce : si vous réalisez une copie de l'AppImage et tapez Ctrl+Maj+V dans le terminal, cela saisira le chemin absolu du fichier qui vient juste d'être "copié".

Désinstaller

Aucune procédure formelle n'est nécessaire pour supprimer l'AppImage installée. Il suffit de supprimer les entrées de menu et tout raccourci ajouté manuellement puis de supprimer l'App elle-même et ses liens (qui seront dans ~/.local/bin).

Créez votre première partition

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Vue d'ensemble

Ce chapitre est un tutoriel de démarrage rapide destiné aux débutants absolus qui n'ont aucune connaissance sur ce logiciel de notation musicale. Il fait la démonstration du processus d'utilisation le plus basique. Plusieurs ressources de
leçons similaires seront disponibles en ligne : voir Getting help [en anglais].

Dans ce chapitre, nous verrons comment :

créer rapidement une nouvelle partition avec
une sélection prédéfinie d'instruments communs (modèle) de votre choix,
aucune altération (dièse ou bémol) dans l'armure,
une indication de mesure de 4/4 et
32 mesures ;

ajouter des notes et silences ainsi que d'autres objets de notation ;
écouter le résultat ;
ajuster les propriétés des objets de partition et notation et le nombre de mesures ;
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enregistrer le fichier de la partition dans un format de fichier natif , de façon à ce qu'il soit pleinement éditable quand on le réouvre dans MuseScore Studio ;
exporter les données de partition dans des formats non natifs comme PDF, MusicXML, MIDI, de façon à ce que d'autres applications puissent les utiliser. Ce n'est pas la façon recommandée pour sauvegarder une partition.

Créer rapidement une nouvelle partition

Quand vous ouvrez MuseScore Studio, aucun fichier n'est créé ou ouvert par défaut (sauf si vous avez changé les paramètres dans Préférences : Général : Lancement de programme). Vous avez besoin de créer une partition vide et la
première chose à faire est d'ajouter des portées vierges à l'aide du paramétrage des instruments. La voie la plus rapide est d'utiliser un modèle prédéfini.

Réalisez l'une des actions suivantes :
Dans l'onglet Accueil: Partitions, sélectionnez Nouvelle partition, ou cliquez sur le bouton Nouveau (en bas à droite).
Dans le menu, sélectionnez Fichier → Nouveau....
Utilisez le raccourci clavier Ctrl+N (Mac : Cmd+N).

Dans la fenêtre de dialogue Nouvelle partition qui apparaît, cliquez sur l’onglet Créer à partir d’un modèle et faites défiler les modèles par Catégorie ; ou utilisez la barre de rechercher pour rechercher directement un modèle.
Cliquez sur Fait pour créer votre nouvelle partition.

Apprenez-en davantage sur les instruments et sur la façon de les ajouter individuellement avec leur portées dans Configurer votre partition : Instruments.
Pour en savoir plus sur les modèles, voir Configurer votre partition : Créer à partir d'un modèle et Modèles et styles.

Saisir des informations sur la partition

Pour plus de simplicité, nous allons sauter ce paramétrage et utiliser les valeurs par défaut listées plus tôt mais il faut savoir que pouvez ajouter des paramètres telles que l'armure, l'indication de mesure, le tempo, l'anacrouse :

idéalement dans l'écran Informations additionnelles sur la partition pendant la création d'une nouvelle partition (dans la fenêtre de dialogue Nouvelle partition, cliquez sur Suivant plutôt que sur
Fait) ; voir le chapitre principal Configurer votre partition : Informations complémentaires sur la partition, ou bien
par différentes autres méthodes à n'importe quel autre moment ultérieur, comme celles traitées dans les chapitres Raccourcis clavier, Utiliser les palettes, Propriétés des partitions, etc.

Saisir des notes et des silences

Une nouvelle partition et automatiquement remplie avec des silences. Le mode de saisie des notes est basé sur la logique suivante : après que l'utilisateur a saisi une note ou un silence, les notes et silences suivants dans cette mesure
ajustent automatiquement leur durée (valeur de note ou de silence) sans affecter le nombre de total de temps de la mesure ; technique que l'on désigne sous le terme d'écrasement. Une des façons de saisir de nouvelles notes ou silences
dans MuseScore Studio est d'utiliser un clavier d'ordinateur. Elle a été conçue pour être similaire à la saisie des lettres dans un traitement de texte comme Microsoft Word :

Tapez la touche N pour entrer dans le mode de saisie des notes. Un curseur de saisie de notes apparaît sous la forme d'une grande et étroite boîte de couleur bleu clair avec une bordure gauche bleu foncé. Il recouvre l'ensemble de la
portée et indique que le mode de saisie de notes est en cours. Le curseur est positionné à l'emplacement du temps où la note ou le silence sera ajouté(e).
Pour les hauteurs de notes, tapez sur les lettres qui correspondent à la dénomination des notes en notation anglo-saxonne : A (La), B (Si), C (Do), D (Ré), E (Mi), F (Fa), G (Sol) ; pour un silence, tapez zéro (0).

La valeur (longueur) de note est à spécifier avant de tapez sa hauteur.

Assurez-vous d'être en mode saisie de notes comme expliqué ci-dessus
Cliquez sur la valeur de note souhaitée dans la barre d'outils Saisie de notes ou utilisez les chiffres du clavier 1 à 7 ainsi que la touche point .
Tapez une hauteur de note comme expliqué précédemment.

Vous êtes en train d'écrire de la musique dans MuseScore Studio ! Apprenez-en davantage sur ce sujet dans Saisir des notes et des silences.

Ajouter des objets à partir des palettes

Le panneau Palettes contient les objets de notation les plus couramment utilisés. Le panneau Palette est visible par défaut ; si ce n'est pas le cas, commencer par l'ouvrir en cochant Affichage → Palettes ou en tapant le raccourci clavier F9.
Pour en afficher le contenu, cliquez sur l'onglet Palettes sur la partie gauche de l'écran.

La façon la plus simple d’ajouter un objet de palette dans votre partition est de :

Sélectionner un objet existant (ou une série d’objets) dans votre partition (par exemple, une tête de note, une clef, une mesure, etc.)
Dans le panneau Palettes, ouvrir une palette en cliquant sur son bouton triangulaire
Cliquer sur l’objet de palette.
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Apprenez-en davantage sur ce sujet dans Utiliser les palettes.

Écouter le résultat

L'interpréteur de notation et le synthétiseur audio de MuseScore Studio permettent la lecture audio. Pour écouter la partition, tapez simplement Espace ou utilisez la barre de menu de lecture (voir Commandes de lecture).

Les indicateurs de nuance affectent la lecture des instruments en fonction des données de sons utilisées : SoundFonts, Muse Sounds, ou VSTi. Voir MuseScore 3 features not (yet) implemented in MuseScore 4 : Velocity controls  [en
anglais]. Quand un instrument utilise des SoundFonts tels que MS Basic (pour le réglage par défaut, voir le chapitre Mélangeur) et qu'aucun indicateur de nuance n'est ajouté dans la partition, toutes ses notes sont jouées mf (mezzoforte).

Quand aucune indication de tempo n'est présente, la lecture du morceau passages utilise par défaut un tempo équivalent à 120 noires par minute. Cette valeur par défaut pratique, décidée par les programmeurs de MuseScore Studio, peut
ne pas être identique à 120 battements par minute (au sens musical commun).

La lecture de passages non affectés par une indication de tempo utilise un rythme de 120 noires par minute.

Réaliser des ajustements dans le panneau Propriétés

Le panneau Propriétés est une version améliorée de l'Inspecteur  des précédents version de MuseScore Studio. Il affiche les propriétés de mise en forme et de lecture des objets sélectionnés ou des caractères sélectionnés à l'intérieur d'un
objet Texte. Si rien n'est sélectionné, il affiche les propriétés de la partition. Le panneau Propriétés est visible par défaut ; si ce n'est pas le cas, commencez par l'ouvrir en cochant Affichage → Propriétés ou en tapant F8. Pour afficher le
panneau, cliquez sur l'onglet Propriétés sur le côté gauche de l'écran (voir l'image plus haut).

Pour afficher et ajuster les propriétés de la partition :

Cliquez sur un espace vide dans la partition, en dehors des portées
Les propriétés sont affichées dans le panneau Propriétés ; ajustez-les comme souhaité.

Pour afficher et ajuster les propriétés d'un ou plusieurs éléments :

Cliquer sur le ou les élément(s) à sélectionner dans la partition ; chaque élément sélectionné est affiché dans une couleur qui dépend de la voix auquel il est assigné (bleu, vert, orange, violet)
Les propriétés sont affichées dans le panneau Propriétés ; ajustez-les comme souhaité.

Pour afficher et ajuster les propriétés de caractères sélectionnés dans un objet Texte :

Cliquez pour sélectionner un objet Texte dans la partition
Faites un double clic pour entrer en mode édition
Surlignez les caractères à sélectionner à l'aide de la souris ou du clavier (en utilisant Maj et les touches fléchées)
Les propriétés sont affichées dans le panneau Propriétés ; ajustez-les comme souhaité.

Apprenez-en davantage sur ce sujet dans les chapitres Sélectionner des éléments, le Panneau des propriétés et Saisir et éditer du texte.

Insérer et supprimer des mesures

Pour insérer une ou des mesure(s) :

Cliquez sur une mesure pour la sélectionner. La mesure sélectionnée est affichée dans un encadrement bleu
Dans la section panneau Propriétés : Mesures, cliquez sur Insérer des mesures
Sélectionnez le nombre de mesures souhaité et utilisez le menu déroulant pour changer le point d'insertion
Cliquez sur le bouton +.

Pour supprimer une ou des mesure(s) :

Sélectionnez la ou les mesures non souhaitées. Utilisez Maj + clic pour faire une sélection groupée (voir le chapitre Sélectionner des éléments)
Dans la section Mesures du panneau Propriétés, cliquez sur l’icône poubelle.

Apprenez-en davantage sur ce sujet dans le chapitre Ajouter et supprimer des mesures.

Enregistrer la partition

Sauvegarder la partition dans un fichier de format natif enregistre l'ensemble de ses propriétés. Elles sont également pleinement éditables quand on le réouvre dans MuseScore Studio. Les partitions peuvent être sauvegardées localement
ou dans votre espace MuseScore de stockage en ligne (cloud) qui est gratuit pour tout utilisateur enregistré. Voir aussi les chapitres Publier sur musescore.com et Partager sur Audio.com.

Pour enregistrer votre partition :

Sélectionnez Fichier → Enregistrer
Dans la fenêtre de dialogue qui apparaît, sélectionnez l'une des options

Enregistrer dans l'ordinateur, qui permet de sauvegarder la partition dans tout répertoire de son choix, ou
Enregistrer dans le cloud, qui sauvegarde la partition en ligne. Quand on enregistre en ligne, une copie locale supplémentaire est automatiquement créée pour fournir des possibilités d'édition hors ligne. Une partition en ligne
peut être réouverte via l'onglet Accueil : Partitions ; elle est signalée par un petit symbole bleu de nuage en haut à gauche dans la miniature de prévisualisation.

Remplissez les informations requises telles que le nom de fichier puis cliquez sur Enregistrer ou OK.

Apprenez-en davantage sur ce sujet dans le chapitre Ouvrir et enregistrer les partitions.

Exporter la partition

Exporter n'est pas la façon recommandée pour sauvegarder une partition : à la place, voir la section "Enregistrer la partition".

La fonction Exporter sauvegarde la partition dans un format que des applications autres que MuseScore Studio peuvent utiliser. Ces formats non natifs incluent PDF, MusicXML, MIDI, etc.

Pour exporter la partition entière :
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Sélectionnez l'onglet Publier
Cliquez sur Exporter
Sélectionner le format de fichier
Cliquez sur Exporter

Apprenez-en davantage sur ce sujet dans le chapitre Exportation de fichiers.

Nouvelles fonctionnalités de MuseScore 4

Si vous arrivez sur MuseScore 4 (devenu MuseScore Studio) depuis une version antérieure, vous noterez des changements, non seulement sur l’interface utilisateur (UI) mais aussi sur des fonctions familières et les moyens de réaliser les
actions. Ces changements étaient nécessaires pour améliorer l’expérience utilisateur tout en offrant une bien plus grande fonctionnalité. Voici un très court aperçu de quelques évolutions majeures.

Nouvelle interface utilisateur

MuseScore Studio est livré avec un nouvelle interface. Quasiment toutes les parties de l’application ont été complètement redessinées pour être plus claires et faciles à lire. On peut choisir entre un thème clair, foncé ou hautement contrasté
ainsi que définir facilement sa touche de couleur favorite. Les changements d’apparence de l’application peuvent être paramétrés dans Préférences.

Instruments et parties

Un nouveau panneau Instruments vous permet de cacher, réarranger et personnaliser vos instruments sans avoir à quitter la partition des yeux.

Le panneau d’instruments est finement intégré au processus de création de Parties afin de faciliter la création de partitions personnalisées avec n’importe quelle combinaison d’instruments disponibles. Il a aussi été ajouté un bouton
spécifique dans la barre de menu pour faciliter l’ouverture rapide de n’importe quelle partie disponible.

Inspecteur

L’Inspecteur des précédentes versions de MuseScore est désormais appelé panneau Propriétés. Chaque option de ce panneau a été réorganisée et l’expérience complètement rationalisée. Par défaut, le panneau Propriétés offre de
multiples options utiles, comme la possibilité d’afficher ou de masquer les portées vides ou d'autres symboles de musique. Alors qu'on avait besoin, auparavant, de sélectionner les types d’éléments isolés avant de pouvoir les modifier,
MuseScore Studio affiche en permanence les réglages concernés, sans tenir compte du nombre d’éléments sélectionnés.

Nouveau support de lecture et d’instruments virtuels

Les améliorations qui concernent la lecture de la musique constituent le changement majeur de MuseScore Studio. En plus d’une nouvelle bibliothèque d’échantillons (« Muse Sounds », disponible en téléchargement séparé), il est
maintenant possible de piloter des modules de VSTi (technologie de studio virtuel d’instruments sous forme de « plugins VSTi ») qui peuvent être appliqués aux instruments en utilisant le nouveau panneau Mélangeur. Le Mélangeur vous
permet de basculer aisément entre les VSTi, les Muse Sounds et les SoundFonts tout en supportant également l’utilisation d’effets virtuels (VSTfx). Les sons sont dorénavant systématiquement enregistrés en même temps que les notes, de
telle façon qu’il n’est plus nécessaire d’accéder au panneau Synthétiseur de MuseScore 3 (qui a été supprimé de MuseScore Studio). Si vous utilisiez précédemment des fichiers SFZ pour lire la musique dans MuseScore 3, nous vous
recommandons maintenant d’utiliser un échantillonneur VST gratuit, comme Sfizz  ou Sforzando  qui exploitent tous les deux le format d’instruments SFZ.

Améliorations d’écriture

MuseScore Studio apporte de nombreuses améliorations en termes d’écriture musicale dont certaines ont un effet sur l’apparence et la mise en page des partitions créées dans les précédentes versions. Le changement le plus significatif
concerne le placement des ligatures et liaisons, l’espacement horizontal et la mise en page. Il y a beaucoup trop de changements pour en faire la liste ici ; aussi ceux que cela intéresse d’en savoir davantage sur ces particularités sont invités
à consulter le document dédié (lien à venir) qui explique et illustre tout cela en détail.
Avoir apporté tant de changements à l’écriture a pour conséquence inéluctable de rendre impossible d’ouvrir une partition dans MuseScore Studio depuis une version antérieure de MuseScore tout en gardant un aspect identique.

Enregistrement en ligne

Quand on sauvegarde un fichier pour la première fois, il est demandé si l’on souhaite enregistrer le fichier sur l’ordinateur ou dans le cloud. Cette nouvelle option fait partie de l’excitant développement des services que nous sommes en train
de réaliser sur musescore.com. Pour en apprendre davantage, allez dans Ouvrir et sauvegarder des partitions et Publier sur musescore.com.

Autres changements

En utilisant le programme, vous trouverez de nombreux autres petits mais significatifs changements qui ont été apportés pour rendre beaucoup plus facile le processus de composition et d’écriture de la musique. Cela comprend :

Une plus grande barre de menu pour la saisie des notes, avec un accès en « un seul clic » pour les éléments fréquemment utilisés comme les triolets et les symboles d’articulation. Il y a aussi un menu “+” pratique qui vous permet
d'ajouter rapidement n’importe quel élément, depuis les notes et intervalles, jusqu’au cadres et objets de texte.
Des fonctionnalités faciles d’accès dans le panneau Propriétés qui vous permettent d’ajouter ou supprimer facilement des mesures et d’afficher ou cacher les portées vides.
Un nouveau et superbe Mélangeur.
Des améliorations dans la palette Indications de mesure.
Un expérience rationalisée pour le paramétrage de la langue dans l’application.
Un nouveau site avec des tutoriels vidéo (en anglais) pour apprendre comment obtenir davantage de l’application.

Affichage et navigation

Accessibilité

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Lecteurs d’écran

MuseScore Studio supporte les lecteurs d’écran suivants pour chaque système d’opération :

Windows 10 et 11 : Narrateur (Narrator) et NVDA
macOS : VoiceOver
Linux : Orca

La synthèse vocale avec JAWS fonctionne la plupart du temps mais la lecture n’est pas aussi complète qu’avec Narrateur ou NVDA.

Synthèse vocale sur Windows

Si la lecture par synthèse vocale s’arrête à un moment, essayez d’appuyer sur Alt+F pour ouvrir le menu Fichier puis deux fois sur Echap. pour retourner là où vous étiez dans l’application ; à ce moment, la lecture de l’écran devrait fonctionner
de nouveau. Il peut être nécessaire de faire cela si vous commencez la lecture d’écran après que MuseScore Studio a déjà commencé de fonctionner, par exemple.

Synthèse vocale sur macOS

Le mode de Navigation rapide  de VoiceOver doit être désactivé pendant l’utilisation de MuseScore Studio. Vous pouvez le désactiver en appuyant simultanément sur les touches ← et → pendant que VoiceOver fonctionne, ou vous pouvez
désactiver le mode de navigation rapide depuis les Commandeurs d’Utilitaire VoiceOver.

On peut naviguer dans l’interface de MuseScore Studio en utilisant le curseur de tabulation ainsi qu’avec le propre curseur de VoiceOver. En général, il est préférable d’utiliser le curseur tabulation car cela correspond à l’interface des autres
plateformes et c'est la modalité décrite dans la plupart des documentations et tutoriels. Le curseur de VoiceOver peut être utilisé pour atteindre des zones de l’application qui ne sont pas encore accessibles via le curseur tabulation. Quand
vous utilisez le curseur tabulation, rappelez-vous d’utiliser les touches fléchées aussi bien que la touche Tab pour naviguer (voir Naviguer dans l’interface utilisateur).

Synthèse vocale sur Linux

Sur Linux, il est nécessaire de démarrer le lecteur d’écran avant de lancer MuseScore Studio ; dans le cas contraire, les fonctionnalités d’accessibilité seront désactivées afin d’économiser des ressources système. Si vous oubliez de faire
cela, il suffit de quitter MuseScore Studio et de le lancer à nouveau. C’est la même chose pour toutes les applications Linux basées sur l’environnement Qt.

Orca est le lecteur d’écran le plus complet disponible pour Linux. Orca est construit dans l’environnement GNOME aussi, il est recommandé que les utilisateurs Linux qui ont des besoins d’accessibilité utilisent une distribution basée sur
GNOME ou un de ses dérivés.

Accès clavier

Naviguer dans l’interface utilisateur

La navigation dans l’interface utilisateur de MuseScore Studio repose sur l’utilisation des touches fléchées en plus de la touche tabulation. Appuyez sur la touche tabulation pour naviguer en boucle sur chaque groupe de commandes puis
utilisez les flèches pour naviguer vers une commande individuelle à l’intérieur du groupe. Ce nouveau système de navigation vous permet de naviguer partout dans l’interface avec un nombre de touches à appuyer beaucoup moins important
que quand la touche tabulation était utilisée pour accéder à chaque commande individuelle, comme cela est habituellement le cas dans les autres applications, y compris les versions précédentes de MuseScore. Le nouveau système de
navigation est encore en train d’être défini et les retours dans le Forum Développement  sont les bienvenus.

En plus des touches flèches et de tabulation, il existe un nouveau raccourci clavier F6 qui vous transportera entre les différents panneau à l’intérieur du programme. Voici comment fonctionnent de concert les raccourcis pour créer un système
hiérarchique de navigation :

Touches fléchées ↑, ↓, ← et → déplacent le focus d’une commande à l’autre à l’intérieur d’un groupe de commandes (exemple : naviguer entre les boutons d’une barre d’outils).

Tab et Maj+Tab déplacent le focus de l’intérieur d’un groupe de commande vers l’intérieur du groupe de commandes suivant (exemple : naviguer entre les barres d’outils).

F6 et Maj+F6 déplacent le focus entre les panneaux et les grandes sections de l’interface utilisateur (exemple : naviguer des barres d’outils vers les Palettes ou la vue partition).
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Une fois que vous avez navigué jusqu’à un bouton ou une commande, il est possible de l’activer dans la plupart des cas en appuyant sur la touche Espace ou Entrée. Dans les affichages de listes et d’autre objets, Espace est souvent utilisée
pour sélectionner les items plutôt que pour les activer. Une fois sélectionnés, certain items peuvent être supprimés en appuyant sur la touche Suppr ou modifiés en tabulant vers une autre commande de l’interface utilisateur qui devient active
une fois qu'un item a été sélectionné. Par exemple, cette approche peut être utilisée à l’intérieur du panneau Instruments pour supprimer des instruments que vous aviez précédemment ajoutés à la partition.

Naviguer dans la partition

La navigation à l’intérieur de la partition (par exemple dans la "vue Notation") est à peu près la même que ce qu’elle était dans MuseScore 3. Voici les raccourcis qui ont une valeur particulière pour les utilisateurs à besoin d’accessibilité :

Raccourci Action

Alt+→ et Alt+←
Déplacement vers l’élément précédent ou suivant. Ces raccourcis vous permettent d’atteindre tout type d’objets
de notation, pas seulement les notes et les silences.

Alt+↑ et Alt+↓
Déplacement vers le haut ou le bas. Ces raccourcis vous permettent de vous déplacer entre les notes individuelles
d’un accord et d’atteindre des notes et des silences dans les autres voix et dans les autres portées.

F2 ou Alt+Maj+E

Édition de l’élément sélectionné. C’est l’équivalent clavier du double-clic de souris sur un élément. Il vous permet
d’éditer des objets texte, y compris les paroles, les nuances et les indications de tempo. Il autorise aussi l’ajustement
de la longueur des éléments lignes comme les symboles crescendo/decrescendo, les liaisons, etc. (utilisez la touche
Tab pour changer la partie de la ligne que vous souhaitez ajuster). Quand l’édition est terminée, appuyer sur Echap.
pour revenir au mode Normal.

D’autres aspects de navigation au clavier sont décrits au travers des pages de ce manuel.

Tutoriels vidéo

Les tutoriels d’accessibilité suivants (en anglais) sont destinés à vous familiariser avec le fonctionnement de MuseScore, en utilisant votre clavier et le lecteur d’écran. Ils ne couvrent pas tous les aspects du programme mais sont susceptibles
de donner de solides bases qui vous permettront de profiter pleinement du reste de ce manuel.

Vidéo Description

Installing MuseScore
Cette vidéo relate l’installation de MuseScore Studio sur Windows, y compris Muse Hub et Muse Sounds. Le
processus est similaire sur macOS et Linux, bien que sur Linux vous devez installer Muse Hub et MuseScore Studio
de façon séparée.

Score setup
Cette vidéo montre le réglage initial de votre partition, y compris le choix des instruments, la sélection de l’armure, de
l’indication de mesure et autres réglages.

Entering music Cette vidéo affiche la saisie basique des notes.

Adding markings Cette vidéo couvre l’ajout de marques telles que les nuances dans votre partition, par l’utilisation des palettes.

The user interface
Cette vidéo vous guide à travers les principales fenêtres du programme pour vous aider à comprendre où sont les
différents panneaux, barres d’outils et commandes et comment les atteindre à partir du clavier.

L'interface utilisateur

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Barre de Menu

La barre de Menu de MuseScore Studio contient les menus suivants :

Fichier : créer un nouveau fichier, ouvrir et sauvegarder des fichiers, importer et exporter dans des formats variés, créer et éditer des parties d’instruments et imprimer
Édition : options pour annuler et rétablir, copier/couper/coller et fonctions Chercher / Aller à
Affichage : afficher ou masquer différentes palettes, fenêtres de dialogue et autres éléments d’espaces de travail. Les items du sous-menu Afficher ajuste l'affichage des éléments non imprimables :

Afficher les éléments invisibles : afficher/masquer les éléments selon leur paramétrage panneau Propriétés : Invisible. si cette option est cochée, les éléments invisibles sont affichés dans l'écran de la partition en gris léger.
Afficher la mise en page : afficher/masquer les symboles Espacement horizontal des systèmes : Sauts de système ou Espacement vertical des pages : Sauts de page
Afficher les cadres : afficher/masquer les bordures en pointillé des Cadres
Afficher les marges de pages : afficher/masquer les Taille et espacement de la partition : Paramètres de page.
Masquer les mesures irrégulières : un signe plus ou moins affiché en haut à droite de la mesure indique que sa durée est différente du paramétrage de l'indication de mesure.

Ajouter : ajouter différents types d’éléments de partition tels que notes, textes, mesures, etc.
Format : ajuster le formatage global et local de la partition. Vous permet aussi d’étirer ou de contracter la partition, de charger et sauvegarder des styles de partition et bien d’autres choses
Outils : de nombreuses commandes utiles sont disponibles ici dont transposer, échanger des voix, notation slash, etc.
Plugins : gestion de vos plugins
Aide : accès au manuel en ligne, signalement de bugs et expérience utilisateur, et restauration des paramètres par défaut

Les utilisateurs de clavier sur Windows et Linux peuvent accéder à ces menus en gardant la touche Alt appuyée et en l’associant à une certaine touche lettre ou chiffre, connue comme touche d’accès mnémotechnique (affichée comme
caractère souligné dans le nom du menu que vous êtes en train de rechercher). Par exemple, tapez Alt+F pour Fichier suivi par Alt+N pour Nouveau. Les lettres 'F' et 'N' sont surlignées dans l’interface utilisateur quand la touche Alt est
pressée.

Sur macOS, les menus de MuseScore Studio font partie du système étendu de barre de menu dans lequel vous pouvez naviguer en appuyant sur Ctrl+F2.

Onglet accueil

Au-dessous du menu principal il y a trois onglets dont le premier est intitulé Accueil. Cet onglet contient les sections suivantes:

Mon compte

Il sert à créer un nouveau compte MuseScore ou pour vous connecter à votre compte existant. Avec un compte actif, vous pouvez bénéficier d’une assistance technique et signaler des anomalies (bugs) dans les forums sur musescore.org .
Vous pouvez aussi sauvegarder vos fichiers en ligne sur le cloud musescore.com .

Partitions

Cette section vous permet de créer une nouvelle partition ou d’en ouvrir une. Apprenez comment créer de nouvelles partitions dans Configurer votre partition.

Plugins

Cette fenêtre affiche une liste des plugins disponibles. Voir la page sur les Plugins pour apprendre comment gérer ces modules pratiques.

Apprendre

C’est là que sont mis à disposition les tutoriels vidéo. Cliquez sur n’importe lequel pour l’ouvrir dans la chaîne YouTube officielle MuseScore .

Onglet Partition

C'est dans cette zone de MuseScore Studio que vous effectuerez la plus grosse partie de votre travail, dont l’ajout de notation musicale le lecture de votre partition. L’espace de travail est composé de différentes régions (numérotées dans les
étiquettes du diagramme suivant) :
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Parties : le bouton proche du centre haut de la fenêtre ouvre la fenêtre de dialogue Parties dans laquelle vous pouvez créer, éditer et supprimer des parties de partitions d’instruments.
Mélangeur : le bouton situé à droite de Parties ouvre et ferme le panneau Mélangeur.
Panneau de lecture : localisé à la droite de l’icône du mélangeur.
Barre d’outils de saisie de notes : étendue au-dessus des fenêtres du programme, elle inclut les éléments essentiels de notation utilisés dans l’écriture de partition. Utilisez la pour régler la durée de la note saisie, ajouter une altération,
appliquer les articulations courantes, saisir des divisions irrégulières et basculer entre les voix.
Barre latérale : la zone à gauche de l’écran contient plusieurs panneaux tels que Palettes, Propriétés et Instruments. Ils peuvent être cachés ou affichés selon vos souhaits.
Fenêtre Document/Partition : cette zone qui contient votre partition est le lieu où les éléments de notation sont ajoutés, édités et supprimés.
Barre de statut : elle court tout en bas de l'écran. La partie gauche affiche des informations utiles sur la partition quand un ou plusieurs éléments sont sélectionnés. La partie droite contient des commandes pour naviguer entre les
différents espaces de travail, sélectionner les vues en tonalité écrite ou réelle, spécifier la modalité d’affichage des pages et régler le facteur de zoom (grossissement).

Les utilisateurs de clavier peuvent utiliser la touche Tab ou F6 pour naviguer entre ces différentes zones avec le clavier. A l’intérieur de chaque zone, la navigation est opérée avec les touches fléchées du clavier et la touche Tab.

Quasiment tous les panneaux et barres d’outils peuvent être détachés et ancrés selon les besoins de votre projet et les préférences d’organisation du travail. Apprenez-en davantage sur ce sujet dans Espaces de travail et Barres d'outils et
fenêtres.

Onglet Publier

Cet onglet vous permet de voir votre partition sans l’encombrement de la barre d’outils de saisie des notes ou des panneaux latéraux. Il fournit des commandes pour imprimer la partition et l’exporter dans différents formats d’image, audio et
documents. Quand votre partition est terminée, vous pouvez aussi la publier dans musescore.com .

Menus contextuels

Dans certaines parties de l’application, principalement dans l’onglet partition, des menus contextuels sont disponibles avec des fonctionnalités additionnelles telles que des options pour copier, éditer, personnaliser, effacer ou afficher les
propriétés de tout élément ou groupe d’éléments qui sont sélectionnés au moment où le menu est ouvert.

Menus contextuels d’élément

A l’intérieur de la partition, chaque élément possède un menu contextuel. Pour ouvrir le menu contextuel d’un élément particulier, faites un clic droit sur l’élément avec la souris, ou sélectionnez l’élément via le clavier et tapez Maj+F10
(quelques claviers d’ordinateur ont aussi une touche Menu dédiée, proche de la touche Ctrl de droite). Les options disponibles dans le menu contextuel peuvent différer selon le type d’élément que vous avez sélectionné ; il est ainsi conseillé
d’expérimenter pour retrouver les différentes options disponibles pour chaque type différent d’élément. Par exemple, quand vous faites un clic droit sur une zone vide à l’intérieur d’une mesure, le menu contextuel qui s'ouvre contient les
options **Propriétés de la Portée / Partie ** et **Propriété de la mesure **. Cela est actuellement la seule façon pour atteindre ces options et les fenêtres de dialogue auxquelles elles conduisent.

Menu contextuels UI

En dehors de la partition, la présence d’un menu contextuel est souvent indiquée par un petit bouton avec des points de suspension (trois points) ou par une roue dentée. Cliquez sur le bouton pour ouvrir le menu.

Quelques fois, le bouton est associé à un autre élément du voisinage, comme dans Palettes où il existe un bouton 'trois points' pour chaque palette. Dans ce cas, vous pouvez faire un clic droit sur le nom de la palette ou la sélectionner avec
le clavier et appuyer sur le raccourci clavier Maj+F10 ou Menu comme alternatives à l’utilisation du bouton à trois points.

Naviguer dans votre partition

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Défilement

Molette de la souris

Utilisez la molette de la souris pour faire défiler l'affichage vers le haut ou vers le bas.
Utilisez Maj associé à la roue de la souris pour faire défiler l'affichage à droite ou à gauche.

Barres d’ascenseur

Les barres d’ascenseur apparaissent aux bords droit et bas de la fenêtre d’affichage de la partition. Cliquez et déplacez les curseurs pour vous déplacer rapidement en direction haut/bas ou droite/gauche. Les barres d’ascenseur sont
habituellement cachées dans l’affichage mais elles peuvent être révélées en passant la souris au-dessus du bord de la fenêtre de partition.

Clavier

Vous pouvez aussi faire défiler la partition en utilisant les touches Page haut, Page bas, Début et Fin sur votre clavier. Si votre clavier manque de touches dédiées, la plupart des systèmes autorisent aussi d’accéder à ces fonctions en gardant
appuyée la touche Fn ou une touche similaire, tout en tapant respectivement sur ↑, ↓, ←, ou →.

Par nature, Page haut et Page bas font défiler d’une page d’écran à la fois. Cela peut être moins que la réelle page de votre partition. Si vous maintenez appuyé Ctrl (Mac : Cmd) pendant que vous tapez Page haut ou Page bas, cela fera défiler
d’une page complète à la fois.

Navigation entre éléments

Quand un seul élément est sélectionné dans votre partition, il agit comme un curseur. Vous pouvez changer la sélection — et par conséquent le curseur — en utilisant les raccourcis clavier courants.

Les touches ← et → déplaceront horizontalement le curseur à travers votre partition d’une note ou d’un silence à la fois. Si vous maintenez Ctrl (Mac : Cmd) tout en tapant ← ou →, vous pouvez naviguer d’une mesure complète à la fois.
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Pour déplacer le curseur verticalement à travers les différentes notes, voix et portées dans votre partition, utilisez les raccourcis Alt+↑ et Alt+↓ (Mac : Option+↑ et Option+↓).

Vous pouvez aussi utiliser les raccourcis Alt+← et Alt+→ (Mac : Option+← et Option+→) pour sélectionner les éléments autres que les notes et les silences. Ces commandes vous permettent de sélectionner à peu près n’importe quel élément — y
compris des articulations, des barres de mesure, des nuances et davantage — en utilisant le seul clavier.

En outre, Ctrl+Début (Mac : Cmd+Début) sélectionnera le premier élément de votre partition et Ctrl+Fin (Mac : Cmd+Fin) le dernier. De nouveau, pour les claviers qui manquent de touches Début et Fin dédicacées, la plupart des systèmes
fournissent respectivement l’alternative Fn+← et Fn+→.

Pour en apprendre davantage, voir Raccourcis clavier par défaut.

Navigateur

Le Navigateur est un panneau qui affiche des réductions des pages de la partition. Pour afficher ou masquer le Navigateur, aller dans le menu et cliquez Affichage → Navigateur.

Le rectangle bleu représente la zone effectivement affichée dans la vue partition. Cliquez sur le rectangle et déplacez le pour naviguer à l’intérieur de votre partition.

Timeline

C’est une aide de navigation qui montre les instruments et la structure de la partition. Pour plus de détails, voir Timeline.

Affichages

Vous pouvez basculer entre différents affichages de votre partition en utilisant la fenêtre éphémère (pop-up) située à droite dans la barre de statut.

Affichage par page

La partition est affichée comme elle apparaîtrait si elle était imprimée ou exportée comme fichier PDF ou image, c’est-à-dire page par page, avec des marges. MuseScore Studio attribue automatiquement des sauts de système et sauts de
pages en fonction des réglages faits dans Paramètres de la page et Style. En outre, vous pouvez définir vos propres sauts de système, de section ou de pages.

Affichage continu (horizontal)

La partition est affichée comme un système unique sans coupure. Même si le point de départ n’est pas visible, la numérotation des mesures, le nom des instruments, la clef, l’armure et l’indication de mesure sont toujours affichés à la gauche
de la fenêtre.

Affichage continu (vertical)

La partition est affichée en une seule page avec le titre mais sans marges et avec une hauteur de page infinie. Les sauts de système sont ajoutés automatiquement en fonction des réglages faits dans Paramètres de la page et Style. En
supplément, vous pouvez définir vos propres sauts de système ou de section.

Zoom

Il y a plusieurs façons de zoomer ou dézoomer l'affichage de la partition :

Élargissement

Ctrl++ (Mac : Cmd++)
ou défilement vers le haut de la molette de la souris pendant que la touche Ctrl (Mac : Cmd) est maintenue.

Rétrécissement

Ctrl+- (Mac : Cmd+-)
ou défilement vers le bas de la molette de la souris pendant que la touche Ctrl (Mac : Cmd) est maintenue.

Commandes de la barre de statut

Pour zoomer et dézoomer depuis les commandes de la barre de statut, vous pouvez :

Cliquer sur l’une des icônes loupe (+ ou -) dans la zone droite de la barre de statut
Cliquer sur le champ numérique à la droite de ces icônes et saisir le niveau de zoom personnalisé
Choisir l’un des niveaux préétablis de zoom dans la liste pop-up située à l’extrême droite
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Restaurer le zoom 100 %

Ceci restaure le zoom à sa valeur défaut (100 %) :
Ctrl+0 (Mac : Cmd+0)

Chercher / Aller à

Le panneau __Chercher / Aller à __ vous permet de naviguer rapidement vers une mesure spécifique, une indication de répétition ou un numéro de page dans la partition.

Pour ouvrir le panneau :

Allez à Édition → Chercher / Aller à ou
Tapez Ctrl+F (Mac : Cmd+F).

Pour cacher le panneau :

Cliquez sur le bouton X (fermer) sur le côté gauche du panneau ou
Tapez Echap lorsque que le panneau a le focus.

Naviguer vers une mesure numérotée

Saisir le numéro de la mesure dans le champ de recherche (en comptant chaque mesure depuis 1, indépendamment de l’anacrouse, des sauts de section ou de la renumérotation manuelle des mesures).

Vers une page numérotée

Saisir le numéro de la page en utilisant le format pXX (où XX est le numéro de page).

Naviguer vers une indication de répétition numérique

Saisir le numéro en utilisant le format rXX (où XX est le numéro de l'indication de répétition).

Naviguer vers une indication de répétition alphabétique

Saisir le nom de l'indication de répétition (la recherche n’est pas sensible à la casse).

Astuce pour les pros !
Il est préférable d’éviter de nommer les indications de répétition avec les simples lettres “R", “r", “P”, “p" ou d'utiliser une de ces lettres avec un nombre entier (exemples : “R1” ou “p3”) car cela embrouille l’algorithme de recherche.

Timeline

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Vue d’ensemble

Timeline est une aide à la navigation qui s’affiche en bas de la fenêtre du programme. Elle donne une vue d’ensemble sur les instruments et les principaux éléments structurels, mesure par mesure. Vous pouvez aisément vous déplacer
dans la partition en cliquant dans une mesure ou sur un élément structurel.

La timeline comporte quatre parties :

Méta-étiquettes

Affichées dans la partie supérieure gauche de la timeline, ce sont les noms des méta-éléments de la partition.

Méta-lignes

Ce sont les lignes de la partie supérieure droite de la timeline. Elles affichent de façon chronologique les valeurs des méta-éléments de la partition.

Noms des instruments

Affichés dans la partie inférieure gauche de la timeline, ils constituent les étiquettes des lignes de la grille principale.

Grille principale

Elle constitue la partie inférieure droite de la timeline. Elle est divisée en plusieurs "cellules" (carré représentant une mesure d’une portée).

Méta-éléments

Les méta-éléments représentent les éléments de la partition qui ne sont pas des notes, mais qui ont leur importance — comme les changements d’armure, d'indication de mesure, de tempo, les indications de répétition, les barres de mesure,
ainsi que les sauts et les marqueurs.

Actions de base

Sélectionner une mesure

Pour sélectionner une mesure d’un instrument dans la timeline, cliquez avec la souris sur la cellule correspondant dans la grille principale. Un carré bleu apparaît autour de la cellule sélectionnée. La mesure correspondante est sélectionnée
dans la partition et positionnée de façon visible dans la fenêtre d’affichage de la partition.

Sélectionner plusieurs mesures

Sélection par glisser

Maintenez Shift ainsi que le bouton gauche de la souris tout en déplaçant la souris au-dessus de la grille principale pour créer une boîte de sélection. Lorsque vous relâchez le bouton de la souris, toutes les cellules au-dessous de la boîte de
sélection sont sélectionnées, tout comme l’ensemble des mesures correspondantes dans la partition.

Sélection avec [Shift]

Si une cellule est déjà sélectionnée, gardez la touche Shift appuyée en sélectionnant une autre cellule dans la timeline pour étendre la sélection jusqu’à cette nouvelle cellule. C’est similaire à la méthode de sélection de mesures dans la
partition.
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Sélection avec [Ctrl]

Si aucune cellule n’est encore sélectionnée, gardez la touche Ctrl appuyée en sélectionnant une cellule pour sélectionner la mesure entière, étendue à l’ensemble des instruments.

Effacer une sélection

Pour effacer la sélection en cours, maintenez la touche Ctrl et cliquez n’importe où sur la grille.

Sélection d’un méta-élément

Cliquez sur un méta-élément dans la timeline pour sélectionner l’élément correspondant dans la partition.

Faire défiler la timeline

Défilement standard

Tournez la molette de la souris vers le haut ou vers le bas pour faire défiler la grille et les noms d’instruments respectivement vers le haut ou vers le bas. Les méta-étiquettes et les méta-lignes ne bougent pas.

Faire défiler avec [Shift]

Tournez la molette de la souris vers le haut ou vers le bas tout en maintenant appuyée la touche Shift pour déplacer la grille et les méta-lignes respectivement vers la gauche ou vers la droite. Les méta-étiquettes et les et les noms
d’instruments ne bougent pas.

Faire défiler avec [Alt]

Tournez la molette de la souris vers le haut ou vers le bas tout en maintenant appuyée la touche Alt pour déplacer la grille et les méta-lignes respectivement vers la gauche ou vers la droite, de façon plus rapide que par le défilement avec
Shift. Les méta-étiquettes et les noms d’instruments ne bougent pas.

Faire glisser

Pour faire glisser le contenu de la timeline, maintenez le bouton gauche de la souris enfoncé et déplacez-le dans la direction souhaitée.

Actions sur les étiquettes

Réorganiser les méta-étiquettes

Toutes les méta-étiquettes en dehors de Mesures peuvent être réorganisées. En déplaçant le curseur de la souris sur l'une des méta-étiquettes, de petites flèches haut/bas apparaissent. Cliquez sur la flèche du haut pour faire monter
l’étiquette d’une ligne en l’échangeant avec celle qui se trouve au-dessus. Cliquez sur la flèche du bas pour la faire descendre d’une ligne en l’échangeant avec celle qui se trouve au-dessous.

Regrouper les méta-étiquettes

Pour cacher les méta-étiquettes tout en gardant l’ensemble des méta-informations sur la timeline, cliquez avec le bouton gauche sur la méta-étiquette Mesures afin de regrouper toutes les méta-lignes actuellement visibles en une seule
rangée dans laquelle les méta-valeurs sont échelonnées. Cliquer de nouveau avec le bouton gauche sur la méta-étiquette Mesures pour étendre les méta-lignes.

Cacher des instruments

Tous les instruments – cachés ou non – sont affichés sur la timeline. Amenez le curseur de la souris au-dessus d’un nom d’instrument : un petit œil apparaît sur le côté droit de l’étiquette ; il est ouvert si l’instrument est visible sur la partition
et fermé si l’instrument est caché. Cliquez avec le bouton gauche de la souris pour basculer entre les deux options.

Zoomer

Pour zoomer ou dézoomer la timeline, tournez la molette de la souris respectivement vers le haut ou vers le bas tout en maintenant appuyée la touche Ctrl (Mac : Cmd).

Braille

Avis aux lecteurs : Vous pouvez signaler les coquilles ou erreurs trouvées dans ce manuel sur la page Documentation  du forum.

Vue d'ensemble

Une fenêtre Braille a été ajoutée à MuseScore Studio qui affiche la mesure actuelle conformément à braille music notation  (en anglais). Le contenu est similaire à celui que vous obtenez si vous exporter en braille  depuis le menu
Fichier, cependant la fenêtre braille est actualisée au fur et à mesure que vous parcourez la partition.

Depuis MuseScore 4.2, la fenêtre braille peut être utilisée pour la saisie des notes et certains symboles musicaux à l'aide de la saisie braille à 6 touches de style Perkins.

Afficher sur un terminal braille physique

Le contenu de la fenêtre braille peut être affiché sur un terminal braille connecté à votre ordinateur (par exemple via Bluetooth ou USB).

Les limitations suivantes s'appliquent lors de l'utilisation d'un terminal braille physique :

NVDA doit être utilisé comme lecteur d'écran.
La fenêtre braille de MuseScore Studio doit avoir le focus clavier (Le curseur de saisie).

Lorsque la partition a le focus (Le curseur), le terminal braille affichera simplement le texte d'état ordinaire du lecteur d'écran.
La navigation dans la fenêtre braille et la saisie à 6 touches doivent être effectuées avec le clavier de l'ordinateur.

Les boutons physiques du terminal braille ne sont pas utilisés, sauf pour faire défiler une mesure trop longue pour tenir sur votre écran.

Faites-nous savoir dans le forum Documentation  si vous découvrez un moyen de contourner l'une de ces limitations.

Terminologie : Braille ou imprimé

Dans cette page, nous faisons référence à la notation de portée habituelle de MuseScore Studio sous le nom de « musique imprimée ». Il s'agit de la notation musicale traditionnelle que les musiciens voyants utilisent sur papier ou sur
appareils électroniques, et est affiché dans la partie centrale de la fenêtre principale de MuseScore, appelée vue partition.

Le braille peut également être utilisé sur papier, mais n'est pas imprimé avec de l'encre. Au lieu de cela, il est embossé sous forme de points en relief, que les musiciens aveugles lisent au toucher. Il est courant dans les milieux touchant à
l’accessibilité d'utiliser le mot « imprimer » pour désigner une notation non braille.
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Affichage du braille

Pour ouvrir ou fermer la fenêtre braille

Aller dans Édition > Préférences > Braille.
Cochez (ou décochez) la case Afficher la fenêtre braille.

La fenêtre braille apparaît directement sous la partition dans la fenêtre principale de MuseScore.

Placer le curseur dans la fenêtre braille

Avec la fenêtre braille ouverte, appuyez sur la touche Tab alors que la partition a le curseur de saisie. Un carré (curseur de saisie) apparaîtra dans la fenêtre braille à la position de l'élément sélectionné dans la partition. Par exemple, si une
note a été sélectionnée dans la partition, le curseur de saisie apparaîtra sur cette note dans la fenêtre braille.

Appuyez sur Maj+Tab à tout moment pour quitter la fenêtre braille et revenir à la partition. Le panneau braille restera ouvert afin que vous puissiez y accéder à nouveau avec les touches Tab.

Naviguer dans la fenêtre braille

Alors que la fenêtre braille a le focus (curseur de saisie), vous pouvez déplacer le curseur à l'aide des touches fléchées. Au fur et à mesure que le curseur se déplace dans la fenêtre braille, l'élément à droite du curseur est sélectionné dans
la partition. Si cet élément est une note, MuseScore Studio jouera le son de la note.

La fenêtre braille n'affiche qu'une seule mesure à la fois, mais il affiche cette mesure pour tous les instruments de la partition. Chaque ligne de braille correspond à une portée dans la notation imprimée, donc les instruments comme le piano
reçoivent deux lignes de braille et l'orgue trois lignes.

Si une portée comporte des paroles, celles-ci sont écrites sur une autre ligne de braille immédiatement en dessous de la ligne correspondant à cette portée. S'il y a plusieurs lignes de paroles (par exemple pour plusieurs couplets), chaque
ligne de paroles est écrite sur une ligne distincte dans la fenêtre braille.

Raccourcis de navigation

Les raccourcis clavier suivants sont disponibles pour naviguer dans la fenêtre braille.

Action Windows/Linux macOS

Aller au caractère braille suivant → →

Aller au caractère braille précèdent ← ←

Aller à la ligne braille au-dessus ↑ ↑

Aller à la ligne braille au-dessous ↓ ↓

Aller à la mesure suivante Ctrl+→ Cmd+→

Aller à la mesure précédente Ctrl+← Cmd+←

Aller au début de la partition Ctrl+Début Cmd+Fn+←

Aller à la fin de la partition Ctrl+Fin Cmd+Fn+→

Activer / Désactiver le mode de saisie braille N N

Écrire en braille

Les notes et certains symboles musicaux peuvent être saisis dans la fenêtre braille en utilisant la méthode de saisie braille à 6 touches similaire à une Machine Perkins .

Activer / Désactiver le mode de saisie braille

Lorsque la fenêtre braille a le focus (curseur), tapez N pour Activer ou Désactiver le mode de saisie braille.

Construire un caractère braille

En mode de saisie braille, six touches alphabétiques du clavier de l'ordinateur sont utilisées pour représenter les six points braille qui composent un caractère braille (⠿).

Les touches utilisées sont F, D, S pour les points 1, 2, 3 de haut en bas pour la première colonne, et J, K, L pour les points 4, 5, 6 de haut en bas pour la deuxième colonne. La barre d’Espace est utilisée pour représenter un caractère braille vide
(⠀), parfois appelée point 0.

Jusqu'à six de ces touches peuvent être pressées en combinaison pour créer n'importe quel motif de caractère braille. Par exemple, pour saisir une note Do noire, qui est représenté en braille par ⠹ (c'est-à-dire les points 1, 4, 5, 6), pressez
et maintenez F+J+K+L, puis relâchez ces touches pour confirmer le caractère. Les touches peuvent être pressées et relâchées dans n'importe quel ordre, à condition qu'au moins une touche soit maintenue pressée à tout moment, jusqu'à ce
que vous ayez terminé le caractère.

Lorsque la touche finale est relâchée, MuseScore Studio lit votre caractère braille. Si votre motif correspond à une note ou un symbole musical reconnu alors cet élément est inscrit directement dans la partition, pas dans la fenêtre braille, car
la notation imprimée est la « source » pour MuseScore. Une fois l’élément dans la partition, la fenêtre braille est automatiquement mise à jour pour refléter ce changement.

Parfois, en notation braille musicale, la même information peut être exprimée de plusieurs manières. Par souci de cohérence, MuseScore Studio choisit toujours la même méthode, quelle que soit la manière dont vous avez saisi la notation.
Par conséquent, le caractère braille qui apparaît dans la fenêtre braille peut ne pas correspondre exactement au(x) motif(s) que vous avez saisi avec les six touches, même s'il aura la même signification.

Saisie des notes

Notes de base

En braille, les Croches et les Quintuple-croches s'écrivent ainsi :

Note Braille Points Touches

Do ⠙ 1, 4, 5 F+J+K

Ré ⠑ 1, 5 F+K

Mi ⠋ 1, 2, 4 F+D+J

Fa ⠛ 1, 2, 4, 5 F+D+J+K

Sol ⠓ 1, 2, 5 F+D+K

La ⠊ 2, 4 D+J

Si ⠚ 2, 4, 5 D+J+K

Des points supplémentaires sont ajoutés aux séquences ci-dessus pour créer d'autres durées :

Durée Braille Points ajoutés Touches ajoutées

Noire et Quadruple-croche ⠠ 6 L

Blanche et Triple-croche ⠄ 3 S

Ronde et Double-croche ⠤ 3, 6 S+L

Par conséquent, une note Do noire est ⠹ (points 1, 4, 5, 6) est entrée avec F+J+K+L. Ce motif est également utilisé pour une double-croche Do.

Doubles-croches et plus petites

Comme mentionné ci-dessus, les doubles-croches et les plus petites utilisent les mêmes motifs de points que les durées plus grandes. Lors de la lecture braille, vous pouvez déterminer la durée la plus courte ou la plus longue en examinant
l’indication de mesure ainsi que d'autres notes de la mesure. Cependant, lorsque vous écrivez en braille, vous devez indiquer à MuseScore Studio les durées que vous souhaitez utiliser.

⠤ ⠄ ⠠ ⠀ Points à utiliser Touches à utiliser

Groupe 1 Ronde Blanche Noire Croche 0, 1 Espace+F

Groupe 2 Double-croche Triple-croche Quadruple-croche Quintuple-croche 0, 2 Espace+D

Par défaut, MuseScore Studio saisit les durées du groupe 1 (Ronde, Blanche, Noire, Croche). Pour passer au groupe 2, saisissez les points 0, 2 (pressez les touches Espace+D). Rien n'apparaîtra dans la fenêtre braille, mais toutes les notes
ou silences que vous écrivez désormais seront dans le groupe 2 (Double-croche, Triple-croche, Quadruple-croche, Quintuple-croche). Pour revenir aux durées du groupe 1, saisissez les points 0, 1 (pressez les touches Espace+F).

Il n'est actuellement pas possible de saisir des durées inférieures ou égales à la Sextuple-croche, ou les notes Carrée et Longue, à partir de la fenêtre braille.

Notes pointées

Le braille utilise ⠄(point 3) pour représenter un point d'augmentation, qui est ajouté dans un nouveau caractère braille immédiatement après une note. Aucun autre caractère n'est autorisé à s'interposer entre la note et son point
d'augmentation.

Pour créer une note pointée dans la fenêtre braille, saisissez d'abord la durée de la note principale en utilisant les règles ci-dessus, puis faites-la suivre par le point 3 (c'est-à-dire pressez S).

Par exemple, un Do Noire pointée est ⠹⠄, qui s’écrit avec le motif de points 1456-3, où le tiret signifie démarrer un nouveau caractère. Les combinaisons de touches sont F+J+K+L, S.

Il n'est actuellement pas possible de saisir plusieurs points 3 pour créer des notes doubles, triples ou quadruples pointées via la fenêtre braille.
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Marques d'octave

Les marques d'octave en braille ont un objectif similaire aux Clefs de la musique imprimée. Si vous voyez une note imprimée, vous ne savez pas de quelle hauteur il s'agit jusqu'à ce que vous regardiez la Clef précédente. En braille, si vous
voyez ⠙ (points 1, 4, 5) vous savez que la note est un Do, mais cela peut être un Do de n'importe quelle octave. Pour déterminer l'octave, vous devez regarder la marque d'octave précédente (ainsi que toutes les notes situées entre cette
marque d'octave et la note actuelle).

La numérotation des octaves dans les paragraphes qui suivent utilise la notation Anglo-Saxonne et ne peut pas être traduite. La traduction de la numérotation des octaves en notation Française, Allemande et Anglaise n’étant
pas implémentée dans MuseScore à ce jour (MuseScore Studio 4.3.1). Le nom des notes est cependant traduit.

Un piano standard de 88 touches possède 7 octaves complètes. En commençant par le Do le plus grave, appelé Do1 en braille ainsi qu'en notation anglo-saxonne pour la numérotation, la première octave complète de touches blanches est
Do1, Ré1, Mi1, Fa1, Sol1, La1 et Si1. Si1 est suivi par Do2, qui marque le début de la deuxième octave complète. Ce schéma se poursuit jusqu'à l'octave complète finale, qui commence par Do7 et se termine par Si7.

Dans ce système, Do4 est le Do central et La4 est le « La du diapason » (c'est-à-dire la note sur laquelle l'orchestre s'accorde au début d'une représentation). L'écriture des notes enharmonique est aussi importante, un Si♯3 a le même son
qu’un Do4 bien que la note soit écrite dans une octave différente, donc Do♭4 a le même son que Si3.

Les pianos standards à 88 touches ont quelques notes en dehors de la plage Do1 à Si7. Le braille fait référence à l'octave Do0 comme l'octave « inférieure » et à l'octave Do8 comme l'octave « supérieure ». Celles-ci doublent simplement les
indications utilisées pour les première et septième octaves.

Octave Marques Points Touches

0 (inférieure) ⠈⠈ 4-4 J, J

1 ⠈ 4 J

2 ⠘ 45 J+K

3 ⠸ 456 J+K+L

4 (central) ⠐ 5 K

5 ⠨ 46 J+L

6 ⠰ 56 K+L

7 ⠠ 6 L

8 (supérieure) ⠠⠠ 6-6 L, L

Lorsqu'elles sont spécifiées, les marques d'octave sont placées immédiatement avant une note. Donc une Noire Do central est ⠐⠹, ou les points 5-1456, qui s’écrit K, F+J+K+L. Aucun autre caractère n'est autorisé à s’intercaler entre la
marque d'octave et la note à laquelle elle appartient.

Il n'est pas nécessaire de marquer l'octave avant chaque note. Les marques d'octave sont uniquement requises :

A la première note de chaque ligne de braille.
A la première note après une double barre de mesure, un signe numérique, un indicateur de mot et certaines autres marques.
Sur la seconde de deux notes séparées par un intervalle mélodique d'une sixte ou plus, quelles que soient leurs octaves.
Sur la deuxième de deux notes séparées par un intervalle mélodique d'une quarte ou plus, si leurs numéros d'octave sont différents.

Bases

Configurer votre partition

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Vue d'ensemble

Ce chapitre est consacré à la sélection des instruments et à la saisie des informations initiales de la partition. Il est nécessaire d'avoir préalablement compris les principes de fonctionnement de base de MuseScore Studio qui sont traités dans
le tutoriel Créez votre première partition.

Instruments

Dans MuseScore Studio, un instrument est une abstraction contenant à la fois les tablature(s) ou les portée(s) (l'aspect le plus utile : voir Notions de mise en page : Portée), les styles de notation (clefs, notes de musique, etc.), les
comportement musicaux ( transposition, gamme jouable) et les réglages relatifs à la lecture audio créée par le synthétiseur de MuseScore Studio. Exemples d'instruments : Piano, Violon, Violons (section), Soprano...

Un instrument Musescore contient des portées qui peuvent représenter un seul ou plusieurs instruments réels. Par exemple, dans la première édition publiée par Cianchettini & Sperati, n.d.[1809] à Londres de la Symphonie n° 3 de
*Beethoven Op.55, la troisième portée Corni 1 & 2 in Eb représente deux joueurs de cor français :
NOT FOUND: corni1.png
Pour transcrire cela, vous devez ajouter un instrument Musescore "Cor en Mib" et le renommer. La lecture n'est pas affectée par le nommage.

Les instruments du monde réel, section instrumentale, chant et chœurs sont supportés par MuseScore Studio de plusieurs façons. Il peut s'agir :

d'un instrument Musescore portant le même nom, comme "Piano", "Violon", "Violons (section)", "Cordes", "Soprano", "Voix", "Femme" et quelques percussions comme "Timbales", "Grosse caisse de concert", "Cymbales" (concert). Des
items similaires pourraient être joués différemment.
de l'instrument Musescore "Set de batterie", un simple item contenant "Caisse claire", "Grosse caisse", "Toms", "Cymbale", etc. Il n'y a pas d'instrument MuseScore séparé pour eux. Voir Personnalisation du set de batterie
Un court son de caisse claire à balais SoundFont est fourni avec MuseScore Studio. Voir Mélangeur.

Utilisez les modèles préconfigurés pour créer une nouvelle partition. Vous pouvez aussi paramétrer des instruments dans toute partition et dans chacune de ses Parties).

MuseScore Studio contient plus de 500 instruments, groupés par famille à laquelle ils appartiennent. Pour suggérer l'ajout d'un instrument manquant, voir https://musescore.org/en/contribute .

Choisir des instruments

Quand vous créez une nouvelle partition, cliquez pour ouvrir l'onglet Choisir les instruments. Plusieurs méthodes mentionnées dans "Modifier les instruments après la création de partition" ouvrent également cette fenêtre.

Les instruments sont filtrés selon le type et le genre affichés dans le menu déroulant de gauche, sous l'en-tête Famille. L'option sélectionnée par défaut est Instruments communs qui affiche les instruments et voix les plus courants, que vous
avez de fortes chances d'utiliser. NOTE : pour afficher tous les instruments disponibles, vous devez sélectionner Tous les instruments.

Les instruments sont groupés dans la famille d'instruments auxquels ils appartiennent. Si vous savez quel instrument/voix vous recherchez, il suffit de saisir le nom ou une partie du nom de l'instrument dans la barre de recherche sous l'en-
tête Instruments. Cliquez sur le bouton X pour vider le champ de sélection.

Ajouter des instruments

Pour ajouter un instrument à votre partition :

Faites un double clic sur un instrument sous Instruments

ou

Sélectionnez un instrument sous Instruments
Cliquez sur le bouton → pour ajouter l'instrument à votre partition (Truc pour les pros : double-cliquer sur l'instrument a le même résultat).
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Les portées d'une partition sont automatiquement arrangées en accord avec l'ordre affiché dans le menu déroulant situé sous l'en-tête Votre partition, à droite. Le menu déroulant Ordre… affiche le préréglage d'ordre de portées en cours.

Changer l'ordre des instruments en les rendant solistes

L'ordre de positionnement des solistes est pratiqué dans les partitions d'orchestre. Par exemple, dans la pratique d'ordonnancement 'Orchestre', les solistes sont placés au-dessus des cordes. Soliste ne signifie pas "seul dans la partition".

Sélectionnez le style dans la liste déroulante Ordre… sous l'en-tête Votre partition.

Pour réarranger un instrument (toutes ses portées) en position de soliste :

Sélectionnez un instrument sous Votre partition
Cliquer sur le bouton "Soliste"

Changer l'ordre des instruments

Pour changer manuellement l'ordre des instruments :

Sélectionnez un instrument dans le panneau Votre partition
Cliquez sur ↑ ou ↓ pour modifier sa position

Supprimer des instruments

Pour supprimer un instrument de votre partition :

Sélectionnez un instrument dans le panneau Votre partition
Cliquez sur l'icône poubelle.

On peut aussi supprimer plusieurs instruments à la fois en gardant la touche Maj appuyée pendant qu'on sélectionne les instruments concernés, avant de cliquer sur l'icône poubelle.

Créer à partir d'un modèle

Les partitions peuvent aussi être créées à partir de modèles préconfigurés. Un modèle est un réglage complet d'instruments pour un type particulier de partition, avec l'ordre et le style qui convient aux usages conventionnels. Les modèles
sont organisés en catégories basées sur un style musical ou une configuration d'orchestre.

Pour créer une partition à partir d'un modèle :

Cliquez sur l'onglet Créer à partir d'un modèle
Sélectionnez un groupe de modèles depuis le panneau Catégorie
Choisissez le modèle souhaité dans le panneau central
Cliquez sur le bouton Terminer
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On peut aussi utiliser la barre de recherche pour naviguer à travers tous les modèles disponibles.

Consultez Modèles et styles pour en apprendre davantage sur les modèles, y compris sur la façon de créer le vôtre pour un usage futur.

Informations complémentaires sur la partition

Cliquez sur Suivant dans la fenêtre de dialogue Nouvelle partition pour spécifier les informations complémentaires dans l'écran Informations additionnelles sur la partition comme l'armure, l'indication de mesure, le tempo, l'anacrouse et
le nombre de mesures.

Notez que c'est une façon pratique d'ajouter des informations lors de la création d'une nouvelle partition mais que ce n'est pas la seule. Il existe d'autres méthodes que vous pouvez utiliser à n'importe quel moment ultérieur, traitées dans
leurs chapitres respectifs comme Raccourcis clavier, Utiliser les palettes, Propriétés des partitions, etc.

Armure

Par défaut, les nouvelles partitions sont créées avec des armures ne contenant ni dièse ni bémol (Do Majeur). Spécifiez une armure différente en cliquant sur le bouton situé sous Armure. Les gammes majeures sont affichées en premier ;
les gammes mineures peuvent être affichées en sélectionnant l'onglet Mineur.

Indication de mesure

Les nouvelles partitions sont créées par défaut en chiffrage 4/4. On peut le modifier en cliquant sur le bouton situé sous Indication de mesure. Pour modifier le nombre de temps par mesure, utiliser les flèches dans la boîte de sélection
numérique ; pour modifier l'unité de temps, la sélectionner dans le menu déroulant. On peut aussi utiliser les indicateurs C et C barré (Alla breve) dans cette fenêtre.

Tempo

Par défaut, les nouvelles partitions sont jouées avec un tempo de noire à 120 battements par minute (BPM). La valeur du tempo n'est pas automatiquement affichée dans les nouvelles partitions.

Pour personnaliser le tempo et l'afficher au-dessus de la portée supérieure :

Cliquez sur le bouton situé sous Tempo
Cochez Afficher l'indication de tempo sur la partition
Sélectionnez l'unité de temps désirée (valeur de note)
Saisissez le nombre de battements par minute (20-400) dans le champ texte ou utilisez les flèches haut et bas pour naviguer dans la plage de tempo.

Pour en apprendre davantage sur les indicateurs de mesure, l'affichage du tempo et la vitesse de lecture, voir Indications de tempo.

Mesures

Les nouvelles partitions sont créées avec 32 mesures et sans anacrouse. Pour changer le nombre de mesures initiales de votre nouvelle partition :

Cliquez sur le bouton situé au-dessous de Mesures
Saisissez le nombre souhaité de mesures dans le champ Nombre initial de mesures.

Il est possible d'ajouter et supprimer des mesures à n'importe quel moment de la création de partition.

Pour commencer votre partition avec une anacrouse :

Cliquez sur le bouton situé sous Mesures
Cochez Créer une anacrouse
Saisissez le nombre de battements souhaités pour l'anacrouse dans la boîte de sélection numérique
Sélectionnez l'unité de temps de l'anacrouse dans le menu déroulant.

Il est toujours possible de créer une anacrouse plus tard. Apprenez comment réaliser cela au chapitre Anacrouse et mesures non comptées.

Titre et autres textes

Saisissez le texte dans les champs situés en partie basse de la fenêtre de dialogue Nouvelle partition et MuseScore Studio le placera automatiquement sur votre nouvelle partition, à la place et dans le format approprié. Vous pouvez utiliser
les étiquettes pour afficher :

le titre
le compositeur
le sous-titre
le parolier
le copyright.

Ces informations deviennent aussi des métadonnées dans les Propriétés de la partition (menu Fichier), informations que vous pouvez modifier à n'importe quel moment.

Une fois que vous avez fini de préciser les informations complémentaires, cliquez sur Fait pour confirmer vos choix et créer votre partition.

Changer les instruments après la création de la partition

Il existe trois possibilités pour modifier les instruments d'une partition existante :

Utilisez le raccourci clavier I pendant que vous êtes dans l'onglet Partition
Cliquez sur Ajouter depuis le panneau Instruments (si ce panneau n'est pas encore visible, presser la touche F7 ou sélectionner le menu Affichage → Instruments)
Cliquez sur Changer d'instrument dans la fenêtre de dialogue Propriétés de la Portée / Partie.
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Saisir des notes et des silences

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Ce chapitre explique la création de musique sur des portées standard uniquement. Voir aussi les chapitres Saisir et éditer la notation de tablature et Saisir et modifier la notation des percussions.

Vue d'ensemble

MuseScore Studio supporte la saisie de musique via un clavier ou une souris d'ordinateur, un clavier MIDI ou le piano virtuel MuseScore. Utiliser le clavier d'ordinateur est une méthode de saisie simple et rapide : choisissez simplement une
durée puis tapez la lettre de la note (A-G) [notation anglo-saxonne où A = La, B = Si, C = Do ...)] ou 0 (zéro) pour un silence..

MuseScore Studio accepte virtuellement des modifications sans limite pour corriger des erreurs de saisie. Cliquez sur le bouton Annuler placé à l'extrême-droite de la barre de menu ou utilisez le raccourci clavier standard Ctrl+Z (Mac : Cmd+Z).

Saisir des notes

Ce chapitre explique le mode de saisie par défaut, pas-à-pas, où les notes et silences sont saisis l'un(e) après l'autre. Il est basé sur la logique suivante : après que l'utilisateur saisit une note ou d'un silence, les notes et silences suivants
ajustent automatiquement leur durée (valeur ou longueur de note) sans affecter le nombre de battements total, quelle que soit la mesure. Voir aussi le chapitre Méthodes alternatives de saisie des notes.

Sélectionner un point de départ

Pour ajouter une note ou un silence à la partition, commencez par sélectionner l'endroit où doit commencer la saisie. Vous pouvez utiliser la souris ou les commandes de navigation du clavier.

Entrer en mode de saisie des notes

Ensuite, entrez en mode de saisie des notes en cliquant sur l'icône crayon dans la barre d'outils ou en utilisant le raccourci clavier N. Un curseur de saisie de notes apparaît sous la forme d'une grande et étroite boîte de couleur bleu clair avec
une bordure gauche bleu foncé. Il recouvre l'ensemble de la portée et indique que le mode de saisie de notes est en cours. Le curseur est positionné au début du temps ou du battement auquel la prochaine note (ou silence) va être ajoutée.

Si vous oubliez de préciser où doit commencer la saisie, MuseScore Studio placera le curseur à la position utilisée lors de la dernière saisie ou en quelque autre place logique. Aussi, assurez-vous que le curseur est bien positionné là où vous
le souhaitez.

Une fois que le mode saisie de notes est activé, les notes sont entrées de gauche à droite, d'abord en sélectionnant une durée de note puis en précisant une hauteur ou un silence. Quand vous avez fini de saisir les notes à cet endroit et que
vous êtes prêt à faire autre chose — par exemple saisir des notes dans une autre partie, ajouter d'autres symboles ou mettre en œuvre d'autres actions comme un copié-collé —, vous pouvez quitter le mode saisie en cliquant sur le bouton
de saisie des notes ou en tapant de nouveau N. Vous pouvez aussi presser Echap. pour revenir au mode normal depuis le mode saisie ou n'importe quel autre mode.

Sélectionner la durée des notes ou des silences

Dans le mode de saisie des notes, vous pouvez sélectionner une durée pour la prochaine note ou silence à saisir :

Soit en cliquant sur la figure de note correspondante dans la barre d'outils Saisie des notes (située immédiatement au-dessus de la fenêtre de la partition)

Soit en utilisant le raccourci clavier 1–9 correspondant à la durée souhaitée.

Les raccourcis claviers ont été choisis pour être efficaces et faciles à mémoriser. Les durées de notes les plus communes sont la croche, la noire et la blanche ; elles sont respectivement représentées par les touches 4, 5, et 6 (la rangée
centrale d'un pavé numérique). Les durées plus courtes sont représentées par des chiffres plus petits ; les plus longues par des chiffres plus grands. La liste est la suivante :

Quadruple croche : 1
Triple croche : 2
Double croche : 3
Croche : 4
Noire : 5
Blanche : 6
Ronde : 7
Carrée : 8
Point de prolongation : . (change la sélection en note pointée ou silence pointé)

D'autres durées, comme le double point et les quintuples croches, peuvent être saisies en commençant par personnaliser sa barre d'outils et/ou définir ses propres raccourcis clavier.

Remarque : il est également possible de sélectionner une durée en utilisant un clavier MIDI, si vous avez défini à l'avance les touches que vous souhaitiez utiliser à cet usage.

Sélectionner la hauteur des notes

Une fois que la durée a été sélectionnée, il est possible de saisir la hauteur de note en utilisant le clavier de l'ordinateur, la souris, un clavier MIDI ou le clavier de piano virtuel.

Sélectionner la hauteur en utilisant le clavier de l'ordinateur

C'est normalement la modalité la plus efficiente pour saisir des notes dans MuseScore Studio.

Pour saisir une note d'une hauteur donnée en utilisant le clavier de l'ordinateur, il suffit de taper la lettre correspondante à sa notation alphabétique anglo-saxonne (A–G) sur le clavier.

Remarque : l'équivalence entre la notation syllabique classique (Do, Ré, Mi...) et la notation alphabétique anglo-saxonne (A, B, C...) est la suivante : Do = C, Ré = D, Mi = E, Fa = F, Sol = G, La = A, Si = B.

Les notes saisies de cette façon remplaceront toute note ou silence présent(e) à la place du curseur de saisie. Pour ajouter une note à une note préexistante ou un accord, utilisez la touche Maj pendant la saisie de la note. Pour plus
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d'informations, voir la section sur la saisie des accords.

Quand vous saisissez des notes via la lettre correspondante, MuseScore Studio choisit l'octave qui est la plus proche de la précédente note sur la portée. Cela fonctionne bien pour les passages qui évoluent essentiellement en écarts de
faible intensité. Si vous avez besoin de changer d'octave pour un écart plus important, utilisez Ctrl+↑ et Ctrl+↓ (Mac : Cmd+↑ et Cmd+↓) pour augmenter ou diminuer d'une octave la hauteur de la note précédemment saisie.

Sélectionner la hauteur en utilisant la souris

Pour saisir une note en utilisant la souris, positionnez la souris sur la ligne ou l'interligne de la portée à l'endroit où elle doit être déposée puis cliquez. Le curseur de la souris affiche l'image de la note que vous êtes sur le point de saisir pour
vous aider à la placer de façon précise.

Si d'autres notes existent déjà dans la position où vous saisissez la nouvelle, cette dernière sera ajoutée au-dessus ou au-dessous. Pour forcer le remplacement de la note existante, utilisez Maj pendant que vous positionnez la nouvelle note.

Il peut être difficile de saisir des notes très éloignées au-dessus ou au-dessous de la portée en utilisant cette méthode car MuseScore Studio peut interpréter les clics éloignés de la portée concernée comme une tentative de saisir des notes
sur la portée supérieure ou inférieure. Pour éviter cela, essayez de saisir la note sur une octave plus basse ou plus haute puis augmentez ou diminuez la hauteur d'une octave en utilisant Ctrl+↑ et Ctrl+↓ (Mac : Cmd+↑ et Cmd+↓).

Remarque : bien qu'il soit naturel de saisir de notes de gauche à droite, la méthode de saisie des notes avec la souris permet en fait de saisir une note à n'importe quel endroit où il existe une note ou un silence à remplacer.

Sélectionner la hauteur avec un clavier MIDI

Si vous avez un clavier MIDI connecté, vous pouvez saisir les notes en tapant simplement les touches correspondantes.

Quand on joue des notes sur un clavier MIDI, elles sont entrées consécutivement à condition de relâcher entièrement chaque touche avant de jouer la note suivante. Si vous pressez une touche avant que la précédente soit relâchée, la note
est ajoutée au-dessus ou au-dessous de la précédente.

Les notes saisies à partir d'un clavier MIDI qui sortent de la gamme définie par l'armure en cours se verront automatiquement attribuer une altération dont la nature peut ne pas être celle que vous attendiez. Pour changer l'altération de façon
enharmonique, utiliser J.

Sélectionner la hauteur avec le clavier de piano virtuel

On peut aussi saisir des notes en utilisant la fenêtre Clavier de piano. Pour l'afficher, utilisez le menu Affichage → Clavier de piano ou le raccourci clavier P. La fenêtre peut être fermée de la même façon.

Pour saisir une note avec une hauteur donnée, il suffit de cliquer sur la touche appropriée du piano à l'aide de la souris.

Comme avec le clavier d'ordinateur, les notes saisies de cette façon remplacent toute note ou silence existant à cette place. Pour créer un accord à la place, gardez la touche Maj enfoncée pendant la saisie des notes.

Remarque : pour changer la taille du clavier, positionnez la souris au-dessus de la fenêtre et gardez appuyée la touche Ctrl (Mac : Cmd) tout en utilisant la mollette de la souris pour l'agrandir ou la diminuer.

Saisir des accords

Dans cette section, les accords sont définis comme toute combinaison de plusieurs notes commençant en même temps, partageant toutes la même durée et disposées sur la même hampe.

Si vous voulez saisir des notes qui sont jouées en même temps mais diffèrent en termes de départ, de durée ou dont les hampes sont séparées, voir la section Voix. Le texte "Dm7" représente un symbole d'accord présenté dans Symboles
d'accords.

De la même façon que des notes individuelles, les accords peuvent être saisis via le clavier d'ordinateur, la souris, un clavier MIDI ou le clavier de piano virtuel. A l'exception du clavier MIDI (où on peut jouer plusieurs notes à la fois), les
notes continuent d'être saisies l'une après l'autre mais d'une façon qui permet de dire à MuseScore Studio de les combiner dans un accord plutôt que de les ajouter de façon séquentielle.

Pour ajouter une note à un accord en utilisant le clavier d'ordinateur, maintenez la touche Maj pressée pendant que vous entrez la note
Pour ajouter une note à un accord en utilisant la souris, cliquez sur l'endroit où vous souhaitez ajouter la note
Pour ajouter une note à un accord en utilisant un clavier MIDI, vous pouvez : soit jouer toutes les notes à la fois, soit les jouer l'une après l'autre mais sans relâcher la touche précédente avant d'appuyer sur la suivante
Pour ajouter une note à un accord en utilisant le clavier de piano virtuel, maintenez la touche Maj pressée pendant que vous cliquez sur la note.

Quand on utilise Maj+A–G pour ajouter une note à un accord, la note est ajoutée au-dessus des notes déjà présentes à la position du curseur. Il est également possible de placer la note en précisant l'intervalle de celle-ci, au-dessus ou au-
dessous de la note actuellement sélectionnée.

Pour ajouter un intervalle au-dessus de la note sélectionnée, utiliser un des moyens suivants :
Dans la barre de menu, ouvrez Ajouter → Intervalles et sélectionnez un intervalle dans la liste
Avec le clavier, utiliser les touches Alt+1-9.

Pour ajouter des intervalles sous la note sélectionnée :
Il est également possible d'utiliser le menu
Avec le clavier, vous aurez besoin de définir des raccourcis clavier personnalisés (voir Préférences).

Saisir des silences

Les silences peuvent être saisis en utilisant le clavier de l'ordinateur ou la souris. La durée est définie de la même manière que pour les notes (par exemple en utilisant la barre d'outils ou les raccourcis claviers 1–9). Ensuite, au lieu de saisir
la hauteur comme pour une note, choisir l'une des options suivantes :

Depuis le clavier de l'ordinateur : tapez 0 (zéro)
Depuis la barre d'outils de saisie des notes : cliquez sur l'icône du silence puis cliquer dans la partition

Avec la souris : faites un clic droit dans la partition.
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Saisir des altérations

Les altérations standard (dièse, bémol, bécarre, double dièse, double bémol) peuvent être saisies soit en en sélectionnant une altération avant de saisir la hauteur de note qu'elle modifie, soit en l'ajoutant à une note déjà saisie.

Sélectionner une altération avant d'entrer une note

Pour spécifier l'altération à appliquer à la prochaine note saisie, on peut utiliser les boutons sur la barre d'outils Saisie de notes située au-dessus de la partition ou bien le raccourcis clavier correspondant. Cela peut être réalisé aussi bien
avant ou après avoir sélectionné la durée de note.

Les raccourcis clavier par défaut sont :

Bémol : -
Dièse : +
Bécarre : =

Contrairement à la sélection de la durée — qui s'applique à toutes les notes suivantes jusqu'à ce qu'elle soit modifiée — une altération s'applique exclusivement à la prochaine note saisie. Mais les règles usuelles de la notation musicale
s'appliquent aussi : si vous attribuez un bémol sur une note donnée, toutes les notes suivantes identiques de la même mesure seront altérées de la même façon, même si aucun signe bémol explicite ne sera ajouté devant.

Ajouter une altération après la saisie d'une note

Les altérations appropriées sont automatiquement ajoutées au notes quand on augmente ou diminue leur hauteur :

↑ : augmente la hauteur d'un demi-ton (effet d'un dièse).
↓ : diminue la hauteur d'un demi-ton (effet d'un bémol).

Vous pouvez aussi appliquer une altération à une note en cliquant sur l'icône appropriée dans la palette Altérations. Cette palette contient aussi un nombre important d'altérations micro-tonales et autres altérations spéciales.

Ajouter des altérations de précaution

Bien que les règles du solfège précisent qu'une barre de mesure annule toutes les altérations qui l'ont précédée, ce qui fait que toutes les notes de la ligne ou interligne de portée retournent à la hauteur indiquée par l'armure, il est considéré
comme bonne pratique de pouvoir ajouter quand même un rappel d'altération, dite altération de précaution, pour lever toute ambiguïté. Cela ne change pas la hauteur de la note et ne peut donc être ajouté au moyen des touches ↑ and ↓.
Cependant, toutes les autres méthodes décrites plus haut fonctionnent.

Bien que l'emploi de parenthèses ou de crochets ne soit pas requis pour les altérations de précaution, certains éditeurs ont quand même fait le choix de les utiliser. Pour ajouter des parenthèses ou des crochets autour d'une altération, vous
devrez temporairement quitter le mode de saisie des notes, sélectionner l'altération puis utiliser : soit le panneau Propriétés pour sélectionner le type de crochets à ajouter, soit cliquer sur les parenthèses ou les crochets dans la section Plus
de la palette Altérations.

Remarque : il existe aussi un jeu de plugins préinstallé avec MuseScore Studio qui peut automatiquement ajouter des altérations de précaution quand c'est nécessaire.

Ajouter des liaisons de prolongation

Une liaison de prolongation est une ligne incurvée placée entre deux notes de même hauteur, indiquant qu'elle doit être jouée comme une seule et même note. Même si elles se ressemblent, les liaisons de prolongation ne doivent pas être
confondues avec les liaisons de phrasé qui joignent des notes de différentes hauteurs et qui indiquent un phrasé legato.

MuseScore Studio facilite grandement la saisie des liaisons de prolongation. Comme elles sont toujours entre notes de même hauteur, il n'est pas nécessaire de préciser la hauteur de la seconde note — il suffit de sélectionner la durée et de
saisir la liaison ; MuseScore Studio ajoutera la note automatiquement. Après avoir saisi la première note, suivez ces étapes pour créer la liaison de prolongation :

Sélectionnez la durée de la seconde note

Cliquez sur l'icône Liaison de prolongation dans la barre d'outils ou utilisez le raccourci clavier T

La liaison de prolongation ajoute la deuxième note et la lie à la première en une seule étape. Si la première note saisie fait partie d'un accord, la commande liaison de prolongation va créer un deuxième accord complet avec les mêmes
hauteurs de notes que le premier et lier l'ensemble des notes.

Remarque : les liaisons de prolongation connectent normalement des notes adjacentes dans la même voix, mais MuseScore Studio permet aussi de lier des notes non adjacentes ou des notes de différentes voix comme cela est expliqué
dans la section sur l'édition des notes.

Voir aussi

Éditer notes et silences
Voix
Divisions irrégulières
Modes de saisie alternatifs
Tablature
Notation des percussions
Notation par slashs
Têtes de notes

Travailler avec plusieurs voix

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Vue d'ensemble

Une voix MuseScore est une ligne de musique écrite sur une portée avec un rythme indépendant d'une autre ligne musicale existant dans la même portée. D'autres programmes de notation musicale utilisent le terme de "couche".

Le terme de "voix" peut être utilisé dans un autre sens : il sert à désigner un registre en musique vocale : soprano, alto, ténor, basse, par exemple. Il est important de ne pas confondre ces différents usages en considérant que les quatre voix
d'une chorale SATB (sopranos, altos, ténors, basses) correspondent aux "voix" 1 à 4 de MuseScore Studio (voir plus bas) ; ce qui équivaudrait à comparer des pommes et des poires.

MuseScore Studio permet d'utiliser jusqu'à quatre voix par portée : Voix 1, Voix 2, Voix 3, Voix 4. Quand on écrit de la musique sur une portée, il est habituel de commencer par la voix 1 puis de passer à la voix 2. Les voix 3 et 4 sont
rarement utilisées.

Deux voix sur la même portée sont normalement indiquées par des hampes de direction opposée — la voix la plus haute avec les hampes dirigées vers le haut, la voix la plus basse avec les hampes vers le bas :
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Dans une composition à quatre parties SATB écrite sur deux portées, vous devriez utiliser les voix 1 & 2 sur la portée du haut pour les voix Soprano & Alto et les voix 1 & 2 sur la portée du bas pour les voix Ténor & Basse :

Saisir des notes et des silences dans différentes voix

La première étape pour saisir des voix multiples est de déterminer si vous avez besoin d'écrire les notes comme voix dans une portée ou de les répartir dans plusieurs portées — comme 4 voix réparties sur les 2 portées d'un piano — ou
dans plusieurs instruments — comme 4 voix réparties dans 4 portées d'instrument à cordes — . Vous devez prendre en compte les fonctionnalités de la notation permise par MuseScore Studio ainsi que vos besoins de
production plutôt que baser votre décision sur des considérations purement académiques :

MuseScore Studio définit automatiquement la direction des hampes de notes en fonction de la voix et du nombre total de voix utilisées dans chaque mesure. Dans les mesures où seule la voix 1 est utilisée sans aucune note ou silence
écrite dans les autres voix, la direction des hampes de notes est déterminée par la hauteur de note — les notes au-dessus de la ligne centrale ont des hampes qui pointent vers le bas, les notes au-dessous de la ligne centrale vers le
haut. Dans les autres cas, la direction des hampes est déterminée par la voix — vers le haut pour les voix 1 et 3, vers le bas pour les voix 2 et 4.
Pour forcer manuellement le changement de direction des hampes, utilisez le bouton Changer de sens de la barre d'outils ou le raccourci clavier X (voir aussi Hampes et crochets de notes).
Écrire directement en voix 2 peut sembler correct sur le plan académique mais MuseScore Studio créera automatiquement des symboles de silence en voix 1 qui pourraient s'avérer redondants dans certains cas. Les options à utiliser
dans ce scénario sont : soit de masquer manuellement les silences à postériori (voir comment faire), soit de simplement utiliser la voix 1 à la place de la voix 2.
Comme il n'est pas encore possible d'assigner différents sons à des voix individuelles, vous pouvez avoir à utiliser plusieurs instruments. Par exemple, vous ne pouvez pas assigner le son virtuel Soprano à la voix 1 et le son virtuel
Ténor à la voix 2, mais soit l'une soit l'autre dans la même portée.
Vous devrez parfois utiliser des voix multiples dans une portée pour créer un certain résultat visuel dans la notation résultant de MuseScore Studio, alors qu'elles ne sont pas réellement des voix sur le plan académique. Par exemple, à
l'intérieur d'une voix dans MuseScore Studio, un accord peut seulement être créé avec des notes de même durée. Si les notes constituant un accord ont des durées différentes, vous devez utiliser des voix séparées pour les écrire. Une
liste des scénarios communs similaires peut être trouvée dans la page Voix du Manuel de MuseScore 3 .

Utiliser plusieurs instruments

Si vous décidez que vous avez besoin de noter différentes voix dans différents instruments, commencez par créer ces instruments en utilisant Configurer votre partition : Choisir des instruments puis éditez les symboles de clefs comme
souhaité avant de composer sur la voix 1 dans toutes ces partitions. Un exemple commun est d'écrire les quatre voix SATB dans les voix 1 de quatre instruments.

Pour convertir des portées séparées en multiples voix dans une seule portée (et vice-versa), voir Rassembler et éclater. Un exemple commun est la conversion d'une partition SATB ouverte <-> réduite.

Saisir des notes et silences dans des différentes voix d'une même portée

Pour saisir des notes dans une voix 1, 2, 3 ou 4 :

Sélectionnez le point de départ dans la portée.
Cliquez sur l'icône crayon de la barre d'outils ou tapez la touche N pour entrer mode saisie de notes.
Sélectionnez la voix souhaitée en utilisant les icônes de la barre d'outils ou à l'aide d'un de ces raccourcis clavier : Ctrl+Alt+1–Ctrl+Alt+4
Saisissez les notes et silences normalement, comme décrit dans Saisie des notes et des silences

Vous pouvez répéter ces étapes pour saisir des notes dans d'autres voix.

Remarque: pour saisir de nouvelles notes, assurez-vous d'être en mode saisie de notes avant de sélectionner la voix désirée. Dans le cas contraire, vous obtiendrez à la place un changement de la voix de tout élément sélectionné.

Remarque : la barre d'outils des notes n'affiche par défaut que les voix 1 et 2. Vous pouvez rendre visibles toutes les icônes de voix en utilisant les contrôles qui apparaissent quand on clique sur l'image de la roue crantée dans la barre
d'outils de saisie des notes. Pour plus d'information, voir les détails dans la section Personnaliser la barre d'outils des notes.

Éditer les notes et silences dans plusieurs voix

Ajuster les silences

Normalement, chaque voix devrait inclure autant de silences que nécessaire pour figurer tous les temps d'une mesure. MuseScore Studio les crée automatiquement. Dans les mesures comportant de multiples voix, les silences sont
automatiquement ajoutés aux voix de numéro moins élevé, à chaque fois que cela est approprié. MuseScore Studio ajuste également le positionnement des silences pour éviter la collision avec d'autres éléments.

Pour masquer, effacer ou ajuster la position de ces silences afin de créer une plus belle partition, utilisez une des méthodes suivantes :

Masquer ou supprimer des silences

Les silences peuvent être masqués en les sélectionnant puis en décochant la case Visible dans le panneau Propriétés ou en utilisant le raccourci clavier V.

Les silences des voix 2-4 peuvent aussi être supprimés, après les avoir sélectionnés, à l'aide de la touche Suppr.. Cependant, cela crée un "vide" dans les voix qui peut rendre plus compliquée une édition future. Pour restaurer les silences
d'une voix, on peut utiliser les commandes présentes dans Outils → Voix pour échanger le contenu d'une voix avec celui de la voix 1, ce qui remplit de nouveau les vides avec des silences. On peut alors utiliser la même commande pour
remettre chaque voix à la place qu'elle occupait précédemment.

Remarque : pour assurer la durée correcte de chaque mesure, les silences de la voix 1 peuvent être cachés mais ils ne peuvent pas être supprimés.

Repositionner les silences

Bien que MuseScore Studio évite habituellement les collisions entre les différentes voix, il peut être parfois pratique de déplacer les silences vers le haut ou vers le bas pour créer plus d'espace ou pour clarifier la voix à laquelle ils
s'appliquent.

Pour repositionner un silence verticalement, sélectionnez-le puis tapez ↑ ou ↓ pour le déplacer d'un interligne à la fois.

Pour plus d'informations sur le positionnement manuel, voir Modifier la position des éléments.

Vous pouvez aussi modifier le décalage vertical par défaut entre les silences et les éléments des autres voix, de 1 à 2 espaces, dans Format → Style… → Silences et Pauses multimesures.

Modifier la voix de notes existantes

Les notes préalablement enregistrées dans une voix peuvent être déplacées dans une autre voix. Pour plus d'informations, voir Modifier une voix en mode normal.

Combiner des voix dans des accords

Dans les cas où les rythmes correspondent, les notes préalablement saisies comme des voix différentes peuvent être combinées en accords dans une même voix. Pour plus d'informations, voir la commande Rassembler.

Séparer des accords en voix

Pour séparer un accord écrit dans une voix en notes séparées dans plusieurs voix :
1. - Sélectionnez manuellement les notes
- Cliquez sur le bouton de la barre d'outils pour assigner une voix aux notes sélectionnées ou utilisez le raccourci clavier Ctrl+Alt+1 – Ctrl+Alt+4.
2. Éclatez dans une portée vide puis rassembler. Voir Rassembler et éclater

Voir aussi

Manuel de MuseScore 4 https://musescore.org/fr/print/book/export/html/329209?toc=1#undefin...

45 sur 199 04/07/2025, 12:24

https://musescore.org/fr/node/278602
https://musescore.org/fr/node/278602
https://musescore.org/fr/print/book/export/html/329209?toc=1#node-329655-changing-instruments
https://musescore.org/fr/print/book/export/html/329209?toc=1#node-329655-changing-instruments
https://musescore.org/fr/print/book/export/html/329209?toc=1#node-329660-Entering_note_input_mode
https://musescore.org/fr/print/book/export/html/329209?toc=1#node-329660-Entering_note_input_mode
https://musescore.org/fr/print/book/export/html/329209?toc=1#node-329660-entering-notes
https://musescore.org/fr/print/book/export/html/329209?toc=1#node-329660-entering-notes
https://musescore.org/fr/print/book/export/html/329209?toc=1#node-329660-Entering_note_input_mode
https://musescore.org/fr/print/book/export/html/329209?toc=1#node-329660-Entering_note_input_mode
https://musescore.org/fr/print/book/export/html/329209?toc=1#node-330536-voice-normal
https://musescore.org/fr/print/book/export/html/329209?toc=1#node-330536-voice-normal
https://musescore.org/fr/print/book/export/html/329209?toc=1#node-330541-customize-toolbars
https://musescore.org/fr/print/book/export/html/329209?toc=1#node-330541-customize-toolbars
https://musescore.org/fr/print/book/export/html/329209?toc=1#node-331419-Changing-position-of-elements
https://musescore.org/fr/print/book/export/html/329209?toc=1#node-331419-Changing-position-of-elements
https://musescore.org/fr/print/book/export/html/329209?toc=1#node-330536-voice-normal
https://musescore.org/fr/print/book/export/html/329209?toc=1#node-330536-voice-normal
https://musescore.org/fr/print/book/export/html/329209?toc=1#node-329717-implode
https://musescore.org/fr/print/book/export/html/329209?toc=1#node-329717-implode


Parties (et Partie dans le glossaire)
Éditer les notes et les silences
Hampes et ligatures
Positionner les éléments
Rassembler et éclater

Méthodes alternatives de saisie des notes

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Accéder à des méthodes alternatives de saisie de notes

En plus de la méthode de saisie de note par défaut Pas à pas, il existe plusieurs autres moyens de réaliser la saisie d'une notation dans MuseScore Studio.

Pour accéder à ces méthodes alternatives :

Cliquez et maintenez le bouton Saisie de notes de la barre d'outils de saisie des notes
Choisissez l'une des méthodes disponibles proposées.

Les utilisateurs de clavier d'ordinateur peuvent accéder au bouton Saisie de notes en tapant plusieurs fois Maj+Tab ou Maj+F6 depuis la partition jusqu'à ce qu'il soit sélectionné. Une fenêtre peut parfois afficher un texte du genre "Mode de
saisie par défaut (pas à pas)". Tapez Espace quand le bouton est sélectionné pour ouvrir un menu qui contient toutes les options de saisie disponibles.

Chaque méthode de saisie de notes peut aussi être activée directement en utilisant un raccourci clavier spécialement attribué (Voir Raccourcis clavier pour apprendre comment s'y prendre).

Noter que la méthode sélectionnée reste effective même après avoir quitté le mode de saisie. Elle sera de nouveau activée la prochaine fois que vous entrerez dans le mode de saisie de notes. Aussi, si vous changez pour la méthode
Hauteur des notes existantes pour modifier un court passage, assurez-vous de revenir à la méthode Pas à pas une fois que vous aurez terminé.

Saisir uniquement le rythme

La méthode Rythme (sans hauteur) permet de saisir des durées à l'aide d'un seule touche. Cela est particulièrement utile pour les instruments à percussions à hauteur non déterminée qui utilisent un seul son. En complément, on peut
combiner les méthodes Rythme et Hauteur des notes pour une organisation efficiente du travail dans certaines circonstances.

Sélectionnez le point de départ dans la partition
Sélectionnez la méthode Rythme comme décrit ci-dessus
Sélectionnez une durée depuis la barre d'outils de saisie des notes ou utilisez les raccourcis clavier 1-9, pour ajouter une note de la durée sélectionnée
Ajoutez une note pointée en tapant . et en sélectionnant ou en tapant la durée souhaitée. Dans ce mode, la durée pointée est basculée en mode actif/inactif pour la saisie de toutes les durées suivantes. Il est important de noter que la
durée n'a pas besoin d'être activée avant de saisir la valeur de note, plutôt qu'après.
Saisissez les silences en cliquant sur l'icône silence dans la barre d'outils de saisie des notes et sélectionnez/tapez la durée souhaitée. Si la durée souhaitée a déjà été sélectionnée (lors de la saisie de la note précédente), tapez
simplement 0 pour saisir le silence. Cliquez sur le bouton silence pour revenir à la saisie des notes.
Continuez de taper les touches de durée pour entrer les notes avec les durées choisies.

Par défaut, les notes sont saisies dans l'interligne centrale de la portée. Vous pouvez utiliser les touches du curseur pour changer la hauteur de la note venant d'être saisie. Les notes suivantes seront aussi saisies à cette hauteur. Vous
pouvez aussi utiliser le mode Hauteur des notes pour saisir rapidement les hauteurs d'un passage après en avoir saisi le rythme.

Saisir uniquement la hauteur des notes

La méthode de saisie Hauteur des notes existantes permet de changer les hauteurs d'une séquence de notes tout en conservant leurs durées.

Sélectionnez le point de départ dans la partition
Sélectionnez la méthode Hauteur des notes comme décrit ci-dessus ou utilisez le raccourci clavier Ctrl+Maj+I (Mac : Cmd+Maj+I)
Saisissez les hauteurs de notes en utilisant le clavier de l'ordinateur, un clavier MIDI ou le clavier de piano virtuel. Remarque : vous ne pouvez pas utiliser la souris pour saisir les notes dans le mode Hauteur des notes.

Le mode Hauteur des notes peut être une façon très efficiente pour saisir des notes dans des musiques qui utilisent des motifs rythmiques qui se répètent. Il suffit de copier et coller le passage existant qui utilise le même rythme pour créer
le nouveau passage avant de modifier la hauteur des notes avec le mode Hauteur des notes. La même technique peut être utilisée pour saisir des parties de plusieurs instruments ou voix qui partagent le même rythme mais ont des hauteurs
de notes différentes.

Saisir les notes en temps réel

La méthode de saisie Temps réel vous autorise de façon basique à jouer un morceau sur un clavier MIDI (ou sur le clavier de piano virtuel de MuseScore Studio) pour que la notation soit ajoutée pour vous. Cependant, vous devez être
alertés sur les limitations connues suivantes :

Vous devez présélectionner la plus petite durée que vous souhaitez utiliser.
Vous ne pouvez pas saisir de triolets dans le mode de saisie Temps réel.
Vous ne devez saisir les notes que dans une seule portée et dans une seule voix, comme c'est le cas dans les autres modes.
Il n'est pas possible d'utiliser le clavier d'un ordinateur pour entrer des notes en Temps réel.

Ces restrictions signifient que MuseScore Studio ne doit avoir que très peu de choses à deviner pour déterminer comment votre jeu doit être saisi afin de garantir la précision de cette méthode.

Temps réel (métronome)

Avec le mode Temps réel (métronome), vous jouez à un tempo fixe indiqué par la pulsation du métronome. Vous pouvez ajuster le tempo en modifiant le délai entre les notes depuis le menu : Édition → Préférences... → Saisie des notes
(Mac : MuseScore → Préférences... → Saisie des notes).

Sélectionnez le point de départ dans la partition
Sélectionnez le mode Temps réel (métronome) comme décrit ci-dessus
Sélectionnez, dans la barre d'outils de saisie des notes, la figure de note qui représentera la pulsation du métronome
Appuyez et maintenez une touche du clavier MIDI ou du piano virtuel pour ajouter une note à la partition
Écoutez les pulsations du métronome — à chaque pulsation la note augmente de la durée choisie
Relâchez la touche quand la note a atteint la durée souhaitée.

La partition cesse d'avancer dès que l'on relâche la touche. Si vous voulez que la partition continue d'avancer — ce qui est nécessaire pour saisir des silences — vous devez alors utiliser le raccourci clavier Avance en temps réel pour
démarrer le métronome. La même action stoppera le métronome de nouveau.

Temps réel (pédale)

Avec le mode Temps réel (pédale), vous indiquez votre tempo de saisie en tapant sur une touche ou une pédale. Vous pouvez jouer à la vitesse que vous souhaitez et celle-ci n'a pas besoin d'être constante. La touche par défaut pour régler
le tempo (appelée "Avance en temps réel") est Entrée sur un clavier d'ordinateur (Mac : Fn+Entrée), mais il est fortement recommandé d'utiliser plutôt une touche de clavier MIDI ou une pédale MIDI (voir plus loin).

Sélectionnez le point de départ dans la partition
Sélectionnez le mode Temps réel (pédale) comme décrit ci-dessus
Sélectionnez, dans la barre d'outils de saisie des notes, la figure de note qui représentera la pulsation du métronome
Appuyez et maintenez une touche du clavier MIDI ou du piano virtuel pour ajouter une note à la partition
Appuyez sur le raccourci "Avance en temps réel" — à chaque appui, la note augmente de la durée choisie
Relâchez la touche quand la note a atteint la durée souhaitée.

Raccourci Avance en temps réel

Le raccourci "Avance en temps réel" est utilisé pour démarrer le métronome dans le mode Temps réel (métronome) ou pour marquer le tempo dans le mode Temps réel (pédale). Il est appelé "Avance en temps réel" car il fait avancer la
position d'entrée, ou "avance", dans la partition.

Le raccourci par défaut de Avance en temps réel est Entrée sur le clavier d'un ordinateur (Mac : Fn+Entrée), mais il est fortement recommandé d'utiliser plutôt une touche de clavier MIDI ou une pédale MIDI via la télécommande MIDI de
MuseScore Studio. La télécommande MIDI est disponible depuis le menu : Édition → Préférences... → Assignations MIDI (Mac : MuseScore → Préférences... → Assignations MIDI).

De façon alternative, si vous avez une pédale USB ou une pédale reliée à l'ordinateur qui peut simuler une touche du clavier, vous pouvez l'utiliser pour remplacer la touche Entrée.

Lorsque les notes sont entrées, elles sont placées juste avant le point de départ sélectionné, mis en évidence avec un marqueur carré bleu. L'élément de départ et toutes les notes ou silences qui suivent dans la même mesure seront décalés
vers l'avant. Vous pouvez déplacer le point d'insertion vers l'avant et vers l'arrière à l'aide des touches fléchées → ou ← ; le nouveau point d'insertion est alors mis en évidence.
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Insérer des notes

La méthode de saisie Insérer permet d'insérer et d'effacer des notes et silences à l'intérieur des mesures, en décalant automatiquement les notes et silences suivants vers l'avant ou vers l'arrière dans la mesure. La durée de la mesure est
automatiquement mise à jour en suivant.

Pour insérer une note :

Sélectionnez le point de départ dans la partition.
Sélectionnez le mode Insérer comme décrit ci-dessus.
Saisissez une note ou un silence comme vous le feriez en mode Pas à pas. Chaque note est insérée avant la position actuelle du curseur et la durée de la mesure est augmentée pour compenser.

De façon alternative, si vous n'avez qu'une ou deux notes à insérer, vous pouvez le faire directement dans le mode par défaut Pas à pas. Appuyez sur Ctrl+Maj (Mac : Cmd+Maj) pendant que vous ajoutez la note avec la souris ou le raccourci
clavier (A-G).

Pour insérer un silence, commencer par insérer une note de la durée souhaitée puis appuyer sur Suppr..

Pour effacer une note ou un silence, utiliser le raccourci clavier Ctrl+Maj+Suppr.. La durée de la mesure est réduite pour compenser. Le raccourci fonctionne à la fois dans les modes de saisie Pas à pas et Insérer.

Du fait que l'insertion ou la suppression de notes peut entraîner l'augmentation ou la diminution de la durée de mesure au-delà de ce qui est spécifié dans l'indication de mesure de la partition, un petit signe "+" ou "-" seront affichés au-
dessus de la mesure si c'est le cas.

Ajouter et supprimer des mesures

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Ajouter des mesures

MuseScore Studio permet d'insérer ou de supprimer des mesures dans la partition en utilisant plusieurs méthodes. Vous pouvez insérer des mesures :

Après une sélection
Avant une sélection
Au début de la partition
À la fin de la partition.

Menu contextuel mesure

Pour insérer une ou plusieurs mesures :

Faites un clic droit sur une zone vide de la mesure
Depuis le menu contextuel qui s'ouvre, choisissez Insérer des mesures
Dans les options qui s'affichent, choisissez l'endroit où insérer la ou les mesures(s)
Complétez la fenêtre de dialogue avec le nombre de mesures à insérer et cliquez sur OK.

Le panneau Propriétés

Pour insérer une ou plusieurs mesures :

Cliquez sur une mesure
Allez sur le panneau Propriétés
Cliquez sur le bouton Insérer des mesures dans la section Mesure
Renseignez le nombre de mesures à insérer (ou laissez-le à “1” pour insérer une seule mesure)
Choisissez où insérer ces mesures dans le menu déroulant (ou laissez-le tel quel pour insérer la ou les nouvelle(s) mesure(s) après le point de sélection)
Appuyez sur le bouton +

Cet affichage reste ouvert jusqu'à ce que vous cliquiez dans une autre partie de l'interface utilisateur. De cette façon, vous pouvez continuer à cliquer sur le bouton + autant de fois que nécessaire pour insérer les mesures supplémentaires
souhaitées.

En outre, vous pouvez insérer des mesures depuis l'un de deux menus suivants :

Barre d'outils de saisie des notes

Sélectionnez un élément dans la partition (ce peut être n'importe quoi en dehors des objets lignes)
Cliquez sur le bouton + de la barre d'outils Saisie de notes
Naviguez jusqu'à Mesures
Choisissez où insérer la ou les nouvelle(s) mesure(s)
Complétez la fenêtre de dialogue avec le nombre de mesures à insérer
Cliquez sur OK.

Barre de menu

Sélectionnez un élément dans la partition (ce peut être n'importe quoi en dehors des objets lignes)
Cliquez sur Ajouter dans la barre de menu
Naviguez jusqu'à Mesures
Choisissez où insérer la ou les nouvelle(s) mesure(s)
Complétez la fenêtre de dialogue avec le nombre de mesures à insérer
Cliquez sur OK.

Insérer des mesures avec des raccourcis clavier

Pour rapidement insérer une mesure avant le point de sélection :

Sélectionnez un élément dans la partition (ce peut être n'importe quoi en dehors des objets lignes)
Appuyez sur Ins

Vous pouvez insérer davantage de mesures avant le point de sélection en répétant l'appui sur Ins.

Pour rapidement insérer plusieurs mesures avant le point de sélection :

Sélectionnez un élément dans la partition (ce peut être n'importe quoi en dehors des objets lignes)
Appuyez sur Ctrl+Ins (Mac : ⌘+Ins)
Complétez le nombre de mesures à insérer dans la fenêtre de dialogue qui s'affiche
Cliquez sur OK

Pour ajouter des mesures à la fin de la partition vous pouvez utiliser les raccourcis clavier
* pour une seule mesure : Ctrl+B (Mac : ⌘+B)
* pour plusieurs mesures : Alt+Maj+B (Mac : Option+Maj+B).

Ajouter des mesures à un cadre

Il est aussi possible d'ajouter des mesures à un cadre dans la partition :
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Cliquez sur le cadre
Utilisez une des méthodes décrites dans les chapitres "Barre d'outils de saisie des notes" ou "Barre de menu" ou un raccourci clavier (voir ci-dessus).

Supprimer des mesures

Pour supprimer une ou plusieurs mesures en utilisant des raccourcis clavier :

Sélectionnez une mesure (ou gardez la touche Maj appuyée pour sélectionner plusieurs mesures)
Tapez Ctrl+Retour arr. ou Ctrl+Suppr (Mac : ⌘+Retour arr. ou ⌘+Suppr).

De façon alternative :

Sélectionnez une mesure (ou gardez la touche Maj appuyée pour sélectionner plusieurs mesures)
Faites un clic droit sur n'importe quelle mesure de la sélection
Sélectionnez Effacer les mesures

Vous pouvez également :

Sélectionner une mesure (ou garder la touche Maj appuyée pour sélectionner plusieurs mesures)
Aller dans le menu Outils
Sélectionner Supprimer la plage sélectionnée

Supprimer les dernières mesures vides

Pour supprimer toutes les mesures vides à la fin de la partition :

Allez dans le menu Outils
Sélectionnez Supprimer les mesures restantes

Voir aussi

Pages relatives aux autres mesures :

Numérotation des mesures
Pauses de mesure et multimesures
Anacrouse et mesures non comptées
Propriétés des mesures
Notation non mesurée et Mensurstrich

Sélectionner des éléments

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

On peut sélectionner des éléments dans la partition pour réaliser des actions telles que la duplication. Les éléments sélectionnés apparaissent colorés avec la couleur de Voix auxquels chaque élément appartient ; dans les autres cas, ils sont
en noir par défaut. La Voix 1 est bleue, la Voix 2 verte, la Voix 3 orange et la Voix 4 violette. Ces couleurs peuvent être modifiées via Édition → Préférences : Avancé : voir le chapitre Préférences.

Le statut de la sélection en cours est affiché dans la barre de statut en bas à gauche. Il est modifié lorsque la sélection est mise à jour par l'utilisateur. Il existe trois statuts de sélection :

statut "sélection d'un élément individuel" : le statut affiche le type de l'élément ;
statut Sélection groupée : un rectangle bleu entourant la sélection est visible dans la partition ;
statut Liste de sélections.

Les exemples affichés ci-dessous illustrent
- la "sélection d'un élément individuel" de la Voix1 :

- une "sélection groupée" avec sa barre de statut :

Sélectionner un seul élément

Pour sélectionner un élément isolé, il suffit de cliquer dessus avec la souris. Cliquer sur un élément le sélectionne toujours sauf pour l'élément Mesure. Cliquer sur un espace vide d'une mesure (à l'intérieur des cinq lignes de portée de la
mesure) sélectionne automatiquement l'ensemble des objets qu'elle contient, ce qui entraîne une Sélection groupée.

Pour sélectionner un élément isolé avec le clavier, utilisez les touches pour naviguer jusqu’à l’élément. Notez que, dans MuseScore Studio, il n’y a pas de concept séparé entre le "curseur" et une sélection, à l’exception du mode Saisie de
notes. Dans le mode Normal, la navigation avec les touches fléchées droite et gauche permet de se déplacer d’un élément sélectionné à l’autre. Même s’il ne s’agit pas, techniquement parlant, d’un curseur, la sélection en tant que telle agit
de la même façon.

En elles-mêmes, les touches fléchées ne permettent de naviguer que d'une note ou silence à la fois. Utilisez Alt avec les touches fléchées pour naviguer entre tous les éléments, y compris les articulations, les nuances et autres symboles.

Éléments qui se chevauchent

Quand de multiples objets occupent la même position dans une partition et se chevauchent complètement, tels que deux notes ayant la même hauteur mais dans des Voix différentes, pressez Ctrl et cliquez de façon répétée sur l'objet pour
sélectionner alternativement les différents éléments concernés jusqu'à ce que l'objet souhaité soit sélectionné.

Sélectionner un élément individuel composant une note

La plupart des commandes qui agissent sur une note individuelle nécessite de sélectionne la tête de note, par exemple pour changer la hauteur de note. Une note consiste aussi en de multiples éléments incluant la tête de note, la hampe, le
crochet, le point, l’altération, etc. Chacun de ces éléments peut être sélectionné individuellement dans le but de régler précisément sa position.

Différentes façons de sélectionner plusieurs notes dans un accord

La sélection de plusieurs notes d'un accord peut résulter en deux statuts différents : c'est soit en une Sélection groupée, soit en une Liste de sélections : voir les sections respectives pour le mode opératoire.

La plupart des commandes qui agissent sur un accord nécessitent une Sélection groupée comme affiché sur l'image au-dessus. Ces commandes comprennent Copier et coller.

Il existe un raccourci clavier spécial pour sélectionner toutes les notes de l'accord. Vérifiez d’abord que rien d’autre n’est en cours de sélection (vous pouvez taper sur la touche Echap pour vous en assurer) puis pressez Maj en cliquant sur
n'importe quelle tête de note de l'accord. Des notes d'autres voix peuvent être inclues de manière imprévue : voir la section Exclure des éléments d’une Sélection groupée pour savoir comment l'éviter si nécessaire.

La commande de répétition de sélection (R) fonctionne aussi sur un accord individuel lorsqu'une seule note de cet accord est sélectionnée mais elle ne fonctionne pas avec une Liste de sélections. Voir le chapitre Copier et coller : Répéter
une sélection.
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Créer une Liste de sélections

Créez une Liste de sélections en sélectionnant manuellement des objets individuels ou de façon automatique à l'aide de certaines commandes.

Sélectionner plusieurs éléments de façon manuelle

Pour ajouter un élément à une sélection ou le supprimer, utilisez Ctrl (Mac : Cmd) puis cliquez sur l'objet. Cela crée une Liste de sélections. Cette méthode d'ajout/suppression n'est pas possible avec une mesure. Ajouter ou supprimer un
élément d'une Sélection groupée la converti aussi en Liste de sélections.

Les éléments positionnés en dehors de toute ligne de portée et qui ne chevauchent pas d'autres éléments peuvent être sélectionnés ensemble en utilisant la sélection par déplacement de souris. Pressez Maj et cliquez sur un espace vide (en
dehors des lignes de portée) puis faites glisser le curseur pour créer un cadre de sélection autour des éléments souhaités. Cela crée une Liste de sélections à condition qu'aucune note ou silence ne soit inclus(e) ; dans le cas contraire,
c'est une Sélection groupée qui est alors créée, utilisant la méthode de "point de départ et point d'arrivée".

Sélectionner automatiquement des éléments similaires

Pour sélectionner tous les éléments d’un type donné dans l’ensemble de la partition ou sur une portée donnée :

Faites un clic droit sur un élément de ce type
Dans le menu qui s’ouvre, cliquez sur Sélectionner → Similaire ou sur Sélectionner → Similaire sur cette portée , selon ce qui est approprié.

Pour sélectionner tous les éléments d’un type donné entre deux instants :

Cliquez sur le premier élément de ce type
Tapez Maj et cliquez sur le dernier éléments de ce type

—OU—

Créez une Sélection groupée
Faites un clic droit sur l'élément en question
Dans le menu qui s’ouvre, cliquez sur Sélectionner → Similaire dans cette sélection.

Pour créer des sélections plus complexes d’éléments similaires :

(Optionnel) Créez une Sélection groupée
Faites un clic droit sur l'élément en question
Dans le menu qui s’ouvre, cliquez sur Sélectionner → Plus
Cochez les cases souhaitées dans la fenêtre de dialogue sélection (voir ci-dessous).

Les options disponibles dépendent du type d’élément sélectionné par le clic droit.

Les options spécifiques de la sélection sont :

Même tête de note : notes qui ont le même type de tête de note (normal, croix, slash, etc.)
Même hauteur : notes de même nom, altération et octave
Même corde : notes sur la même corde (tablature seulement)
Même type : notes de même type (normal, acciaccatura, appoggiature)
Même type de note : notes de la même durée, sans tenir compte de la présence de point ou division irrégulière
Même durée: notes de la même durée effective
Même nom de note: notes qui ont le même nom et altération, sans tenir compte de l’octave
Même portée: notes dans la même portée
Même voix : notes dans la même voix
Dans la sélection : notes à l’intérieur de la sélection actuelle
Même système : notes dans le même système

En plus des options spécifiques relatives au type d’élément, il existe des options au bas de la fenêtre de dialogue qui sont communes à tous les types d’éléments. Seule une de ces actions, qui s’appliquent aux éléments sélectionnés, peut
être choisie.

Remplacer la sélection : si cochée, cette option remplace la sélection en cours
Ajouter à la sélection : si cochée, cette option ajoute les éléments à la sélection en cours
Retirer de la sélection : si cochée, cette option supprime les éléments de la sélection en cours

Créer une Sélection groupée

Une Sélection groupée inclut la plupart des éléments présents entre des points de départ et d’arrivée, précisés sur une ou plusieurs portées. C’est une technique requise pour effectuer une opérations de type Copier et coller.

Effectuer une Sélection groupée en déplaçant la souris

Pour sélectionner une plage de mesures et de portées avec la seule souris, utilisez la touche Maj en faisant glisser la souris pour dessiner un rectangle autour. Notez que cela n’est réalisable que pour des sélections relativement petites qui
s’affichent en même temps sur l’écran.

Effectuer une Sélection groupée en cliquant

Une méthode plus flexible pour réaliser des sélections groupées utilise une combinaison de clavier et de souris :

Cliquez sur la première note (ou silence) de la sélection souhaitée
Maintenez Maj et cliquez sur la dernière.

Entre les deux clics, vous pouvez utiliser les commandes de navigation pour positionner la partition à l'écran. Cela permet de faire des sélections qui couvrent plusieurs pages.

Cette méthode fonctionne également si vous cliquez la dernière note (silence) et que vous utilisez Maj pour cliquer sur la première.

Effectuer une Sélection groupée avec le clavier

En utilisant le clavier seul ou de façon initiale :

Sélectionnez la première note (ou silence) en utilisant le clavier pour la navigation ou en cliquant
Maintenez Maj pendant que vous utilisez le clavier pour étendre la sélection en naviguant.
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Les commandes disponibles sont :

Maj+Gauche et Maj+Droite pour étendre la sélection une note ou un silence à la fois
Maj+Ctrl+Gauche et Maj+Ctrl+Droite pour étendre la sélection une mesure à la fois (Mac : utilisez Cmd à la place de Ctrl)
Maj+Haut et Maj+Bas pour étendre la sélection d’une portée à la fois
Maj+Début et Maj+Fin pour étendre la sélection jusqu’au début ou à la fin du système
Maj+Ctrl+Début et Maj+Ctrl+Fin pour étendre jusqu’au début ou jusqu’à la fin de la partition (Mac : utiliser Cmd à la place de Ctrl)

Effectuer une Sélection groupée à l'aide de commandes spéciales

MuseScore Studio offre des commandes spéciales pour réaliser des sélections particulières :

Édition → Tout sélectionner ou Ctrl+A (Mac : Cmd+A) pour sélectionner la partition entière
Édition → Sélectionner une section pour sélectionner la section en cours de la partition (tout ce qui se trouve entre le premier saut de section et le suivant).

Exclure des éléments d’une Sélection groupée

Avant d'exécuter des actions sur une Sélection groupée, il est possible d'exclure certain(s) type(s) d’éléments. Par exemple, en supprimant les paroles de la sélection quand on duplique des notes, silences, et la plupart des autres marques
d’une phrase musicale ; ou en supprimant tout ce qui n’est pas dans la Voix 1 dans un morceau à plusieurs voix. Pour exclure des éléments d’un type donné :

Ouvrez le Filtre de sélection avec Affichage → Filtre de sélection
Décochez les cases de tous les éléments que vous souhaitez exclure de la sélection.

Notez que si vous excluez la Voix 1, vous ne serez plus en mesure de sélectionner les mesures qui ne contiennent aucune autre voix. Aussi, assurez-vous de restaurer la Voix 1 après avoir réalisé l’opération pour laquelle vous l’avez exclue.
Par exemple, si vous voulez copier-coller uniquement la voix 2, réalisez votre sélection groupée, utilisez le Filtre de sélection pour exclure la voix 1, utilisez Édition → Copier ou Ctrl+C, puis restaurez la case à cocher à côté de la Voix 1
avant de tenter de sélectionner la destination où doit être collée le passage copié.

Éditer des notes et des silences

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Vue d’ensemble

Ce chapitre aborde les méthodes pour éditer la musique qui existe déjà dans une partition. Le lecteur doit déjà être familier avec les méthodes de saisie de la musique expliquées dans le chapitre Saisir des notes et des silences.

Pour modifier une note (hauteur, durée, position chronologique, etc.) ou un silence sans une partition, utiliser au choix :

le mode de saisie des notes ou
le mode normal.

Effectuer des modifications dans le mode de saisie des notes

Entrez en mode de saisie des notes en cliquant sur l'icône crayon de la barre d'outils ou en utilisant le raccourci clavier N. Un curseur de saisie de note apparaît sous la forme d'une grande et fine boite bleu clair avec une bordure gauche
bleu foncé étendue sur toute la hauteur de la portée. Il indique que l'on est actuellement en mode de saisie des notes. Le curseur est positionné au début du temps ou du battement où la prochaine note ou le prochain silence sera ajouté.

Utilisez les touches pour déplacer le curseur sur la note ou le silence qui précède ou qui suit..

Modifier la durée d’une note en mode saisie de notes

Il y a deux commandes qui modifient la durée d’une note existante dans le mode saisie de notes :

Maj+W augmente la durée
Maj+Q diminue la durée

Les deux commandes ajouteront d’abord un point si approprié avant de proposer la note de durée plus petite ou plus grande. Par exemple, presser Maj+W sur une noire la transforme en noire pointée et une deuxième action Maj+W la change en
blanche.

Modifier la hauteur d’une note en mode saisie de notes

Les commandes pour changer la hauteur d’une note sélectionnée dans le mode de saisie de note sont :

↑ augmente la note d’un demi-ton (comme un dièse)
↓ baisse la note d’un demi-ton (comme un bémol)
Alt+Maj+↑ augmente d’un intervalle diatonique (note immédiatement au-dessus)
Alt+Maj+↓ diminue d’un intervalle diatonique (note immédiatement en dessous)
Ctrl+↑ (Mac : Cmd+↑) augmente la hauteur d’une octave
Ctrl+↓ (Mac : Cmd+↓) diminue la hauteur d’une octave.

Remplacer des notes et des silences en mode saisie de notes

Avec le mode par défaut pas-à-pas, les notes and silences sont saisis l'un(e) après l'autre. Il est basé sur la logique que, quand une note ou un silence est ajouté par l'utilisateur, les notes et silences qui suivent ajustent automatiquement leur
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durée (valeur de note) sans affecter le nombre total de battements des mesures.

C'est analogue à ce qu’un traitement de texte comme Microsoft Word appelle "remplacer" ou "écraser". Pour remplacer une note avec une nouvelle, saisissez-la directement. La nouvelle note remplace automatiquement ce qu'il y avait
précédemment sans besoin d'effacer préalablement l'ancienne note.

Pour ajouter une nouvelle note et déplacer les notes suivantes de façon qu'elles ne soient pas remplacées, vous pouvez soit :

Repositionner les notes suivantes en utilisant Copier et coller avant de saisir les nouvelles notes, ou
Utiliser un mode de saisie des notes différent que pas-à-pas (voir le chapitre Méthodes alternatives de saisie des notes).

Effacer des notes en mode saisie de notes

Pour effacer une note et la remplacer par un silence, tapez simplement Suppr..

Remarque : si vous souhaitez plutôt déplacer les notes suivantes plus tôt dans la chronologie pour qu’elles prennent la place de la note effacée, il n’est pas nécessaire d’effacer d’abord la note originale. Déplacez simplement les notes
suivantes en utilisant directement la fonction couper et coller.

Déplacer des notes en mode saisie de notes

Bien que la plupart des cas, le déplacement des notes soit réalisé dans le mode normal, il a y deux commandes qui peuvent être utilisées dans certains cas pour changer la position chronologique d’une note ou d’un silence en mode saisie
de notes. Si vous avez deux notes ou silences de la même durée et que vous voulez les échanger dans ce mode, vous pouvez utiliser Maj+← ou Maj+→ pour échanger une note ou silence avec sa voisine de la même durée.

Effectuer des modifications dans le mode normal

Utilisez le mode normal en quittant tout autre mode.

Pour quitter le mode de saisie des notes actuellement actif dans MuseScore Studio, tapez sur la touche Echap ou cliquez sur le bouton de saisie des notes ou tapez de nouveau sur la touche N. Le curseur de saisie des notes ne devrait plus
être visible après cela (voir la section "Effectuer des modifications dans le mode de saisie des notes").

Pour quitter le mode édition actuellement actif dans MuseScore Studio, tapez sur la touche Echap. Voir les pages Ajuster directement les éléments et Saisir et éditer du texte : Éditer du texte.

Sauf lorsque c’est précisé, les méthodes décrites ci-après agissent à la fois sur la sélection d’une seule note ou silence, sur la sélection d’une liste de notes ou silences, ou sur la sélection d’un groupe entier d’éléments. Voir la page Sélection
d’éléments pour en apprendre davantage.

Effectuer des modifications dans le mode normal

Attribuer une durée spécifique à des notes sélectionnées

Pour changer la durée d’une ou plusieurs notes sélectionnées dans le mode normal afin de leur donner une valeur spécifique, il vous suffit de cliquer sur la figure de note appropriée ou d’utiliser les raccourcis clavier correspondant : 1–9.

Augmenter ou diminuer la durée d’une note sélectionnée

Pour augmenter la durée d’une note sélectionnée, vous pouvez utiliser la commande Maj+W telle que décrite plus haut. Cela ajoute un point à la note, s’il n’est pas déjà présent, ou lui attribue la durée de la note de durée immédiatement
suivante si la note est déjà pointée. Par exemple, une croche sera changée en croche pointée. On peut aussi utiliser W pour doubler la durée, modifiant ainsi directement une croche en noire, ou une croche pointée en noire pointée.

Les commandes Maj+Q et Q exécutent l’opération inverse, diminuant ou réduisant de moitié la durée, de la même façon.

Toutes ces commandent ne fonctionnent que sur une seule note à la fois.

Doubler ou réduire de moitié toutes les notes d’une sélection de groupe.

Si vous avez saisi un morceau utilisant des croches et des doubles-croches mais que vous souhaitez doubler la durée de l’ensemble des notes et silences — ce qui double la durée du morceau — allez voir la section commandes pour coller
avec la moitié ou le double de la durée .

Modifier la hauteur des notes en mode normal

Les mêmes commandes qui servent à modifier la hauteur d’une note en mode de saisie de notes fonctionnent aussi en mode normal, y compris pour les sélections de note individuelle, de liste ou de groupe.
Ces commandes sont :

↑ augmente d’un demi-ton
↓ baisse d’un demi-ton
Alt+Maj+↑ augmente d’un intervalle diatonique
Alt+Maj+↓ diminue d’un intervalle diatonique
Ctrl+↑ (Mac : Cmd+↑) augmente la hauteur d’une octave
Ctrl+↓ (Mac : Cmd+↓) diminue la hauteur d’une octave.

En outre, quand vous êtes en mode normal, les boutons d’altération de la boîte d’outils Saisie de notes et les raccourcis clavier correspondants basculent (ajoutent ou suppriment) les altérations des notes sélectionnées, ce qui change
potentiellement leur hauteur. La palette Altérations peut aussi être utilisée pour ajouter des altérations aux notes sélectionnées.

Supprimer des notes et silences en mode normal

Pour supprimer une note et la remplacer par un silence, il suffit d’utiliser la touche Suppr..

Si plusieurs notes sont sélectionnées en tant que liste, Suppr. les remplace toutes individuellement par un silence.

Si on sélectionne un groupe, Suppr. remplace la partie entière avec le nombre correct de silences, conformément à la métrique musicale.

Les silences ne peuvent normalement pas être supprimés puisque cela signifierait de laisser une mesure avec un nombre de temps inférieur à celui qu’elle devrait comporter. Cependant, voir la commande de suppression d’une sélection
groupée ci-dessous pour s’informer sur la façon de réaliser cela lorsque c’est nécessaire. De même, les silences dans les voix 2 et 4 peuvent être supprimés sans que cela ait des conséquences sur les temps d’une mesure.

Supprimer des notes et silences et les temps qui leur sont associés

Pour supprimer complètement les notes et les silences — ce qui signifie laisser un morceau avec moins de mesures, (si des mesures entières sont sélectionnées) ou avec moins de temps dans une mesure (si une partie de mesure est
sélectionnée) — utilisez Outils → Supprimer la plage sélectionnée ou les raccourcis clavier Ctrl+Suppr. (Mac : Cmd+Suppr.).

Ajouter des liaisons de prolongation en mode normal

Des liaisons de prolongations peuvent être ajoutées en mode normal mais, à la différence du mode de saisie de notes où la commande ajoute automatiquement une note en créant une liaison, les deux notes doivent déjà exister.

Pour ajouter une liaison de prolongation dans le mode normal :

Sélectionnez une note que vous voulez lier par une liaison de prolongation à la note suivante de même hauteur
Cliquez sur l'icône liaison de prolongation dans la barre d’outils de saisie des notes ou utiliser le raccourci T ("tie" en anglais = liaison de prolongation)

Cela fonctionne même si la note suivante de la même hauteur appartient à une autre voix.

Si vous sélectionnez plusieurs notes, MuseScore Studio attribuera une liaison à chacune d’entre elles. Vous pouvez utiliser cette technique pour lier des accords complets en une seule fois.

Cette technique vous permet aussi de lier deux notes qui ne sont pas adjacentes.

Modifier une voix en mode normal

Une note saisie dans une voix donnée peut être déplacée dans une autre voix si c’est musicalement possible. On peut aussi échanger deux voix entre elles.

Déplacer des notes sélectionnées dans une autre voix

Pour déplacer une sélection d’une à plusieurs notes dans une autre voix, on peut soit cliquer sur les boutons de voix dans la barre d’outils, soit utiliser les raccourcis clavier Ctrl+Alt+1–4 (Mac : Cmd+Option+1–4). Les notes seront déplacées dans
la mesure où cela est possible sans compromettre le contenu actuel de la voix de destination.

Une note peut être déplacée dans une autre voix s’il existe actuellement un silence (figure de silence ou rien du tout) dans la voix de destination à la même position et pour la même durée que la note à déplacer. Dans ce cas, la note est
simplement déplacée dans la nouvelle voix..

Une note peut aussi être déplacée dans une autre voix s’il y a déjà une note ou un accord de même durée commençant à la même position. Dans ce cas, la note sera combinée avec na note ou l’accord existant.

Échanger le contenu de deux voix

MuseScore Studio peut aussi échanger le contenu de n’importe quelle paire de voix. Ces commandes ne fonctionnent que sur des mesures complètes, pas sur des notes individuelles.
Pour échanger le contenu de deux voix, utiliser la commande correspondante dans Outils → Voix :

Échanger les voix 1-2
Échanger les voix 1-3
Échanger les voix 1-4
Échanger les voix 2-3
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Échanger les voix 2-4
Échanger les voix 3-4

Voir aussi

Saisie des notes et des silences

Copier et coller

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Les commandes couper, copier et coller peuvent être utilisées pour reproduire des morceaux entiers de musique, déplacer chronologiquement de la musique en avant ou en arrière, copier du texte ou d’autres marques entre des portées,
échanger du contenu entre différentes mesures et plus encore.

Accéder aux commandes

Dans tous les cas, la première étape est de sélectionner ce que l’on a envie de couper ou de copier .
Comme avec les autres logiciels qui supportent le couper-copier-coller, on peut accéder à ces commandes : via le menu Édition, par l’intermédiaire d’un menu contextuel qui apparaît après un clic droit ou procédure équivalente (par exemple
: Ctrl + clic, ou tape avec deux doigts), ou avec les raccourcis clavier standards.

Commande Raccourci (Windows) Raccourci (Mac) Menu contextuel Menu principal

Couper Ctrl+X Cmd+X Couper Édition → Couper

Copier Ctrl+C Cmd+C Copier Édition → Copier

Coller Ctrl+V Cmd+V Coller Édition → Coller

Échanger avec le presse papier Ctrl+Maj+X Cmd+Maj+X Échanger avec le presse papier
Édition → Échanger avec le presse
papier

Coller avec une demi-durée Ctrl+Maj+Q Cmd+Maj+Q N/A Édition → Collage demi durée

Coller avec une double durée Ctrl+Maj+W Cmd+Maj+W N/A Édition → Collage double durée

Remarque : quand vous utilisez le menu contextuel, faites attention de toujours faire un clic droit sur un élément sélectionné ; si le clic droit est réalisé par erreur sur un emplacement vide, votre sélection sera perdue !

Copier une Sélection groupée

Comme cela est expliqué au chapitre Sélectionner des éléments, dans une Sélection groupée, MuseScore Studio sélectionne automatiquement les éléments utiles entre un point de départ et un point d'arrivée chronologiques sur une série
donnée de portées. Ces éléments incluent toutes les notes, silences, objets Texte Musescore tels que les symboles de nuance et objets Lignes Musescore tels que pédale, etc. Les éléments de niveau système, tel que les marques de tempo,
les indications de mesure, les marques de répétition et les sauts de mise en page ne sont pas inclus dans la sélection automatique et ne sont donc pas copiés.

Lorsqu'elle est collée sur une destination chronologique, la musique copiée remplace tout le contenu existant à l'exception de la structure rythmique originale de la mesure et des éléments de niveau système.

Créez une Sélection groupée
(Optionnel) Utilisez le Filtre de sélection pour exclure certains types d'éléments de la sélection.
Utilisez la commande Copier depuis le menu ou tapez Ctrl+C (Mac : Cmd+C)
Sélectionnez la première note ou silence de la destination

Utilisez la commande Coller depuis le menu ou tapez Ctrl+V (Mac : Cmd+V)

Copier un élément individuel ou une Liste de sélections

MuseScore Studio permet aussi de copier un élément isolé ou une Liste de sélections de plusieurs paroles, symboles d’accord, nuances, articulations ou autres marques pour les coller à un autre tout en conservant intact le contenu tel que
les notes dans la zone de destination. Une Liste de sélections multiples de notes ne pas être copiée.

MuseScore Studio préserve si possible les positions chronologiques relatives des marques et symboles en se basant sur la distance littérale de valeur de note mais ne prend pas en compte le rythme de la mesure. Cela inclut le cas de la
copie des symboles d’accord et des nuances. Des ancrages valides de notes et silences sont requis pour copier des paroles et articulations dans la destination.

Sélectionnez un élément individuel (pas une mesure) ou créez une Liste de sélections (voir le chapitre Sélectionner des éléments
Utilisez la commande Copier depuis le menu ou tapez Ctrl+C (Mac : Cmd+C)
Sélectionnez la première note ou silence de la destination
Utilisez la commande Coller depuis le menu ou taper Ctrl+V (Mac : Cmd+V)

Déplacer des éléments

Les commandes copier et coller peuvent être utilisées pour :

déplacer un passage vers une autre portée, comme de la musique de flûte vers le clarinette, ou
avancer ou retarder un passage. Cette méthode est particulièrement utile comme outil pour insérer ou supprimer une note ou un silence et aussi pour décaler des notes et silences existants pour créer ou aménager un
silence.

Les mesures (leur structure rythmique) ne peuvent pas être déplacées mais voir les chapitres Ajouter et supprimer des mesures et Indications de mesure. Quand on déplace une Liste de sélections, les positions relatives sont si possible
préservées : voir la section "Copier une Liste de sélection".

Pour déplacer une sélection :

Sélectionnez ce que vous voulez déplacer
Utilisez la commande Copier depuis le menu ou tapez Ctrl+C (Mac : Cmd+C)
Sélectionnez la première note ou silence de la destination
Utilisez la commande Coller depuis le menu ou tapez Ctrl+V (Mac : Cmd+V)

Échanger une sélection avec le presse-papier

La commande Échanger avec le presse-papier combine deux opérations en une : (1) en premier, il écrase la partie sélectionnée de la partition avec le contenu du presse-papier, exactement comme le ferait commande Coller ; (2) en
second, il transfère en retour la partie écrasée de la partition dans le presse-papier, exactement comme le ferait la commande Copier.

Cela peut être utilisé, par exemple, pour échanger deux sections d’égale longueur, A et B, d'une partition :

Sélectionnez la section A
Appliquez la commande Couper
Sélectionnez la section B
Appliquez la commande Échanger avec le presse-papier pour coller A à la place du contenu de B tout en déplaçant le contenu de B dans le presse-papier
Sélectionnez de nouveau A (ou juste la note, le silence ou la mesure de départ)
Appliquez la commande Coller

Comme les autres commandes décrites ici, vous pouvez accéder à la commande Échanger avec le presse-papier depuis le menu ou via un raccourci clavier — dans ce cas, c’est Ctrl+Maj+X (Mac : Cmd+Maj+X).

Répéter une sélection
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Une utilisation commune du copier-coller est de dupliquer un passage donné (incluant notes, accords, etc.) immédiatement après l’original. Utilisez la commande spéciale Répéter sélection pour simplifier ce processus.

Sélectionnez un élément individuel ou créez une Sélection groupée (voir le chapitre Sélectionner des éléments.
Tapez R.

Cela ne fonctionne pas avec une Liste de sélections. La commande fonctionne pour un accord isolé comme pour une Sélection groupée sur lui ainsi que lorsque exactement une note de cet accord est sélectionnée : voir le chapitre
Sélectionner des éléments. En mode de saisie des notes, cette commande reproduit l’accord entier auquel appartient la note sélectionnée. Cela est pratique pour créer une série d’accords répétés.

Copier une Sélection groupée vers plusieurs portées

Si vous voulez copier un passage dans plusieurs portées — par exemple, doubler un musique de flûte vers les hautbois et clarinette — vous pouvez utiliser la commande Éclater

Sélectionnez le passage que vous souhaitez copier
Étendez la sélection en incluant les portées inférieures (par exemple en tapant Maj+↓)
Utilisez Outils → Éclater

Cela copie la sélection originale, en supposant qu’elle ne contient que des notes isolées — aucun accord ni voix multiples. S’il existe des accords ou des voix multiples, ils seront distribués dans les portées restantes tel que c’est décrit dans
la section sur la commande Éclater .

Coller avec une demi ou une double durée

Si vous avez saisi un passage utilisant principalement des croches mais que vous voulez raccourcir le morceau en utilisant principalement des doubles croches, ou bien l’allonger en les remplaçant par des noires, MuseScore Studio fournit
deux commandes spéciales pour le faire. Vous pouvez soit modifier les durées sur la sélection en cours, soit créer une copie séparée du passage avec les durées modifiées.

Pour réduire de moitié ou doubler la durée d’une plage :

Sélectionnez la plage à modifier
Utilisez la commande Copier
Si vous souhaitez créer une copie séparée avec les durées modifiées, sélectionnez la destination
Utilisez la commande Collage demi durée ou Collage double durée Ctrl+Maj+Q/W (MacOS : Cmd+Maj+Q/W)

Dupliquer des éléments individuels

Les éléments individuels — y compris ceux qui ne sont pas automatiquement sélectionnés dans une Sélection groupée, comme l’indication de mesure ou les barres de reprise — peuvent être sélectionnés puis dupliquées en utilisant une
souris.

Tout en gardant appuyée les touches Ctrl+Maj (Mac : Cmd+Maj), cliquez sur l’élément et maintenez le bouton de souris
Déplacez l'élément n’importe où dans la partition

Quand vous relâchez le bouton de la souris, l’élément sélectionné est copié à la nouvelle position.

Voir aussi

Sélectionner des éléments
Rassembler et éclater

Utiliser les palettes

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Vue d’ensemble

L'utilisation du panneau Palettes est la méthode recommandée pour appliquer des symboles et des textes dans votre partition. MuseScore Studio est équipé de palettes prédéfinies qui organisent les objets par nature, comme les Armures
et les Articulations. Par défaut, un jeu basique de palettes est visible. Plusieurs palettes avancées sont masquées et peut être rendues visibles comme souhaité. Vous pouvez ajouter, effacer, éditer et réorganiser les objets à l'intérieur de
chaque palette. Vous pouvez aussi créer et personnaliser vos propres palettes.

Ce chapitre est consacré à l'usage des objets de palettes et les effets sur la partition. La personnalisation de l'interface est traitée dans le chapitre Palettes de la section Personnalisation.

Une autre façon d'appliquer des symboles musicaux et du texte est d'utiliser la fenêtre Palette principale. On y accède via Affichage → Palette principale ou par le raccourci clavier Maj+F9. La fenêtre Palette principale est l'entrepôt de tous
les symboles musicaux. Elle fournit également une modalité alternative pour créer des armures personnalisées et des indications de mesure personnalisées.

Au sein de la Palette principale, la section (catégorie) Symboles abrite tous les symboles et textes des polices musicales intégrées ; voir la page Autres symboles.

En naviguant dans les objets de la fenêtre Palette principale, vous pouvez trouver de multiples symboles qui se ressemblent. Ils diffèrent sur le plan de la programmation. Ceux qui sont dans la catégorie Symboles ne sont pas des versions
fonctionnelles comme les autres objets textes et symboles. Ne les utilisez que dans le cas où c'est nécessaire (voir la page Other symbols).

On peut encore utiliser une autre façon d'appliquer des symboles et du texte en ajoutant des images ; voir Utiliser des images.

Accéder au panneau Palettes

Le panneau Palettes est normalement affiché sur la barre latérale gauche de la fenêtre principale. Il existe trois onglets affichés au sommet de la barre latérale : Palettes, Instruments et Propriétés. Si l’un des autres onglets est
actuellement affiché, cliquer sur l’onglet Palettes pour le faire apparaître à la place du précédent.

Vous pouvez ouvrir et fermer le panneau Palettes en utilisant Affichage→Palettes ou le raccourci clavier F9. Si tous les panneaux dans la barre latérale sont fermés, la barre latérale elle-même se ferme, augmentant l’espace pour l’affichage
de la partition.

Comme la plupart des autres panneaux dans MuseScore Studio, celui de Palettes peut aussi être détaché pour s’afficher comme une fenêtre séparée.

Ajouter des objets palette dans la partition

Pour ajouter un objet palette dans votre partition, commencez par ouvrir la palette appropriée, si ce n’est pas encore le cas, en cliquant sur son titre ou sur la petite icône flèche à sa gauche. Les objets de cette palette sont affichés dans une
grille.
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En général, pour appliquer des objets palette à votre partition, vous pouvez soit sélectionner les éléments cibles dans la partition puis cliquer sur l’objet palette, soit faire glisser l’objet avec la souris vers l’élément cible. Voir la section sur la
recherche et navigation plus bas pour s’informer sur les moyens d’appliquer des objets palettes via le clavier.

Objets appliqués à des éléments individuels de la partition

Beaucoup d’objets palette — par exemple articulations, nuances et la plupart des autres textes — peuvent être appliqués à des notes, des silences ou d’autres éléments individuels de la partition. Quand vous utilisez le glisser-déposer,
assurez-vous de faire glisser l’objet vers un élément spécifique et ne relâchez pas la souris avant que l’élément cible s’active pour indiquer qu’il peut accepter l’objet palette.

Il est habituellement plus efficient, cependant, de commencer par sélectionner les éléments cibles dans la partition avant de cliquer sur l’objet palette. Cela est tout particulièrement vrai si vous voulez appliquer le même objet palette à
plusieurs éléments de la partition puisque cette méthode vous permet d’appliquer l’objet à un groupe de plusieurs éléments en une seule fois.

Pour appliquer un objet palette à un ou plusieurs éléments de la partition :

Sélectionnez le ou les éléments auxquels vous voulez appliquer l’objet palette (élément isolé, liste, plage)
Cliquez sur l’objet palette.

L’objet de palette sera normalement ajouté à chaque élément sélectionné. Notez qu’avec une sélection groupée, si l’objet palette représente du texte (y compris nuances et indications de tempo), l’objet ne sera ajouté qu’au seul premier
élément de la plage sélectionnée. Le texte de système (dont l'indication de tempo) ne sera appliqué qu’à la portée supérieure ; les autres textes sont appliqués à chaque premier élément des portées inclues dans la sélection groupée.

Objets appliqués à des sélections groupées

Les objets tels que les symboles de crescendo, liaisons, lignes d’octave (8va) et indications de pédale sont appliqués à une plage de notes plutôt qu’à une note ou un silence isolés. Le procédé pour les ajouter est le même :

Sélectionnez la plage des éléments auxquels vous voulez appliquer l’objet palette
Cliquez sur l’objet palette.

Objets appliqués à des mesures complètes

Certains objets palette tels que les barres de mesure, les indications de mesure, reprises et sauts de mise en page sont normalement appliqués à une mesure — ou un groupe de mesures — plutôt qu’à une note ou à un silence spécifique.
Le procédé pour les ajouter est le même que pour les autres objets palette :

Sélectionnez la mesure ou la plage de mesures à laquelle vous voulez appliquer l’objet palette
Cliquez sur l’objet palette.

Développer et réduire les palettes

Une palette peut être ouverte (développée) ou fermée (réduite) individuellement en cliquant sur la barre de titre ou sur l’icône placée à gauche du titre. En outre, vous pouvez développer ou réduire l’ensemble des palettes en même temps ou
laisser MuseScore Studio fermer automatiquement les palettes. Pour accéder à ces options, cliquez sur le bouton ... au sommet de la fenêtre de la palette pour ouvrir le menu d’options (popup).

Clic simple pour ouvrir une palette : définit si les palettes sont ouvertes par un simple ou un double clic
Ouvrir une seule palette à la fois : si la case est cochée, le développement d’une palette entraîne la fermeture automatique de toutes les autres
Réduire toutes les palettes : réduit immédiatement toutes les palettes ouvertes
Développer toutes les palettes : ouvre immédiatement l’ensemble des palettes

Effectuer une recherche et naviguer dans les palettes

Vous pouvez aussi effectuer une recherche et naviguer dans les palettes en utilisant votre clavier plutôt qu’avec la souris.

Effectuer une recherche

Pour rechercher un objet palette par son nom, utilisez le raccourcis clavier Ctrl+F9 (Mac : Cmd+F9), ou cliquez sur l’icône loupe en haut du panneau Palettes.

Cela affiche une boîte de recherche. Au fur et à mesure que vous saisissez des caractères dans la boîte, MuseScore Studio affichera tous les objets dont les noms correspondent.

Pour fermer la boîte de recherche, cliquer sur l’icône "X".

Naviguer
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Les palettes sont pleinement accessibles par l’intermédiaire du clavier. La fonction de recherche décrite ci-dessus est une méthode que vous pouvez employer pour commencer le processus mais vous pouvez aussi utiliser Maj+F6 pour
amener le focus sur la barre latérale du panneau Palettes.

Une fois que le focus est sur le panneau Palette, les touches ↑ et ↓ permettront de se déplacer dans les différentes palettes. Vous pouvez alors ouvrir et fermer une palette en tapant Entrée. Pour accéder aux objet d’une palette, tapez → pour
accéder à la palette puis ↑ et ↓ pour se déplacer à l’intérieur des objet de la palette.

Accéder à davantage d’objets palette

Quelques palettes contiennent des éléments supplémentaires qui ne sont pas affichés par défaut. Pour y accéder, cliquez le bouton Plus en bas à droite de la palette.

Vous pouvez ajouter n’importe lequel de ces objets dans la partie principale de la palette par un simple glisser-déplacer. Pour plus d’informations, voir Palettes dans le chapitre Personnalisation.

Ajouter d’autres palettes

MuseScore Studio est équipé avec des palettes avancées qui sont masquées par défaut. Pour les rendre visibles cliquez sur le bouton Ajouter des palettes au sommet du panneau Palettes.

Cela va afficher une liste de palettes que vous pouvez ajouter à votre panneau Palettes. Pour ajouter une palette, cliquez sur le bouton + près du nom de la palette.

Les palettes sont ajoutées au-dessus des autres palettes. Vous pouvez les glisser-déplacer pour les réarranger comme vous le souhaitez.

De même, en plus du panneau Palettes standard, il existe une Palette principale à laquelle vous pouvez avoir accès via le menu Affichage → Palette principale ou le raccourci clavier Maj+F9.

Vous pouvez aussi créer une palette personnalisée vide que vous pourrez alimenter plus tard en cliquant sur le bouton Créer une palette personnalisée (voir le chapitre Palettes dans le section Personnalisation).

Voir aussi

Palettes pour la personnalisation de l'interface
Autres symboles pour avoir des informations supplémentaires sur la section (catégorie) Symboles dans la Palette principale
Utiliser des images

Panneau des propriétés

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Vue d'ensemble
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Le panneau Propriétés affiche les propriétés de mise en forme et de lecture des objets sélectionnés ou des caractères sélectionnés au sens d'un objet Texte. Quand rien n'est sélectionné, il affiche les propriétés de la partition. Il représente
une version améliorée de l’Inspecteur et a la fonctionnalité de barre d'outils texte : voir le chapitre Saisir et éditer du texte ainsi que, dans le manuel Musescore 3, les chapitres Inspecteur  et Édition des textes .

La page Éditer le manuel de Musescore 4 a aussi été modifiée. La personnalisation des propriétés est désormais expliquée d'une façon différente que dans le manuel Musescore 3. Elles sont respectivement expliquées au sein du chapitre
qui est le plus pertinent. Le présent chapitre n'aborde que le panneau et les propriétés communes aux multiples objets.

Accéder au panneau Propriétés

Ouvrir l'onglet the Partition
Tapez le raccourci clavier par défaut F8 ou cliquez sur l'onglet Propriétés sur le côté gauche de l'écran :

Depuis la fenêtre Partition, cliquez sur l’onglet Propriétés sur la partie gauche de l’écran :

Propriétés pour la partition

Les propriétés de partitions sont sauvegardées dans un fichier partition (*.mscz). Il ne doit pas être confondu avec les Espaces de travail.

Quand rien n'est sélectionné, le panneau Propriété affiche les propriétés de la partition :

Sous le sous-titre Afficher :

Invisible : rend visibles/invisibles les objets de votre partition
Cadres : rend visibles/invisibles les cadres
Mise en forme : rend visibles/invisibles les éléments de mise en forme ajoutés avec la palette Mise en page
Marges de page : rend visibles/invisibles les marges de page

Sous le sous-titre Apparence de la partition :

Portées vides : rend visibles/invisibles les portées qui ne contiennent aucune notation musicale à l’intérieur d’un système. Ce réglage est l’équivalent de Masquer les portées vides dans les systèmes de la fenêtre de dialogue Style.
Paramètres de la page : ouvre la fenêtre de dialogue Paramètres de la page . Équivalent de Format → Paramètres de la page. Voir Modèles et styles.
Paramètres de style : ouvre la fenêtre de dialogue Style. Équivalent de Format → Style. Voir Modèles et styles.

Propriétés pour les objets

Quand un ou plusieurs objets sont en cours de sélection, le panneau de Propriétés affiche les propriétés communes de mise en forme et de lecture de l'ensemble. Sous la section "Notation", tapez sur un [type d'objet] pour restreindre les
items présentés à ce seul type d'objet.

Quelques réglages communs à la plupart des objets :

Visible : cliquez sur cette boîte pour rendre visibles/invisibles les éléments sélectionnés ou utilisez le raccourci clavier V. Utilisez cette fonctionnalité pour masquer des éléments afin qu'ils n'apparaissent pas dans la partition exportée ou
imprimée. Cela peut être utile quand par exemple, on utilise une indication de tempo ou de nuance uniquement dans le but d'affecter la lecture dans MuseScore Studio.
Auto-placement : habituellement cochée par défaut, cette fonctionnalité positionne les objets sélectionnés en accord avec les algorithmes d’évitement de collision horizontale et verticale de MuseScore Studio. Décochez Placement
auto pour avoir davantage de contrôle sur le positionnement de certains éléments. Apprenez-en plus sur cette fonctionnalité dans Positionner les éléments .
Petite taille : cette fonctionnalité est utilisée pour créer des petites répliques de notes : par exemple, notes fournies pour assister l’interprète en lui indiquant ce qu’un autre membre de l’orchestre/ensemble est en train de jouer en
même temps. Cocher la case rétrécit toutes les notes sélectionnées, y compris leurs hampes et toutes les ligatures associées.
Joué : quand elle est cochée, cette propriété autorise la lecture de l’élément sélectionné. Décochez Joué pour rendre l’élément silencieux.

Réglages de lecture
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La fonctionnalité de lecture des indicateurs de nuance fait l'objet d'un développement actif. Elle peut être modifiée radicalement en fonction des versions du logiciel. Les informations fournies ici sont valides pour la version Musescore 4.2.
Elles peuvent être obsolètes à l'heure de la lecture de ces lignes.

Sous le bouton Lecture sont affichées les propriétés de lecture, si les éléments sélectionné en ont :

Vélocité :
Seules les notes possèdent une propriété Vélocité. Ses effets sur la lecture ne sont pas les mêmes que dans Musescore 3.
Cette propriété n'a pas d'effet sur les instruments utilisant MuseSound : voir Mélangeur : Son et Velocity controls  [en anglais].
La plage valide va de 1 à127. La valeur par défaut est 64, indépendamment des indicateurs de nuances affectant la note. La saisie 0 est automatiquement convertie en 64.
Les indicateurs de nuance n'ont plus d'effet sur la propriété Vélocité. Ils ne changent plus le timbre/la puissance uniquement par la manipulation des valeurs de vélocité MIDI. Voir aussi le chapitre Nuances.

Réglage d'accord :
Seules les notes ont une propriété de Réglage d'accord. La Tonalité écrite par défaut de 440Hz et les ajustements qui existaient dans le synthétiseur de Musescore 3 ont été supprimés (voir https://musescore.org/en/
node/334701#tuning  [en anglais]). La propriété Réglage d'accord des notes est toujours fonctionnelle dans les portées utilisant Soundfont. Pour déterminer la valeur en Hertz (Hz) de la propriété Réglage d'accord qui utilise
l'unité Cent, utilisez le calculateur fourni par http://www.sengpielaudio.com/calculator-centsratio.htm . [en anglais].
Il affecte la hauteur des instruments utilisant Soundfont.

Réglages d’apparence

Espace devant : cela modifie l’espace qui précède les éléments sélectionnés. L’ajustement de cet espace est reporté sur toutes les portées de façon à ce que les notes de même position chronologique restent alignées.
Largeur de mesure : cela modifie la largeur de la mesure en proportion de la largeur originelle : par exemple, 1,5 = une fois et demi la largeur par défaut..
Distance minimum : ce paramètre est utilisé par l’algorithme d’évitement de collision et s’applique uniquement aux éléments placés par défaut au-dessus/dessous de la portée, comme le texte de portée, les nuances, le doigté, les
lignes, etc. Il fixe la distance minimum (exprimée en sp.) des objets sélectionnés par rapport aux autres objets qui sont tout proches de la portée, ou par rapport à la portée elle-même.
Décalage : quand ils sont nouvellement appliqués, les éléments adoptent une position par défaut. Le décalage horizontal/vertical vous offre un moyen plus précis pour positionner un élément plutôt qu’en le déplaçant avec la souris ou à
l’aide des flèches du clavier.
Aligner sur la grille : cette fonctionnalité vous permet de contraindre les opérations de déplacement en incrémentation d’espace souhaitée. Vous devez d’abord cocher la case Aligner sur la grille puis presser le bouton Configurer la
grille pour régler les pas d’incrémentation horizontale et verticale de la grille. Activez/désactivez Aligner sur la grille comme souhaité en cochant/découchant la case.
Sous le sous-titre Positionner, les quatre boutons contrôlent comment sont positionnés les éléments qui se chevauchent :

Avancer : déplace l’élément sélectionné d’une position vers l’avant pour qu’il s’affiche devant l’élément suivant
Reculer : déplace l’élément sélectionné d’une position vers l’arrière pour qu’il s’affiche derrière l’élément précédant.
Premier plan : déplace l’élément sélectionné devant tous les autres éléments
*Arrière-plan : déplace l’élément sélectionné derrière tous les autres éléments, y compris les lignes de portée.

Couleur : cliquez sur ce bouton pour changer la couleur des éléments sélectionnés. On peut choisir une des couleurs natives ou créer sa propre couleur en cliquant sur le bouton +. Cela est conservé comme future dans la liste des
couleurs personnelles sur la droite.

Propriétés pour les caractères au sein des objets Texte

Quand des objets Texte sont sélectionnés (l'objet, pas les caractères), le panneau Propriétés affiche les paramètres de mise en forme de ces objets. Éditer ces propriétés modifie l'objet mais peuvent changer tous les caractères contenus
par l'objet.

Quand des caractères internes à un objet Texte sont sélectionnés, le panneau Propriétés affiche la mise en forme de ces caractères. Éditer ces propriétés ne modifiera que les caractères sélectionnés. Voir le chapitre Mettre en forme du
texte.

Sauvegarder et restaurer les paramètres par défaut

Voir la page Modèles et styles.

Sous le bouton "points de suspension" (trois points) du menu adjacent à la propriétés, on trouve deux boutons :

Réinitialiser : supprime le paramétrage spécifique et réinitialise la propriété à sa valeur par défaut.
Enregistrer comme style par défaut pour cette partition permet :

d'assigner la valeur de la propriété de l'objet en cours à celle correspondante du profil de style trouvé sous Format → Style (voir Modèles et styles)
d'effacer ensuite la propriété spécifique de cet objet .
Le résultat est que cet objet n'a plus de propriété spécifique mais qu'il utilise la valeur enregistrée dans style de profil, qui est la même puisqu'elle vient juste d'y être assignée. Tous les objets utilisant le même profil dans la partition
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sont affectés.

Ajuster directement les éléments

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Ce chapitre explique les méthodes pour ajuster précisément la mise en page des éléments littéraux d'une partition. Les méthodes d'édition musicale les plus communes sont expliquées dans les chapitres Saisir et éditer du texte et Éditer des
notes et des silences.

Modifier la position des éléments

Pour positionner précisément la position d'un élément littéral d'une partition, utilisez n’importe laquelle des méthodes suivantes :

Déplacez-le (voir aussi le chapitre Aligner sur la grille), OU
Sélectionnez l'élément sur la partition et ajustez ses propriétés Décalage (voir le chapitre Panneau des propriétés), OU

Utilisez le mode édition.

Pour entrer en mode édition, vous pouvez soit

Faire un clic droit sur un élément et sélectionner Éditer l’élément, ou
Sélectionner un élément et utiliser le raccourci clavier F2, ou
Sélectionner un élément et utiliser le raccourci clavier Alt+Maj+E (Mac : ⌥+Maj+E)

Puis, en mode édition, utilisez les touches fléchées ← → ↑ ↓ pour déplacer l'objet par pas de 0,5 sp, OU

L'éditer directement (cette méthode ne fonctionne pas sur les notes, silences et éléments ajoutés via la "Palette principale : Symboles" (voir le chapitre Autres symboles). Sélectionnez l'élément et utilisez les touches fléchées ← → ↑ ↓ pour
le déplacer par petits pas (0,1 sp). En combinaison avec Ctrl (Mac : ⌘), le déplacement se fait par grands pas (1 sp).

En lire plus sur le spatium (sp.) dans le chapitre Notions de mise en page.

Modifier la forme des éléments

Pour changer la forme des éléments comme les liaisons de phrasé et les liaisons de prolongation après les avoir ajoutés dans la partition :

Cliquez sur la liaison à ajuster
Cliquez et déplacez les poignées d’ajustement qui apparaissent autour de l’élément (NB : les lettres rouges qui apparaissent dans le schéma suivant ne sont affichées que pour servir de référence)

Notez que :

Les poignées B, C, et D changent la forme de la courbe à leur niveau
Les poignées A et E ajustent la longueur de l’élément (ce qui peut aussi se réaliser en tapant Maj+←/→ pour déplacer les extrémités d’une note/accord à la fois)
La poignée F repositionne l’ensemble de la ligne dans changer sa forme ni sa longueur.

Si vous voulez changer la note à laquelle la liaison de phrasé est connectée, la méthode recommandée est d’utiliser les raccourcis décrits ci-dessus (Maj+←/→). C’est le moyen le plus efficient pour changer à la fois le visuel et la lecture de la
plage des notes concernées par une liaison de phrasé ou de prolongation.

Utiliser les points d'ancrage

Plusieurs types d'objets – symboles de nuances, crescendos et diminuendos, texte de tempo, marques de pédale – n'ont pas besoin d'être nécessairement attachés à des notes ou silences mais peuvent l'être aussi à des positions
rythmiques au sein d'une durée, appelées points d'ancrage.

En général, ces items ne peuvent pas être directement attachées à un point d'ancrage au sein d'une durée mais doivent être d'abord ajoutés à une note ou un silence puis déplacés jusqu'à la position adéquate. Les raccourci clavier pour se
déplacer entre des points d'ancrage sont Maj+←/ → (les mêmes raccourcis qui déplacent les autres types d'items entre les notes). Les positions d'ancrage sont sauvegardées dans le fichier comme une position rythmique réelle aussi les items
resteront à l'emplacement correct en cas de modification de format de la partition.

Si vous sélectionnez un item "ancrable" et tapez Maj, vous visualiserez les points d'ancrage disponible dans cette mesure ; ils sont affichés sous forme de bandes foncées alternées avec des bandes plus claires. La couleur est déterminée par
la voix à laquelle l'objet est assigné : violet pour toutes les voix, bleu pour la voix 1, vert pour la voix 2, etc. Chaque tranche représente une subdivision rythmique à laquelle on peut ancrer l'objet.

Déplacer les objets entre des points d'ancrage

Pour déplacer un objet entre des points d'ancrage, maintenez Maj et tapez ← ou → :

Avec des lignes (crescendo, diminuendo, marques de pédale), chaque extrémité peut être déplacée de façon indépendante.

Par défaut, les subdivisions d'ancrage affichées correspondent à la moitié du battement tel qu'il est déterminé par l'indication de mesure (comme ici, la moitié du quart de battement, soit une croche). Cependant, les points d'ancrage ancres
peuvent aussi être affichés pour les notes dans d'autres portées qui ont des positions rythmiques qui tombent en dehors de ces subdivisions, ce qui signifie que vous pouvez aligner un objet sur des notes d'autres portées, quelles que soient
leurs position :

Déplacer une nuance à la position de "fin de durée"

En utilisant Maj+Alt+←/→, vous pouvez sauter non seulement entre les positions rythmiques mais aussi à la fin de chacune de ces subdivisions. C'est une position spéciale : pour une nuance, la fin d'une durée n'est pas identique au début de la
suivante (qui peut avoir sa propre nuance – ou peut être un silence). Cela est le plus souvent rencontré dans des situations ressemblant à ce type de notation :

Pour saisir la nuance dans cet exemple :

Ajoutez une nuance f à la note
Ajoutez une marque de diminuendo à la note ; elle terminera sur le silence
Ajoutez une nuance p à la marque de diminuendo (ce qui l'affichera au point final de la marque, par exemple sur le silence), ou directement sur le silence
Sélectionnez la nuance et tapez Maj+Alt+←, ce qui déplace la nuance à la fin de la dernière subdivision de la note précédente.

Notez que les marques de crescendo/diminuendo ne peuvent pas être déplacées jusqu'à la position d'une "fin de durée" ; s'il n'y a pas de nuance à cet endroit, la distinction est insignifiante. Mais, si la nuance est déplacée, toute marque de
crescendo/diminuendo suivra.

Pour plus de clarté, quand on déplace des marques de crescendo/diminuendo ou d'autres lignes, les subdivisions que l'objet recouvre sont affichées de façon plus foncée de façon à bien les identifier :

Manuel de MuseScore 4 https://musescore.org/fr/print/book/export/html/329209?toc=1#undefin...

58 sur 199 04/07/2025, 12:24

https://musescore.org/fr/forum/16
https://musescore.org/fr/forum/16
https://musescore.org/fr/print/book/export/html/329209?toc=1#node-329664-Aligner_sur_la_grille
https://musescore.org/fr/print/book/export/html/329209?toc=1#node-329664-Aligner_sur_la_grille
https://musescore.org/fr/print/book/export/html/329209?toc=1#node-329660-ties
https://musescore.org/fr/print/book/export/html/329209?toc=1#node-329660-ties


Travailler avec les lignes

Modifier la plage d’une ligne

Pour modifier les points de début et de fin d’une ligne :

Sélectionnez la ligne pour afficher les poignées d’ajustement

Utilisez Maj+←/→ pour déplacer la fin de la ligne d’un pas à la fois (un pas = une note/silence ou une mesure — selon le type de ligne).
Remarque : vous pouvez cliquer ou utiliser Tab pour déplacer le focus entre les poignées au cours de l’ajustement. Mettre le focus sur la poignée gauche pour déplacer le début de la ligne.

Ajustez précisément la position des poignées en utilisant les touches fléchées du clavier ←/→ si nécessaire. Notez que cela n’affecte pas la plage de lecture de la ligne.

Comme pour les liaisons de phrasé et de prolongation, il est recommandé d’utiliser Maj pendant l’ajustement de la longueur de ligne avec les touches fléchées afin de s’assurer que la plage de lecture s’ajuste également en conséquence.

Créer des lignes diagonales

Bien que les lignes soient horizontales par défaut, elles peuvent être réglées à n’importe quel angle en déplaçant la poignée d’ajustement de début ou de fin de ligne ; ou en sélectionnant une poignée de début/fin et en utilisant les touches
fléchées ↑/↓.

Éditer le texte d'une ligne de texte

Pour éditer le texte d’un objet ligne de texte (tel que "ligne de texte de système", "ligne de texte de portée" ou "ligne de capodastre", voir Saisir et éditer du texte) :

Sélectionnez un élément ligne de texte
Allez dans le panneau Propriétés
Ouvrez l’onglet Texte dans la section Ligne de texte
Éditez les champs

Texte de début
Texte si poursuite vers autre système : le texte à afficher si l'objet s'étend sur plus d'un système (voir le chapitre Notions de mise en page).

Voir aussi

Autres lignes : Propriétés de ligne
Positionnement des éléments

Parties

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Ouvrir une partie

MuseScore Studio crée automatiquement une partie séparée (par défaut) pour chaque instrument de votre partition.

Pour ouvrir toutes les parties à la fois :

Cliquez sur le bouton Parties dans la barre d’outils (ce qui ouvre une fenêtre de dialogue Parties)
Cliquez sur Tout ouvrir

Pour ouvrir une partie individuelle :

Cliquez sur le bouton Parties dans la barre d’outils
Cliquez sur une partie pour la sélectionner
Cliquez sur Ouvrir la sélection.

Vous pouvez aussi sélectionner des parties spécifiques à ouvrir en même temps. Faites-le en maintenant la touche Ctrl (Mac : ⌘) tout en sélectionnant les parties à ouvrir, puis cliquez sur Ouvrir la sélection . Il est également possible de
sélectionner une plage de parties contiguës en cliquant sur la première et en gardant la touche Maj appuyée lorsque l’on sélectionne la dernière.

Fermer une partie

Cliquez sur le bouton X de l’onglet d’une partie pour fermer la partie.

Notez que les changements que vous réalisez dans une partie seront sauvegardés avec cette partie et que vous les retrouverez la prochaine fois que vous l’ouvrirez depuis la fenêtre de dialogue Parties.

Créer des parties personnalisées

La fenêtre de dialogue Parties est étroitement intégrée avec le nouveau panneau Instruments. Cette intégration vous facilite la création de parties avec n’importe quelle combinaison d’instruments de votre partition.

Il y a deux façons de personnaliser les parties dans MuseScore Studio : utiliser les parties par défaut (par exemple, un modèle de partition) pour révéler d’autres instruments, ou créer des parties entièrement nouvelles.

Révéler les instruments dans les parties par défaut

Comme cela a déjà été signalé, MuseScore Studio crée automatiquement une nouvelle partie (par défaut) pour chaque instrument de votre partition. Tout ce que vous avez à faire est d’ouvrir la fenêtre de dialogue Parties.

En fait, chaque partie par défaut contient tous les instruments de votre partition – ils sont simplement cachés de la vue (excepté, bien entendu, l’instrument de la partie choisie).
Cela signifie que vous pouvez “révéler” les autres instruments à l’intérieur de chaque partie par défaut. Pour réaliser cela :

Ouvrez une partie (comme décrit ci-dessus)
Sélectionnez le panneau Instruments
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Cliquez sur l’icône œil à proximité du nom d’un autre instrument.

Cet instrument sera dorénavant visible dans la partie choisie.

Cela rend le processus de création de parties personnalisées incroyablement flexible. Révéler ou masquer les autres instruments est parfaitement non destructif, ce qui signifie que vous pouvez personnaliser chaque instrument dans chaque
partie et ne montrer que ce que vous souhaitez révéler aux différents interprètes (ou pour différents projets musicaux), sans avoir à recréer entièrement de nouvelles parties à chaque fois.

Créer une nouvelle partie

MuseScore Studio vous donne bien sûr la possibilité de créer une partie complètement vierge, à partir de rien, vous donnant pleinement le contrôle de la personnalisation. Pour réaliser cela :

Cliquez sur Parties dans la boîte d’outils pour ouvrir la fenêtre de dialogue Parties
Cliquez sur Créer une nouvelle partie
Donnez un nom à votre partie
Cliquez sur Ouvrir la sélection.

Votre nouvelle partie sera ouverte dans l’onglet Partition mais elle apparaîtra vide d’instruments. Pour ajouter des instruments à cette partie :

Allez sur le panneau Instruments
Cliquez sur l’icône œil de chaque instrument que souhaitez voir apparaître dans votre partie.

Choisir quelles voix apparaissent dans chaque partie

Il est quelquefois nécessaire de créer des parties individuelles à partir de portées qui contiennent plusieurs voix. Vous pourriez, par exemple, vouloir extraire des parties séparées pour des interprètes d’orchestre qui partagent une portée
dans la même partition (exemple : Flûte 1 et Flûte 2). Ou bien vouloir créer des parties vocales individuelles pour des partitions chorales où, par exemple, quatre voix sont notées à travers deux portées.

Vous aurez d’abord besoin de créer (voir ci-dessus) ou de dupliquer (voir ci-dessous) une partie. Puis de sélectionner quelle(s) voix faire apparaître dans la partie :

Ouvrez une partie (voir ci-dessus)
Allez au panneau Instruments
Déroulez les options de l’instrument en cliquant sur l’icône triangulaire
Cliquez sur l’icône roue dentée qui se situe à côté du nom de la clef de la portée
Sélectionnez quelle(s) voix vous voulez faire apparaître dans la partie en cochant/décochant les cases sous **Voix visibles dans la partition **.

Appliquer des styles aux parties

Les paramétrages de style pour l’affichage d’un grand nombre d’éléments peuvent être appliqués spécifiquement à des parties, sans affecter la partition principale.

Pour modifier des paramètres de style pour une partie donnée :

Assurez-vous que la partie soit ouverte et actuellement sélectionnée dans l’onglet Partition
Allez au menu Format → Style...
Effectuez les modifications de paramètres souhaités (les changements effectués sont visibles en temps réel dans la partition)
Cliquez sur OK pour confirmer vos choix.

Les modifications réalisées dans cette fenêtre de dialogue n’affecteront que la partie sélectionnée dans l’onglet Partition. Si vous voulez que les modifications affectent toutes les parties (mais pas la partition principale), cliquez sur le bouton
Appliquer à l’ensemble des parties.

Apprenez-en davantage sur la sauvegarde et le chargement des réglages de styles par défaut dans Modèles et styles.

Renommer, dupliquer et supprimer des parties

On réalise toutes ces options dans la fenêtre de dialogue Parties (accessible via le bouton Parties de la barre d’outils).

Cliquez simplement sur l’icône points de suspension (trois points) associé à une partie sélectionnée pour afficher ses options. Notez que seules les parties nouvellement créées (en cliquant sur le bouton ** Créer une nouvelle partie**)
peuvent être supprimées. Toutes les parties peuvent être dupliquées ou renommées.

Pour dupliquer une partie :

Cliquez sur l’icône points de suspension de la partie à dupliquer dans la fenêtre de dialogue Parties
Sélectionnez Dupliquer dans le menu contextuel qui apparaît
Saisissez un nouveau nom pour la partie (ou laisser le nom par défaut)
Cliquez sur Entrée pour confirmer le nom ou n’importe où dans la fenêtre de dialogue Parties

Pour renommer une partie :

Cliquez sur l’icône points de suspension de la partie à dupliquer dans la fenêtre de dialogue Parties
Sélectionnez Renommer dans le menu contextuel qui apparaît
Saisissez le nouveau nom pour la partie
Cliquez sur Entrée pour confirmer le nouveau nom, ou n’importe où dans la fenêtre de dialogue Parties
Notez que vous pouvez aussi faire un double clic sur n’importe quelle partie dans la fenêtre de dialogue Parties pour la renommer.

Pour supprimer une partie :

Cliquez sur l’icône points de suspension de la partie nouvellement créée à supprimer dans la fenêtre de dialogue Parties
Sélectionnez Supprimer dans le menu contextuel qui apparaît

Quand une partie est supprimée, son onglet (si elle était ouverte) est fermé. Toutes les personnalisations réalisées dans cette partie seront également perdues. La partie n’apparaîtra désormais plus dans la fenêtre de dialogue Parties.

Exporter et imprimer des parties

Pour exporter une partie :

Cliquez sur Fichier → Exporter... (ou sélectionnez l’onglet Publier et cliquez sur Exporter)
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Cochez la case correspondant au(x) partie(s) que vous voulez exporter ou cliquez sur Tout sélectionner pour les choisir toutes en une fois
Modifiez si nécessaire le format d’exportation dans le menu déroulant (il est au format PDF par défaut)
Choisissez si vous voulez exporter Toutes les parties combinées dans un seul fichier ou laisser le paramètre par défaut Chaque partie dans un fichier séparé
Cliquez sur Exporter...
Sélectionnez la destination du fichier sur votre ordinateur et le nom de votre partition dans la fenêtre de dialogue Exporter
Cliquez sur Enregistrer

Les parties sont exportées par défaut en format PDF. Pour changer le format d’exportation, sélectionnez le format souhaité dans le menu déroulant Format de Paramètres d’export. Vous pouvez exporter vos parties dans une variété de
formats image et audio, ainsi que le format braille pour les imprimantes compatibles. Pour plus d’informations, voir Exportation de fichiers.

Pour imprimer des parties :

Assurez-vous que la partie que vous voulez imprimer est sélectionnée dans l’onglet Partitions
Cliquez sur Fichier → Imprimer ou utilisez le raccourci clavier Ctrl+P (Mac : ⌘+P)
Utilisez la fenêtre de dialogue de l’ordinateur pour imprimer la partie sélectionnée

Notez que les parties ne peuvent actuellement être imprimées qu’une à la fois.

Liens externes

Mise en page et parties  (YouTube, en anglais)

Raccourcis clavier par défaut

Sur macOS, réalisez les substitutions suivantes :

Remplacer Ctrl par Cmd (ou ⌘)
Remplacer Alt par Option (ou ⌥)
Remplacer Début par Fn+←
Remplacer Fin par Fn+→
Remplacer Page haut par Fn+↑
Remplacer Page bas par Fn+↓
Ajouter Fn aux touches de fonction

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page Documentation  du forum.]

Navigation

Navigation entre pages

Action Windows/Linux macOS

Zoomer Ctrl+= Cmd+=

Dézoomer Ctrl+- Cmd+-

Zoomer à 100 % Ctrl+0 Cmd+0

Aller au premier élément de la partition Ctrl+Début Cmd+Fn+←

Aller au dernier élément de la partition Ctrl+Fin Cmd+Fn+→

Aller à l’écran suivant Page bas Fn+↓

Aller à l’écran précédent Page haut Fn+↑

Aller en haut de la première page Début Fn+←

Aller en bas de la dernière page Fin Fn+→

Aller à la page suivante Ctrl+Page bas Cmd+Fn+↓

Aller à la page précédente Ctrl+Page haut Cmd+Fn+↑

Rechercher / Aller à… Ctrl+F Cmd+F

Navigation dans la partition

Action Windows/Linux macOS

Sélectionner l’accord suivant → →

Sélectionner l’accord précédent ← ←

Aller à la mesure suivante Ctrl+→ Cmd+→

Aller à la mesure précédente Ctrl+← Cmd+←

Sélectionner l’élément suivant dans la partition Alt+→ Option+→

Sélectionner l’élément précédent dans la partition Alt+← Option+←

Sélectionner la note / le silence au-dessus Alt+↑ Option+↑

Sélectionner la note / le silence au-dessous Alt+↓ Option+↓

Saisie des notes

Général

Action Windows/Linux macOS

Basculer en/hors mode de saisie des notes N N

Afficher/masquer le clavier de piano P P

Utiliser la voix 1 Ctrl+Alt+1 Cmd+Option+1

Utiliser la voix 2 Ctrl+Alt+2 Cmd+Option+2

Durée des notes

Action Windows/Linux macOS

Définir la durée 1 – 9 1 – 9

Définir la durée = triple croche 2 2

Définir la durée = double croche 3 3

Définir la durée = croche 4 4

Définir la durée = noire 5 5

Définir la durée = blanche 6 6

Définir la durée = ronde 7 7

Basculer en/hors note pointée . .

Saisir une division irrégulière Ctrl+2 – Ctrl+9 Cmd+2 – Cmd+9

Saisir un duolet Ctrl+2 Cmd+2

Saisir un triolet Ctrl+3 Cmd+3

Saisir un quartolet Ctrl+4 Cmd+4

Ajouter une liaison de prolongation T T

Réduire de moitié la durée de la sélection (y compris valeurs pointées) Maj+Q Maj+Q

Doubler la durée de la sélection (y compris valeurs pointées) Maj+W Maj+W

Hauteur des notes

Action Windows/Linux macOS

Saisir une note A – G A – G

Ajouter une note sur un accord Maj+A – Maj+G Maj+A – Maj+G

Saisir un intervalle Alt+1 – Alt+9 Option+1 – Option+9

Ajouter/supprimer un bémol - -

Ajouter/supprimer un bécarre = =

Ajouter/supprimer un dièse + +

Saisir un silence 0 0

Ajouter une acciaccatura / /

Tablature

Action Windows/Linux macOS
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Action Windows/Linux macOS

Définir la durée (TAB) Maj+1 – Maj+9 Maj+1 – Maj+9

Définir la durée = triple croche (TAB) Maj+2 Maj+2

Définir la durée = double croche (TAB) Maj+3 Maj+3

Définir la durée = croche (TAB) Maj+4 Maj+4

Définir la durée = noire (TAB) Maj+5 Maj+5

Définir la durée = blanche (TAB) Maj+6 Maj+6

Définir la durée = ronde (TAB) Maj+7 Maj+7

Saisir TAB : frette 0 – 9 0 – 9

Saisir TAB : frette A – H et K A – H et K

Aller à la corde du dessus (TAB) ↑ ↑

Aller à la corde du dessous (TAB) ↓ ↓

Bascule avec/sans note étouffée Maj+X Maj+X

Sélection

Action Windows/Linux macOS

Tout sélectionner Ctrl+A Cmd+A

Ajouter à la sélection : note/silence qui précède Maj+← Maj+←

Ajouter à la sélection : note/silence qui suit Maj+→ Maj+→

Ajouter à la sélection : portée du dessus Maj+↑ Maj+↑

Ajouter à la sélection : portée du dessous Maj+↓ Maj+↓

Sélectionner jusqu’au début de la mesure Ctrl+Maj+← Cmd+Maj+←

Sélectionner jusqu’à la fin de la mesure Ctrl+Maj+→ Cmd+Maj+→

Sélectionner jusqu’au début de la partition Ctrl+Maj+Début Cmd+Maj+Fn+←

Sélectionner jusqu’à la fin de la partition Ctrl+Maj+Fin Cmd+Maj+Fn+→

Édition

Général

Action Windows/Linux macOS

Sortir Echap. Echap.

Annuler Ctrl+Z Cmd+Z

Rétablir Ctrl+Maj+Z Cmd+Maj+Z

Copier Ctrl+C Cmd+C

Couper Ctrl+X Cmd+X

Coller Ctrl+V Cmd+V

Répéter la sélection R R

Insérer une mesure avant la sélection Ins Ins

Insérer des mesures avant la sélection Ctrl+Ins Cmd+Ins

Insérer une mesure à la fin de la partition Ctrl+B Cmd+B

Insérer des mesures à la fin de la partition Alt+Maj+B Option+Maj+B

Supprimer Suppr. Suppr.

Supprimer les mesures sélectionnées Ctrl+Suppr. Cmd+Suppr.

Afficher/masquer les propriétés F8 Fn+F8

Éditer l’élément F2 Fn+F2

Durée

Action Windows/Linux macOS

Définir la durée 1 – 9 1 – 9

Saisir une division irrégulière Ctrl+2 – Ctrl+9 Cmd+2 – Cmd+9

Ajouter une liaison de prolongation T T

Hauteur

Action Windows/Linux macOS

Ajouter/supprimer un bémol - -

Ajouter/supprimer un bécarre = =

Ajouter/supprimer un dièse + +

Augmenter la hauteur de la sélection ↑ ↑

Diminuer la hauteur de la sélection ↓ ↓

Augmenter d’une octave Ctrl+↑ Cmd+↑

Diminuer d’une octave Ctrl+↓ Cmd+↓

Changer l’appellation enharmonique (tonalité écrite et réelle) J J

Déplacer une note vers la corde du dessus (TAB) Ctrl+↑ Cmd+↑

Déplacer une note vers la corde du dessous (TAB) Ctrl+↓ Cmd+↓

Notation

Action Windows/Linux macOS

Renverser la direction des notes X X

Utiliser la voix 1 Ctrl+Alt+1 Cmd+Option+1

Utiliser la voix 2 Ctrl+Alt+2 Cmd+Option+2

Réglages manuels

Action Windows/Linux macOS

Déplacer le texte vers la gauche ← ←

Déplacer le texte vers la droite → →

Déplacer rapidement le texte vers la gauche Ctrl+← Cmd+←

Déplacer rapidement le texte vers la droite Ctrl+→ Cmd+→

Déplacer la sélection vers le haut ↑ ↑

Déplacer la sélection vers le bas ↓ ↓

Déplacer rapidement la sélection vers le haut Ctrl+↑ Cmd+↑

Déplacer rapidement la sélection vers le bas Ctrl+↓ Cmd+↓

Texte

Général

Action Windows/Linux macOS

Ajouter du texte : texte de portée Ctrl+T Cmd+T

Ajouter du texte : texte d’expression Ctrl+E Cmd+E

Ajouter du texte : texte de système Ctrl+Maj+T Cmd+Maj+T

Ajouter du texte : indications de tempo Alt+Maj+T Option+Maj+T

Ajouter du texte : repère Ctrl+M Cmd+M

Mise en forme

Action Windows/Linux macOS

Mettre en forme le texte : gras Ctrl+B Cmd+B

Mettre en forme le texte : italique Ctrl+I Cmd+I

Mettre en forme le texte : souligné Ctrl+U Cmd+U
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Paroles

Action Windows/Linux macOS

Ajouter du texte : paroles Ctrl+L Cmd+L

Aller à la syllabe suivante Espace Espace

Aller à la syllabe précédente Maj+Espace Maj+Espace

Paroles : saisir un trait d’union - -

Paroles : saisir un mélisme _ _

Ajouter un couplet Entrée Entrée

Aller au couplet suivant ↓ ↓

Aller au couplet précédent ↑ ↑

Symboles d’accords, chiffres romains d'analyse, numéros Nashville, basse chiffrée

Action Windows/Linux macOS

Ajouter du texte : symbole d’accord Ctrl+K Cmd+K

Élément de texte suivant Espace Espace

Élément de texte précédent Maj+Espace Maj+Espace

Progression du curseur : temps suivant ; ;

Progression du curseur : temps précédent Maj+; Maj+;

Progression du curseur : durée Ctrl+1 – Ctrl+9 Cmd+1 – Cmd+9

Autres éléments de partition

Action Windows/Linux macOS

Afficher/masquer les palettes F9 Fn+F9

Rechercher des palettes Ctrl+F9 Cmd+Fn+F9

Ajouter une liaison de phrasé S S

Ajouter une articulation : accent Maj+V Maj+V

Ajouter une articulation : marcato Maj+O Maj+O

Ajouter une articulation : staccato Maj+S Maj+S

Ajouter une articulation : tenuto Maj+N Maj+N

Ajouter une nuance : crescendo < <

Ajouter une nuance : diminuendo > >

Paramétrage et mise en forme de la partition

Action Windows/Linux macOS

Ajouter/supprimer des instruments I I

Ouvrir la fenêtre de dialogue des instruments F7 Fn+F7

Rendre visible/invisible des éléments V V

Diminuer l'étirement de la mesure { {

Augmenter l'étirement de la mesure } }

Ajouter/supprimer un saut de système Entrée Entrée

Ajouter/supprimer un saut de page Ctrl+Entrée Cmd+Entrée

Réinitialiser les formes et positions Ctrl+R Cmd+R

Opérations sur les fichiers

Action Windows/Linux macOS

Nouveau Ctrl+N Cmd+N

Ouvrir Ctrl+O Cmd+O

Fermer Ctrl+W Cmd+W

Enregistrer Ctrl+S Cmd+S

Imprimer Ctrl+P Cmd+P

Quitter Ctrl+Q Cmd+Q

Interface utilisateur

Lecture

Action Windows/Linux macOS

Lire Espace Espace

Afficher/masquer le mélangeur F10 Fn+F10

Notation : Instruments, portées et systèmes

Travailler avec les instruments

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Vue d’ensemble

Les lecteurs devraient déjà connaître le concept de l'instrument Musescore et l'usage de la fenêtre Ajouter ou supprimer un instrument expliquée au chapitre Configurer votre partition. Le présent chapitre aborde le nouveau panneau
Instruments utilisé par MuseScore Studio pour configurer :

les instruments du fichier de partition (fonction que la fenêtre Ajouter ou supprimer un instrument offre déjà) ;
les portées du fichier de partition (par exemple, ajouter et configurer une nouvelle portée de clef de sol) ;
les paramètres visibilité et lecture de chaque instrument (toutes ses portées) de la "partition complète" ou de la "Partie" actuellement ouverte ;

la visibilité de chaque portée de la "partition complète" ou de la "Partie" actuellement ouverte.

Lire davantage d'informations sur les notions de "partition complète" et de "Partie" dans le chapitre Parties.

Ajouter et ranger les instruments

Accéder au panneau Instruments

Ouvrez le panneau Instruments en cliquant sur l’onglet Instruments sur la partie gauche de l’écran :

Ajouter des instruments

Cliquez sur le bouton Ajouter (ou tapez simplement sur i) pour ouvrir la fenêtre de dialogue Instruments (pour plus d’informations, voir Choisir des instruments).

Supprimer des instruments

Pour supprimer un instrument de la partition, sélectionnez l’instrument et cliquez sur l’icône poubelle, ou tapez Suppr.
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Modifier l’ordre des instruments

Sélectionnez n’importe quel instrument et utilisez les boutons ↑ ou ↓ pour changer sa position dans la partition. De façon alternative, vous pouvez faire glisser le nom de l’instrument vers le haut ou le bas en utilisant la souris.

Paramétrer les instruments

Masquer/afficher des instruments

Pour rendre invisible/visible la visibilité d'une instrument (toutes ses portées) :

Ouvrez la "partition complète" ou une "Partie" (voir le chapitre Parties
Cliquez sur l'icône Œil à côté de l'étiquette de l'instrument.

Masquer n'est pas supprimer. Masquer un instrument désactive la lecture de toutes ses portées. Cette fonctionnalité est utile en combinaison avec la fonctionnalité Parties de MuseScore Studio. Elle permet par exemple la création
d'instruments alternatifs ou l'impression de différentes versions destinées à des instrumentistes différents ; ou d'isoler des sections d'une grande partition pour orchestre sans effacer quoi que ce soit.

Renommer les instruments

Cliquez sur l’icône roue dentée
Éditer le nom (c'est la même chose qu'éditer le Nom long de l'instrument dans les Propriétés de Portée/Partie). Laissez-le vide si nécessaire.

Remplacer des instruments

Pour remplacer un instrument dans le panneau Instruments :

Cliquez sur l’icône roue dentée à la droite du nom de l’instrument
Dans la fenêtre qui apparaît, cliquez sur Changer d’instrument
Sélectionnez l’instrument avec lequel vous souhaitez effectuer le remplacement dans la fenêtre de dialogue qui apparaît.
Cliquez sur OK

Ajouter et configurer des portées

Le panneau Instruments peut aussi être utilisé pour ajouter des portées à un instrument existant et en configurer quelques propriétés de base..

Pour ajouter une portée à un instrument existant

S’il n’y a aucun nom de portée visible sous le nom de l’instrument, cliquez sur le petit triangle à gauche du nom pour la révéler
Cliquez sur Ajouter une portée
Cliquez sur l’icône roue dentée de la nouvelle portée et ajustez les réglages "Type de portée" si nécessaire. Pour plus d'information sur le type de portée, voir les Différents types de portées au chapitre Propriétés des Portées /
Parties.

Les portées ajoutées partagent le même instrument mais leur notation peut être éditée de façon indépendante. Entre autres choses, elles peuvent être utilisées pour créer des portées/tablatures pour les interprètes d’instruments à cordes
(exemple : guitare, banjo, ukulélé, etc.).

Pour ajouter une portée liée à un instrument existant

Certains objets de notation d’une portée peuvent être destinés à apparaître automatiquement sur les autres portées si elles sont liées ensemble. Pour créer une portée liée :

S’il n’y a aucun nom de portée visible sous le nom de l’instrument, cliquez sur le petit triangle à gauche du nom pour la révéler
Cliquez sur l’icône roue dentée du nom de l’instrument (exemple : "Clef de sol")
Cliquez sur Créer une portée liée
Cliquez sur l’icône roue dentée de la nouvelle portée et ajustez les paramètres "Type de portée" si nécessaire (et si disponible pour l’instrument).

Configurer une portée
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Cliquez sur l'icône roue dentée à côté du nom de l'instrument (exemple : "Clef de sol")
Modifier comme désiré :

Type de portée : voir les Différents types de portées au chapitre Propriétés des Portées / Parties.
Petite portée : réduit la taille de la portée. Réglez la taille dans Format → Style… → Tailles.
Masquer toutes les mesures qui ne contiennent pas de notation (découper) : Voir les portées découpées dans le chapitre N'afficher les portées que si nécessaire.

Apprenez-en davantage sur la personnalisation dans les Propriétés des portées/parties.

Masquer une portée tout en conservant sa lecture

(Obligatoire) Cliquez sur une étiquette de portée (exemple : "Clef de sol") mais pas son instrument
Cliquez sur son icône Œil.

Masquer n'est pas effacer.

Voir aussi la section "Masquer/afficher des instruments" qui explique comment masquer un instrument. Masquer un instrument désactive la lecture de toutes ses portées.

Supprimer des instruments et des portées

Remarque : dans des partitions qui utilisent la fonctionnalité Parties de MuseScore Studio, supprimer une portée la supprime dans la "partition complète" et toutes les autres "Parties" qui l'utilisent. Voir aussi l'alternative de commande
"masquer" dans les sections "Masquer/afficher des instruments" et "Masquer une portée tout en conservant sa lecture".

Pour supprimer un instrument et toutes ses portées :

Cliquez sur le nom de l'instrument
Cliquer sur l'icône poubelle en haut du panneau Instruments ou tapez Suppr.

Pour supprimer une portée d'un instrument :

S’il n’y a aucun nom de portée visible sous le nom de l’instrument, cliquez sur le petit triangle noir à gauche du nom pour la révéler
Cliquez sur l'étiquette de portée
Cliquez sur l’icône poubelle au sommet du panneau Instruments ou tapez Suppr.

N'afficher les portées que si nécessaire

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Vue d'ensemble

Par défaut, une partition affiche les mesures de toutes les portées sur toutes les pages de la partition, quelles contiennent ou non des notes. Cependant, vous pouvez souhaiter que certaines portées n’apparaissent que dans les systèmes où
elles sont nécessaires. Vous pouvez même vouloir qu’une portée apparaisse (ou disparaisse) de façon partielle. MuseScore Studio fournit un certain nombre de commandes pour y parvenir. Ce chapitre les présente.

Pour masquer certains instruments partout dans une partition, utilisez à la place la fenêtre de dialogue Choisir les instruments (raccourci clavier : i), le panneau des instruments sur la partie gauche de l'écran (une nouvelle fonctionnalité de
MuseScore Studio) ou le bouton Parties de la boîte d'outil en haut de l'écran.

Masquer une portée vide dans un système (l'ensemble de ses mesures dans ce système)

L'omission de portées vides est une pratique courante trouvée dans les partitions d'ensemble imprimées. Quand une portée dans un système (Notion de mise en page) ne contient aucune notation, la portée (toutes ses mesures au sein
de ce système) est cachée.

Masquer toutes les portées vides

Pour configurer la partition en cours afin de masquer automatiquement les portées des systèmes lorsqu’elles sont vides :

Assurez-vous que rien n’est sélectionné dans votre partition (tapez Echap. si nécessaire)
Allez au panneau Propriétés
Cliquez sur l’icône œil à côté de Portées vides (section Apparence de la partition).
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De façon alternative, vous pouvez cocher l’option Masquer les portées vides dans les systèmes via le menu Format → Style → Partition.

MuseScore Studio continue normalement d’afficher toutes les portées dans le premier système, conformément à la convention commune. Si vous souhaitez forcer MuseScore Studio à masquer les portées vides également dans le premier
système, décochez l’option Ne pas masquer les portées vides du 1er système dans la fenêtre de dialogue qui s’affiche (via l’icône roue dentée à côté de Portées vides du panneau Propriétés, ou via le menu style de partition). Vous
pouvez aussi contrôler si les crochets doivent ou non être affichés quand, par exemple, seul un instrument d’une section est joué, via l’option Afficher les crochets étendus à une portée unique.

Empêcher des portées spécifiques d’être masquées

Le réglage de niveau partition évoqué plus haut affecte toutes les portées de la partition. Il existe aussi un paramétrage individuel pour chaque portée (qui contient une clef) qui outrepasse le réglage de niveau partition :

Faites un clic droit sur une portée
Cliquez sur Propriétés de la Portée/Partie
Dans la fenêtre de dialogue qui s’ouvre, régler l'option Masquer lorsque vide.

Dans une partition où l'option de paramétrage de niveau partition Masquer les portées vides dans les systèmes est activée,

Pour spécifier que cette portée unique ne doit pas être masquée quand elle est vide, réglez son option Masquer lorsque vide à Jamais.
Le comportement de masquage par défaut traite chaque portée de façon indépendante. Pour les instruments qui utilisent deux portées ou plus (comme le piano, l’orgue et la harpe), vous pourriez vouloir spécifier que des portées
individuelles soient affichées même lorsqu'elles sont vides. Par exemple, dans un passage solo d'un concerto pour piano où seule par portée en clef de Sol a des notes, il est habituel d'afficher la portée en clé de Fa même si elle est
vide. Pour permettre cela, réglez l'option Masquer lorsque vide à Instrument pour chacune des portées. Pour l'exemple ci-dessus, régler l'option pour la portée en clef de Fa.
Pour supprimer un paramétrage individuel de portée et revenir à celui de niveau partition, réglez son option Masquer lorsque vide à Auto.

Portées temporaires

Le réglage de niveau partition évoqué plus haut affecte toutes les portées de la partition. Il existe aussi un paramétrage individuel pour chaque portée (qui contient une clef) qui outrepasse le réglage de niveau partition :

Faites un clic droit sur la portée.
Cliquez sur Propriétés de la Portée/Partie
Dans la fenêtre de dialogue qui s’ouvre, paramétrez l'option Masquer lorsque vide.

Dans une partition où toutes les portées sont affichées partout (option de réglage de niveau partition Masquer les portées vides dans les systèmes désactivée), il peut néanmoins y avoir une ou deux portées spéciales que vous
souhaiteriez n'afficher que quand nécessaire. Par exemple, cela pourrait être une partie solo dans une partition d'ensemble orchestral, ou une portée de basse dans un lead sheet. Pour masquer une portée quand elle est vide sans assigner
un réglage de masquage de niveau partition, paramétrez son option Masquer lorsque vide à Toujours.

Choisir la portée à afficher quand toutes les portées d'un système sont vides

Dans une partition qui contient un système où toutes les portées de tous les instruments visibles sont complètement vides, la portée du haut est affichée par défaut. Pour spécifier l'affichage de la portée :

Faites un clic droit sur la portée.
Cliquez sur Propriétés de la Portée/Partie
Dans la fenêtre de dialogue qui s’ouvre, activez l'option Ne pas masquer si le système est vide.

Ce paramétrage peut être utile quand on utilise la fonction Parties Musescore. Ce réglage n'a aucun lien avec tous les autres paramétrages de masquage des portées évoqués dans ce chapitre.

Masquer des mesures vides

Portées découpées

Les musiques de cinéma et autres partitions contemporaines utilisent souvent un style de notation où les mesures individuelles sont masquées lorsqu’elles sont vides. Elles sont parfois appelées portées découpées (ou cutaway en anglais).

Pour appliquer ce style à une portée dans MuseScore Studio :

Faites un clic droit sur la portée
Cliquez sur Propriétés de la Portée/Partie
Dans la fenêtre de dialogue qui s’ouvre, paramétrez Masquer lorsque vide à Toujours
Cochez l’option Découper.

L'option Découper seule ne change pas la mise en page verticale, l'espace vertical de portée est réservé dans tous les systèmes même s'ils sont invisibles.

Si vous souhaitez que toutes les portées soient affichées de cette manière, vous pouvez remplacer l'étape 3 avec le paramétrage de niveau partition expliqué plus haut. Cependant, Cependant, vous devrez continuer à utiliser l’option
Découper pour chaque portée de façon individuelle. Vous pouvez accélérer cette procédure en utilisant les touches fléchées en bas à gauche de la fenêtre de dialogue Propriétés de la Portée/Partie :

Cochez l’option Découper pour la portée du haut
Cliquez sur le bouton Appliquer
Cliquez sur le bouton ↓ pour atteindre la portée suivante
Répétez les étapes 1-3 jusqu’à ce que vous ayez parcouru toute les portées.

Ossia

Un ossia est un type spécial de portée découpée dans laquelle un passage musical apparaît en taille réduite au-dessus de la portée normale afin d'afficher une interprétation alternative.

Cela peut être créé dans MuseScore Studio en utilisant une combinaison de fonctionnalités :

Ajoutez une portée comme décrite dans Ajouter et configurer des portées
Sélectionnez, supprimez ou paramétrez tout crochet automatiquement ajouté
Saisissez la notation souhaitée
Faites un clic droit sur la portée
Cliquez sur Propriétés de la Portée/Partie
Dans la fenêtre de dialogue qui s’ouvre, réglez Masquer lorsque vide à Toujours
Cochez les options Découper et Petite portée
Cliquez sur OK.

Si vous souhaitez écouter l’ossia à la place de la portée normale, sélectionnez les mesures correspondantes dans la portée normale et décochez le réglage Joué dans le panneau Propriétés. Faites de même dans la portée ossia si vous
voulez plutôt écouter la portée normale.

En fonction de l’affichage souhaité, vous pourriez aussi vouloir la barre de mesure initiale ou finale du passage. Pour faire cela, sélectionnez la barre de mesure et tapez V ou décochez l’option Visible dans le panneau Propriétés.
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Vous pourriez aussi vouloir diminuer la distance entre l’ossia et la portée normale. Cela est réalisé en utilisant un Espaceur de portée fixe depuis la palette Mise en page.

Autres mesures invisibles

MuseScore Studio vous permet aussi de masquer des mesures individuelles dans toute portée donnée, qu'elle soit vide ou non. Pour qu’une mesure soit rendue invisible dans une portée :

Faites un clic droit sur la mesure
Cliquez sur Propriétés de la mesure
Décochez l’option Visible pour la ou les portées (s) où vous souhaitez que la mesure soit masquée.

Remarque : vous ne pouvez pas rendre une mesure invisible sur toutes les portées — il doit en rester au moins une visible.

Rassembler et éclater

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Rassembler

La commande Rassembler vous permet de réaliser l’une ou l’autre de ces actions :

Combiner la notation de plusieurs voix d’une même portée en une seule voix
Combiner les notations de plusieurs portées séparées en plusieurs voix dans une même portée.

Combiner les notes de différentes voix d’une portée en une seule voix

Sélectionnez une plage de mesures dans une seule portée
Dans la barre de menu, sélectionnez Outils → Rassembler.

Toutes les notes sélectionnées sont dorénavant intégrées en voix 1.

Combiner les notes de plusieurs portées en plusieurs voix dans une même portée

Assurez-vous qu’il n’y a qu’une seule voix dans chaque portée à rassembler
Sélectionnez une plage de mesures dans la portée du haut et étendez la sélection dans les portées inférieures pour inclure jusqu’à quatre portées
Dans la barre de menu, sélectionnez Outils → Rassembler.

La notation qui était initialement dans la portée du haut est maintenant en voix 1, la portée du dessous en voix 2, etc.

Éclater

La commande Éclater vous permet de réaliser l’une ou l’autre de ces actions :

Copier un passage de notes isolées d’une portée unique dans une ou plusieurs portée(s) du dessous
Transformer les accords d’un passage de musique d’une portée donnée dans leurs notes constitutives vers une ou plusieurs portée(s) du dessous.

Copier un passage de plusieurs notes dans plusieurs portées

Assurez-vous que le passage est en voix 1 (il ne devrait y avoir aucune note ou silence dans les autres voix)
Sélectionnez la plage de mesures souhaitée
Étendez la sélection vers le bas dans toutes les portées où vous souhaitez effectuer la copie
Dans la barre de menu, sélectionnez Outils → Éclater.

Le passage de la portée du haut est copié dans chacune des portées inférieures sélectionnées.

Séparer un passage d’accord en leur notes constitutives

Dans ce cas, les notes constitutives des accords d’une passage sélectionné sont séparées de la façon suivante :

Si tout le passage est en voix 1, la note la plus haute est conservée dans la portée du haut et les notes inférieures sont respectivement déplacées dans des portées suivantes
Si le passage contient plusieurs voix, les notes de la voix 1 sont conservées dans la portée du haut et les autres voix sont respectivement déplacées dans les portées suivantes.
Toutes les notes éclatées se retrouvent en voix 1.

Assurez-vous qu’il y a assez de portées sous la portée source de façon à recevoir les notes éclatées. Créez des portées supplémentaires si nécessaire en utilisant le panneau Instruments.
Choisissez l’une de ces deux options :

Sélectionnez une plage de mesures dans la portée source ; cela permet à toutes les notes d’être éclatées s’il y a assez de portées disponibles.
Sélectionnez une plage de mesures qui inclut à la fois la portée source et les extensions vers le bas pour inclure une ou plusieurs portées de destination ; cela limite le nombre de notes/voix éclatées au nombre de portées
sélectionnées.

Dans la barre de menu, sélectionnez Outils → Éclater.

Remarques :
(1) Si toute la sélection est en voix 1, MuseScore Studio écartera la ou les notes de tout accord contenant plus de notes que le nombre de portées dans la sélection.
(2) Si toute la sélection est en voix 1 et que l'accord a moins de notes que le nombre de portées de destination, les notes seront dupliquées de façon à ce que toutes les portées reçoivent une note.
(3) Toute musique existant dans les portées de destination est écrasée.
(4) Si vous sélectionnez une partie de mesure, la commande Éclater l’étendra automatiquement à une mesure complète.

Changer d'instrument en cours de partition

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Ajouter un changement d’instrument

Quand un musicien est amené à jouer de plusieurs instruments dans une section de la partition, l’instruction de changement d’instrument est généralement placée au-dessus de la partition, au début de cette section. Un retour à l’instrument
initial est signalé de la même façon.

Dans MuseScore Studio, l’instruction de changement d’instrument est porté par l’élément Chg. Instr. qu’on trouve dans la Palette Texte. Cet objet texte est différent du texte de portée et de système car il est lié à la lecture de la partition,
autorisant un changement de son de l’instrument.

Pour ajouter un changement d’instrument :

Cliquez sur une note ou un silence pour sélectionner le point de départ du changement
Cliquez sur l’élément Chg. Instr. de la palette Texte Palette
Choisissez quel nouvel instrument vous voulez faire jouer dans la boîte de dialogue Sélectionner un instrument qui apparaît
Cliquez sur OK.

L’instruction de changement pour le nouvel instrument apparaîtra au-dessus du point d’insertion dans la partition.

Travailler avec un changement d’instrument

Supprimer un changement d’instrument
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Pour supprimer un changement d’instrument, commencez par cliquer sur l’élément texte Chg. Instr. pour le sélectionner puis tapez soit sur Suppr. soit sur Retour arr..

Renommer un changement d’instrument

Vous pouvez renommer tout élément texte Chg. Instr. de la partition en faisant un double clic sur l’élément et en entrant un nouveau texte. Cela n’affectera pas la lecture du nouvel instrument.

Changer d’instrument dans le Mélangeur

La lecture de la musique pour les changements d’instrument se répercute dans le Mélangeur par l’affichage d’un canal séparé inséré à la droite de l’instrument initial. Les noms de ces instruments apparaissent entre parenthèses. Vous
pouvez changer la bibliothèque assignée à la lecture, appliquer des effets, ajuster le volume, couper le son, jouer en solo de ces canaux de la même façon que vous le feriez pour chacun des autres instruments. Pour plus d’information, voir
le Mélangeur.

Changer le type de portée

La modification d’instrument peut nécessiter de changer l’armure, la clef, voire le type de portée. Apprenez-en davantage sur la modification de style de portée dans Changer le type de portée.

Changer le type de portée

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Vue d'ensemble

Pour modifier une portée dans l'ensemble d'une partition changez plutôt le type ou modèle de portée. Les types et modèles de portée supporté par MuseScore Studio sont évoqués dans le chapitre Propriétés de Portée/Partie.

Vous pouvez changer l'apparence d'une portée depuis un certain point d'une partition en ajoutant un élément "Changement de type de portée" à une mesure et en ajustant ses propriétés dans le panneau Propriétés. Cela peut être
utilisé quand on passe de portées à hauteur déterminée à un autre type de portées ou encore pour différents effets de notation expérimentale.

Ajouter un changement de style de portée

Sélectionnez une mesure dans la portée

Cliquez sur le symbole "Changement de type de portée"  dans la palette Mise en page pour l’ajouter.

De façon alternative, vous pouvez faire glisser le symbole de la palette vers une mesure de votre partition.

Régler les propriétés de la portée

Quand vous changez une propriété de l’élément "changement de type de portée" dans le panneau Propriétés, la nouvelle valeur prend la préséance sur celles affichées dans la fenêtre de dialogue globale Propriétés de la Portée/Partie.
Seules les valeurs de Propriétés de la Portée/Partie qui ne peuvent être changées pour l’élément "changement de type de portée" resteront valides tout au long de la partition.

Les propriétés qui peuvent être changées pour l’élément "Changement de type de portée" dans le panneau Propriétés sont :

Petite taille
Utilise la Taille des petites portées qui est définie pour la partition dans la fenêtre de dialogue Style/Tailles

Décalage
Déplace la portée verticalement

Échelle
Change la taille de la portée en utilisant un pourcentage personnalisé

Nombre de lignes
Change le nombre de lignes constituant la portée

Interligne
Change l’espacement entre deux lignes de portée

Décalage de pas
Décale les notes sur la portée

Lignes de portée invisibles
Masque/affiche les lignes de portée

Couleur des lignes de portée
Paramètre la couleur des lignes de la portée

Type de tête de note
Spécifie l’apparence des têtes de notes telle que l'affichage du nom de la hauteur de note ou une forme particulière de tête de note

Sans hampe
Masque/affiche les hampes de note

Afficher les barres de mesure
Masque/affiche les barres de mesure

Afficher les lignes supplémentaires
Masque/affiche les lignes supplémentaires (notes placées en dehors de la portée)

Générer les Clefs
Masque/affiche les clefs

Générer les indications de mesure
Masque/affiche les indications de mesure

Générer les armures
Masque/affiche les armures

Propriétés des Portées / Parties

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Vue d’ensemble

Mise en garde : le terme "Partie" utilisé dans ce chapitre et en en-tête de fenêtre est une dénomination actuellement inadaptée dans MuseScore Studio qui doit être mise à jour (donnée dépassée datant de MuseScore 3). Pour ce
chapitre, le terme est à interpréter comme instrument Musescore mais il faut noter que partout ailleurs dans ce manuel et dans MuseScore Studio, il signifie bien Parties (la fonctionnalité permettant d'aider à extraire des portées pour
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imprimer différentes versions d'une même partition).

La fenêtre de dialogue Propriétés de Portée / Partie vous autorise à modifier l’affichage d’une portée particulière ainsi que les propriétés des instruments Musescore associés. Pour ouvrir la fenêtre de dialogue :

Faites un clic droit sur une zone vide dans une portée ou bien sur le nom de l'instrument et sélectionnez Propriétés de la mesure…

Cliquer sur les boutons flèches de navigation ↑ et ↓ en haut à gauche annulera toute modification non enregistrée et basculera dans l'édition de la portée précédente ou suivante.

Il existe quatre types différents de portée :
1a. Portée standard I. C'est une portée de hauteur donnée utilisée pour la plupart des instruments excepté les instruments à frettes à corde pincée.
1b. Portée standard II. C'est une portée de hauteur donnée pour un instrument à frettes à cordes pincées avec des options pour paramétrer le nombre et la tonalité des cordes.
2. Portée tablature. C'est une portée pour un instrument à frettes à cordes pincées qui affiche la musique en séries de marques de frettes sur les cordes. Elle contient aussi des options pour paramétrer le nombre et la tonalité des cordes.
3. Portée de percussion. C'est une portée de hauteur donnée utilisée pour les instruments de percussion.

Les 4 instruments affichés ci-dessus montrent des exemples des 4 types de portées. Téléchargez ce fichier de démonstration : https://musescore.org/sites/musescore.org/files/2023-10/ms411_stafftype…

Pour chacun des types, il existe des modèles prédéfinis à choisir dans la fenêtre de fenêtre de propriétés de style avancé (Éditer le type de portée).

Remplacer un instrument modifie également le type de portée mais cela peut avoir des résultats inadéquats et entraîner une lecture incorrecte. Ce qui serait le cas, par exemple, en remplaçant un piano (portée standard de type 1a) par un
set de percussion (portée de percussion, type 3).

Propriétés des portées

La section supérieure de la fenêtre de dialogue vous permet de régler beaucoup de paramètres sur l'apparence d’une portée individuelle. Les options suivantes sont communes à tous les types de portées.

Première colonne :

Groupe de style : affiche le type de portée ; les types 1a et type 1b comme Standard , le type 2 comme Tablature , le type 3 comme Percussion.
Lignes : nombre de lignes constituant la portée. Pour une tablature, ce chiffre correspond habituellement au nombre de cordes de la fenêtre de dialogue Paramètres des cordes (à l'exception des instruments ayant plus de cordes que
de lignes comme le luth baroque, le théorbe, etc.).
Interligne : espacement entre deux lignes de la portée actuelle. Ce réglage est rarement utile. Voir comment paramétrer l'espacement de toutes les portées au chapitre Notions de mise en page.
Remarque : il n’est pas recommandé de changer cette valeur par défaut ; si vous avez besoin de rendre la portée plus grande ou plus petite, utilisez plutôt la fenêtre de dialogue Paramètres de la page.
Distance supplémentaire au-dessus de la portée: augmente ou diminue l’espace entre les portées sélectionnées et celle située au-dessus, dans tous les systèmes.
Remarques : (1) Ce réglage ne s’applique pas à la portée la plus haute d’un système, qui est contrôlée par la distance minimum/maximum de système (voir Mise en page). (2) L’espacement au-dessus d’une seule portée dans un
système particulier, voir Espacement vertical des pages.
Échelle : modifie en pourcentage la taille de la portée sélectionnée et de tous les éléments associés. Voir comment changer l'échelle de toutes les portées dans le chapitre Notions de mise en page.

Deuxième colonne :

Masquer lorsque vide : réglage de niveau portée pour masquer les portées vides au sein d'un système (voir le chapitre N'afficher les portées que si nécessaire).
Afficher la clef : détermine si la clef de la portée doit être affichée ou pas.
Afficher l’indication de mesure : détermine si les indications de mesure doivent être affichés ou pas.
Afficher les barres de mesure : détermine si les barres de mesures doivent être affichées ou pas.
Masquer la barre de mesure du système : affiche/masque la barre de mesure sur le côté gauche de la portée.
Fusionner les silences similaires : détermine si les silences similaires dans les autres voix sont à fusionner ou à laisser séparés.

Troisième colonne :

Ne pas masquer si le système est vide : désigne la portée à afficher quand toutes les portées d'un système sont vides (voir le chapitre N'afficher les portées que si nécessaire : Choisir la portée à afficher quand toutes les portées d'un
système sont vides).
Petite portée : crée une portée de taille réduite. On peut fixer les réglages par défaut dans le menu Format → Style… → Tailles.
Lignes de portée invisibles : rend invisibles les lignes de portée.
Couleur des lignes de portée : utilise un nuancier pour modifier la couleur des lignes de la portée.
Découper : réglage pour masquer des mesures vides (voir le chapitre N'afficher les portées que si nécessaire : Masquer des mesures vides).
Propriétés avancées de style : (voir ci-dessous)

Propriétés avancées de style
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Le bouton Propriétés avancées de style… ouvre une fenêtre de dialogue qui donne accès à des options avancées d’affichage pour la portée. Ces options varient en fonction du type de portée choisie.

Propriétés avancées de style communes aux quatre types de portées

Première ligne : Lignes, Interligne__: interface utilisateur dupliquée avec les mêmes propriétés qu'au-dessus
Deuxième ligne : Afficher la clef, Afficher l'indication de mesure, Afficher les barres de mesure : interface utilisateur dupliquée avec les mêmes propriétés qu'au-dessus
Au bas de la fenêtre : liste déroulante Modèle
Assigner un modèle modifie le nombre de lignes (portée de percussion type 3) ou intervertit entre eux les types de portée (type 1a, type 1b et type 2). Pour appliquer un modèle :
1. Effectuez une sélection dans la liste déroulante étiquetées "Modèle"
2. Cliquer sur < Rétablir par rapport au modèle
3. Cliquer sur OK pour accepter le changement et quitter le fenêtre de dialogue (ou Annuler pour annuler l'opération).

Propriétés avancées de style : réglages pour les portées standard et de percussion (Type 1a, type 1b et type 3)

Troisième ligne :

Afficher l'armure, Afficher les lignes supplémentaires : options pour l'affichage de ces éléments (Oui/non).
Sans hampe : si elle est cochée, les notes de la partition n'auront ni hampe ni crochet.

Propriétés avancées de style : réglages pour les portées standard (Type 1a, type 1b)

Type de tête de note : voir Types de têtes de notes.

Propriétés avancées de style : réglages pour la portée tablature (Type 2)

Inverser : si l’option n’est pas cochée, la ligne de tablature du haut se réfère à la corde du haut et le bas de la tablature à la corde du bas (c’est l’option la plus commune). Si elle est cochée, c’est l’inverse (exemple : tablature de luth de
style italien).
Aperçu : affiche une courte section d’un spécimen de partition telle qu’elle apparaîtrait avec les options courantes appliquées.

Sous l'onglet Frettes
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Les repères de frette sont les nombres et les lettres utilisés pour indiquer la localisation des notes sur le manche/la touche. Les groupes de propriétés suivantes définissent l’apparence des repères de frettes :

Police : police utilisée pour dessiner les marques de frette. Une sélection de huit polices est fournie avec tous les symboles nécessaires dans 8 différents styles — à la fois modernes et historiques.
Taille : taille de police en points typographiques. Les polices intégrées ont habituellement un bel effet à une taille de 9-10 pt.
Décalage vertical : MuseScore Studio tente de placer les symboles de façon pratique et on n’a pas habituellement à modifier cette valeur (réglée à 0) pour les polices intégrées. Si les symboles de la police utilisée ne sont pas alignés
sur les lignes de base, cette propriété permet de déplacer les frettes vers le haut (décalage négatif) ou vers le bas (décalage positif) pour un meilleur positionnement vertical. Les valeurs sont en sp..
Les repères sont des : définit si on doit utiliser des Nombres (“1”, “2”…) ou des Lettres (“a”, “b”…) comme repères de frettes. Quand les lettres sont utilisées, la lettre “j” est sautée et “k” est utilisé pour la 9e frette.
Les repères sont affichés : choisir si les repères de frette sont positionnés Sur les lignes ou Au-dessus des lignes.
Les lignes sont : choisir entre Continues (les lignes passent à travers les repères de frette) ou Discontinues (un petit espace apparaît sur la ligne là où le repère de frette est affiché).
Afficher les repères liés : si l’option n’est pas cochée, seule la première note d’une série de notes liées est affichée. Si elle est cochée, toutes les notes d’une série liée sont affichées.
Afficher les doigtés dans la tablature : cocher pour autoriser l’affichage des symboles de doigté appliqués depuis une palette.

Sous l'onglet Valeurs de notes : propriétés qui définissent l’apparence des symboles indiquant les valeurs de notes

Police : police choisie pour dessiner les figures de rythme. Actuellement, 5 polices sont fournies qui supportent tous les symboles nécessaires dans 5 styles différents : moderne, italien, tablature, tablature française, baroque français
(sans tête). Utilisé uniquement avec l’option "Symbole de note" (voir ci-dessous).
Taille : taille de police en points typographiques. Les polices intégrées ont habituellement un bel effet à une taille de 15pt. Utilisé uniquement avec l’option "Symboles de note" (voir ci-dessous).
Décalage vertical : Utilisé uniquement quand l’option "Symboles de note" est utilisée (voir ci-dessous). Utiliser des valeurs négatives pour déplacer les symboles vers le haut, des valeurs positives pour les déplacer vers le bas.
Affichées comme :

Aucune : aucune valeur de note ne sera affichée (comme dans l’exemple au-dessus)
Symboles de notes : symboles sous la forme de notes qui sont affichés au-dessus de la portée. Quand cette option est sélectionnée, les symboles ne sont affichés que quand la valeur de note change, sans être répétés (par
défaut) pour une séquence de notes de la même valeur.
Hampes et ligatures : les hampes des notes et les ligatures (et crochets) seront dessinées. Les valeurs sont indiquées pour chaque note, en utilisant la même mécanique typographique que dans une portée standard ; toutes les
commandes de la palette Propriétés des ligatures peuvent être appliquées à ces ligatures également.

Répétées : si plusieurs notes d’une même séquence ont la même durée, on peut spécifier si et où répéter le même symbole de note. Par exemple : Jamais / Nouveau système / Nouvelle mesure / Toujours.
Remarque : cette option n’est disponible que si “Affichées comme : Symboles de notes” est sélectionné (voir ci-dessus).
Styles de hampe :

A côté de la portée : les hampes sont dessinées à une hauteur fixe au-dessus/au-dessous de la portée.
A l’intérieur de la portée : les hampes traversent la portée pour toucher les repères de frette.
Remarque : cette option n’est disponible que quand “Affichées comme : Hampes et ligatures” est sélectionné (voir plus haut).

Position de la hampe :
Au-dessus : hampes et ligatures sont dessinées au-dessus de la portée.
Au-dessous : hampes et ligatures sont dessinées sous la portée.
Remarque : cette option n’est disponible que quand “Affichées comme : Hampes et ligatures” et “Style de hampe : A côté de la portée” sont sélectionnés (voir plus haut).

Blanches : Aucune / Avec une hampe courte / Avec une hampe barrée.
Remarque : cette option n’est disponible que quand “Affichées comme : Hampes et ligatures" et “Style de hampe : A côté de la portée” sont sélectionnés (voir plus haut).
Afficher les silences : indique si les symboles de notes doivent aussi être utilisés pour afficher les silences ; quand ils sont utilisés pour les silences, les symboles de notes sont dessinés à une position légèrement plus basse. Utilisé
uniquement avec l’option "Symbole de note" (voir ci-dessus).

Propriétés des parties

Mise en garde : le terme "Partie" utilisée dans l'en-tête est inadapté pour MuseScore Studio

Instrument

Le nom de l’instrument est affiché ici. Pour changer l’instrument,

cliquez sur le bouton Changer d’instrument et faites un choix dans la fenêtre "Sélectionner un instrument". Cela remplace l'instrument auquel cette portée appartient et modifie toutes les portées liées à cet instrument. Cela modifie la
lecture, le nom de la portée, la transposition, etc. Le changement de type de portée peut avoir des résultats inadéquats et entraîner une lecture incorrecte.
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Noms

Nom long de l’instrument : libellé affiché à gauche de la portée dans le premier système de la partition ou de la section.
Nom abrégé de l’instrument : libellé affiché à gauche de la portée dans les système suivants de la partition.

Tessiture/registre utilisable

Amateur : les notes en dehors du registre amateur sont colorées en vert olive/jaune foncé dans la partition.
Professionnel : les notes en dehors du registre professionnel sont colorées en rouge dans la partition.

Remarque : pour désactiver la coloration des notes en dehors de la tessiture/du registre, allez au menu Édition → Préférences… (Mac : MuseScore → Préférences…), cliquez dans l’onglet “Saisie des notes” et décochez la case “Mettre en couleur
les notes extrêmes de l’étendue de l’instrument.”

Transposition

Définissez l’octave et l’intervalle haut/bas pour s’assurer que la transposition de l’instrument est correctement établie. Cela est automatiquement réalisé par le programme pour la plupart des instruments.

Pour les instruments transpositeurs, une option additionnelle est affichée : "Choisir Dièses ou Bémols pour la transposition des armures". Il y a trois options :

Par défaut : laisser MuseScore Studio décider
Bémols : préférer une armure en bémols
Dièses : préférer une armure en dièses.

Propriétés des parties : réglages pour les cordes pincées uniquement (Type 1b et type 2)

En plus de celles listées ci-dessus, les portées d'instruments à cordes frettées et pincées (Type 1b et type 2) possèdent quelques options supplémentaires affichées dans la partie basse de la fenêtre,

Nombre de cordes : affiche le nombre de cordes de l’instrument.
Éditer les paramètres des cordes… : ce bouton ouvre une fenêtre de dialogue qui permet de régler le nombre et la hauteur des cordes. Voir Modifier le réglage d'accord.

Crochets de systèmes

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Vue d'ensemble

Différents types de crochets et une accolade sont fournis dans la palette "Crochets".
Les crochets/accolades sont automatiquement appliqués quand une partition est créée dans la fenêtre de dialogue Nouvelle partition. Vous pouvez facilement les changer si celles par défaut ne sont pas celles souhaitées (vois plus bas).

Ajouter un crochet

Pour ajouter un crochet ou une accolade à tous les systèmes :

Cliquez sur la première mesure de la portée où vous voulez faire commencer le crochet/l’accolade, maintenez Shift et cliquez sur la mesure où doit se terminer le crochet/l’accolade.
Cliquez sur l’icône du type de crochet souhaité dans la palette "Crochets".

De façon alternative :

Sélectionnez la mesure de départ et cliquez dans la palette "Crochets" sur le crochet à insérer
Sélectionnez le crochet dans la partition, cliquez sur la poignée d’ajustement et faites-la glisser vers le bas jusqu’à la position désirée pour la mettre en place.

Des crochets imbriqués peuvent aussi être mis en place avec ces méthodes, en appliquant d’abord le symbole le plus interne et en finissant par le symbole le plus externe. L’ordre peut être édité secondairement en utilisant la propriété
"Colonne" (voir plus bas).

Éditer les crochets

Si vous sélectionnez un crochet/une accolade, vous pouvez éditer ses propriétés dans le panneau Propriétés.

Colonne : déplace le crochet vers l’intérieur/l’extérieur.
Étendue : étend ou rétracte la fin du crochet/de l’accolade.

Modifier le type de crochet

Sélectionnez le crochet/l’accolade à modifier dans la partition puis cliquez sur le nouveau type de crochet/accolade dans la palette "Crochets".

Changer l’étendue de crochet

Utilisez une des méthodes suivantes :

Sélectionnez le crochet, cliquez sur la poignée d’ajustement et faite la glisser jusqu’à la position souhaitée.
Sélectionnez le crochet, cliquez sur la poignée d’ajustement et tapez sur les touches Shift+↑/↓ pour le déplacer de portée en portée.
Modifier le paramètre "Espace" dans le panneau Propriétés.

Supprimer un crochet

Pour supprimer un crochet/une accolade, sélectionnez l’élément et tapez Suppr..

Personnaliser l’apparence du crochet

Les crochets/accolades ont quelques propriétés qui peuvent être paramétrées dans le menu Style :

Réglez l’Épaisseur du crochet et la Distance entre crochet et système dans Format → Style → Système.
Ajustez la Distance au-dessus/au-dessous dans Format → Style → Page → Activer la justification verticale des portées.

Notation : Rythme, temps et mesures

Indications de mesure

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Vue d’ensemble

Les indications de mesure (chiffres indicateurs) sont appliquées à la partition à partir de la palette "Indications de mesure".

Fixer l’indication de mesure initiale de votre partition

Cela est réalisé dans le deuxième écran de la Fenêtre de dialogue Nouvelle partition.

Ajouter un changement d’indication de mesure dans votre partition

Utilisez l’une des méthodes suivantes :

Sélectionnez une indication de mesure, une mesure, une note ou un silence existant dans votre partition et cliquez sur une indication de mesure dans la palette.
Cliquez et déplacez une indication de mesure depuis la palette vers un espace dans une mesure ou vers une indication de mesure existante.

Supprimer une indication de mesure

Pour supprimer une indication de mesure dans la partition, sélectionnez-la et cliquez sur la touche Suppr..
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Paramétrez la visibilité des indications de mesure

Pour masquer/afficher les indications de mesures dans une portée particulière :

Faites un clic droit sur la portée et choisissez "Propriétés de Portée / Partie ";
Décochez/cochez "Afficher l’indication de mesure".

Pour désactiver/activer toutes les indications de mesures de précaution (rappels affichés à la fin des systèmes) :

Dans la barre de menu, sélectionnez Format → Style →Page.
Décochez/cochez "Créer des indications de mesure de précaution".

Pour masquer/afficher une indication de mesure de précaution individuelle :

Sélectionnez l’indication de mesure "parente"
Dans la section Indication de mesure du panneau Propriétés, décochez/cochez "Afficher l’indication de mesure de précaution sur le système précédent".

Créer un indicateur de mesure personnalisé

Dans la palette Indications de mesure, cliquez sur Plus puis, dans la palette supplémentaire, cliquez sur le bouton “Créer l’indication de mesure”
Dans Valeur saisissez les chiffres indicateurs du haut (numérateur) et du bas (dénominateur) voire, de façon optionnelle, le texte (quand vous souhaitez que l’affichage soit différent de l’actuel indicateur de mesure)
Paramétrez les ligatures de notes dans la section Groupes de ligatures (voir Groupes de ligatures plus bas).
Cliquez sur Ajouter pour transférer le nouveau modèle d’indication de mesure dans la palette.

Vous pouvez aussi faire la même chose dans la Palette principale (Shift+F9).

Ajouter une indication de mesure locale dans une seule portée

Dans certains cas, une partition peut montrer deux portées avec des indicateurs de mesure différents à jouer en même temps. C’est le cas, par exemple, dans la suivante (Variation Goldberg n° 26 de J. S. Bach) :

L’indication de mesure globale est 3/4 mais l’indication de mesure dans la portée du haut a été réglée de façon indépendante à 18/16.

Pour ajouter une indication de mesure limitée à une portée :

Maintenez la touche Ctrl (Mac : Cmd) et glissez/déposez une indication de mesure depuis la palette jusque dans une mesure vide.

Redimensionner une indication de mesure

Sélectionnez une indication de mesure
Dans la section Indication de mesure du panneau Propriétés, paramétrez les valeurs d’échelle horizontale et verticale.

Propriétés des indications de mesure

Pour ouvrir la fenêtre de dialogue Propriétés de l’indication de mesure utilisez un des moyens suivants :

Faites un clic droit sur un indicateur de mesure et, dans le menu contextuel, sélectionnez "Propriétés de l’indication de mesure…".
Sélectionnez une indication de mesure puis, dans la section "Indication de mesure" du panneau Propriétés, cliquez sur le bouton Propriétés de l’indication de mesure.

Apparence

Cette partie de la fenêtre de dialogue vous permet d’ajuster l’apparence visuelle de l’indication de mesure sans affecter la valeur rythmique sous-jacente.

Texte : insère les chiffres que vous voulez voir s’afficher au numérateur et au dénominateur dans la partition.
Vous pouvez également faire une sélection depuis une variété de symboles (pour plus d'informations sur ces symboles, voir Ligatures).

Groupes de ligatures

Voir le chapitre Ligatures.

Style d’indications de mesure

Il existe quelques paramètres généraux de styles pour les indications de mesure (voir Format → Style).

Afficher le rappel des indications de mesure : option située dans la section Clefs - Armure - Indications de mesure. Cochez la case pour créer les indications de mesure de précaution ou décocher la pour annuler cette
fonctionnalité.
Entre la clef et l’indication de mesure / Entre l’armure et l’indication de mesure / Entre la barre de mesure et l’indication de mesure / Entre l’indication de mesure et la barre de mesure / Entre l’indication de mesure et la
première note : paramètres situés dans la section Mesures. Ils vous permettent de définir les divers espacements entre l’indication de mesure et les autres éléments à proximité.

Hampes et crochets de notes

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Direction de hampe

Direction des hampes par défaut
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MuseScore Studio aligne les hampes des notes de la voix 1 en accord avec les conventions de théorie musicale. En revanche, les hampes des notes des voix 2 et 4 sont dirigées vers le bas alors que celles de la voix 3 sont dirigées vers le
haut. En présence de notes de voix 2 ou 4, les hampes de la voix 1 sont automatiquement dirigées vers le haut.

Renverser la direction de la hampe

Sélectionnez soit la tête de note, soit la hampe, soit la ligature associée (si existe)
Utilisez une des méthodes suivantes :

Tapez X
Cliquez sur l’icône "Changer de sens" dans la boite d’outils Saisie des notes
Sélectionnez une direction de hampe dans l’onglet Hampe du panneau Propriétés

Cette action renversera également toutes les ligatures associées.

Modifier la longueur de hampe

Sélectionnez la hampe
Utilisez une des méthodes suivantes :

Tapez ↑/↓ pour augmenter ou diminuer la longueur de hampe
Changez Longueur dans le panneau Propriétés (après avoir cliqué sur Afficher plus si nécessaire)
Utilisez la poignée de dimensionnement de la hampe en la faisant glisser avec la souris.

Créer des notes sans hampe

Pour masquer les hampes de notes individuelles :

Sélectionnez une ou plusieurs têtes de notes
Allez dans le panneau Propriétés
Sélectionnez l’onglet Hampe
Cochez la case à côté de Sans hampe

Pour masquer toutes les hampes dans une partie d’instrument :

Faire un clic droit sur la portée et sélectionnez Propriétés de la Portée / Partie
Cliquez sur Propriétés avancées de style
Cochez la case devant Sans hampe

Propriétés des hampes et crochets de notes

Des propriétés spécifiques aux hampes et crochets de notes peuvent être éditées dans l’onglet Hampe de la section Note du panneau Propriétés :

Sans hampe : masque les hampes et ligatures associées des notes sélectionnées
Direction de hampe :

Automatique détermine la direction de la hampe en fonction de la voix des notes sélectionnées
Flèches ↑ et ↓ forcent la direction par défaut des hampes

Types de ligature : détermine l’apparence des crochets de note pour la partition entière, soit en style traditionnel, soit en style linéaire
Épaisseur : règle l’épaisseur de la hampe
Longueur : détermine la longueur de la hampe
Décalage hampe : utilisé pour déplacer la hampe dans une direction horizontale/verticale

Styles des hampes et crochets de notes

Des réglages globaux peuvent aussi être paramétrés via le menu Format → Style → Notes tels que Épaisseur de la hampe ou Style de hampe.

Voir aussi

Ligatures

Ligatures

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Aperçu

Une ligature est une ligne qui connecte des notes consécutives pour indiquer un groupe rythmique de notes croches ou plus courtes (Wikipedia ). Vous pouvez paramétrer la présence ou l'absence de ligatures entre les notes ainsi que leur
apparence.

Paramétrer quelles notes sont liées par des ligatures

Le mode de ligature par défaut est déterminé dans les propriétés de l'indication de mesure. Vous pouvez les éditer et donc modifier les ligatures pour l'ensemble des notes liées à cette indication de mesure. Vous pouvez aussi éditer les
ligatures des notes individuelles, ce qui remplacera le réglage par défaut.

Régler le mode de ligature par défaut pour une indication de mesure

Voir la page Indications de mesure.

Chaque indication de mesure possède un réglage par défaut qui contrôle l'affichage les ligatures de l'ensemble des notes liées à cette indication de mesure. Comme on souhaite habituellement que toutes les ligatures soient cohérentes tout
au long de la partition, c'est bien à ce moment que l'on peut commencer de déterminer le mode de ligature. Pour éditer les paramètres par défaut pour une indication de mesure donnée, utilisez la boîte de dialogue Propriétés de l'indication
de mesure.

Accéder aux propriétés de l'indication de mesure

Sélectionnez une indication de mesure dans la partition
Cliquez sur le bouton Propriétés de l'indication de mesure dans le panneau Propriétés
Éditez la section Groupes de ligatures comme expliqué plus bas.

Vous pouvez aussi accéder à cette fenêtre de dialogue en faisant un clic droit sur une indication de mesure.

Note : les paramétrages réalisés dans cette boîte de dialogue s'appliquent par partition mais aussi par portée. Pour appliquer les modifications aux autres portées de la partition, vous pouvez faire glisser l'indication de mesure vers une autre
portée tout en utilisant Ctrl + Maj, ce qui a la même fonction que son ajout via la palette. Pour rendre disponible une indication de mesure personnalisée dans d'autres partitions, déplacez-la avec Ctrl +Maj vers la palette.

Groupes de ligatures

Pour modifier la ligature d'une note de durée donnée sur un temps donné, cliquez sur la note correspondante dans la section Groupes de ligatures pour basculer entre les modes ligature ou non ligature pour cette note. Ainsi, cliquez sur
une note qui est actuellement liée par une ligature à la note précédente pour faire cesser la ligature et cliquez sur une note non liée à la précédente pour rétablir la ligature. Vous pouvez aussi déplacer une des icônes du Sélecteur de
ligature sur n'importe quelle note donnée pour lui attribuer ce type de ligature comme cela est expliqué plus loin.

Si vous sélectionnez l'option Modifier aussi les notes plus courtes, la modification s'appliquera à toutes les notes du même temps, quelle que soit leur durée.
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Cliquez sur Réinitialiser pour annuler toutes les modifications réalisées depuis que la boîte de dialogue a été ouverte. Notez que ce bouton ne réinitialise pas les paramétrages originaux réalisés via la palette. Pour annuler toutes les
modification réalisées depuis que l'indication de mesure a été ajoutée, utilisez la palette pour la remplacer par une nouvelle indication de mesure.

Remplacer la ligature par défaut d'une note ou d'un silence spécifique

Les propriétés de l'indication de mesure contrôlent le mode de ligature par défaut des notes de la partition mais vous pouvez outrepasser ce comportement sur la base d'un réglage note par note, de façon à obtenir une mesure avec des
notes liées de façon différente des autres. Cela peut être utile lors de l'écriture de certains rythmes, afin de les rendre plus lisibles, ou dans les cas où les options disponibles dans les Propriétés d'indication de mesure ne sont pas
suffisantes pour créer les comportements par défaut souhaités. C'est aussi la seule façon de créer des ligatures entre silences.

Les propriétés de ligature sont paramétrées sur les notes elles-mêmes. Pour modifier la ligature entre deux notes, vous devrez normalement commencer par sélectionner la seconde des deux notes puisque la plupart des propriétés de
ligature contrôlent la ligature précédant une note. Notez que ces propriétés peuvent être réglées depuis le panneau Propriétés ou la palette Propriétés de ligature ; cependant, cette section portera sur le paramétrage via le panneau
Propriétés.

Pour modifier la ligature d'une note donnée :

Sélectionnez la note
Sélectionnez l'onglet Ligature* dans la section **Note du panneau Propriétés

Sélectionnez une des icônes pour attribuer la propriété appropriée.

De la gauche vers la droite, les propriétés disponibles sont :

Auto : réinitialise le mode de ligature au comportement par défaut de l'indication de mesure
Note seule sans ligature : interrompt les ligatures précédant et suivant la note sélectionnée
Interrompre la ligature à gauche de la note : interrompt toute ligature liée à la note précédente
Interrompre les ligatures à gauche et/ou à droite (Croches) : interrompt toutes les ligatures de la note sélectionnée sauf celle de niveau croche (pour les notes qui pourraient avoir 2 ligatures ou plus)
Interrompre les ligatures à gauche et/ou à droite (Doubles-croches) : interrompt toutes les ligatures de la note sélectionnée sauf celle de niveau double-croche (pour les notes qui pourraient avoir 3 ligatures ou plus)
Joindre les ligatures : établit une (des) ligature(s) depuis la note précédente vers la note sélectionnée (sauf si la note précédente est paramétrée comme Note seule).

Afficher des ligatures au-dessus des silences

Pour étendre une ligature au-dessus d'un silence :

Sélectionnez le silence
Appliquez la propriété Joindre les ligatures ou Interrompre la ligature à gauche de la note

Afficher des ligatures à travers des barres de mesure

Pour étendre une ligature à travers une barre de mesure :

Sélectionnez la première note ou silence après la barre de mesure
Appliquez la propriété Joindre les ligatures.

Paramétrer l'apparence des ligatures

Alors que l'attribution et l'interruption de ligatures est une fonction des notes individuelles, l'apparence courante des ligatures peut être paramétrée en sélectionnant, soit les ligatures elles-mêmes, soit n'importe quelle note qu'elles joignent.
Par conséquent, pour régler ces propriétés, vous pouvez au choix :

Sélectionner une note comportant une ligature
Sélectionner l'onglet Ligature dans la section Note du panneau Propriétés

ou bien

Sélectionner la ligature elle-même.

Quelle que soit la modalité choisie, vous verrez s'afficher à ce moment les mêmes options pour paramétrer l'apparence de la ligature.

Ligatures progressives

Les boutons de la section Ligatures progressives du panneau Propriétés peuvent être utilisés pour indiquer un changement de rythme progressif (accélération ou ralentissement) entre les notes liées (notez que cela n'est pas supporté en
lecture). Ces options ne peuvent être attribuées que pour les doubles croches et croches utilisant des ligatures multiples.

Aucun : réinitialise l'apparence standard (sans changement de vitesse)

Ajouter une ligature progressive : Ralentir : les ligatures se rapprochent pour indiquer une ralentissement progressif du rythme

Ajouter une ligature progressive : Accélérer : les ligatures s'ouvrent en éventail pour indiquer une augmentation progressive du rythme.

Les icônes Ralentir et Accélérer sont également accessibles dans la palette Propriétés des ligatures.

Hauteur de ligature

Manuel de MuseScore 4 https://musescore.org/fr/print/book/export/html/329209?toc=1#undefin...

75 sur 199 04/07/2025, 12:24



La hauteur d'une ligature peut être réglée directement en la sélectionnant et en déplaçant les poignées qui s'affichent, soit avec la souris, soit via les touches fléchées du clavier. Mais vous pouvez aussi utiliser les paramètres du panneau
Propriétés. Vous pouvez d'abord avoir à cliquer sur le bouton Afficher plus pour afficher cette section.

Les deux paramètres trouvés ici correspondent aux poignées gauche et droite de la ligature et vous permettent d'attribuer la hauteur de chaque côté de la ligature de façon indépendante.

Vous pouvez aussi forcer une ligature à devenir horizontale en activant la case à cocher Horizontale.

Style des ligatures

Quelques propriétés globales applicables aux ligatures peuvent être paramétrées via Format → Style → Ligatures :

Distance entre les ligatures : définit la distance verticale d’une ligature à une autre
Épaisseur de la ligature : règle l'épaisseur de toutes les ligatures
Longueur minimale de la coupure de la ligature : définit la longueur minimale des ligatures interrompues comme celles utilisées dans les rythmes pointés
Aplanir l’ensemble des ligatures : cochez pour rendre toutes les ligatures horizontales, sans tenir compte du contexte.

Voir aussi

How to add a beam over a rest  (Comment ajouter une ligature passant au-dessus d'un silence) [en anglais]
Utiliser les palettes

Regrouper les rythmes

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Vue d’ensemble

La notation musicale standard suit normalement un corpus de conventions destinées à faciliter la lecture du rythme. L’idée de base est de grouper les notes de telle façon que l’on reconnaisse facilement à quel temps elles appartiennent.
Parmi ces règles :

les doubles croches devraient comporter des ligatures pour différencier chaque temps
les croches devraient être associées à des ligatures pour chaque groupe de deux temps
les notes plus longues qui commencent en dehors du temps devraient être interrompues avec des crochets pour signaler chaque temps ou groupe de deux temps.

La discussion détaillée sur ce sujet va au-delà de l’objet de ce Manuel mais des informations plus complètes peuvent être trouvées (en anglais) dans ce document .

Voici un exemple de rythme écrit de façon incorrecte suivi de la bonne notation :

MuseScore Studio peut corriger automatiquement la plupart de ces cas.

Regrouper les rythmes

Pour regrouper les rythmes en respectant les conventions standard de la notation musicale :

Sélectionnez le passage que vous souhaitez regrouper
Dans le menu principal, sélectionnez Outils → Regrouper les rythmes.

Le rythme lui-même n’est pas modifié — seulement sa notation (si besoin).

Voir aussi

Notation Rules: Rhythm

Divisions irrégulières

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Créer une division irrégulière

Une division irrégulière est un groupe de notes qui divise le temps d’une autre façon que celle normalement permise par l’indication de mesure. Le triolet, qui consiste en 3 croches jouées en un temps (celui d’une noire), est le type de
division irrégulière le plus fréquent.

Division irrégulière simple

Une division irrégulière simple comme le triolet montré ci-dessus peut être saisi en mode de saisie des notes ou dans le mode normal.

Dans le mode de saisie des notes

Naviguez jusqu’à la note/silence (ou la mesure vide) où vous souhaitez que la division irrégulière commence
Sélectionnez une note dont la durée s’applique à l’ensemble du groupe de notes de la division irrégulière (par exemple, pour un triolet de croches, cette durée est celle de la noire — dont le raccourci clavier est 5).
Utilisez une des commandes suivantes :

Tapez le raccourci clavier pour la division irrégulière souhaitée ; par exemple : Ctrl+3 pour un triolet ; Ctrl+4 pour un quartolet … etc. jusqu’à Ctrl+9 pour un "nonolet". (Mac : Cmd+3 … Cmd+9)
Dans le menu, choisissez Ajouter → Divisions irrégulières puis sélectionnez la division souhaitée.
Dans la barre d’outils de saisie des notes, cliquez sur l’icône Division irrégulière et sélectionnez celle désirée dans la liste déroulante.
La note ou le silence est automatiquement divisé(e) pour vous et la notation appropriée est affichée.

Saisissez les séries désirées de notes/silences.

Dans le mode normal

Sélectionnez une note dont la durée s’applique à l’ensemble du groupe de notes de la division irrégulière. Vous pouvez avoir besoin de la créer au préalable dans la partition. Ainsi, si vous voulez créer un triolet de croches, vous devez
sélectionner une noire ou un soupir.
Utilisez une des commandes suivantes :

Tapez le raccourci clavier pour la division irrégulière souhaitée ; par exemple : Ctrl+3 pour un triolet ; Ctrl+4 pour un quartolet … etc. jusqu’à Ctrl+9 pour un "nonolet". (Mac : Cmd+3 … Cmd+9)
Dans le menu, choisissez Ajouter → Divisions irrégulières puis sélectionnez la division souhaitée.
Dans la barre d’outils de saisie des notes, cliquez sur l’icône Division irrégulière et sélectionnez celle désirée dans la liste déroulante.
La note ou silence est automatiquement divisé(e) pour vous et la notation appropriée est affichée.

Saisissez les séries désirées de notes/silences.

Divisions irrégulières consécutives

Si vous avez besoin de saisir une série de divisions irrégulières et que vous ne souhaitez pas répéter continuellement la commande de création individuelle, vous pouvez sélectionner les notes de la première division irrégulière et taper R
(répétition) aussi souvent que nécessaire ; puis déplacer les notes suivantes dans leur position (hauteur) en utilisant les touches fléchées ou en les retapant, notamment en mode Hauteur des notes.

Divisions irrégulières personnalisées

Des divisions plus complexes peuvent être créées selon les modalités suivantes :

En mode de saisie des notes, sélectionnez une note dont la durée s’applique à l’ensemble du groupe de notes de la division irrégulière ou, en mode normal, sélectionnez un note/silence de la durée totale souhaitée
Ouvrir la fenêtre de dialogue Créer une division irrégulière en sélectionnant Autres, soit depuis le menu (Ajouter → Divisions irrégulières → Autres…, soit en cliquant sur l’icône Division irrégulière (barre d’outils de saisie des
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notes).

Dans le champ Ratio, spécifiez les nombres souhaités pour le ratio de la division irrégulière
Définissez le Numéro et le type de Crochet à utiliser pour l’affichage de la division irrégulière
Cliquez sur le bouton OK pour fermer la fenêtre de dialogue
Saisissez la série souhaitée de notes et de silences.

Divisions irrégulières imbriquées

Une division irrégulière peut être imbriquée avec une autre division irrégulière.

Pour créer des divisions irrégulières imbriquées :

Créer la division irrégulière extérieure comme décrit plus haut
Pendant la saisie des notes individuelles, créez une division irrégulière à l’intérieur (sélectionnez la durée totale pour la division irrégulière interne puis utilisez une des commandes vues plus haut pour la diviser de façon appropriée).

Modifier l’affichage des divisions irrégulières

Vous pouvez choisir d’afficher ou de masquer le numéro ou le crochet de la division irrégulière, changer son orientation ou régler l’épaisseur de la ligne. Voir Propriétés des divisions irrégulières ci-dessous.

Propriétés des divisions irrégulières

L’affichage des divisions irrégulières sélectionnées peut être modifié dans la section Division irrégulière du panneau Propriétés (après en avoir sélectionné au moins une en cliquant sur son crochet).

Direction : indique si l’indication de division irrégulière doit apparaître au-dessus ou au-dessous du groupe de note. Les réglages disponibles sont "Automatique", "au-dessus" (↑) ou "au-dessous" (↓).
Type de numéro : affecte l’affichage du numéro, avec un choix entre "Numéro", "Ratio" ou "Aucun".
Type de crochet : détermine l’affichage du crochet, entre "Automatique", "Crochet", or "Sans crochet".
Épaisseur de la ligne : fixe l’épaisseur de la ligne, si le crochet est affiché.

Style des divisions irrégulières

Voir Modèles et styles.

Les valeurs du "Style de division irrégulière" peuvent être éditées via Format → Style → Divisions irrégulières.
Les valeurs de "Style pour le texte dans les divisions irrégulières" peuvent être éditées via Format → Style → Styles de texte → Division irrégulière

Le "Style pour divisions irrégulière " contient

Les paramètres comprennent :

Propriétés
Direction
Type de numéro
Type de crochet

Crochets
Épaisseur du crochet
Hauteur du crochet

Distance verticale par rapport aux notes
Inclinaison maximale
Distance verticale depuis la hampe
Distance verticale depuis la tête de note
Éviter les portées

Distance horizontale par rapport aux notes
Distance avant la hampe de la première note
Distance avant la tête de la première note
Distance après la hampe de la dernière note
Distance après la tête de la dernière note

Barres de mesure

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Vue d'ensemble

La palette Barres de mesure contient une gamme complète de barres de mesure.
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Modifier ou ajouter des barres de mesure

Modifier le type de barre de mesure dans toutes les portées

Sélectionnez une ou plusieurs barres de mesure dans une portée
Cliquez sur le modèle désiré de barre de mesure dans la palette.

De façon alternative, vous pouvez cliquer/déposer un modèle de la palette vers une barre de mesure de la partition.

Les modifications sont appliquées automatiquement à toutes les barres de mesures situées au même endroit que la sélection dans les autres portées de la partition.

Modifier le type de barre de mesure pour une seule portée

Sélectionnez une ou plusieurs barres de mesure dans la partition
Gardez la touche Ctrl appuyée puis cliquez sur le modèle désiré de barre de mesure dans la palette.

De façon alternative, vous pouvez utiliser la touche Ctrl tout en cliquant/déposant un modèle de la palette vers une barre de mesure de la partition.

Seules les barres de mesure sélectionnées sont affectées.

Ajouter des barres de mesures au sein d’une même mesure

Sélectionnez une ou plusieurs notes
Cliquez sur une barre de mesure dans la palette.

Cela ajoute une "barre de mesure" devant chaque note sélectionnée. Cette barre n’a qu’un objectif visuel et ne joue aucun autre rôle particulier.
Si vous souhaitez diviser une mesure en y insérant une vraie barre de mesure voir le processus Scinder une mesure.

Modifier la longueur de la barre de mesure

Nous évoquons ci l’extension verticale des barres de mesure pour lier plusieurs portées ensemble ou leur réduction en barres de mesure partielles.

Étendre toutes les barres de mesures d’une portée

Sélectionnez une barre de mesure au "départ" de la portée
Utilisez une des procédures suivantes :

Déplacez la poignée de fin vers le bas jusqu’à ce qu’elle atteigne la portée de destination. Cette méthode est la plus efficace pour étendre les barres de mesure à travers des mesures multiples.
Sélectionnez la poignée et tapez sur la touche ↓.
Cochez la case "Étendre à la portée suivante" dans la section Barre de mesure du panneau Propriétés puis cliquez sur le bouton Définir comme paramètre de portée par défaut

Répétez si nécessaire pour les autres portées.

La barre de mesure se met en place ainsi que toutes les autres barres de mesures de cette portée.

Étendre les barres de mesure sélectionnées dans une portée

Sélectionnez une ou plusieurs barres de mesure (et leur contrepartie dans les portées inférieures s’il y a davantage que deux portées à joindre)
Cochez la case "Étendre à la portée suivante" dans la section Barre de mesure du panneau Propriétés.

Créer des barres de mesure partielles

Des barres de mesures partielles peuvent être facilement créées en ajustant les réglages "Étendre à partir de" et "Étendre jusqu’à" dans la section Barre de mesure du panneau Propriétés.

Créer des barres de mesures uniquement entre portées (Mensurstrich)

Voir Travailler avec des Mensurstrich.

Propriétés des barres de mesure

Vous pouvez éditer les propriétés spécifiques aux barres de mesure dans la dans la section Barre de mesure du panneau Properties :

Style : utilisé pour sélectionner l’aspect de la barre de mesure dans la liste déroulante
Étendre jusqu’à la portée suivante : cocher cette case pour étendre les barres de mesure jusqu’à la portée du dessous
Étendre à partir/jusqu’à : utilisé pour éditer les points de départ et de fin des barres de mesure sélectionnées
Définir comme paramètre de portée par défaut : applique à toutes les barres de mesure de la portée les changements réalisés dans Étendre jusqu’à la portée suivante et Étendre à partir/jusqu’à
Extensions prédéfinies : applique le modèle prédéfini aux barres de mesures sélectionnées dans la partition.

Style des barres de mesure

Les propriétés de toutes les barres de mesure peuvent être modifiées dans le menu Format → Style → Barres de mesure:

Voir aussi

Barres de répétition.
Largeurs fixes de mesure , une solution de rechange afin de s’assurer que les barres de mesures soient alignées verticalement entre systèmes (en anglais).

Numérotation des mesures

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]
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Afficher et masquer la numérotation des mesures

Afficher automatiquement la numérotation des mesures

Par défaut, MuseScore Studio affiche les numéros de mesure au début de chaque système sauf pour la première mesure d’une section. La numérotation commence à la première mesure complète d’une section.

Si vous voulez changer la numérotation :

Depuis la barre de menu, sélectionnez Format → Style → Numéros de mesure
Éditer les propriétés suivantes comme souhaité :

Numéros de mesure : elle est cochée par défaut. Décochez la pour arrêter la numérotation automatique des mesures
Afficher sur la première : cochez la case pour afficher le numéro de mesure sur la première mesure du premier système d’une section
Toutes les portées : cochez pour afficher les numéros de mesures sur chaque portée
À chaque système / intervalle : si "À chaque système" est sélectionné, la numérotation des mesures est affichée au début de chaque système ; si "Intervalle" est sélectionné, vous pouvez choisir un intervalle de mesures auquel
vous voulez appliquer l’affichage des numéros

Réglez les changement de position en utilisant les contrôles affichés à droite : Position verticale / horizontale / au-dessus / au-dessous. Voir Ajuster la position des numéros de mesure ci-dessous
Éditez l’affichage de la numérotation des pauses multimesures (section inférieure de la fenêtre) :

Afficher la plage de numéros de mesure des pauses multimesures : si la case est cochée, vous pourrez aussi personnaliser l’apparence et la position de la numérotation ; non cochée (par défaut), seul le compte des pauses
multimesures est affiché.

Afficher manuellement la numérotation des mesures

Pour toujours afficher le numéro d’une mesure particulière, sans tenir compte des paramètres de style, ouvrir Propriétés de la mesure et sélectionnez "Toujours afficher" dans la liste déroulante Mode de numérotation de la mesure.

Masquer les numéros de mesures

Pour masquer toute la numérotation, décochez "Numéros de mesure" dans Format → Style → Numéros de mesure.

Pour masquer le numéro d’une mesure particulière, sans tenir compte des paramètres de style, ouvrez Propriétés de la mesure et sélectionnez "Toujours masquer" dans la liste déroulante Mode de numérotation de la mesure.

Modifier la séquence de numérotation des mesures

Exclure une mesure du décompte

Dans Propriétés de la mesure, cochez "Mesure non comptée" dans la section Autre.

Modifier la numérotation d’une mesure

Dans Propriétés de la mesure, éditez "Ajouter au numéro de mesure ". Des chiffres positifs comme négatifs sont acceptés.

Réinitialiser la numérotation des mesures pour une nouvelle section

Par défaut, la numérotation des mesures recommence toujours au début d’une nouvelle section. Pour prévenir ce comportement et rendre la numérotation continue, sélectionnez le saut de section et, dans le panneau Propriétés, décochez
"Réinitialiser les numéros de mesure d’une nouvelle section ".

Ajuster la position des numéros de mesure

Pour ajuster la position de tous les numéros de mesure, éditez les décalages X et Y de "Position au-dessus" et "Position au-dessous" dans Format → Style → Numéros de mesure.

Propriétés des numéros de mesure

Notez que tout changement dans la numérotation de mesure réalisé dans le panneau Propriétés peut être perdu si le modèle change.

Style de numérotation des mesures

See Templates and styles

Les valeurs du "Style de numérotation des mesures" peuvent être éditées via Format → Style → Numéros de mesure.
Les valeurs du "Style de texte au sein des numéros de mesure" peuvent être éditées via Format → Style → Styles de texte → Divisions irrégulières.

Voir aussi

Autres pages relatives aux mesures :

Pauses de mesure et pauses multimesures
Anacrouse et notation non mesurée* Propriétés de la mesure
Ajouter et supprimer des mesures
Notation pour musique ancienne et Mensurstrich

Pauses de mesures et pauses multimesures

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Pauses de mesure

Une pause de mesure ressemble à une pause mais elle est centrée dans une mesure et indique que toute la mesure (ou une voix dans la mesure) est silencieuse :

Elles est communément utilisée dans toutes les indications de mesure (excepté 4/2 et 8/4).

Pour créer une ou plusieurs pause de mesure complète

Utilisez la méthode suivante si toutes les mesures sélectionnées sont "standard" — par exemple, sans durée personnalisée :

1 Sélectionnez une mesure ou un groupe de mesures.
2. Tapez Suppr (Mac : Retour arr).

Si au moins une des mesures contient une durée personnalisée, utilisez à la place la méthode suivante :

1 Sélectionnez une mesure ou un groupe de mesures.
2. Tapez Ctrl+Maj+Suppr (Mac : Cmd+Maj+Retour arr).

Pour créer une pause de mesure complète dans une voix particulière
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Dans la voix appropriée, saisissez un silence qui s'étend sur toute la mesure
Assurez-vous que le silence est sélectionné puis tapez Ctrl+Maj+Suppr (Mac : Cmd+Maj+Retour arr).

Si la voix ne contient que des silences, vous pouvez sélectionner le premier et utiliser la commande de conversion.

Pause multimesures

Une pause multimesures est utilisée pour indiquer une série de mesures vides, le nombre de mesures étant affiché par un nombre au-dessous/au-dessous de la portée.

Activer et désactiver les pauses multimesures

Les pauses multimesures peuvent être activées/désactivées avec le raccourci clavier M pour les versions antérieures à 4.4 ; pour les versions depuis la 4.4, utiliser Ctrl+Maj+M (Mac : Cmd+Maj+M). On peut aussi cocher "Pauses multimesures"
dans Format → Style → Pauses multimesures.

Par défaut, si la case est activée, toute séquence de deux mesures vides ou plus est automatiquement convertie en pause multimesures.

Pour modifier le nombre minimal de mesures vides nécessaires pour déclencher une notation multimesures :

Ouvrez le menu Format → Style… → Pauses multimesures
Cochez "Pauses multimesures" (si ce n’est pas déjà le cas)
Éditez le "Nombre minimum de mesures vides".

Les pauses multimesures peuvent être activées/désactivées de façon indépendante dans la partition et les parties d’instruments.

Interrompre les pauses multimesures

Les pauses multimesures sont automatiquement interrompues à certains moments : une barre de mesure double, une indication de répétition, un changement d’armure ou d’indication de mesure, un saut de section, etc.

Vous pouvez également choisir d’interrompre une pause multimesures ailleurs comme suit :

Désactivez les pauses multimesures
Faites un clic droit sur la mesure où vous voulez interrompre la pause multimesures et sélectionnez Propriétés de la mesure.
Dans la fenêtre de dialogue, cliquez sur "Diviser les pauses multimesures ".
Cliquez sur OK.
Réactivez les pauses multimesures.

Propriétés des pauses multimesures

Vous pouvez éditer les propriétés de pauses multimesures sélectionnées dans la section Pause multimesures du panneau Propriétés :

Afficher le numéro : cette option est cochée par défaut ; décochez-la pour masquer le nombre
Position du numéro : ajuste la position verticale du nombre de multimesures, au-dessus ou au-dessous de la pause.

Style de pauses multimesures

Plusieurs propriétés globales des pauses multimesures peuvent être paramétrées depuis le menu Format → Style → Numéros de mesure :

D’autres depuis Format → Style → Pauses multimesures :

Voir aussi

Autres pages relatives aux mesures :

Numérotation des mesures
Anacrouse et notation non mesurée
Propriétés de la mesure
Ajouter et supprimer des mesures
Notation pour musique ancienne et Mensurstrich

Anacrouse et notation non mesurée

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Créer une anacrouse

Une anacrouse (ou levée) est une mesure partielle (incomplète) au début d’une partition ou d’une section.

Remarque : par convention, la numérotation des mesures commence à la première mesure complète.

Préciser la durée de l’anacrouse lors de la création d’une partition

Cliquez sur Mesures dans la page "Informations additionnelles sur la partition " (page 2) dans la fenêtre de dialogue Nouvelle partition
Cochez "Créer une anacrouse"
Choisissez une "indication de mesure“ à l’aide des champs numériques situés au-dessous (le premier champ indiquant le nombre de temps souhaité dans cette mesure).

Transformer une mesure en anacrouse

Faites un clic droit sur la mesure et choisissez Propriétés de la mesure;
Dans la section Durée de la mesure, à côté de "Réel", précisez le nombre de temps souhaité dans cette mesure en modifiant "l’indication de mesure" sous-jacente
Cliquez sur OK (ou cliquez sur Appliquer puis sur ← ou → si vous voulez configurer une mesure partielle adjacente).

Il est de bonne pratique musicale d'ôter la durée de l’anacrouse à la mesure finale de l’œuvre ou de la même section répétée. La même méthode s’applique pour raccourcir ces mesures.

Créer une notation non mesurée

Une notation non mesurée est une mesure dans laquelle la durée est plus longue ou plus courte que celle indiquée dans l’indication de mesure.
Une mesure de plus courte durée que celle indiquée dans l’indication de mesure peut être créée exactement de la même façon qu’une anacrouse (voir ci-dessus).

Les autres façons de créer une notation non mesurée sont décrites ci-après.

Insérer des notes et des silences
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Des notes/silences supplémentaires peuvent être insérés dans une mesure à l’aide d’un raccourci clavier ou bien d’un mode spécial de saisie appelé Mode insertion.

Utiliser un raccourci clavier

Sélectionnez l’élément (note ou silence) dans la partition devant lequel vous voulez insérer des notes/silences
Entrez en mode de saisie des notes
Sélectionnez une durée de note
Tapez Ctrl+Maj (Mac : Cmd+Maj) pendant l’ajout de la note/du silence avec le clavier ou la souris.

Utiliser le mode insertion

Vérifiez que vous avez bien sélectionné l’élément à partir duquel vous souhaitez commencer l’insertion de notes/silences
Cliquez longuement sur l’icône de saisie des notes et sélectionnez Insérer sur la fenêtre déroulante qui s’affiche
Saisissez une note ou un silence comme vous le feriez dans le mode de saisie pas-à-pas ; chaque note est insérée avant la position courante du curseur
Déplacez le curseur en avant ou en arrière si besoin (avec les touches fléchées) pour changer le point d’insertion.

Si, à un moment donné, la durée totale des notes et silences à l’intérieur de la mesure n’est pas cohérente avec l’indication de mesure, un petit signe + ou – s’affichera au-dessus de la mesure.

Joindre des mesures

Cette action fusionne les mesures sélectionnées en une seule.

Méthode A. Joindre deux mesures seulement :

Sélectionnez la barre de mesure entre les deux mesures
Tapez Ctrl+Suppr. ou sélectionnez Outils → Supprimer la plage sélectionnée.

Méthode B. Pour joindre n’importe quel nombre de mesures :

Sélectionnez le nombre de mesures à fusionner
Dans la barre de menu, sélectionnez Outils → Mesures → Joindre les mesures sélectionnées.

Remarques :
(1) Si vous sélectionnez des mesures sur une seule portée dans une partition qui en comporte plusieurs, les mêmes mesures seront jointes dans chaque portée du système.
(2) Les ligatures peuvent être automatiquement modifiées.

Scinder une mesure

Cette action insère une barre de mesure avant une note sélectionnée, divisant la mesure en deux.

Utilisez l’une des méthodes suivantes :

Sélectionnez une note puis maintenez Ctrl et cliquez sur une barre de mesure dans une palette
Maintenez Ctrl et déplacez la barre de mesure sélectionnée (depuis une palette) vers une note
Sélectionnez une note puis, dans la barre de menu, sélectionnez Outils → Mesures → Scinder la mesure avant la Note / Silence sélectionné.

Voir aussi

Travailler avec de la musique non mesurée.

Autres pages relatives aux mesures :

Numérotation des mesures
Pauses de mesures et pauses multimesures
Propriétés de la mesure
Ajouter et supprimer des mesures
Notation pour musique ancienne et Mensurstrich

Propriétés de la mesure

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Ouvrir et utiliser la fenêtre de dialogue

La fenêtre de dialogue Propriétés de la mesure vous permet de paramétrer plusieurs propriétés d’une mesure individuelle — telles que sa visibilité, sa durée, sa numérotation et sa taille ("étirement").
Pour modifier toutes les mesures d'une partition, utilisez Format → Style dans les fenêtres des catégories : Partition, Page, Numéros de mesures et Mesure. Pour modifier toutes les mesures d'une portée dans l'ensemble de la
partition, changer les propriétés de portée .

Pour ouvrir Propriétés de la mesure, faites un clic droit sur une mesure et sélectionnez "Propriétés de la mesure…".

Si vous souhaitez paramétrer une seule mesure, cliquez sur OK pour rendre vos changements permanents. Si vous vouliez aussi paramétrer les mesures adjacentes, il n'est pas besoin de fermer la fenêtre de dialogue : cliquez simplement sur
le bouton Appliquer puis utilisez les flèches situées en bas à gauche pour vous déplacer dans une nouvelle mesure. Le nouveau numéro de mesure est affiché dans la barre de titre de la fenêtre de dialogue ainsi que dans la barre de statut.

Portées

Visible : décochez/cochez la case pour masquer/afficher les mesures sélectionnées
Sans hampe : décochez/cochez la case pour masquer/afficher les hampes de notes.

Durée de la mesure

Nominale : il s’agit de l’indication de mesure paramétrée dans la partition.
Réelle : ajustez ces chiffres pour augmenter ou diminuer la durée de la mesure (voir Anacrouse et notation non mesurée).

Autre

Mesure non comptée : cochez la case pour sauter le comptage de la mesure sélectionnée.
Diviser les pauses multimesures : voir Pauses de mesures et pauses multimesures.
Mode de numérotation de la mesure : vous permet d’afficher/masquer le numéro de mesure pour la mesure sélectionnée, sans tenir compte des réglages de style.
Ajouter au numéro de mesure : modifie la numérotation dans l’ensemble de la partition à partir de cette mesure.
Étirement de la mesure : cette propriété est principalement réglée avec un raccourci clavier (voir Espacement horizontal) ; utilisez "Propriétés de la mesure" pour un réglage plus fin.
Nombre de lectures : cela n’apparaît que si la mesure précède une barre de fin de répétition ; il indique le nombre de fois où la section répétée est jouée.

Voir aussi

Largeur fixe de mesure  : une solution de rechange afin de s’assurer que les barres de mesures soient alignées verticalement entre systèmes (en anglais).
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Autres pages relatives aux mesures :

Pauses de mesures et pauses multimesures
Anacrouse et notation non mesurée
Ajouter et supprimer des mesures
Notation pour musique ancienne et Mensurstrich

Notation : Hauteur de note et tonalité

Clefs

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Aperçu

Les Clefs sont ajoutées à la partition à partir de la palette "Clefs" .

Définition de la clef initiale d'une portée

MuseScore Studio définit automatiquement la ou les clefs les plus appropriées pour l'instrument lors de la création d'une nouvelle partition. Vous pouvez facilement changer la clef à partir de la fenêtre Nouvelle partition si nécessaire.

Ajouter ou modifier une clef

 Ajouter/modifier une clef de début

Pour changer de clef au début d'un système, utilisez l'une des options suivantes :

Sélectionnez la première mesure du système et cliquez sur un symbole de clef dans la palette
Faites glisser une clef de la palette sur la première mesure du système
Sélectionnez la clef et cliquez sur une clef dans la palette
Faites glisser une nouvelle clef de la palette sur la clef.

 Ajouter/modifier une clef à l'intérieur d'une mesure

Pour ajouter/modifier une clef à l'intérieur d'une mesure avant une note, utilisez l'une des options suivantes :

Cliquez sur la note puis sur une clef dans la palette
Faites glisser une clef d'une palette sur la note.

Pour ajouter/modifier une clef à l'intérieur d'une mesure devant une barre de mesure, utilisez l'une des options suivantes :

Sélectionnez la mesure suivante et cliquez sur une clef de palette
Faites glisser une clef de palette sur la mesure suivante.

Remarques :
(1) Les clefs "à mi-portée" sont toujours plus petites que la clef principale du système.
(2) Les notes après un changement de clef sont automatiquement repositionnées afin qu'elles continuent à sonner à la hauteur d'origine.

Supprimer

Pour supprimer une clef, il suffit de la sélectionner et d'appuyer sur Suppr. Notez que les clefs au début des systèmes ne peuvent pas être supprimées.

Contrôler la visibilité des clefs

Clefs standard

Pour masquer/afficher les clefs au début de tous les systèmes sauf le premier :

Dans la barre de menus, sélectionnez Format → Style → Page
Décochez/cochez Créer une clef pour tous les systèmes.

Les clefs à l'intérieur d'une mesure ne sont pas affectées.

Pour masquer/afficher toutes les clefs d'une portée sélectionnée :

Faites un clic droit sur une mesure
Choisissez "Propriétés de la Portée / Partie "
Dans la fenêtre de dialogue, décochez Afficher la clef.

Cela affecte les clefs au début d'un système et à l'intérieur d'une mesure.

Clefs de précaution

Pour masquer/afficher toutes les clefs de précaution :

Dans la barre de menus, sélectionnez Format → Style → Page
Décochez/cochez la case Créer les clefs de précaution.

Si le rappel des clefs de précaution est activé, vous pouvez quand même masquer une clef de précaution individuelle comme suit :

Sélectionnez la clef standard appropriée
Dans le Panneau des propriétés, décochez/cochez Afficher la clef de précaution sur le système précédent.

Clefs et transposition

Utilisation des clefs d'octave

[Doit être ajouté]

Utilisation de différentes clefs pour la transposition et la hauteur de concert

[Doit être ajouté]

Propriétés des clefs

Voir Clefs de précaution (ci-dessus).

Style des clefs

Les utilisateurs de tablatures peuvent sélectionner le type de clef de tablature affichée :

Dans le menu, sélectionnez Format → Style → Clefs
Définissez la clef de tabulation par défaut sur "Standard" ou "Serif" selon les besoins.

D'autres propriétés de style sont disponibles dans Format → Style → Page, à savoir :

Créer une clef pour tous les systèmes
Créer les clefs de précaution.

Pour plus de détails, voir Contrôle de la visibilité des clefs (ci-dessus).

Armures

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Aperçu

Les Armures sont ajoutées à la partition à partir de la palette "Armures".
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Définir l'armure initiale de la partition

L'armure initiale est définie à partir de la page 2 de Nouvelle partition qui spécifie les Informations complémentaires de la partition.

Ajouter un changement d'armure à la partition

Utilisez l'une des méthodes suivantes :

Sélectionnez une mesure et cliquez sur une armure de la palette
Faites glisser une armure de la palette sur une partie vide d'une mesure.

Remarque : il est également possible, bien que peu courant, d'ajouter une armure au milieu d'une mesure en sélectionnant une note puis en cliquant sur une armure de la palette, ou en faisant glisser l'armure sur une note.

Ajouter une armure locale à une seule portée

Si vous souhaitez ajouter une armure à une seule portée, en laissant les autres inchangées, appliquez l'une des méthodes suivantes :

Sélectionnez la mesure à partir de laquelle vous souhaitez appliquer la nouvelle armure, puis maintenez la touche Ctrl (Mac : Cmd) en cliquant sur une armure de la palette
Maintenez la touche Ctrl (Mac : Cmd) en faisant glisser une armure de la palette vers une mesure.

Sélectionner une armure pour une seule portée

Si vous souhaitez sélectionner une armure pour une seule portée, maintenez la touche Ctrl (Mac : Cmd) en cliquant sur l'armure.

Remplacer une armure existante

Utilisez l'une des méthodes suivantes :

Sélectionnez l'armure à remplacer et cliquez sur une nouvelle armure de la palette
Faites glisser une armure de la palette sur l'armure à remplacer (ou sur la mesure contenant l'armure).

Pour remplacer l'armure sur une seule portée, maintenez Ctrl (Mac : Cmd) en réalisant les opérations ci-dessus.

Supprimer une armure

Pour supprimer une armure dans la partition, sélectionnez-la et appuyez sur Suppr.
Pour supprimer une armure d'une seule portée uniquement, maintenez Ctrl (Mac : Cmd) tout en la sélectionnant puis appuyez sur Suppr.

Contrôler la visibilité des armures

Pour afficher les armures uniquement au début d'une partition et lors d'un changement de clef :

Dans la barre de menu, sélectionnez Format → Style → Page
Décochez/cochez Créer une armure pour tous les systèmes.

Pour masquer/afficher toutes les armures de précaution (rappel en fin de système) :

Dans la barre de menus, sélectionnez Format → Style → Page
Décochez/cochez Créer les armures de précaution.

Pour masquer/afficher une armure de précaution particulière :

Sélectionnez l'armure "parente" ;
Dans le panneau Propriétés, décochez/cochez Afficher l'armure de précaution sur le système précédent.

Armures et instruments transpositeurs

Des précautions doivent être prises lorsque vous travaillez dans la tonalité écrite et que vous sélectionnez une armure directement à un instrument transpositeur. Par exemple, une clarinette Sib est écrite un ton plus haut que le son qu'elle
produit ; donc, pour que la clarinette s'affiche en Sol majeur, vous devez appliquer une armure de Fa majeur à partir de la palette. Et ainsi de suite.

Armure ouverte/atonale

Certains instruments (par exemple le cor d'harmonie) sont écrits de manière conventionnelle sans armure. Pour ce faire, vous devez ajouter une armure locale ouverte/atonale à la portée (ceci est déjà fait dans les partitions créées à partir de
modèles).

Une armure ouverte/atonale ressemble à une armure « Do majeur/La mineur ». Cependant, contrairement aux armures standard, une armure ouverte reste toujours la même, quels que soient les changements de clef apportés au reste de la
partition.

Créer une armure personnalisée

Pour créer une armure personnalisée :

Dans la palette "Armures", cliquez sur Plus puis sur Créer une armure

Faites glisser les altérations sur l'image de la portée selon vos besoins. Remarque : les altérations sont alignées horizontalement par défaut. Si vous voulez une altération dans une position personnalisée, maintenez Ctrl (Mac : Cmd) tout
en la faisant glisser.
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Pour supprimer une altération, sélectionnez-la et appuyez sur Suppr. Remarque : le bouton Effacer supprime toutes les altérations ajoutées.

Pour ajouter l'armure terminée à la palette principale, cliquez sur Ajouter.

Remarque : les armures personnalisées sont adaptées automatiquement aux instruments transpositeurs. Si vous voulez que l'instrument transpositeur utilise l'armure personnalisée exactement de la même manière que dans la palette, vous
devez la transposer à nouveau. Sélectionnez la mesure où l'armure est placée et utilisez Outils → Transposer.

Propriétés des armures

Vous pouvez modifier les propriétés spécifiques aux armures dans la section Armure du panneau Propriétés :

Afficher l'armure de précaution sur le système précédent : Voir Contrôler la visibilité des armures (ci-dessus).
Mode : vous pouvez sélectionner un mode pour l'armure si nécessaire : majeur, mineur, dorien, etc. La valeur par défaut est « inconnu ».

Style des armures

Diverses propriétés de style affectent l'affichage de l'armure :

Menu Format → Style → Page

Créer une armure pour tous les systèmes
Créer des armures de précaution

L'utilisation de ces propriétés est traitée dans Contrôler la visibilité des armures (ci-dessus).

Menu Format → Style → Altérations

Ici, vous pouvez modifier la façon dont les altérations sont affichées lors des changements d'armure dans la partition.

Menu Format → Style → Mesure

Entre la Clef et l'Armure
Entre l'Armure et l'Indication de mesure
Entre la Barre de mesure et l'Armure
Entre l'Armure et la Barre de mesure
Entre la Clef/Armure et la Première note

Ces propriétés contrôlent les différents espacements avant et après les armures dans la partition.

Voir également

Transposition

Transposition

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Aperçu

La transposition consiste à élever ou abaisser d'un même intervalle la hauteur d'une sélection de notes.

Dans MuseScore Studio, vous pouvez transposer votre musique à l'aide de raccourcis clavier ou via la fenêtre de dialogue Transposer.

Transposer avec des raccourcis clavier

Pour transposer avec des raccourcis clavier, sélectionnez d'abord une plage de notes (voir Sélectionner des éléments). Utilisez ensuite l'une des options suivantes, selon la façon dont vous devez transposer votre musique :

Transposer chromatiquement

Tapez sur ↑ ou ↓ pour déplacer les notes de la sélection vers le haut/bas, par demi-tons.

Transposer diatoniquement

Tapez sur Alt+Maj+↑/↓ pour déplacer les notes de la sélection vers le haut /vers le bas, en degrés (Mac : ⌥+Shift+↑/↓).

Transposer d'une octave

Tapez sur Ctrl+↑/↓ pour déplacer les notes de la sélection vers le haut/bas par pas d'une octave (Mac : < kbd>⌘+↑/↓).

Utiliser la fenêtre de dialogue de transposition

La fenêtre de dialogue Transposer vous donne davantage de contrôle sur la transposition, avec des options de transposition sur les touches sélectionnées ou par intervalles spécifiques.
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Sélectionnez d'abord une plage de notes que vous souhaitez transposer. (Voir Sélectionner des éléments). Si aucune sélection n'est faite, la partition entière est automatiquement sélectionnée pour la transposition.

Ouvrez ensuite la fenêtre de dialogue en sélectionnant Outils → Transposer...

Transposition chromatique

Lorsque cette option est sélectionnée, vous pouvez choisir de transposer dans une tonalité spécifique ou par intervalle spécifié.

Pour transposer chromatiquement dans une tonalité spécifique

Sélectionnez Par tonalité
Sélectionnez s'il faut transposer dans la tonalité de destination Au plus près (par rapport à la tonalité actuelle de la sélection) ou vers le Haut ou le Bas
Choisissez la tonalité de destination dans le menu déroulant
Laissez Transposer les armures sélectionné pour transposer toutes les armures existantes dans votre sélection (la désélection de cette option laissera toutes les armures existantes inchangées)
Laissez Transposer les symboles d'accord sélectionné pour transposer tous les symboles d'accord existants dans votre sélection (si vous désélectionnez cette option, tous les symboles d'accord existants resteront inchangés)
Cliquez sur OK

Pour transposer chromatiquement par intervalle

Pour transposer les notes sélectionnées vers le haut ou vers le bas par incréments d'un demi-ton :

Sélectionnez Par intervalle
Choisissez de transposer votre sélection vers le Haut ou le Bas de l'intervalle spécifié
Sélectionnez l'intervalle de transposition dans le menu déroulant
Sélectionnez les options pour Transposer les armures et Transposer les symboles d'accord selon les besoins (voir ci-dessus)
Cliquez sur OK

Transposition diatonique

Sélectionnez cette option pour transposer la sélection d'un intervalle spécifié sans modifier la ou les armures existantes. Remarque : les relations d'intervalle entre les hauteurs de votre sélection changeront en conséquence !

Sélectionnez Transposition diatonique
Choisissez de transposer votre sélection vers le Haut ou le Bas de l'intervalle spécifié
Laissez Maintenir les altérations de degré sélectionné pour conserver toutes les altérations dans la sélection (Remarque : (1) les altérations seront modifiées par rapport à la tonalité existante; (2) la désélection de cette option
supprimera toute altération existante lors de la transposition)
Laissez Transposer les symboles d'accord sélectionné pour transposer tous les symboles d'accord existants dans votre sélection (voir ci-dessus)
Cliquez sur OK

Travailler avec des instruments transpositeurs

Tonalité écrite et tonalité réelle

Les instruments transpositeurs (tels que la clarinette, le cor d'harmonie, la trompette, etc.) sont notés à une hauteur (et une tonalité) différente de celle qu'ils jouent effectivement. La hauteur notée est appelée Tonalité écrite, tandis que la
hauteur jouée est appelée Tonalité réelle (parfois appelée de concert).

Par défaut, la partition est affichée avec toutes les portées à la hauteur écrite. Toutefois, si vous souhaitez afficher la partition à hauteur réelle, il vous suffit d'aller dans la barre d'état (située en bas à droite de la fenêtre principale de
MuseScore Studio) et de cocher la case "Tonalité de concert" associée à une icône de diapason.

Réglage de l'intervalle de transposition

Lorsque vous configurez une partition dans les fenêtres de dialogue Nouvelle partition ou Ajouter et ranger les instruments, les armures transposées sont automatiquement appliquées à tous les instruments transpositeurs. Cependant, si pour
une raison quelconque vous avez besoin de configurer manuellement la transposition de la portée, voici comment procéder :

Faites un clic droit sur la portée de l'instrument et sélectionnez Propriétés de la Portée/Partie...
À côté de "Transposition" dans la partie inférieure de la fenêtre de dialogue, sélectionnez l'intervalle dans lequel l'instrument joue au-dessus/en dessous de la hauteur réelle (la musique pour la clarinette Sib, par exemple, est écrite un
ton au-dessus de sa hauteur sonore et le réglage de transposition est donc une seconde majeure vers le Bas)

Cliquez sur OK.

La bonne armure transposée apparaîtra maintenant sur la portée.

Contrôle de l'enharmonie

L'enharmonie de la tonalité écrite, qu'elle soit en dièses ou en bémols, est définie dans les propriétés Portée/Partie (voir Réglage de l'intervalle de transposition au-dessus).

Pour changer l'enharmonie des notes dans la partition, voir Recalculer les altérations.

Lignes d'octave

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Vue d'ensemble

Les lignes d'octave sont utilisées pour indiquer qu'une section de musique doit être jouée une ou plusieurs octaves au-dessus ou en dessous de la tonalité écrite. Les lignes 8va (Ottava alta) et 8vb (Ottava bassa) sont particulièrement
courantes dans les partitions pour piano, bien qu'elles soient parfois utilisées dans d'autres musiques instrumentales. Les lignes 15ma (Quindicesima alta, 2 octaves au-dessus) et 15mb (Quindicesima bassa, 2 octaves en dessous) sont
également parfois utilisées. MuseScore Studio crée une lecture pour les lignes d'octaves. La ligne peut être dessinée pleine ou en pointillés.

8--------┐ou 8va--------┐ : Jouer une octave au-dessus de la tonalité écrite
8--------┘ou 8vb--------┘ : Jouer une octave en dessous de la tonalité écrite

Ajouter une ligne d'octave à la partition
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Les lignes d'octave peuvent être trouvées dans les Palettes Lignes et Hauteur. Pour en ajouter une sur une ou plusieurs note(s) ou mesure(s) et ajuster sa plage chronologique, voir les chapitres Utiliser les palettes et Autres lignes :
Ajouter une ligne. Pour ajuster précisément la position de la ligne, voir Ajuster directement les éléments.

Propriétés des lignes d'octave

Les propriétés spécifiques aux lignes d'octaves sélectionnées peuvent être paramétrées dans la section Octave du panneau Propriétés, à savoir :

Onglet Style

Type : spécifie si la ligne d'octave est 8va, 8vb etc.
Afficher seulement les numéros : masque tout texte (tel que "va")
Afficher la ligne : rend la ligne visible/invisible ; le texte n'est pas affecté
Autoriser la diagonale : autoriser la pente de la ligne si nécessaire.

Pour les autres propriétés de cet onglet, voir Propriétés des lignes.

Onglet Texte

Cet onglet a une interface utilisateur similaire aux lignes générales (voir Propriétés des lignes) mais il utilise un code spécial pour spécifier le texte d'octave.

Style des lignes d'octave

Voir la page Modèles et styles

Les valeurs de la "Police de symboles musicaux" peuvent être éditées dans Format → Style → Partition. Les caractères va et vb sont des symboles qui peuvent être ajoutés via la fenêtre des caractères spéciaux (Affichage →
Palette principale).
Les valeurs du "Style pour lignes d'octave" peuvent être éditées dans Format → Style → Octaves.

Les valeurs du "Style pour le texte interne aux lignes d'octave" peuvent être éditées dans Format → Style → Style de texte → Octave.

Têtes de note

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Vue d'ensemble

Ce chapitre évoque l'apparence des têtes de notes dans MuseScore Studio.

Modèles de têtes de notes

Le modèle d'écriture des notes est un aspect du système de notation musicale. Un modèle est un ensemble de règles utilisées pour décider la signification de la forme des notes, dont certaines sont supportées par MuseScore Studio. Les
modèles supportés déterminent la signification des notes en termes de :

durée : comme dans les règles les plus communément utilisées
hauteur (utilisant un do absolu ou relatif) : symboliquement écrite sur la note, ou
hauteur relative (utilisant des formes de note) : comme dans la "notation par forme de note" (voir les références sous Liens externes).

Le modèle le plus largement utilisé est celui que connaissent la grande majorité des musiciens. Il est référencé comme "Normal" dans MuseScore Studio et utilisé par défaut pour créer une nouvelle portée. Les détails des neufs modèles
disponibles dans MuseScore Studio sont décrits dans Types de portées personnalisées : Systèmes et types de notes.

La connaissance des notations de hauteurs relatives (formes de têtes de notes) peut faciliter la compréhension de ce chapitre par le lecteur. La plupart du temps, une forme de tête de note est associée à une signification particulière et cette
signification n'est associée qu'à une seule forme de tête de note. La notation par forme de note est une variation de celle avec do mobile qui appartient aux exceptions. Par exemple, dans un type de "notation par forme de note", un triangle
peut être utilisé pour écrire une hauteur relative de "Do 4" mais les triangles peuvent aussi être lus uniquement comme des "Do" relatifs ou des "Fa" et les triangles peuvent être chantés "Fa" ou par une autre syllabe communément utilisée
par les chanteurs locaux. La perception des intervalles grâce à la notation basée sur les formes de note peut être meilleure que celle du type "Normal".

Formes de têtes de notes

Affichées ci-dessus : les têtes de note en diamant peuvent être utilisées pour les notes harmoniques de guitare, violon, etc. ; les notes slash pour les accords de guitare, etc. : la note en croix est aussi appelée note fantôme (ghost note) ou
note morte (dead note).

Le résultat final de l'affichage de la forme des notes dans MuseScore Studio est déterminé par trois facteurs : le facteur de type de tête de note, le facteur de hauteur et le facteur de durée (ou valeur de note, rythme).

Facteur de hauteur

La hauteur de note peut affecter la forme de tête de note selon le modèle utilisé. Mais cela n'arrive que si la note n'utilise pas une propriété Forme de tête de note qui l'écrase ; voir la section "Facteur de type de tête de note". Le modèle
"Normal" n'utilise pas la hauteur pour déterminer la forme des têtes de notes.

Facteur de durée

Le facteur de durée est déterminé par la durée de la note. Pour éditer la durée, voir les chapitres Saisir des notes et des silences et Éditer des notes et des silences. Il peut aussi être visuellement remplacé pour une note individuelle, sans en
modifier la valeur et la lecture.

Facteur de type de tête de note

Les options disponibles pour le facteur de type de tête de note dépend du Type de portée.

Sur les portées standard (type 1a, type 1b), il existe trois niveaux :
Niveau 1 Modèle de têtes de notes de portée : le modèle par défaut est "Normal"
Niveau 2 Groupe de têtes de notes de(s) note(s) (option avec menu déroulant à partir de MuseScore Studio 4.1.1) :

l'option par défaut "Automatique" signifie "ignore ce niveau"
les autres options de type à utiliser pour cette note remplacent le régale de Niveau 1.
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Niveau 3 Forme de tête de note correspondant à la propriété d'une note. Il affecte la forme de la tête de note __si et seulement si __ le résultat des niveaux 1 et 2 est "Normal".
Les portées Tablatures (type 2) n'utilisent pas de têtes de notes.
Sur les portées de percussions (type 3), l'instrument (comme la caisse claire ou le charleston, pas le "Set de batterie" de Musescore) détermine le facteur de modèle de têtes de notes. Il n'y a qu'un seul réglage qui affecte l'ensemble
des notes d'une portée : voir Saisir et éditer la notation des percussions : Formes de têtes de notes .

Le Modèle de têtes de notes est utilisé pour déterminer la forme des têtes de notes, sauf remplacement par la propriété Groupe de tête de note d'une note individuelle. Quand le modèle n'est pas remplacé, la hauteur de note peut affecter
la forme de la tête de note en fonction du modèle. Le modèle "Normal" n'utilise pas la hauteur pour déterminer la forme des têtes de notes. Si une note utilise une propriété de groupe de tête de note, les informations de hauteur n'affectent
aucunement la forme de la note.

Modifier la forme des têtes de note

Facteur de type de note

(Valide sur les portées standard uniquement) Pour modifier le niveau 1 Modèle de têtes de notes d'une portée unique, affectant l'ensemble des notes :
Faites un clic droit sur une partie vide de la portée concernée et sélectionnez Propriétés de Portée / Partie
Cliquez sur le bouton Propriétés avancées de style (qui ouvre la fenêtre Éditer le type de portée)
Sélectionnez une option dans le menu déroulant Modèle de têtes de notes.

(Valide sur les portées standard uniquement) Pour modifier le niveau 2 Groupe de têtes de notes de(s) note(s) :
Sélectionnez une ou plusieurs notes dans la partition
Dans le panneau Propriétés , ouvrez Note : onglet Tête
Sélectionnez une option dans le menu déroulant Groupe de têtes de notes (il peut être nécessaire de cliquer sur "Afficher plus" en bas du panneau pour l'afficher) : le paramètre "Automatique" signifie "ignore ce niveau".

(Valide sur les portées standard uniquement) Pour modifier la propriété de niveau 3 Forme de tête de note :
Sélectionnez une ou plusieurs notes dans la partition
Utilisez une des options suivantes :

Dans le panneau Propriétés, ouvrez Note : onglet Tête et sélectionnez une forme de tête de note, ou
Cliquez sur un item de la palette Têtes de notes ou faites-le glisser sur une note de la partition.

Pour modifier le(s) numéro(s) de frette(s) sélectionnés dans les têtes en forme de croix, cliquez sur l'icône Croix dans la palette Têtes de notes. Pour insérer le numéro de frettes(s) dans des crochets (parenthèses, note morte ou note
fantôme), utilisez Maj+X.
Pour modifier les têtes de note sur les portées de percussions, voir le chapitre Personnaliser le set de batterie : Forme des têtes de notes.

Facteur de durée

Pour modifier la durée d'une note, voir les chapitres Saisir des notes et des silences et Éditer des notes et des silences.
Pour modifier la durée apparente sans altérer la valeur réelle de façon à ce que la lecture ne soit pas affectée :

Sélectionner une ou plusieurs notes dans la partition
Dans le panneau Propriétés, ouvrez Note : onglet Tête
Sélectionnez l'option souhaitée dans Remplacer la durée affichée (il peut être nécessaire de cliquer sur "Afficher plus" en bas du panneau pour l'afficher) : le paramètre par défaut "Automatique" signifie "ne pas remplacer".

Ajouter des informations de hauteur aux notes

Pour éditer la vélocité de lecture d'une note :

affiché ci-dessus une des formes de notation par forme appelée les "7 formes" (Aikin)

Il existe six méthodes pour modifier la hauteur des notes.

La plupart du temps, la hauteur de note n'affecte que sa position verticale dans la portée. Pour la modifier :

Changez la hauteur de la note (voir Saisir des notes et des silences et Éditer des notes et des silences)
Modifiez la lecture de la hauteur de note dans la partition sans altérer sa notation : dans le panneau Propriétés, cliquez sur Général : Lecture , éditez Réglages d'accord (cents). Ceci est pratique pour les raisons expliquées dans le
manuel de Musescore 3 au chapitre Tuning systems, microtonal notation system, and playback  [en anglais]. Cela ne fonctionne pas (encore) sur les instruments utilisant MuseSounds sur MuseScore Studio 4.1.1.

Tablatures, Notation pour percussion  et
plusieurs modèles de têtes de notes (voir la Vue d'ensemble) utilisent la forme de tête de note pour traduire l'information sur sa hauteur :

[non encore opérationnel, attendu pour la version 4.3 https://github.com/musescore/MuseScore/issues/16500  ] Les items crochets (parenthèses, note morte ou note fantôme) de la palette Têtes de notes peuvent être ajoutés à une
note ou une altération.
Pour utiliser une forme personnalisée de tête de note en représentation visuelle de hauteur :

Modifiez le paramétrage de niveau 1 comme requis pour la portée
Utilisez un réglage de remplacement de niveau 2 sur les notes sélectionnées :

Sélectionnez les notes dans la partition
Dans le panneau Propriétés, ouvrez Note : onglet Tête
Sélectionnez "Normal" dans le menu déroulant Groupe de têtes de notes (il peut être nécessaire de cliquer sur "Afficher plus" en bas du panneau pour l'afficher).

Assignez la propriété de niveau 3 Forme de tête de note avec l'une des méthodes suivantes :
Dans le panneau Propriétés, ouvrez Note : onglet Tête et sélectionnez une Forme de tête de note, ou
Cliquez sur un symbole dans la palette Têtes de notes ou faites-le glisser jusqu'à une note de la partition.

Ces note(s) utiliseront toujours ce symbole sans tenir compte des éventuels changements futurs de l'échantillon de hauteur par l'utilisateur, à la différence des autres notes de cette portée.
Modifiez la facteur de durée comme souhaité.

Pour minimiser la relation entre la position verticale de la note et sa hauteur, de façon à ce que toutes les notes d'une portée crée la lecture souhaitée, profitez de la fonctionnalité 'Transposition des instruments'.

Modifier la direction d'une tête de note

Pour déplacer une ou plusieurs têtes de notes sur le plan horizontal de l'autre côté de la hampe, utilisez une des méthodes suivantes :

Tapez Maj+X, ou
Dans le panneau Propriétés, ouvrez Note : onglet Tête et sélectionnez Direction de note (il peut être nécessaire de cliquer sur "Afficher plus" en bas du panneau pour l'afficher).

(Remarque : comparez cette commande avec X qui déplace la hampe et la ligature horizontalement et verticalement de l'autre côté de la tête de note).

Propriétés des têtes de note

Après avoir sélectionné une ou plusieurs notes dans le panneau Propriétés Note : onglet Tête de note, les propriétés suivantes peuvent être modifiées :

Parenthèses de tête de note : ajoute ou supprime des parenthèses
Forme de tête de note : voir la vue d'ensemble et Modifier la forme de la tête de note
Masquer la tête de note : rend la tête de note invisible (voir aussi la propriété Visible)
Petite tête de note : diminue la dimension de la tête de note
Position du point : il permet un décalage alternatif du point de durée
Bouton Afficher plus/Afficher moins
Groupe de têtes de note : niveau 2 du modèle de têtes de notes, voir la vue d'ensemble. Le réglage par défaut "Automatique" signifie "ignore ce niveau"
Remplacer la durée affichée : modifie le facteur de durée voir la vue d'ensemble. Le réglage par défaut "Automatique" signifie "ignore ce niveau"
Direction de note : voir Modifier la direction de la tête de note (ci-dessus)
Décalage de tête de note : modifie uniquement le décalage de la tête de note (pour modifier le décalage de la note complète, utilisez à la place "Décalage" dans Propriétés : Apparence).

Style et police de tête de note

Il existe 8 options de polices (deux nouvelles options par rapport à Musescore 3) pour les têtes de notes. Elles sont paramétrées dans Format → Style → Partition. Les têtes de notes n'utilisent pas de profil de style (Modèles et styles).
La palette Têtes de notes est affichée avec la police Bravura.

Partager des têtes de note entre les voix

Quand deux notes de voix différentes coïncident dans le même battement, elles peuvent soit partager une tête de note unique, soit être décalées pour afficher les deux têtes de notes. Cela est réalisé automatiquement par MuseScore Studio
en application de certaines règles (voir ci-dessous).

Pour forcer deux têtes de note décalées dans des voix différentes à partager une seule tête de note, utilisez l'une des méthodes suivantes :

Rendez invisible la tête de note de plus petite valeur ; cela fonctionne dans la majorité des cas.
Sélectionnez la tête de note de plus petite valeur et, dans la section Note du panneau Propriétés, changez "Tête de note (visuel uniquement)" à la valeur de la note de valeur supérieure.

Règles pour partager automatiquement ou décaler les têtes de note :

Les notes avec des hampes dans la même direction ne partagent pas les têtes de note.
Les notes pointées ne partagent pas les têtes de notes avec les notes non pointées.
Les notes noires ne partagent pas les têtes de notes avec les notes blanches.
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Les notes entières ne partagent jamais les têtes de notes.

Supprimer les numéros de frette en double dans la tablature

Si vous utilisez des portées standard et tablature jumelées, vous rencontrerez des situations où une tête de note partagée dans la portée standard génère deux numéros de frette dans la tablature. Dans ce cas, masquez simplement l'un
des numéros de frette en le rendant invisible.

Voir aussi

Saisie et modification de la notation des percussions

Liens externes

[En anglais]
- The Music Notation Project Wiki > Shape Note Notation
- IMSLP.org Wiki > 4-shape notation
- IMSLP.org Wiki > 7-shape notation

Ambitus

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

L'ambitus représente l'étendue des notes incluses dans une portée. Il est utilisé pour indiquer la voix appropriée pour une partie donnée. Voir Wikipedia : Ambitus .

Ajouter un ambitus à votre partition

Pour créer un ambitus, choisissez l'une des méthodes suivantes :

Sélectionnez la clef de départ souhaitée et cliquez sur le symbole ambitus qui est accessible dans les palettes Hauteur et Lignes.
Faites glisser le symbole ambitus depuis l'une de ces palettes et déposez-le sur la clef de départ.

Modifier l'étendue d'un ambitus

Les notes hautes et basses de l'ambitus peuvent être ajustées manuellement via Propriétés.

Propriétés de l'ambitus

On peut modifier manuellement quatre propriétés de l'ambitus :
1. Direction : verticale ou diagonale
2. Type de tête de note
3. Durée des têtes de note
4. Épaisseur de la ligne joignant les têtes de notes

Échanger les notes enharmoniques / Recalculer les altérations

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Note de traduction : Jusqu’à MuseScore 4.1.1, cette fonction était traduite en Recalculer les altérations , Depuis la version 4.2 elle est traduite en Échanger les notes enharmoniques pour plus de clarté.

Modifier manuellement l'écriture enharmonique de certaines notes

Pour changer une ou plusieurs notes en leur équivalent enharmonique à la fois dans la Tonalité écrite et dans la Tonalité réelle :

Sélectionnez une note ou un groupe de notes 
Appuyez sur J
Continuez à appuyer sur J pour faire défiler en boucle les équivalents enharmoniques et arrêtez le défilement quand l'écriture de la note correspond à votre attente

Reprenez si besoin l'étape 1 pour une autre note ou un autre groupe de notes.

Pour modifier l'enharmonie dans la Tonalité écrite, sans affecter la Tonalité réelle, ou vice versa :

Sélectionnez une note ou un groupe de notes 
Appuyez sur Ctrl+J (Mac : Cmd+J)
Continuez à appuyer sur la même combinaison de touches pour faire défiler en boucle les équivalents enharmoniques

Reprenez si besoin l'étape 1 pour une autre note ou un autre groupe de notes.

Remarque : Si les hauteurs des notes sélectionnées ne sont pas toutes identiques, l'effet peut être imprévisible.

Modifier automatiquement toutes les notes d'une sélection

Échanger les notes enharmoniques

Dans le menu, sélectionnez Outils → Échanger les notes enharmoniques.

Notation : Symboles d’expression

Articulations

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Aperçu

Ce chapitre aborde les symboles d'articulations disponibles dans la palette Articulations (indicateurs d'accents, staccato, vibrato, etc.).

Pour ajouter des objets verbaux d'articulations disponibles dans la palette Texte (legato, pizz. , arco, tremolo etc.) dans une partition, voir le chapitre Texte de portée, Texte de système et Texte d'expression. Les articulations pour guitare
sont traitées dans les chapitres de la partie Notation spécialisée : Guitare. Les articulations des instruments à vent (Fall, Doit, Plop, Scoop) sont traitées dans Arpèges et glissandos.

Ajouter des articulations dans votre partition

Raccourcis clavier

Pour ajouter une articulation à l’aide d’un raccourci clavier :

Sélectionnez une ou plusieurs notes
Utilisez le raccourci clavier approprié de la liste ci-dessous :

Accent: Maj+V
Marcato: Maj+O
Staccato: Maj+S
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Tenuto: Maj+N

Barre d’outils

Certaines articulations (accent, marcato, staccato et tenuto) peuvent être ajoutées depuis la barre d’outils de saisie des notes (au-dessus de la fenêtre de la partition).

Sélectionnez une ou plusieurs notes
Cliquez sur le symbole désiré dans la zone articulations de la barre d’outils.

Palette Articulations

Pour ajouter une articulation :

Sélectionnez une ou plusieurs notes
Cliquez sur le symbole désiré dans la palette Articulations.

De façon alternative, cliquez et déplacez le symbole de la palette vers une tête de note.

Lecture des articulations

Certaines articulations affectent la lecture de la note — comme staccato, tenuto (louré), et accent. Cela est géré automatiquement par le programme.

Propriétés des articulations

Les propriétés éditables des articulations sélectionnée dans la partition sont affichées dans le panneau Propriétés.

Position : ce paramètre modifie le placement du symbole : Automatique / Au-dessus de la portée / En dessous de la portée / Au-dessus de la note/accord / Au-dessous de la note/accord.

Style des articulations

Voir le chapitre principal Modèles et styles

Les valeurs du "Style pour Articulations & Ornements" peuvent être éditées dans Format → Style → Articulations, Ornements.

Les résultats sur la partition de plusieurs options sont affichés ci-dessous.

Options d'alignement

Aligner avec la hampe

Aligner avec la tête de note

Centrer entre la hampe et la tête de note

Options d'articulations combinées

Toujours garder ensemble

Préférer la proximité par rapport à la tête de note (les articulations combinées pourraient devenir séparées)

Nuances

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Ajouter des nuances à une partition
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Tous les objets Indicateurs de nuance sont dans la palette Nuances . Pour ajouter un indicateur de nuance à la partition :

Sélectionnez une ou plusieurs notes et cliquez sur un indicateur de nuance dans la palette OU
Déplacez un indicateur de nuance de la palette vers une note.

Propriétés des indicateurs de nuance

Les indicateurs de nuance sélectionnés peuvent être édités dans le panneau Propriétés. Les options suivantes sont disponibles :

Échelle : taille des symboles de nuance.
Éviter les barres de mesure : choisir si les indicateurs de nuance doivent éviter la collision avec les barres de mesure (par défaut) ou non
Affectation des voix : choisir à quelle(s) voix assigner l'indicateur de nuance sélectionné. Cela affecte à la fois la position du symbole de nuance et sa lecture.
Position : choisir si les nuances doivent être positionnées au-dessus ou au-dessous de la portée
Centrer entre les portées : sur les instruments de plus d'une portée, choisir si le symbole doit être centré verticalement entre les deux portées. Cela peut être combiné avec Position.
Alignement avec la tête de note (sous Afficher plus) : pour les indicateurs de nuances avec des caractères texte d'expression ajoutés, il permet de justifier les éléments combinés à la droite de la note ou de les centrer par rapport à la
note.
Cadre (sous Afficher plus) : ajouter un cadre carré ou circulaire à l'indicateur de nuance et personnaliser son style.

Pour éditer le paramétrage sur l'ensemble de la partition, voir la section Style des indicateurs de nuance.

Lecture des nuances

À partir de MuseScore Studio 4.4, les indicateurs de nuance (y compris les marques de crescendo et diminuendo) peuvent indépendamment être affectés à des voix ou des portées individuelles. Une nuance s'applique à la voix à laquelle elle
a été assignée depuis le point où elle apparaît jusqu'à ce qu'une autre nuance vienne affecter la même voix ou l'ensemble des voix.

Voir la section compatibilité de lecture des nuances pour apprendre comment agit cette fonctionnalité avec les différentes technologies de sons.

Affectation des voix aux nuances

Regardez notre vidéo sur les nuances et les voix  [en anglais]

Dans MuseScore Studio 4.4, les indicateurs de nuance et marques de crescendo et diminuendo peuvent être assignés à Toutes les voix ou à une voix spécifique de 1 à 4 en utilisant la propriété Affectation des voix. Par défaut, les nuances
sont affectées à l'ensemble des voix de l'instrument.

Pour les instruments à portées multiples, sélectionner Tout affiche deux options distinctes :

Toutes les voix de l'instrument (affecter toutes les portées) et
Toutes les voix de cette portée seulement (affecter toutes les voix de la seule portée à laquelle la nuance est attachée).

Pour affecter directement une nuance que vous ajoutez à une voix spécifique :

Sélectionner une note ou un silence dans la partition
Cliquer sur un symbole de nuance dans la palette tout en maintenant la touche Ctrl (Ma c: Cmd)
La nuance sera affectée à la voix de la note ou du silence sélectionné.

Pour modifier l'affectation de voix d'un indicateur de nuance existant, sélectionnez-le puis, au choix :

cliquer sur l'un des boutons dans Propriétés → Affectation des voix OU
cliquez sur l'un des boutons de voix dans la barre d'outils de saisie de notes OU
utilisez un raccourci clavier

Pour la voix 1 à 4 :
Ctrl+Alt+1–4 (Mac : Cmd+Opt+1–4)
Pour Tout (ou Toutes les voix de l'instrument*) :
Ctrl+Alt+0 (Mac : Cmd+Opt+0)
Pour Toutes les voix de cette portée seulement*:
Ctrl+Alt+- (Mac : Cmd+Opt+-)

*Pour les instrument à portées multiples

Déterminez si les indicateurs de nuance sont affectés à toutes les voix ou à des voix individuelle par défaut dans Édition → Préférences → Saisie des notes → Affectation des voix.

Positionner les indicateurs de nuance

Il existe 3 options disponibles dans Format → Style → Nuances et Crescendos/Decrescendos → Positions par défaut des nuances et crescendos/decrescendos qui contrôlent le positionnement général des indicateurs de nuance :

Position détermine si les indictions de nuance doivent être positionnées selon leur affectation aux voix ('Basé sur la voix', par défaut), ou l'être 'Au-dessus' ou 'Au-dessous'
Placer au-dessus de la portée pour les instruments vocaux spécifie si le placement doit se faire au-dessus de ce type de portée (coché par défaut) ou non
Centrer automatiquement entre les portées de piano centrera verticalement l'indicateur de nuance entre les portées de l'instrument à portées multiples (coché par défaut)

Positionnement basé sur la voix

Si le positionnement Basé sur la voix est choisi, l'affectation des voix affectera la position de l'indicateur de nuance comme suit :

la nuance de la voix 1 est affichée au-dessous de la portée s'il n'y a qu'une voix à cette position rythmique ou au-dessus dans les autres cas
la nuance de la voix 3 est affichée au-dessus de la portée
les nuances des voix 2 et 4 sont affichées en dessous de la portée
les nuances affectées à toutes les voix sont affichées en dessous de la portée.

La position de chaque indicateur de nuance peut être explicitement modifiée via Propriétés → Position.

Centrer les indicateurs de nuance entre les portées

Les indicateurs de nuance des instruments à portées multiples (claviers de piano, percussions, harpe...) peuvent être centrés verticalement entre les portées.

Par défaut, un indicateur de nuance est automatiquement centré quand :

Il y a une portée du même instrument au-dessus ou au-dessous de l'indicateur de nuance (en fonction de sa position relative par rapport à la portée à laquelle elle est rattachée) entre lesquelles il peut être centré
Propriétés → Affectation des voix est paramétré sur Toutes les voix de l'instrument
Propriétés → Centrer entre les portées est paramétré sur Auto
Dans Format → Style → Nuances et Crescendos/Decrescendos, l'option Centrer automatiquement entre les portées de piano est cochée
Aucun décalage vertical n'a été appliqué à l'indicateur de nuance.

Vous pouvez aussi centrer manuellement l'indicateur de nuance en cochant Centrer entre les portées et en configurant Position selon que la portée avec laquelle vous voulez le centrer est au-dessus ou au-dessous.
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Combiner indicateur de nuance et texte

Pour ajouter une instruction de nuance qui combine un symbole de nuance avec du texte, par exemple poco f :

Ajoutez un symbole d'indication de nuance approprié à votre partition en utilisant les étapes précédentes (pour poco f, ajouter un symbole de nuance f)
À partir de la palette Texte, ajoutez un élément texte expression à la même note.

Le symbole de nuance et le texte d'expression seront combinés ensemble, vous autorisant à les manipuler comme un élément unique.
Faites un double-clic sur le texte expression pour l'éditer (pour poco f, remplacez le texte avec le mot poco).

De façon alternative, vous pouvez faire un double-clic sur un symbole de nuance et taper le texte additionnel d'un côté ou de l'autre du symbole.

Quand un texte d'expression est combiné avec un indicateur de nuance, la taille du texte peut être indépendamment déterminée en utilisant la propriété Taille dans Propriétés > Texte.

Style d'indicateurs de nuance

Voir la page Modèles et styles

Format → Style → Nuances et Crescendos/Decrescendos contient les options pour le positionnement par défaut, l'espacement et la taille des indicateurs de nuances et des Crescendos/Decrescendos.

Éditer la police des indicateurs de nuance

Vous pouvez sélectionner la police utilisée pour les indicateurs de nuance dans Format → Style → Partition → Police des symboles musicaux. La police par défaut est Leland. Vous pouvez aussi modifier la police des indicateurs de
nuance sans modifier la police utilisée pour les autres symboles musicaux dans Format → Style → Nuances et Crescendos/Decrescendos → Remplacer la police de la partition de la section Nuances.

Éditer le style de texte d'expression

Vous pouvez éditer le style du teste d'expression dans Format → Style → Styles de Texte → Expression. Vous pouvez choisir si le texte d'expression est automatiquement combiné à l'indicateur de nuance dans Format → Style → Texte
d'expression.

Compatibilité de lecture des indicateurs de nuance

La compatibilité des nuances spécifiques à certaines voix dépend de la technologie de son choisie (SoundFont, VST ou Muse Sounds) et si l'instrument est capable de changer de nuance sur une note unique (comme un violon ou une flûte)
ou non (comme le piano ou les instruments de percussion pour lesquels la propriété de nuance commence à s'estomper après l'attaque initiale de la note).

Dans la table ci-dessous, les instruments à nuances sur une même note sont référencés comme SND (single-note-dynamic), et les autres comme non-SND.

Technologie de son Compatibilité avec des voix/portées individuelles

Muse Sounds Compatibilité totale avec les nuances individuelles de voix et de portée.

SoundFont (MS Basic)
Les instruments SND comme non-SND sont compatibles avec les nuances de voix individuelles. Seuls les
instruments non-SND sont compatibles avec les nuances individuelles de portée.

VST Seuls les instruments non-SND sont compatibles avec les nuances individuelles de voix et de portée.

Marques de crescendo et diminuendo

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Types de marques

Il y a deux sortes de symboles graphiques (quelquefois appelés "soufflets") indiquant le changement graduel de volume sonore dans la partition : crescendo (augmenter le son) et diminuendo (baisser le son) :

Il y a aussi des lignes crescendo et diminuendo qui veulent dire la même chose :

Remarque : le terme decrescendo est parfois utilisé à la place de diminuendo.

Ces marques peuvent être trouvées à la fois dans les palettes Lignes et Nuances.

Ajouter des marques de crescendo/diminuendo dans la partition

Palettes

Pour saisir une marque de crescendo/diminuendo, utilisez une des options suivantes :

Sélectionnez une plage de notes ou de mesures puis cliquez sur le type de marque souhaité dans la palette Lignes ou Nuances
Cliquez déplacez un type de marque vers une tête de note. La marque s’étendra jusqu’à la fin de la mesure.

Raccourcis clavier

Pour saisir une marque de crescendo/diminuendo avec un raccourci clavier :

Sélectionnez une plage de notes ou de mesures
Utilisez une des options suivantes :

Pour un crescendo, tapez < (signe "plus petit que ").
Pour un diminuendo, tapez > (signe "plus grand que").

Modifier l’apparence des marques de crescendo/diminuendo

Plage d’effet

Pour étendre ou réduire la plage de notes sur laquelle s’applique le crescendo/diminuendo, voir Modifier la plage d’une ligne.

Hauteur du symbole

Pour changer la hauteur du symbole, cliquez sur la poignée d’ajustement de hauteur (grisée dans l’image ci-dessous)…

… puis utilisez les touches fléchées du clavier ou déplacez la poignée avec la souris jusqu’à la position souhaitée (Voir Bases : Ajuster directement les éléments).

De façon alternative, vous pouvez régler le paramètre Hauteur dans l’onglet Style de la section Crescendo / Diminuendo du panneau Propriétés.

Inclinaison du symbole

Pour incliner le symbole en diagonale, cochez la case Autoriser la diagonale dans l’onglet Style de la section Crescendo / Diminuendo du panneau Propriétés. Vous pouvez alors déplacer les poignées d’ajustement de début/fin du
symbole pour lui donner l’angle souhaité.

Autres réglages

Voir Propriétés de marques de crescendo/diminuendo.

Modifier la lecture des crescendos/diminuendos

[A compléter]

Propriétés des marques de crescendo/diminuendo
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Vous pouvez éditer les propriétés spécifiques des marques sélectionnées dans la section Crescendo / Diminuendo du panneau Propriétés.

Onglet style

Cercle niente : place un petit cercle à la pointe du symbole
Autoriser la diagonale : permet d’ajuster l’angle du symbole ; voir Modifier l’apparence des symboles de crescendo/diminuendo (ci-dessus)
Style de ligne : choisissez entre ligne continue, tirets ou pointillés
Épaisseur / Hauteur :
Hauteur (nouveau système) : spécifie la hauteur des symboles suivants si le premier enjambe un système
Position : "Au-dessus" ou "Au-dessous".

Onglet texte

Les propriétés vous permettent ici de définir le début, la fin et la poursuite des textes au-delà d’un système ainsi que leurs décalages verticaux.

Style des marques de crescendo/diminuendo

Voir Modèles et styles.

Les valeurs du "Style pour les marques de crescendo/diminuendo" peuvent être éditées via Format → Style → Crescendos / Diminuendos.
Les valeurs du "Style de texte au sein des marques de crescendo/diminuendo" peuvent être éditées via Format → Style → Styles de texte → Crescendo/Diminuendo.

Dans MuseScore Studio 4.1.1, l'option "Remplacer la police de la partition" du "Style pour les marques de nuance" n'affecte pas le texte de crescendo/diminuendo : utilisez "Police" du "Style de texte au sein des marques de crescendo/
diminuendo".

Liaisons de phrasé

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Aperçu

Une liaison de phrasé est une ligne courbe réunissant des notes de différentes hauteurs pour indiquer un phrasé legato ; l’interprétation exacte dépend de l’instrument.
Les liaisons de phrasé ne doivent pas être confondues avec les liaisons de prolongation qui connectent deux notes de même hauteur et augmentent la durée de la première note avec celle de la note liée.

Ajouter une liaison de phrasé à votre partition

Après avoir sélectionné une note, une liaison de phrasé peut être créée en utilisant n’importe laquelle des techniques suivantes :

Le raccourci clavier S. Cette option est à la fois pratique et rapide
L’option de menu Ajouter → Ligne → Liaison de phrasé
La liaison de phrasé de la palette Lignes (ou __Articulations_).

La méthode d'application exacte dépend si vous êtes en mode saisie de note ou normal. La méthode par raccourci clavier sera utilisée comme exemple.

Ajouter une liaison de phrasé en mode normal

Méthode 1

Sélectionnez la note où vous voulez faire commencer la liaison de phrasé

Tapez S pour ajouter une liaison de phrasé étendue à la note suivante

Pour étendre la liaison aux notes suivantes, maintenez Maj et tapez sur la touche → (flèche droite). Répétez l’opération autant de fois que nécessaire

Pour inverser la direction de la liaison (haut/bas), tapez X

Tapez Echap. pour sortir du mode normal

Méthode 2

Sélectionnez la note où vous voulez faire commencer la liaison de phrasé
Choisissez l’un des options suivantes :

Pour ajouter une seule liaison de phrasée, maintenez Ctrl (Mac : Cmd) et sélectionnez la dernière note devant être liée
Pour ajouter des liaisons de phrasé à toutes les voix, maintenez Maj et sélectionnez la dernière note devant être liée

Tapez S pour étendre la liaison de phrasé à la note suivante.

Ajouter une liaison de phrasé en mode saisie de notes

Saisissez la première note de la section à lier
Tapez S pour commencer la section liée
Saisissez les notes restantes de la section liée
Tapez S de nouveau pour terminer la liaison.

Créer des liaisons de phrasé multi-voix et inter-portées

En utilisant la méthode 2 ci-dessus, vous pouvez créer une liaison de phrasé couvrant des notes de la même voix ou de voix différentes. Les liaisons de phrasé inter-portées peuvent être créées exactement de la même façon. Exemple :

Vous pouvez aussi régler les poignées d’ajustement de début/fin d’une liaison de phrasé pour les amener le début ou la fin sur une note d’une voix différente :

Cliquez sur le début / la fin de la poignée de la liaison de phrasé

Manuel de MuseScore 4 https://musescore.org/fr/print/book/export/html/329209?toc=1#undefin...

92 sur 199 04/07/2025, 12:24

https://musescore.org/fr/print/book/export/html/329209?toc=1#undefined-change-appearance
https://musescore.org/fr/print/book/export/html/329209?toc=1#undefined-change-appearance
https://musescore.org/fr/forum/16
https://musescore.org/fr/forum/16
https://musescore.org/fr/print/book/export/html/329209?toc=1#node-329660-ties
https://musescore.org/fr/print/book/export/html/329209?toc=1#node-329660-ties
https://musescore.org/fr/print/book/export/html/329209?toc=1#node-329757-normal-mode
https://musescore.org/fr/print/book/export/html/329209?toc=1#node-329757-normal-mode


Tapez Maj+↑/↓ pour la déplacer entre les différentes voix et entre portées.

Modifier l’apparence des liaisons de phrasé

Pour ajuster la forme d’une liaison ou la plage de notes à laquelle elle s’applique, voir Ajuster directement les éléments.

Propriétés des liaisons de phrasé

Les propriétés suivantes, spécifiques aux liaisons de phrasé sélectionnées, peuvent être paramétrées dans le panneau Propriétés.

Style: ligne continue, tirets ou pointillés.
Position : Au-dessus ou Au-dessous.

Style des liaisons de phrasé

Plusieurs propriétés par défaut de toutes les liaisons de phrasé de la partition peuvent être paramétrées dans Format → Style→ Liaisons de phrasé / prolongation.

Respirations et pauses

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Aperçu

Les symboles de pauses et de respiration peuvent être trouvés dans la palette Respiration et pauses.

Ces symboles ont aussi un effet sur la lecture, qui peut être paramétrée.

Remarque : il ne faut pas confondre le terme de "pause" utilisé dans ce chapitre – au sens de arrêt, interruption de tempo – et la figure de silence appelée pause qui est un silence ayant la valeur d’une ronde et qui est également utilisée
comme pause de mesure ou de multimesures.

Types de symboles de pauses

Point d’orgue et point d’arrêt

Un point d’orgue placé au-dessus/au-dessous d’une figure de note en prolonge la durée, indiquant un arrêt provisoire du tempo de la musique :

Lorsque le symbole est placé sur/sous une figure de silence, il est appelé point d’arrêt :

Dans MuseScore Studio, on peut aussi positionner le point d’orgue au-dessus d’une barre de mesure pour indiquer de marquer une pause avant la lecture du morceau ou de la section de musique suivante.

Respiration

Une respiration est un symbole (apostrophe) placé juste au-dessus de la portée pour indiquer à l’interprète d’un instrument à vent ou à un chanteur de prendre une respiration à cet endroit — ou à d’autres instruments de faire une très
légère pause. Elle peut apparaître entre deux notes ou à la fin d’une mesure.

Césure

Le symbole de césure indique également une pause, légèrement plus longue que la respiration mais moins que le point d’orgue. La césure peut être placée entre deux notes ou à la fin d’une mesure.

Ajouter un symbole de pause à la partition

Pour ajouter un point d’orgue ou un point d'arrêt :

Sélectionnez une note, un silence ou une barre de mesure
Cliquez sur un symbole de point d’orgue dans la palette Respiration et pauses.

De façon alternative, vous pouvez cliquer-déplacer un symbole de point d'orgue vers une note ou un silence.

Pour ajouter un symbole de respiration ou de césure :

Sélectionnez une note
Cliquez sur le symbole de respiration/césure dans la palette __Respiration et pauses __.

De façon alternative, vous pouvez cliquer-déplacer une marque de respiration/césure vers une note.

MuseScore Studio place automatiquement les marques de respiration/césure dans un positionnement correct, juste au-dessus de la portée et après la note sélectionnée.

Modifier la lecture des symboles de pause

Les symboles de pause ont un effet sur la lecture de la partition. Pour ajuster la durée de la pause, cliquez sur le bouton Lecture dans le panneau Propriétés et ajustez le paramètre Durée.

Propriétés des symboles de pause

La position d’un symbole de pause sélectionné peut être paramétrée en cliquant sur Apparence dans le panneau Propriétés et en ajustant les options de paramétrage. De façon alternative, vous pouvez déplacer le symbole avec la souris ou
entrer en Mode édition puis utiliser les flèches du clavier pour le déplacer.

En outre, vous pouvez positionner un point d’orgue au-dessus ou au-dessous de la portée en sélectionnant la position désirée dans le paramètre Placement sur la portée de la section Point d’orgue du panneau Propriétés.

Style des symboles de pause

Vous pouvez régler les propriétés par défaut de positionnement de tous les points d’orgue via Format → Style → Points d’orgue.
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Ornements

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Aperçu

Les ornements et lignes d’ornement peuvent être trouvés dans la palette Ornements.

La palette Ornements est masquée par défaut. Pour afficher cette palette :

Cliquez sur Ajouter des palettes
Cliquez sur le bouton + à droite de Ornements

Cela inclut les symboles de gruppetto, trille et mordant.

Ajouter un ornement à la partition

Ajouter un ornement

Pour ajouter un ornement à la partition :

Sélectionnez une ou plusieurs notes
Cliquez sur le symbole d’ornement souhaité dans la palette Ornements.

Uniquement pour la trille, il est possible d’utiliser un raccourci clavier personnalisé à la place de l’étape 2.

Ajouter une ligne d’ornement

La procédure pour insérer une ligne d’ornement est identique à celle des autres types de lignes, c’est-à-dire :

Sélectionnez une note de départ
Tapez Maj et cliquez sur la note de fin
Cliquez sur la ligne d’ornement souhaitée dans la palette Ornements.

Si vous avez besoin d’ajuster secondairement la longueur de la ligne d’ornement, voir Modifier la plage d’une ligne.

Modifier l'intervalle d'un ornement (ajouter des altérations)

Les ornements sont sensibles à l'armure et aux autres altération de la mesure. Par défaut, les trilles, gruppettos, mordants et autres ornements sont affichés et joués avec des intervalles diatoniques. Utilisez le panneau Propriétés pour
changer l'intervalle, afficher les altérations appropriées dans la partition et modifier la lecture.

Pour appliquer une altération à un ornement :

Sélectionnez un ornement
Ouvrez le panneau Propriétés
Utilisez les sélecteurs d'intervalle pour choisir celui qui est souhaité. La partition affichera les altérations appropriées pour l'intervalle choisi.

Les trilles peuvent être personnalisées par qualité (majeure, mineur, augmentée, etc.) and numéro d'intervalle, de l'unisson à l'octave. L'altération appropriée ou la note auxiliaire seront affichées au-dessus ou au-dessous de l'ornement dans
la partition. Pour les intervalles plus importants que la seconde, préférez utiliser un trémolo.

L'intervalle supérieur comme l'intervalle inférieur peuvent être paramétrés pour les gruppettos.

Les intervalles des trilles courtes et mordants peuvent être paramétrés en seconde majeure ou mineure.

Toutes les altérations introduites uniquement par un ornement doivent être confirmées ou annulées plus tard dans la mesure pour plus de clarté. ce qui signifie qu'il n'est pas possible d'effacer des altérations quand la note :

est postérieure ET dans la même mesure qu'un ornement avec des altérations
a la même hauteur de note que la note avec une altération spécifiée par un ornement (à l'exclusion de la note de base).

Par exemple, dans une mesure commençant avec un gruppetto chromatique en La comme vu plus bas, tous les Sol et Si qui suivent dans la mesure auront une altération, même si c'est la même chose que ce qui apparaît dans l'ornement.
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Bien que ces altérations ne puissent être supprimées, on peut empêcher leur visibilité. Pour réaliser cela :

Sélectionnez l'altération
Ouvrez le panneau Propriétés
Décochez Visible

Propriétés des ornements

Les propriétés suivantes des ornements sélectionnés peuvent être paramétrées dans la section Ornement du panneau Propriétés :

Visibilité des altérations

Par défaut affiche uniquement les altérations qui n'ont pas été déjà affichées plus tôt dans la mesure.
Afficher toutes les altérations afficher de nouveau l'altération, même si elle apparaît plus tôt dans la mesure.
Toujours afficher une altération affiche les altération, même pour les notes diatoniques.

Position

Utilise les contrôles de positionnement soit pour laisser MuseScore Studio choisir automatiquement la position standard, soit pour effectuer manuellement le placement, Au-dessus ou Au-dessous.

Propriétés des altérations

Quand elles sont sélectionnées, les altérations, y compris celles qui sont liées aux ornements, ont les propriétés suivantes dans le panneau Propriétés :

Ajouter des parenthèses ou des crochets
Basculer en petite altération

Style des ornements

Les propriétés d'espacement et de taille par défaut des ornements peuvent être paramétrées dans Format → Style... → Articulations, Ornements.

Les ornements peuvent être repositionnés individuellement par les cliquant et déplaçant dans la partition ou via la fenêtre de dialogue Apparence du panneau Propriétés.

Arpèges et glissandos

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Aperçu

Arpèges, flèches de sens d'exécution (pour claviers et instruments à cordes pincées) et glissandos ("bends" ou "portamentos" entre deux notes mais non avant une note [technique d'instruments à cordes]) peuvent être mis en œuvre depuis
la palette Arpèges & glissandos :

Beaucoup ont des effets sur la lecture qui sont paramétrables (voir dessous).

Symboles d’arpège

Remarque : les techniques relatives aux arpèges sont également applicables au "gratter" de guitare et autres instruments à cordes pincées.

Ajouter un arpège à votre partition

Pour ajouter un arpège à une partition :

Cliquez sur n’importe quelle note dans un accord (une sélection multiple est possible)
Cliquez sur un symbole d’arpège dans la palette.

De façon alternative, vous pouvez faire glisser un symbole avec la souris depuis la palette jusqu’à une tête de note.

Étendre la hauteur du symbole d’arpège

Quand on clique sur un symbole d'arpège, deux poignées d’ajustement apparaissent en haut et en bas du symbole. Vous pouvez les faire glisser avec la souris ou bien sélectionner une poignée et utiliser les flèches haut/bas du clavier.

Créer des arpèges multi-voix ou inter-portées

Arpèges multi-voix

Par défaut les symboles d’arpège ne couvrent qu’une seule voix. Si vous avez un accord étendu sur plus d’une voix, il suffit d’étendre l’arpège en hauteur comme montré ci-dessus.

Arpèges inter-portées

Pour créer un arpège qui couvre deux portées :

Commencez par ajouter un arpège à l’accord de la portée supérieure
Cliquez sur la poignée d’ajustement du bas du symbole d’arpège et tapez Shift+↓.

Le symbole devrait maintenant couvrir les accords des deux portées.

Modifier la lecture des arpèges

Pour modifier la vitesse de lecture d’un arpège sélectionné, cliquez sur le bouton Lecture dans le panneau Propriétés et paramétrez Délai de propagation.

Si vous souhaitez arrêter complètement la lecture de l'effet, décochez la case Joué dans la section Général du panneau Propriétés.

Style des symboles d’arpège

Les propriétés par défaut de tous les symboles d’arpège peuvent être paramétrées via le menu Format → Style → Arpèges.

Manuel de MuseScore 4 https://musescore.org/fr/print/book/export/html/329209?toc=1#undefin...

95 sur 199 04/07/2025, 12:24

https://musescore.org/fr/forum/16
https://musescore.org/fr/forum/16


Symboles de glissando

Remarque : Les Slides de guitare sont documentés dans Techniques de guitare.

Ajouter un glissando dans votre partition

Sélectionnez une ou plusieurs notes de départ

Cliquez sur le symbole souhaité de glissando dans la palette. Le glissando créé s’étend jusqu’à la note suivante, dans la même voix :

De façon alternative, vous pouvez faire glisser un symbole avec la souris depuis la palette jusqu’à une tête de note.

Les glissandos peuvent traverser les portées si besoin :

Éditer la plage d’un glissando

Si nécessaire, vous pouvez changer la position de début ou de fin du glissando comme suit :

Sélectionnez la poignée d’ajustement du côté où vous voulez réaliser le changement
Tapez Shift+↑/↓/←/→ pour déplacer la poignée dans la direction souhaitée, une note à la fois.

Cette méthode peut aussi être utilisée pour déplacer la poignée à travers les voix et les portées.

Modifier l’apparence des glissandos

Le type de ligne d’un glissando sélectionné — linéaire ou trille — et tout texte associé peuvent être paramétrés dans la section Glissando du panneau Propriétés. Vous pouvez aussi masquer le texte en décochant la case "Afficher le texte".

Modifier la lecture d’un glissando

Pour modifier l’effet de lecture, cliquez sur le bouton Lecture dans le panneau Propriétés et sélectionnez une option dans la liste déroulante : chromatique, touches blanches, touches noires, diatonique, portamento. (Remarque : cela crée un
portamento entre deux notes. MuseScore Studio 4.1.1 ne permet pas un portamento avant une note (technique d'instrument à cordes) ou leur lecture.)

Si vous souhaitez complètement arrêter la lecture de l’effet, décochez la case "Joué" dans la section Général du panneau Propriétés.

Propriétés et style des glissandos

Les propriétés suivantes sont disponibles dans la section Glissando du panneau Propriétés :

Ligne de glissando : choisissez entre "Linéaire" et "Trille".
Afficher le texte : décochez/cochez cette case pour masquer/afficher le texte du glissando.
Texte : spécifie tout texte à afficher avec le glissando.

Le style par défaut de tous les textes de glissando est déterminé par les paramètres de la section Glissando dans Format → Style → Styles de Texte.

Symboles de bend

Remarque : pour le bend ("tiré") de guitare, voir Techniques de guitare et, à partir de la version 4.2 de MuseScore Studio, Bends de guitare.

La palette Arpège & glissandos contient aussi des symboles de bend pour les instruments à vent comme la trompette :

Ceux-ci ont des effets sur la lecture de la partition.

Types de bends

Fall (Portamento descendant)
Doit (Portamento ascendant)
Plop
Scoop

Si vous n’êtes pas sûr de savoir qui fait quoi, faites survoler le curseur de la souris pour voir le nom du symbole s’afficher.

Ajouter un bend à votre partition

sélectionnez une tête de note
Cliquez sur un symbole de bend souhaité dans la palette.

De façon alternative, vous pouvez faire glisser un symbole avec la souris depuis la palette jusqu’à une tête de note.

Changer l’apparence des bends

Pour changer la forme d’un bend, cliquez dessus. Quatre poignées d’ajustement deviennent visibles. Faites-les glisser avec la souris ou cliquez dessus et utilisez les touches fléchées du clavier jusqu’à obtenir la forme désirée.

Fioritures

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Aperçu

Les fioritures peuvent être mise en œuvre à partir de la palette Fioritures.

Pour les joueurs de cornemuse, il existe une plage complète de fioritures spécifiques dans la palette Ornements pour cornemuse.

Types de fioritures

Les fioritures sont des notes de taille réduite qui accompagnent une note précédente ou suivante. Elles prennent leur valeur de celle la note parente mais ne sont pas comptées elles-mêmes dans la durée de la mesure.

Il en existe plusieurs sortes :
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Acciaccatura :  habituellement écrite avec un trait oblique sur le crochet de la note (ou sur la ligature pour une plage de notes reliées par une ligature).

Appoggiature :  note accentuée de durée deux fois moins importante que la valeur de la note parente.

Fioriture de fin de trille : indique la façon de jouer la fin d’une trille.

Ajouter une fioriture à votre partition

Remarque : pour des portées standard et tablatures, les instructions suivantes fonctionnent à la fois dans les modes saisie de notes et Modes de saisie des notes .

Ajouter une fioriture à l’aide d’un raccourci clavier

Assurez-vous que la note "parente" est sélectionnée (une sélection multiple est possible en mode normal).
Pour ajouter une acciaccatura, tapez / (slash). Pour les autres fioritures, utilisez un raccourci clavier personnalisé (voir Préférences : Raccourcis).

Ajouter une fioriture à partir de la palette

Assurez-vous que la note "parente" est sélectionnée (une sélection multiple est possible en mode normal).
Cliquez sur le symbole souhaité dans la palette Fioritures.

De façon alternative, vous pouvez cliquer/déplacer le symbole de la palette jusqu’à une note de la partition.

Fioritures multiples

Fioritures en séquence

Vous pouvez ajouter une séquence de fioritures à une note sélectionnée en répétant l’une des techniques suivantes :

Tapez sur le raccourci clavier correspondant (voir ci-dessus)
Cliquez sur un symbole de fioriture dans la palette
Cliquez/déplacez une fioriture de la palette vers une note.

Accords de fioritures

Pour réaliser un accord de fioritures :

Ajoutez une fioriture simple (comme décrit ci-dessus).
Pour les portées standard utilisez une des méthodes suivantes :

Tapez Maj et une lettre de note, A à G. Cela ajoutera la note correspondante au-dessus.
Tapez Alt+1–9 ou, depuis la barre de menu, sélectionnez Ajouter → Intervalles et choisissez l’intervalle dans la liste. Cela ajoutera la note indiquée par l’intervalle ci-dessus au-dessus de la note sélectionnée
Vous pouvez ajouter des intervalles en dessous de la note sélectionnée de la même façon via le menu ou en utilisant un raccourci clavier personnalisé (voir Préférences : Raccourcis)

Pour une tablature, sélectionnez la fioriture en mode normal puis ajoutez les notes suivantes de l’accord en utilisant la méthode d’ajout d’intervalles de l’étape 2.

Éditer les fioritures

Modifier la durée

Pour éditer la durée visible, cliquez sur une fioriture en mode normal et sélectionnez une durée dans la barre d’outils de saisie de notes ou utilisez un raccourci clavier (voir Sélectionner la durée des notes ou des silences).

Modifier la hauteur

Portées standard : pour modifier la hauteur de note d’une fioriture, utilisez une des méthodes décrites dans Éditer des notes et des silences.

Tablature : pour modifier la hauteur de note d’une fioriture, utilisez une des méthodes décrites dans Modifier la hauteur en mode normal (tablature).

Modifier la lecture des fioritures

Vous pouvez arrêter la lecture d'une fioriture sélectionnée en décochant la case Joué dans la section Général du panneau Propriétés.

Style des fioritures

Vous pouvez paramétrer les tailles par défaut de toutes les fioritures dans le menu Format → Styles → Tailles.

Trémolos et roulements

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Types de trémolos et roulements

Un trémolo est la répétition rapide d’une note ou d’un accord, ou bien l’alternance rapide entre deux notes ou accords. Le placement des trémolos est réalisé automatiquement par le programme.

Trémolo d’une seule note

Pour les notes avec hampe, la valeur rythmique du trémolo est indiquée par le nombre de barres diagonales traversant la hampe. Pour les rondes, le symbole de trémolo est placé au-dessus de la note.
Une barre indique que la note originale est divisée en croches ; exemple :

Deux barres divise la note en doubles croches et trois barres en triples croches.

Trémolos entre notes

Dans les trémolos traditionnels entre deux notes ou deux accords, des ligatures incomplètes sont tracées entre les notes pour indiquer la valeur rythmique du trémolo (pour changer le style, voir ci-dessous). Une ligature indique des croches,
deux ligatures des doubles croches et trois ligatures des triples croches ; exemple :

Buzz roll

Un symbole de Buzz roll est aussi disponible dans la palette Trémolos. Cependant, il ne s’agit que d’une notation qui n’a, actuellement, aucun effet sur la lecture.

Ajouter un trémolo à une note seule

Cliquez sur une tête de note dans la partition
Cliquez sur le symbole de trémolo souhaité dans la palette Trémolos.

Ajouter un trémolo entre des notes/accords

Saisissez les notes avec la moitié de la durée totale du trémolo désiré
Sélectionnez une note dans le premier accord
Cliquez sur le symbole de trémolo souhaité dans la palette Trémolos.

Les ligatures de trémolo apparaissent entre les notes/accords et l’apparence des têtes de notes est ajustée en conséquence.

Exemple : pour saisir un trémolo d’une durée d’une blanche entre deux notes, saisissez deux noires. Après avoir appliqué un symbole de trémolo sur la première note, les valeurs de notes sont automatiquement doublées et affichées sur une
blanche.

Modifier l’apparence des symboles de trémolo
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Trois styles de trémolos entre notes/accords sont fournis par MuseScore Studio ; le style traditionnel est paramétré par défaut. Pour modifier le style :

Cliquez sur le symbole de trémolo (entre les notes)
Dans la section Trémolos du panneau Propriétés, cliquez sur le modèle de symbole souhaité sous Style (entre les notes).

Autres lignes

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Vue d’ensemble

Une ligne Musescore est un objet qui peut s'attacher (s'ancrer) à un plage de sélection horizontale de plus de deux notes ou silences, ou bien à une collection de notes verticales (accord). Elle est composée d'une certaine longueur de ligne
droite ou courbée et, de façon optionnelle, d'un texte. Ces objets peuvent fonctionnellement affecter la partition et partager des propriétés de ligne, propriétés de texte, et styles similaires.

Les objets Ligne Musescore incluent les catégories qui suivent (suivez le lien attaché au texte pour consulter leur page dédiée ou "sauter à la section" contenue dans cette page) :

Ligne standard ou quelconque (une simple ligne droite universelle) (sauter à la section)
Liaisons de phrasé
Lignes texte de portée et de système (sauter à la section)
Marques de crescendo et diminuendo
Lignes de tempo comme rit --- (sauter à la section)
Alternatives de reprise (lignes et crochets de répétition au-dessus de la portée)
Marques de Notation spécialisée : Clavier : Pédale
Lignes d'octave (8ve, etc.)
(Longues) lignes de trille (sauter à la section)
Arpèges
Glissando (slides) et portamento entre deux notes
Différentes types de mordants (Upprall, Downprall, Prallprall), ornements qui affectent la lecture
lignes relatives à la guitare (sauter à la section), incluant la ligne de barré, "let ring" line, P.M. --- (palm mute), vibrato et les lignes personnalisées de doigté/numéro de corde
lignes de vibrato et de trémolo en dents de scie, qui n'affectent pas la lecture
Ambitus (une fonctionnalité récente).

Les marques qui suivent sont également formés par une longueur de ligne ou de courbe mais elle n'appartiennent pas aux objets Ligne de MuseScore Studio car elles ne peuvent pas s'attacher (s'ancrer) à une sélection de notes continues :

Bends (articulations pour guitare ou instruments à vent)
Liaisons de prolongation
Trémolos et roulements
Note isolée d'ornements tels que gruppettos, (courtes) trilles et mordants
Crochets de système et accolades (de portée)
Barres de mesure
Ligne de portée (pour changer l'épaisseur générale des lignes de portée, voir Notions de mise en page : Portée. Pour d'autres paramétrages associés, voir le chapitre Propriétés de portée / partie).

Remarque : les descriptions suivantes sur les actions et le comportement général s'appliquent aux objets Ligne discutés ici (qui n'ont pas de chapitre dédié dans le manuel). Pour les autres objets Lignes, référez-vous aux chapitres
concernés pour obtenir des informations plus précises.

Ajouter une ligne à la partition

La façon la plus commune pour ajouter une nouvelle Ligne Musescore est d'utiliser, au choix :

un raccourci clavier prédéfini, comme par exemple S pour ajouter une liaison de phrasé (voir le chapitre dédié dans le chapitre précédent), ou
la palette Lignes ou Guitare.

Pour appliquer une ligne à une plage de notes/mesures :

Sélectionnez une plage de notes
Cliquez sur un symbole de ligne d’une palette.

Ou

Cliquez-déplacez un symbole de ligne vers la note de départ
Utilisez la poignée d’ajustement de la ligne pour l’étendre (voir Modifier la plage d’une ligne).

Pour appliquer une ligne à une note seule, vous pouvez choisir une de ces méthodes :

Sélectionnez la note et cliquez sur le symbole de ligne désiré dans une palette
Déplacez le symbole depuis la palette vers la note de départ.

Ajuster une ligne

Pour ajuster la plage d’une ligne, voir Modifier la plage d’une ligne.

Types de lignes

Lignes standard

Les lignes standard sont appliquées à partir de la palette Lignes. Elles peuvent être utilisées pour n'importe que usage comme pour créer les lignes de doigté ou de numérotation de corde pour la guitare. Elles peuvent être ajustées pour
s'afficher en diagonale ou de façon verticale.

Lignes de portée et de système

Une ligne de texte de portée est fixée à une portée dans un système et n'est informative que pour cette seule portée. Elle n'apparaît que dans la partie qui affiche cette portée.

Une ligne de texte de système est fixée à une portée mais elle est informative pour l'ensemble des portées du système. Elle apparaît dans toutes les parties d'instruments.

Lignes de tempo

Les indications de tempo comme rit --- sont nouvelles dans MuseScore Studio. Elles affectent le tempo de lecture de la partition.

Lignes relatives à la guitare

Ligne de barré de la palette Guitare : utilisée pour indiquer la position sur les frettes (voir Ajouter une ligne de barré dans votre partition).
Pour créer une ligne de Doigté/numéro de corde :

ajoutez un Doigté à partir de la palette Doigtés
ajouter une ligne standard à partir de la palette Lignes
ajuster sa longueur comme souhaité.

Vibrato de la palette Guitare : vous pouvez modifier la forme de la ligne dans la section Vibrato du panneau Propriétés.
Palm mute (P.M.) de la palette Guitare : elle modifie le son joué comme celle d'une guitare électrique aux cordes étouffées.
Let ring de la palette Guitare ("laisser vibrer") : affecte la lecture comme le maintien de la pédale forte (sustain) sur un clavier.

Lignes de trilles

À ne pas confondre avec les (courtes) trilles d'ornements.

Les lignes de trille ont été améliorées dans MuseScore Studio avec un certain nombre de paramètres d'affichage, comme l'utilisation de petites notes crochées et d'altérations pour noter la hauteur de la trille. Ces réglages sont expliqués
dans la page Ornements.

Elles continuent de créer des effets de lecture avec les instruments SoundFonts comme dans les versions précédentes de Musescore. Si l'instrument utilise Muse Sounds et qu'un échantillon sonore existe, la ligne de trille jouera la belle trille
audio lors de la lecture, par exemple dans le cas d'une ligne de trille de quinte juste.
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Propriétés des lignes

Le panneau des propriétés vous permet de voir et éditer les paramètres généraux, d’apparence, et de lecture.

Le nom de la section suivante dépend du type de ligne mais il y a toujours deux onglets nommés Style et Texte :

Onglet Style

Cliquer sur l’onglet Style vous permet de régler les paramètres de la ligne elle-même :

Type de ligne : choix entre ligne seule, avec crochet simple à angle droit ou oblique, et crochet double.
Épaisseur / Hauteur du crochet : réglages spécifiques de l’aspect de la ligne
Style : choix entre ligne continue, en tirets ou en pointillés.
Tiret / Espacement: ajuste l’apparence si une ligne "en tirets" est sélectionnée.

Onglet Texte

Cliquer sur l’onglet Texte vous permet d’insérer et de positionner n’importe quel texte associé à la ligne :

Texte de début : saisir le texte, si besoin, à faire apparaître au début de la ligne.
Décalage vertical/horizontal : vous permet de déplacer le texte par rapport à la ligne (en sp.).

Texte si poursuite vers un autre système : texte qui sera affiché avant la ligne dans le système suivant.
Décalage vertical/horizontal : comme ci-dessus.

Style des lignes

Voir Modèles et styles.

Les valeurs du "Style de ligne de texte" peuvent être éditées via Format → Style → Ligne de texte.
Les valeurs du "Style de ligne de texte système" peuvent être éditées via Format → Style → Ligne de texte de système.
Les valeurs du "Style de texte au sein d'une ligne de texte" peuvent être éditées via Format → Style → Style de texte → Ligne de texte.

Autres symboles

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Vue d'ensemble

La fenêtre palette principale est d'abord présentée dans le chapitre Utiliser les palettes dans la sections Base. La fenêtre Palette principale est l'entrepôt de tous les symboles musicaux. Sa section (catégorie) Symboles abrite tous les
symboles et textes des polices musicales intégrées. L'accès ; voir la page Autres symboles. On y accède via le menu Affichage → Palette principale ou le raccourci clavier Maj+F9.

A l'intérieur de la fenêtre Palette principale, les palettes appartiennent à deux groupes :
* les objets non fonctionnels de la palette ('catégorie) Symboles
* les objets fonctionnels dans tous les autres palettes (catégories).

Vous pouvez trouver de multiples symboles qui se ressemblent visuellement. Ils diffèrent sur le plan de la programmation. La palette (catégorie) Symboles rassemble les versions non fonctionnelles des symboles et objets textes. Vous
ne devriez pas les utiliser sauf nécessite absolue. Voir la page Notation types du Manuel 3  pour les différences entre les objets fonctionnels et non fonctionnels et leurs usages. Ce chapitre n'est pas inclus dans le Manuel 4 pour éviter
des complications inutiles.

La méthode la plus simple et recommandée pour appliquer symboles et textes est le panneau Palettes. Commencez par lire le chapitre Utiliser les palettes dans la section Bases.

Une autre façon d'appliquer des symboles et du texte en ajoutant des images ; voir Utiliser des images.

La palette Symboles

Afficher
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Pour afficher la palette Symboles, sélectionnez Affichage → Palette principale ou utilisez le raccourci clavier Maj+F9. La sélection de “Symboles” dans la liste des catégories affiche tous les symboles de toutes les sous-catégories.
Sélectionnez une sous-catégorie pour afficher un jeu spécifique de symboles (actuellement nommés en anglais).

Rechercher

Vous pouvez rechercher un symbole en saisissant un terme dans la boîte Rechercher en haut de la fenêtre des Symboles. Précisez la police de caractères recherchée dans la liste déroulante "Police" à bas à droite.
Remarque : le nom de chaque symbole n’est actuellement disponible qu’en anglais ; la recherche ne peut donc être réalisée que dans cette langue.

Ajouter des symboles à votre partition

Les symboles ajoutés depuis la palette Symboles sont à l’échelle de la partition (voir taille de la portée), mais leur taille de police est fixe.

Si vous avez besoin d’un symbole avec une police de taille réglable, vous devriez envisager de l’ajouter plutôt depuis la fenêtre caractères spéciaux comme un texte de portée.

Ajouter un symbole

Utilisez une des méthodes suivantes :

Sélectionnez un ou plusieurs éléments de la partition (notes, silences, barres de mesure) puis cliquez sur le symbole à ajouter dans la __palette Symboles __
Cliquez/déplacer le symbole depuis la __palette Symboles __ vers un élément de partition (note, silence, barre de mesure).

Joindre à d’autres symboles

Après avoir ajouté un symbole, vous pouvez si besoin le joindre à un symbole existant. Utilisez une des méthodes suivantes :

Sélectionnez un symbole (préalablement ajouté à votre partition depuis la palette Symboles) puis cliquez sur le symbole à ajouter dans la palette Symboles
Cliquez/déplacer le symbole vers le symbole existant dans la partition.

Repositionner les symboles

Pour repositionner un symbole, vous pouvez le déplacer avec la souris ou paramétrer les décalages dans la section Apparence du panneau Propriétés. Vous pouvez aussi déplacer le symbole en utilisant les touches fléchées — après l’avoir
sélectionné et être entré en mode édition en tapant Alt+Maj+E ou F2.

Remarque : si deux symboles ont été associés (voir Joindre à d’autres symboles ci-dessus), déplacer le premier symbole ajouté déplacera les deux. Cependant, vous pouvez toujours déplacer le second symbole par rapport au premier.

Voir aussi

Palettes pour la personnalisation de l'interface
Utiliser les palettes pour l'usage des objets palettes et leurs effets sur la partition
Utiliser des images

Notation : Répétitions

Barres de répétition

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Aperçu

Une barre de répétition ressemble à une double barre de mesure avec un point au-dessus et au-dessous de la ligne médiane de la portée (voir l'image ci-dessous). Elle est utilisée pour encadrer des sections de la partition à répéter. On
trouve les barres de répétition dans les palettes Barres de mesure et Reprises.

Ajouter des barres de répétition à votre partition

Répétitions simples

Placez un Début de répétition (Gauche) au début de la section répétée et une Fin de répétition (Droite) à la fin de la section, voir : Modifier ou ajouter des barres de mesure.

Si le début de la section de répétition coïncide avec le début du morceau, il n'est pas nécessaire d'ajouter une barre de Début de répétition (Gauche).

Répétitions avec fins multiples (reprises complexes)

Voir Alternatives de reprise, pour les sections répétées avec plusieurs fins.

Modifier la lecture des barres de répétition

Pour modifier le nombre de fois que la section de répétition est jouée, ajustez le Nombre de lectures de la mesure finale dans la fenêtre de dialogue Propriétés de la mesure.

Ignorez la lecture des barres de répétition, des sauts et des repères en décochant l'option Barre d'outils Lecture → icône roue dentée → Jouer les reprises : voir le chapitre Commandes de lecture.

Modifier l'apparence des barres de répétition

Sélectionnez une barre de répétition dans la partition

Réalisez n'importe laquelle des actions suivantes selon nécessité :

Éditez les valeurs dans le panneau Propriétés
Faites glisser la poignée carrée (voir l'image ci-dessous) pour étendre toutes les barres verticalement à travers la partition
Ctrl + déplacement de la poignée carrée pour étendre uniquement la barre sélectionnée.

Propriétés des barres de répétitions
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Sélectionnez une barre de répétition dans la partition
Sous Barre de mesure du panneau Propriétés :
Style : laissez-le comme "--", ne pas éditer
Style de répétition : modèle utilisé.
Pour les autres items, voir le chapitre Barres de mesure.

Style des barres de répétition

Voir la page Modèles et styles

Les valeurs du "Style de barre de mesure" peuvent être éditées dans Format → Style → Barres de mesure. Spécifiez la largeur, la distance, etc.

Alternatives de reprise

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Aperçu

Les alternatives de reprise sont des lignes au-dessus de la portée utilisées pour indiquer différentes façons de terminer une section répétée. MuseScore Studio en assure une lecture correcte. Dans l'exemple affiché ci-dessous, la section
répétée est jouée une première fois jusqu'à la fin marquée "1" puis une seconde fois avec la fin marquée "2".

Ajouter une alternative de reprise à votre partition

Assurez-vous que les Barres de répétition sont dans la bonne position
Pour ajouter une alternative de reprise, utilisez l'une des méthodes suivantes :

Sélectionnez une mesure et cliquez sur la ligne souhaitée dans la palette Lignes ou
Faites glisser une ligne d'une palette sur une mesure.

Modifier l'apparence des alternatives de reprise

Sélectionnez une alternative de reprise dans la partition
Sous la section Alternative de reprise du panneau Propriétés
Ouvrez l'onglet Style et éditez l'apparence de la ligne (voir le chapitre Autres lignes : Propriétés des lignes)
Ouvrez l'onglet Texte et éditez l'apparence du texte, voir les chapitres Saisir et éditer du texte et Mettre en forme du texte. Ce texte n'a qu'une valeur indicative : il n'affecte pas la lecture.

Pour modifier la plage couverte par une alternative de reprise, voir Modifier la plage d’une ligne.

Modifier la lecture des alternatives de reprises

Sélectionnez une alternative de reprise dans la partition
Sous la section Alternative de reprise du panneau Propriétés, ouvrez l'onglet Style, autorisez la lecture du passage de musique sous la ligne de reprise en éditant la Liste des reprises.
Par exemple, saisissez "1" pour autoriser la lecture de ce passage uniquement la première fois ; elle sera sautée durant la répétition. Saisissez "2" pour autoriser la lecture de ce passage uniquement lors de la répétition.
On peut utiliser une série de nombre joints avec des virgules comme "1,2,3" pour indiquer les numéros de répétitions qui doivent être jouées.
N'oubliez pas d'éditer le Propriétés de la mesure : Autre : Nombre de lectures en conséquence. La mesure avec la barre de fin de répétition doit avoir un Nombre de lectures dont la valeur est égale au nombre total de lectures de
cette mesure + 1 ou plus. Le nombre total de lectures d'une mesure est habituellement le nombre d'entrées de la Liste des reprises. Par exemple, si la Liste des reprises est "1,7,9", le Nombre de lectures devrait être égal à "4".

La propriété du Crochet de fin affecte la lecture.

Pour modifier la plage couverte par l'alternative de reprise, voir le chapitre Ajuster directement les éléments : Modifier la plage d’une ligne.

Vous pouvez ignorer la lecture des barres de répétition, des sauts et des repères en décochant l'option Barre d'outils Lecture → icône roue dentée → Jouer les reprises : voir le chapitre Commandes de lecture.

Exemple d'un paramétrage d'alternative de reprise complexe

Télécharger le fichier mscz d'exemple  :

La mesure 3 devrait avoir un nombre de lectures fixé à 4
La mesure 5 devrait avoir un nombre de lectures fixé à 3

Cet exemple est joué ainsi : 1-3, 1-2,4-5, 1-3, 1-3, 1-2,4-5, 1-2,6-8

Propriétés d'une alternative de reprise

Sélectionnez une alternative de reprise dans la partition
Sous la section Alternative de reprise du panneau Propriétés, il existe deux onglets : Style et Texte. Leur usage est expliqué dans les sections précédentes. La propriété Crochet de fin affecte la lecture.

Style des alternatives de reprise

Voir la page Modèles et styles

Les valeurs du "Style d'alternative de reprise" peuvent être éditées dans Format → Style → Alternatives de reprise.

Les valeurs du "Style de texte au sein d'une alternative de reprise" peuvent être éditées dans Format → Style → Style de texte → Alternatives de reprise.
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Sauts et reprises

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Aperçu

Les objets Sauts et Reprises sont utilisés pour créer des sections de lectures répétées dans une partition.

Types d'objets Sauts et Reprises

Objets Sauts agissant comme point de saut :
* D.C. (Da Capo) : répéter depuis le début de la partition
* D.C. al Fine : répéter depuis le début jusqu'au repère Fine
* D.C. al Coda : répéter depuis le début de la partition jusqu'au repère To Coda puis continuer à partir du repère Coda
* D.S. (Dal segno) : répéter depuis le repère Segno
* D.S. al Fine : répéter depuis le repère Segno jusqu'au repère Fine
* D.S. al Coda : répéter depuis le repère Segno jusqu'au repère To Coda puis continuer à partir du repère Coda.

Objets Reprises agissant à la fois comme point de saut et comme étiquette de position chronologique :

To Coda : pour l'utiliser comme point de saut vers le repère Coda, il doit être utilisé en même temps que D.C. al Coda ou D.S. al Coda. Son étiquette de propriété par défaut est "coda".

Objets Reprises agissant uniquement comme étiquette de position chronologique :

Fine : pour indiquer la fin du morceau, il doit être utilisé en même temps que D.C. al Fine ou D.S. al Fine

Coda :  (dernière section de la partition). Son étiquette de propriété par défaut est "codab".

Segno :  (signe).

Ajouter un Saut ou une Reprise à votre partition

Utilisez l'une des méthodes suivantes :

Sélectionnez une mesure puis cliquez sur le symbole de répétition souhaité dans la palette Reprises et sauts
Faites glisser et déposez un symbole de répétition de la palette sur la mesure souhaitée.

Modifier l'apparence des Sauts et Reprises

Les Sauts et les Reprises sont des objets Texte. Pour éditer le texte, voir les chapitres Saisir et éditer du texte et Mettre en forme du texte.
Les symboles Segno et Capo peuvent être ajoutés depuis la fenêtre des caractères spéciaux : Affichage → Palette principale → Reprises et sauts ; ils utilisent la Format → Style → Partition : Police de symboles musicaux (voir le
chapitre Polices  du manuel Musescore 3 [en anglais]).

Modifier la lecture des Sauts et Reprises

Pour ignorer la lecture des barres de répétition, des sauts et des reprises, décochez l'option Barre d'outils Lecture → icône roue dentée → Jouer les reprises : voir le chapitre Commandes de lecture.

Propriétés des Sauts et Reprises

Sélectionnez le(s) Saut(s) et Reprise(s) à modifier
Sous les sections Saut et/ou Reprise du panneau Propriétés:
Étiquette : texte interne au logiciel utilisé pour le saut ; assurez-vous qu'il correspond au texte de l'objet Saut de départ. À ne pas confondre avec le texte d'apparence : voir la section "Modifier l'apparence des sauts et des repères".
Aller à : saisissez l'étiquette cible
Jouer jusqu'à : saisissez l'étiquette cible
Continuer à : saisissez l'étiquette cible
Jouer les reprises : autorise la lecture des barres de répétition après le saut.

Style des Sauts et Reprises

Voir la page Modèles et styles

Les valeurs de la "Police de symboles musicaux" peuvent être éditées dans Format → Style → Partition.
Les valeurs du "Style de texte dans le Texte de reprise de gauche" peuvent être éditées dans Format → Style → Style de texte → Texte de reprise de gauche (utilisé par Segno, Capo).
Les valeurs du "Style de texte dans le Texte de reprise de droite" peuvent être éditées dans Format → Style → Style de texte → Texte de reprise de droite (utilisé par les autres).

Répétition de mesure et répétitions multimesures

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Aperçu

Un symbole de répétition de mesure indique que la mesure précédente doit être répétée. Les symboles de répétition de deux et quatre mesures indiquent la répétition des deux ou quatre mesures précédentes.

Ajouter une répétition de mesure ou une répétition multimesures à votre partition

Pour appliquer un symbole de répétition d'une mesure, sélectionnez une mesure dans la partition et cliquez sur l'icône Répéter la dernière mesure dans la palette Reprises. Ou faites glisser le symbole sur une mesure.

Pour appliquer un symbole de répétition pour deux ou quatre, sélectionnez la première mesure vide après la section que vous voulez répéter, puis cliquez sur l'icône de répétition de mesure adéquate dans la palette Reprises. Vous pouvez
également faire glisser le symbole de répétition de la palette sur la même mesure vierge.

Remarque : vous devrez peut-être cliquer sur l'icône Plus dans la palette pour afficher les symboles de répétition de deux et quatre mesures.

Dans le cas de répétitions de plusieurs mesures, un symbole "Groupe de mesures" apparaît au-dessus et entre les mesures (à condition que Afficher la mise en page soit cochée dans Affichage → Afficher). Cela permet de conserver les
mesures ensemble sur le même système, dans la mesure du possible, en cas de changement automatique de mise en page dans la partition. Ce symbole peut être supprimé si vous le souhaitez.

Propriétés des répétitions de mesure
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Le paramétrage de Position du numéro dans la section Répétition de mesure du panneau Propriétés vous permet de modifier le décalage vertical du nombre au-dessus de la mesure.

Style des répétitions de mesure

Les propriétés de toutes les répétitions de mesure dans la partition peuvent être définies à partir de Format → Style → Répétitions des mesures.

Lecture des répétitions

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Activer et désactiver la lecture des répétitions

Par défaut, les répétitions sont toujours lues. Si vous souhaitez désactiver la lecture des répétitions :

Cliquez sur l’icône roue dentée dans la Barre d'outils : Commandes de lecture

Décochez Jouer les reprises.

Notation spécialisée : Clavier

Pédale

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Pour les pédales de harpe, voir plutôt Notation spécialisée : Harpe.

Types de marques de pédale

Ce chapitre fait le point sur les types de symboles de pédales de piano disponibles. Pour connaître les différentes pédales de piano, voir l'article Wikipedia .

En termes de représentation visuelle

Les symboles supportés comprennent :

Lignes sans crochet à une ou aux deux extrémités ou avec des crochets à 45 ou 90 degrés, en terminant en "T" ;
Ped. suivi par une ligne de ce type ou un symbole de rosette (*) : la ligne du bouton par défaut de palette est invisible et ne peut pas être imprimée. Paramétrez de façon appropriée l'affichage sur l'écran avec le menu Affichage >
Afficher > Afficher les éléments invisibles (voir L'interface utilisateur). Pour convertir la ligne en version imprimable, ou l'afficher en style tirets, voir Propriétés.

D'autres symboles et pictogrammes associés peuvent être trouvés sous la catégorie Symboles dans la fenêtre Palette principale (voir Autres symboles). L'indication Sost. (pédale sostenuto) ne doit pas être confondue avec sost.--
Indications de tempo ; voir aussi (en anglais) : discussion on steinberg.net .

Symboles personnalisés sim. ou pedal ad lib créés avec Texte de portée, Texte de système et Texte d'expression.

La pédale forte est tacite : il n'y a pas (encore) de symbole pour indiquer l'absence de réglage de niveau, pas plus qu'en lecture.

En termes de fonction dans MuseScore

Il y a trois sous-types différents.

Le type 1 comprend :

La ligne avec des crochets aux extrémités à 45 degré ou sans crochet d'extrémité, précédé ou non du texte Ped..
Ped. suivi par un symbole de rosette (*)

Visuellement, la ligne ou le symbole seul s'étend horizontalement jusqu'à la tête de note liée à l'ancre de fin.
Fonctionnellement, si cette note est attachée à une autre marque d'ancre de début, le marquage suivant sera automatiquement connecté et une forme créé ressemblant à "-^-", ce qui correspond à la technique de piano "pédale relâchée
puis pressée de nouveau sans relâcher cette note".

L'image ci-dessus illustre la connexion automatique. Sa lecture est aussi associée à la technique de piano.
Si l'instrument utilise des SoundFonts comme "MS Basic" ou lors de l'exportation comme fichier MIDI, un sustain (MIDI CC 64) est créé. Quand des marques de type 1 consécutives créent un "-^-", la lecture correspond à la technique de
piano : la première marque est interprétée par le synthétiseur comme un relâchement au niveau de la note liée à l'ancre de fin. Des marques d niveau 1 isolées ou successives créent une lecture audio comme le type 2 : soutien jusqu'à la

Manuel de MuseScore 4 https://musescore.org/fr/print/book/export/html/329209?toc=1#undefin...

103 sur 199 04/07/2025, 12:24

https://musescore.org/fr/forum/16
https://musescore.org/fr/forum/16
https://musescore.org/fr/forum/16
https://musescore.org/fr/forum/16
https://fr.wikipedia.org/wiki/P%C3%A9dale_de_piano
https://fr.wikipedia.org/wiki/P%C3%A9dale_de_piano
https://musescore.org/fr/print/book/export/html/329209?toc=1#undefined-properties
https://musescore.org/fr/print/book/export/html/329209?toc=1#undefined-properties
https://forums.steinberg.net/t/sostenuto-inconsistent-preset-behaviour/131902
https://forums.steinberg.net/t/sostenuto-inconsistent-preset-behaviour/131902


fin de la note attachée à l'ancre de fin.

Comme les deux dernières marques de type 1 affichées ci-dessus sont isolées ou successives, elles créent un jeu de lecture de type 2

Le type 2 comprend :

Les lignes autres que celles décrites dans le Type 1, précédées ou non par le texte Ped..

Visuellement, la ligne s'étend horizontalement avec la longueur appropriée qui inclus la durée totale de la note attachée à l'ancre de fin.
Fonctionnellement, si l'instrument utilise des SoundFonts comme "MS Basic" ou lors de l'exportation comme fichier MIDI, un sustain (MIDI CC 64) est créé. Le type 2 soutien toujours jusqu'à ce que la note attachée à l'ancre de fin termine.

Les types 1 et 2 sont interchangeables en ajustant leurs propriétés.

Le type 3 inclut la marque de pédale sostenuto ainsi que les texte de portée personnalisés. Ils ne sont utilisés que pour l'affichage et ne sont pas fonctionnels.

Ajouter une marque de pédale à la partition

L'exemple ci-dessus montre une marque de type 2 sur la partition

Pour ajouter une marque de pédale à partir de la palette Lignes, voir Autres lignes : Ajouter une ligne à la partition.

Ajustez avec Maj+←/→ et changez de poignée avec Tab (voir Ajuster directement les éléments : Modifier la plage d'une ligne).

Malheureusement, vous pourriez compromettre le style d'affichage ou ne rien noter du tout si vous devez créer une lecture particulière du fait des limitations fonctionnelles précisées. Comme avec MuseScore Studio, les marques de pédales
ne créent que des effets de soutien en lecture, cela rend impossible d'utiliser une astuce pour "ajouter un symbole redondant tout en le rendant invisible".

Pour créer une forme ressemblant à "-^-" avec des marques de type 1 consécutives, assurez-vous que l'ancre de fin est liée correctement, ce qui est habituellement fait avec la première note de la mesure suivante plutôt qu'avec la
dernière note de la mesure précédente. Cette image montre la résultat d'un positionnement correct de l'ancre de fin.

Créer des changements de pédale

À ne pas confondre avec le changement de pédale de harpe

Utilisez des marques de type 1 détaillées dans "la section "ajouter une marque".

Propriétés de pédale

Sélectionnez les indications de pédales dans la section Pédale du panneau propriétés. Les propriétés de lignes peuvent être éditées. L'option supplémentaire disponible pour l'indication de pédale est la case à cocher "Affiche une ligne
avec la rosette" sous l'onglet Style : cochez la pour rendre visible la ligne par défaut lors de l'impression et de l'export.
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Style de pédale

Voir Modèles et styles

Les valeurs du "Style de Pédale" peuvent être éditées dans le menu Format → Style → Pédale.
Les valeurs du "Style de texte de Pédale" peuvent être éditées dans Format → Style → Styles de texte → Pédale.
Voir aussi Style de ligne.

Notation entre portées

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Créer une notation entre portées

Pour commencer, saisissez uniquement la notation dans une seule portée

Sélectionnez une note dans la voix que vous voulez déplacer vers la portée du haut ou du bas. Exemple :

Tapez Ctrl+Maj+↓/↑ (Mac : Cmd+Maj+↓/↑) pour déplacer la voix vers le haut ou le bas dans l'autre portée. De façon alternative, vous pouvez cliquer sur l'icône Ligatures entre portées dans la barre d'outils de saisie des notes et choisir
la même option dans le menu contextuel (si l'icône n'est pas affichée, voir personnaliser le contenu des barres d'outils).

Remarque : cette opération fonctionne sur une base de voix plutôt que sur des notes individuelles. Cela signifie que si vous voulez vous assurer que des notes resteront sur la même portée pendant l'opération, elles devraient être dans
une voix différente que celle sélectionnée ci-dessus.

Changer l'apparence de la notation entre portées

Pour ajuster l'angle et la hauteur de la ligature, cliquez sur la ligature puis sur une poignée d'ajustement et utilisez les touches fléchées du clavier ou déplacez la poignée avec la souris. Exemple :

De façon alternative, vous pouvez réaliser des ajustements plus précis dans la section ligature du panneau Propriétés.

Voir aussi

Comment étendre un accord ou une hampe entre deux portées ?

Notation pour accordéon

ce ne sont littéralement que des symboles mais il existe une palette dédiée
on pourrait envisager de supprimer cette page
on pourrait aussi envisager d'en ajouter une pour la harpe

Ajouter des symboles accordéon à votre partition

Notation spécialisée : Guitare

Diagrammes d'accord de guitare

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Aperçu

Les Diagrammes d'accord se trouvent généralement au-dessus de la portée sur les "lead sheets" (mélodie/accords) et les partitions de piano :

Ils sont couramment utilisés pour les accords de guitare, mais MuseScore Studio vous permet de créer des diagrammes pour n'importe quel instrument à cordes.

Une bibliothèque de diagrammes d'accords de guitare courants (majeur, mineur et 7ème) est fournie dans la palette Diagrammes d'accord de guitare.

Pour afficher le nom d'accord de n'importe quel diagramme de la palette, placez le curseur dessus.

Ajouter un diagramme d'accord à votre partition

Utilisez l'une des méthodes suivantes :
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Sélectionnez une ou plusieurs notes puis cliquez sur un diagramme d'accord dans la palette
Faites glisser et déposez un diagramme d'accord de la palette sur une note.

Symboles d'accord liés aux diagrammes d'accord

Lorsque l'un des diagrammes prédéfinis est ajouté à la partition, un symbole d'accord est automatiquement placé au-dessus. Ce symbole d'accord lié a les mêmes propriétés qu'un symbole d'accord autonome et peut être modifié et déplacé
en tant que tel.

Le placement par défaut d'un symbole d'accord par rapport à son diagramme générateur est contrôlé par la propriété Distance du diagramme d'accord de guitare (définie dans Format → Style → Symboles d'accord → Position). Cette
valeur interagit avec la Distance minimum du symbole d'accord (pour l'afficher, appuyez sur Apparence dans le panneau Propriétés). Ajustez la position du diagramme manuellement si vous avez besoin de modifier ces valeurs.

Un symbole d'accord lié peut être supprimé indépendamment de son diagramme générateur. Vous pouvez également ajouter un nouveau symbole d'accord lié à un diagramme d'accord : voir Saisir un symbole d'accord.

Remarque : ni les diagrammes d'accord ni leurs symboles d'accord liés ne sont affectés par les commandes de transposition.

Créer un diagramme d'accord personnalisé

Sélectionnez un diagramme d'accord existant dans la partition ; ou ajoutez-en un à partir de la palette Diagrammes d'accord de guitare
Assurez-vous que le panneau Propriétés est ouvert (basculez avec F8)
Cliquez sur Effacer pour supprimer les marques existantes (facultatif)
Modifiez les propriétés dans l'onglet Paramètres selon vos besoins
Dans l'onglet Général, appliquez les instructions suivantes à l'image du manche, selon les besoins :

Supprimer tous les points : cliquez sur le bouton Effacer au-dessus du diagramme
Ajouter un point de doigt : cliquez sur une frette. La forme du point est déterminée par le paramètre Type de repère ; si Plusieurs points est coché, vous pouvez ajouter plus d'un point par corde
Supprimer le point : cliquez sur un point existant
Ajouter barré / barré partiel : si Barré n'est pas coché, appuyez sur Maj et cliquez sur la frette de la corde où vous voulez que le barré commence; si Barré est coché, cliquez simplement sur la frette. Par exemple :

Ajouter un barré partiel se terminant avant la première corde : créez d'abord un barré standard (voir l'instruction précédente) puis raccourcissez le en cliquant sur Maj (si Barré est désactivé) ; ou (si Barré est activé) en
cliquant la frette où vous voulez que le barré se termine. Par exemple :

Supprimer un barré : avec Barré désactivé, Maj cliquez sur le "haut" du barré. Avec Barré activé, cliquez simplement sur le "haut"
Créez plusieurs barrés : répétez les étapes ci-dessus à différentes positions de frette
Cordes à vide / Cordes non jouées : cliquez juste au-dessus du diagramme pour basculer une corde entre :

Aucun symbole
À vide (o)
Muet/non jouée (X).

Remarque : voir aussi Propriétés du diagramme d'accord (ci-dessous).

Repères de doigts

Le repère de doigt par défaut est un point noir rond, ce qui suffit pour les diagrammes d'accords (et de gammes) standard. Cependant, un certain nombre d'autres formes sont fournies (croix, carré et triangle) pour permettre d'autres types de
notation.

Types de notation alternatifs

Certains arrangeurs et éducateurs ont étendu la forme de base du diagramme d'accord en incorporant des points de doigt de différentes formes et en autorisant plusieurs points par corde. Le guitariste de jazz Ted Greene et ses successeurs
en sont des exemples notables.

Type de notation à points multiples. Avec cette approche, l'accord indiqué par des points ronds sur le diagramme du manche est joué en premier (voir l'image ci-dessous). Puis, sur des temps successifs marqués par des symboles
d'accord, le doigté d'accord est modifié pour incorporer d'autres formes sur le même schéma ; l'ordre de lecture habituel est : point → croix → carré → triangle, mais cela peut varier.

Type de notation de note facultative. Une autre utilisation de plusieurs points par corde permet à d'autres symboles d'afficher des notes facultatives, plutôt que des notes retardées :

Apparence du diagramme d'accord

Sélectionnez un diagramme d'accord et cliquez sur Apparence dans le panneau Propriétés.

Modifiez les propriétés suivantes selon vos besoins :

Espace devant : espace de début de la mesure
Largeur mesure
Distance minimum : distance minimale par rapport à la portée
Décalage : pour déplacez le diagramme horizontalement ou verticalement
Aligner sur la grille
Positionner : vers l'arrière ou vers l'avant
Couleur : cliquez sur ce bouton pour changer la couleur d'un diagramme d'accord sélectionné.

Propriétés du diagramme d'accord

Lorsqu'un diagramme d'accord est sélectionné, ses propriétés sont visibles dans l'onglet Propriétés de la barre latérale comme suit :

Onglet Général
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Barré : cochez si vous souhaitez ajouter ou supprimer des barrés en un clic sur l'image du manche ci-dessous ; si décochée, des barrés sont ajoutées en cliquant sur Maj à la place
Plusieurs points : si cette case n'est pas cochée, vous ne pouvez ajouter qu'un seul point de doigt par corde ; si cochée, vous pouvez ajouter plusieurs points par corde
Type de repère : lorsque vous cliquez sur l'image du manche, la forme du point ajouté est déterminée par cette propriété ; cela vous permet d'ajouter une variété de formes si vous le souhaitez
Effacer : efface tout en laissant un manche vide.

Onglet Paramètres

Échelle : vous permet d'agrandir ou de réduire la taille de la touche
Cordes : nombre de cordes à afficher
Frettes visibles : spécifie le nombre de frettes affichées : celles-ci sont ajoutées, ou supprimées, depuis le bas du diagramme
Numéro de frette : spécifie le numéro de frette à afficher en haut à gauche/droite du diagramme
Placement sur la portée : positionne le diagramme au-dessus ou au-dessous de la portée
Afficher le sillet : cochez la case pour épaissir la ligne du sillet. S'applique uniquement aux diagrammes de première position.

Au bas de la section Diagramme d'accord de la barre latérale se trouve une image du diagramme d'accord sélectionné. Toutes les modifications apportées à cette image sont également automatiquement appliquées au diagramme d'accord
dans la partition.

Style de diagramme d'accord

Les propriétés globales du diagramme d'accord peuvent être définies dans Format → Style → Diagrammes d'accord de guitare.

Voir également

Personnaliser le contenu des palettes

Techniques de guitare

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Ajouter un symbole de Barre de trémolo à votre partition

Le symbole Barre de trémolo est disponible dans la palette Guitare (recherchez le "V" surdimensionné). Il est ajouté et ajusté de la même manière que les [symboles de Bend] (#add-bend) (plus loin) — avec une interface graphique
similaire dans la section "Barre de trémolo" des Propriétés.

Vous pouvez choisir parmi une gamme de préréglages dans Type de barre de trémolo ou créer votre modèle personnalisé.

Ajouter un Slide de guitare (Glissando) à votre partition

Les Glissandos (Slides) se trouvent dans la palette Arpèges & glissandos. Ils sont de deux types :

Slides de type Glissandos intermédiaires : ils se positionnent d'une note ou d'un accord à l'autre.

Slides In ou Slides Out : joués avant une note (Glissando avant la note) ou joués après une note (Glissando après la note) ; ceux-ci peuvent être ascendants ou descendants.

Par défaut, les Glissandos (Slides) ont un effet de lecture sur la partition. Vous pouvez désactiver cette option en décochant Joué dans la section Général du panneau Propriétés.

Ajouter un Glissando (Slide)

Utilisez l'une des méthodes suivantes :

Sélectionnez une ou plusieurs notes comme point de départ puis cliquez sur l'icône de Glissando (Slide) souhaité dans la palette
Faites glisser l'icône de de Glissando (Slide) souhaité de la palette sur une note.

Dans le cas de Glissandos (Slides) intermédiaires allant d'un accord à l'autre, le programme tentera de lier les notes correctes dans la mesure du possible. Si un réglage supplémentaire est nécessaire, voir ci-dessous.

Modifier les propriétés

Pour les Glissandos (Slides) intermédiaires, les propriétés suivantes peuvent être paramétrées dans la section Glissando du panneau Propriétés.

Type : choisissez entre Linéaire ou Trille.
Afficher le texte : cochez cette case pour afficher le texte. Remarque : s'il n'y a pas assez d'espace entre les notes, le texte ne s'affiche pas.
Texte : le libellé affiché au-dessus du Glissando (Slide), le cas échéant.

Ajuster les points de début et de fin d'un Glissando (Slide)

Glissandos (Slides) intermédiaires :

Pour déplacer une poignée de fin verticalement ou horizontalement, d'une note à la suivante :

Sélectionnez le Glissando (Slide)
Cliquez sur la poignée de début ou de fin :

Utilisez Maj+↑↓ pour déplacer la poignée vers le haut ou vers le bas, d'une note à l'autre
Utilisez Maj+←→ pour déplacer la poignée horizontalement, d'une note à l'autre.

Glissandos (Slides) In ou Out :
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Pour régler la position de la poignée d'extrémité :

Sélectionnez le Glissando (Slide)
Cliquez sur la poignée de réglage
Faites glisser la poignée ou utilisez les flèches du clavier

Ajouter une Ligne de capodastre (en V4.0.2) ou Ligne de barré (en V4.1) à votre partition

Une Ligne de capodastre (en V4.0.2) ou Ligne de barré (en V4.1) est une Ligne de texte dessinée au-dessus d'une portée de guitare pour indiquer que le passage nécessite un barré complet ou un demi barré. Des symboles tels que les
suivants sont couramment trouvés dans la musique pour guitare :

Barré complet (2e frette) :

Demi barré (2e frette) :

Avant les chiffres romains, vous pouvez mettre un B (pour Barré) ou un C (pour Ceja en espagnol) mais ils peuvent être omis et d'autres variations dans le style de ligne et le texte sont possibles, selon l'éditeur.

Pour ajouter un barré :

Cliquez sur la note de début du barré, puis cliquez sur la note de fin pour définir la durée du barré
Cliquez sur le symbole Ligne de capodastre (en V4.0.2) ou Ligne de barré (en V4.1) dans la palette Guitare
Personnalisez la ligne et le texte selon vos besoins.

Pour ajuster la longueur d'une ligne, voir Modifier la plage d'une ligne.

Ajouter des symboles de "hammer-on" (liaison ascendante) et de "pull-off" (liaison descendante) à votre partition

Les hammer-on (ascendant) et pull-off (descendant) sont notés par des liaisons de phrasé. Si vous avez également besoin d'annotations textuelles, créez-les à l'aide de textes de portée et de système ; ils peuvent être enregistrés dans une
palette pour une utilisation future (voir Personnalisation du contenu de la palette : Ajouter des éléments depuis votre partition).

Notation des harmoniques

Portée standard

Sur une corde les harmoniques naturels sont produits à la 12e frette (octave), 7e frette (quinte), 5e frette (octave), 7e frette (tierce majeure).

Un harmonique naturel peut être noté de l'une des trois manières suivantes :

Au diapason (même note) de la corde à vide sur laquelle il est produit. Par exemple, les harmoniques sur la troisième corde (à vide Sol3) apparaissent comme H12 : 12e frette, H7 : 7e frette, H5 : 5e frette, H4 4e frette :

Au diapason de la frette de la corde à laquelle il est produit. Les mêmes harmoniques apparaissent maintenant comme Sol4, Ré4, Sol5, Si3 :

En tonalité réelle. Les mêmes harmoniques apparaissent maintenant comme :

Remarque : la guitare sonne une octave plus bas par rapport à ce qui est écrit.

Une annotation, telle que "Harm", "Nat. Har.", "NH", "Har.", est généralement jointe, ainsi que les numéros de cordes et de frettes ; la tête de note peut être standard ou en forme de losange, et rendue claire plutôt que noire ; les numéros de
frette peuvent être arabes ou romains; etc.

Correction de la Lecture : si les harmoniques ne sont pas lues à la bonne hauteur, coupez-les (décocher Joué et Visible) et créez une voix masquée contenant les harmoniques à la hauteur réelle.

Voir aussi, How to Read Harmonic Notation on the Classical Guitar  (douglasniedt.com) en anglais.

Tablature

Un harmonique naturel en tablature peut être transcrit simplement comme un numéro de frette, ou peut être suivie d'un point, ou entourée d'un diamant, ou d'une paire de chevrons. Par exemple :

Pour créer une paire de chevrons :

Sélectionnez un harmonique et ajoutez un texte de portée.
Entrez un « guillemet simple pointant vers la gauche » (U2039), puis un espace, puis un « guillemet simple pointant vers la droite » (U203A)
Il est plus simple d'utiliser les caractères "<" et ">"
Déplacez le texte pour qu'il repose sur la marque de frette
Ajustez la taille de la police du texte de la portée et l'espace à l'intérieur pour encadrer juste l'harmonique
Enregistrez le dans une palette pour une utilisation future.

Paires portée/tablature

Vous devez vous assurer que les paires portée/tablature ne sont pas liées afin de pouvoir éditer chaque portée indépendamment l'une de l'autre.

Notation du doigté de la guitare

Les types de doigtés de guitare et comment les ajouter sont expliqués dans Doigté.

Ajouter un symbole de Bend à votre partition

À ne pas confondre avec les bends des instruments à vent bois et cuivres.
Cette section affiche les anciennes instructions pour l'utilisation des bends dans MuseScore 4.0 à Musescore 4.1. Pour les utilisateurs de MuseScore 4.2 et versions suivantes, voir le chapitre Bends de guitare.

Ajouter un Bend

Les Bends sont créés avec l'outil Bend situé dans la palette Guitare :

Pour ajouter un ou plusieurs Bends à la partition, utilisez l'une des options suivantes :

Sélectionnez une ou plusieurs notes et cliquez sur le symbole de Bend dans la palette
Faites glisser le symbole de Bend de la palette sur une note.

Un Bend par défaut est créé dans la partition. Vous pouvez modifier ce Bend ou choisir parmi une gamme d'alternatives à l'aide de Type de Bend dans la section Bend du panneau Propriétés.

Modifier un Bend

La forme et la longueur du Bend peuvent être modifiées dans l'affichage graphique de la section Bend du panneau Propriétés :
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Chaque segment de ligne rouge entre les nœuds bleus représente une étape dans le Bend et chaque étape s'étend horizontalement sur 1sp. dans la partition. La pente de n'importe quelle ligne indique s'il s'agit d'un Bend vers le haut (aigu),
d'un Bend vers le bas (grave) ou d'une attente. Ainsi, le graphique ci-dessus décrit un Bend vers le haut, puis une attente — avec une longueur totale de 2sp.

L'axe vertical du graphique représente la valeur de la hauteur de la note, vers le haut (aigu) ou vers le bas (grave) : une unité (le côté d'un petit carré) équivaut à un quart de ton, 2 unités à un demi-ton, 4 unités à un ton entier, etc...

Pour ajouter une autre étape à un Bend, ajoutez un autre nœud en cliquant sur l'intersection de ligne appropriée.

Pour supprimer une étape à un Bend, cliquez sur le nœud concerné pour le supprimer.

Paramétrer la hauteur du Bend

La hauteur du Bend est automatiquement ajustée afin que tout texte apparaisse juste au-dessus de la portée. Cette hauteur peut être paramétrée, si nécessaire, avec une solution de contournement :

Créez une autre note verticalement au-dessus de la note (en raccourcissant la hauteur) ou en dessous de la note (en augmentant la hauteur) à laquelle vous voulez que le Bend commence
Ajoutez le Bend à la nouvelle note
Pour ajuster la hauteur du Bend, déplacez cette note créée verticalement afin que le symbole de Bend ait la hauteur souhaitée
Faites glisser le symbole de Bend vers la position correcte (vers la note d'origine)
Rendez la note créée comme invisible et silencieuse (à l'aide du panneau Propriétés).

Repositionner le Bend

Les Bends peuvent être librement repositionnés à l'aide des méthodes présentées dans Changer la position des éléments.

Créer une portée de tablature

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Aperçu

La musique pour instruments à cordes pincées est généralement notée en utilisant une tablature (souvent abrégé en TAB) ; cela donne une représentation visuelle des cordes et des numéros de frettes. La tablature se trouve fréquemment
en combinaison avec la notation de portée traditionnelle.

Types de portées de tablature

Une variété de modèles de tablature pour les instruments courants est fournie. Si ce n'est pas tout à fait ce que vous cherchez, vous pouvez facilement changer le modèle (voir Modifier le type de portée de tablature) et/ou personnaliser la
portée (voir Personnaliser une portée de tablature).

Ajouter une tablature à votre partition

Il y a trois possibilités :

Créer une tablature dans le cadre d'une Nouvelle partition
Ajouter une tablature à une partition existante
Changer une portée existante de standard à tablature.

 Créer une tablature dans le cadre d'une Nouvelle partition

Pour créer une tablature dans le cadre d'une Nouvelle partition :

Ouvrez la fenêtre de dialogue Nouvelle partition
Sélectionnez la tablature requise dans les onglets Choisir les instruments ou Créer à partir d'un modèle
Complétez le reste de la fenêtre de dialogue Nouvelle partition.

 Ajouter une tablature à l'aide de la fenêtre de dialogue "Ajouter ou supprimer des instruments"

Pour créer une portée de tablature dans une partition existante :

Dans le panneau Instruments, cliquez sur le bouton Ajouter ou appuyez sur la touche de raccourci, I. Cela fait apparaître la fenêtre de dialogue Ajouter ou supprimer des instruments
Cliquez sur la Famille Cordes pincées et choisissez la tablature souhaitée dans la colonne Instruments
Cliquer sur le bouton → pour ajouter l'instrument à votre partition (Pour les pros : double-cliquer sur l'instrument a le même résultat).
Appuyez sur OK.

Changer une portée existante de standard à tablature

Assurez-vous que la portée standard contient un instrument à cordes pincées
Utilisez l'une des méthodes décrites sous Changer le type de portée de tablature.

Créer une combinaison de portées standard et tablature

La musique pour la guitare (et d'autres instruments à cordes pincées) est souvent notée à l'aide d'une portée standard et d'une portée de tablature qui sont combinées. Dans MuseScore Studio, les portées peuvent être liées ou non liées.

Liées : toute modification que vous apportez à la notation d'une portée met automatiquement à jour l'autre.

Non liées : chaque portée est éditée indépendamment. Pour mettre à jour les autres portées, copiez et collez la notation musicale appropriée.

Remarque : sans les deux cas, le couple portée/tablature partage le même instrument.

 Créer des portées standard/tablature combinées à l'aide de l'assistant de Nouvelle partition

Il existe deux manières de procéder lors de la création d'une nouvelle partition (A ou B) :

A. Pour les portées liées uniquement :

Ouvrez l'assistant Nouvelle partition
Dans l'onglet "Créer à partir d'un modèle", cliquez sur la Catégorie "Solo" et choisissez l'option "Guitare + Tablature"
Terminez le reste de l'assistant Nouvelle partition
Modifiez le type d'instrument, si nécessaire, dans Propriétés des Portées / Parties.
Modifiez le type de tablature, si nécessaire (voir Changer le type de portée de tablature).

B. Pour les portées liées ou non liées :

Ouvrez l'assistant Nouvelle partition
Dans l'onglet « Choisir des instruments », cliquez sur la Famille « Cordes pincées » et sélectionnez une option de portée dans la colonne « Instruments »
Terminez le reste de l'assistant
Ajoutez la portée souhaitée à l'aide du panneau Instruments.

 Créer des portées standard/tablature combinées à l'aide de la fenêtre de dialogue Instruments
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Utilisez cette méthode lorsque vous souhaitez ajouter une tablature à une partition existante :

Ouvrez la fenêtre de dialogue Ajouter ou supprimer des instruments : appuyez sur I ; ou, alternativement, cliquez sur le bouton Ajouter dans la barre latérale Instruments
Cliquez sur la Famille Cordes pincées et choisissez la portée souhaitée dans la colonne Instruments
Appuyez sur OK
Ajoutez la tablature souhaitée depuis le panneau Instruments.

Remarque : si vous avez déjà une portée d'une combinaison standard/tablature dans votre partition, vous pouvez simplement ajouter la portée manquante depuis le panneau Instruments. Voir Ajouter et configurer des portées.

Saisir et éditer la notation de tablature

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Saisir avec le clavier de l'ordinateur

Dans Mode Normal, sélectionnez une mesure ou une note/silence sur la portée tablature
Basculez vers Mode de saisie de notes : le curseur apparaît sous la forme d'un petit "rectangle bleu" sur la corde actuellement "active"
Sélectionnez la durée (voir ci-dessous) de la note ou du silence à saisir
Appuyez sur les touches fléchées ↑/↓ pour déplacer le curseur entre les cordes. Utilisez les touches fléchées ←/→ pour naviguer dans la partition
Appuyez sur un chiffre de 0 à 9 pour entrer un numéro de frette de 0 à 9 sur la corde actuelle. Pour saisir des numéros à plusieurs chiffres, appuyez sur chaque chiffre dans l'ordre (Remarque : vous ne pouvez pas saisir un nombre
supérieur à la valeur Nombre de frettes définie dans Personnaliser une portée de tablature : Changer le nombre de frettes)
Appuyez sur ; (point-virgule) pour entrer un silence de la durée sélectionnée.
Pour saisir des Fioritures, voir Fioritures
Vous pouvez saisir des notes dans différentes voix si nécessaire, comme vous le feriez dans une portée standard.

Remarque pour la Notation de tablature ancienne : les lettres (majuscule ou minuscule) a à k (en sautant i) peuvent également être utilisées pour saisir les nombres de 0 à 9. Dans la tablature française, les lettres correspondantes
apparaissent à la place ; pour l, m, n, il faut taper respectivement 10, 11, 12.

Voir aussi, Modification de la notation de la tablature (ci-dessous).

Saisir avec la souris de l'ordinateur

Entrez en Mode de saisie de notes et sélectionnez la durée de la note ou du silence (voir ci-dessous)
Cliquez sur une corde et MuseScore Studio affichera un 0 qui signifie "corde à vide" ou "frette zéro" (pour les tablatures françaises, MuseScore Studio affiche un a)
Vous pouvez saisir immédiatement un nombre à un ou deux chiffres pour remplacer le 0 (Remarque : vous ne pouvez pas saisir un nombre supérieur à la valeur "Nombre de frettes" définie dans Personnaliser une portée de tablature :
Changer le nombre de frettes)
Vous pouvez également augmenter/diminuer le numéro de frette en utilisant Alt+Maj+↑ ou Alt+Maj+↓
Vous pouvez saisir des notes dans différentes voix si nécessaire, comme vous le feriez dans une portée standard.

Voir aussi Modification de la notation de la tablature (ci-dessous).

Sélectionner la durée de la note

Que vous utilisiez un clavier ou une souris, vous pouvez définir la durée des notes à l'aide de l'une des options suivantes :

Appuyez sur Maj+1 jusqu'à Maj+8 pour définir la durée d'une quadruple croche à une carrée (la disponibilité de ces raccourcis peut dépendre de la plate-forme et/ou de la disposition du clavier)
Appuyez sur Pavé numérique 1 à 8 pour régler la durée d'une quadruple croche à une carrée (si un pavé numérique existe et "Verr num" est activé)
Cliquez sur l'icône de durée de note souhaitée dans la barre d'outils de saisie de note au-dessus de la fenêtre du document
Appuyez sur q pour diminuer la durée sélectionnée et sur w pour l'augmenter.

Remarque : cela s'applique uniquement au Mode de saisie de notes. Si vous voulez changer la durée d'une note sélectionnée en mode normal voir Modifier la durée en mode normal.

Notation de tablature ancienne

MuseScore Studio prend également en charge la notation tablature pour les instruments d'époque tels que les luths renaissance et baroques, le théorbe, etc. Il existe un certain nombre de systèmes de notation utilisés (français, italien,
allemand, espagnol) mais le plus courant est le français.

La tablature française comporte 6 lignes représentant les 6 chœurs du haut. Au lieu de chiffres, les frettes sont indiquées par des lettres, comme expliqué ci-dessus. Toutes les notes sur les chœurs de basse en dessous de la 6e corde
(frettée ou non frettée) sont représentées par des symboles dans l'espace sous la 6e ligne de tablature.

Pour saisir des symboles sous la 6e ligne :

En mode de saisie de note, déplacez le curseur jusqu'à ce qu'il se trouve dans l'espace sous la 6ème ligne. Appuyez sur ↓ pour déplacer le curseur sur le chœur le plus bas suivant et ainsi de suite. Ce faisant, une "marque de repère"
apparaît à gauche du curseur pour vous indiquer quel parcours est actif :

pas de repère = 7e chœur
/ = 8e chœur
// = 9e chœur
/// = 10e chœur
4 = 11e chœur
5 = 12e chœur
6 = 13e chœur
7 = 14e chœur
8 = 15e chœur.
Inversement, appuyer sur ↑ ramène le curseur au chœur le plus élevé suivant.

Si le chœur est fretté, entrez le numéro de frette souhaité. Si le chœur n'est pas fretté/à vide, appuyez sur "a" (ou, en fait, sur n'importe quelle touche de numéro de frette) et le numéro de frette correct sera ajouté automatiquement.

Modifier la notation de la tablature

Modifier la hauteur

En mode saisie de notes :

Positionnez le curseur sur le numéro de frette et tapez le numéro souhaité
Incrémentez ou décrémentez le numéro de frette en utilisant Alt+Maj+↑ ; ou, Alt+Maj+↓ (le numéro de frette change automatiquement les cordes, si nécessaire, pour atteindre la plus basse position de frette possible).

En mode normal :

Sélectionnez un ou plusieurs numéros de frette
Utilisez l'une des commandes suivantes :

Pour incrémenter ou décrémenter, sans changer la corde : appuyez sur ↑/↓
Pour incrémenter ou décrémenter, en changeant de corde, si possible, pour minimiser le numéro de frette : appuyez sur Alt+Maj+↑/↓.

Remarque : le numéro de frette ne peut pas être supérieur à la valeur "Nombre de frettes" définie dans la boîte de dialogue Personnaliser une portée de tablature : Changer le nombre de frettes.

Déplacer le numéro de frette vers une autre corde

Pour déplacer le numéro de frette sur une corde adjacente sans changer la hauteur :

En mode saisie de notes :

Positionnez le curseur sur un numéro de frette et appuyez sur Ctrl+↑/↓ (Mac : Cmd+↑/↓).

En mode normal :

Utilisez l'une des méthodes suivantes :

Sélectionnez un ou plusieurs numéros de frette et appuyez sur Ctrl+↑/↓ (Mac : Cmd+↑/↓)
Faites glisser un numéro de frette vers le haut ou vers le bas jusqu'à une corde adjacente.

Remarque : cette opération ne peut se poursuivre que si la corde concernée est libre et peut produire cette note.

Modifier la durée

Voir Changer la durée en mode normal.

Notes étouffées (en croix) ou "Ghost notes"

Pour changer un numéro de frette en croix/Ghost note :

Sélectionnez un ou plusieurs numéros de frette (en mode normal)
Appuyez sur Maj+X pour activer/désactiver les têtes de Ghost notes (cela a pour effet de mettre des parenthèses).
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Personnaliser une portée de tablature

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Modifier le réglage d'accord

Faites un clic droit sur la portée et sélectionnez Propriétés de la Portée / Partie
Appuyez sur le bouton Éditer les paramètres des cordes… en bas de la boîte de dialogue. Cela ouvre la boîte de dialogue Paramètres des cordes :

Sous Accord des cordes, cliquez sur une hauteur de corde et sélectionnez Éditer la corde…. Alternativement, double-cliquez simplement sur la hauteur de la corde.
Sélectionnez une nouvelle hauteur dans la boîte de sélection de note et cliquez sur OK. Alternativement, double-cliquez simplement sur la nouvelle Hauteur.
Cliquez sur OK pour fermer la boîte de dialogue "Paramètres des cordes".
Cliquez sur OK pour fermer la boîte de dialogue "Propriétés de la Portée / Partie".

Remarques : (1) Si l'accordage est modifié sur une tablature qui contient déjà des notes, les numéros de frettes seront ajustés automatiquement (si possible). (2) Toute modification de l'accordage d'un instrument particulier s'applique
uniquement à la partition en cours et ne modifie aucun des paramètres par défaut du programme.

Ajouter ou supprimer des cordes

Ajouter une corde

Faites un clic droit sur la portée et sélectionnez Propriétés de la Portée / Partie
Cliquez sur Éditer les paramètres des cordes…
Cliquez sur une hauteur de corde et sélectionnez Nouvelle corde…
Sélectionnez la nouvelle hauteur et appuyez sur OK ; alternativement, il suffit de double-cliquer sur la nouvelle hauteur.

La nouvelle corde est insérée sous la corde sélectionnée. Vous devrez également ajuster le nombre de lignes dans Propriétés de la Portée / Partie → Propriétés avancées de style.

Supprimer une corde

Faites un clic droit sur la portée, sélectionnez Propriétés de la Portée / Partie
Cliquez sur Éditer les paramètres des cordes…
Cliquez sur une Hauteur de corde et appuyez sur Supprimer la corde.

Remarque : après avoir supprimé une corde de tablature, vous devrez également ajuster le nombre de lignes dans Propriétés de la Portée / Partie → Propriétés avancées de style.

Marquer la corde non frettée "à vide"

Pour un instrument comme le luth baroque, cette fonction est utilisée pour marquer une corde de base comme non pincée — par exemple toujours joué à vide comme une corde de harpe. Cela signifie que seule une frette marquée zéro peut
être affichée.

Pour marquer une corde non pincée :

Faites un clic droit sur la portée et sélectionnez Propriétés Portée / Partie
Cliquez sur Éditer les paramètres des cordes…
Cochez les cases requises dans la colonne Corde à vide.

Voir aussi Notation de tablature ancienne.

Changer le nombre de frettes de l'instrument

Cette propriété définit le nombre maximum de frettes pouvant être saisies sur une portée de tablature.

Faites un clic droit sur la portée et sélectionnez Propriétés de la Portée / Partie
Cliquez sur Éditer les paramètres des cordes…
Sélectionnez ou saisissez un nouveau nombre à l'aide de la molette Nombre de frettes.

Modifier le type de portée de tablature

MuseScore Studio fournit une gamme de types de tablature courants. Si vous souhaitez modifier le type de tablature, choisissez l'une des deux options suivantes.

Changer le type de portée depuis le panneau Instruments

Assurez-vous que le panneau Instruments est visible (basculez l'affichage avec F7).

Cliquez sur la flèche à côté du nom de l'instrument pour faire apparaître les portées
Cliquez sur l'icône roue dentée d'édition à côté de la portée souhaitée et choisissez une option dans la liste déroulante Type de portée.
Pour fermer, appuyez sur Échap ou cliquez en dehors de la fenêtre de dialogue.

Modifier le type de portée à partir des propriétés de portée/partie

Faites un clic droit sur une zone vide de la portée et sélectionnez Propriétés de la Portée / Partie.
Cliquez sur Propriétés avancées de style…, sélectionnez l'option souhaitée dans "Modèle" puis appuyez sur < Rétablir par rapport au modèle. Vous pouvez affiner l'affichage si nécessaire en utilisant les onglets Frettes et Valeurs de
notes.
Cliquez deux fois sur OK pour quitter.

Remarque : pour les options de personnalisation en détail, voir Personnalisation de l'apparence de la tablature ci-dessous.

Vous trouverez les termes "simple", "courante" et "complète" dans les noms de type de tablature :

simple : affiche uniquement les numéros de frettes

courante : affiche les numéros de frettes, les silences ; les hampes et les ligatures de notes sont affichées sous la tablature
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complète : affiche les numéros de frettes, les silences; les hampes et les ligatures de notes sont affichées sur la tablature.

Personnaliser l'apparence de la tablature

Propriétés de la portée tablature

Faites un clic droit sur la portée et sélectionnez Propriétés de la Portée / Partie
Cliquez sur Propriétés de style avancées….

Cela vous donne accès à une gamme complète d'options de personnalisation de tablature. Voir Propriétés de la portée : Options pour la portée Tablature.

Tablature staff style

Le paramétrage général est réglé dans Format → Style → Styles des tablatures.

Appliquer un capodastre

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Aperçu

Un capodastre est un dispositif fixé sur un instrument à cordes frettées afin qu'il puisse être joué à une hauteur plus élevée. MuseScore Studio vous permet d'émuler cet effet en ajoutant le texte Capodastre 3 (par exemple) à une portée
d'instrument (ou à des portées). Cela transpose automatiquement la lecture à la hauteur désirée tout en gardant les notes, ou les repères de frette, inchangés. Des capodastres partiels sont également possibles (voir ci-dessous).

Appliquer un capodastre à votre partition

L'élément Capo est disponible dans la palette Guitare, qui est masquée par défaut. Pour faire apparaître cette palette :

Cliquez sur Ajouter des palettes
Cliquez sur le bouton + à côté de Guitare

Pour appliquer un capodastre à une portée :

Cliquez sur la note, ou le silence, où vous souhaitez ajouter une marque de capodastre.
Cliquez sur l'élément Capo dans la Palette de guitare. "Capodastre 1" est affiché par défaut.
Réglez les paramètres dans la boîte de dialogue contextuelle (voir ci-dessous).

Ajuster les paramètres du capodastre

Activer ou désactiver le capodastre

Sélectionnez Avec en haut de la boîte de dialogue pour indiquer qu'un capodastre doit être ajouté à l'instrument.
Sélectionnez Sans pour indiquer que le capodastre doit être retiré de l'instrument et que la lecture doit revenir à la tonalité d'origine.

Régler la position du capodastre

Le numéro de Frette fait référence à la frette où le capodastre doit être appliqué. Par exemple, la frette 1 transpose la tonalité vers le haut d'un demi-ton, la frette 2 d'un ton entier, et ainsi de suite. L'étiquette de texte dans la partition
sera mise à jour automatiquement.

Spécifier le placement d'un capodastre partiel

Les commutateurs de la section Appliquer à vous permettent de spécifier qu'un capodastre ne doit être appliqué qu'à certaines cordes. Lorsqu'au moins l'un d'entre eux est désactivé, le texte de la partition change pour indiquer un
capodastre partiel.

Personnaliser l'apparence du texte du capodastre
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Pour modifier le libellé du texte du capodastre :

Cochez la case Spécifier manuellement le texte d'instruction dans la boîte de dialogue.
Tapez le texte que vous voulez voir apparaître dans la partition.

Pour placer le texte du capodastre sous la portée :

Sous Position, sélectionnez Au-dessous.

Changer le réglage du capodastre en cours de partition

En suivant les étapes ci-dessus, vous pouvez, si vous le souhaitez, modifier le réglage du capodastre à différents endroits de la partition. Chaque instance de capodastre affectera la transposition de toute la musique qui la suit, jusqu'à la
marque de capodastre suivante.

Remarque : il n'est pas possible d'appliquer plus d'un capodastre en même temps. Cette fonctionnalité est prévue pour une version ultérieure.

Bends de guitare

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Cette page décrit les fonctionnalités ajoutées dans MuseScore 4.2. Pour les versions plus anciennes de MuseScore 4, voir Techniques de guitare.
Pour les autres types de bends, voir les bends pour instruments à vent.

Ajouter des bends à votre partition

À partir de MuseScore 4.2, quatre types de bends ("glissés") de guitare peuvent être ajoutés à votre partition :

Bend standard
Pré-bend
Bend de fioriture
Bend léger

Ces bends peuvent être trouvés dans la palette Guitare

Remarques générales sur les bends dans MuseScore Studio

En général, les bends dans MuseScore Studio connectent deux notes ensemble : une ‘note de départ’ et une ‘note d'arrivée’.

Les bends sont contextuels, ce qui signifie que si la note d'arrivée est plus haute que la note de départ, un bend à la hausse sera créé. Inversement, si la note d'arrivé est plus basse que la note de départ, un relâchement sera dessiné.

À chaque fois qu'un bend est ajouté à une partition de tablature, les notes de départ et d'arrivée sont toutes les deux entrées comme positions de frette. La note d'arrivée, cependant, sera masquée par défaut. Cela vous permet de créer des
séquences de bends multiples (comme des combinaisons de bends-relâchement) en n'utilisant que la portée de tablature, sans avoir besoin de saisir des notes dans la portée standard. Si vous travaillez essentiellement dans la portée
standard, vous pourriez trouver plus pratique de masquer ces positions de frette via le réglage Invisible dans le panneau Propriétés.

Dans tous les cas, la valeur de bend, qui est l'intervalle entre les notes de départ et d'arrivée, est reflétée par les hauteurs notées sur la portée standard, ce qui vous permet de voir la forme de la ligne mélodique, affectée par la présence de
notes de bends. Sur la portée de tablature, la valeur de bend est donnée par un chiffre indicateur : "1" pour un ton, "1/2" pour un demi-ton, "1/4" pour un quart de ton, etc.

Appliquer un bend

Pour appliquer n'importe quel type de bend à votre partition, utilisez une des méthodes suivantes :

Sélectionnez une ou plusieurs notes et cliquez sur le symbole de bend désiré dans la palette Guitare
Faites glisser le symbole le symbole depuis la palette Guitare vers une note
Sélectionnez une ou plusieurs notes et tapez le raccourci clavier approprié (voir détails plus bas)

Bend standard

Windows Alt+B | macOS ⌥+B

Un bend standard connecte deux notes ensemble : une ‘note de départ’ et une ‘note d'arrivée’. Les bends standard sont essentiellement utilisés quand on souhaite spécifier clairement le rythme du schéma de bend.

Quand un bend est ajouté à une note, il est automatiquement dessiné jusqu'à la note suivante dans la partition (la note d'arrivée). Si un silence suit la note de départ, MuseScore Studio le remplacera de telle façon que le bend ait une note
d'arrivée à connecter.

Bend de fioriture

Windows Ctrl+Alt+B | macOS ⌘+⌥+B

Les bends de fioriture peut être utilisés pour indiquer les bends qui n'ont pas de durée rythmique définie ; ils sont généralement joués plutôt rapidement avant le battement.

Quand vous appliquez un bend de fioriture à une note, il sera automatiquement saisi avec un pas diatonique plus bas que la note qu'il précède.

Pré-bend

Il n'existe pas de raccourci clavier par défaut : définissez le vôtre dans Préférences.
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Le pré-bend indique une corde qui a fait l'objet d'un bend avant d'être frappée. Sur une portée standard, il est représenté comme une fioriture sans hampe mise entre parenthèses. Sur la portée de tablature, il est illustré avec une flèche droite
plutôt qu'une flèche incurvée.

Bend léger

Il n'existe pas de raccourci clavier par défaut : définissez le vôtre dans Préférences.

Le bend léger est le seul type de bend dans MuseScore Studio qui n'est pas connecté à une note d'arrivée.

Il a toujours une valeur prédéfinie à ¼ de ton et toujours joué à la hausse depuis la note de départ.

Maintien

Un maintien est indiqué par une ligne horizontale sous forme de tirets tracée entre deux bends. Il est uniquement affiché sur la portée de tablature.

Les lignes de maintien sont automatiquement dessinées quand une note de bend est liée par la suite à une ou plusieurs notes.

De plus, vous pouvez afficher ou masquer les lignes de maintien si cela fait sens de le faire.

Sélectionnez un bend dans votre partition
Ouvrez le panneau Propriétés
Sous Ligne de maintien, sélectionnez Afficher ou Masquer pour forcer l'affichage de la ligne en conséquence.

Modifier des bends

On peut ajuster à la fois la valeur d'intervalle et la vitesse de lecture des bends dans MuseScore, soit en modifiant la hauteur des notes de bend dans la portée standard, soit en ajustant la courbe de bend dans le panneau Propriétés.

Modifier un bend dans la portée standard

Pour modifier la valeur d'un bend d'un bend standard, d'un bend de fioriture ou d'un pré-bend dans une portée standard, il suffit simplement de modifier la hauteur de la note de départ et/ou d'arrivée dans votre partition. L'indicateur de
fraction dans toutes les portées de tablature liées sera automatiquement ajusté.

Modifier un bend dans le panneau Propriétés

On peut ajuster à la fois la valeur de bend et sa vitesse de lecture via le panneau Propriétés.

Pour ajuster la valeur de bend :

Appliquez un bend à votre partition en utilisant une des méthodes mentionnées plus haut
Sélectionnez le bend
Ouvrez le panneau Propriétés
Dans le graphique Personnaliser le bend, cliquez et déplacez les extrémités de la courbe vers le haut ou vers le bas

L'extrémité de gauche de la courbe correspond à la note de départ. Celle de droite à la note d'arrivée.

Déplacer l'extrémité droite de la courbe (point final) vers le haut élève la note d'arrivée par paliers de ¼ de ton. De la même façon, déplacer le point final vers le bas baisse la hauteur de la note d'arrivée. L'indicateur de fraction sur la portée
de tablature et la hauteur de note dans la portée standard seront mis à jour en conséquence.

Pour ajuster la vitesse de lecture d'un bend :

Sélectionnez un bend dans votre partition
Ouvrez le panneau Propriétés
Dans le graphique Personnaliser le bend, cliquez et déplacez les points de départ et de fin de la courbe vers la droite ou la gauche
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Déplacer horizontalement un point de la courbe change uniquement sa vitesse de lecture, y compris la durée de maintien des notes de départ et d'arrivée (indiquée par une ligne horizontale). Cela n'affecte pas la notation rythmique dans
votre partition.

Ajouter des bends à des accords

MuseScore Studio rend aussi possible l'application de bends à des accords et la création de bends d'unisson..

Pour appliquer un bend à des accords :

Créez un accord de deux notes ou plus
Sélectionnez les notes auxquelles vous voulez appliquer un bend
Ajoutez le type de bend désiré (voir les étapes plus haut)

Pour créer un bend d'unisson :

Créez un accord contenant deux notes à l'unisson
Sélectionnez les notes auxquelles vous voulez appliquer un bend
Ajoutez le type de bend désiré (voir les étapes plus haut)

Dans le cas des bends d'unisson, il peut être plus facile d'appliquer le bend dans la portée de tablature où il est plus aisé de voir exactement à quelle corde s'applique le bend.

Personnaliser le style des bends

Pour personnaliser l'apparence des bends dans l'ensemble d'une partition :

Cliquez sur Format dans la barre de menu
Sélectionnez Style...
Dans la fenêtre de dialogue qui apparaît, choisissez Bends dans la liste des catégories à gauche

Dans cette fenêtre de dialogue, vous pouvez modifier :

Épaisseur de la ligne : l'épaisseur des lignes de bend à la fois dans les portées standard and tablature
Largeur de la flèche et Hauteur de la flèche : la largeur et la hauteur des têtes de flèche des courbes de bend dans les portées de tablature
Label pour bends complets : choisir entre l'affichage "1" ou le mot "full" pour indiquer un bend d'un ton complet dans la portée de tablature
Numéro de frettes de tablature : cocher la case dans cette section fait apparaître en petits caractères les positions de frette des bends de fioriture dans les portées de tablature (par défaut, les numéros de position de frette pour les
fioritures ont la même taille que pour les autres types de bends).

Réglages alternatifs d'accord des cordes

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Cette page décrit les fonctionnalités ajoutées dans MuseScore 4.2. Pour l'accord des cordes dans les versions plus anciennes de MuseScore 4, voir Personnaliser une portée de tablature.

Appliquer des instructions d'accord des cordes

Pour appliquer une instruction d'accord de cordes dans une portée :

Allez dans la palette Guitare
Cliquez et déplacez l'élément Accord des cordes dans une mesure

Une icône diapason apparaîtra au-dessus de la partition.

De façon alternative, commencez par sélectionner une mesure puis cliquez sur l'élément Accord des cordes dans la palette Guitare.

Les instructions d'accord de cordes sont ajoutés aux mesures et n'ont d'effet que sur la portée à laquelle elles ont été appliquées (ce qui inclut les portées liées). Vous pouvez appliquer des accords de cordes multiples à différentes mesures
de votre partition. Chaque réglage de corde prendra effet depuis la mesure à laquelle il a été ajouté jusqu'à l'élément suivant de réglage de corde.

Spécifier les réglages d'accord de cordes

Une fois que vous avez ajouté un élément accord des cordes à une portée, vous pouvez spécifier le réglage que vous voulez utiliser pour votre instrument.

Sélectionnez l'icône diapason (évoqué dans les étapes précédentes)
Dans l'affichage qui apparaît (widget), choisissez parmi les réglages les plus communs dans le menu déroulant préétabli

L'icône diapason sera remplacée par une instruction textuelle conventionnelle, constituée d'un numéro encerclé pour chacune des cordes de l'instrument et d'un texte montrant la nouvelle hauteur de chaque corde [en notation anglo-saxonne
: A-G].

Vous pouvez personnaliser le texte d'accord et la hauteur désirée pour n'importe quel numéro de corde :

Cliquez sur l'élément d'accord
Dans le widget qui apparaît, basculez l'icône œil en ouvert ou fermé pour montrer ou masquer les cordes de l'instrument
Ajustez la hauteur de chaque corde en utilisant les flèches haut et bas dans les boîtes de texte associées à chaque corde

Notez que les icônes 'œil' montrent ou masquent simplement le texte d'instruction sur la portée. Le véritable accord de chaque corde, dans la mesure où il affecte la lecture et les positions de frettes de tablature (voir davantage d'informations
plus bas), est déterminé par la hauteur indiquée dans le texte attaché à chaque corde – sans tenir compte si l'instruction de réglage d'accord de cette corde est affichée ou cachée dans la partition.

Les réglages d'accord alternatifs affectent les positions de frette

Quand un élément alternatif d'accord est appliqué à une partition, la hauteur spécifiée pour chaque corde sera montrée comme une position à vide ("0") dans la portée tablature.

Pendant la lecture, la hauteur de toutes les positions de frettes le long de chaque corde reste relative à la hauteur de la corde à vide. Par exemple :

Si la 6e corde est accordé à E (Mi), la position à vide sonnera comme un Mi lors de la lecture et la première frette comme un Fa
Si la 6e corde est abaissée à D (Ré), la position libre sonnera comme un Ré pendant la lecture et la première frette comme un Ré dièse.

La notation de n'importe quelle portée liée standard reste non affectée par la présence de réglages d'accord de cordes. Cela permet au joueur de continuer à lire la hauteur de son de chaque corde.

Lire les hauteurs transposées sur la portée standard

Quelques fois, notamment dans les cas où l'ensemble des cordes ont été uniformément réaccordées, il est préférable pour le joueur de lire la notation standard à la hauteur ‘habituelle‘ (par exemple préréglée) plutôt qu'à la hauteur du son.
Afin de réaliser cela, les portées peuvent être transposées.

Faites un clic droit sur une mesure dans la portée standard
Sélectionnez Propriétés de Portée / Parties...
Dans le menu déroulant Transposition, sélectionnez la valeur de transposition souhaitée.

Un exemple classique est de vouloir réaccorder la guitare un demi-ton plus bas sans affecter la notation standard. Pour réaliser cela :

Appliquez un élément de réglage d'accord alternatif à votre portée (voir les étapes plus haut)
Sélectionnez le préréglage Tune down 1/2 step
Si besoin, ajoutez une armure qui correspond à la hauteur de la chanson ou du travail (par exemple : tonalité réelle)
Faites un clic droit sur une mesure et choisissez Propriétés de portée / partie...
Dans le menu déroulant Transposition, sélectionnez 1 – Seconde mineure
Sélectionnez le bouton radio Bas
Enfin, si vous êtes en train d'utiliser une portée de tablature liée et souhaitez que les positions de frettes continuent à afficher le doigté standard, cochez la case Ne pas appliquer la transposition dans les portées de tablature liées
Quand vous êtes prêt, cliquer sur OK.

La portée standard ainsi que toute portée de tablature liée (si applicable) afficheront les positions de frettes et la notation à la hauteur standard pour jouer (puisqu'aucun réglage d'accord alternatif n'a été spécifié). La lecture reflètera
cependant le réglage alternatif.

Basculer sur Tonalité réelle affichera les hauteurs de son affichées sur les portées standard.

[Brouillon seulement : d'avantage de contenu à venir]

Notation spécialisée : Harpe

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page 'Documentation’ du forum .]

Vue d’ensemble

Les harpes ont typiquement sept cordes par octave, avec une corde par hauteur de note, de Do à Si. Les harpes modernes ont aussi sept pédales qui ont chacune trois positions : milieu (naturel/bécarre), relâchée (bémol) et enfoncée
(dièse). Relâcher la pédale à partir de la position moyenne diminue la tension de toutes les cordes de la classe de note dans tous les octaves, diminuant les notes d’un demi-ton ; enfoncer la pédale entraîne l’augmentation d’un demi-ton. Par
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exemple, enfoncer la pédale de Do à la position la plus basse jouera un Do# sur toutes les cordes de Do.

Dans la notation musicale pour les pédales de harpe, des diagrammes ou des repères textuels indiquent quand changer la position des pédales pour modifier les notes jouées.

Ajouter un diagramme de pédales de harpe à votre partition

Depuis MuseScore 4.1 le diagramme de pédales de harpe est disponible dans la palette Harpe.

Pour appliquer un diagramme de pédales de harpe dans une portée :

Cliquez dans la partition à l’endroit où vous voulez insérer le diagramme
Cliquez sur l’élément Diagramme de pédale de harpe dans la palette Harpe
Choisissez le réglage de hauteur des notes dans la fenêtre qui s’affiche.

Les notes qui ne peuvent être jouées avec la pédale sélectionnée apparaîtront en rouge.

La vue diagramme affiche chaque pédale alors que la vue texte ne montre que les notes qui ont besoin d’être changées depuis le dernier repère de pédale.

Par défaut, les diagrammes apparaissent au-dessus des portées et les repères textuels sont affichés entre les deux.

Pour modifier un diagramme, sélectionnez-le pour rouvrir la fenêtre de dialogue.

Lire des diagrammes de pédales de harpe

Diagramme visuel

Le diagramme correspond visuellement aux pédales. Les trois à gauche de la ligne verticale correspondent aux pédales du pied gauche ; les quatre de droite au pied droit. De la gauche vers la droite, les contrôles de pédales sont :

Pied gauche : Ré, Do, Si
Pied droit: Mi, Fa, Sol, La

Une barre sur la ligne indique la position moyenne qui joue une note naturelle (bécarre). Une barre au-dessus de la ligne indique au joueur de lever la pédale, pour bémoliser la note ; une barre au-dessous indique d’enfoncer la pédale pour
obtenir un dièse.

Par exemple, les notes qui peuvent être jouées avec le diagramme indicatif suivant sont Do#, Ré, Mi, Fa#, Sol#, La et Si.

Diagramme textuel

La ligne supérieure des notes (en notation anglo-saxonne : A = La, B = Si, C = Do, etc.) se réfère aux pédales contrôlées par le pied droit et la ligne inférieure correspond aux pédales du pied gauche.

La première instance d’un diagramme textuel de pédales de harpe dans la partition montrera systématiquement les positions des sept pédales. Les repères textuels n’afficheront ensuite que les notes qui ont besoin d’être changées depuis le
précédent repère de pédales.

Les diagrammes textuels s’affichent entre les portées par défaut mais peuvent être repositionnées manuellement.

Notation spécialisée : Percussion

Saisir et modifier la notation des percussions

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Vue d’ensemble

Dans la notation pour percussions, les lignes et interlignes de la portée musicale sont allouées à des instruments différents — plutôt qu’à des hauteurs de note — et on utilise une gamme variée de têtes de notes.

L’exemple ci-dessous montre un exemple de rythme simple de batterie sur une portée de cinq lignes. Par convention, le rythme de grosse caisse est écrit sur le premier interligne (le plus bas de la portée), la caisse claire sur le troisième
interligne et la charleston fermée sur le premier espace au-dessus de la portée :

Les partitions de batterie sont souvent écrites en utilisant deux voix : la voix 1 (avec les hampes vers le haut) pour les instruments jouées avec les mains comme les tambours et les cymbales ; et la voix 2 (avec les hampes vers le bas) pour
les instruments joués avec les pieds, comme la grosse caisse et la pédale de charleston.

Types de portées de percussions

La musique pour percussions est habituellement écrite sur une portée de 5 lignes, 3 lignes ou 1 ligne — en fonction de l’instrument. Quand un instrument est créé en utilisant la fenêtre de dialogue Nouvelle partition, MuseScore Studio choisit
automatiquement le type de portée le plus approprié. Cela peut être changé, si nécessaire, utilisant le menu déroulant "Type de portée" dans le panneau Instruments.

Ajouter une portée de percussion à votre partition

Voir Configurer votre partition et/ou Travailler avec les instruments.

Saisir des notes et des silences dans des portées de percussions

Il y a plusieurs façons de saisir de la musique sur une portée de percussions :

En utilisant la souris et la palette de saisie de batterie
Via des raccourcis clavier
Par l’intermédiaire d’un clavier MIDI externe
Avec le clavier de piano virtuel.

Après la saisie d’une nouvelle note ou silence, le curseur avance automatiquement de façon à être correctement positionné pour la saisie suivante.
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Avec la souris et la palette de saisie de batterie

Sélectionnez un point de départ dans la portée de percussions
Entrez en mode de saisie de notes (raccourci : N). La Palette de saisie de batterie (PSB) apparaît au bas de la fenêtre :

Cela affiche une série d’instruments de percussions et la façon dont ils apparaîtront sur la portée. Pour tout instrument qui a un raccourci clavier, celui-ci est montré au-dessus de la portée.
Cliquez sur un instrument dans la PSB et son nom apparaît sur la partie gauche de la palette. La couleur de la note montre la voix pré-allouée à cette instrument : bleu pour la voix 1 ; vert pour la voix 2.
Utilisez une des méthodes suivantes :

Cliquez sur un instrument dans la PSB, sélectionnez la durée de note souhaitée puis cliquez sur la portée à la position de saisie souhaitée.
Sélectionnez une durée de note puis faites un double clic sur l’instrument souhaité dans la PSB. La note est saisie à la position du curseur.
Remarque : toutes les notes existantes dans cette voix seront écrasées.

Pour saisir un autre instrument dans la même voix à une certaine position, tapez Maj puis faites un double clic sur l’instrument dans la PSB.
Pour saisir un silence dans la durée sélectionnée, tapez 0 (zéro).

Avec des raccourcis clavier

Cette méthode est adaptée à l’ajout d’instruments qui ont un raccourci clavier affiché sur la Palette de saisie de batterie (PSB).

Sélectionnez une note, un silence ou une mesure dans la portée percussion qui servira de point de départ.
Entrez en mode de saisie des notes (raccourci N). La PSB apparaît au bas de la fenêtre (comme ci-dessus).
Choisir une durée de note.
Tapez sur le raccourci clavier correspondant à l’instrument souhaité (il est affiché au-dessus de la portée dans la PSB). La note est saisie à la position du curseur.
Remarque : toutes les notes existantes dans cette voix seront écrasées.
Pour saisir un autre instrument dans la même voix, maintenez appuyée la touche Maj pendant que vous entrez le raccourci.
Pour saisir un silence de la durée sélectionnée, tapez 0 (zéro).

Remarque : les raccourcis peuvent être changés dans la fenêtre de dialogue Éditer le set de batterie.

Par l’intermédiaire d’une interface MIDI

Pour ajouter des notes à une portée de percussions avec un clavier MIDI :

Assurez-vous que le clavier MIDI est connecté à votre ordinateur avant de lancer MuseScore Studio. Vérifier que cela fonctionne correctement.
Remarque : si vous cliquez sur la portée des percussions en mode normal, vous pouvez avoir un aperçu du son des instruments de percussion associés au clavier MIDI.
Cliquez sur la note ou le silence où vous voulez débuter la saisie
Entrez en mode de saisie des notes
Sélectionnez la voix dans laquelle vous souhaitez saisir les notes
Sélectionnez une durée de note
Pressez la touche de l’instrument pour ajouter une note dans la partition. Pour ajouter un autre instrument dans la même voix, maintenez pressée la première touche pendant que vous pressez la seconde touche

Pour saisir un silence de la durée sélectionnée, tapez 0 (zéro).

Remarque : référez-vous à la liste des percussions de la norme GM2 pour obtenir des détails sur la correspondance entre un instrument de percussion et une touche de clavier MIDI (voir https://fr.wikipedia.org/wiki/General_MIDI ).

Avec le clavier de piano virtuel

Pour ajouter les notes sur une portée de percussions à l’aide du clavier de piano virtuel :

Assurez-vous que le clavier de piano virtuel est affiché : tapez P (ou sélectionnez-le depuis le menu Affichage → Clavier de piano)
Remarque : si vous cliquez sur la portée de percussions sans entrer en mode de saisie des notes, vous pouvez avoir une démo des instruments de percussion du clavier de piano virtuel.
Cliquez sur la note ou le silence où vous voulez commencer la saisie
Entrez dans le mode de saisie des notes
Sélectionnez la voix dans laquelle vous voulez entrer les notes
Sélectionnez une durée de note.
Cliquez sur une touche du clavier virtuel pour ajouter une note à la partition. Pour ajouter une autre note à une note existante, tapez et maintenez Maj pendant que vous cliquez sur la nouvelle note.
Pour saisir un silence de la durée sélectionnée, tapez 0 (zéro).

Remarque: référez-vous à la liste des percussions de la norme GM2 pour obtenir des détails sur la correspondance entre un instrument de percussion et une touche de clavier (voir https://fr.wikipedia.org/wiki/General_MIDI ).

Personnaliser le set de batterie

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Introduction

Vous pouvez personnaliser la notation des instruments au sein de l'instrument MuseScore "Set de batterie" en utilisant la fenêtre de dialogue Éditer le set de batterie.
Pour personnaliser la portée de percussion, voir Propriétés des Portées / Parties et les chapitres de la Notation spécialisée : Percussion.

La fenêtre Éditer le set de batterie peut être ouverte en mode de saisie des notes depuis la Palette de saisie de batterie (PSP) en cliquant sur le bouton Éditer le set de batterie (en bas à gauche de la fenêtre). De façon alternative, en
mode normal, faites un clic droit sur la portée de percussions et sélectionnez Éditer le set de batterie...
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La liste des instruments disponibles est affichée à gauche. Vous pouvez la trier par ordre de numéro MIDI en cliquant sur le titre de colonne "N°" ; cliquez de nouveau pour afficher la liste dans l’ordre inverse. Vous pouvez faire de même avec
les autres colonnes ("Note", "Raccourci", "Nom") pour changer l’ordre d’affichage comme souhaité.

Les paramètres disponibles pour l’instrument sélectionné s'affichent à droite : nom, position sur la portée, type de tête de note, voix par défaut, raccourci, direction de la hampe de note…

Toute modification apportée ici sera automatiquement sauvegardée dans le fichier de la partition MuseScore (après validation par OK). Vous pouvez aussi sauvegarder indépendamment ces paramètres dans un fichier séparé.

Personnaliser la définition du set de batterie [projet]

Sélectionner un son

info sur les sons de batterie GM
à quel point cela est pertinent pour les VST ?

Définir la note

Nom

Têtes de note

Autres propriétés

Sauvegarder et charger les définitions du set de batterie [projet]

Autres notations des percussions

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Coups doubles

Le coup double (diddle) peut être ajouté en utilisant un Trémolo croche :

Lignes de pédale

Pour ajouter une ligne de pédale vibraphone, voir Pédale.

Roulements

Pour ajouter un roulement à votre partition, voir Trémolo.

Sticking (doigté de batterie)

Pour entrer des symboles de sticking (R, L) :

Sélectionnez une note de départ
Dans le menu, sélectionnez Ajouter → Texte → Doigté de batterie (de façon alternative, paramétrez un raccourci clavier pour faire de même). Le curseur est positionné pour accepter votre saisie clavier
Saisissez la lettre que vous souhaitez comme vous le feriez avec un texte normal. Pour vous déplacer vers la note précédente ou suivante, voir les commandes de navigation (symboles d’accords).
Pour sortir, tapez Echap. ou cliquez sur un espace vide dans la partition.

Notation alternative

Notation pour musique ancienne et Mensurstrich

Ajouter une indication mesurée à votre partition

Pour appliquer des symboles de notation mesurée  à une partition, vous avez besoin d'ajouter d'abord une indication de mesure conventionnelle puis de modifier son affichage en lui substituant le symbole approprié dans la fenêtre de
dialogue Propriétés de l'indication de mesure. Notez que ces symboles ne sont utilisés que pour l'affichage ; il n'est pas possible de modifier le ratio de durée entre les différentes valeurs de notes et l'indication de mesure sous-jacente n'est
pas modifiée.

Utiliser des symboles de notes mesurées

[à compléter]

Travailler avec une musique non mesurée

La musique ancienne, comme la musique chorale de la renaissance, peut être écrite sans barre de mesure ou indication de mesure. Cela peut être transcrit dans MuseScore Studio comme suit :

Configurez les instruments ou les voix de la partition selon la façon habituelle (voir Configurer votre partition)
Masquez l'indication de mesure
Dans Format → Style → Partition, cochez la case intitulée "Afficher les valeurs de note dépassant la mesure"
Faites un clic droit sur une mesure dans la portée supérieure et sélectionnez Propriétés de la Portée / Partie;
Décochez "Afficher les barres de mesure" ; répétez cela pour chaque portée concernée (voir la remarque)
Cliquez sur OK.

Remarque : à l'étape 4, vous pouvez plutôt rendre invisibles les barres de mesure en les sélectionnant toutes et en tapant V.
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Notez que les mesures actuelles de la partition sont toujours présentes. Les Propriétés de mesure peuvent être éditées si besoin.

Travailler avec une notation Mensurstrich

Mensurstrich est une forme de notation utilisée pour de la musique ancienne dans laquelle les barres de mesures sont tracées entre les portées plutôt qu'à travers elles :

Ajouter des barres de mesure entre des portées

Faites un clic droit sur la portée la plus basse concernée par la notation Mensurstrich et sélectionnez Propriétés de la Portée / Partie. Décochez "Afficher les barres de mesure".
Sélectionnez la première barre de mesure (pas le début) de chacune des portées restantes
Cochez la case "Étendre jusqu'à la portée suivante" dans la section Barre de mesure du panneau Propriétés
Ajustez "Étendre à partir de" pour régler la position du haut de chaque barre de mesure
Cliquez sur Définir comme paramètre de portée par défaut.

Afficher les valeurs de notes dépassant les frontières de mesure

Dans la barre de menu, sélectionnez Format → Style → Partition
Cochez "Afficher les valeurs de note dépassant la mesure".

Notation avec slashs

Dans la musique jazz et populaire, la notation de certains passages utilise des têtes de notes slash qui indique l'absence de tonalité spécifique. La notation peut inclure des hampes pour indiquer des rythmes spécifiques, soit utiliser des
notes sans hampe et indiquer simplement le battement de tempo.

Remplir une sélection avec des slashs rythmiques

Les slashs de battements n'ont pas de hampes et n'indique pas de rythme, uniquement le battement lui-même. En fonction du contexte, cela pourrait indiquer un solo improvisé, une trame d'accompagnement à imaginer par l'interprète, ou
une suggestion pour poursuivre dans le style précédemment écrit pour le passage. Ces slashs sont souvent accompagnés par des symboles d'accords (qui peuvent aussi être ajoutés selon les modalités usuelles).

Pour remplir une sélection de mesures avec des slashs :

Faites une sélection groupée des mesures vides concernées

Dans le menu, sélectionnez Outil → Remplir avec des slashs.

Ces slashs ne sont pas joués mais les symboles d'accord oui.

Créer une notation rythmique avec slashs

Pour noter un rythme spécifique, utilisez la notation rythmique avec slashs. Par défaut, ces slashs ne sont pas joués mais vous pouvez forcer cela si vous voulez saisir des notes spécifiques ou des accords de voix que vous voulez entendre
même s'ils seront transformés en notation de slashs sans tonalité.

Rythmes d'accompagnement sur la portée

Ajoutez les notes dans le rythme souhaité en utilisant la notation standard sur la portée. Si vous souhaitez pouvoir les écouter en lecture, saisissez les notes que vous souhaitez effectivement entendre ; dans le cas contraire, vous
pouvez entrer n'importe quelle hauteur de note.
Effectuez une sélection groupée des accords
Dans la barre de menu, sélectionnez Outils → Activer / Désactiver : Notation rythme avec slash
Si vous voulez entendre jouer les notes que vous avez saisies, sélectionnez le groupe de notes concerné et cochez “Jouer” dans la section Général du panneau Propriétés.

Afficher les rythmes au-dessus ou en dessous de la portée

Pour saisir les rythmes au-dessus de la portée, utilisez la même procédure mais saisissez le rythme en voix 3. Utilisez la voix 4 pour afficher le rythme en dessous de la portée.

Types de portées personnalisées

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Vue d'ensemble

MuseScore Studio déploie quatre types de portées. Chacune d'entre elles dispose de différents modèles prédéfinis : voir Propriétés des Portées / Parties.

Pour créer une portée personnalisée utilisée dans l'ensemble de la partition :

Utilisez cette étape commune aux quatre types de portées : recherchez et ajoutez un instrument utilisant une portée similaire au type de portée cible dans la partie Configurer votre partition ou dans le panneau Instruments puis changez
ses propriétés de portée et propriétés avancées de style où on peut aussi personnaliser le type de tête de notes.
Pour une portée de percussion (type 3, voir Propriétés de Portée / Partie), en complément des actions ci-dessus, utilisez la fenêtre Éditer le set de batterie. Pour le paramétrage des têtes de notes, voir Personnalisation du set de
batterie.

Pour créer une portée personnalisée utilisée dans une section de la partition:

Utilisez les éléments de changement de type de portée
L'élément texte Chg. Instr. modifie aussi le type de portée en changeant d'instrument (voir Changer d'instrument en cours de partition.

Il existe un format communément employé pour les impressions en grand format, appelé Modified Stave Notation (MSN). Pour l'utiliser, voir le tutoriel MuseScore 3 Creating Modified Stave Notation in MuseScore  [en anglais]. La
fonctionnalité est identique dans MuseScore Studio.

Personnaliser l'apparence des lignes de portée

[cette section fait l'objet d'un travail en cours]

Nombre
Couleur
Visibilité
Interligne

Personnaliser l'apparence d'éléments générés

[cette section fait l'objet d'un travail en cours]

Clef
Armure
Indication de tempo
Barres de mesure
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Personnaliser l'apparence des notes

[cette section fait l'objet d'un travail en cours]

Lignes supplémentaires
Hampes

Systèmes et types de têtes de notes

Téléchargez ce fichier de démonstration : MS4 Noteheadschemes.mscz

Le terme 'têtes de notes' est utilisé par les musiciens pour désigner la signification de la forme des têtes de notes. Dans MuseScore Studio, le modèle utilisé pour une portée est désigné sous le terme "Type de tête de note" ; la même option
pour une note est appelée "Système de tête de note". Voir Têtes de notes.

MuseScore Studio comporte neuf types de têtes de notes. Cinq d'entre eux sont directement et pleinement supportés : les notes écrites génèrent une lecture correcte. Quatre "notations à forme géométrique (shape notes) sont supportées en
termes d'impression ; les utilisateurs doivent profiter de la fonctionnalité des instruments transpositeurs pour créer la lecture souhaitée.

Pour créer une notation par forme de note personnalisée, voir Têtes de notes.

Les neufs types supportés par MuseScore Studio sont :

Normal : c'est le type par défaut utilisé par la grande majorité des musiciens.

4 notations de noms de solfège :

Nom de note : les têtes de notes changent de façon automatique pour inclure le nom anglo-saxon de la note dans la tête de note.
Nom de note allemand : similaire à Nom de note mais B est remplacé par H et B♭ par B.
Solmisation Do variable (aussi appelé Tonic Solfa) : les noms de notes sont littéralement écrits dans la tête de note. Il est utilisé Ti et non Si.
Solmisation Do fixe : les noms de notes sont littéralement écrits dans la tête de note. Il est utilisé Si et non Ti.

4 types de notes à formes géométriques (shapes) qui nécessitent une configuration ultérieure pour être correctement joués :

Notation à 4 shapes (Walker) : notation utilisée dans des livres comme Southern Harmony de William Walker’s (1835).
Notation à 7 shapes (Aikin) : notation utilisée dans des livres comme The Christian Minstrel de Jesse B. Aikin’s (1846) et ceux de Ruebush & Kieffer Publishing Company. C'est le système à 7 shapes le plus utilisé.
Notation à 7 shapes (Funk): comme dans Harmonia Sacra de Joseph Funk’s (1851).
Notation à 7 shapes (Walker): comme dans Christian Harmony de William Walker’s (1867).

Modifier le type de portée en cours de partition

Voir la vue d'ensemble

[cette section fait l'objet d'un travail en cours]

La plupart des paramètres ci-dessus ainsi que le décalage des lignes et têtes de notes.

Liens externes

Pour les types de notes :

The Music Notation Project Wiki > Shape Note Notation  [en anglais]
IMSLP.org Wiki > 4-shape notation  [en anglais]
IMSLP.org Wiki > 7-shape notation  [en anglais]
Fenêtre de prévisualisation des propriétés portée/partie de partition  [en anglais]
Shape note SMuFL specification  [en anglais]
Wikipedia > Shape note  [en français]

Texte

Saisir et éditer du texte

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Vue d’ensemble

MuseScore Studio offre différentes fonctionnalités d'édition de texte. Les chapitres de la section Texte du manuel, sont dédiés aux objets Texte Musescore, ceux qui peuvent être individuellement placés sur une partition et ceux qui les
contiennent. Il existe également des paramétrages de partition qui ajoutent automatiquement du texte sur les pages.

Types de texte

Objet Texte Musescore

Un objet Texte Musescore est un objet dans une partition qui contient des caractères individuels qui peuvent être saisis et supprimés en utilisant un clavier d'ordinateur. Il est habituellement attaché à une note ou un silence ; quelques-uns
sont reliés à un autre objet :

le Texte de portée peut être attaché à une portée ;
les Sauts et Repères aux mesures ;
certains types (Titre, Sous-titre, etc.) doivent être reliés à un cadre (voir les chapitres Utiliser des cadres et Blocs de texte).

Les différents types d'objets Texte ne sont pas interchangeables. Ils possèdent des champs de propriétés spécifiques qui affectent la façon de fonctionner de MuseScore. Par exemple, un Texte de portée ressemblant à une indication de
métronome ne pourra jamais modifier le tempo de lecture dans Musescore; c'est un objet d'indication de tempo qui doit être utilisé pour cela.

Pour vérifier le type d'un texte, sélectionnez-le ; son type est affiché dans la barre de statut.
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Utilisez le tableau sous "Types de textes" pour décider quel type utiliser selon vos besoins et suivre les liens vers les pages spécifiques du manuel sur ces objets afin d'en apprendre davantage.

Type d'objet Texte Usage

Texte de portée
Peut être configuré pour appliquer une lecture swing ou comme texte à usage général, pour un instrument
Musescore (voir les chapitres Configurer votre partition et Texte de portée, Texte de système et Texte d'expression.

Texte de système
Fonction similaire au Texte de portée mais pour tous les instruments du système : voir les chapitres Notions de mise
en page et Texte de portée, Texte de système et Texte d'expression.

Texte d'expression
Item expression de la palette Texte. C'est un nouveau type introduit dans MuseScore Studio. Il n'affecte la lecture
que depuis Musescore 4.2 (voir le chapitre Texte de portée, Texte de système et Texte d'expression).

Changement d’instrument
L'item Change instr. de la palette Texte modifie l'instrument Musescore joué après la note ou le silence où il est
ancré. Voir les chapitres Configurer votre partition et Changer d'instrument en cours de partition .

Nuance
Comme p, mf, etc. : ce sont des objets de la palette Nuance qui affectent le volume de lecture de Musescore. Voir le
chapitre Nuances.

Changement graduel de nuance
Comme cresc. et dim. : ce sont des objets de la palette Nuance qui affectent le volume de lecture de Musescore.
Voir le chapitre Marques de crescendo et diminuendo.

Annotation de technique de jeu
Items legato, pizz., etc. de la palette Texte. [Remarque : cette fonction fait l'objet d'une développement actif.
Pour les mises à jour, voir les chapitres Texte de portée, Texte de système et Texte d'expression, Nuances,
Mélangeur, Glossaire et Articulations

Tempo
Indication numérique de métronome et indication verbale de tempo. Ce sont des types de Texte qui spécifient le
tempo de lecture de MuseScore Studio : voir le chapitre Indications de tempo.

Changement graduel de Tempo
Comme accel., un nouveau type de Ligne de texte introduit dans MuseScore Studio qui affecte le tempo de lecture :
voir le chapitre Indications de tempo.

Swing et Straight
items de la palette Tempo qui sont des Textes de système préconfigurés item in the Tempo : voir les chapitres
Lecture du swing et Texte de portée, Texte de système et Texte d'expression.

Paroles
Le raccourci clavier Ctrl+V décompose les mots enregistrés dans le presse-papier le colle et saute de façon adaptée
jusqu'à la prochaine note. Voir le chapitre Paroles.

Saut
Comme "D.C." (Da Capo), "D.S. al Coda", etc. trouvés dans la Palette Reprises et sauts. Voir le chapitre Sauts et
repères.

Alternative de reprise
Comme les symboles Capo, Segno, "Fine", "To Coda", etc. trouvés dans la Palette Reprises et sauts. Voir le
chapitre Sauts et reprises.

Repère
Item encadré B1 de la Palette Texte. Il facilite les reprises, divise la partition en sections, sert de signet sur certains
passages, etc. Voir le chapitre Repères.

Symbole d'accord Il est joué, avec des notes automatiquement créées. Voir le chapitre Symboles d'accord.

Numéro Nashville Il est joué, de façon similaire au symbole d'accord. Voir le chapitre Symboles d'accord : Saisir un numéro Nashville.

Chiffre romain d'analyse Il n'est pas joué. Voir le chapitre Symboles d'accord : Saisir des chiffres romains d’analyse.

Basse chiffrée Notation abrégée pour clavier, non jouée. Voir le chapitre Basse chiffrée.

Sticking
Lettre (L ou R) attachée aux notes (de batterie) montrant quelle main ou pied utiliser. Voir le chapitre Autres notations
des percussions : Sticking.

Doigté Chiffres ou lettres attachées aux notes montrant quel(s) doigt(s) utiliser. Voir le chapitre Doigtés.

Titre, Sous-titre, Compositeur, Parolier et Texte (type de bloc de texte)
Ce sont des types de textes destinés à être utilisés dans un cadre. Voir les chapitres Blocs de texte et Utiliser des
cadres pour ajouter du contenu. Ils sont différents des textes de paramètre utilisés par les hauts et bas de pages :
voir la section "Paramétrages de partition" section.

Ligne de texte de type Alternative de reprise, Pédale, etc.
Les alternatives de reprises sont dans la Palette Reprises et sauts; Pédale dans la palette Clavier; les lignes
d'octave (8--, 8ve, 8va, 15--, etc.) dans la palette Hauteur; les barrés de guitare dans la palette Guitare, etc.. Voir le
chapitre Autres lignes.

Paramétrages de partition

Les noms longs et courts des instruments Musescore (voir le chapitre Configurer votre partition) est automatiquement ajouté à la gauche de la partition dans chaque système (terme de mise en page, voir le chapitre Notions de mise en page).
Les noms peuvent être modifiés directement dans la partition en utilisant le mode édition de texte ou en utilisant la fenêtre Propriétés de Portée / Partie (voir le chapitre Propriétés des Portées / Parties). Ils ne sont, par défaut, ajoutés que
lorsqu'il y a plus d'un instrument. Pour modifier ce comportement par défaut, modifier le paramètre dans Format → Style → Partition.

Les numéros de mesure peuvent être ajoutés automatiquement. Configurez cela dans Format → Style → Numéros de mesures (voir le chapitre Numérotation des mesures).

La fonctionnalité des hauts et bas de pages de MuseScore Studio ajoute automatiquement du texte sur chaque pages. Modifiez cela dans Format → Style → En-tête et Pied de page. Des symboles spéciaux de texte de paramètre peuvent
être utilisés pour ajouter des informations comme le numéro de page actuelle, le texte de copyright, etc. Ils peuvent aussi être aussi utilisés pour ajouter de façon dynamiques des informations via des étiquettes de métadonnées, comme le
nom du fichier de la partition. Voir le chapitre En-tête et pied de page.

Ajouter du texte à une partition

Les différents types d'objets Texte n'étant pas interchangeables, choisissez l'objet adapté avant de l'ajouter. Utilisez le tableau de la section "Objet Texte Musescore" Pour des besoins généraux d'impression ou d'affichage, il est recommandé
d'utiliser un Texte de portée ou un Texte de système.

Les chapitres suivants expliquent comment ajouter du texte à une note ou un silence ou à une ancre valide en dehors des cadres. Ajouter du texte à un cadre est détaillé au chapitre Blocs de texte.

Depuis une palette

Pour ajouter un élément texte à votre partition depuis une palette, vous pouvez : soit sélectionner une ou plusieurs notes/silences et cliquer sur l’objet de palette souhaité ; ou bien déplacer l’objet de la palette vers une note ou un silence. Par
exemple :

Depuis un menu

Si l'objet Texte est associé avec une portée, vous pouvez l'ajouter en sélectionnant une note puis choisir une option texte depuis le menu Ajouter → Texte.

À l’aide d’un raccourci clavier

De nombreux textes peuvent être saisis en utilisant des raccourcis clavier. Vous pouvez voir une liste de ces raccourcis affichés à droite des items dans Ajouter → Texte.
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Pour créer un objet texte, sélectionnez une note puis tapez le raccourci approprié.

Supprimer des objets texte d'une partition

Pour éditer du *texte automatiquement ajouté par les paramètres de partition*, voir la section "Paramétrages de partition".

Pour supprimer un ou plusieurs objets d'une partition, sélectionnez les objets puis tapez Suppr.

Éditer le contenu d'un objet Texte

Pour éditer du *texte automatiquement ajouté par les paramètres de partition*, voir la section "Paramétrages de partition".

Les objets Texte et Ligne de texte sont éditées selon deux méthodes différentes, en fonction du type d'objet :

éditer directement dans le mode d'édition de texte, comme expliqué plus bas, ou
éditer ses propriétés dans le Panneau des propriétés (voir le chapitre spécifique aux objets texte).

Pour entrer en mode édition de texte, utilisez une des méthodes suivantes :

Faites un double clic sur l’objet texte OU
Sélectionnez l’objet texte et tapez Entrée OU
Sélectionnez l’objet texte et tapez F2 ou Alt+Maj+E OU
Faites un clic droit sur l’objet texte et sélectionnez Éditer l’élément.

Vous pouvez maintenant ajouter, éditer et mettre en forme le texte directement dans l’objet texte.

Pour quitter le mode édition de texte, tapez Echap ou bien cliquez sur une zone de la partition située en dehors de la zone d’édition.

Raccourcis clavier disponibles en mode édition de texte

Les raccourcis clavier suivants sont disponibles en mode édition de texte.

Fonction Windows & Linux Mac

Gras (effet bascule) Ctrl+B Cmd+B

Italique (effet bascule) Ctrl+I Cmd+I

Souligné (effet bascule) Ctrl+U Cmd+U

Déplacer le curseur Début, Fin, ←, →, ↑, ↓ (Alt+) ←, →, ↑, ↓

Supprimer un caractère à la gauche du curseur Retour arr. Suppr.

Supprimer un caractère à la droite du curseur Suppr → Suppr or Fn+Suppr

Débuter une nouvelle ligne ↵ Entrée

Insérer un caractère spécial (voir ci-dessous F2 Fn+F2

Caractères spéciaux

On peut accéder à des caractères qui ne sont pas disponibles sur le clavier standard en utilisant la fenêtre Caractères Spéciaux.

Pour ouvrir Caractères spéciaux, passez en mode édition de texte (voir la section "Éditer le contenu d'un objet Texte" section) puis tapez Maj+F2 ou cliquez sur le bouton Insérer des caractères spéciaux dans la section Texte du panneau
Propriétés.

La fenêtre de dialogue est divisée en trois onglets : Symboles communs, Symboles musicaux, et Symboles Unicode. Les onglets symboles musicaux et Unicode sont également subdivisés en catégories (actuellement en anglais pour les
symboles musicaux) rangées par ordre alphabétique. Il est préférable d'utiliser les items de l'onglet Symboles communs car ils sont fonctionnels : voir le chapitre du manuel Musescore 3 Fonts  [en anglais].

Cliquez sur un symbole dans cette fenêtre de dialogue l’ajoute immédiatement au texte à la position du curseur. Plusieurs caractères peuvent être ajoutés sans avoir besoin de fermer la fenêtre de dialogue et l’utilisateur peut également,
pendant qu’elle est ouverte, continuer de taper du texte normalement, supprimer des caractères, saisir des codes numériques, etc.

Dans le mode d'édition de texte, les raccourcis clavier suivants ajoutent une version fonctionnelle des caractères spéciaux (quand c'est possible) dans l'objet Texte courant : voir le chapitre du manuel Musescore 3 Fonts  [en anglais].

Raccourcis pour caractères spéciaux

Caractère Windows & Linux Mac Note

Dièse ♯ Ctrl+Maj+# Cmd+Maj+# Peut ne pas fonctionner avec certains claviers

Bémol ♭ Ctrl+Maj+B Cmd+Maj+B

Bécarre ♮ Ctrl+Maj+H Cmd+Maj+H

Piano p Ctrl+Maj+P Cmd+Maj+P

Forte f Ctrl+Maj+F Cmd+Maj+F

Mezzo m Ctrl+Maj+M Cmd+Maj+M

Rinforzando r Ctrl+Maj+R Cmd+Maj+R

Sforzando s Ctrl+Maj+S Cmd+Maj+S

Niente n Ctrl+Maj+N Cmd+Maj+N

Z z Ctrl+Maj+Z Cmd+Maj+Z

Élision ‿ Ctrl+Alt+- Cmd+Alt+-

Mettre en forme du texte

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Vue d’ensemble

Niveaux de mise en forme

Commencez par lire Modèles et styles pour connaître les deux niveaux principaux de mise en page et de formatage utilisés par MuseScore Studio. Les objets Texte ont des niveaux de paramétrage plus fins :

Niveau 1 : Propriétés de chaque objet Texte individuel dans un fichier de partition :
Formatage des caractères individuels à l'intérieur d'un objet Texte ;
Formatage de l'objet qui contient tous les caractères.

Niveau 2
"Style pour certains types d'objet" : vous pouvez changer leurs paramètres à partir du panneau de gauche de la fenêtre 'Style'
"Style pour le texte contenu par certains types d'objet" : vous pouvez changer leurs paramètres dans les réglages de 'Style de texte' dans le panneau gauche de la fenêtre 'Style'.

Apparence et fonction des objets Texte

Les aspects visuel et fonctionnel de la plupart des objets dans un fichier de partition sont déterminés par :

Les caractères n'ont pas de formatage spécifique. Quand des paramètres leur sont ajoutés, ils sont toujours utilisés. Voir Modifier les caractères plus bas.
Les objets Texte n'ont pas de formatage spécifique. Quand les propriétés sont modifiées dans le panneau Propriétés, elles seront toujours utilisées sauf pour les caractères ayant déjà leur propre formatage. Voir les détails dans
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"Propriétés de texte" plus bas.
En termes de paramétrage fonctionnel, chaque objet dans une partition utilise les valeurs de "style pour certains types d'objet". Ce comportement ne peut pas être changé mais vous pouvez éditer leurs valeurs.
En termes de paramétrage visuel :

un objet dans une partition utilise automatiquement les valeurs définies dans le "style pour le texte contenu par certains types d'objet" approprié, tel que "Style de texte dans un symbole d'accord", "Style de texte dans les
lignes impaires de paroles". Ce comportement peut être changé avec la propriété Plus... > Style de texte dans le panneau Propriétés. Vous pouvez aussi utiliser les 12 styles personnalisés.
Le "style du texte contenu dans le texte de portée" est spécial. Tout objet Texte d'une partition utilise ses valeurs à moins qu'elles aient été écrasées. Ce comportement ne peut pas être changé mais vous pouvez éditer les
valeurs de ce style.

Un sous-ensemble de caractères utilise toujours le paramétrage de police défini dans la fenêtre 'Style' > Partition : la "Police des symboles musicaux" (8 options) avec des symboles comme Segno, Coda, octavas, des symboles de
nuance comme mf et des caractères spéciaux. Voir le manuel Musescore 3 Fonts  [en anglais] (la plupart sont identiques à ceux de MuseScore Studio mais mis à jour et augmentés de 2 options).

Les options du panneau Propriétés se comportent différemment selon la sélection en cours.

"Police", "Style", "Taille", "Indice et exposant" sont à la fois des propriétés d'objet et des options de formatage de caractères individuels. Quand vous modifiez un objet en utilisant le panneau Propriétés, les paramètres incompatibles avec
des caractères individuels sont supprimés.

"Alignement", "Cadre", "Style de texte" sont des propriétés d'objet. Quand vous sélectionnez des caractères individuels et que vous changez ces options dans le panneau Propriétés, les propriétés sont plutôt appliquées à l'objet.

Modifier la mise en forme des caractères

Pour éditer le contenu d'un texte, voir plutôt Saisir et éditer du texte.

Utilisez le panneau Propriétés pour modifier la mise en forme de caractères individuels. MuseScore Studio a mis à jour l'Inspecteur présent dans Musescore 2 et Musescore 3 et intégré la fonction d'édition des textes  dans le panneau
Propriétés.

Entrez en mode édition de texte en utilisant une des méthodes suivantes :
Faites un double clic sur l'objet Texte.
Sélectionnez l'objet et tapez F2 ou Alt+Maj+E
Faites un clic droit sur l'élément et sélectionnez Éditer l'élément.

Mettre en surbrillance les caractères à modifier
Appliquez le formatage dans la section Texte du panneau Propriétés et/ou utilisez des raccourcis clavier (voir Éditer du texte).

Modifier la mise en forme d'un objet Texte

Cliquez sur le bouton Plus... pour voir :

Pour éditer le contenu du texte, voir plutôt Saisir et éditer du texte.

Utilisez le panneau Propriétés pour modifier la mise en forme de l'objet Texte, ce qui peut modifier l'ensemble des caractères qu'il contient :

Sélectionnez le ou les objet(s) Texte
Éditez les paramètres dans la section Texte du panneau Propriétés.

Les options sont suffisamment explicites. Les paramétrages des options spéciales sont affichés après avoir cliqué sur le bouton Plus...:
Faire correspondre la taille des portées : pour que la taille du texte change proportionnellement (voir Notions de mise en page).
Style de texte : modifie le style qu'un objet Texte peut utiliser, voir ci-dessous
Position : au-dessus ou au-dessous la portée, voir plus bas.

Modifier le style utilisé par un objet Texte

Dans le panneau Propriétés, utilisez la propriété Style de texte sous Afficher plus. Le concept de mise en forme est expliqué dans la vue d'ensemble. seul le "style de texte interne d'un certain type d'objet" qu'un objet Texte d'une partition
utilise peut être modifié ; cela inclut les styles personnalisés "Personnalisé-1" ... "Personnalisé-12", voir plus bas. Voir Modèles et styles.

Position

La panneau Propriété est utilisé pour assigner la mise en forme des objets Texte. Quad on objet Texte est modifié, tous les caractères contenu dans cet objet peuvent être modifiés. Le panneau Propriétés est aussi utilisé pour assigner la
mise en forme de caractères individuels dans l'objet Texte, lorsque les caractères sont sélectionnés.

Il est important de noter que, même quand des caractères à l'intérieur d'un objet Texte sont sélectionnés, certaines propriétés affichées dans le panneau Propriétés concernent encore le paramétrage de l'objet Texte et pas les propriétés des
caractères qu'il contient. Cela inclut la propriété Position.

Dans le panneau Propriétés, utilisez le propriétés Position sous Afficher plus pour modifier la mise en page de l'objet Texte. Si une option d'outrepassement existe pour ce type d'objet, elle st dans le "style pour certain type d'objet" mais pas
dans le "style de texte interne à certain type d'objet", voir la section "Modifier les valeurs dans un style" plus bas. Voir aussi la page Modèles et styles.

Modifier les valeurs dans un style

Le concept de formatage est expliqué dans la vue d'ensemble.

Il faut comprendre d'abord les Modèles et styles. Pour modifier les paramètres d'un style, utilisez la fenêtre "Style" du menu Format → Style.

"style pour certains types d'objet" : vous pouvez changer leurs valeurs dans le panneau gauche de la fenêtre 'Style'
"style pour le texte contenu dans certains types d'objet" : vous pouvez modifier leur valeurs dans 'Style de texte' du panneau gauche de la fenêtre 'Style' ou utiliser une méthode plus efficiente à partir du panneau Propriétés :
1. Sélectionner un objet de partition qui utilise le style
2. Éditer une propriété
3. Cliquer sur les points de suspension (…) au-dessus de la propriété et sélectionnez "Style par défaut pour cette partition".
4. Répétez pour les autres propriétés selon besoins.

Modifier les valeurs des styles Personnalisé-1 à Personnalisé-12

Pour assigner des paramètres visuels à un style personnalisé "Personnalisé-1" à "PersonnaliséU-12", utilisez la fenêtre "Style" via le menu Format → Style > Text Style > User-1 ... User-12.

Texte de portée, Texte de système et Texte d'expression

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Vue d’ensemble

Les objets Texte de portée et Texte de système sont utilisés pour les usages indicatifs listés directement ci-dessous. Ils peuvent de façon optionnelle avoir des effets sur la lecture par MuseScore Studio playback : seule la section après la
note ou le silence attaché est affecté. Cela inclut :

L'application de la façon de jouer, swing ou régulier (Texte de portée et Texte de système)
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La réalisation de titres de partitions et de mouvements
La lecture du capodastre pour les guitaristes (Texte de portée pour Musescore 4.0.2 et précédents uniquement ; à partir de la version 4.1.0 de Musescore, voir le nouveau chapitre Appliquer un capodastre)
D'autres usages généraux non couverts par d'autres types de texte uniquement. Les différents types d'objets basés sur du texte ne sont pas interchangeables : voir Types de texte.

Les objets Texte d'expression expriment des expressions musicales et des indications sur la façon de jouer. Ils n'affectent pas la lecture par Musescore Studio. Pour indiquer des nuances et affecter la lecture en même temps, utilisez les
objets Indicateurs de nuance. Pour indiquer et affecter le tempo en même temps, utilisez les Indications de tempo.

Similarités et différences entre Texte de portée et Texte de système

Texte de portée et Texte de système ont des comportements et des fonctions similaires.

Tous les deux se lient à une note ou un silence
Tous les deux peuvent être paramétrés pour avoir des effets sur la lecture audio créée par le synthétiseur de MuseScore Studio ; un Texte de portée n'a d'effet que sur la lecture de l'instrument Musescore auquel appartient la note ; un
Texte de système affecte tous les instruments Musescore d'une partition.
Les Textes de portée sont masqués par l'option "Masquer les portées vides dans une système" (et l'option secondaire "Ne pas masquer les portées vides du 1er système") dans la fenêtre "Style" : "Partition" (voir Modèles et styles).
Un Texte de portée n'apparaît que dans la ou les Partie(s) Musescore qui affiche(nt) l'instrument Musescore. Un Texte de système s'affiche sur toutes les Parties Musescore.
Un nouveau Texte de système est positionné au-dessus de la portée supérieure de chaque système (notion de mise en page).

Ajouter un Texte de portée à votre partition

Sélectionnez une note
Utilisez une des méthodes suivantes :

Tapez Ctrl+T
Dans le menu, sélectionnez Ajouter → Texte → Texte de portée
Cliquez sur l’icône Texte de portée dans la palette Texte

Saisissez le texte souhaité dans le cadre de sélection.

De façon alternative, cliquez et déplacez l’icône Texte de portée vers une note de la partition avant de saisir le texte souhaité.

Ajouter un Texte d’expression à votre partition

Sélectionnez une note
Utilisez une des méthodes suivantes :

Tapez Ctrl+E
Dans le menu, sélectionnez Ajouter → Texte → Texte d’expression
Cliquez sur l’icône Expression dans la palette Texte

Saisissez le texte souhaité dans le cadre de sélection.

De façon alternative, cliquez et déplacez l’icône Expression vers une note de la partition avant de saisir le texte souhaité.

Ajouter un Texte de système à votre partition

Sélectionnez une note
Utilisez une des méthodes suivantes :

Pressez Ctrl+Shift+T
Dans le menu, sélectionnez Ajouter → Texte → Texte de système
Cliquez sur l’icône Texte de système dans la palette Texte

Saisissez le texte souhaité dans le cadre de sélection.

De façon alternative, cliquez et déplacez l’icône Texte de système vers une note de la partition avant de saisir le texte souhaité.

Répéter un Texte de système sur les autres portées

Un nouveau Texte de système est positionné au-dessus de la portée supérieure de chaque système. Si vous souhaitez ajouter une indication similaire sur une portée plus basse, ajoutez-la à cette portée en utilisant un Texte de portée.

Plusieurs modèles ont une fonctionnalité additionnelle. Quand vous créez un Texte de système, il est automatiquement dupliqué et affiché juste au-dessus d'une autre portée inférieure. Si l'instance de l'objet est éditée, le contenu des deux
est mis à jour. Si l'un est supprimé, les deux sont supprimés. Ces modèles sont :

Symphony Orchestra : dupliqué et affiché au-dessus du violon.
Classical Orchestra : dupliqué et affiché au-dessus du violon.
SATB + Piano : dupliqué et affiché au-dessus du piano.
SATB + Organ : dupliqué et affiché au-dessus de l'orgue.
SATB Closed Score + Piano : dupliqué et affiché au-dessus du piano.
SATB Closed Score + Organ : dupliqué et affiché au-dessus de l'orgue.

Propriétés

Éditez les propriétés d'un objet sélectionné Texte de portée, Texte de système ou Texte d'expression d'une partition dans le panneau Propriétés. Les réglages relatifs au texte sont évoqués dans le chapitre Mettre en forme du texte.

Un objet Texte de portée ou Texte de système peut de façon optionnelle avoir des effets sur la lecture ; seule la section après la note ou le silence de rattachement est affectée. Les paramétrages de lecture sont édités dans les fenêtres
"Propriétés de Texte de portée" et "Propriétés de Texte de système". Quand un Texte de portée est dupliqué ou réutilisé via une palette personnalisée, les réglages de lecture sont copiés.

Un Texte d'expression peut être ajouté à une note qui possède déjà un indicateur de nuance qui lui est attaché. Réaliser cela le lie au symbole de nuance. Ce comportement et la propriété Propriétés : Expression : Aligner sur la nuance
sont expliqués dans le chapitre Nuances.

Fenêtre "Propriétés de Texte de portée"

On peut accéder aux propriétés de Texte de portée réglant le capodastre et le swing de la façon suivante :

Faites un clic droit sur l'objet texte
Sélectionnez Propriétés du texte de portée
Choisissez l'un des onglets suivants :

Paramètres du swing
Paramètres de capodastre pour Musescore 4.0.2 et précédents uniquement ; à partir de la version 4.1.0 de Musescore, utilisez à la place le nouveau chapitre Appliquer un capodastre.

Fenêtre "Propriétés de Texte de système"

La fenêtre "Propriété de Texte de système" n'a qu'un onglet qui comporte les paramètres de Swing.

Style

Voir la page Modèles et styles.

Le "Style pour texte au sein d'un Texte de portée" est spécial : voir Mettre en forme du texte.

Les valeurs du "Style de Texte de portée" peuvent être éditées via Format → Style → Texte de portée.
Les valeurs du "Style de Texte d'expression" peuvent être éditées via Format → Style → Texte d'expression
Les valeurs du "Style de texte dans un Texte de portée" peuvent être éditées via Format → Style → Styles de texte → Portée.

Les valeurs du "Style de texte dans un Texte d'expression" peuvent être éditées via Format → Style → Styles de texte → Expression.
Les valeurs du "Style de texte dans un Texte de système" peuvent être éditées via Format → Style → Styles de texte → Système.

Indications de tempo

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Vue d’ensemble

La terminologie musicale du tempo a un rapport avec la cadence ou le rythme d'une composition. Les musiciens utilisent les indications/symboles de tempo pour indiquer le tempo. Les indicateurs de tempo supportés comprennent :
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L'indication de métronome : elle consiste en une note, un signe égal et un nombre entier.  indique 80 blanches par minute.  indique 80 noires par minute.
L'indication littérale de tempo : Andante, Allegro, a tempo, tempo primo, etc.
La ligne de changement de tempo : consiste en un texte et une ligne en tirets. Comprend accel., allarg., rall. et rit.

L'équivalence rythmique (parfois traduite mot à mot de l'anglais en modulation métrique) : 

La cadence du synthétiseur de MuseScore Studio est influencée par deux paramètres :

Le tempo réel, écrit de la partition. Il est uniquement déterminé par l'indicateur de tempo de la partition. Les sauts de section et barres de mesures ne réinitialisent rien. Si aucune indication de tempo n'est présente dans une
partition, elle est jouée comme si on utilisait ♩ = 120 (120 noires en une minute).
Le curseur de contrôle qui change temporairement la cadence, dans un objectif de contrôle. Voir le chapitre Commandes de lecture.

Les musiciens utilisent les indicateurs de tempo pour indiquer la valeur d'un battement mais MuseScore Studio n'utilise pas les informations internes à l'indicateur. Les informations de battement sont uniquement obtenues à partir de
l'indicateur de mesure.

Les indicateurs de tempo sont des objets Texte de Musescore, à l'exception de la ligne de changement de tempo qui fait partie des objets Ligne de Musescore contenant du texte. Voir les chapitres Texte et Autres lignes.

Le panneau des Propriétés et le panneau de Commandes de lecture utilisent une unité spéciale : "BPM". "BPM" correspond au nombre de noires qui auraient pu être jouées en une minute, exprimé en nombre décimal. Il n'est pas relié au
battement de la musique. Il n'a pas de rapport avec le nombre entier conventionnellement utilisé dans les indications de mesure ou sur la partition.

Utiliser des indications de métronome ou des équivalences rythmiques

La lecture suit le contenu écrit par défaut uniquement si des symboles professionnels sont utilisés. L'utilisateur peut aussi utiliser un paramétrage qui les outrepasse.

Utiliser des lignes de changement de tempo

Le tempo est modifié tout au long de la série des notes sur lequel l'objet est ancré : voir le chapitre Autres lignes.

MuseScore Studio ne comprend pas le contenu textuel écrit. Ces objets ont des paramètres prédéfinis de tempo. Dans la palette Tempo de la version beta de Musescore 4.2, par défaut :

accel. accélère graduellement la cadence jusqu'à 133 % du tempo d'origine
allarg. diminue graduellement la cadence jusqu'à 75 % du tempo d'origine. L'italien allargando signifie "élargir"
rall. diminue graduellement la cadence jusqu'à 75 % du tempo d'origine
rit. diminue graduellement la cadence jusqu'à 75 % du tempo d'origine.

Le paramétrage est modifiable : voir la section "Modifier la lecture" section.

Utiliser les indications littérales de tempo

MuseScore Studio ne comprend pas le contenu écrit. Dans la palette Tempo de la version beta de Musescore 4.2, par défaut :

l'objet "a tempo" rétablit le tempo au précédent utilisé avant tout changement par des lignes de changement de tempo
l'objet "tempo primo" rétablit le tempo à la valeur indiquée par la première indication valide
Les autres objets indicateurs de tempo ont un paramétrage prédéfini de tempo.

Tous ces paramètres sont modifiables : voir la section "Modifier la lecture".

Ajouter des indications de tempo à votre partition

Toutes les indications sont trouvées dans la palette Tempo (voir le chapitre Utiliser les palettes).

Les indications de tempo affectent toutes les portées d'une partition.

La nouvelle Ligne de changement de tempo est positionnée en haut d'une portée, comme pour un Texte de portée). Elle n'apparaît que dans la "Partition entière" et dans la "Partie" où apparaît la portée concernée. Toutes les autres
nouvelles indications de tempo sont positionnées en haut d'un système, comme pour un Texte de système. "Système" est un terme relatif à la mise en page : voir le chapitre Concepts de mis en page.

Pour ajouter une indication de métronome, une indication littérale de tempo ou une équivalence rythmique à votre partition, utilisez une des méthodes suivantes :

Sélectionnez une note/un silence et cliquez sur un objet dans la palette
Cliquez/déplacez un objet d’une palette vers une note/un silence
Dans la barre de menu, sélectionnez Ajouter → Texte, et cliquez sur Indication de tempo.
Voir aussi les liens externes pour la méthode alternative utilisant une police tierce.

Pour ajouter une indication de métronome qui utilise une valeur de note appropriée en utilisant l'information de battement de l'indicateur de mesure :

Sélectionnez une note/un silence et tapez le raccourci clavier Alt+Maj+T.

Pour ajouter une ligne de changement de tempo, utilisez les méthodes expliquées dans le chapitre Autres lignes : Ajouter une ligne à la partition :

Soit :
Sélectionnez une note ou un silence pour créer un objet Tempo avec un comportement de "Texte de portée", ou
Sélectionnez une mesure pour créer un objet Tempo avec un comportement de "Texte de système"

Maintenez Maj et cliquez sur la/le dernier élément
Cliquez sur un objet de la palette

Modifier l’apparence

La lecture peut être configurée pour suivre le contenu écrit de l'indication de métronome et l'équivalence rythmique. MuseScore Studio ne comprend que les symboles professionnels de note et note pointée. Ne pas copier ou utiliser
des caractères Unicode à partir d'autres programmes ou Internet. Le point d'augmentation n'est pas un "point final" du clavier de l'ordinateur. .

Les autres caractères et chiffres sont des caractères simples, saisis au clavier d'ordinateur. Ils ont des comportements de mise en forme différents. Par exemple, modifier la Police du panneau Propriétés n'affecte pas les symboles (voir le
chapitre Fonts  du manuel Musescore 3 [en anglais]). Voir aussi le chapitre Saisir et éditer du texte.

Ajouter des caractères simples

Sélectionner un objet
Entrez en mode édition (double clic)
Tapez le texte.

Ajouter des symboles professionnels

Sélectionner un objet
Entrez en mode édition (double clic)
Utilisez la Fenêtre Caractères spéciaux : onglet Symboles communs (une façon de l'ouvrir est de taper Maj+F2)

Lignes de changement de tempo

Les lignes de changement de tempo sont des Lignes Musescore. Pour modifier l'apparence des lignes à tirets, voir les chapitres Autres lignes : Propriétés des lignes et Ajuster directement les éléments : Travailler avec les lignes.

Modifier la lecture

Indication de métronome, équivalence rythmique et indication littérale de tempo

Pour assigner un paramétrage manuel/remplacer le réglage de tempo :

Sélectionner un ou des objets
Ouvrez la palette Propriétés
Sous la section Tempo, A Tempo ou Tempo primo, cliquer pour modifier :

Suivre le tempo écrit : décochez la case pour ignorer le contenu écrit dans la partition
Définir un tempo spécifique : cochez pour ignorer le contenu écrit dans la partition

Saisir une valeur dans Remplacer le tempo écrit (cette valeur utilise l'unité spéciale BPM, voir Vue d'ensemble.

Ligne de changement de tempo
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Pour modifier le réglage manuel de tempo :

Sélectionner un ou des objets
Ouvrez la palette Propriétés
Cliquez sur Lecture et changer les valeurs selon besoins :

Valeur : objectif de tempo en pourcentage du tempo d'origine (100% signifie aucun changement)
Méthodes de lissage : vitesse de changement de tempo change. Les options sont :

Normal : un effet de transition linéaire avec le même taux de changement du début à la fin
Entrée progressive : un effet de transition avec une variation lente du taux de changement au début mais une variation rapide à la fin
Sortie progressive : un effet de transition avec une variation rapide du taux de changement mais une variation lente du taux à la fin.

Les lignes de changement de tempo sont des Lignes Musescore. Pour modifier l'apparence des lignes à tirets, voir les chapitres Autres lignes : Propriétés des lignes et Ajuster directement les éléments : Travailler avec les lignes.

Répéter l’indication de tempo sur les autres portées

La mise en page et le positionnement par défaut d'une indication de tempo dépend de la façon dont elle a été ajoutée : voir la section "Ajouter des indications de tempo à votre partition" section.

Pour les indications qui se comportent comme un "Texte de système" ou une "Ligne de texte de système", il existe une méthode spéciale pour répéter l'objet : voir le chapitre Texte de portée, Texte de système et Texte d'expression : Répéter
un Texte de système sur les autres portées.

Propriétés des indications de tempo

Les indicateurs de tempo sélectionnés dans une partition peuvent être édités avec le panneau Propriétés. Les paramètres ont déjà été évoqué dans les autres sections de cette page. La propriété panneau Propriété : Police affecte les
caractères simples mais pas les symboles professionnels. Les symboles professionnels utilisent "Musical symbols font" : voir la section "Style de tempo". Les réglages relatifs aux textes sont évoqués au chapitre Mettre en forme du texte. Les
réglages relatifs aux lignes sont évoqués dans le chapitre Autres lignes.

Pour éditer les réglages de niveau partition, voir "Style de tempo ".

Style de tempo

Voir la page Modèles et styles

Les valeurs de "Police de symboles musicaux" peuvent être éditées dans Format → Style → Partition
Les valeurs du "Style de texte de tempo" peuvent être éditées via Format → Style → Texte de tempo
Les valeurs du "Style de texte au sein de l'indicateur de tempo" peuvent être éditées via Format → Style → Styles de texte → Tempo
Les valeurs du "Style de texte dans les changements progressifs de tempo" peuvent être éditées via Format → Style → Styles de texte → Changement de tempo progressif.

Les valeurs du "Style de texte pour Métronome" peuvent être éditées dans Format → Style → Styles de texte → Métronome. Aucun objet n'utilise ce profil par défaut ; il a pour objet de donner un style aux indicateurs de tempo qui ont
à la fois une part d'indication littérale et une part d'indicateur de métronome. Souvent, l'indicateur de métronome est en caractère non gras et légèrement plus petit. Source : https://github.com/musescore/MuseScore/
issues/13377#issuecomment-147399…  [en anglais]

Liens externes

indication a tempo github https://github.com/musescore/MuseScore/pull/15563  [en anglais]
créez des indications d'équivalences rythmiques ("modulations métriques") avancées avec la police "Metrico" de Florian Kretlow, PSA: If you want to write complex metric modulations, check out this awesome font Florian Kretlow
made!  [en anglais]

Paroles

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Vue d’ensemble

Les Paroles sont une forme de texte associé à la ligne mélodique sur les portées. Exemple :

Comme vous pouvez le voir dans l’exemple ci-dessus, les paroles sont saisies syllabe par syllabe, celles à l’intérieur des mots étant réunies par des traits d’union. Les lignes de soulignement ou les traits d’union (selon le contexte) sont
utilisés pour indiquer un mélisme, c’est-à-dire une syllabe étendue sur plusieurs notes (voir plus bas).

Les paroles sont organisées en couplets, avec le premier couplet placé en haut et les suivants classés dans l’ordre au-dessous.

Ajouter des paroles à votre partition

Pour pouvoir entrer de nouvelles paroles ou éditer/mettre en forme des paroles existantes, vous devez être en mode paroles.

Il y a deux façons d’entrer en mode paroles :

Commencer à partir d’une note sélectionnée : voir Saisir des syllabes (plus bas)
Commencer à partir d’une syllabe existante : voir Éditer des syllabes existantes (plus bas).

Saisir des syllabes

Sélectionnez la note de départ souhaitée et entrez en mode paroles en tapant le raccourci clavier Ctrl+L (Mac & Linux : Cmd+L) ; cela crée un rectangle de sélection pour la saisie du texte
Tapez la syllabe
Pour saisir la syllabe connectée, tapez - (trait d’union) puis la nouvelle syllabe
Pour aller en avant saisir un nouveau mot (de n’importe quel point de la syllabe), tapez Espace. De façon alternative, et uniquement si vous êtes à la fin d’un mot, tapez → (flèche droite)
Pour entrer un espace insécable, tapez Ctrl+Espace
Pour saisir un mélisme, voir plus bas
Pour vous déplacer vers l’avant ou l’arrière, un caractère à la fois et en sautant entre les syllabes, tapez →/← (flèches droite/gauche)
Pour retourner en arrière d’une syllabe, tapez Maj+Espace.

Saisir un mélisme

Un mélisme est une syllabe qui s’étend sur plus d’une note.
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Si le mélisme est à la fin d’un mot, il doit être noté avec une ligne de soulignement :

En partant de la fin de la syllabe précédente, tapez _ (trait de soulignement) pour chaque note sur laquelle le mélisme s’étend.

Si le mélisme survient au milieu d'un mot, il peut être noté par un trait d'union à la place :

En partant de la fin de la syllabe précédente, tapez - (trait d'union) pour chaque note sur laquelle le mélisme s’étend.
Pour un long mélisme, plutôt que de répéter la frappe de traits d'union, sélectionnez la dernière note incluse dans le mélisme et tapez - (trait d'union). Les traits d'union intermédiaires seront automatiquement insérés entre la précédente
syllabe saisie et cette note finale.

Saisir des couplets multiples

Pour entrer des couplets supplémentaires, répétez les étapes décrites dans Saisir des syllabes. Le point de saisie des paroles commence automatiquement dans l’espace en dessous du dernier couplet saisi.

En mode paroles, vous pouvez vous déplacer vers le haut et vers le bas entre les couplets en utilisant les flèches du clavier ↑ et ↓.

Saisir des paroles attachées à des silences

Par défaut, le curseur saute les silences dans le mode paroles. Cependant, il est possible d’entrer une syllabe sous un silence en sélectionnant le silence puis en en (ré)entrant en mode paroles avant de taper la syllabe. Vous pouvez alors
continuer à saisir les paroles comme ci-dessus.

Utiliser des caractères spéciaux dans les paroles

Les caractères qui ne sont pas disponibles via le clavier de l’ordinateur peuvent être saisis en mode paroles en utilisant la palette Caractères spéciaux.
Un cas spécial est souligné ci-dessous.

Élision

Une élision (liaison lyrique ou synalèphe) est un symbole utilisé pour joindre deux syllabes sous une même note.
Par exemple, pour créer les paroles ci-dessous, commençant avec la syllabe "te" :

Tapez te
Ouvrez la palette Caractères spéciaux
Cliquez sur l’un des symboles d’élision dans l’onglet Symboles communs
Tapez A.

Saisir des caractères réservés

Dans la plupart des cas, les paroles peuvent être éditées comme noté précédemment, des touches comme - (trait d'union) and _ (caractère souligné) ont des significations particulières durant la saisie des paroles. Si vous voulez saisir l'un de
ces caractères en tant que tel, il faut alors taper un modificateur d'échappement (par exemple un raccourci) pour éviter d'enclencher l'effet spécial.:

Caractère Windows macOS/Linux

Espace( ) Ctrl+Espace Alt+Espace

Trait d'union (-) Ctrl+- Alt+-

Souligné (_) Ctrl+Maj+_ Alt+Maj+_

Saut de ligne (↵) Ctrl+Entrée (ou Entrée sur le pavé numérique) Alt+Entrée (ou Entrée sur le pavé numérique)

Éditer des paroles existantes

Pour ajouter des paroles ou modifier celles existantes, cliquez sur une syllabe et utilisez une des méthodes d’édition de texte pour entrer en mode paroles.

Supprimer des paroles

Les paroles sont automatiquement supprimées avec la suppression de leurs notes parentes. Vous pouvez aussi supprimer des paroles en laissant les notes intactes en sélectionnant les paroles et en tapant Suppr..

Saisir les paroles au-dessus de la portée

Si vous voulez positionner les paroles au-dessus plutôt qu’au-dessous la portée :

Dans la barre de menu, sélectionnez Format → Style → Paroles
Paramétrez Position à "Au-dessus".

Vous pouvez bien sûr faire la même chose en sélectionnant toutes les paroles de la partition et en modifiant Position à "Au-dessus" dans la section Texte du panneau Propriétés.

Modifier la numérotation des couplets

Chaque couplet attaché à la portée se voit allouer par MuseScore Studio un numéro de couplet avec le numéro le plus petit pour le couplet du haut et le numéro plus grand pour le couplet du bas. Vous pouvez bien sûr affecter un numéro au
début de chaque couplet mais cela reste une indication visuelle qui n'est pas utilisée pour le tri des couplets.

Pour modifier le numéro de couplet, sélectionnez le couplet et ajustez Affecter au couplet dans la section Paroles du panneau Propriétés. Cela modifie sa place dans la hiérarchie des couplets.

Remarque : assurez-vous d’avoir sélectionné l’ensemble des paroles du couplet à déplacer car la modification du numéro de couplet n’affecte que les syllabes sélectionnées.

Copier des paroles

Copier des paroles dans MuseScore Studio

Les paroles sont automatiquement copiées avec leurs notes parentes mais vous pouvez aussi les copier sans les notes.

Copier vers le même couplet

Sélectionnez une plage ou une liste de syllabes
Réalisez un copier
Sélectionnez une note de destination dans le même couplet
Collez les paroles.

Notez que la plage de destination doit être libre de paroles existantes. Dans le cas contraire, le contenu du presse-papier sera collé en superposition au-dessus de ces paroles.

Copier vers un couplet différent

Sélectionnez une plage ou une liste de syllabes
Réalisez un copier
Assignez les paroles sélectionnées à un nouveau numéro de couplet (voir ci-dessus)
Cliquez sur la première note de la sélection des paroles
Collez. Cela remplacera les paroles déplacées (à l’étape 3).

Remarque : les paroles se collent toujours dans le même couplet que celui où elles ont été copiées.

Copier les paroles vers d’autres programmes

Toutes les paroles attachées à des portées peuvent être copiées dans le presse-papier en utilisant le menu Outils → Copier les paroles dans le presse-papier.

Propriétés des paroles

Voir Modifier la numérotation de couplet des paroles.

Style des paroles

Voir Modèles et styles

Les valeurs du "Style de paroles" peuvent être édités via Format → Style → Paroles.
Les valeurs de "Style de texte dans les lignes impaires de paroles" peuvent être éditées via Format → Style → Styles de texte → Lignes de paroles impaires.
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Les valeurs de "Style de texte dans les lignes paires de paroles" peuvent être éditées via Format → Style → Styles de texte → Lignes de paroles paires.

Texte de paroles

Position / Position au-dessus / Position au-dessous : règle le positionnement par défaut des paroles par rapport à la portée musicale.
Hauteur de ligne : espace entre les lignes de couplets.
Marge du haut Min./Marge du bas Min. : distance au-dessus et au-dessous du bloc paroles par rapport aux portées du dessus et du dessous.
Distance min. : distance minimum entre syllabes. Augmentez ce paramètre si les paroles sont trop serrées.
Aligner les numéros de couplet

Tirets de paroles

Ici vous trouverez un certain nombre de propriétés qui vous autoriseront à contrôler comment les traits d'union entre syllabes sont affichées :

Longueur minimale/maximale du tiret : règlent la longueur minimale et maximale du tiret entre des syllabes.
Distance maximum du tiret : distance maximale autorisée entre tirets. Réduire cette valeur autorise davantage de tirets à se former entre syllabes, lorsque c'est possible, et vice-versa.
Épaisseur du tiret : l'épaisseur (verticale) du tiret.
Espace autour du tiret : la distance entre le - et la syllabe
Ratio de la position Y des tirets : affecte le placement vertical du tiret.
Toujours forcer le trait d'union : cliquez pour garantir qu'un tiret et toujours visible entre syllabes.

Mélisme

Épaisseur du mélisme : l'épaisseur (verticale) du mélisme.
Espace autour du mélisme : la distance entre le mélisme et la syllabe.
Alignement

Doigtés

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Types de doigtés

On trouve des symboles de doigtés pour différents instruments dans la palette Doigtés. Certains d’entre eux sont dupliqués dans la palette Guitare.

Passez la souris au-dessus des symboles pour en afficher les noms.

Les différents types de doigtés sont les suivants :

Doigtés : utilisés en notation pour clavier pour indiquer les doigts des mains gauche et droite. Ils peuvent aussi être utilisés en musique pour guitare pour indiquer le doigté de la main gauche.
Doigtés de guitare Main Gauche : en notation pour guitare, indiquent les doigts de la main gauche (ou celle du côté du manche) : 1=index, 2=majeur, 3=annulaire, 4=auriculaire (petit doigt), 0 (zéro)=corde à vide ; T=pouce. Ils peuvent
aussi être utilisés pour la musique sur clavier.
Doigtés de guitare Main Droite : en notation pour guitare, utilisés pour indiquer les doigts de la main droite (ou celle qui gratte les cordes) avec p=pouce, i=index, m=majeur, a=annulaire, c=auriculaire (petit doigt, quelques fois
également noté e sur certaines partitions).
Numéros de corde (cerclé) : en notation pour guitare, utilisés pour indiquer les cordes (numérotées de haut en bas de 1 à 6) ; 0 (zéro) est utilisé pour une corde à vide.
Autres symboles de doigtés : les doigtés pour le luth peuvent être trouvés en cliquant sur le bouton "Plus" dans la palette Doigtés.

Ajouter un doigté à votre partition

Remarque : si vous voulez que le doigté soit affiché en tablature, faites un clic droit sur la tablature (TAB) et sélectionnez Propriétés de la Portée / Partie … → Propriétés avancées de style… puis cochez la case Afficher les doigtés
dans la tablature.

Ajouter un élément doigté avec une palette

Pour ajouter un doigté à une sélection de notes :

Sélectionnez une ou plusieurs notes
Cliquez sur le symbole désiré dans une palette.

De façon alternative, vous pouvez cliquer/déplacer le symbole de la palette vers une note.

Quand le doigté est ajouté à une note, le focus se déplace immédiatement sur le symbole, ce qui vous permet de l’ajuster dans la foulée.

Ajouter un élément doigté à l’aide d’un raccourci clavier

Sélectionnez la note de départ
Choisissez une des options suivantes :

(pour tout type de doigté) Ajoutez le symbole souhaité depuis une palette (comme illustré ci-dessus)
(pour le type Doigté seulement) Saisissez le raccourci clavier personnalisé pour "Ajouter un doigté" puis tapez le chiffre souhaité.
Remarque : vous pouvez créer ce raccourci via le menu Éditer→Préférences→Raccourcis.

Choisissez une des options suivantes :
pour déplacer le curseur vers la note suivante : Espace ou Alt+→
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pour déplacer le curseur vers la note précédente : Maj+Espace ou Alt+←
Tapez le chiffre souhaité ; un doigté de même type est ajouté comme le doigté original
Répétez les étapes 3 et 4 selon besoin
Pour quitter, tapez Echap. ou cliquez sur un espace vide dans la fenêtre du document.

Ajouter un élément doigté via le menu

Sélectionnez la note de départ
Dans la barre de menu, sélectionnez Ajouter → Texte → Doigté
Tapez le chiffre du doigté de la première note
Appuyez sur Espace pour vous déplacer à la note suivante.
Etc.

Ajuster la position du doigté

Pour éditer la position du doigté, voir Changer la position des éléments.

Quelques symboles de doigtés peuvent être basculés de l’autre côté de la portée en utilisant le raccourci X ou bien avec l’icône Changer de sens de la barre d’outils de saisie des notes.

Modifier l’apparence des éléments de doigté

La mise en forme des éléments de doigté peut être paramétrée dans la section Texte du panneau Propriétés. Pour plus de détails, voir Mettre en forme du texte.

Propriétés des éléments de doigté

Les propriétés générales et de texte pour les doigtés peuvent être éditées dans le panneau Propriétés.

Pour les propriétés Général, voir Réglages généraux.

Pour les propriétés Texte, voir Mettre en forme du texte.

Style des éléments de doigté

Chaque classe d’éléments de doigté a son propre style de texte. Celui-ci peut être consulté et édité via le menu : Format → Style → Styles de texte.

Voir aussi

Sticking (doigtés de batterie)

Symboles d'accord

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Vue d’ensemble

Un symbole d’accord représente, sous forme abrégée, un accord musical et son harmonie.

MuseScore Studio supporte les notations suivantes :

Symbole d’accord : nom alphabétique de l’accord (en notation anglo-saxonne) suivi de sa qualité (Majeur, mineur, etc.) ; exemple : Am,
Système de numérotation de Nashville : chiffre arabe et qualité de l’accord ; exemple : 6m,
Chiffre romain d’analyse : chiffre romain et qualité de l’accord ; exemple : vi.

Ajouter un symbole d’accord dans une partition

Saisir un symbole d’accord

Sélectionnez une note, un slash de battement ou un silence de départ
Tapez Ctrl+K (Mac : Cmd+K). Le curseur est maintenant positionné au-dessus de la portée, prêt pour la saisie
Saisissez le symbole d’accord en utilisant les caractères suivants :

Note fondamentale : a, b, c, d, e, f, g (les minuscules seront automatiquement transformées en majuscules en quittant le mode symbole d’accord)
Dièse : # (hashtag)
Bémol : b ("b" minuscule)
Double dièse : x ("x" minuscule) ou ## (2 hashtags)
Double bémol : bb (2 "b" minuscules)
Bécarre : Ctrl+Maj+H
Espace : Ctrl+Espace (Mac : Alt+Espace)
Pour d’autres symboles, voir Syntaxe des symboles d’accord (plus bas).

Pour déplacer le curseur en avant vers la note/battement/silence, tapez Espace. Pour les autres façons de déplacer le curseur, voir commandes de navigation (plus bas);
Quittez le mode symbole d’accord en tapant Echap.

Nom des accords, altérations et formatage

Après avoir quitté le Mode édition, tout caractère saisi est automatiquement converti au format adéquat. Une fondamentale saisie en minuscule est transformée en majuscule (pour les options alternatives, voir plus bas Mise en majuscule
automatique). Les caractères saisis pour les altérations sont automatiquement convertis en signes typographiques musicaux. Par exemple, un "#" (hashtag) devient automatiquement un signe dièse (♯). Ne saisissez, copiez ni collez aucun
caractère Unicode comme U+266F (signe ♯), ou U+266D (signe ♭) etc. car MuseScore Studio ne les interprèterait pas correctement dans la notation d’accord.

Commandes de navigation

Le tableau suivant est un résumé des raccourcis clavier utilisés pour déplacer le curseur dans le mode de saisie des accords :

Action Raccourci Windows Raccourci macOS

Déplacer le curseur vers la note, le silence ou le battement suivant Espace Espace

Déplacer le curseur vers le battement suivant ; (point virgule) ;

Déplacer le curseur vers la note, le silence ou le battement précédent Maj+Espace

Déplacer le curseur vers le battement précédent : (deux points) :

Déplacer le curseur vers la mesure suivante Ctrl+→ Cmd+→

Déplacer le curseur vers la mesure précédente Ctrl+← Cmd+←

Déplacer le curseur d'un nombre symbolisant la durée Ctrl+1-9 Cmd+1-9

Quitter le mode de saisie des symboles d’accord Echap Echap

Syntaxe des symboles d’accord

MuseScore Studio sait interpréter la plupart des abréviations utilisées dans les symboles d’accord :

Majeur: M, Ma, Maj, ma, maj, Δ (tapez t ou ˆ pour le triangle)
Mineur: m, mi, min, - (signe moins)
Diminué: dim, ° (saisi avec la lettre o en minuscule, affiché comme ° si on utilise le style Jazz ou comme l’omicron grec o dans les autres cas). Note : pour obtenir Dø, tapez "D0", pas "Dm70" ni "Dm0".
Septième mineure et quinte diminuée: ø (saisi avec le nombre 0, affiché comme ø si on utilise le style Jazz style ou comme 0 (zéro) dans les autres cas). De façon alternative, vous pouvez bien sûr choisir des abréviations comme
mi7b5, etc.
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Augmenté: aug, + (signe plus)
Les abréviations suivantes sont également valides : enrichissements et altérations comme b9 ou #5, sus, alt, et no3 ; renversements et basse modifiée (Slash Chord), tels que C7/E ; virgule ; parenthèses (qui peuvent entourer une
partie ou l’ensemble du symbole d’accord).

Éditer un symbole d’accord

Les symboles d'accord sont du texte. Faites un double-clic sur un symbole d'accord pour entrer en mode édition: : voir Éditer du texte. Utilisez les méthodes décrites plus haut pour créer des caractères spéciaux. Après que l'on a quitté le
Mode édition, ils sont automatiquement convertis au format adéquat.

Saisir des chiffres romains d’analyse

À ne pas confondre avec la Basse chiffrée.

Sélectionnez une note de départ
Dans le menu, sélectionnez Ajouter → Texte → Chiffre Romain d’Analyse. De façon alternative, créez un raccourci clavier pour réaliser la même chose dans Préférences
Saisissez les symboles du système d’analyse pour l’accord comme un texte normal, comme suit :

Accord majeur : chiffre romain en majuscule
Accord mineur : chiffre romain en minuscule
Accord diminué : o (en minuscule)
Accord de septième mineure et quinte diminuée : 0 (zéro)
Accord augmenté : +
Renversements d’accord : saisir jusqu’à 3 numéros à un chiffre en commençant par la note supérieure
Altérations : saisir # pour un dièse, b pour un bémol ou h pour un bécarre. Cela sera converti immédiatement dans la bonne notation (en exposant) ♯ , ♭ ou ♮ ; voir la saisie des altérations plus haut
Pour prévenir toute interprétation ou la mise en forme en exposant ou indice, faites précéder le caractère avec une barre oblique inversée (antislash) : "\". Cela peut être utilisé, par exemple, pour ajouter un caractère littéral "b",
"h", un hashtag "#", ou un nombre non mis en exposant, etc.
La notation de renversement utilisant les lettres alphabétiques a, b, c, d peut être créée avec la méthode décrite ci-dessus
La notation de renversement utilisant des chiffres arabes alignés verticalement sans altération comme 64 peut être créée avec la méthode ci-dessous
La notation de renversement utilisant des chiffres arabes alignés verticalement avec altération, comme 6#3, n’est actuellement pas supportée : créer un texte de basse chiffrée à la place ; ou créez des objets texte distincts et
ajustez leur mise en place
Pour les autres symboles, voir les illustrations plus bas.

Déplacez le curseur en avant ou en arrière pour continuer la saisie ou l’édition des symboles pour d’autres accords
Quand l’analyse est terminée, quitter en tapant Echap ou en cliquant dans un espace vide de la partition.

La saisie du système d’analyse par chiffres romains utilise les même raccourcis de navigation que les symboles d’accord (voir plus haut).

Altérations des chiffres romains d'analyse et formatage

À la suite de chaque saisie au clavier d'ordinateur, les caractères sont automatiquement convertis au format correct. MuseScore Studio utilise une police de caractère spécialisée, Campania , pour fournir le formatage correct à l'analyse par
chiffres romains.

Exemples de chiffres romains d'analyse

Saisissez cela :

... pour obtenir :

Saisir un numéro Nashville

Le système de numérotation de Nashville (Nashville Number System, NNS) est une façon abrégée de représenter des accords basée sur les degrés de la gamme plutôt que sur les notes. Cela permet de jouer un accompagnement à l'aide
des mêmes diagrammes d’accord dans n’importe quelle tonalité.

Pour commencer à saisir la notation Nashville :

Sélectionnez une note de départ
Dans le menu, sélectionnez Ajouter → Texte → Numéro Nashville.

Vous pouvez saisir la notation Nashville exactement comme les symboles d'accord standard et MuseScore Studio fera de son mieux pour reconnaître et mettre en forme les symboles de manière appropriée. La saisie en notation Nashville
utilise les même raccourcis de navigation que les symboles d’accord (voir plus haut).

Vue d'ensemble de l'apparence et de la fonction

Voir aussi le chapitre Modèles et styles.

L'apparence et la fonction d'un symbole d'accord, d'un numéro Nashville ou d'une analyse par chiffres romains dans une partition sont déterminée par :

Les propriétés de chaque symbole individuel d'un partition. Par défaut, les objets n'ont pas de propriété spécifique. Quand des propriétés sont paramétrées dans le panneau Propriétés, elles seront toujours utilisées
Les profils globaux (de chaque partie Musescore et de la "partition entière").

Les symboles d'accord, numéros Nashville et chiffres romains d'analyse utilisent des valeurs compatibles correspondantes au "Style de symbole d'accord" défini dans Format → Style → Symboles d'accord. Ce comportement ne
peut pas être changé. Par exemple, les symboles d'accord et numéros Nashville (mais pas les chiffres romains d'analyse) sont affectés par le style d'interprétation Jazz .
Les symboles d'accord, numéros Nashville et chiffres romains d'analyse utilisent par défaut un "style de texte propre" défini dans Format → Style → Styles de texte → Symbole d'accord, Numéro Nashville, Chiffres romains
d'analyse. Ce comportement peut être modifié dans le panneau Propriétés de chaque objet individuel via le bouton Plus... → menu déroulant Style de texte. Par exemple, les symboles d'accord utilisent le style de texte "Symbole
d'accord" mais vous pouvez le changer pour utiliser le style de texte "Symbole d'accord (alternatif)" ou n'importe quel autre profil. Cela autorise deux réglages séparés de format pour éditer de façon plus facile les partitions de
réharmonisation.

Aligner les symboles d’accord

Voir la page Mettre en forme du texte ainsi que la section "Apparence et fonction" plus haut.

Avec le menu Style

"Style pour symboles d'accord"

L’alignement vertical par défaut de tous les symboles d’accord, Nashville et chiffres romains d'analyse est paramétré dans Format → Style → Symboles d’accord : Position.

Distance du diagramme d'accord de guitare : affecte la distance entre les diagrammes de guitare et tout symbole d'accord au-dessus.
Espacement minimum entre les accords : la distance minimum autorisée entre accords.
Distance maximum de la barre de mesure :
Décalage maximum au-dessus/au-dessous : cela est utiliser pour rétablir l'alignement entre symboles d'accord dont l'alignement vertical est irrégulier. Tester jusqu'à obtenir l'apparence souhaitée.

"Style de texte propre à certains objets"

L'alignement par défaut des éléments dépend aussi du profil utilisé. Voir la section "Style de symbole d'accord". Les effets des valeurs dans les profils de style sont cumulatifs.

Utiliser le panneau Propriétés

Pour aligner des éléments :

Sélectionnez les éléments (voir le chapitre Sélectionner des éléments)
Dans le panneau Propriétés, sous la section Texte, modifiez Style de texte (voir la section "Style de texte propre à certains objets" section.
Ajustez Alignement, Position.
Cliquez sur le bouton Apparence et ajustez Décalage. Les effets sont cumulatifs.

Transposer les symboles d’accord
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Instruments transpositeurs

En cochant le mode "Tonalité réelle" dans la fenêtre de la partition, les symboles d'accord des instruments transpositeurs s'ajustent d'eux-mêmes automatiquement. Quand les symboles d'accord sont copiés et collés, ils sont transposés en
conséquence. Voir aussi le chapitre Transposition.

Les accords associés à des diagrammes d’accord de guitare ne sont pas transposés automatiquement : voir le chapitre Diagrammes d'accord de guitare.

Fenêtre de dialogue Transposer

La fenêtre de dialogue transpose tous les éléments sélectionnés sauf Nashville et Chiffres romains d'analyse : voir le chapitre Transposition : Utiliser la fenêtre de dialogue de transposition. Pour désactiver la transposition des symboles
d'accords sélectionnés, décochez Transposer les symboles d’accord.

Autoriser la création automatique de symboles d'accord supplémentaires avec un capodastre (pas Nashville ni chiffres romains)

MuseScore Studio peut être configuré pour créer automatiquement sur la partition un symbole d'accord supplémentaire avec le capodastre, affiché entre parenthèses ou crochets à côté de chaque symbole d'accord (sauf Nashville et Chiffres
romains d'analyse). Le symbole entre parenthèses, quand il est joué avec le capodastre, sonne de façon identique à l'accord sans parenthèse. Pour activer cette fonctionnalité :

Ouvrez Format → Style → Symbole d'accord : Position du capodastre
Assignez la position de capodastre pour le symbole supplémentaire à ajouter. La valeur par défaut 0 ne crée aucun symbole d'accord supplémentaire.

Modifier la notation des symboles d’accord (pas Nashville ni chiffres romains)

Pour les symboles d'accord seulement (pas Nashville ni chiffres romains).

MuseScore Studio utilise par défaut les lettres du système anglo-saxon (A-G) mais vous pouvez modifier le système de notation. MuseScore Studio les met aussi automatiquement en lettres capitales qu'elles soient saisies en capitales ou
minuscules ; vous pouvez changer ce comportement.

Systèmes de notation des accords

Dans le menu principal, choisissez Format → Style → Symboles d’accord puis choisissez l’un des boutons radio suivants dans la section Notation :

Standard : A, B♭, B, C, C♯…
Allemande : A, B♭, H, C, C♯…
Allemande complète : A, B, H, C, Cis…
Solfège : Do, Do♯, Re♭, Re…
Française : Do, Do♯, Ré♭, Ré...

Mise en majuscule automatique

Dans le menu principal, choisissez Format → Style → Symboles d’accord puis choisissez parmi les options suivantes :

Accords mineurs en minuscule : c, cm, cm7,...
Note de basse en minuscule : C/e,... (il s’agit d'une note qui modifie la basse d'un accord Slash)
Tous les noms de notes en majuscule : DO, RE, MI,...

Vous pouvez aussi arrêter complètement la mise en majuscule automatique en décochant la case Majuscules automatiques. Dans ce cas, les noms des notes sont simplement affichés de la façon dont vous les avez saisies.

Modifier l’apparence

*Les images ci-dessous sont les résultats de différents réglages de style de police et de rendu. Dans le troisième exemple, les propriétés de police des éléments individuels sont ignorés car le style de rendu Jazz est utilisé.**

Police

La police (police de caractères, type ou nom de police) ne doit pas être confondue avec le style de rendu. Voir aussi Fonts  dans le Manuel 3 (en anglais).

Pour assigner une police et une mise en forme spécifiques à un symbole individuel d'une partition, utilisez le panneau Propriétés. Pour assigner une police par défaut, utilisez les profils de styles de texte globaux "styles propres à certains
types de texte". Pour les symboles d'accord et numéros Nashville (mais pas chiffres romains d'analyse), la propriété **Police* des objets individuels est ignorée quand le style de rendu Jazz est utilisé.

Style de rendu des symboles d'accord et numéros Nashville (pas des chiffres romains d'analyse)

Le style de rendu ne doit pas être confondu avec l'option police.

Le style de rendu est une fonctionnalité de MuseScore Studio qui utilise un formatage supplémentaire pour améliorer l'impression. Il est défini via le profil de style de texte global "Style de symbole d'accord" (Format → Style → Symboles
d'accord). Tous les symboles d'accord sont affectés par le choix du style de rendu : il n'y a pas d'option de propriété individuelle. Un réglage approprié est utilisé par défaut sur la base du modèle choisi pour créer la partition. Le style de
rendu Jazz est utilisé pour les modèles Jazz, ; pour les autres, c'est le rendu Standard qui est utilisé. Les 3 options disponibles sont :

Standard : les accords sont affichés simplement avec la police, sans formatage supplémentaire.
Jazz : la police MuseJazz est utilisée pour donner un aspect manuscrit, avec des exposants distincts et d'autres caractéristiques de formatage.
Personnalisé : il vous permet de personnaliser l'aspect des symboles d'accord (et aussi d'assurer la compatibilité avec de vieilles partitions) grâce à un fichier de style de symbole d'accord (*.xml) . Ces fichiers peuvent être trouvés
dans le répertoire d'installation "styles". Dans Windows 10, il devrait être C:\Program Files\MuseScore 4\styles\ . La documentation est disponible dans le même répertoire. Cela est réservé aux seuls utilisateurs avancés : voir liens
externes plus bas.

MuseScore Studio utilise la terminologie suivante :

Les parties Enrichissement (extension) et Modificateur (modifier) peuvent être utilisées comme paramètres supplémentaires de mise en page :

Mise à l'échelle de l'enrichissement et Mise à l'échelle du modificateur : ils affectent la taille de l'enrichissement d'accord ou du modificateur.
Décalage vertical de l'enrichissement et Décalage vertical du modificateur : ils affectent la position verticale de l'enrichissement du symbole d'accord ou du modificateur.

Modifier la lecture des symboles d’accord

Activer et désactiver la lecture

Seuls les symboles d'accord et les numéros Nashville peuvent être joués, pas les chiffres romains d'analyse.

Pour désactiver/activer la lecture de ces éléments du programme Musescore :

Cliquez sur l'icône roue dentée à la droite des contrôles de lecture
Désélectionnez/sélectionnez Jouer les symboles d’accord.
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Pour désactiver/activer la lecture des éléments sélectionnés dans la partition :

Désélectionnez/sélectionnez la case Joué dans la section Général du panneau Propriétés.

Personnaliser la lecture

Pour modifier les symboles d'accord sélectionnés, éditez les paramètres dans la section Symbole d’accord du panneau Propriétés. Pour éditer les réglages globaux de tous les symboles d'accord et numéros Nashville (pas les chiffres
romains d'analyse) d'une partition, utilisez Format → Style → Symboles d'accords : section Lecture.

Interprétation : Littéral ou Jazz.
Harmonisation (Voicing) : Automatique, Fondamentale seulement, Toutes les notes, 2ème note une octave au-dessous (_Drop 2)_, Six notes (les plus importantes), Quatre notes (les plus importantes), Trois notes (les plus
importantes). Voir les détails dans le chapitre Lecture : Symboles d'accords / Numéros Nashville  du manuel Musescore 3.
Durée : Jusqu'au symbole d'accord suivant, Jusqu’à la fin de la mesure, Durée de l'accord ou du silence.

Remarque : le symbole triangle Δ crée uniquement une triade majeure dans MuseScore. Pour modifier la qualité des accords à postériori, voir la section "Liens externes".

Générer des accords d’interprétation dans une portée

MuseScore Studio vous permet de générer des notes à partir des symboles d'accord et numéros Nashville sélectionnés (pas chiffres romains d'analyse). L’interprétation de ces accords dépend des options de lecture (ci-dessus) précisées.

Pour générer les notes à partir d’une sélection de symboles d’accords :

Sélectionnez les symboles d’accord
Faites un clic droit sur l’un des symboles de la sélection
Cliquez sur Créer les notes des symboles d’accord
(Optionnel) Cochez Personnaliser les options et paramétrez les options comme souhaité
Cliquez sur OK.

Remarque : Le symbole triangle Δ crée uniquement une triade majeure dans Musescore.

Propriétés des symboles d’accord

Les symboles d'accord d'une partition peuvent être édités avec le panneau Propriétés. Les réglages relatifs au texte sont abordés dans la section Texte. Les réglages relatifs à la lecture sont abordés dans la section Modifier la lecture des
symboles d’accord, plus haut.

Style des symboles d’accord

Voir la page Modèles et styles et la section plus haut Apparence et fonction.

Les paramètres pour le "Style de symbole d'accord" peuvent être édités dans Format → Style → Symboles d'accord.
Les paramètres pour le "Style de texte dans un symbole d'accord" peuvent être édités via Format → Style → Styles de texte → Symbole d'accord.
Les paramètres pour le "Style de texte dans un symbole d'accord (alternatif)" peuvent être édités via Format → Style → Styles de texte → Symbole d'accord (alternatif).
Les paramètres pour le "Style de texte dans un numéro Nashville" peuvent être édités via Format → Style → Styles de texte → Numéro Nashville.
Les paramètres pour le "Style de texte dans un chiffre romain d'analyse" peuvent être édités via Format → Style → Styles de texte → Chiffre romain d'analyse.

Liens externes

Pour modifier la qualité des accords après génération d'accords d’interprétation dans une portée, utilisez un plugin tel que :

Chord Level Selector  (sélecteur de niveau d'accord)
Next inversion  (renversement suivant) : remplace tous les accords d'une sélection (au clavier) avec leur renversement suivant.

Pour identifier l'harmonie d'un accord, utilisez un plugin tel que :

Chord Identifier (Pop and Jazz)  (identificateur d'accord) : pour la musique qui utilise essentiellement du chromatisme harmonique
Chord ID and Roman numeral analysis  (nom d'accord et chiffre romain d'analyse) : pour la musique à tonalité stable.

Fichier de style de symboles d'accord (*.xml) :

chords.xml with sub/superscript and stacked chord alterations  (accords avec indice/ exposant et altérations empilées d'accords) partagé par RunasSudo
github issue Support for chords with stacked extensions #16241  (support pour les accords avec extensions empilées), solution de contournement par MarcSabatella.

Basse chiffrée

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Vue d’ensemble

La basse chiffrée est une notation raccourcie utilisée pour représenter les accords joués sur un instrument continuo (comme un clavier). Elle utilise une série de nombres et d’autres symboles écrits sous les notes de la portée de basse qui
permettent à l’instrumentiste d’improviser pour accompagner la mélodie (technique de la basse continue).

Ajouter une indication de basse figurée à votre partition

Saisir un chiffre

Sélectionnez la note à laquelle la basse figurée s’applique
Tapez sur le raccourci de basse figurée. Le raccourci par défaut est Ctrl+G (Mac : Cmd+G). Il peut être modifié si besoin dans Préférences : Raccourcis
Saisissez le texte dans la "boîte d'édition" qui apparaît.

Format de texte

Afin que les substitutions et les formes de combinaisons adéquates prennent effet et obtenir un bon alignement, le mécanisme de basse figurée a besoin que la saisie de texte suive un certain nombre de règles (qui sont basées, dans tous
les cas, sur les règles syntaxiques de la notation en basse figurée) :

Il ne peut n’y avoir qu’une seule altération (avant ou après) ou qu'un suffixe de combinaison par chiffre
Il ne peut y avoir à la fois une altération et un suffixe de combinaison
Il peut y avoir une altération sans chiffre (tierce altérée) mais pas un suffixe sans chiffre
Aucun autre caractère non listé ci-dessus n’est permis.

Si un texte saisi ne suit pas ces règles, il ne sera pas analysé : il sera stocké et affiché tel quel, sans aucune mise en forme.

Chiffres

Les chiffres sont saisis directement. Des groupes de chiffres empilés l’un sur l’autre sont aussi saisis directement dans un seul texte, en les empilant avec Entrée :

Altérations

Les altérations peuvent être saisies en utilisant les touches de base du clavier :
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Pour saisir : tapez :

Double bémol bb

Bémol b

Bécarre h

Dièse # (hashtag)

Double dièse ## (2 hashtags)

Ces caractères seront automatiquement convertis en signes adéquats dès que vous quitterez l’éditeur. Les altérations peuvent être saisies avant ou après un chiffre (et bien sûr à la place d’un chiffre pour les tierces altérées), en fonction du
style requis. Les deux styles sont alignés de façon adéquate avec l’altération "accrochée" à droite ou à gauche.

Formes combinées

Les chiffres avec barre oblique et les chiffres avec une croix peuvent être saisis en ajoutant \, / ou + après le chiffre (suffixes combinés) ; les formes combinées adéquates seront substituées lors de la sortie de l’éditeur :

La police intégrée peut organiser une équivalence de combinaison en favorisant la substitution la plus courante :

1+, 2+, 3+, 4+ donnent  en notation moderne ou  en version historique

et 5\, 6\, 7\, 8\, 9\ donnent  en notation moderne ou  en version historique.

Il est important de se rappeler que / ne peut être combiné qu’avec le chiffre 5 ; toute autre combinaison avec un slash sera remplacée par un point d’interrogation.

+ peut aussi être utilisé avant un chiffre ; dans ce cas, il ne s’agit pas d’une combinaison mais le signe sera correctement aligné ('+' suspendu du côté gauche).

Parenthèses

Des parenthèses '(', ')' et crochets '[', ']' peuvent être insérés avant et après les altérations, les chiffres ou une ligne de prolongement ; leur ajout ne perturbera pas l’alignement approprié du caractère principal.

Remarques : (1) L'éditeur ne vérifie pas que les parenthèses et crochets, ouverts et fermés, sont correctement équilibrés. (2) L’emploi de plusieurs parenthèses/crochets dans une ligne ne respecte pas la syntaxe et empêche la
reconnaissance correcte du texte saisi. (3) Une parenthèse entre un chiffre et un suffixe combiné ("+", "\", "/") est acceptée, mais empêche la combinaison de forme.

Éditer des indications existantes de basse chiffrée

Pour éditer une indication de basse chiffrée déjà saisie, utilisez une des options suivantes :

Sélectionnez la (ou la note à laquelle elle est rattachée) et tapez le raccourci de Basse chiffrée utilisé pour en créer un nouveau
Faites un double clic sur l’indication.

La boîte d’édition de texte s’ouvre avec le texte converti en caractères de base ('b', '#' et 'h' pour les altérations, suffixes de combinaison séparés, caractères de soulignement, etc.) afin de faciliter l’édition.

Une fois la saisie terminée, tapez sur la touche Espace pour passer à la note suivante ou cliquez en dehors de la boîte d’édition de texte pour la quitter, comme pour une création de nouvelle indication de basse figurée.

Se déplacer entre notes, battements ou mesures

L’indication de basse figurée dure jusqu’à l’indication suivante de basse figurée ou l’atteinte d’une barre de mesure. Ce type de basse figurée peut être saisi de façon consécutive avec le clavier. Pour se déplacer sur un point intermédiaire
ou augmenter la durée d’une indication de basse figurée, voir Fixer la durée.

Tapez Espace pour atteindre la note suivante et saisir la nouvelle indication de basse chiffrée (ou cliquez en dehors de la boîte d’édition pour quitter). L’éditeur avance à la note suivante, ou au silence auquel une indication de basse
figurée est rattachée.

Maj+Espace déplace la boîte d’édition vers la précédente note ou silence de la portée
Tab avance la boîte d’édition au commencement de la mesure suivante
Maj+Tab déplace la boîte d’édition au commencement de la mesure précédente.

Fixer la durée

La durée de chaque indication de basse figurée est indiquée par une ligne grise affichée au-dessus (évidemment, cette ligne n’est qu’indicative et n’est pas imprimée ou exportée en PDF).
Au départ, une indication de basse chiffrée a la même durée que la note à laquelle elle est attachée. Une durée différente peut être requise pour associer plusieurs indications à une seule note ou pour étendre une indication à plusieurs
notes. Pour ce faire, chaque combinaison de touches du tableau ci-dessous peut être utilisée pour (1) avancer la boîte d’édition de la durée indiquée et (2) régler la durée de l'indication précédente jusqu’à la nouvelle position de la boîte de
saisie.
En appuyant consécutivement sur plusieurs d'entre elles sans saisir de chiffre, on prolonge d’autant la durée de l'indication précédente.

Tapez : pour la durée :

Ctrl+1 quadruple croche

Ctrl+2 triple croche

Ctrl+3 double croche

Ctrl+4 croche

Ctrl+5 noire

Ctrl+6 blanche

Ctrl+7 ronde

Ctrl+8 carrée

(Les chiffres sont les mêmes que ceux utilisés pour régler la durée d’une note)

Le réglage de la durée exacte d’une indication de basse chiffrée n’est obligatoire que dans deux cas :
1. Lorsque plusieurs indications sont réunies sous une seule note de la portée (il n'y a pas d'autre moyen)
2. Lorsque des lignes de prolongement sont utilisées car leur longueur dépend de la durée de l'indication.

Cependant, il est de bonne pratique de toujours fixer la durée à la valeur prévue pour les besoins des plugins et de MusicXML.

Saisir des lignes de prolongement

Les lignes de prolongement sont saisies en ajoutant un '' (_caractère de soulignement) à la fin de chaque ligne de texte. Chaque chiffre d’une indication peut avoir sa propre ligne de prolongement :

Les lignes de prolongement sont affichées sur la durée totale de l’indication de basse figurée.
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Lignes de prolongement 'étendues'

De façon occasionnelle, une ligne de prolongement doit être connectée à la ligne de prolongement de l'indication de basse continue suivante alors qu'un autre degré d’accord est poursuivi à travers deux indications. Exemples (les deux sont
extraits de J. Boismortier, _Pièces de viole, op. 31, Paris 1730_) :

Dans le premier cas, chaque indication a sa propre ligne de prolongement ; dans le second, la ligne de prolongement se poursuit ‘pendant’ le second.

Cela peut être obtenu en tapant plusieurs caractères de soulignement '__' (deux ou davantage) à la fin de la ligne de texte du premier groupe.

Propriétés des indications de basse chiffrée

La mise en forme des symboles de basse figurée est réalisée automatiquement par le programme, basé sur le paramétrage de style (voir ci-dessous). Seules les propriétés Général et Apparence peuvent être ajustées via le panneau
Propriétés.

Style des indications de basse chiffrée

Les propriétés de tous les symboles de basse chiffrée de la partition peuvent être paramétrées via Format → Style → Basse chiffrée.

Police : c’est la police MuseScore Figured Bass qui est spécialement dessinée pour construire la notation en basse chiffrée
Taille : taille de la police en points
Position verticale : distance (en sp.) entre le haut de la portée et le sommet du texte de basse chiffrée. Des valeurs négatives font monter l'indication (au-dessus de la portée) et, des valeurs positives la font descendre (au-dessous de
la portée : une valeur supérieure à 4 est nécessaire pour enjamber la portée elle-même)

Hauteur de la ligne : distance entre chaque ligne de base d’indication de basse figurée, exprimée en pourcentage de taille de police.

L’image suivante illustre chaque paramètre numérique :

Alignement : sélectionne l’alignement vertical. Avec Haut, le haut de la ligne de chaque indication est aligné avec la position verticale principale et l’indication est ‘accrochée’ à celui-ci (c’est le réglage par défaut, normalement utilisé
pour la notation en basse chiffrée) ; avec Bas, le bas de chaque indication est aligné avec la position verticale principale et l’indication est ‘posée’ sur celui-ci (cela est parfois utilisé dans certains types de notations d'analyse
harmonique) :

Style : choix entre Moderne et Historique. La différence entre les styles sont illustrées ci-dessous :

Raccourcis clavier de basse chiffrée

Tapez : pour :

Ctrl+G Ajouter une nouvelle indication de basse chiffrée à la note sélectionnée

Espace Avancer la boîte d’édition à la note suivante

Maj+Espace Déplacer la boîte d’édition à la note précédente

Tab Avancer la boîte d’édition à la mesure suivante

Maj+Tab Déplacer la boîte d’édition à la mesure précédente

Ctrl+1 Avancer la boîte d’édition de la durée d’une quadruple croche, fixant la durée de l’indication précédente

Ctrl+2 Avancer la boîte d’édition de la durée d’une triple croche, fixant la durée de l’indication précédente

Ctrl+3 Avancer la boîte d’édition de la durée d’une double croche, fixant la durée de l’indication précédente

Ctrl+4 Avancer la boîte d’édition de la durée d’une croche, fixant la durée de l’indication précédente

Ctrl+5 Avancer la boîte d’édition de la durée d’une noire, fixant la durée de l’indication précédente

Ctrl+6 Avancer la boîte d’édition de la durée d’une blanche, fixant la durée de l’indication précédente

Ctrl+7 Avancer la boîte d’édition de la durée d’une ronde, fixant la durée de l’indication précédente

Ctrl+8 Avancer la boîte d’édition de la durée d’une carrée, fixant la durée de l’indication précédente

Ctrl+Espace Saisir un espace effectif ; utile quand le chiffre apparaît "sur la deuxième ligne" (exemple : 5 4 -> 3)

BB Saisir un double bémol

B Saisir un bémol

H Saisir un bécarre

# Saisir un dièse

## Saisir un double dièse

_ Saisir une ligne de prolongement

__ Saisir une ligne de prolongement étendue

Remarque : pour les Mac, Ctrl est remplacé par Cmd.

Repères

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Vue d’ensemble

Les Repères (quelquefois appelés lettres repères) peuvent être utilisés de différentes manières. Par exemple :

Pour identifier des points spécifiques dans une partition afin de faciliter les répétitions
Comme un marque-page vers lequel vous pouvez instantanément naviguer — en utilisant la commande Chercher / Aller à
Pour marquer les différentes sections de la partition.

Les repères sont un type de texte de système. Dans une partition complète, ils ne sont affichés qu’au-dessus de la portée supérieure d’un système, mais ils apparaissent dans toutes les parties d’instruments.
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Des repères peuvent être ajoutés dans la partition de deux façons : (1) manuellement, vous permettant de les nommer comme vous le souhaitez ou (2) automatiquement, ce qui assure qu’ils seront énumérés dans l’ordre.

Ajouter un repère à votre partition

Placer et nommer un repère de façon manuelle

Pour créer un repère manuellement et lui attribuer un nom de votre choix :

Cliquez sur une note (ou silence) à la position souhaitée
Utilisez l’une des options suivantes :

Tapez Ctrl+M (Mac : Cmd+M)
Dans le menu, choisissez Ajouter → Texte → Repère

Saisissez le texte souhaité.

Placer et nommer un repère automatique

MuseScore Studio peut nommer les Repères automatiquement. Vous pouvez, au choix :

Cliquer sur une note (ou silence) à la position souhaitée puis cliquer sur l'icône [B1] dans la palette Texte
Cliquer/déplacer cet icône de la palette Texte vers la partition.

Remarques :
(1) Par défaut, les repères sont ajoutés dans l’ordre A, B, C, etc.
(2) Pour changer le format des repères consécutivement ajoutés (pour mettre la lettre en minuscule ou utiliser des nombres), éditez le repère précédent en conséquence.
(3) Les repères ajoutés entre des repères existants adoptent une lettre ou un nombre du précédent repère : il est recommandé d’utiliser la commande Remettre les repères dans l’ordre à postériori (voir plus bas).

Utiliser des numéros de mesure dans les repères

Si vous voulez que les repères soient affichés comme des numéros de mesure :

Ajoutez le premier repère puis éditez le pour lui afficher le même numéro que la mesure à laquelle il est attaché
Ajoutez les repères suivants comme indiqué dans Placer et nommer un repère automatique (plus haut). Ils adopteront automatiquement le format nombre de mesure.

Remettre les repères dans l’ordre

MuseScore Studio permet à l’utilisateur de remettre automatiquement dans l’ordre une série de repères s’ils sont sortis de l’ordre logique pour n’importe quelle raison. Utilisez une des méthodes suivantes :

Avant de faire une sélection, vous pouvez si besoin établir un nouveau format pour les repères (lettre majuscule/minuscule, chiffre ou numéro de mesure) en modifiant manuellement le premier repère de la plage en conséquence
Sélectionnez la plage des mesures auxquelles vous voulez appliquer la commande Remettre les repères dans l’ordre (s’il n’y a pas de sélection, le programme considèrera que vous souhaitez remettre dans l’ordre l'ensemble des
repères de toutes les mesures).
Dans le menu, sélectionnez Outils → Remettre les repères dans l’ordre.

MuseScore Studio détecte automatiquement l’ordre basé sur le premier repère de la sélection — tous les repères de la sélection seront modifiés en conséquence. Les séquences suivantes sont possibles :

A, B, C, etc.
a, b, c, etc.
Chiffres 1, 2, 3, etc.
Chiffres en accord avec les numéros de mesure.

Rechercher des repères

Voir Chercher / Aller à (Naviguer dans votre partition).

Répéter les repères dans les autres portées

Dans la plupart des partitions, les repères sont affichés uniquement au-dessus de la portée supérieure d’un système mais apparaissent dans toutes les parties générées d’instruments. Si une copie du repère est souhaitée sur des portées
inférieures, vous pouvez l’ajouter comme texte de portée.

Plusieurs modèles ont une fonctionnalité supplémentaire comme, par exemple Symphony Orchestra ou Classical Orchestra (voir la liste des modèles dans le chapitre Texte de portée et texte de système). Dans une nouvelle partition créée en
utilisant n'importe lequel de ces deux modèles, quand vous créez un repère au-dessus de la portée supérieure, un repère identique est automatiquement ajouté au-dessus de la section des instruments à cordes. Si l’un des repères est
modifié, les deux sont mis à jour. Si l'un des repères est supprimé, les deux sont supprimés.

Modifier l’apparence des repères

Par défaut, les repères apparaissent en police de caractères gras, entourés d’un cadre et alignés au centre de la première barre de la mesure. Vous pouvez éditer les propriétés de texte par défaut via le menu Format → Style → Styles
de Texte .

Propriétés des repères

Les propriétés des repères sélectionnés peuvent être modifiés dans le panneau Propriétés.

Style des repères

Voir Modèles et styles.

Les valeurs du "Style de Repères" peuvent être éditées dans Format → Style → Repères.
Les valeurs du "Style de texte interne au Repère" peuvent être éditées dans Format → Style → Styles de texte → Repère .

Liens externes

Rehearsal letter  (article Wikipedia en anglais)

En-tête et pied de page

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Vue d’ensemble

Les en-tête et pied de page sont des textes automatiquement ajoutés en haut et bas de chaque page. Pour ajouter du texte limité à certaine(s) page(s), utilisez à la place des objets cadre et texte de MuseScore Studio : voir le chapitre Saisir
et éditer du texte.

Ajouter un en-tête ou un pied de page dans votre partition
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Depuis le menu principal, sélectionnez Format → Style → En-tête, Pied de page
Cochez les cases Texte d’en-tête et/ou Texte de pied de page comme requis.

Note : pour créer une en-tête ou un bas de page pour une Partie, ouvrez et affichez d'abord cette page.

Saisir les informations

Depuis le menu principal, sélectionnez Format → Style → En-tête, Pied de page :
La zone du haut correspond aux en-têtes, celle du bas aux bas de pages
Chacune des deux est divisée en deux lignes nommées Pair et Impair pour le contenu des pages impaires et paires respectivement
Elles sont aussi divisées en trois colonnes nommées Gauche, Centre et Droite qui représentent les zones correspondantes

Trois types de données valides peuvent y être saisies :
Texte simple
Texte de paramètre ou symboles spéciaux qui sont convertis automatiquement en informations ; ils comprennent :

des informations en lecture seule telles que le numéro de page courant et
des métadonnées éditables : voir la section "Utiliser les métadonnées".

Les textes de paramètre et symboles spéciaux sont sensibles à la casse ; ils doivent être saisis lettre par lettre avec la bonne casse. Par exemple :
$d est converti dans la date en cours
$D est converti dans la date de création
$:movementNumber: affiche la métadonnée "Numéro de mouvement"
$:movementnumber: est invalide car il comporte par erreur la lettre 'n' en minuscule

Pour voir une liste des textes disponibles de paramètres ou de symboles spéciaux, laissez le curseur de la souris au-dessus de n'importe quelle zone de saisie de texte et attendez qu'une fenêtre bondissante (popup) apparaisse. La
liste affichée ci-dessous correspond à la version Musescore 4.2.

Utiliser des métadonnées

Les métadonnées sont des étiquettes informatiques qui contiennent des informations assignées dans __Fichier → Propriétés de partition___. Utilisez la syntaxe $:[étiquette de métadonnée]: pour les ajouter aux en-têtes ou bas de pages. Voir
l'exemple dans la section "Saisir les informations" et dans la page Propriétés des partitions.

Modifier l'apparence des en-têtes et pieds de pages
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Dans le menu principal, sélectionnez Format → Style→ En-tête et pied de page :
Afficher sur la première page : autorise l’affichage de l’en-tête/pied de page sur la page 1
Pages impaires / paires différentes : utilise des contenus différents sur les pages paires et impaires.

Les en-têtes et bas de pages respectent les marges de page configurées dans Format → Paramètres de la page (voir le chapitre Taille et espacement de la partition). Les marges de page étant toujours laissées vides, MuseScore Studio
redéfinit la zone des portées pour afficher le contenu des en-têtes et pieds de page. Une marge additionnelle peut être obtenue en ajustant les réglages Décalage dans les profils de style. Des options de police sont aussi disponibles : voir la
section "Style des en-têtes et pieds de pages".

Propriétés des en-têtes et pieds de pages

Les en-têtes et bas de page n'étant pas des objets Texte, il n'est pas possible de sélectionner et d'utiliser le panneau Propriétés pour modifier de façon séparée les propriétés d'une en-tête ou d'un bas de page sur une page particulière.
Modifiez les valeurs de tous les en-têtes et bas de pages dans les profils de style : voir la section "Style des en-têtes et pieds de pages" ci-dessous.

Pour ajouter du texte uniquement sur certaines pages, utilisez à la place les cadres et objets textes de MuseScore Studio : voir le chapitre Saisir et éditer du texte.

Style des en-têtes et pieds de pages

Voir la page Modèles et styles

Les valeurs du "Style de texte d'en-tête" peuvent être éditées dans Format →Style → Style de texte → En-tête

Les valeurs du "Style de texte de bas de page" peuvent être éditées dans Format →Style → Style de texte → Bas de page.

Voir aussi

Spécifier un numéro de page de départ personnalisé dans Format → Paramètres de la page : Numéro de la première page. Voir aussi la page Taille et espacement de la partition.

Blocs de texte

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

À ne pas confondre avec l'en-tête : voir le chapitre En-tête et pied de page.

Vue d’ensemble

Un bloc de texte est un objet Texte à l’intérieur d’un cadre. Utilisé avec un cadre vertical qui s'étend sur la largeur totale de la page, il est destiné, de façon élégante, à :

afficher en début de la partition le titre, le sous-titre, le compositeur, l’arrangeur, le parolier, etc.
afficher des informations sur des pièces individuelles à l’intérieur d’une suite
afficher les paroles à la fin d’une chanson, d’un hymne.

Les partitions créées à partir de certains modèles contiennent un cadre vertical avec des objets Texte en haut de la première page. Ils sont automatiquement remplis avec les informations fournies par l'utilisateur dans le fenêtre de dialogue
Nouvelle partition : voir Configurer votre partition : Informations complémentaires sur la partition . Il ne s'agit pas d'un en-tête, qui est une fonctionnalité utilisée pour ajouter du texte sur toutes les pages (voir le chapitre En-tête et pied de
page.

Ajouter un bloc de texte à une partition

Ajoutez d'abord un cadre approprié s'il n'en existe pas : voir Utiliser des cadres pour ajouter du contenu.

Pour ajouter un bloc de texte dans un cadre, utilisez une des méthodes suivantes :

Faites un clic droit sur le cadre, sélectionnez Ajouter puis le type de contenu approprié dans la liste proposée : Texte, Titre, Sous-titre, Compositeur, Parolier ou Nom de la partie
Sélectionnez le cadre puis, dans la barre de menu, sélectionnez Ajouter → Texte → Titre, Sous-titre, Compositeur, Parolier ou Nom de la partie. Cette méthode n'a pas d'option Texte.

Chaque option décrite ci-dessus ajoute un objet Texte vide, sans tenir compte des informations fournies dans la fenêtre de dialogue Nouvelle partition ou des étiquettes de métadonnées (voir le chapitre Propriétés des partitions). De même,
les données saisies dans ces objets ne changeront pas le contenu des étiquettes de métadonnées. Les principales différences entre ces options sont le positionnement et la taille de police utilisés par défaut (voir la section "Style de texte
dans un bloc de texte").

Modifier l’apparence des blocs de texte

Sélectionnez un objet Texte
Dans le panneau Propriétés, éditez les propriétés souhaitées. Les plus utilisées sont :

Alignement sous la section Texte
Décalage dans la fenêtre qui apparaît après avoir cliqué sur le bouton Apparence (voir aussi le chapitre Ajuster directement les éléments)
Suit le paramètre Hauteur d'interligne de portée, case à cocher sous la section Texte, réduit derrière le bouton Afficher plus. Voir le chapitre Taille et espacement de la partition : Échelle.
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Pour sauvegarder les paramètres dans un profil de style, cliquez sur l'icône trois points à la droite de la propriété et sélectionnez ”Enregistrer comme style par défaut pour cette partition” (voir le chapitre Modèles et styles.

Propriétés de texte dans un bloc de texte

Les propriétés de texte d’un bloc de texte sélectionné peuvent être modifiées dans la section Texte du panneau Propriétés.

De façon alternative, vous pourriez avoir envie de changer complètement de style de texte en le modifiant dans la liste déroulante située sous Propriétés : Texte → Afficher plus… → Style de texte.

Style de texte dans un bloc de texte

Voir le chapitre principal Modèles et styles

Les valeurs du "Style de texte dans Nom de partie" peuvent être éditées via Format → Style → Style de Texte → Nom de l'instrument (Partie).
Les valeurs du "Style de texte dans Texte (type d'objet texte)" peuvent être éditées via Format → Style → Style de Texte → Cadre.
Les valeurs du "Style de texte dans Titre" peuvent être éditées via Format → Style → Style de Texte → Titre.
Les valeurs du "Style de texte dans Sous-titre" peuvent être éditées via Format → Style → Style de Texte → Sous-titre.
Les valeurs du "Style de texte dans Compositeur" peuvent être éditées via Format → Style → Style de Texte → Compositeur.
Les valeurs du "Style de texte dans Parolier" peuvent être éditées via Format → Style → Style de Texte → Parolier.

Voir aussi

Utiliser des cadres pour ajouter du contenu.

Mise en page

Notions de mise en page

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Aperçu

MuseScore Studio réalise habituellement une bonne mise en page de la musique et du texte mais il existe des situations où on peut avoir besoin de faire des ajustements — pour rendre la partition plus petite ou plus grande, pour ajouter de
l’espace entre les portées, pour changer le nombre de mesures sur une page, pour rapprocher ou éloigner du texte de la portée, etc. Afin d'être en mesure de réaliser ce type de modifications, il est utile de comprendre comment MuseScore
Studio fonctionne pour assurer la mise en page.

Définitions

Il existe un certain nombre de termes relatifs à la mise en page auxquels vous devez devenir familier.

Spatium / sp.

La taille de tout objet dans une partition, comme une portée, une tête et une hampe de note, une altération, une clef, etc., utilise une unité de mesure basique appelée "Spatium" ou "sp." pour maintenir les proportions de manière appropriée.
Un sp. est défini comme la distance verticale standard entre deux lignes d'une portée (ou le quart de la taille verticale d'une portée de 5 lignes en supposant que l'épaisseur de chaque ligne soit nulle).
Quand vous créez une nouvelle partition, MuseScore Studio tente d'ajuster l'espace automatiquement de façon à ce que toutes les portées s'ajustent initialement dans une page.
Cela donne habituellement une valeur de 1 sp = 1.75 mm, avec une hauteur de portée d'environ 7 mm (détails supplémentaires sans la section "Hauteur de partition absolue finale"), ce qui est une bonne hauteur de portée pour la plupart des
partitions de musique solo, chorale et petits ensembles ainsi que pour les parties individuelles. Les conducteurs (partition réduite, lead sheet) et la musique pour enfant peuvent bénéficier de plus grandes tailles de portée. De grand
ensembles d'orchestre nécessitent souvent une taille plus petite afin de faire tenir tous les instruments sur une seule page.
Vous pouvez avoir besoin d'ajuster cette valeur plus tard lorsque vous ajouter de la musique si le placement automatique entraîne l'ajout d'espace supplémentaire entre des portées afin d'éviter des collisions.

Modifiez la définition du "Spatium" lui-même dans la fenêtre "Paramètres de la page". Voir le chapitre Taille et espacement de la partition qui explique aussi les options pour outrepasser ce paramétrage.

Portée

À ne pas confondre avec le concept d'instrument Musescore.

Une portée est l’ensemble de lignes et d’interlignes sur lesquelles les notes sont écrites. Quand ce terme est utilisé dans MuseScore, il se réfère à l’ensemble des lignes et interlignes d’un instrument donné, sur l’ensemble de la partition.
Dans la partition suivante pour voix et de piano, tout ce qui est surligné en jaune constitue une même portée — la portée pour la voix :

Hauteur de partition absolue finale

L'épaisseur des lignes de portée est réglée dans Format → Style... → Portée. Sa valeur par défaut est de 0,11sp et la valeur par défaut de sp est de 1,75 mm, ce qui donne une épaisseur de ligne par défaut de 0,1925 mm. La hauteur
'absolue' d'une portée de 5 lignes, mesurée entre le bord supérieur de la ligne du haut et le bord inférieur de la ligne du bas, est égale à 0,5 x 0,11sp + 4 sp + 0,5 x 0,11sp = 7,1925 mm (source : https://musescore.org/en/node/362733  [en
anglais]).

Portées de type piano

Dans la notation pour piano et certains autres instruments, deux portées sont utilisées — une principalement dédiée à la main droite, l’autre à la main gauche. Cet ensemble de deux portées est normalement connecté par une accolade (ces
portées liées sont dénommées grand staff par les Anglo-saxons). Dans l’exemple suivant, la portion surlignée en jaune correspond à cette définition :
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Système

Comme du texte, la musique est lue de gauche à droite et de haut en bas. Chaque ligne de musique lue à travers la page est appelée un système ; il contient toutes les portées de tous les instruments. Dans l’exemple suivant, la zone
surlignée en jaune correspond à un seul système :

Même si une partition n’a qu’une seule portée pour un seul instrument, nous continuerons à nous référer à la ligne de musique lue sur la page comme à un système. Dans l’exemple suivant, il n’y a qu’une seule portée mais trois systèmes :

Cadre

La plupart des textes en notation musicale sont associés à des notes ou mesures spécifiques. Cependant, on peut aussi avoir besoin de placer du texte qui n’est pas associé à une note ou une mesure — le titre au début de la partition, les
paroles d’une chanson placées à la fin d’une partition, des informations complémentaires placées entre systèmes voire entre mesures. MuseScore Studio utilise pour cela des éléments appelés cadres. Il existe des cadres verticaux et des
cadres horizontaux — chacun est adapté à un usage particulier. Les cadres horizontaux peuvent également être utilisés pour créer une séparation entre des mesures d’un système, avec ou sans texte associé.

Marges

Une marge est une zone dans laquelle MuseScore Studio ne place normalement pas d’éléments, musicaux ou autres. Les marges de page sont les espaces sur les quatre côtés de la page où aucun élément n’est placé (haut, bas, droite,
gauche). Les marges de musique sont les zones situées entre la marge de haut/bas et la première/dernière portée. Les portées elles-mêmes ne seront pas placées dans ces marges mais les notes et autres symboles situés au-dessus ou au-
dessous de la portée peuvent l’être.
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Positionner les éléments

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Aperçu

MuseScore Studio place automatiquement les éléments dans votre partition en tenant compte d’un jeu de règles et de paramètres de style. Ceux-ci sont destinés à rendre des résultats optimaux par défaut dans la plupart des situations — les
éléments sont positionnés selon des pratiques standard d’écriture musicale tout en évitant les collisions entre éléments. MuseScore Studio donne aussi la possibilité de personnaliser les paramètres et d’outrepasser les réglages par défaut de
n’importe quel élément donné.

Position par défaut

La plupart des éléments ont une position par défaut qui est déterminée par les paramètres de style. Ceux-ci peuvent être personnalisés via le panneau Propriétés ou la fenêtre de dialogue Format → Style. Pour les éléments qui sont placés
au-dessus de la portée, la position est spécifiée en tant que décalage par rapport à la ligne supérieure de la portée ; pour les éléments placés au-dessous, le décalage est spécifié par rapport à la ligne inférieure de la portée. Ces réglages,
comme la plupart des mesures dans MuseScore Studio, sont exprimées en unité spatium, abrégée en sp. (voir : Hauteur d'interligne de portée). Pour la plupart des types d’éléments, il est possible de spécifier un décalage à utiliser quand
l’élément est placé au-dessus ainsi qu’un décalage distinct à utiliser quand il est placé au-dessous. Il est également possible de spécifier lequel de ces placements doit être employé par défaut.

Pour plus d'information, voir le chapitre Modèles et styles.

Par exemple, pour les nuances, le placement par défaut est au-dessous de la portée, avec un décalage sous la ligne inférieure de la portée est de 2,5 sp. Si on opte pour un placement de la nuance au-dessus de la portée, son décalage par
défaut est de 1,5 sp. au-dessus de la ligne supérieure de la portée (exprimé en valeur de décalage négative : -1,5 sp.). Ces paramétrages sont situés dans Format → Style → Nuances.

Notez que le réglage par défaut est plus grand pour les nuances placées au-dessous de la portée uniquement parce que le décalage est mesuré depuis la ligne de base du texte :

Auto-placement

Auto-placement est le terme que MuseScore Studio emploie dans divers algorithmes utilisés pour éviter les collisions ou pour aligner automatiquement des éléments. Une compréhension de base de la façon dont fonctionne l’auto-placement
peut être utile lorsqu’on réalise des ajustements.

Évitement vertical de collision

Pour la plupart des éléments placés au-dessus ou au-dessous de la portée, l’évitement de collision fonctionne de façon verticale. Quand un élément est à positionner, MuseScore Studio essaye d’abord de le placer en cohérence avec les
décalages par défaut de ce type d’élément. Si cela est susceptible d'entraîner une collision avec un autre élément, un des deux éléments sera déplacé plus loin pour éviter le chevauchement. MuseScore Studio suit les règles standard de
notation pour déterminer quel élément déplacer. Par exemple, une indication de tempo sera déplacée au-dessus d’une ligne de trilles plutôt que le contraire.

Le paramétrage de style trouvé dans Distance minimum détermine quel espace MuseScore Studio doit attribuer entre les éléments quand il évite une collision de cette manière. Le paramétrage correspondant dans le panneau Propriétés
vous permet d’outrepasser le réglage par défaut pour des éléments individuels si nécessaire. Mais MuseScore Studio ajuste cette valeur automatiquement quand des éléments sont positionnés de façon manuelle, comme cela est vu plus bas
dans la section sur l’ajustement manuel.

Évitement horizontal de collision

Pour certains éléments comme les symboles d’accord, MuseScore Studio élargira les mesures pour éviter les collisions plutôt que de déplacer ces éléments verticalement.

Alignement vertical

MuseScore Studio essaiera aussi d’aligner certains éléments verticalement de façon à ce que, si un élément de même type nécessite d’être déplacé verticalement pour éviter une collision, les autres éléments de même type soient également
automatiquement déplacés. Parmi les éléments qui sont toujours alignés verticalement, on trouve les paroles et les indications de pédale. Les symboles de nuance seront alignés s’ils sont directement adjacents, tout comme le seront les
indications de pédale.

Les symboles d’accord peuvent aussi être alignés verticalement si vous le rendez possible dans le paramétrage de style des symboles d’accord en réglant la valeur Décalage maximum. Voir Symboles d’accord pour davantage
d’informations.
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Désactiver l’auto-placement

L’auto-placement réalise habituellement un travail efficace pour éviter les collisions et aligner les éléments. Et dans les situations où vous souhaitez positionner un élément manuellement, vous pouvez normalement le faire sans avoir à
désactiver l’auto-placement (voir Ajustement manuel plus bas). Cependant, il peut y avoir des situations dans lesquelles vous pouvez quand même souhaiter désactiver l’auto-placement. Par exemple, le placement des repères est prévu par
défaut au-dessus d'une alternative de reprise mais vous pouvez choisir l’inverse si la ligne d'alternative de reprise est déjà placée haut et qu’il existe de la place pour afficher le repère en dessous.

Dans cet exemple, désactiver l’auto-placement pour le repère lui permet d’être affiché sous la ligne de répétition tout en permettant toujours à la ligne de répétition d’éviter les collisions avec les notes.

Pour désactiver l’auto-placement pour un élément, sélectionnez-le puis décochez la case Placement auto dans la section Général du panneau Propriétés.

L’élément sera replacé dans sa position par défaut (telle qu’elle est déterminée par ses paramètres de style) et ne sera pas inclue dans la détection des collisions avec d’autres éléments. La désactivation de l’auto-placement pour un élément
entraîne aussi son exclusion de tout alignement vertical qui aurait pu autrement être appliqué.

Ajustement manuel

Que l’auto-placement ait affiché un élément selon ses paramètres par défaut ou non, la position de chaque élément peut être ajustée manuellement en utilisant la souris, les touches fléchées du clavier ou les champs de Décalage du
panneau Propriétés. Pour plus d’informations, voir Ajuster directement les éléments.

MuseScore Studio vous autorise même à réaliser des ajustements manuels qui pourraient entraîner une collision. Dans l’exemple du dessus, quand on déplace manuellement le repère sous la ligne de répétition, MuseScore Studio autorise
cette action et va automatiquement régler le paramètre Distance minimum de cet élément en lui attribuant une valeur négative, ce qui permet effectivement d’autoriser une collision sans désactiver l’auto-placement.

Alignement manuel

Les éléments de même type sont normalement alignés par défaut car ils partagent les mêmes paramètres de style et par conséquent le même décalage. Cependant, l’auto-placement peut entraîner le déplacement plus important de certains
éléments que d’autres par rapport à la portée. Comme décrit plus haut dans le chapitre Alignement vertical, MuseScore Studio va chercher à aligner plusieurs types d’éléments. Pour les autres types, il est possible de les aligner
manuellement en leur assignant la même valeur de décalage vertical.

Pour réaliser cela, sélectionnez simplement les éléments que vous voulez aligner (par exemple, cliquez sur le premier puis maintenez Maj en cliquant sur le dernier) et augmentez ou diminuez progressivement le décalage vertical dans le
panneau Propriétés. Par exemple, pour aligner une série d’indications de tempo au-dessus de la portée, vous aurez besoin de régler leur décalage vertical à la même valeur. Pour être sûr qu’ils soient alignés tout en évitant que l’auto-
placement en déplace un ou plusieurs pour commencer, vous aurez besoin de régler le décalage avec une valeur négative suffisamment importante.

Taille et espacement de la partition

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Vue d'ensemble

MuseScore Studio fournit un certain nombre de paramètres, couvrant l’ensemble de la partition, qui ont pour objet de contrôler la taille globale et l’espacement des partitions.
Cette page évoque les réglages et algorithmes de MuseScore Studio. Ces paramétrages sont dans la fenêtre "Paramètres de la page" et dans les items de la partie supérieure du panneau de gauche de la fenêtre "Style" : Format → Style...
→ Partition, Page, Taille, Système, Mesure, etc..
Il existe également de multiples façons d'outrepasser les valeurs par défaut afin de modifier l’espacement horizontal ou vertical des pages de systèmes individuels ; cela est développé dans les chapitres Espacement horizontal des
systèmes et Espacement vertical des pages.

Voir aussi Modèles et styles si vous êtes en train d'utiliser une fonctionnalité Partie Musescore.

Paramètres de la page

Les paramètres qui contrôlent la taille générale de votre partition sont fournis dans Format → Paramètres de la page.

Notez que les unités dans cette fenêtre de dialogue sont par défaut en millimètres mais que vous pouvez les changer en pouces (inches) en modifiant le paramètre Unité.

Tailles de page et de marges

Taille de la page : formats de pages prédéfinis
Largeur : largeur personnalisée
Hauteur : hauteur personnalisée
Portrait / Paysage : modalité d’orientation de la page
Recto / Verso : détermine si les marges, tout comme les en-têtes et pieds de pages, peuvent être paramétrées individuellement pour les pages paires et impaires.

La taille de page par défaut est "Lettre" pour l’Amérique du nord et l'Amérique centrale; "A4" pour quasiment le reste du monde.

Marges des pages impaires : valeurs des marges du haut, du bas, de gauche et de droite pour les pages impaires
Marges de pages paires : valeurs des marges du haut, du bas, de gauche et de droite pour les pages paires.

Les marges sont réglées à 15 mm par défaut, sans tenir compte de la taille de la page. Si Recto / Verso n’est pas coché, seul le paramétrage des Marges des pages impaires est disponible.

Échelle

Hauteur d'interligne de portée (sp.) : modifie la définition de l'unité Spatium (sp.) elle-même. Voir le chapitre Notions de mise en page.

Voir la vue d'ensemble ci-dessus pour les informations sur les autres options de taille globale et d'espacement ainsi que les deux chapitres détaillant les options spécifiques aux systèmes individuels.

Des options d'outrepassement pour les objets individuels d'une partition sont disponibles :
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Chaque objet texte d'une partition possède une case à cocher de propriété "Faire correspondre la taille de portée" paramétrée dans le panneau Propriétés (voir le chapitre Mettre en forme du texte).
Plusieurs profils de "style de texte au sein d'un certain type d'objet" possèdent des cases à cocher "Suit le paramètre interligne de portée" paramétrées dans Format → Style... → Styles de texte → (items de milieu de panneau).
Voir les chapitres Modèles et styles et Mettre en forme du texte.
Chaque image dans une partition possède une case à cocher de propriété Utiliser l'unité de hauteur d'interligne de portée paramétrée dans le panneau Propriétés. Voir Utiliser des images.
[Merci d'ajouter des options manquantes si vous en trouvez]

Autres paramètres

Numéro de la première page : définit le chiffre à partir duquel la numérotation des pages commence (pratique si votre partition a une page de titre, par exemple)
Unité : permet de choisir entre Inches (in) (pouces) et Millimètres (mm) pour les valeurs de cette fenêtre de dialogue.

Actions

En plus des boutons standards OK and Annuler, cette fenêtre de dialogue contient aussi :

Rétablir les paramètres par défaut : rétablit tous les paramètres de cette fenêtre avec leurs valeurs par défaut
Appliquer à l’ensemble des parties : applique les paramètres en cours de la fenêtre à toutes les parties individuelles.

Notez que dans les partitions pour grands orchestres où MuseScore Studio a automatiquement réduit la taille des portées pour permettre de ranger tous les instruments sur une seule page, le rétablissement des paramètres par défaut
entraîne celui de la hauteur d’interligne de portée standard de 1,75 mm.

Paramètres de style

L’espacement horizontal des notes et l’espacement vertical des portées et systèmes sont contrôlés par des paramètres de style.

Espacement horizontal

Cette section contient une vue d'ensemble. Pour plus de détails, voir Espacement horizontal des systèmes.

MuseScore Studio détermine une largeur initiale pour chaque mesure sur la base de la musique qu’elle comporte, calcule combien de mesures peut contenir chaque système puis étire ces mesures de façon à ce que tous les systèmes (sauf
éventuellement le dernier) soient justifiés sur la marge de droite, de la même façon que le fait l'option "justifier" sur un paragraphe d'un traitement de texte . Vous ne pouvez pas changer ce comportement mais voir les options pour
l'outrepasser dans Espacement horizontal des systèmes.
La largeur initiale d’une mesure est déterminée par la notation musicale qu’elle comporte ainsi que par des paramètres de style qui définissent l’espacement entre les notes et autres symboles.

La largeur initiale d'une mesure est déterminée par la musique qu'elle contient ainsi que par un groupe de paramètres de style qui contrôlent l'espacement entre les notes et d'autres symboles.

La plupart des paramètres affectant l’espacement horizontal sont trouvés dans Format → Style → Mesure. Les plus importants sont :

Largeur minimale de la mesure : largeur minimale de chaque mesure
Rapport d’espacement : rapport entre l’espace alloué à une valeur de note et celui de la note de durée inférieure suivante
Distance minimum entre les notes : espacement minimum entre deux notes.

Le rapport d’espacement par défaut a une valeur de 1,5 ; cela signifie que chaque note de durée donnée prend 1,5 fois plus d’espace que la note de durée plus courte suivante. Ainsi, une blanche prend 1,5 fois plus d’espace qu’une noire,
etc.

La distance minimale entre les notes spécifie la plus petite distance que MuseScore Studio autorisera entre deux notes, ce qui définit l’espacement minimum initial entre les valeurs de notes les plus courtes. Les notes de durée plus longue,
avec le rapport d’espacement, se verront toujours attribuer plus d’espace ; comme les mesures sont étirées pour remplir la largeur de la page, il est fort probable que même l’espacement entre notes les plus courtes ne sera pas effectivement
aussi réduit que le minimum paramétré.

La distance minimum entre notes et le rapport d’espacement déterminent ensemble si l’espacement est étroit ou lâche.

À un extrême, la portée du haut utilise un ratio d'espacement horizontal de 1,0, ce qui a pour effet que chaque note occupe un espace identique, sans tenir compte de la durée de la note. À l'autre extrême, la portée du bas utilise un ratio
d'espacement horizontal de 2,0, résultant en un espacement proportionnel des notes en fonction de leur durée relative, tel qu'une blanche occupe deux fois plus d'espace qu'une noire. C'est pratique si on souhaite des mesures de largeur
identiques. Des valeurs proches de celle par défaut de 1,5 sont préférables dans la plupart des cas. Une valeur légèrement inférieure autorise un espacement plus resserré ; une valeur légèrement supérieure un espacement plus large.
Diminuer ou augmenter la distance minimum entre notes entraîne également le resserrement ou l'élargissement de l'espacement.

Si le calcul d’espacement a pour résultat que quelques mesures (celles qui contiennent relativement peu de notes) sont plus petites que la largeur minimum, un espace supplémentaire sera ajouté pour imposer le minimum requis.

Il existe aussi beaucoup de paramètres individuels dans cette même fenêtre de dialogue destinés à contrôler des réglages spécifiques comme la distance Entre la Clef et l’armure ou Entre la barre de mesure et la fioriture. Beaucoup
d’autres paramètres se sont ajoutés au fil du temps ; ils sont censés se passer d’explication.

Des paramètres de style additionnels relatifs à l’espacement peuvent être trouvés dans :

Format → Style → Partition
Activer le retrait du premier système : permet le retrait du premier système de la partition par rapport à la marge gauche
Retrait du premier système : règle la valeur du retrait

Format → Style → Page
Seuil de remplissage du dernier système : détermine si le dernier système de la partition doit être rempli jusqu’à la marge de droite.

Espacement vertical

Cette section contient une vue d'ensemble. Pour plus de détails, voir Espacement vertical des pages.

MuseScore Studio permet de choisir entre deux algorithmes différents d’espacement vertical.

Dans les deux algorithmes, MuseScore Studio remplit les pages avec les systèmes de façon similaire au procédé de remplissage des systèmes avec les mesures. Il détermine d’abord une taille initiale pour chaque système, calcule combien
de systèmes peuvent être affichés sur chaque page puis répartit ces systèmes de la façon la plus harmonieuse sur chaque page. En fonction de vos paramétrages de style, MuseScore Studio peut littéralement remplir chaque page jusqu’à la
marge du bas ou bien laisser de l’espace supplémentaire au bas de certaines pages, si le remplissage complet de la page avait pour conséquence d’espacer les éléments de façon trop importante.

La différence entre les deux algorithmes est en rapport avec la façon dont le remplissage des pages est réalisé.

Si vous sélectionnez Désactiver la justification verticale des portées, la distance entre les portées à l’intérieur d’un système est fixée, sauf si cela est responsable de collisions. Dans cet algorithme, si MuseScore Studio a besoin d’espacer
les systèmes pour remplir une page, il le fera toujours en ajoutant de l’espace entre les systèmes plutôt qu’à l’intérieur des systèmes. Cela conduit à favoriser un espacement cohérent entre portées d’un système à l’autre mais peut entraîner
un écartement plus important entre systèmes que celui des portées à l’intérieur des systèmes. Il peut aussi avoir pour conséquence une irrégularité des marges basses pour les pages qui ne comportent qu’un seul système (puisque les
portées de système ne seront pas espacées pour remplir la page).

Le paramétrage par défaut est cependant d’Activer la justification verticale des portées. Lorsque cette méthode est sélectionnée, l’espacement entre les portées à l’intérieur des systèmes peut également être agrandi. Cela a pour
conséquence de régulariser l’affichage général — l’espacement restera plus important entre les systèmes qu’à l’intérieur de ceux-ci mais sans excès — et d’éviter l’irrégularité des marges basses sur les pages ne comportant qu’un seul
système (puisque les portées à l’intérieur du système peuvent être espacées pour remplir la page).

La plupart des paramètres contrôlant l’espacement vertical sont trouvés dans Format →Style → Page. Il existe également un paramètre d’espacement dans Format → Style→ Partition :

Distance verticale min. : valeur minimum d’espace que MuseScore Studio doit allouer entre les symboles situés au-dessous d’une portée et les symboles situés au-dessus de la portée inférieure adjacente.

Marges de musique

Que la justification verticale soit activée ou non, MuseScore Studio ajoutera de l’espace au-dessus de la portée supérieure et au-dessous de la portée inférieure de chaque page (voir Notions de mise en page). Ces paramètres sont trouvés
dans Format → Style → Page :

Marge au-dessus de la musique : valeur minimum d’espace entre la marge haute de la page et le haut de la portée supérieure
Marge au-dessous de la musique : valeur minimum d’espace entre la marge basse de la page et le bas de la portée inférieure.

Espacement entre portées à l’intérieur d’un système

Si vous sélectionnez Désactiver la justification verticale des portées, il existe deux paramètres qui contrôlent l’espacement à l’intérieur des systèmes :

Distance entre portées : espacement entre les portées des instruments adjacents
Distance entre portées de type piano : espacement entres des portées liées par une accolade (voir : portée de type piano).

Remarque : même si Désactiver la justification verticale des portées est sélectionné, MuseScore Studio continuera d’ajouter autant d’espace que nécessaire entre les portées pour éviter les collisions. Pour contraindre le programme à
afficher un espacement entièrement constant entre portées (et accepter les collisions qui en résultent), attribuez une grande valeur négative à Distance verticale min.
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Si on sélectionne Activer la justification verticale des portées, le paramétrage n’est plus limité à la définition des seules distances "entre portées" et "entre portées de type piano". À la place, il est affiché une série de distances et de
valeurs acceptables qui contrôlent comment MuseScore Studio peut utiliser l’espace disponible pour étirer les systèmes ainsi que les portées (et combien d’espace supplémentaire ajouter entre les groupes de portées liées par une accolade
ou un crochet). Les paramètres comprennent :

Distance min. entre portées : espacement minimum entre des portées adjacentes
Distance max. entre portées : espacement maximum entre des portées adjacentes
Distance max. entre portées de type piano : espacement maximum entre les portées de type piano (liées par une accolade)
Facteur de distance au-dessus/au-dessous du crochet : quantité d’espace supplémentaire pouvant être utilisée entre les groupes de portées liées par un crochet
Facteur de distance au-dessus/au-dessous d’une accolade : quantité d’espace supplémentaire pouvant être utilisée entre les groupes de portées liées par une accolade.

Espacement entre systèmes

Que la justification verticale des portées soit activée ou non, il est possible de paramétrer l’espacement entre systèmes à l’intérieur d’une plage de valeurs :

Distance min. entre systèmes : espacement minimum entre des systèmes adjacents
Distance max. entre systèmes : espacement maximum entre des systèmes adjacents.

De plus, si on sélectionne Activer la justification verticale des portées, deux paramètres supplémentaires sont disponibles :

Facteur de distance entre systèmes : quantité d’espace supplémentaire pouvant être utilisée entre systèmes
Distance max. du remplissage de la page : montant de l’espacement total.

Propriétés de portée/partie

Il existe aussi quelques paramètres spécifiques aux portées qui affectent leurs taille et espacement. Pour y accéder faites un clic droit (Ctrl+clic) sur une portée puis sélectionnez Propriétés de Portée / Partie. Les paramètres en question
sont :

Petite portée : réduit la taille de la portée selon le pourcentage spécifié dans Format → Style → Tailles
Échelle : règle la taille de portée selon un pourcentage personnalisé
Distance supplémentaire au-dessus de la portée : attribue un espacement supplémentaire entre cette portée et la portée située au-dessus.

Espacement horizontal des systèmes

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Aperçu

L’algorithme d’espacement horizontal de MuseScore Studio évalue la largeur de chaque mesure, ce qui détermine en conséquence combien de mesures peuvent être affichées dans chaque système. Bien que cet algorithme donne de bons
résultats dans la plupart des cas, il existe aussi des situations où on peut avoir besoin d’outrepasser cela afin d'obtenir davantage ou moins de mesures par système ou de produire des espacements différents à l’intérieur des systèmes.

Fonctionnalités

Les principaux outils destinés à contrôler l’espacement horizontal et vertical des systèmes sont décrit plus bas.

Sauts de système

Un saut de système oblige MuseScore Studio à terminer un système après une mesure ou un cadre horizontal spécifique, même si davantage de mesures pourraient y tenir. Pour ajouter un saut de système, sélectionnez une mesure (ou
n’importe quel élément à l’intérieur de celle-ci) ou un cadre puis cliquez sur l’icône Saut de système dans la palette Mise en page :

Vous pouvez aussi utiliser le raccourci clavier Entrée. Les deux méthodes d’ajout de sauts fonctionnent aussi en mode de saisie de note.

Après l’ajout d’un saut, l’icône apparaît au-dessus de la mesure à laquelle vous l’avez ajouté :

Comme pour les autres éléments de mise en page, le saut de système apparaît en gris et ne sera pas imprimé ; son affichage sur l’écran peut être désactivé via le panneau Propriétés.

Étirement

Vous pouvez augmenter ou diminuer la largeur des mesures : leur contenu sera étiré ou rétréci en conséquence. La largeur calculée d’une mesure est multipliée par un facteur numérique d’étirement que vous pouvez paramétrer pour les
mesures sélectionnées ; mais vous pouvez aussi utiliser des commandes pour augmenter ou diminuer l’étirement des mesures sélectionnées sans avoir besoin de régler un nombre spécifique.

Pour changer directement l’étirement, vous pouvez sélectionner une ou plusieurs mesures puis utiliser l’une des commandes dans Format → Étirement:

Augmenter l’étirement des mesures : augmente la largeur des mesures (raccourci : })
Diminuer l’étirement des mesures : diminue la largeur des mesures (raccourci : {)
Réinitialiser l’étirement des mesures : réinitialise la largeur des mesures.

Pour régler numériquement la valeur de l’étirement, vous pouvez sélectionner une ou plusieurs mesures puis paramétrer Largeur mesure dans la section Apparence du panneau Propriétés.

Comme vous pourrez le constater en regardant ce paramètre, chaque frappe de } ou { augmente ou diminue cette valeur par incréments de 0,1.

Vous pouvez aussi régler cette valeur pour une mesure seule en faisant un clic droit dessus, en sélectionnant Propriétés de la mesure puis en réglant Étirement de la mesure dans la fenêtre de dialogue qui s’ouvre.

Cadres horizontaux

Un cadre horizontal est une boîte qui peut être placée entre les mesures d’une partition. Bien que l’on puisse insérer du texte ou des images dans un cadre horizontal (voir Utiliser des cadres pour ajouter du contenu), l’une de leurs
fonctionnalités principales est de créer un espace vide à l’intérieur d'un système comme expliqué ci-dessous.

Pour ajouter un cadre horizontal à votre partition, sélectionnez une mesure puis cliquer sur l’icône Insérer un cadre horizontal dans la palette Mise en page :
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Le cadre sera inséré avant la mesure sélectionnée. Si la mesure est au début d’un système, le cadre peut effectivement apparaître comme à la fin de la mesure précédente, s’il y a suffisamment d’espace.

Vous pouvez aussi utiliser les commandes du menu Ajouter → Cadres.

Vous pouvez alors modifier la largeur du cadre en paramétrant la propriété Largeur dans le panneau Propriétés, en sélectionnant le cadre et déplaçant sa poignée d’ajustement, ou bien en utilisant les flèches du clavier ← et →. L’ajustement
au clavier se fait par incrément de 0,5 sp. — ou de 1,0 sp. si vous maintenez la touche Ctrl (Cmd sur Mac).

Insérer un cadre horizontal: insère un cadre horizontal avant la mesure sélectionnée
Ajouter un cadre horizontal: ajoute un cadre horizontal à la fin de la partition.

Grouper des mesures dans le même système

Pour grouper des mesures afin qu’elles restent ensemble dans un même système, vous pouvez les sélectionner puis cliquer sur l’icône Groupe de mesures dans la palette Mise en page :

Quand MuseScore Studio calcule combien de mesures placer dans un système donné et qu’elle rencontre un tel groupe, si l’ensemble du groupe ne peut tenir dans l’espace restant, le programme déplacera l’ensemble du groupe dans le
système suivant.

Utilisation pratique

Ces fonctionnalités peuvent être utilisées dans une grande variété de situations mais il existe une poignée de tâches qui sont particulièrement communes.

Placer moins de mesures dans un système

Il est toujours possible d’avoir un nombre moins important de mesures dans un système que celui que MuseScore Studio placerait par défaut. Pour terminer un système avec une mesure particulière ou un cadre horizontal, sélectionner le/la
et ajoutez un saut de système.

Placer davantage de mesures dans un système

Bien que ce ne soit pas toujours physiquement possible de faire rentrer plus de mesures dans un système donné avec les paramétrages en cours, de la taille de portée et de l’espacement — il peut y avoir tout simplement "trop de notes" à
placer sans chevauchement — vous pouvez réduire la largeur des mesures sélectionnées.

Pour placer davantage de mesures dans un système :

Sélectionnez et supprimez tous les sauts de système qui peuvent déjà être présents
Sélectionnez les mesures que vous voulez combiner en un seul système
Diminuez l’étirement des mesures sélectionnées jusqu’à ce qu’elles rentrent dans le système (par exemple, en tapant {).

Selon la valeur de l’étirement précédent, il peut être nécessaire de réaliser plusieurs opérations de réduction d’étirement avant que toutes les mesures puissent tenir. Mais on peut aussi être dans la situation où cela n’est justement pas
possible sans réduire l’ensemble des paramètres de page, de taille de portée ou d’espacement. Pour plus d’informations, voir : Taille et espacement de la partition.

Modifier l’espacement relatif des mesures au sein d’un système

L’espacement par défaut est destiné à s’assurer que toutes les notes d’une durée donnée dans un même système prennent le même espace, même si davantage d’espace est requis pour faire de la place pour afficher des marqueurs
spécifiques à certaines notes. Mais il peut y avoir des cas où il pourrait être sensé d’augmenter l’espacement dans une ou plusieurs mesures, ce qui a pour conséquence de diminuer l’espacement dans les autres (ou vice-versa).

Pour modifier l’espacement dans une ou plusieurs mesures, sélectionnez-la (les) et augmentez ou diminuez l’étirement comme décrit plus haut.

Créer de l’espace entre mesures

Pour créer de l’espace entre deux mesures, sélectionnez la deuxième mesure et ajoutez/ajustez un cadre horizontal comme décrit plus haut.

Créer de l’espace au début ou à la fin d’un système

Pour créer un espace supplémentaire au début ou à la fin d'un système individuel, ajoutez un cadre horizontal. Pour le premier système d'une partition, le paramètre de style Retrait du premier système (dans Format → Style → Partition)
crée automatiquement de l’espace. Pour plus d'informations, voir Taille et espacement de la partition. Vous pouvez souhaiter créer des sections différentes avec un "Saut de section" au lieu de penser à créer un espace supplémentaire à la fin
d'un système individuel : voir le chapitre Utiliser des sections pour séparer mouvements ou chansons.

Pour ajouter de l’espace au début d’un système, sélectionnez la première mesure puis insérez/ajustez un cadre horizontal comme décrit plus haut. Vous pouvez aussi avoir besoin de placer un saut de système sur la dernière mesure du
système précédent pour vous assurer que le cadre n’apparaîtra pas plutôt à cet endroit.

Pour ajouter de l’espace à la fin d’un système, assurez-vous d’abord qu’il n’y a pas de saut de système sur la dernière mesure puis sélectionnez celle-ci et insérez un cadre horizontal. Puis ajoutez un saut de système sur le cadre lui-même si
nécessaire.

Ajuster la largeur du dernier système

Le dernier système d’une partition doit normalement être justifié à droite (étiré pour remplir la largeur de la page) si sa largeur par défaut est supérieure au Seuil de remplissage du dernier système défini dans Format → Style → Page.
Pour plus d’informations, voir Taille et espacement de la partition. Cela produit normalement de bons résultats mais il peut y avoir des cas où le système est justifié mais pourrait être plus agréable à voir s’il ne l’était pas (ou vice-versa)

Pour les cas où le système est justifié mais que vous préfèreriez qu’il ne le soit pas, vous pouvez augmenter le seuil de remplissage. Une valeur de 100 % signifie que le système n’est jamais justifié (puisque sa largeur n’excèdera jamais ce
seuil). Inversement, si le dernier système n’est pas justifié mais que vous voulez qu’il le soit, diminuez le seuil. Une valeur de 0 % signifie que le dernier système sera toujours étiré (car sa largeur dépassera toujours ce seuil).

Il est conseillé, cependant, de sélectionner une valeur de seuil susceptible de s’adapter aux futurs changements de la partition avec davantage ou moins de mesures affichées dans le dernier système. Par exemple, si votre dernier système a
plusieurs mesures et que vous le forcez à être justifié en fixant le seuil à 0 %, cela peut avoir de mauvais résultats si la mise en page est modifiée dans le futur et que le dernier système ne se retrouve plus qu'avec une seule mesure. Ou,
inversement, si le système n’a qu’une seule mesure et que vous le forcez à ne pas être justifiée en réglant le seuil à 0 %, cela peut produire un mauvais affichage si la mise en page change et que le dernier système comporte désormais
plusieurs mesures. C’est pourquoi il est habituellement conseillé d’utiliser une valeur moyenne.

Il est habituellement préférable, toutefois, de programmer des sauts de système pour éviter que le dernier système se retrouve moins rempli que les autres.

Grouper des mesures

Comme discuté dans Taille et espacement de la partition, MuseScore Studio remplit normalement autant de mesures qu’il peut dans chaque système. Cela peut parfois avoir pour résultat de créer des discontinuités dans des mesures
musicalement reliées du fait d'un saut de système au sein du groupe alors qu'il serait plus facile de les lire si elles étaient affichées ensemble dans le système suivant. Bien que vous puissiez ajouter un saut de système sur la mesure
précédent le groupe, cela pourrait se révéler rapidement contreproductif si la mise en page était modifiée secondairement, permettant à toutes les mesures de tenir dans le système précédent. Ce que l’on souhaite en fait, c'est d’être en
capacité de spécifier que certaines mesures doivent être affichées ensemble, si possible, soit en les conservant dans le système d’origine, soit en les déplaçant toutes ensemble dans le suivant.

Dans un traitement de texte, un "espace non sécable" peut être utilisé pour garder des mots ensemble. Si les deux mots se retrouvent sur la même ligne, l’espace non sécable agit comme s'il s'agissait d'un espace normal. Mais si les deux
mots ne peuvent être écrits sur la même ligne, il sont déplacés tous les deux sur la ligne suivante plutôt que d’être coupés à l’endroit où se trouve l’espace non sécable.

Dans MuseScore, vous pouvez utiliser l’icône Groupe de mesures dans la palette Mise en page pour sélectionner les mesures de la même façon. Ces mesures seront traitées comme un seul bloc pour décider si elle peuvent être placées
dans un système ou dans le suivant.

Notez que cela ne vous autorisera pas de placer davantage de mesures dans un système que cela est normalement autorisé avec le paramétrage en cours. Il dit simplement à MuseScore Studio que ces mesures doivent être, si possible,
conservées ensemble.

Espacement vertical des pages

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Fonctionnalités
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Comme décrit dans Espacement vertical , MuseScore Studio remplit chaque page avec le plus de systèmes possibles en fonction des paramètres en cours avant d'ajuster l’espacement à l’intérieur de chaque page en fonction de deux
algorithmes différents. Vous pouvez aussi paramétrer manuellement le nombre de systèmes sur une page ou l’espacement entre portées et systèmes spécifiques.

Sauts de page

Un saut de page oblige MuseScore Studio à terminer une page après un système donné, même si davantage de systèmes auraient pu y tenir. Pour ajouter un saut de page, sélectionnez une mesure ou un cadre puis tapez Ctrl+Entrée
(Cmd+Entrée sur Mac) ou cliquez sur l’icône Saut de page dans la palette Mise en page :

Espaceurs

Un espaceur est un élément de mise en page que vous pouvez ajouter à une mesure pour contrôler la hauteur d’espacement affichée au-dessus ou au-dessous de cette portée. Les espaceurs peuvent avoir pour effet soit d’augmenter, soit
de diminuer l’espacement et ils peuvent opérer à la fois à l’intérieur des système ou entre ceux-ci.

Pour ajouter un espaceur à votre partition, sélectionnez une mesure puis cliquez sur l’icône appropriée dans la palette Mise en page :

Vous pouvez aussi cliquer/déplacer un espaceur vers la mesure de destination de votre partition.

Une fois que vous avez ajouté un espaceur, vous pouvez ajuster sa hauteur en le sélectionnant et en faisant glisser sa poignée d’ajustement ; ou en utilisant le paramètre Hauteur dans le panneau Propriétés. Il y a trois types différents
d’espaceurs et le réglage de hauteur a des effets différents en fonction du type d’espaceur :

Espaceur au-dessous de la portée : s’assure qu’il y a au minimum la valeur de l’espacement spécifié au-dessous de la portée
Espaceur au-dessus de la portée : s’assure qu’il y a au minimum la valeur de l’espacement spécifié au-dessus de la portée
Espaceur de portée fixe : s’assure que l’espacement au-dessous de la portée est exactement celui qui a été spécifié.

L’espaceur agit à l’intérieur d’un système quand il est ajouté entre portées d’un système. L'Espaceur au-dessous de la portée et l'Espaceur de portée fixe ont un effet entre les systèmes quand ils sont appliqués sur la portée basse d’un
système ; l'Espaceur au-dessus de la portée fait de même quand il est ajouté à la portée haute d’un système.

Cadres verticaux

Un cadre vertical est une boîte qui peut être placée entre les systèmes d’une partition. Bien que les cadres verticaux puissent être laissés vides et ainsi fonctionner de manière similaire à un espaceur, l’objet principal des cadres verticaux est
d’ajouter du texte ou des images. Pour plus d’information, voir Utiliser des cadres pour ajouter du contenu.

Séparateurs de systèmes

Dans une partition pour ensemble musical où plusieurs systèmes sont affichés dans une même page, on peut utiliser une paire de barres diagonales pour aider à distinguer la séparation entre les systèmes.
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MuseScore Studio peut les ajouter automatiquement via Format → Style → Système. Vous pouvez activer indépendamment les séparateurs de Gauche et Droite. Pour chacun, vous pouvez personnaliser un certain nombre de paramètres :

Symbole : choisissez entre Séparateur de systèmes, Séparateur de systèmes long et Séparateur de systèmes extra-long
Décalage horizontal : distance par rapport à la position par défaut (= alignée sur la marge de page correspondante)
Décalage vertical : distance par rapport à la position par défaut (= centrée entre les systèmes).

Utilisation pratique

Les fonctionnalités ci-dessus peuvent être utilisées pour réaliser un certain nombre de tâches communes.

Placer moins de systèmes dans une page

Pour placer un nombre moins important de systèmes dans une page, ajoutez simplement un saut de page au système ou au cadre que vous voulez voir apparaître en dernier sur la page.

Placer davantage de systèmes dans une page

Comme pour l’espacement horizontal, il n'est pas toujours possible de faire rentrer plus de systèmes dans une page que le paramétrage en cours le permet. Vous pouvez aussi envisager, au niveau de l’ensemble de la partition, d’utiliser une
taille de portée plus petite, de réduire la distance minimum d’un système ou d’appliquer d’autres modifications de style. Cependant, dans quelques cas, il est possible de faire tenir plus de systèmes sur une page en réduisant manuellement la
distance entre des systèmes spécifiques.

Pour réduire la distance entre deux systèmes spécifiques, ajoutez l'Espaceur de portée fixe au bas de la portée du haut puis paramétrez sa hauteur comme souhaité. Si la réduction permet de placer un nouveau système sur la page, cela
sera fait automatiquement.

Ajuster l’espacement sur les pages clairsemées

MuseScore Studio tente de répartir les systèmes et les portées pour remplir une page (pour plus d’informations, voir Espacement vertical). Selon que vous activez ou désactivez la justification verticale, cependant, les pages qui sont
particulièrement clairsemées peuvent s'afficher de façon bizarre. C’est particulièrement commun pour la dernière page d’une partition où d’autres systèmes auraient pu être casés.

Dans la plupart des situations, on peut obtenir de bons résultats en planifiant les sauts de page/système tout au long de la partition pour éviter ces pages excessivement clairsemées. Mais dans les cas où cela n’est pas possible, vous aurez
besoin de décider où placer de l’espacement supplémentaire — uniquement en toute fin de page ; en le répartissant entre le haut et le bas ; en le dispersant entre systèmes ; voire également entre portées.

Pour appliquer tout l’espacement supplémentaire en bas de la page, une des solutions est d’ajouter l'Espaceur au-dessous de la portée sous le dernier système et d’ajuster sa hauteur à la distance appropriée pour remplir l’espace que
vous souhaitez garder dessous. Une autre option est de réduire la Distance max. entre systèmes, ou bien la Distance max. du remplissage de la page (voir Espacement vertical). Ces réglages peuvent aussi affecter d’autres pages mais,
dans la plupart des cas, ils ne seront pertinents que pour les pages spécialement clairsemées.

Pour appliquer un espacement supplémentaire en haut de page, vous pouvez ajouter l'Espaceur au-dessus de la portée sur le premier système.

Pour modifier la distribution de l’espace entre les systèmes et entre les portées au sein des systèmes, vérifiez que l'option Activer la justification verticale des portées est cochée dans Format → Style → Page, puis ajustez le Facteur de
distance entre systèmes. Une valeur de 1,0 signifie que l’espacement est équitablement distribué à l’intérieur et entre les systèmes. Des valeurs plus grandes feront que l’espacement disponible sera davantage attribué entre systèmes
plutôt qu’à l’intérieur de ceux-ci.

Ajuster l’espacement entre systèmes spécifiques

Pour ajouter de l’espace entre deux systèmes spécifiques, ajoutez l'Espaceur au-dessous de la portée sur la portée basse du système supérieur ou l'Espaceur au-dessus de la portée sur la portée haute du système inférieur.

Ajuster l’espacement entre portées spécifiques

Pour ajouter de l’espace entre des portées spécifiques au sein d’un seul système, ajoutez l'Espaceur au-dessous de la portée à la portée du haut ou l'Espaceur au-dessus de la portée à la portée inférieure.

Pour ajouter un espace spécifique sur l’ensemble des systèmes — comme pour séparer l’accompagnement piano des portées de chant choral — faites un clic droit sur la portée inférieure, sélectionnez Propriétés de Portée / Partie et
augmentez la valeur du paramètre Distance supplémentaire au-dessus de la portée.

Utiliser des cadres pour ajouter du contenu

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Vue d’ensemble

Un cadre et un espace rectangulaire dans lequel on peut insérer un ou plusieurs objets texte ou images. Dans la fenêtre de la partition, les côtés du cadre sont marqués par des lignes en pointillé (elles ne seront pas visibles dans une
partition imprimée).

Un cadre peut être de trois types :

Cadre vertical : rectangle de pleine largeur qui peut être inséré avant le premier système, après le dernier système ou entre systèmes ; il peut contenir plusieurs objets texte et/ou images.
Cadre de texte : rectangle de pleine largeur qui peut être inséré avant le premier système, après le dernier système ou entre systèmes ; il ne peut contenir qu'un seul objet texte.
Cadre horizontal : rectangle placé entre deux mesures ; il peut contenir plusieurs objets texte et/ou images.

Remarque : bien que l’on puisse utiliser des cadres pour créer un espacement supplémentaire entre systèmes, il est préférable d’utiliser les espaceurs dans ce but.

Usages des cadres

Des cadres peuvent être utilisés pour :

Afficher les informations en début de la partition de type titre, sous-titre, compositeur, parolier, arrangeur, etc. Cela est réalisé automatiquement pour les nouvelles partitions si on complète les informations associées dans la page 2 de la
Fenêtre de dialogue Nouvelle partition
Afficher des informations sur des mouvements au sein d’une partition
Afficher les paroles à la fin d’une chanson

Créer un espace vide avant un coda.

Etc..

Ajouter des cadres avant, entre ou après un système

Cadres de texte

Un cadre de texte est un rectangle de pleine largeur qui peut être placé : soit avant le premier système, soit après le dernier système, soit entre systèmes. Seul un bloc de texte unique peut être ajouté à ce type de cadre. La hauteur du
cadre est automatiquement ajustée à la hauteur du bloc de texte qu’il contient.

Ajouter un cadre de texte

Sélectionnez une mesure ou un cadre
Appliquez l’une des méthodes suivantes :

Dans la barre de menu, sélectionnez Ajouter → Cadres → Insérer un cadre de texte
Dans la palette Mise en page, cliquez sur l’icône Insérer un cadre de texte
Utilisez un raccourci clavier personnalisé Insérer un cadre de texte (vous pouvez le paramétrer dans la fenêtre de dialogue Préférences: Raccourcis).

Si la mesure sélectionnée est la première dans un système, le cadre sera simplement inséré au-dessus du système. Si la mesure sélectionnée n’est pas la première, cela commencera un nouveau système avec le cadre placé au-dessus

Ajouter du texte

Pour ajouter un bloc de texte dans le cadre de texte :

Faites un double clic sur le cadre ; ou faites un clic droit et choisissez Éditer l’élément ; ou sélectionnez le cadre et utilisez le raccourci F2 ou Alt+Maj+E
Saisissez le texte souhaité.

Le texte est en style Cadre par défaut mais vous pouvez le changer en utilisant Style de texte dans l’onglet Texte du panneau Propriétés.

Cadres verticaux

Un cadre vertical est un rectangle de pleine largeur qui est placé : soit avant le premier système, soit après le dernier système, soit entre systèmes. Plusieurs objets texte et/ou des images peuvent y être ajoutés.

Ajouter un cadre vertical

Sélectionnez une mesure ou un cadre
Appliquez l’une des méthodes suivantes :

Dans la barre de menu, sélectionnez Ajouter → Cadres → Insérer un cadre vertical
Dans la palette Mise en page, cliquez sur l’icône Insérer un cadre vertical
Utilisez un raccourci clavier personnalisé Insérer un cadre vertical (vous pouvez le paramétrer dans la fenêtre de dialogue Préférences: Raccourcis).

Si la mesure sélectionnée est la première dans un système, le cadre sera simplement inséré au-dessus du système. Si la mesure sélectionnée n’est pas la première, cela commencera un nouveau système avec le cadre placé au-dessus
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Ajouter du texte

Pour ajouter un bloc de texte dans le cadre vertical, appliquez une des méthodes suivantes :

Faites un clic droit sur le cadre, sélectionnez Ajouter puis choisissez une des options (Texte, Titre, Sous-titre, Compositeur, Parolier, Nom de partie)
Sélectionnez le cadre et depuis la barre de menu ouvrez Ajouter → Texte puis choisissez une des cinq premières options (Titre, Sous-titre, Compositeur, Parolier, Nom de partie)
Sélectionnez le cadre et utilisez les raccourcis claviers pour ajouter les blocs de texte applicables (vous pouvez les voir dans la fenêtre de dialogue Préférences: Raccourcis).

Ajouter une image

Faites un clic droit sur le cadre vertical
Sélectionnez Ajouter → Image
Recherchez et ajoutez l’image dans la fenêtre Insérer une image.

Taille

La hauteur du cadre vertical est automatiquement ajustée à la hauteur du bloc de texte (ou de l’image) qu’il contient. Mais vous pouvez paramétrer cela en utilisant le paramètre Hauteur dans l’onglet Cadre vertical du panneau Propriétés ou
à l’aide de la poignée d’ajustement.

Position et alignement du contenu

La position d’un objet texte (ou image) qui jouxte directement la bordure d’un cadre vertical ou de texte peut être modifiée en ajustant les marges concernées (gauche, droite, haute, basse) dans l’onglet Cadre vertical ou Cadre de texte du
panneau Propriétés.

Par exemple, un objet aligné à gauche et en haut peut être déplacé par rapport à ces bordures en augmentant la Marge droite et/ou la Marge haut, etc.

Espacement

Dans l’onglet Cadre vertical ou Cadre de texte du panneau Propriétés, ajustez Espace au-dessus et Espace au-dessous pour créer un espace supplémentaire au-dessus/au-dessous du cadre.

Ajouter des cadres entre des mesures

Cadres horizontaux

Un cadre horizontal est utilisé pour créer un espace entre des mesures d’un système particulier, avec du contenu optionnel en texte ou image.

Ajouter un cadre horizontal

Sélectionnez une mesure
Appliquez l’une des méthodes suivantes :

Dans la barre de menu, sélectionnez Ajouter → Cadres → Insérer un cadre horizontal
Dans la palette Mise en page, cliquez sur l’icône Insérer un cadre horizontal
Utilisez un raccourci clavier personnalisé Insérer un cadre horizontal (vous pouvez le paramétrer dans la fenêtre de dialogue Préférences: Raccourcis).

Le cadre est inséré entre la mesure sélectionnée et la suivante.

Ajouter du texte

Pour ajouter un bloc de texte dans le cadre horizontal, faites un clic droit sur le cadre et sélectionnez Ajouter → Texte.

Ajouter une image

Faites un clic droit sur le cadre vertical
sélectionnez Ajouter → Image
Recherchez et ajoutez l’image dans la fenêtre Insérer une image.

Taille

Vous pouvez ajuster la largeur du cadre dans l’onglet Cadre horizontal du panneau Propriétés.

Espacement

Vous pouvez ajuster l’espace de chaque côté du cadre horizontal en utilisant Écart de gauche et Écart de droite dans l’onglet Cadre horizontal du panneau Propriétés.

Autre propriété du cadre horizontal

Afficher les crochets, les clefs et les armures dans la mesure suivante

Voir aussi

Ajouter des mesures à un cadre

Utiliser des images

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Des images peuvent être insérées dans des partitions en les liant à des objets de notation ou à des cadres.

Les formats suivants sont supportés : SVG (*.svg), PNG (*.png), JPEG (*.jpg et *.jpeg), Bitmap (*.bmp), et TIFF (*.tif et *.tiff).

Remarques : (1) SVG est le format recommandé car il vous permet d'ajuster la taille de l'image sans aucune perte de définition. Notez que les fonctions de shading, blurring, clipping et masking ne sont pas prises en charg. (2) PNG supporte
la transparence. (3) Les formats GIF (.gif), WebP (.webp) et X PixMap (*.xpm) ne sont pas supportés.

Utiliser des images

Importer des images

Pour ajouter une image à un cadre vertical ou horizontal :

Faites un clic droit sur le cadre, sélectionner Ajouter puis Image.

Pour attacher une image à un objet de notation :

Faites glisser le fichier image depuis l'extérieur de MuseScore Studio et déposez-le sur une note, un silence ou une mesure.

Remarque : utilisez la méthode précédente pour des petites images associées à des portées musicales, comme des symboles.

Sauvegarder des images dans des palettes

Pour intégrer une image importée dans une palette, voir Ajouter des éléments à partir de votre partition.

Copier des images importées

Une fois que l'image a été importée dans la partition, elle peut être copiée/coupée et collée dans une autre localisation, comme un cadre, une note ou un silence, en utilisant les commandes et la procédure standard (voir Copier et coller).

Ajuster des images

Changer la hauteur et la largeur de l'image

Sélectionnez l'image et utiliser l'une ou l'autre des méthodes suivantes :

Faites glisser l'une et/ou l'autre des poignées d'ajustement.
Éditez les paramètres de “hauteur/largeur d'image” dans la section Image du panneau Propriétés.

Tant que le symbole cadenas est actif (coloré en bleu dans Propriétés : Image), le ratio visuel (hauteur/largeur) de l'image sera conservé. Si vous voulez ajuster un côté indépendamment de l'autre, cliquez sur le cadenas pour le désactiver
(coloré en gris).

Échelle d'image

Pour mettre à l'échelle une image à la hauteur du cadre qui la contient :
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Ajustez le cadre à la hauteur désiré
Cochez “Redimensionner à la taille du cadre” dans la section Image du panneau Propriétés.

Tant que l'option “Redimensionner à la taille du cadre” reste cochée, la taille de l'image suivra la hauteur de cadre.

Ajuster la position d'une image

L'image peut être repositionnée en la faisant glisser ou en ajustant ses paramètres de décalage dans la section Apparence du panneau Propriétés. Ctrl+R restaure l'image à sa position par défaut.

Propriétés d'image

Les propriétés d'une image sélectionnée peuvent être ajustées dans la section Image du panneau Propriétés.

Hauteur de l'image / Cadenas / Largeur de l'image : ajustent les dimensions de l'image. Le cadenas, qui est actif par défaut, assure que le ratio visuel est conservé.
Redimensionner à la taille du cadre : voir Échelle d'image (plus haut).

Utiliser la hauteur d'interligne de portée : quand l'option est cochée (réglage par défaut), la proportion de l'image est automatiquement ajustée au réglage d'échelle défini dans Format → Paramètres de la page et utilise l'unité
d'interligne de portée, Sp. Si l'option n'est pas cochée, la taille de l'image est en mm et n'est pas proportionnelle à l'échelle. Voir
Notions de mise en page.

Cette image a une hauteur de 4 Sp qui lui permet de tenir parfaitement dans l'espace entre les lignes inférieure et supérieure d'une portée de 5 lignes. L'option "Utiliser la hauteur d'interligne de portée" est cochée afin qu'elle soit
affichée proportionnellement à l'échelle de la portée.

Voir aussi

Utiliser les palettes pour s'informer sur la façon d'appliquer des objets palette.

Utiliser des sections pour séparer mouvements ou chansons

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Vue d’ensemble

Un saut de section est utilisé pour diviser la partition en deux sections séparées, comme cela peut être nécessaire dans une suite musicale, par exemple.

Dans l’exemple de partition suivant, il y a un saut de section à la fin du premier système, suivi par un cadre de texte fournissant le titre du mouvement suivant.

Caractéristiques

Un saut de section a les caractéristiques suivantes :

La mesure qui suit le point d’application est forcée à commencer un nouveau système (comme un saut de système)
La lecture s’arrête pendant une pause de durée ajustable entre les mouvements
Il est possible de recommencer la numérotation de mesure
Il est possible d’afficher le nom complet de l’instrument (comme sur le premier système de la partition).

Ces options sont détaillées dans les Propriétés de saut de section (plus loin).

Indications de tempo et armures

Si le début d’une nouvelle section est accompagné d’un changement de tempo ou d’armure, il n’y aura pas d’armure de précaution à la fin de la section précédente.

Ajouter un saut de section

Pour ajouter un saut de section, sélectionnez une mesure, une barre de mesure (ou n’importe quel élément dans une mesure) puis cliquez sur l’icône Saut de section dans la palette Mise en page. Vous pouvez substituer la dernière action
avec un raccourci personnalisé si souhaité (voir Préférences : Raccourcis).

Propriétés de saut de section

Les propriétés de saut de section suivantes sont paramétrables (après avoir sélectionné le saut de section) dans la partie Saut de section du panneau Propriétés.

Pause de lecture

Pour ajuster la durée de la pause de lecture de la partition après un saut de section, éditez Pause avant lecture de la nouvelle section.

Nom des instruments

Pour afficher le nom des instruments en version longue sur le premier système qui suit le saut de section, assurez-vous que Démarrer avec les noms longs d’instruments est coché.

Numérotation des mesures

Pour redémarrer la numérotation des mesures après le saut de section, assurez-vous que Réinitialiser la numérotation des mesures est coché.

D’autres paramètres pour les numéros de mesures sont disponibles dans la fenêtre de dialogue Propriétés de la mesure.

Gestion des fichiers

Ouvrir et enregistrer les partitions

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Vue d’ensemble

Vous pouvez sauvegarder vos fichiers localement sur votre ordinateur mais aussi en ligne ("sur le cloud") dans votre compte musescore.com. Si vous n’avez pas encore de compte, vous pouvez en créer un gratuitement ici .

Dans le cas de partitions enregistrées en ligne, MuseScore Studio conserve également une copie sur votre ordinateur de façon à ce que vous puissiez travailler sur ces fichiers, même sans connexion Internet. Chaque fois que vous
sauvegardez une "partition en ligne", la copie sur musescore.com est également mise à jour. Ce système protège l’intégrité à la fois des enregistrements locaux/en ligne, tout en offrant des avantages du stockage en ligne tels que la
sauvegarde, l’affichage et la lecture via des dispositifs multiples, la facilité du partage, la possibilité de commenter et bien d’autres.

Notez que si vous téléchargez une de vos partitions depuis musescore.com et que vous l’ouvrez dans MuseScore, le fichier sera considéré comme nouveau, avec un fichier enregistré localement distinct du fichier en ligne.

Ouvrir une partition
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Il existe plusieurs façons d’ouvrir une partition dans MuseScore Studio.

Fichier → Ouvrir

Cela ouvre votre navigateur de fichiers, vous permettant de sélectionner et d’ouvrir les fichiers enregistrés sur votre ordinateur ou le dispositif de stockage &mdash la fenêtre de dialogue sera différente selon le système d’exploitation (OS).
Raccourcis Windows/Linux : Ctrl+O. MacOS : Cmd+O

Fichier → Partitions récentes

Cette option vous permet de choisir dans une liste de partitions récemment ouvertes.

Onglet Accueil → Partitions

La fenêtre Partitions affiche les fichiers les plus récemment modifiés. Faites un double clic sur n’importe quelle image miniature pour l’ouvrir. Vous pouvez aussi cliquer sur le bouton Ouvrir un autre fichier pour accéder aux fichiers
enregistrés localement depuis la fenêtre de votre navigateur de fichiers.

Les partitions qui ont été sauvegardées dans le cloud sont signalées par une icône nuage. À la différence des partitions locales, il n’est pas possible de renommer un fichier du cloud depuis le navigateur de fichiers de votre ordinateur. Vous
pouvez cependant le faire dans le gestionnaire de fichiers de musescore.com. Vous pouvez y aller directement en cliquant sur le bouton Gestionnaire de partitions (en ligne) dans la fenêtre Partitions.

Il est possible d’ouvrir simultanément plusieurs partitions. Dans ce cas, MuseScore Studio ouvre chaque partition dans une fenêtre séparée.

Formats d’importation de fichiers

En dehors de ses formats natifs  (*.mscz et *.mscx), MuseScore Studio peut aussi ouvrir les formats MusicXML , MusicXML compressé  et Midi . Vous pouvez personnaliser les paramétrages d’importation dans Édition →
Préférences → Importer.

Enregistrer une partition

Pour enregistrer une partition :

Allez dans le menu Fichier
Choisissez l’une des options suivantes :

Option Action Raccourci

Enregistrer
Enregistre la partition actuelle dans un nouveau fichier ou ses modifications
dans un fichier précédemment enregistré

Windows/Linux : Ctrl+S, MacOS : Cmd+S

Enregistrer sous Enregistre la partition actuelle dans un nouveau fichier Windows/Linux : Maj+Ctrl+S, MacOS : Maj+Cmd+S

Enregistrer une copie
Enregistre la partition actuelle dans un nouveau fichier tout en permettant de
continuer d’éditer le fichier originel

Aucun

Enregistrer la sélection Enregistre les mesures sélectionnées dans un nouveau fichier Aucun

Enregistrer dans le cloud Sauvegarde le fichier sur musescore.com Aucun

La première fois que vous utilisez l’une de ces options Enregistrer, une fenêtre de dialogue s’ouvre pour demander "Comment voulez-vous enregistrer ?" en offrant les options Dans le cloud (gratuit) et Sur votre ordinateur.

Pour désactiver cette fenêtre, cocher la case Ne plus afficher pour vous assurer que seule la fenêtre native de votre système d’exploitation soit visible lors des prochains enregistrements.

Enregistrer sur l’ordinateur

L’option Enregistrer sur l’ordinateur ouvre la fenêtre "Enregistrer" de votre système d’exploitation et vous permet de sauvegarder la partition au format (compressé) MuseScore : .mscx

Il est également affiché une option pour enregistrer les fichiers dans un format non compressé (Type "Dossier MuseScore non compressé (expérimental)"). Cette option crée un nouveau répertoire (du nom choisi) sur votre ordinateur qui
contient un fichier MuseScore (.mscx) ainsi qu’une image miniature (.png) et des fichiers appropriés de type .json, .mss, et .xml.

Enregistrer dans le cloud

Les partitions enregistrées en ligne (dans le cloud) apparaissent dans la fenêtre Partitions avec une icône nuage sur le coin supérieur gauche de la miniature du fichier. Une copie locale est automatiquement enregistrée sur votre ordinateur.

Pour sauvegarder une partition dans le cloud, choisissez Enregistrer dans le cloud. Cela ouvre une fenêtre de dialogue avec les options suivantes :

Nom

C’est le nom sous lequel votre partition sera identifiée sur musescore.com.

Visibilité

Privé vous permet d’enregistrer et de modifier votre partition sans que d’autres personnes puissent voir votre travail en ligne
Public rend votre partition visible par tous sur musescore.com.

Quand vous êtes prêt, cliquez sur Enregistrer.

La première fois que vous réalisez cette action, MuseScore Studio vous demandera si vous voulez générer un fichier audio MP3 pour la lecture en ligne dans musescore.com. Vous pouvez choisir l’une des trois options suivantes :

Jamais

Chaque fois que vous cliquerez sur Enregistrer, seule la partition elle-même sera téléchargée sur musescore.com. Sa lecture en ligne utilisera la soundfont MS Basic.

Toujours

Chaque fois que vous cliquerez sur Enregistrer, MuseScore Studio génèrera un fichier .mp3 pour le télécharger en même temps que votre partition. La lecture de la partition sur MuseScore Studio aura le même rendu sonore que sur votre
ordinateur (y compris la lecture avec les sons de la bibliothèque Muse Sounds si vous l’avez installée, d'instruments VST ou de tout effet que vous avez ajoutés).

Tous les x enregistrements

MuseScore Studio ne génèrera et ne téléchargera un fichier .mp3 file que dans l’intervalle spécifié.

Ces paramétrages n’affectent que vos partitions privées dans le cloud. On ne vous demandera de préciser ce choix qu’une seule fois mais vous pouvez cependant modifier ce paramétrage à n’importe quel moment en vous rendant sur
Édition → Préférences → Cloud.

Une fois que vous avez cliqué sur OK, MuseScore Studio confirmera que votre partition a été sauvegardée. Votre fichier sera accessible à la fois dans l’onglet Accueil et dans le gestionnaire de partition sur musescore.com.

Lien externe

Publier et sauvegarder sur le cloud  (YouTube, en anglais)

Exportation de fichiers

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Vue d’ensemble

Ce chapitre est consacré à l’enregistrement des fichiers MuseScore dans des formats autres que les formats natifs (*.mscz and *.mscx), tels que MusicXML, MIDI, MEI, MP3, PDF, PNG etc.

Exporter votre partition

Pour exporter une partition :

Sélectionnez Fichier → Exporter
Choisissez un Format dans la liste déroulante
Sélectionnez les parties à exporter en cochant / décochant les cases appropriées sur la gauche de la fenêtre de dialogue
Si vous voulez combiner toutes les parties en un fichier, cliquez sur le bouton radio intitulé Toutes les parties combinées en un seul fichier
Cliquez sur Exporter...

Formats de fichier

Formats graphiques

PDF est un format universel pour textes, images, musique, etc. Théoriquement, tout ordinateur possède un lecteur PDF dédié ; sinon, un fichier PDF peut aussi être ouvert avec des navigateurs Internet tels que Firefox, etc.
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Utilisez ce format quand vous voulez créer des partitions musicales à faire lire par d’autres musiciens. Les partitions PDF peuvent aussi être imprimées sur document papier si besoin.

PNG est un format graphique compressé qui peut être intégré dans tous les types de documents.
SVG est un format qui permet de préserver la plus haute résolution graphique et autorise le redimensionnement de l’image.

Formats audio

MuseScore Studio vous permet d’exporter des fichiers audio dans de nombreux formats compressés : MP3 est le plus connu mais OGG et FLAC ont aussi leurs avantages. Ces formats combinent le bénéfice d’une taille relativement réduite
et d’une excellente qualité audio.

Si vous voulez un format non compressé, choisissez le format WAV. La taille du fichier sera considérablement plus grande que les options de fichiers audio compressés.

Format MIDI

MIDI (Musical Instrument Digital Interface), un standard bien établi dans l’industrie musicale, encode les notes et l’instrumentation d’une partition originale. Il peut être lu avec un lecteur de média pour PC ou une application compatible
dès lors que les bons instruments informatiques (logiciels ou matériels) sont disponibles pour l’interprétation.

Vous devez être conscient que le son généré par un fichier MIDI dépend des instruments virtuels utilisés pour la lecture, ce qui peut rendre un son de qualité différente par rapport à l’original. De même, il ne conserve pas la mise en forme de
la partition ni les voix.

Formats de notation musicale

MusicXML est un standard universel qui pour objet de préserver le mieux possible la mise en page originale de la partition. Il peut être ouvert par n’importe quel logiciel moderne d’édition musicale. MuseScore Studio utilise MusicXML
4.0.

Braille ou BRF (Braille Ready Format), est un format de texte brut qui permet de stocker des textes écrits ou des documents musicaux destinés à être utilisés par des personnes aveugles. Ces fichiers peuvent être ouverts dans un
logiciel tiers pour être lus avec un afficheur braille électronique ou imprimés sur du papier sous forme de points en relief.

Les fichiers Braille de MuseScore utilisent le format bar over bar (mesures superposées), ce qui signifie qu'il y a une ligne Braille distincte pour chaque portée, et que les mesures sont alignées verticalement entre les portées. (Une alternative
serait le format bar by bar (mesure l’une après l’autre) ou section par section, où une ou plusieurs mesures sont écrites pour la première portée, suivi de ces mêmes mesures pour la portée suivante, et ainsi de suite, le tout sur une seule
ligne Braille. MuseScore Studio ne prend actuellement pas en charge ce format.) Les fichiers utilisent le codage de caractères ASCII plutôt qu'Unicode, donc les utilisateurs voyants qui ouvrent ces fichiers devront installer une police Braille
afin de voir les caractères Braille sous forme de points.

Les fichiers Braille de MuseScore Studio sont conformes au North American Music Braille Code 2015 , mais de nombreuses fonctionnalités doivent encore être implémentées, vous pourriez donc exporter en MusicXML, puis utiliser un outil
de conversion MusicXML en Braille tiers, comme l'outil Web gratuit SM Music Braille .

MEI (Music Encoding Initiative) est un format XML ouvert qui représente la structure sémantique des documents de notation musicale et qui est développé dans le cadre d'un effort communautaire. Le support MEI dans MuseScore
Studio se limite à MEI Basic, un sous-ensemble de la MEI qui facilite son utilisation pour l'échange de données et améliore l'interopérabilité. Le support la MEI dans MuseScore Studio est disponible à partir de la version 4.2 et est
documenté ici .

Personnaliser les paramètres d’export

[À ajouter]

MIDI import

MIDI import panel not currently implemented, making this section largely moot

Travailler avec des fichiers MusicXML

Vue d’ensemble

MusicXML est un format de fichier universel qui permet de partager de la musique entre différents programmes de notation musicale. Par exemple, Vous pouvez convertir un fichier MuseScore .mscz dans un format MusicXML puis l’ouvrir
dans Sibelius, Finale ou n’importe quel autre logiciel d’écriture musicale compatible ; et vice versa.

MusicXML reproduit fidèlement les notes et l’instrumentation mais, toutefois, il est habituellement nécessaire de réaliser quelques actions de nettoyage pour rendre à la partition transférée exactement le même aspect que la partition
originale.

Ouvrir un fichier MusicXML

Quand un fichier MusicXML est ouvert pour la première fois dans MuseScore Studio, les positions et propriétés personnalisées des objets texte sont préservées aussi bien que possible. Il peut aussi y avoir d’autres personnalisations visibles
dans la partition que vous ne pouvez pas ou pourriez ne pas souhaitez conserver.

Nettoyer une partition importée

Restaurer les hampes de notes

Pour remettre les hampes de toutes les notes dans leurs positions et orientations par défaut :

Faites un clic droit sur une note et choisissez Sélectionner → Similaire
Tapez Ctrl+R.

Restaurer les espaces devant les notes

Pour remettre les espaces devant toutes les notes au paramétrage par défaut de la partition :

Faites un clic droit sur une note et choisissez Sélectionner → Similaire
Cliquez sur le bouton Apparence dans le panneau Propriétés
Si le bouton de remise à zéro (flèche circulaire) de Espace devant est actif , cliquez dessus pour revenir au paramétrage par défaut de la partition ; dans l’autre cas, aucune action supplémentaire n’est requise.

Supprimer les sauts

Pour supprimer tous les sauts —de système, page et section :
1. Faites un clic droit sur un saut et choisissez Sélectionner → Similaire
2. Tapez Suppr.

Pour ne supprimer que les sauts de système (en gardant en place les sauts de section et de page) :

Dans le menu principal, sélectionnez Format → Ajouter / Supprimer des sauts de système
Sélectionnez Supprimer les sauts de système actuels
Cliquez sur OK pour fermer la fenêtre de dialogue.

Restaurer les styles de texte par défaut

Pour remettre tous les objets textes dans la partition et dans les cadres à leurs paramètres de styles par défaut :

Dans le menu principal, sélectionnez Format → Style
Cliquez sur le bouton marqué Réinitialiser tous les styles
Cliquez OK pour fermer la fenêtre de dialogue.

Ouvrir Format → Style → Styles de Texte pour voir la liste des styles et les valeurs des propriétés.

Retour aux positions de texte par défaut

Cadre

Pore restaurer les positions de tous les objets textes dans les cadres :

Faites un clic droit sur un objet texte dans un cadre
Choisissez Sélectionner → Similaire
Tapez Ctrl+R.

Texte de partition

Vous pouvez appliquer la même méthode que celle utilisée dans les cadres pour les objets texte dans la partition. Cependant, vous aurez à répéter cela pour chaque classe individuelle d’objet — tous les textes de tempo, les textes de portée,
etc.

Préparer l’export d’une partition

Pour exporter une partition comme fichier MusicXML, voir Exportation de fichiers.
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Paramétrage d’export

Quand vous exportez une partition vers un fichier MusicXML, vous pouvez choisir entre un format compressé (l’option par défaut) ou non compressé ; et décider si vous voulez exporter tous les sauts ou pas, ou pour autoriser uniquement les
sauts ajoutés manuellement à apparaître dans le fichier.

[À ajouter :

ajustements manuels, mauvais usage de types d’éléments, images...
paramétrage d’export]

Backup and recovered files

TBD

Propriétés des partitions

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Vue d’ensemble

La fenêtre de dialogue Propriétés de la partition contient des étiquettes de métadonnées, informations digitales éditables du fichier. Toutes les partitions créées avec MuseScore Studio contiennent les étiquettes prédéfinies suivantes.
Certaines d'entre elles sont automatiquement assignées avec les informations fournies par l'utilisateur dans la fenêtre de dialogue Nouvelle partition : voir le chapitre Configurer votre partition.

Propriété Détails

Titre de partition contient le texte du "Titre" fourni dans la fenêtre de dialogue Nouvelle partition.

Sous-titre contient le texte du "Sous-titre" fourni dans la fenêtre de dialogue Nouvelle partition.

Compositeur contient le nom du "Compositeur" fourni dans la fenêtre de dialogue Nouvelle partition.

Arrangeur

Parolier contient le nom du "Parolier" fourni dans la fenêtre de dialogue Nouvelle partition.

Traducteur

Copyright
contient le texte de "Copyright" fourni dans la fenêtre de dialogue Nouvelle partition. Vous êtes libre de copier et
d'utiliser ce symbole de copyright suivant : ©

Numéro de l'œuvre

Titre du mouvement

Numéro du mouvement

Date de création
Date de la création de la partition. Ce champ peut être vide si la partition avait été sauvegardée en mode test (voir
Options de la ligne de commande). Éditez-la de façon manuelle si vous êtes le fantôme de Beethoven.

Plateforme
Plateforme informatique sur laquelle la partition a été créée. Elle peut être vide si la partition a été enregistrée en
mode test.

Source Peut contenir le lien URL si la partition a été téléchargée ou publiée sur MuseScore.com.

URL Audio.com

Version de Musescore Non éditable. La version utilisée lors de la dernière sauvegarde de la partition

Chemin du fichier Non éditable. La localisation du fichier sur votre ordinateur.

Remarques :

une partition créée à partir d'un modèle contient un cadre vertical en haut de page et des objets Texte Musescore sur la première page. Ces objets, tels que Titre, Sous-titre, etc. sont aussi automatiquement remplis avec les
informations fournies par l'utilisateur dans la fenêtre de dialogue Nouvelle partition mais ils ne sont pas reliés aux étiquettes de métadonnées (voir le chapitre Saisir et éditer du texte.
Les étiquettes des métadonnées originalFormat et poet, automatiquement créées avec les versions précédentes de Musescore, ne le sont plus dans MuseScore Studio.

Modifier les propriétés de la partition

Pour changer une propriété de la partition :

Dans le menu, choisissez Fichier → Propriétés de la partition...
Éditez l'étiquette souhaitée

Ajouter de nouvelles propriétés

Pour ajouter une nouvelle étiquette personnalisée de métadonnée, cliquez sur le bouton Nouvelle propriété. Renseignez le champ "Propriété" et cliquez sur OK

Pour supprimer une étiquette, cliquez sur l’icône poubelle correspondante. Il n’est pas possible de supprimer les métadonnées prédéfinies.

Accéder aux propriétés de votre partition

La seule façon d'ajouter des propriétés de partition (étiquettes de métadonnées) sur la partition est d'y faire référence dans l'en-tête ou le bas de page : voir le chapitre En-tête et pied de page.

Score comparison

not currently implemented

Publier sur musescore.com

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Vue d’ensemble

Avant de commencer ce chapitre, il est nécessaire de comprendre que les entités suivantes sont distinctes :

MuseScore Studio est un projet de logiciel de notation de musique open source pour ordinateur (Windows, macOS, Linux).
musescore.org rassemble des volontaires du monde entier pour contribuer au projet.
musescore.com est une entreprise commerciale de partage de partitions de musique.

Vous pouvez publier dans musescore.com soit directement, soit depuis MuseScore Studio mais gardez à l'esprit que les volontaires musescore.org ne sont pas capables de manipuler chacune des publications liées à
musescore.com comme les souscriptions payées, la propriété, les droits d'auteur, la demande de licence, le piratage, etc. Voir How and where to ask for support  (en anglais).

Vous pouvez choisir de garder vos partitions privées ou d'autoriser d'autres personnes à les lires ou les télécharger. Pour utiliser cette fonction, il est nécessaire d'ouvrir un compte sur musescore.com, qui peut être un compte gratuit ou
payant (voir aussi Ouvrir et enregistrer les partitions).

Coûts et revenus de publication

Le site musescore.com semble mettre en avant la fonction virtuellement gratuite de service de partage de partitions plutôt que d'aider les auteurs à générer des revenus. Néanmoins, il donne des précisions abondantes sur la façon dont
les partitions hébergées sont utilisées . La plateforme n'a pas encore ouvertement et directement travaillé sur le partage des revenus avec les auto-éditeurs et compositeurs individuels. Elle a commencé à collaborer avec les éditeurs , en
réponse aux plaintes sur la protection des droits d'auteur . Si vous êtes musicien à la recherche de revenus, essayez des méthodes alternatives comme celles listées dans https://music.stackexchange.com/questions/696/sites-with-a-
good-selecti…  (en anglais).
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Droits de publication

Respectez le copyright. Au même titre que vous détenez les droits d'une musique que vous créez, les autres possèdent le copyright pour celle qu'ils créent. Vous pouvez transcrire dans MuseScore Studio de la musique dont les droits sont
détenus par d'autres personnes mais vous ne gagnez pas nécessairement des droits sur la partition musicale qui en résulte.

Ce chapitre utilise une définition générale du terme "publier". Pour éviter les confusions, seul l'acte de télécharger/sauvegarder du contenu sur un serveur en ligne est considéré comme de la "publication". Vous devriez faire attention à la
définition de "publier" utilisé par les licences contractuelles légales. D'après https://www.copyright.gov/help/faq-definitions.html  : "... La publication correspond à la distribution de copies ou d'enregistrements d'un travail vers le public ..." Une
partition peut être mise en ligne comme "non répertoriée" (unlisted), ce qui signifie qu'elle ne peut être recherchée de façon publique ou affichée dans un catalogue publique, mais la partition peut probablement être considérée comme
publique.

Dans le post Copyright Infringement  [violation des droits d'auteur] publié sur le forum, il est noté [traduction en français] :
"... Pour une reprise, vous avez besoin de la permission de celui à qui appartient le copyright (cela peut être l'auteur, l'éditeur, les héritiers, etc.) ..."
"... Vous ne pouvez pas publier un morceau, même avec une licence de l'auteur original, sans signaler que la licence inclut aussi la cession des droits spécifiques à MuseScore BVBA comme le requiert le contrat de service ; cependant, ce
n'est pas nécessaire si (également) une autre licence adaptée est présente, comme toutes les licences Open Source / Open Knowledge. Le contrat de service requiert aussi (dans la même veine) que celui qui publie abandonne certains
droits moraux de l'artiste ..."

Dans le post Would somebody tell me what is original music?  [Est-ce que quelqu'un peut me dire ce qu'est de la musique originale ?], il est écrit : ... "Si vous n'avez pas délibérément basé votre partition sur une autre composition, vous
pouvez la publier comme originale. S'il apparaît qu'elle ressemble à une composition connue, cela sera signalé par quelqu'un. Si elle est proche d'une partition à droits d'auteur, elle peut être rétrogradée (rendue privée) sans causer de
problème ..."

Dans https://bernardgreenberg.com/MuseScore.html  (de Bernie/BSG, un volontaire de longue date, conseiller musical sur musescore.org et musescore.com), le 29 juin 2021 : "... Le responsable en chef produit (CPO) de MuseScore.com,
David Mandelstam, a posté, dans une discussion publique avec moi, que le site (musescore.com) est le catalogue de musique libre le plus grand au monde. Ce n'est pas un média social ni un site hébergeant des partitions ..."

Le dernier et non le moindre, dans https://musescore.com/community-guidelines  : "... Traitez les gens comme vous souhaiteriez être traité ..."

Créer un compte MuseScore

Rendez-vous sur www.musescore.com
Cliquez sur Log in — c’est au coin droit supérieur de la fenêtre
Dans la fenêtre de dialogue qui apparaît, cliquez sur Create an account — c’est le bouton en bas à droite de la fenêtre
Si votre navigateur est déjà authentifié par un compte Google, Facebook ou Apple, vous pouvez vous enregistrer avec ces services en cliquant sur le bouton approprié
Si vous préférez vous enregistrer avec une autre adresse email, remplissez les champs restant et cochez la case "Je ne suis pas un robot"
Cliquez sur Create new account

Sauvegarder uniquement sur musescore.com

La première fois que vous enregistrez une partition sur votre ordinateur, on vous demandera si vous voulez publier la partition sur musescore.com.

Si vous n’êtes pas connecté à musescore.com ou que vous n’avez pas encore de compte, vous aurez besoin de vous connecter.

Il vous sera demandé si l’enregistrement doit être Public, Non répertorié ou Privé.

Les partitions publiques (Public) sont visibles par tous sur Internet.
Les partitions non répertoriées (Unlisted) sont visibles par tous sur Internet mais ne sont pas affichées dans les résultats de recherche. Seules les personnes disposant du lien seront capables de trouver une partition non répertoriée.
Les partitions privées (Private) ne sont visibles que par vous. Vous devez être connecté à votre compte musescore.com pour les voir.

Si vous être en train de publier une partition que vous avez déjà publiée au moins une fois, vous pouvez choisir de remplacer la partition existante ou de la publier comme nouvelle partition en ligne.

On vous demandera si vous voulez aussi télécharger votre audio sur musescore.com. Voir Gérer la création de mp3 pendant la sauvegarde (plus bas)
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MuseScore Studio vous signalera quand cela sera terminé. Les grandes partitions peuvent nécessiter beaucoup de temps pour la création de fichiers MP3.

Publier les partitions enregistrées localement

Les partitions enregistrées sur votre ordinateur peuvent aussi être publiées sur Musescore.com mais elles ne sont pas automatiquement mises à jour.

Pour publier une partition sur Musescore.com
* Cliquez sur l’onglet Publier (sous la barre de menu)
* Cliquez sur Publier sur Musescore.com

Visibilité dans le gestionnaire de partitions

Les partitions publiées uniquement sur Musescore.com sont signalées par une icône nuage dans le gestionnaire de partitions de MuseScore Studio.
MuseScore Studio garde aussi des copies locales sur votre ordinateur, ce qui vous permet de travailler avec ces partitions sans connexion Internet active.

Gérer la création de mp3 pendant la sauvegarde

Quand on enregistre un fichier en ligne, MuseScore Studio crée un fichier audio MP3 de votre partition. En fonction de sa longueur et du nombre d’instruments, cela peut prendre du temps. Pour contrôler cette fonction :

Dans le menu, choisissez Édition → Préférences... → Cloud

Sous Générer un fichier audio MP3 pour vos partitions privées sur le cloud choisissez Jamais, Toujours, ou Tous les x enregistrements.

Jamais

Chaque fois que vous cliquez sur Enregistrer, seule la partition elle-même sera téléchargée sur musescore.com. La lecture en ligne de la partition utilisera la soundfont MS Basic.

Toujours

À chaque enregistrement, MuseScore Studio créera un fichier .mp3 qui sera téléchargé en même temps que la partition. La lecture dans musescore.com aura le même rendu sonore que si elle était réalisée sur votre ordinateur (avec
les sons de la bibliothèque Muse Sounds si elle a été installée et avec les autres effets ou instruments virtuels VST que vous auriez ajoutés).

Tous les x enregistrements

MuseScore Studio ne créera et téléchargera un fichier .mp3 que selon l’intervalle défini.

Si vous choisissez Tous les x enregistrements, précisez le nombre d’enregistrements
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Partager sur Audio.com

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘Documentation’ du forum .]

Vue d’ensemble

En plus de la publication de votre partition sur MuseScore.com , vous pouvez partager l’audio MP3 généré par MuseScore Studio sur Audio.com , un service gratuit de Muse Group. Sur Audio.com, vous pouvez partager vos pistes de
façon publique, les rendre disponibles en téléchargement et mettre en ligne des fichiers audio sans qu'ils apparaissent sur une liste ("Non répertorié").

Pour partager un fichier audio à partir de votre partition sur Audio.com

À partir de MuseScore 4.1

Ouvrez l’onglet Publier
Cliquez sur le bouton Partager sur Audio.com… dans la barre d’outils

Si vous ne vous êtes pas encore connecté à un compte audio.com, il vous sera demandé de le faire ou de créer un compte
Saisissez un titre, choisissez comment le fichier sera partagé entre Public ou Hors listé puis cliquez sur Partager

Audio.com ouvrira votre navigateur pour télécharger le fichier audio
À partir de ce point, vous pouvez définir le titre* (Audio Title), l’URL* (Permalink), la catégorie* (Category), les mots clefs (Tags), la description (Description), les permissions de partage (Public, Unlisted, Allow other users to download
this file) et télécharger les permissions sur votre fichier audio (Save).
* le titre, l’URL et la catégorie sont des champs obligatoires sur le site.

Pour partager sur Audio.com chaque fois que vous publiez une partition

À partir de MuseScore 4.2

La première fois que vous publiez une partition, il vous sera proposé de faire un partage sur Audio.com. Vous pouvez choisir d'avoir cette notification chaque fois que vous publiez. Cela peut être paramétré dans Édition → Préférences.

Ouvrir Préférences
Aller dans l'onglet Sauvegarder et publier
Cochez Toujours demander de partager sur Audio.com après publication sur MuseScore.com

Son et lecture sonore de la partition

Commandes de lecture

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Vue d'ensemble

Les fonctions de lecture de base sont accessibles depuis le panneau Commandes de lecture en haut à droite de la fenêtre du programme. De gauche à droite, les icônes sont :

Aller au début : la lecture revient au début de la partition ou au début de la boucle (le cas échéant)
Jouer (espace) : voir Démarrer/arrêter la lecture
Lecture en boucle : voir Activer/Désactiver la lecture en boucle
Métronome : active/désactive les battements du métronome durant la lecture
Paramètres de lecture : ouvre la fenêtre de dialogue Autres commandes (voir ci-dessous).
Temps écoulé entre le début de la partition et la position du curseur
Numéro de mesure et de temps à la position du curseur
Moniteur de tempo (voir la section "Position de lecture et moniteur de tempo").

Détachez la barre d'outils pour afficher le panneau lecture et accéder à des commandes supplémentaires : voir la section Position de lecture et moniteur de tempo.

Commandes de lecture

Démarrer/arrêter la lecture

Pour reproduire toutes les parties instrumentales

Cliquez sur une note ou un silence pour établir le point de départ
Appuyez sur le bouton Jouer ou sur Espace.

Pour reproduire uniquement les parties instrumentales sélectionnées

Sélectionnez une mesure à partir de laquelle vous voulez commencer (en cliquant sur un espace vide dans cette mesure)
Pour lire plus d'une partie instrumentale, étendez la sélection vers le haut ou vers le bas selon les besoins
Appuyez sur le bouton Jouer ou sur Espace.

Remarques : (1) Si aucune sélection n'est effectuée avant d'activer la lecture, la lecture revient à l'endroit où elle s'était arrêtée précédemment ; ou, s'il n'y a pas eu de lecture précédente, au début de la partition. (2) Le bouton Jouer se
transforme en icône Pause pendant la lecture de la musique.

Pour arrêter la lecture
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Appuyez sur le bouton Jouer (icône Pause) ou sur Espace.

Aller au début

Pour revenir au début de la lecture, cliquez sur l'icône Aller au début dans le panneau de lecture. Cette action ramène la lecture au début de la partition ou, si une boucle est définie, au début de la boucle.

Lire un passage en boucle

Pour lire en boucle une section de musique :

Arrêtez la lecture (si elle est activée)
Assurez-vous que le bouton Lecture en boucle est désactivé (c'est-à-dire qu'il n'est pas coloré en bleu) 
Sélectionner une plage de mesures dans la partition, englobant les portées d'instruments que vous souhaitez reproduire 
Cliquez sur le bouton Lecture en boucle dans le panneau de lecture. Des drapeaux apparaissent autour de la sélection et le bouton change de couleur
Cliquez sur le bouton Jouer.

Dans l'exemple ci-dessous, la lecture parcourt les trois mesures sélectionnées de Flûte 2 et Flûte 3, la zone est marquée par les drapeaux bleus. Utilisez le bouton Lecture en boucle pour activer ou désactiver la boucle.

Il est également possible de positionner directement les drapeaux pour délimiter le début et la fin de la plage à lire en boucle, surtout si le passage à répéter s'étend sur plusieurs pages :
1. Cliquez sur la note (ou le silence) où doit commencer la boucle
2. Dans le panneau de lecture, cliquez sur le bouton Définir le marqueur de boucle de gauche (accessible directement si le panneau est détaché ou après avoir cliqué sur l'icône roue dentée)
3. Cliquez sur la dernière note (ou silence) de la section à répéter
4. Cliquez sur le bouton Définir le marqueur de boucle de droite.

Remarque : dans ce cas, la lecture concerne l'ensemble des systèmes (mais on peut utiliser le Mélangeur pour ajuster le volume de chaque instrument en fonction des besoins).

Utiliser le métronome

Pour ajouter automatiquement le son du battement de métronome lors de la lecture, utilisez le bouton métronome.

Le nombre de battements joués dans chaque mesure est déterminé à la fois par :
- le rythme. Le nombre de battements par mesure est uniquement dicté par l'indication de mesure ; elle ne dépend pas du style de ligature ou de la note (valeur, durée) utilisée comme marqueur de tempo (l'utilisation de la noire ♩ = 60 ou de
la croche ♪ = 120 comme marqueurs donnent des résultats identiques)
- le tempo écrit sur la partition
- le réglage courant du curseur de moniteur de tempo de lecture (voir la section "Position de lecture et moniteur de tempo".

La logique suivante est utilisée :

Pour les rythmes simples, le nombre supérieur de l'indication de mesure correspond au nombre de battements de chaque mesure : 2 = doubles, 3 = triples, 4 = quadruples. Un son de métronome est joué à chaque battement.

Pour les rythmes composés (6/8, 9/8, etc.), le nombre de battements dans chaque mesure correspond au nombre supérieur de l'indication de mesure divisé par 3 : 6 = doubles, 9 = triples, 12 = quadruples. Un son de métronome est
joué à chaque battement. Deux sons supplémentaires par battement sont ajoutés dans les passages musicaux lorsque le tempo réel est joué à un rythme inférieur à 60 battements par minute ; ce chiffre 60 ne fait pas référence au
symbole de métronome utilisé dans le coin haut droit du panneau/de la barre d'outils de lecture.

L'image affichée ci-dessus est une démo du résultat des combinaisons de réglage de tempo. Le fichier de partition de démonstration est disponible dans la section Liens externes. Pour une mesure utilisant 9/8 avec une noire pointée ♩.
= 59 en marqueur de tempo écrit et un moniteur de tempo de lecture à 100%, neuf sons de métronome sont joués. Utiliser une croche ♪ = 179 pour l'indicateur de tempo donne le même résultat. Alors que pour une mesure utilisant 9/8,
un marqueur de tempo en noire pointée ♩. = 60 et un moniteur de tempo à 100%, trois sons sont ajoutés. Le même résultat est obtenu avec une croche ♪ = 180 en marqueur de tempo. Diminuer le curseur du moniteur de tempo à 90%
crée neufs sons dans cette mesure.

Le Métronome par défaut utilise MS Basic. Il inclut deux extraits de sons : un fort (T1) et un faible (T2). T1 est utilisé comme tout premier battement de chaque mesure. T2 est utilisé dans toutes les autres places. Une source alternative de
son peut être sélectionnée dans le Mélangeur. T1 est joué en Mi5, et T2 en Fa5.

Ces sons sont ajoutés à n'importe quel fichier audio exporté. Pour obtenir davantage de contrôle sur les sons de métronome dans le fichier audio ou lors de la lecture, essayez cela :

Ajoutez une portée de percussion, remplissez la première mesure avec le rythme désiré et le reste avec des signes de répétition de mesure, puis masquez cette portée (source )
Utilisez Metronome SoundFont (CC0)  fourni par mirabilos,
Utilisez le plugin Add metronome part  par sal.vador.

Position de lecture et moniteur de tempo

La position de lecture actuelle est indiquée par deux compteurs à droite des commandes de lecture. L'un montre la position en termes de temps écoulé, l'autre en mesures et temps (voir l'image dans la Vue d'ensemble). Pour sauter
manuellement à un moment, une mesure ou un battement donné, cliquez sur un des compteurs et modifiez sa valeur.

L'item complètement à droite est le moniteur de tempo. Il affiche le tempo qu'aurait la musique en noires par minute à la position actuelle du curseur. Il ne reflète pas l'apparence exacte du tempo écrit dans la partition. Sa valeur noire n'est
pas reliée au battement musical de la partition.

Pour révéler des commandes supplémentaires, détachez la barre d'outils de lecture. Cliquez sur l'icône "6 points" et maintenez appuyé pour faire glisser le panneau Lecture depuis sa position en haut à droite de l'écran de MuseScore Studio
puis relâchez (voir le chapitre Barres d'outils et fenêtres : Détacher ou ancrer les panneaux. La barre d'outils détachée s'agrandit automatiquement en un petit panneau de lecture qui affiche deux curseurs. Le curseur du haut montre la
position actuelle de la lecture. Le curseur du bas affiche le moniteur de tempo de lecture. Ce dernier modifie temporairement la vitesse de lecture sans modifier les réglages de chaque indication de tempo écrite dans la partition.
Remettre le curseur à sa position par défaut, 100%, restaure le tempo à sa valeur écrite dans la partition.
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Dans la capture d'écran précédente, le bouton sur le curseur du haut position de lecture actuelle est d'environ un tiers de la gauche, suggérant que la lecture est environ à un tiers de la partition. Le bouton du curseur inférieur moniteur de
tempo de lecture et réglé légèrement à droite de la position par défaut. Il affiche 130%, indiquant que la vitesse de lecture est actuellement accélérée de 130% par rapport au tempo écrit. Le tempo écrit, noire = 60, est symbolisé par un
indicateur de tempo qui n'est pas affiché dans l'image. Le symbole en haut à droite affiche noire = 78, signifiant qu'il devrait y avoir 78 noires par minute à la position actuelle du curseur.

Pour changer temporairement le tempo de lecture :

Soit, cliquez sur le curseur du moniteur de tempo en maintenant appuyé pour le faire glisser vers la gauche ou la droite, ce qui ajustera le tempo de lecture par pas de 5 % ;
Soit,

cliquez sur la valeur de tempo de lecture en pourcentage, ce qui met le chiffre en surbrillance

puis éditez la valeur de tempo qui peut être réglée par pas de 1 %. Dans l'image ci-dessous, le tempo sera lu à 96 % de la fréquence réelle du métronome.

Autres commandes

Cliquez sur l'icône roue dentée du panneau de lecture pour afficher les commandes suivantes :

Vous pouvez décocher ou cocher ces options selon vos besoins.

Activer l'entrée MIDI

Activez l'entrée MIDI pour écrire de la musique sur votre partition avec un périphérique MIDI relié (tel qu'un clavier ou une boîte à rythmes) pendant la lecture.

Jouer les reprises (répétitions)

Décochez cette option si vous souhaitez que la lecture ignore toute indication de reprise (répétition) dans la partition.

Jouer les symboles d'accord

Décochez cette option si vous souhaitez que la lecture ignore les symboles d'accord dans la partition.

Suivre la partition automatiquement

Lorsqu'elle est cochée, cette option effectue un suivi des pages de la partition pendant la lecture ; décochez si vous voulez que la vue de la page reste fixe.

Liens externes

Fichier démo de partition avec son de métronome https://musescore.org/en/node/357722#comment-1220561

Mélangeur

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Aperçu

Le mélangeur vous permet de :

changer les sons des instruments (sans affecter la portée de notation).
charger des instruments et des effets virtuels
ajuster le volume et le panoramique et faire d'autres ajustements à la lecture pour chaque portée.

Le mélangeur est divisé en un certain nombre de pistes à code couleur :

Instrument : chaque portée d'instrument de la partition a sa propre piste, avec le nom de l'instrument sur fond bleu, en partie inférieure. Un canal est automatiquement créé pour chaque changement d'instrument en cours de partition
appliqué à une portée.
Métronome : ce canal, également sur fond bleu, permet de contrôler le volume et le panoramique (pan) du métronome.
Aux 1/Aux 2 : ce sont des canaux (channels) auxiliaires](#aux-channels), étiquetés sur fond vert, qui peuvent être utilisés pour accueillir des unités d'effets VST. "Aux 1" contient par défaut Muse Reverb (voir plus bas).
Master : le fader (potentiomètre) général, étiqueté en rouge.

Ouvrir le mélangeur

Vous pouvez afficher/masquer le mélangeur en :

Cliquant sur le bouton Mélangeur dans la barre d'outils Saisie de notes
Cliquant sur Affichage → Mélangeur
Utilisant le raccourci clavier F10.

Remarque : si les canaux d'instruments ne sont pas dans le même ordre que les instruments dans la partition, essayez de fermer et de rouvrir le mélangeur.

Contrôles du mélangeur

Les contrôles du mélangeur les plus communément utilisés sont :
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Pan : cliquez et déplacez ce bouton rotatif pour faire varier signal audio vers la droite ou la gauche du champ d'écoute stéréo. Faites un double-clic sur le bouton pour le remettre en position centrale.
Volume : cliquez et déplacez le fader (potentiomètre linéaire) pour augmenter ou diminuer le volume de lecture. Faites un double-clic sur le fader pour le ramener à sa position par défaut, 0 dB.
Mute (M) et Solo (S) : cliquez sur le bouton Mute pour rendre le canal muet ; recliquez pour annuler la commande. Le bouton Solo rend muet tous les autres canaux, vous permettant de n'écouter que le canal solo. Il est possible de
faire une sélection multiple des boutons Mute et Solo, ce qui vous permet d'isoler de façon pratique n'importe quelle combinaison d'instruments.
Nom : notez que ce nom n'est affecté par aucun changement réalisé sur le nom de l'instrument dans la partition.

Cliquez sur le bouton 3 points au coin supérieur droit de la fenêtre Mélangeur pour afficher/masquer un contrôle. Par exemple, vous pouvez masquer les faders de volume pour gagner de l’espace vertical pour l’affichage de la partition.

Son

La ligne étiquetée Son affiche l’instrument virtuel sélectionné pour la lecture de chaque canal. Il peut être de type SoundFont (.sf2,.sf3), instrument VST (VSTi) ou Muse Sound.

Pour changer l'instrument d'un canal :

Survoler un emplacement de son avec la souris (sur la ligne marquée "Son")
Cliquez sur le bouton de menu déroulant qui apparaît
Localisez et sélectionnez un élément dans le menu déroulant.

Remarque : cela modifie l'instrument de la portée mais n'a aucun effet sur la notation de la portée. Si vous voulez que la portée soit également mise à jour, c'est à dire avec les changements adaptés en termes de transposition et de clef, voir
Choisir des instruments.

MuseScore Studio ne supporte pas encore la sélection de banque de son à partir d'un seul fichier SoundFont (comme le faisait MuseScore 3). C'est planifié pour une future version mais, pour l'instant, utilisez les méthodes de contournement
indiquées dans SoundFonts.

Les fichiers SFZ sont supportés mis uniquement via un échantillonneur VST, voir SoundFonts.

FX Audio

Chaque emplacement FX Audio vous permet d’ajouter un effet audio supplémentaire (Effets VST ou Muse Reverb (un effet intégré). L’audio est généré en intégrant les FX Audio du haut vers le bas.

Trouvez les VSTi dans le menu déroulant Son et les effets VST dans le menu déroulant FX Audio.
Pour appliquer un ou plusieurs effet FX Audio à un instrument, ajoutez un FX Audio dans le canal correspondant de l’instrument.
Pour appliquer facilement le(s) même(s) FX Audio à plusieurs instruments, utilisez les canaux Aux send.

Pour ajouter un plugin FX Audio

Survolez un emplacement FX Audio vide
Cliquez sur le bouton déroulant qui apparaît
Localisez et cliquez sur un plugin dans le menu déroulant.
Le plugin se chargera dans une fenêtre séparée au somment de la fenêtre de MuseScore Studio.
Quand vous ajoutez un effet, un nouvel emplacement vide est automatiquement créé pour permet l’ajout d’effets supplémentaires. Répétez ces étapes pour ajouter davantage d’effets.

Pour désactiver un effet VST

Survolez un emplacement FX Audio
Cliquez sur l'icône bouton d'alimentation qui apparaît

Cela désactive le plugin sans le supprimer du Mélangeur.

Pour supprimer un plugin VST

Survolez un emplacement FX Audio
Cliquez sur le bouton déroulant qui apparaît
Cliquez sur Sans effet

Muse Reverb

Muse Reverb est l'unité de réverbération (réverb) préinstallé de MuseScore Studio. Un niveau fixe de réverb est ajouté par défaut à chaque instrument — vous pouvez ajuster ce niveau pour chaque canal utilisant les boutons Aux sends à
côté des boutons bleus labellisés "Réverb". L'effet peut être basculé avec/sans pour chaque canal en cliquant sur les mêmes boutons. Vous pouvez aussi ajuster le volume de l'effet en utilisant le fader Aux.

Aux sends

Chaque emplacement Aux send ajuste le niveau du ou des effet(s) des canaux Aux channel ajouté(s) à la lecture audio d'un instrument.

Il y a deux canaux Aux sends qui correspondent aux deux Aux channels :

La première ligne ajuste le niveau d’effet Aux 1 ajouté à l’instrument courant. Il est montré en tant que Réverb par défaut car Aux 1 contient Muse Reverb par défaut.
La deuxième ligne ajuste le niveau d’effet Aux 2 ajouté à l’instrument courant. Aux 2 ne contient aucun FX Audio par défaut.
Les deux Aux sends sont activés par défaut pour chaque instrument et peuvent être désactivés individuellement. L’audio est générée en prenant en compte Aux 1 puis Aux 2.
Vous pouvez aussi appliquer des effets audios à un instrument en n’ajoutant que de l'effet FX Audio.
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Pour afficher/masquer un emplacement Aux send

Cliquez sur l’icône trois points situé dans le coin supérieur droit du panneau Mélangeur
Survolez Affichage avec la souris
Cliquez sur Aux send 1 et/ou Aux send 2.

Pour supprimer un emplacement Aux send

Vérifiez que l'Aux send est visible
Cliquez sur Réverb pour supprimer Aux send 1 OU cliquez sur Aux 2 pour supprimer Aux send 2.

Aux channels

Les Aux channels sont des canaux spéciaux créés pour simplifier l’application des effets FX audio. Vous pouvez installer un FX audio dans un des canaux Aux puis l’appliquer à plusieurs instruments.

Il y a jusqu’à deux Aux channel dans chaque partition :

Aux 1 : contient l’effet Muse Reverb par défaut mais vous pouvez le supprimer et le remplacer par n’importe quel autre effet FX Audio de votre choix.
Aux 2 : il est vide par défaut.

Pour afficher/masquer les Aux channels

Par défaut, les Aux channel sont masqués. Pour afficher/masquer un Aux channel :
1. Cliquez sur l’icône trois points situé dans le coin supérieur droit du panneau Mélangeur
2. Survolez Affichage avec la souris
3. Cliquez sur Aux 1 et/ou Aux 2.

Pour ajouter un effet FX Audio à un Aux channel

Le procédé est le même que pour ajouter un FX Audio à un canal d'instrument, voir Pour ajouter un FX Audio.

S’il n’y a qu’un FX Audio dans un Aux channel, le canal et les Aux sends correspondants sont étiquetés avec le nom du FX Audio. S’il y en a plus d’un, ils sont étiquetés Aux 1 et Aux 2. Vous pouvez avoir besoin de sauvegarder et rouvrir la
partition pour afficher la mise à jour des étiquettes.

Pour ajuster le niveau d’un Aux channel

Chaque Aux channel possède un fader. Cela modifie le volume de l’effet dans toutes les canaux où l'Aux send correspondant est activé. Pensez-y quand vous paramétrez le volume maximum des effets qu’un canal d’instrument peut recevoir.

Pour appliquer l’effet d’un ou plusieurs Aux channel à un instrument

Pour régler le niveau d’effet d’un Aux channel envoyé à chaque instrument, utilisez le bouton rotatif de l’Aux send correspondant sur le canal de l’instrument, voir Aux sends.

Voir également

Installer les sons Muse Sounds

SoundFonts

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Aperçu

MuseScore Studio utilise des instruments virtuels pour créer l'audio utilisée pour la lecture. Les SoundFonts sont l'un des formats supportés (.sf2, .sf3). Un fichier sf2 ou sf3 contient toutes les données audio d'un ou plusieurs instruments
virtuels.

MuseScore Studio est fourni avec sa propre SoundFont préinstallée, MS Basic, qui contient la plupart des sons d'instruments dont vous pouvez avoir besoin pour la lecture de vos partitions.

Vous pouvez aussi ajouter et utiliser des SoundFonts personnalisées — des soundfonts gratuites sont disponibles en ligne. Voir aussi la liste dans SoundFonts et fichiers SFZ  (manuel MS3 ).

Installer une SoundFont

Une fois que vous avez téléchargé une SoundFont sur votre ordinateur, il existe deux manières pour l'installer dans MuseScore Studio :

Glissez/déposez le fichier SoundFont dans MuseScore Studio
Placez le fichier SoundFont dans le répertoire dédié de MuseScore.

Installer par glisser/déposer

Ouvrez MuseScore Studio
Ouvrez votre gestionnaire de fichiers (Windows : Explorateur de fichiers, macOS : Finder)
Localisez le fichier SoundFont
Faites un clic gauche sur le nom de fichier Soundfont et maintenez-le dans la fenêtre du gestionnaire de fichiers
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Déplacez le fichier vers la fenêtre de MuseScore Studio
Si la fenêtre de MuseScore Studio n'est pas visible, déplacez le fichier au-dessus de l'icône de MuseScore dans la barre de système pour la faire apparaître

Relâchez le bouton de la souris pour "déposer" le fichier dans MuseScore Studio

Une fenêtre de dialogue devrait apparaître pour inviter l'installation du fichier SoundFont au bon endroit.

Installer dans le répertoire de fichiers

Il est également possible d'installer manuellement les fichiers SoundFont dans le bon répertoire. Par défaut, cette localisation est ~/Documents/MuseScore4/SoundFonts, où~ (tilde) représente votre répertoire racine. Le chemin pour cette
localisation est :

Windows : C:\Users\USERNAME\Documents\MuseScore4\SoundFonts
macOS : /Users/USERNAME/Documents/MuseScore4/SoundFonts
Linux : /home/USERNAME/Documents/MuseScore4/SoundFonts

Les fichiers SoundFont placés dans ce répertoire deviendront automatiquement disponibles pour leur usage dans MuseScore Studio.

Ajouter ou modifier le répertoire SoundFont

Il est également possible de spécifier un ou plusieurs dossier(s) alternatif(s) pour ranger les fichiers SoundFont à la place — ou en complément — du répertoire par défaut mentionné plus haut. Les fichiers SoundFont placés dans n'importe
lequel de ces dossiers seront disponibles dans MuseScore Studio.

Pour spécifier un répertoire SoundFont alternatif :

Ouvrez Préférences (Mac : MuseScore → Préférences ou raccourci Cmd+ ;. Windows : Édition → Préférences)
Sélectionnez Dossiers (avant MuseScore 4.2, cela était sous la catégorie Général)
Cliquez sur l'icône dossier sur la ligne SoundFonts
Cliquez sur Ajouter un dossier dans la boîte de dialogue qui s'affiche
Choisissez et ouvrez l'emplacement du répertoire dans lequel vous souhaitez que MuseScore Studio recherche les fichiers SoundFont
Si vous le souhaitez, vous pouvez ajouter d'autres répertoires en répétant les cinq étapes ci-dessus (facultatif)
Lorsque vous avez terminé, cliquez sur OK. Le ou les répertoires spécifiés apparaîtront dans le champ de texte de la ligne SoundFonts.
Cliquez sur OK dans la boîte de dialogue Préférences pour confirmer votre sélection.

Utiliser les sons d'une SoundFont

Une fois qu'une SoundFont est installée, voici comment l'utiliser dans MuseScore Studio :

Ouvrez le Mélangeur (raccourci : F10)
Localisez la colonne de l'instrument dont vous voulez changer le son
Survolez avec la souris l'emplacement du plugin de l'instrument sur la ligne marquée Son (pour les utilisateurs de lecteur d'écran : pressez Tab jusqu'à entendre "menu son")
Cliquez sur le bouton de liste déroulante qui apparaît
Survolez les SoundFonts
Sélectionnez la SoundFont que vous souhaitez attribuer à cet instrument particulier.

Comme dans MuseScore 4.2, il est possible de choisir un son spécifique au sein de la SoundFont. Le paramétrage par défaut Choix automatique demande à MuseScore Studio d'utiliser le(s) son(s) adapté(s) à l'instrument dans la partition.

Pour certains instruments (comme le violon) utilisant MS Basic, les objets textes d'articulation verbale (comme legato, pizz. arco) créent leur propre lecture uniquement si Choix automatique est sélectionné : voir musescore sur github
[en anglais]. Cependant, il est préférable de changer l'instrument Musescore : voir le chapitre Configurer votre partition : Changer les instruments après la création de la partition. Choix automatique ne fonctionne qu'avec les SoundFonts qui
obéissent au standard General MIDI  (voir le chapitre SoundFonts et fichiers SFZ : soundfonts  du manuel de Musescore 3.

L'image ci-dessous affiche une sélection de soundfont dans MuseScore Studio 4.1.1.

Sélectionner des sons individuels

Comme mentionné plus haut, MuseScore 4.2 réintroduit la capacité de choisir des sons individuels dans une SoundFont.

Avant MuseScore Studio 4.2, vous deviez faire avec le choix automatique ou employer une solution de rechange où chaque son individuel était rendu disponible dans un fichier SoundFont séparé. Une version spéciale de MS Basic  était
créée à cette fin. Pour les autres SoundFonts, vous pouviez les séparer en sons individuels en utilisant un outil libre tel que sf2-split  or SF2 Splitter . Pour les VST, vous pouviez utiliser un échantillonneur VST tel que Sforzando ,
FluidSynthVST , ou juicysfplugin .

Éditer des Soundfonts

Cela est possible en utilisant des logiciels tiers comme Polyphone . Pour plus d'informations, voir aussi Soundfont, MIDI velocity and instruments.xml  (Developer’s Handbook) [en anglais].

Désinstaller une SoundFont

Pour désinstaller une SoundFont, ouvrez simplement le dossier où son fichier est installé et supprimez-le.

Informations sur le lecteur Zerberus et les SFZ

Des utilisateurs de MuseScore 3.6 et versions antérieures peuvent être habitués à utiliser le lecteur Zerberus qui prend en charge le format de fichier .sfz. Lors de la construction du nouveau système prenant désormais en charge les
instruments VST, des modifications ont été nécessaires, nécessitant la suppression du lecteur Zerberus, ainsi que du Synthétiseur  présent dans les versions antérieures de MuseScore. Par conséquent, certaines fonctionnalités ont été
perdues au cours du processus, notamment la possibilité de mapper des sons d'instruments spécifiques tels que pizzicato et tremolo sur des canaux MIDI spécifiques. Notre priorité absolue pour les futures versions de MuseScore Studio est
de prendre à nouveau en charge cette fonctionnalité pour VST, SoundFont et les bibliothèques Muse Sounds. Les utilisateurs qui comptent beaucoup sur le mappage des sons .sfz pour réaliser des interprétations spécifiques sont invités à
continuer d'utiliser les versions antérieures de MuseScore jusqu'à ce que cette fonctionnalité soit réactivée dans MuseScore Studio. Il convient de mentionner que les nouveaux systèmes qui sont prévus seront beaucoup plus flexibles, faciles
à utiliser et puissants que ceux trouvés dans MuseScore 3.

Pour ceux qui souhaitent continuer à utiliser les sons SFZ dans MuseScore Studio, de bonnes alternatives seraient d'utiliser les échantillonneurs VST open source tels que Sfizz  (Windows, Mac & Linux) ou Sforzando  (Windows & Mac),
qui prennent tous deux en charge la lecture SFZ.

Voir également
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SoundFonts et fichiers SFZ  (Manuel MS3)

Alternatives aux soundfonts :

Muse Sounds
VSTi

Installer les sons Muse Sounds

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Installer les Muse Sounds via Muse Hub

Muse Sounds est une bibliothèque de plugins sophistiqués qui fournissent une lecture réaliste pour MuseScore Studio.

Les sons Muse Sounds sont installés à l'aide de l'application Muse Hub, qui peut être téléchargée sur musescore.org .

Une fois installé, Muse Hub peut être ouvert en cliquant sur l'icône de l'application dans la barre de menus (macOS) ou la barre des tâches (Windows). Cliquez sur Get sous n'importe quel son que vous souhaitez avoir dans votre
bibliothèque : le téléchargement et l'installation commenceront immédiatement.

Muse Hub contient également une gamme de plugins d'effets. Téléchargez et installez-les à partir de l'onglet Effets.

Une fois qu'un plugin est entièrement téléchargé, il apparaîtra dans le Mélangeur la prochaine fois que vous lancerez MuseScore Studio.

Utiliser les Muse Sounds dans MuseScore Studio

Tous les plugins Muse Sounds que vous avez téléchargés seront automatiquement affectés aux instruments appropriés de votre partition.

Vous pouvez indiquer à MuseScore Studio de toujours utiliser les plugins Muse Sounds disponibles via la boîte de dialogue Configuration de la lecture.

Accédez à Affichage → Configuration de la lecture
Sélectionnez Muse Sounds dans la section Profils
Laissez l'option Définir comme valeur par défaut pour les nouvelles partitions cochée si vous souhaitez que toutes les partitions futures utilisent également Muse Sounds
Cliquez sur OK.

Le profil de lecture Muse Sounds garantit que tous les plugins Muse Sounds seront affectés à chaque instrument disponible dans votre partition. Vous pouvez également affecter manuellement un plugin Muse Sounds à un seul instrument via
le mélangeur. Cela peut être utile pour les partitions avec plus d'un instrument où vous pourriez souhaiterez combiner les plugins Muse Sounds avec d'autres VST ou Soundfonts.

Allez dans Affichage → Mélangeur pour afficher le Mélangeur ou cliquez sur le bouton Mélangeur de la barre d'outils centrale ou utilisez le raccourci clavier F10
Survolez un emplacement de plugin à côté de Son
Cliquez sur le bouton déroulant qui apparaît
Accédez à Muse Sounds et sélectionnez un son dans la bibliothèque souhaitée

Sons disponibles dans Muse Sounds

Muse Sounds prend actuellement en charge les instruments suivants :

Choir (chœurs)

Sopranos
Altos
Tenors
Basses

Strings (instruments à cordes)

Violins 1
Violin 1 (Solo)
Violins 2
Violin 2 (Solo)
Violas
Viola (Solo)
Violoncellos
Violoncello (Solo)
Contrabasses

Woodwinds (bois)

Alto Flute
Alto Sax
Baritone Sax
Bass Clarinet
Bass Flute
Bassoon
Clarinet in Bb
Clarinet in Eb
Contrabass Flute
Contrabassoon
English Horn
Flute 1
Flute 2
Oboe
Piccolo
Soprano Sax
Tenor Sax

Brass (cuivres)

French Horns a6
French Horn
Trumpets a4
Trumpet
Trombones a3
Trombone
Bass Trombone
Cimbasso
Tuba

Percussions

Bass Drum
Bell Tree
Bongos
Cabasa
Castanets
Claves
Cowbell
Crotales
Field Drum
Glockenspiel
Gong
Marimba
Mark Tree
Piatti
Shaker
Sleigh Bells
Snare Drum
Suspended Cymbal
Taikos
Tam-Tam
Tambourine
Timbales
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Timpani
Toms
Triangle
Tubular Bells
Vibraphone
Wood Blocks
Xylophone
Metronome

Keys (claviers)

Celesta
Grand Piano
Harpsichord
Soft Piano
Upright Piano
Hammond Organ
Suitcase Piano
Wurly 200A
Dream Piano

Harp

Harp

Guitars

Acoustic Nylon
Acoustic Steel Picked
Acoustic Steel Plucked
Electric Bass
Electric LP - Clean
Electric LP - Heavy
Electric LP - Lead
Electric SC - Clean
Electric SC - Heavy
Electric SC - Lead

Tous les instruments non pris en charge par Muse Sounds resteront affectés à MS Basic par défaut.

Lien externe

Installer les Muse Sounds  (présentation en anglais)

Sound flags

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

La disponibilité sound flag commence avec MuseScore Studio 4.3.

Vue d'ensemble

Des sound flags peuvent être ajoutés à un texte de portée pour accéder à des sons et à des techniques de jeu additionnels sur les instruments Muse Sounds. Vous pouvez télécharger gratuitement l'ensemble des instruments Muse Sounds
(et, bientôt, d'autres sons des meilleurs développeurs audio du monde) via le Muse Hub .

Quand on ajoute un sound flag (illustré plus bas), il agit sur la lecture de l'instrument à partir de ce point, jusqu'à ce qu'il rencontre un autre sound flag.

En utilisant des sound flags, vous pouvez :

Appliquer des techniques de jeu d'instruments à corde telles que espressivo, sul ponticello et bartok pizzicato
Activer (Snare on) ou désactiver (Snare off) le timbre sur la caisse claire (Snare drum) Muse Sounds
Choisir entre différents phonèmes comme ooh, ahh et mmm

Les boutons sound flag qui apparaissent dans la partition ne seront jamais affichés lors de l'exportation, de l'impression ou de la publication dans MuseScore.com.

Ajouter un sound flag

Assurez-vous qu'un instrument Muse Sounds est sélectionné dans le Mélangeur
Ajoutez un texte de portée depuis la palette Texte ou en utilisant Ctrl+T (Mac : Cmd+T) à la portée de l'instrument Muse Sounds
Cliquez sur le bouton sound flag à côté du champ de texte
Sélectionnez n'importe quelle option pour l'appliquer à votre partition
Lire la partition pour écouter le nouveau son.

Utiliser un sound flag sans afficher de texte dans la partition

Les sound flags doivent toujours être attachés à un élément texte de portée. Si vous souhaitez cacher le texte :

Sélectionnez le texte de portée
Dans le panneau Propriétés, sous Général, décochez Visible.

Supprimer un sound flag

Sélectionnez le bouton sound flag et tapez Suppr pour le supprimer tout en laissant le texte de portée en place.

La suppression du texte de portée supprimera aussi le sound flag associé.

Masquer les sound flags dans la partition

Sans aucun élément sélectionné dans la partition, ouvrez le panneau Propriétés
Sous Général, cliquez sur l'icône œil à côté de Sound flags.

Les boutons sound flag seront masqués. Ils peuvent toutefois être édités en cliquant sur le texte de portée associé, ce qui affiche le bouton sound flag.

Options supplémentaires

Réinitialiser un sound flag

Les premières options dans les sections Modifier le son et/ou Techniques de jeu de la fenêtre sound flag sont les sons par défaut. Si vous souhaitez rapidement réinitialiser un sound flag à ces sons :

Sélectionnez un bouton sound flag
Cliquez sur le bouton trois-points en haut à droite de la fenêtre et sélectionnez Réinitialiser au son par défaut

Sélectionnez des sons multiples dans un même sound flag

Vous pouvez souhaiter combiner plus d'une option son à jouer en même temps. Si le sound flag possède la section Modifier le son, vous pouvez :

Sélectionner un bouton sound flag

Manuel de MuseScore 4 https://musescore.org/fr/print/book/export/html/329209?toc=1#undefin...

161 sur 199 04/07/2025, 12:24

https://www.youtube.com/watch?v=n7UgN69e2Y8
https://www.youtube.com/watch?v=n7UgN69e2Y8
https://musescore.org/fr/forum/16
https://musescore.org/fr/forum/16
https://www.musehub.com/
https://www.musehub.com/


Cliquer sur le bouton trois-points en haut à droite de la fenêtre et sélectionner Autoriser la sélection multiple
Puis sélectionner plus d'un son sound flag pour les écouter joués ensemble lors de la lecture.

Modifier les portées qu'un sound flag affecte

Par défaut, les sound flags affectent toutes les portées d'un instrument, mais ce comportement peut être modifié.

Sélectionnez un bouton sound flag
Cliquez sur le bouton trois-points en haut à droite de la fenêtre et décochez Appliquer la sélection à toutes les portées
Répétez l'opération pour les sound flags des autres portées.

Sons sans sound flags

Tous les instruments Muse Sounds ne possèdent pas des options sound flag. Si nous n'avons pas encore ajouté d'option sound flag options, vous verrez s'afficher dans la fenêtre du sound flag (exemple) :

Navigation avec le clavier d'ordinateur

Ajouter un sound flag avec le clavier

Sélectionnez une note ou un silence
Tapez Ctrl+T (Mac : Cmd+T) pour ajouter un texte de portée
Entrer n'importe quel texte
Tapez Echap pour sélectionner le texte
Tapez Alt+←
(Mac : Opt+←) pour ouvrir la fenêtre popup
Utilisez Tab et les flèches de direction pour naviguer à l'intérieur de le fenêtre et Espace pour sélectionner.

Voir aussi

Installer les sons Muse Sounds

Lecture avec capodastre

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Aperçu

MuseScore Studio vous permet de transposer la lecture d'une portée sans changer la notation musicale (tonalité écrite). Cela simule l'effet d'un capodastre sur une guitare (ou un autre instrument à cordes).

Ajouter une indication de capodastre à votre partition

Pour une partition à une seule portée

Ajouter un texte de portée à la note/silence à partir de laquelle vous voulez que la lecture du capodastre démarre
Faites un clic droit sur le texte de portée pour ouvrir la boîte de dialogue Propriétés des textes de système et de portée
Cliquez sur l'onglet Paramètres du capodastre
Cochez la case Paramètres du capodastre et réglez Frette du capodastre sur le numéro de la frette à laquelle vous souhaitez appliquer le capodastre (chaque frette augmente la hauteur d'un demi-ton)
Cliquez sur OK pour appliquer vos modifications
Modifiez le libellé du texte comme vous le souhaitez.

Pour un couple portée/tablature

Utilisez l'une des actions suivantes :

Si le couple portée/tablature est lié, ajoutez le capodastre à la portée standard, pas à la tablature
Si le couple portée/tablature n'est pas lié, ajoutez le capodastre à chacune des deux portées.

Remarque : tous les paramètres de lecture de capodastre s'appliquent jusqu'à ce qu'ils soient remplacés par un texte de portée ultérieur avec Paramètres du capodastre activé.

Voir également

Symboles d'accord : Position du capodastre

Lecture du swing

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Aperçu

Avec une lecture "linéaire" du rythme, la musique est interprétée strictement telle qu'elle est écrite dans la partition. En revanche, la musique en rythme Swing interprète les paires de croches et de doubles croches comme des triolets dont la
première note est environ deux fois plus longue que la seconde (pour un ratio de 2:1). Cela donne au rythme une sensation de balancement caractéristique — souvent associée à la musique jazz, notamment. On l'appelle aussi phrasé
ternaire.

Lecture des croches en swing avec un ratio de 2:1 :

Lecture des doubles croches en swing avec un ratio de 2:1 :

Plutôt que de noter la musique swing exactement telle qu'elle est jouée, il est accepté par convention de l'écrire en mode linéaire et de fournir simplement les indications écrites "Swing et "Linéaire" aux endroits appropriés de la partition.
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Les indications de swing ont un effet de lecture sur la partition. Le ratio de swing par défaut est de 60 % (3:2), — soit un rapport croche pointée-double croche pour un swing de croches — mais vous pouvez le modifier en fonction de la
sensation du morceau si nécessaire.

Ajouter une indication de jeu Swing ou Linéaire à votre partition

Pour ajouter une indication Swing

Cliquez sur la note ou le silence de destination
Cliquez sur le texte Swing dans la palette Tempo.

Alternativement, vous pouvez faire glisser et déposer le texte Swing de la palette sur la note ou le silence en question.

Vous pouvez, si vous le souhaitez, ajouter également une indication visuelle du Swing  (page en anglais).

Pour ajouter une indication Linéaire

Cliquez sur la note ou le silence de destination
Cliquez sur le texte Linéaire dans la palette Tempo.

Notez que les indications ci-dessus sont une forme de Texte de système et donc l'effet de lecture est appliqué à toutes les portées du système. Si vous souhaitez que le swing ne s'applique qu'à une seule portée, vous pouvez utiliser un Texte
de portée à la place : voir ci-dessous.

Modifier la lecture du swing

Ajuster le type et le degré de swing

Faites un clic droit sur le texte Swing dans la partition et sélectionnez Propriétés du texte de système…

Dans l'onglet Paramètres du swing, paramétrez le mode de swing et son ratio selon vos besoins.

Remarque : on retrouve les paramètres du swing à la fois dans le texte de système et dans le texte de portée.

Appliquer le swing à une seule portée

Si vous souhaitez que le swing ne s'applique qu'à une seule portée du système, utilisez plutôt le texte de portée :

Sélectionnez la note ou le silence de destination
Cliquez sur l'indication Texte de portée dans la palette Texte
Modifiez le texte pour créer l'indication de performance souhaitée (exemple : "swing")
Cliquez avec le bouton droit sur le texte et sélectionnez Propriétés du texte de portée…. Vous pouvez également sélectionner l'objet texte et dans le panneau Propriétés et cliquer sur le bouton Propriétés du texte de portée….
Dans l'onglet Paramètres du swing, paramétrez le mode de swing et son ratio selon vos besoins.

Working with MIDI

This section needs to be organized / written by someone with an understanding of how to use MIDI input/output in MuseScore 4. If JACK is still supported, it could be discussed here too, or in a new page.

Travailler avec les plugins VST et VSTi

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Introduction aux VST

La technologie de studio virtuel — en anglais : Virtual Studio Technology (VST) — est une interface logicielle de plugin audio, sous licence Steinberg, qui intègre des synthétiseurs logiciels et des unités d'effets dans des stations de travail
audio numériques. La plupart des plugins VST représentent soit des sons d'instruments (VSTi), soit des effets (VSTfx) — les VSTi comportent des émulations de simulation logicielle de synthétiseurs matériels et d'échantillonneurs bien
connus.

Installer des VST

Dans MuseScore Studio, tous les plugins VST compatibles installés sur un ordinateur Windows ou MacOS seront automatiquement mis à disposition dans le Mélangeur où vous pouvez facilement configurer les réglages de lecture pour tous
les instruments de la partition. Notez que Linux n'est pas actuellement supporté (mais voir Linux VST3 ).

Après avoir installé de nouveau(x) VST sur votre ordinateur, pour pouvez avoir à relancer MuseScore Studio pour les rendre visibles dans le Mélangeur. Si cela ne fonctionne pas, vous pouvez forcer une nouvelle recherche des VST en
effaçant les précédents réglages dans le cache avant de relancer. Sur Windows 10, le fichier correspondant peut être trouvé sur

C:\Users\ [votre utilisateur] \AppData\Local\MuseScore\MuseScore4\known_audio_plugins.json

MuseScore Studio ne prend en charge directement que les plugins VST3 (pas VST1 ni VST2) en raison de restrictions de licence. Si vous utilisez VST1 or VST2, voir How to use older, non-VST3 plugins in MuseScore 4  (en anglais).

Remarque : les sons paramétrés dans le Mélangeur sont enregistrés avec la partition mais pas dans l'application informatique.

Activer, désactiver, supprimer et remplacer les plugins VST

Voir Mélangeur : Effets audio et sons.

Voir aussi

Alternatives aux instruments VST :

Muse Sounds
SoundFonts

Personnalisation

Langue

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Vue d'ensemble

MuseScore Studio fonctionne avec votre langue "Système" (celle utilisée par la plupart des programmes, et généralement en fonction de votre pays et des paramètres de langue du PC, ou du compte).

Changer de langue

Depuis le menu, sélectionnez Édition → Préférences… (Mac : MuseScore → Préférences…)

Dans l’onglet Général, sélectionnez la langue souhaitée dans la liste déroulante de la section Langues (redémarrage nécessaire).
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Mettre à jour les traductions

Pour mettre à jour les traductions :

Depuis le menu, sélectionnez Édition → Préférences… (Mac : MuseScore → Préférences…)
Dans l’onglet Général, cliquez sur le bouton Vérifier les mises à jour de langue.

Un message s'affichera si la version de votre langue est déjà à jour :

Dans le cas contraire, la mise à jour sera téléchargée.

Pour terminer cette étape, un redémarrage de l'application est nécessaire.

Voir aussi

Aider aux traductions

Apparence

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Vue d'ensemble

Pour changer l'apparence de MuseScore Studio

Depuis le menu, sélectionnez Édition → Préférences… (Mac : MuseScore → Préférences…) ;

Dans l’onglet Apparence, sélectionnez l'option souhaitée décrite ci-dessous.

Thème et couleurs

Les options suivantes sont disponibles pour changer les couleurs de MuseScore Studio. L'affichage change immédiatement afin que les options puissent être testées sans fermer la fenêtre de dialogue. Les changements s'appliquent à toutes
les instances ouvertes de MuseScore Studio (voir Barres d'outils et fenêtres).

Thèmes — choisissez Clair ou Sombre
Utiliser le thème du système & mdash; cochez l'option si vous voulez que MuseScore Studio change le thème de clair à sombre, ou de sombre à clair, lorsque le thème du système change
Activer le contraste élevé
Couleurs d'accentuation — couleur employée pour surligner les palettes et outils
Arrière-plan — la couleur de la fenêtre partition (pas celle des palettes et autres éléments du programme) peut être remplacée par une couleur unie ou une image de fond d'écran.
Papier — la couleur de la partition elle-même peut être remplacée par une couleur unie ou une image de fond d'écran.
Inverser les couleurs — affiche la partition en blanc sur fond noir.
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Police de caractères

Pour modifier la police de caractères et la taille du texte des éléments des menus et des palettes :

Depuis le menu, sélectionnez Édition → Préférences… (Mac : MuseScore → Préférences…) ;
Dans l’onglet Apparence, sélectionnez les options de police de caractères.

Cela n'affecte pas les éléments texte de la partition.

Barres d'outils et fenêtres

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Espace de travail

Les fenêtres, boîtes d’outils et panneaux de MuseScore Studio peuvent être repositionnés et on peut choisir quels éléments on souhaite voir s’y afficher.

L’apparence par défaut (en mode sombre) est le suivant :

La barre de menu
Les boîtes d’outils
La barre latérale gauche (panneaux Palettes, Instruments et Propriétés)
La fenêtre de la partition
La barre de statut

Barres d’outils

Afficher et masquer les barres d’outils

Pour afficher ou masquer les commandes de lecture, saisie des notes ou la barre de statut, sélectionnez Affichage → Barres d’outils et cochez/décochez l’élément souhaité.

Repositionner les barres d’outils

Pour changer la position de la barre d’outils saisie des notes ou de celle de lecture, cliquez sur l'icône six points située à la gauche de la barre d’outils et maintenez la souris appuyée pour déplacer la sélection à l’endroit souhaité par
glisser/déposer. La barre d’outils peut être laissée en position flottante mais, dans le cas de la barre d’outils de saisie des notes, vous pouvez aussi la glisser/déplacer sur l’un des quatre côtés de la fenêtre — un rectangle bleu apparaîtra
pour montrer la position où la barre peut être ancrée. La barre d’outils de lecture ne peut être (ré)ancrée que sur sa position par défaut.

Personnaliser le contenu des barres d’outils

Pour sélectionner les commandes que vous voulez voir sur la barre d’outils de saisie des notes ou de lecture, cliquez sur l'icône roue crantée à droite de la barre d’outils :

Dans le cas de la barre d’outils de saisie des notes, cela fait apparaître une liste déroulante à partir de laquelle vous pouvez choisir ce que vous voulez afficher en cliquant sur l'icône œil devant chaque élément (œil fermé = masqué, œil
ouvert = affiché).

Dans le cas de la boîte d’outil de lecture, décochez/cochez les différentes options pour masquer/afficher les éléments correspondants.

Fenêtres et panneaux

Détacher ou ancrer les panneaux

Pour déplacer un des panneaux latéraux (Palettes, Instruments, Propriétés, Filtre de sélection), cliquez sur l'icône points de suspension (3 points) de l’onglet, sélectionnez l’option Détacher puis faites glisser le panneau détaché jusqu’à la
position souhaitée.

Vous pouvez laisser le panneau en position libre mais il existe aussi des positions d’ancrage supplémentaires à gauche et à droite de la fenêtre partition — un rectangle bleu apparaîtra pour monter là où le panneau peut être déposé en
position ancrée.

De façon similaire, vous pouvez (ré)ancrer le panneau libre sur la barre latérale gauche :

Pour afficher le panneau avec une hauteur diminuée de moitié en haut de la barre latérale gauche, cliquez/déplacez le panneau libre en haut de la barre (les autres onglets seront affichés dans la moitié inférieure)
Pour afficher le panneau avec une hauteur diminuée de moitié en bas de la barre latérale gauche, cliquez/déplacez le panneau libre en bas de la barre (les autres onglets seront affichés dans la moitié supérieure)
Pour (ré)afficher le panneau en pleine hauteur, cliquez/déplacez le panneau libre au centre de la barre latérale gauche.

Vous pouvez aussi ancrer le panneau libre dans sa position initiale en cliquant sur l'icône points de suspension puis en sélectionnant Ancrer.

Les panneaux tels que ceux du Mélangeur ou du Piano virtuel peuvent être détachés en les déplaçant vers la position souhaitée ou en cliquant sur l'icône points de suspension et en sélectionnant Détacher. Pour les réancrer, cliquez sur
l'icône points de suspension et sélectionnez Ancrer.

Le mélangeur détaché peut être redimensionné en faisant glisser ses bordures vers l’intérieur ou l’extérieur.

Personnaliser le contenu des panneaux

Pour choisir quels éléments afficher dans le mélangeur ou le Piano virtuel, cliquez sur l'icône points de suspension, sélectionnez Affichage et décochez/cochez les options disponibles.

Pour personnaliser la zone des palettes, voir Personnalisation : Palettes.

Modèles et styles

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

[Le texte qui suit est en cours de révision. Il contient possiblement des erreurs]

Vue d’ensemble

La mise en page et le formatage ont deux principaux niveaux dans MuseScore Studio :

des "profils généraux de style " comprenant mise en page de la partition et paramétrage des styles par type d'objets (exemple : marques de nuances, de crescendo et decrescendo) : chaque Partie a son "profil général de style"
individuel ;
chaque objet d'une partition (chaque note, texte ou symbole) a ses propres priorités qui sont paramétrées dans le panneau Propriétés ; ce chapitre ne les aborde pas.

Vous pouvez enregistrer le "profil général de style" ** de la partie en cours d'affichage** en tant que fichier séparé et le réutiliser pour une autre partition.
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Modèles

À ne pas confondre avec Propriétés de Portée/Partie : modèle type de portée

Un modèle de partition peut être utilisé pour configurer votre partition rapidement. Il inclut le paramétrage de l'instrument.

Un modèle est un fichier de partition rangé dans un répertoire spécifique utilisé par Musescore Studio. Vous pouvez créer une partition à partir de rien et la sauvegarder comme modèle ou copier tout fichier .mscz existant dans ce répertoire
pour l'utiliser comme modèle.

On distingue deux types de modèles :

Le système de modèles prédéfinis, inclus dans MuseScore Studio. Dans la fenêtre de dialogue Nouvelle partition, les modèles sont triés en catégories sous l'onglet Créer à partir d'un modèle.
Les modèles utilisateur : ces modèles personnalisés créés par l'utilisateur doivent être enregistrés dans le répertoire Documents/MuseScore4/Templates. Dans la fenêtre de dialogue Nouvelle partition, on les retrouve dans la
catégorie Mes modèles.

Enregistrer votre partition comme modèle

Cliquez sur le menu Fichier > Enregistrer sous pour Enregistrer la partition au format .mscz dans [le répertoire de modèle utilisé par Musescore]{#template-and-dir}. Le texte du titre de la partition (à la place du nom de fichier) est utilisé
comme nom de modèle.

Créer une partition à partir de votre modèle

Assurez-vous que le fichier de modèle personnalisé est dans le bon répertoire.
Cliquez sur le menu Fichier > Nouveau pour ouvrir la fenêtre de dialogue Nouvelle partition
Choisissez un modèle dans l'onglet Créer à partir d’un modèle, catégorie : Mes modèles. Dans MuseScore Studio, la fenêtre de prévisualisation affiche une vue du modèle.
Complétez les éléments de la fenêtre de dialogue Nouvelle partition et terminez.

Fichiers de Style

MuseScore Studio ne lit pas automatiquement les répertoires pour retrouver les fichiers de style exportés que vous pouvez ranger où vous le souhaiter. Utilisez le répertoire Documents/MuseScore 4/Styles pour assurer une meilleure gestion
des fichiers.

Sauvegarder les paramètres de style de votre partition dans un fichier

Ouvrez la partie désirée.
Sélectionnez Format → Enregistrer le style et enregistrez le fichier dans un répertoire de votre choix.

Charger les paramètres d'un "profil général de style" à partir d’un fichier

Chargez ou créez une partition et ouvrez la partie désirée
Sélectionnez Format → Charger un style.

Paramétrer un style par défaut pour votre partition

Le "profil général de style" (voir la vue d'ensemble) de la Partie actuellement affichée est paramétré :

dans la fenêtre Style : Format → Style
dans le panneau Propriétés : en haut à droite d'une propriété, cliquez sur les points de suspension ... et sélectionnez "Enregistrer comme style par défaut pour cette partition".

Définir les fichiers par défaut : Édition > Préférences > Partition

Style
Style de partie
NOT FOUND: pref.PNG

Palettes

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Aperçu

Ce chapitre montre comment personnaliser les palettes ; l'application des objets palette est déjà traitée dans Utiliser les palettes (Bases).

Ajouter des palettes

Pour ajouter une palette prédéfinie ou personnalisée, voir Utiliser les palettes : Ajouter d'autres palettes.

Masquer et supprimer des palettes

Pour masquer une palette prédéfinie, faites un clic droit sur celle-ci et sélectionnez Masquer la palette. La palette retourne dans la liste Ajouter des palettes. Notez que les palettes prédéfinies ne peuvent pas être supprimées.

Pour masquer une palette personnalisée précédemment créée, faites un double clic sur celle-ci et sélectionnez Masquer / Supprimer la palette puis suivez les instructions de la fenêtre de dialogue (pour Masquer, Supprimer ou Annuler).

Changer l’ordre des palettes

Pour changer l’ordre des palettes, il suffit de faire glisser chacune vers le haut ou le bas jusqu’à la position souhaitée dans la liste des palettes.

Personnaliser le contenu des palettes

Les palettes peuvent être remplies par des objets de la Palette principale (Maj+F9 ou Affichage → Palette principale), ou depuis une partition ouverte.

Après ajout à une palette, les objets de la partition sont sauvegardés avec leurs propriétés personnalisées.

Pour autoriser/interdire l’édition d'une palette particulière :

Faites un clic droit sur le nom de la palette ou cliquez sur l'icône points de suspension (3 points) à sa droite
Cochez/décochez l’option Activer l’édition.

Ajouter des éléments à partir de la fenêtre Palette principale

Pour ajouter un symbole de la Palette principale vers une palette du panneau Palettes :

Ouvrez la palette en s'assurant que l'édition est autorisée (voir Personnaliser le contenu des palettes)
Ouvrez la Palette principale (Maj+F9 ou Affichage → Palette principale)
Cliquez sur le symbole dans la section adéquate de la Palette principale et faites-le glisser jusqu’à la palette ordinaire à la place souhaitée.

Si vous avez créé une palette personnalisée, il existe une autre façon d'accéder à la Palette principale :

Ouvrez la palette personnalisée
Cliquez sur le bouton Plus
Utilisez les boutons fléchés pour naviguer dans les différentes sections de la Palette principale
Sélectionnez un symbole
Cliquez sur __Ajouter à [nom de la palette personnalisée]
Pour sortir de la fenêtre de dialogue, cliquez de nouveau sur le bouton Plus ou tapez Echap ou cliquez en dehors de la fenêtre.

Ajouter des éléments à partir de votre partition (#add-score-elements)

Pour ajouter des éléments de votre partition à une palette :

Ouvrez la palette concernée
Tapez Ctrl+Maj puis faites glisser l’élément dans la palette.

Déplacer des éléments entre palettes

Les symboles peuvent être déplacés d’une palette à l’autre en les faisant simplement glisser à l’aide de la souris.

Supprimer des éléments d’une palette

Pour supprimer un élément d’une palette, faites un clic droit sur celui-ci et sélectionnez Supprimer. Dans le cas d’une palette prédéfinie, l’élément sera déplacé dans la section Plus. Pour une palette personnalisée l'action Supprimer vous
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demandera de choisir si vous voulez Masquer (déplace l'élément dans la section Plus) ou Supprimer définitivement l'élément.

Réinitialiser une palette

Pour réinitialiser une palette à son état par défaut, faites un clic droit sur le nom de la palette ou cliquez sur l'icône points de suspension à la droite de celui-ci puis sélectionnez Réinitialiser la palette.

Remarque : une palette personnalisée sera réinitialisée en palette vide quand cette fonction est utilisée.

Sauvegarder et charger des palettes

Pour sauvegarder une palette, faites un clic droit sur le nom de la palette ou cliquez sur le symbole points de suspension (trois points) à la droite de celui-ci puis sélectionnez Sauvegarder la palette….

Pour charger une palette précédemment sauvegardée, faites un clic droit sur un nom de palette ou cliquez sur l'icône points de suspension à la droite de celui-ci puis sélectionnez Chargement de la palette.

Menu des palettes

Pour accéder aux options d’affichage de la zone des palettes, cliquez sur l'icône points de suspension à la droite du titre de l’onglet Palettes :

Clic simple pour ouvrir une palette : décochez pour accéder aux palettes par double clic
Ouvrir une seule palette à la fois : si cette option est cochée, l’ouverture d’une palette entraîne la fermeture automatique des autres
Réduire toutes les palettes : ferme toutes les palettes ouvertes
Développer toutes les palettes : ouvre toutes les palettes
Fermer : ferme le panneau Palettes
Détacher : détache le panneau Palettes (voir Fenêtres et panneaux).

Propriétés des palettes

Pour accéder aux Propriétés de palette d’une palette individuelle, faites un clic droit sur son nom ou cliquez sur l'icône points de suspension à la droite de celui-ci puis sélectionnez Propriétés de la palette…

Cela vous permet de renommer la palette, de créer une grille visible pour séparer les éléments, d’ajuster la hauteur et la largeur des cellules et de changer l’échelle et le décalage des symboles.

Voir aussi

Utiliser les palettes pour des informations sur la façon d'appliquer des objets palette.
Autres symboles for davantage d'informations sur les symboles de palette.

Espaces de travail

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Vue d’ensemble

L'espace de travail, également connu sous le nom d'interface utilisateur graphique, est le paramétrage visuel du logiciel MuseScore Studio lui-même ; une analogie de la position du crayon et de la règle sur le bureau d'un compositeur. Il
contient le contenu et positions, attachées ou libres, des palettes, des barres d'outils et des autres fenêtres ouvertes. Les modifications apportées à l'espace de travail en cours sont automatiquement sauvegardées : aucune action
complémentaire n'est requise. Vous pouvez créer des espaces de travail personnalisés pour changer rapidement tous ces réglages en un seul clic de souris.

Remarquez que les réglages suivants ne comptent pas comme espace de travail : Affichage → Afficher → Afficher les éléments invisibles, Afficher la mise en page, Afficher les cadres, Afficher les marges des pages, Marquer les
mesures irrégulières ; de même que les barres de statut Tonalité réelle, niveau de zoom et Affichage continu/par page. Ces réglages, décrits dans
le chapitre L'interface utilisateur, sont des données de partition. Ils sont sauvegardés et chargés avec chaque fichier partition. Des modèles contenant ces réglages seront utilisés lorsque vous créerez une nouvelle partition à partir d'un
modèle : voir Configurer votre partition.

Créer un nouvel espace de travail

Pour créer un nouvel espace de travail :

Cliquez sur le nom de l’espace de travail actuel dans la barre de statut sous la fenêtre du document. De façon alternative, sélectionnez Affichage → Espaces de travail → Configurer l’espace de travail
Cliquez sur Créer un nouvel espace de travail
Remplissez le nom de l’espace de travail et ne choisissez dans les options proposées que celles qui sont à charger et enregistrer lorsque l'espace de travail est utilisé.
Cliquez sur Sélection pour fermer la/les fenêtre(s) de dialogue.

Pour personnaliser l’affichage des palettes et de leur contenu, voir Utiliser les palettes.
Pour personnaliser l’affichage des barres d’outils et des panneaux, voir Barres d’outils et fenêtres.

Supprimer un espace de travail

Cliquez sur le nom de l’espace de travail actuel dans la barre de statut sous la fenêtre du document. De façon alternative, sélectionnez Affichage → Espaces de travail → Configurer l’espace de travail
Sélectionnez l’espace de travail à supprimer
Cliquez sur l’icône poubelle en haut à droite de la fenêtre de dialogue.

Changer d’espace de travail

Cliquez sur le nom de l’espace de travail actuel dans la barre de statut sous la fenêtre du document.
Sélectionnez l’espace de travail souhaité
Cliquez sur Sélection.

De façon alternative

Sélectionnez Affichage → Espaces de travail → Configurer l’espace de travail
Cliquez sur l’espace de travail souhaité dans the menu.

Raccourcis clavier

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Vue d'ensemble

On peut accéder aux commandes de MuseScore Studio via le menu principal, les barres d'outils, le panneau Propriétés, les menus contextuels ou en utilisant des raccourcis clavier.

Les raccourcis clavier déjà existants sont signalés à côté des commandes dans les menus principaux ou contextuels (ouverts avec un clic droit) ou en faisant survoler le pointeur de la souris sur une icône dans une barre d'outils.

De façon alternative, vous pouvez afficher une liste des commandes avec leurs raccourcis dans Édition → Préférences → Raccourcis. C'est aussi à cet endroit que vous pouvez créer un raccourci ou changer un raccourci existant. Pour
localiser une action dans la liste, vous pouvez : soit les faire défiler dans l'ordre alphabétique, soit renseigner un mot clé approprié dans la boîte de recherche.

Définir un raccourci

Pour définir un nouveau raccourci ou modifier un raccourci existant :

Dans la barre de menu, sélectionnez Édition → Préférences → Raccourcis
Trouvez la commande pertinente dans la liste alphabétique (utilisez la boite de recherche si besoin)
Faites un double clic sur l'action souhaitée ou sélectionnez celle-ci puis appuyez sur le bouton Définir...
Dans la fenêtre de dialogue Entrer une séquence de raccourci, tapez et maintenez la séquence de touche(s) à utiliser sur votre clavier pour le nouveau raccourci
Cliquez sur Enregistrer (ou Annuler pour sortir de la fenêtre sans rien changer).
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Réinitialiser et effacer les raccourcis

Réinitialiser un raccourci à sa valeur par défaut

Pour réinitialiser un raccourci à sa valeur par défaut :

Dans la barre de menu, sélectionnez Édition → Préférences → Raccourcis
Trouvez la commande pertinente dans la liste alphabétique (utilisez la boite de recherche si besoin)
Sélectionnez la commande et cliquez sur le bouton Réinitialiser à la valeur par défaut.

Effacer un raccourci

Pour effacer un raccourci :

Dans la barre de menu, sélectionnez Édition → Préférences → Raccourcis
Trouvez la commande pertinente dans la liste alphabétique (utilisez la boite de recherche si besoin)
Sélectionnez la commande et cliquez sur le bouton Effacer.

Remarque : vous pouvez sélectionner plus d'un raccourci si besoin. Utilisez la touche Maj pour établir une plage de sélection continue ou la touche Ctrl pour une liste discontinue.

Importer et exporter des raccourcis

Pour enregistrer les raccourcis existants ou importer une liste personnelle :

Dans la barre de menu, sélectionnez Édition → Préférences → Raccourcis
Cliquez sur Exporter pour enregistrer la liste ou sur Importer pour charger une nouvelle liste de raccourcis.

Préférences

[À créer]
* Cette page fait une présentation rapide de toutes les préférences (et potentiellement permet d'y trouver des informations supplémentaires)
* Mentionner la réinitialisation des préférences au tout début

Général

Apparence

Canevas

Saisie de notes

Commandes d'un périphérique MIDI

Partition

Entrée/Sortie

Importation

Raccourcis

Mise à jour

Avancé

Plugins

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

Vue d’ensemble

Un plugin est un petit morceau de programme qui ajoute des fonctionnalités supplémentaires à MuseScore Studio. Certains plugins sont automatiquement préinstallés. Vous pouvez aussi installer d'autres plugins compatibles ou écrire votre
propre plugin.

Organiser les plugins

Installer un nouveau plugin

Recherchez les plugins disponibles sur, par exemple :
https://musescore.org/plugins  [musescore.org → Download → Plugins]
Attention : des plugins peuvent potentiellement contenir du code malveillant ou erroné qui pourrait compromettre voire endommager vos partitions ou votre système. Tous les plugins partagés sur l'entrepôt de musescore.org sont
non vérifiés. Aucune garantie d'aucune sorte n'est fournie. Il est conseillé de ne télécharger que ceux venant d’un auteur de confiance ou bien de faire vous-même une vérification du code. Recherchez les avis sur le forum
Plugins .
https://github.com/topics/musescore-plugin
https://github.com/topics/musescore-plugins

Assurez-vous qu'il est compatible avec votre version de MuseScore Studio

Téléchargez le fichier :
pour les fichiers qml hébergés chez musescore.org, un navigateur peut parfois s'ouvrir en l'affichant sous forme de texte et refuser de le télécharger comme fichier ; il peut être nécessaire de faire un clic droit sur le lien et
sélectionner Enregistrer le lien sous...
pour les codes compressés sur github.com, téléchargez le projet comme un fichier zip en cliquant sur Code: Download ZIP
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pour les fichiers non compressés github.com, cliquez sur l'item approprié dans Assets

Si c'est un fichier zip, réalisez l'extraction avec un logiciel de décompression d'archives
Déplacez les fichiers dans le répertoire des plugins de MuseScore Studio, ce qui peut être configuré dans Préférences : Général : Répertoires. Les répertoires par défaut sont :

Windows : C:/Users/[Votre nom d'utilisateur]/Documents/MuseScore4/Plugins/
macOS : [travail en cours, information à venir]
Linux : ~/Documents/MuseScore4/Plugins

Mettre à jour un plugin existant

La mise à jour fonctionne de la même façon que l’installation mais il faut veiller à supprimer les fichiers des anciennes versions pour éviter d’avoir des doublons de plugins !

Activer et désactiver des plugins

Cliquez sur Accueil : Plugins ou le menu Plugins : Gérer les plugins...

Sélectionnez un plugin et cliquez sur Activer ou Désactiver
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Démarrer un plugin

Assurez-vous d'avoir ouvert l'onglet Partition
Sélectionnez Plugins : [le nom du plugin]

Vous pouvez aussi définir des raccourcis pour démarrer des plugins spécifiques dans l'onglet *Accueil : Plugins ou via le menu Plugins : Gérer les plugins....

Plugins préinstallés

[travail en cours, à compléter avec un bref commentaire sur chaque]

Add Courtesy Accidentals
Color Notes
Lilypond Lyrics
Mirror Intervals
Modal Temperaments
Modal Tuning
New Retrograde
Note Names
Remove Courtesy Accidentals
Tuning

Créer un plugin

Le système de plugins de MuseScore Studio est en cours de modification et de réimplantation.

En octobre 2023, le système de plugins de MuseScore Studio 4.1.1 est essentiellement une version quelque peu restreinte du système de plugins de MuseScore 3. Visitez le chapitre Developers' Handbook Plugins for 3.x  pour les
fondamentaux et le chapitre Plugins for 4.x  pour s'informer (en anglais) sur les nouveaux paramètres et le portage des plugins de MuseScore 3 vers MuseScore Studio.

Voir aussi

Fonctionnalités de MuseScore 3 non implémentées dans MuseScore 4  (en anglais)

Support

Getting help

Overview

The official, up-to-date support info is posted at https://musescore.org/support , visit that page and read it first.

In addition to tutorial material promoted inside Musescore, MuseGroup, the managing company of the MuseScore project maintains an online server https://musescore.org  for the musician community free of charge. The community
volunteers to maintain written handbooks and a collection of help pages collaboratively. To ask for help, use https://musescore.org/en/forum

Everyone are invited to join the community and encouraged to contribute, see https://musescore.org/en/donate  and https://musescore.org/en/contribute  . Report bugs of Musescore 4 the windows, macOS and linux software at
https://github.com/musescore/MuseScore/issues

There are other really good quality third party tutorial materials, video streams and communities for different level of Musescore users online.

Learn

tutorials
classes

Forums

Go to https://musescore.org/en/forum  to read news and participate in discussions.

Issue tracker

Go to https://github.com/musescore/MuseScore/issues  to post and track issues.

GitHub

The project is available at https://github.com/musescore/MuseScore  .

Mastering MuseScore

There are other really good quality third party tutorial materials, video streams and communities for different level of Musescore users online, most notably https://school.masteringmusescore.com/  created by Mr. Marc Sabatella. While Marc
Sabatella has been contributing heavily to MuseScore codebase and official tutorial materials and diligently helping the community for an extended period of time, that site is not affiliated with Muse Group or any of its subsidiary companies.

Revert to factory settings

Overview
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Resetting Musescore app preferences may be necessary if your app's preferences are corrupted. This deletes custom palettes and custom keyboard shortcuts, and clears out links to recent scores under File menu and Home tab : Scores but
will not delete any score files.

Feel free to consult volunteers at https://musescore.org/en/forum  before committing. Proceed at your own discretion, Muse Group and the online community are not responsible for any data loss.

Reverting to factory settings from the menu

Select Help→Revert to factory settings.
Select Revert to reset.
Select Restart to restart the application.

Reverting to factory settings from the command line

If MuseScore does not start, you must run this process via the Command line.

Windows

source: https://musescore.org/en/node/342982

If you have MuseScore open, you need to close it first (File→Quit)
Type ⊞ Win+R to open the Run dialog. Alternatively select "Start" using your mouse and type "run," then click the "Run" program.
Click Browse...
Look for MuseScore4.exe on your computer. The location may vary depending on your installation, but it is probably something similar to My Computer → Local Disk → Program Files → MuseScore 4 → bin → MuseScore4.exe
Click Open to leave the Browse dialog and return to the Run dialog. The following text (or something similar) should display in the Run dialog

C:\Program Files\MuseScore 4\bin\MuseScore4.exe

or
%ProgramFiles%\MuseScore 4\bin\MuseScore4.exe

For the Windows Store version (Windows 10), it is pretty well hidden, search for it via Windows Explorer

Click after the quote and add a space followed by a hyphen and a capital F: -F
Press OK

After a few seconds, MuseScore should start and all the settings reverted to "factory settings".

For advanced users,

The main preference file is located at:
C:\Users\[USERNAME]\AppData\Roaming\MuseScore\MuseScore4.ini

or
%APPDATA%\MuseScore\MuseScore4.ini

The recent list is located at:
C:\Users\[USERNAME]\AppData\Local\MuseScore\MuseScore4\recent_files.json

or
%LOCALAPPDATA%\MuseScore\MuseScore4\recent_files.json

The other preferences (palettes, session, shortcuts, workspaces, logs, ...) are in:
C:\Users\[USERNAME]\AppData\Local\MuseScore\MuseScore4\

or
%LOCALAPPDATA%\MuseScore\MuseScore4\

For the Windows Store version (Windows 10), these are pretty well hidden, search for them via Windows Explorer

macOS

Instruction written under this section (macOS) is not tested and no Musescore 4 specific macOS test result found online yet (October 2023), the following is adapated from Musescore 3 https://musescore.org/en/handbook/3/revert-
factory-settings . Please test it, correct errors, and remove this paragraph .

If you have MuseScore open, you need to quit the application first (MuseScore→Quit)
Open Terminal (in Applications/Utilities, or via Spotlight search) and a session window should appear
Type (or copy/paste) the following command into your terminal line (include the '/' at the front):

/Applications/MuseScore\ 4.app/Contents/MacOS/mscore -F

This resets all MuseScore preferences to factory settings and immediately launches the MuseScore application. Note that you cannot quit the Terminal without quitting MuseScore. You can safely quit MuseScore, quit the Terminal, and then
reopen MuseScore in the normal fashion, ready to continue using.
For advanced users, the main MuseScore preference file is located at ~/Library/Preferences/org.musescore.MuseScore4.plist. Often, deleting this file has no effect: macOS stores a cached copy of the settings in some unknown location. The
correct way to delete this file, is by running the following command in the Terminal app:
defaults delete org.musescore.MuseScore4

The other preferences (palettes, session, shortcuts, workspaces, logs,...) (Those are not cached by macOS.) are in
~/Library/Application\ Support/MuseScore/MuseScore4/

Linux

source : https://musescore.org/en/node/345932

The following is true for Ubuntu, and most likely all other Linux distributions and UNIX-style operating systems.

If you have MuseScore open, you need to quit the application first (File→Quit)
From the Ubuntu main menu, choose Applications→Accessories→Terminal. A Terminal session window should appear
Type, (or copy/paste) the following command into your terminal line (Ctrl+Shift+V to paste in Terminal):

mscore -F

Or
musescore -F

Or
mscore4portable -F

Or, if you are using the AppImage version, use the cd command to change directory to wherever you saved the AppImage. For example, if you saved it to your Desktop (and there is only one):
cd ~/Desktop

./MuseScore*.AppImage -F

This resets all MuseScore preferences to factory settings and immediately launches the MuseScore application. You can now quit Terminal, and continue using MuseScore.

For advanced users,

the main MuseScore preference file is located at
${XDG_CONFIG_HOME:-~/.config}/MuseScore/MuseScore4.ini

The other preferences (palettes, session, shortcuts, workspaces,logs, …) are in
${XDG_DATA_HOME:-~/.local/share}/MuseScore/MuseScore4/

Troubleshooting

Browse the How-to's  first

Installation issues

"This file came from another computer ..." message see microsoft.com support
Muse Hub on Fedora (Nobara) and/or other Linux distros

Score issues

The most useful pages from How to:

How to fix MuseScore 4 corrupted files
How to fix a score that contains corruptions
How to recover a backup copy of a score

Display issues

Manuel de MuseScore 4 https://musescore.org/fr/print/book/export/html/329209?toc=1#undefin...

171 sur 199 04/07/2025, 12:24

https://musescore.org/en/forum
https://musescore.org/en/forum
https://musescore.org/en/node/342982
https://musescore.org/en/node/342982
https://musescore.org/en/handbook/3/revert-factory-settings
https://musescore.org/en/handbook/3/revert-factory-settings
https://musescore.org/en/handbook/3/revert-factory-settings
https://musescore.org/en/handbook/3/revert-factory-settings
https://musescore.org/en/community-documentation
https://musescore.org/en/community-documentation
https://musescore.org/en/node/345932
https://musescore.org/en/node/345932
https://musescore.org/en/howto?version=4.x
https://musescore.org/en/howto?version=4.x
https://support.microsoft.com/en-gb/topic/-windows-cannot-access-the-specified-device-path-or-file-error-when-you-try-to-install-update-or-start-a-program-or-file-46361133-47ed-6967-c13e-e75d3cc29657
https://support.microsoft.com/en-gb/topic/-windows-cannot-access-the-specified-device-path-or-file-error-when-you-try-to-install-update-or-start-a-program-or-file-46361133-47ed-6967-c13e-e75d3cc29657
https://musescore.org/fr/node/337059
https://musescore.org/fr/node/337059
https://musescore.org/fr/node/335842
https://musescore.org/fr/node/335842
https://musescore.org/fr/node/54721
https://musescore.org/fr/node/54721
https://musescore.org/fr/node/52116
https://musescore.org/fr/node/52116


Sound issues

Printing issues

Known incompatibilities

Annexes

Utilisation de la ligne de commande

Remarque : cette page a été copiée à partir de la page équivalente  du manuel de MuseScore 3. Si vous trouvez une option qui ne fonctionne pas avec MuseScore Studio, merci de la signaler sur GitHub et d’ajouter une note relative à
cette option dans cette page. Si l’option a été volontairement supprimée de MuseScore Studio, il faut la supprimer de cette page.

Nom

mscore, MuseScore4 , MuseScore Studio — Éditeur de partition de musique MuseScore Studio

Résumé

Vous pouvez lancer MuseScore Studio à partir de la ligne/invite de commande en tapant :
* mscore [options] [nom de fichier …] (Mac and Linux/BSD/Unix)
* musescore [options] [nom de fichier …] (Linux/BSD/Unix)
* mscore4portable [options] [nom de fichier …] (Linux AppImage)
* MuseScore4.exe [options] [nom de fichier …] (Windows)

[options] et [nom de fichier] sont optionnels. Pour que cela fonctionne le fichier exécutable de MuseScore doit être dans la variable d’environnement %PATH% (Windows) ou $PATH (Mac and Linux). Si ce n’est pas le cas, voir Restaurer les
paramètres par défaut  pour avec des instructions détaillées sur comment et où trouver et exécuter le fichier exécutable de MuseScore depuis la ligne de commande dans les différentes plateformes supportées.

Voici un résumé plus détaillé des options disponibles :

mscore [-deFfhIiLmnOPRstvw]
[-a | --use-audio driver]
[-b | --bitrate bitrate]
[-c | --config-folder pathname]
[-D | --monitor-resolution DPI]
[-d | --debug]
[-E | --install-extension extension file]
[-e | --experimental]
[-F | --factory-settings]
[-f | --force]
[-h | -? | --help]
[-I | --dump-midi-in]
[-i | --load-icons]
[-j | --job file.json]
[-L | --layout-debug]
[-M | --midi-operations file]
[-m | --no-midi]
[-n | --new-score]
[-O | --dump-midi-out]
[-o | --export-to file]
[-P | --export-score-parts]
[-p | --plugin name]
[-R | --revert-settings]
[-r | --image-resolution DPI]
[-S | --style style]
[-s | --no-synthesizer]
[-T | --trim-image margin]
[-t | --test-mode]
[-v | --version]
[-w | --no-webview]
[-x | --gui-scaling factor]
[--diff]
[--long-version]
[--no-fallback-font]
[--raw-diff]
[--run-test-script]
[--score-media]
[--score-meta]
[--highlight-config]
[--score-parts]
[--score-parts-pdf]
[--score-transpose]
[--source-update]
[--template-mode]
[file ...]

Description

MuseScore est un logiciel libre et open source de notation musicale multilingue et multiplateforme WYSIWYG (ce que vous voyez est ce que vous obtenez), publié sous la licence publique générale GNU (GPLv3).

Exécuter mscore sans option supplémentaire lance le programme MuseScore Studio en version graphique complète et ouvre tous les fichiers spécifiés dans la ligne de commande.

Les options sont les suivantes :

-a | --use-audio pilote
Utilise un fichier driver audio parmi : jack, alsa, portaudio, pulse

-b | --bitrate débit_binaire
Règle le débit binaire de sortie MP3 en kbit/s

-c | --config-folder chemin_d'accès
Outrepasse le répertoire de configuration et de paramètres

-D | --monitor-resolution DPI
Spécifie la résolution du moniteur (outrepasse la détection automatique)

-d | --debug
Démarre MuseScore Studio en mode débogage

-E | --install-extension fichier_d’extension
Installe un fichier d’extension ; les soundfonts sont chargées par défaut sauf si -e est également spécifié

-e | --experimental
Active les fonctionnalités expérimentales, telles que calques

-F | --factory-settings
Utilise uniquement les préréglages intégrés standard (“réglages d'usine”) et supprime les préférences utilisateur ; à comparer avec l’option -R (Voir aussi Restaurer les paramètres par défaut )

-f | --force
Ignore les avertissements de corruption de partition et de non-concordance de version en "mode convertisseur"

-h | -? | --help
Affiche la présentation des instructions d'appel (ne fonctionne pas sous Windows)

-I | --dump-midi-in
Affiche toutes les entrées MIDI dans la console

-i | --load-icons
Charge les icônes depuis le système de fichier ; utile si vous souhaitez modifier les icônes de MuseScore Studio et prévisualiser les changements

-j | --job fichier.json
Traite une tâche de conversion (voir Exemples plus bas)

-L | --layout-debug
Démarre MuseScore Studio en mode débogage de mise en page

-M | --midi-operations nom_fichier
Spécifie le fichier des opérations d'import MIDI (voir Exemples plus bas)

-m | --no-midi
Désactive l'entrée MIDI

-n | --new-score
Force le démarrage avec l'Assistant Nouvelle Partition, qu’il soit activé ou désactivé dans les préférences de l’utilisateur

-O | --dump-midi-out
Affiche toutes les sorties MIDI dans la console

-o | --export-to nom_fichier
Exporte le fichier donné (ou en cours) vers le fichier spécifié nom_fichier. Le type de fichier dépend de l’extension du nom de fichier donné. Cette option passe en mode convertisseur et évite l’interface utilisateur graphique.

Manuel de MuseScore 4 https://musescore.org/fr/print/book/export/html/329209?toc=1#undefin...

172 sur 199 04/07/2025, 12:24

https://musescore.org/fr/node/278640
https://musescore.org/fr/node/278640
https://musescore.org/fr/node/278582#Via-command-line
https://musescore.org/fr/node/278582#Via-command-line
https://musescore.org/fr/node/278582#Via-command-line
https://musescore.org/fr/node/278582#Via-command-line
https://musescore.org/fr/node/301598
https://musescore.org/fr/node/301598
https://musescore.org/en/node/278582
https://musescore.org/en/node/278582
https://musescore.org/fr/print/book/export/html/329209?toc=1#undefined-EXAMPLES
https://musescore.org/fr/print/book/export/html/329209?toc=1#undefined-EXAMPLES
https://musescore.org/fr/print/book/export/html/329209?toc=1#undefined-EXAMPLES
https://musescore.org/fr/print/book/export/html/329209?toc=1#undefined-EXAMPLES
https://musescore.org/fr/print/book/export/html/329209?toc=1#undefined-EXAMPLES
https://musescore.org/fr/print/book/export/html/329209?toc=1#undefined-EXAMPLES


-P | --export-score-parts

Lorsque qu’on convertit en format PDF avec l’option -o, ajoute les pages de chaque partie au fichier PDF créé. Si la partition n’a pas de partie, toutes les parties par défaut seront automatiquement générées de façon temporaire.

-p | --plugin nom
Exécute le plugin spécifié

-R | --revert-settings
Utilise seulement les préréglages standards ("réglages d'usine") mais ne supprime pas les préférences utilisateur ; à comparer avec l'option-F.

-r | --image-resolution DPI
Définit la résolution d'affichage pour la sortie vers les fichiers PNG. Par défaut : 300 DPI ( la valeur de « Résolution » du groupe d’options PNG dans l' Onglet ‘Export’ des préférences )

-S | --style style
Charge un fichier de style en premier ; pratique pour utiliser avec l'option -o

-s | --no-synthesizer
Désactive le synthétiseur logiciel intégré

-T | --trim-image marge
Recadre les images PNG et SVG exportées pour enlever les pourtours blancs de la partition. La marge, spécifiée en pixels, sera conservée (utilisez 0 pour une image totalement rognée. Lors de l’exportation vers SVG, cette option ne
fonctionne qu’avec des partitions d’une seule page.

-t | --test-mode
Active le mode test pour tous les fichiers, y compris --template-mode.

-v | --version
Affiche le nom et la version de l’application sans démarrer l’interface utilisateur graphique (ne fonctionne pas sous Windows).

-w | --no-webview
Désactive le composant Web View dans le Centre de démarrage.

-x | --gui-scaling facteur
Redimensionne l'affichage de la partition et d'autres éléments de l'interface graphique selon le facteur spécifié ; destiné à être utilisé avec des écrans haute résolution.

--diff
Imprime les différences conditionnées entre les partitions données

--long-version
Affiche le nom complet, la version et la révision git de l’application sans démarrer l’interface utilisateur graphique (ne fonctionne pas sous Windows).

--no-fallback-font
N’utilise pas Bravura comme police musicale de repli

--raw-diff
Imprime les différences brutes entre les partitions données

--run-test-script
Lance les tests des scripts listés dans les arguments de la ligne de commande

--score-media
Exporte tous les médias (sauf MP3) pour une partition donnée en tant que document JSON unique vers stdout (sortie standard)

--highlight-config
Règle le surlignage au svg généré à partir d’une partition donnée

--score-meta
Exporte les métadonnées de la partition dans un document JSON document et l’imprime vers stdout (sortie standard)

--score-parts
Génère les données des parties de la partition donnée et les enregistre en fichiers mscz séparés.

--score-parts-pdf
Génère les données des parties de la partition donnée et les exporte en un document JSON unique vers stdout (sortie standard).

--score-transpose
Transpose la partition donnée et exporte les données vers un fichier JSON unique et l’imprime vers stdout (sortie standard).

--source-update
Met à jour la source dans la partition donnée

--template-mode
Enregistre les fichiers en mode modèle (par exemple : sans format de page)

MuseScore Studio supporte aussi les options de ligne de commande Qt .

Conversion par lot au format JSON

L’argument de l’option -j doit être le chemin d’accès d’un fichier composé d’un document JSON valide respectant les spécifications suivantes :

L’élément de niveau supérieur doit être un JSONArray, qui peut être vide.
Chaque élément du tableau doit être un JSONObject avec les clés suivantes :

in : la valeur est le nom du fichier d’entrée (partition à convertir), en tant que JSONString.
plugin : la valeur est le nom de fichier d’un plugin (avec l’extension .qml), qui sera lu à partir du chemin global ou du chemin utilisateur de plugin et exécuté avant que la sortie de conversion ne se produise, en tant que JSONString.
Facultatif, mais au moins un des plugins et out doit être donné.
out : la valeur est la cible de sortie de la conversion, telle que définie ci-dessous. Facultatif, mais au moins un des plugins et out doit être donné.

La cible de sortie de conversion peut être un nom de fichier (avec l'extension, qui a décidé du format à convertir), en tant que JSONString.
La cible de sortie de conversion peut être un JSONArray de noms de fichiers comme elle peut être un JSONString, comme ci-dessus, ce qui fera que la partition sera écrite dans plusieurs fichiers de sortie (dans plusieurs formats de
sortie) séquentiellement, sans être fermée, rouverte et re-traitée entre les deux.
Si la cible de sortie de conversion est un JSONArray, un ou plusieurs de ses éléments peuvent également être, chacun, un JSONArray de deux JSONStrings (appelés première et deuxième moitié dans la description suivante). Il en
résultera une extraction des parties : pour chacune de ces deux lignes, toutes les parties existantes de la partition seront sauvegardées individuellement, les noms de fichiers étant composés en concaténant la première moitié, le nom
(titre) de la partie, et la deuxième moitié. La chaîne résultante doit être un nom de fichier valide (avec extension, déterminant le format de sortie). Si une partition n’a pas de parties (extraits) définies, elle sera silencieusement ignorée
sans erreur.

Les extensions de fichiers valides pour la sortie sont :

flac

Free Lossless Audio Codec (audio compressé sans perte)
metajson

diverses métadonnées de notation (JSON)
mid

fichier MIDI standard
midi

fichier MIDI standard
mlog

fichier journal de l'audit interne d'intégrité (JSON)
mp3

MPEG Layer III (audio compressé avec perte)
mpos

mesure des positions (XML)
mscx

fichier MuseScore non compressé
mscz

fichier MuseScore compressé
musicxml

fichier MusicXML non compressé
mxl

fichier MusicXML compressé
ogg

OGG Vorbis (audio compressé avec perte)
pdf

portable document file (impression)
png

portable network graphics (image) — les fichiers individuels, un par page de la partition, avec un trait d’union suivi du numéro de page placé avant l’extension de fichier, seront générés.
spos

segment positions (XML)
svg

scalable vector graphics (image)
wav

RIFF Waveform (audio non compressé)
xml

fichier MusicXML non compressé

Voir plus bas pour un exemple.

Environnement

SKIP_LIBJACK

Paramétrez cela (la valeur n’a pas d’importance) pour sauter l’initialisation de la bibliothèque du kit de connexion Jack audio, dans le cas où il pose des problèmes.
XDG_CONFIG_HOME

Localisation de la configuration utilisateur ; défini par défaut à ~/.config si elle n’est pas paramétrée.
XDG_DATA_HOME

Localisation des données utilisateur ; défini par défaut à ~/.local/share si elle n’est pas paramétrée.

Notez que MuseScore Studio supporte aussi les variables de l’environnement Qt normal telles que QT_QPA_GENERIC_PLUGINS, QT_QPA_PLATFORM, QT_QPA_PLATFORMTHEME, QT_QPA_PLATFORM_PLUGIN_PATH, QT_STYLE_OVERRIDE, DISPLAY, etc.
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Fichiers

/usr/share/mscore-4.0/ contient les données support de l’application (démos, instruments, localisation, plugins système, soundfonts, styles, accords, modèles et papiers peints). A la place, dans la distribution Debian, les soundfonts systèmes
sont respectivement installés dans /usr/share/sounds/sf2/, /usr/share/sounds/sf3/ ou /usr/share/sounds/sfz/.

Les données (extensions, plugins, soundfonts, styles, modèle) et fichiers (images, scores) de l’utilisateur sont normalement installés dans des sous-répertoires sous ~/MuseScore4/ mais elles peuvent être modifiées dans la configuration. Notez
que les versions snapshot, alpha et beta utilisent MuseScore4Development à la place de MuseScore4 pour tous ces chemins.

$XDG_CONFIG_HOME/MuseScore/MuseScore4.ini contient les préférences utilisateur, la liste des fichiers récemment ouverts ainsi que leur localisation, la position et la taille des fenêtres, etc. Voir ci-dessus pour les chemins des versions de
développement.

$XDG_DATA_HOME/data/MuseScore/MuseScore4/ contient la localisation mise à jour des fichiers téléchargés depuis le programme, les informations de plugins, les partitions en cache, les certificats pour le site communautaire musescore.com, les
informations de sessions, les paramètres de synthétiseur ; les clefs, indications de mesure et raccourcis personnalisés. Voir ci-dessus pour les chemins des versions de développement.

Exemples

Convertir une partition en pdf à partir de la ligne de commande

mscore -o 'My Score.pdf' 'My Score.mscz'

Exécuter un lot de commande pour convertir plusieurs documents

mscore -j job.json

Cela nécessite de s’assurer qu’un fichier job.json existe dans le répertoire courant avec un contenu similaire au suivant :

[
    {
        "in": "MyScore1.mscz",
        "out": "MyScore1.pdf"
    },
    {
        "in": "MyScore2.mscz",
        "plugin": "colornotes.qml",
        "out": [
            "MyScore2-notecolors.pdf",
            "MyScore2-notecolors.svg"
        ]
    },
    {
        "in": "MyScore3.mscz",
        "out": [
            "MyScore3.pdf",
            "MyScore3.musicxml",
            "MyScore3.mid",
            [
                "MyScore3 (",
                " part).pdf"
            ]
        ]
    }
]

Si MyScore3.mscz contient des extraits (parties instrumentales), la syntaxe ci-dessus devrait entraîner la production de fichiers comme “MyScore3 (partie violon).pdf” à côté du PDF et des fichiers MusicXML du conducteur, aussi bien qu’un
fichier MIDI avec l’orchestration complète. Si MyScore3.mscz ne comporte pas d’extraits définis, seuls les fichiers PDF, MusicXML, et MIDI du conducteur seront générés, alors que la requête pour les parties PDF est ignorée de façon
silencieuse.

Opération d’importation MIDI

Le fichier midi_import_options.xml  est un exemple de fichier d’opération d’importation pour l’option -M.

Diagnostics

L’utilitaire mscore renvoie 0 en cas de succès et >0 si une erreur survient.

Voir aussi

https://musescore.org/handbook

Manuel en ligne

https://musescore.org/forum

Forum de support

https://musescore.org/en/node/278582

Restaurer les paramètres par défaut (en cas d’anomalies)

https://github.com/musescore/MuseScore/issues

Outil de suivi des problèmes —  vérifier d’abord si le bug que vous rencontrez a déjà été signalé. Si vous avez juste besoin d’une aide pour réaliser quelque chose, merci d’utiliser plutôt le forum .

http://doc.qt.io/qt-5/qguiapplication.html#supported-command-line-optio…

Documentation sur les options de ligne de commande automatiques Qt

Standards

MuseScore Studio a pour objet d’implémenter les standards suivants :

MusicXML 3.1 (format d’échange de partitions)
SF2 (SoundFont 2.01)
SF3 (SoundFont avec échantillons compressés OGG Vorbis)
SFZ (soundfont Sforzato)
SMuFL (police de mise en page de musique standard 1.20)

Historique

MuseScore s’est séparé du séquenceur MusE en 2002 et est devenu depuis le principal programme open source de notation musicale.

Auteurs

MuseScore Studio est développé par MuseScore BVBA et autres.

Ce manuel a été écrit par mirabilos <tg@debian.org >.

Avertissements

Les options de ligne de commande Qt automatiques sont retirés du vecteur d’argument avant que l’application ait la possibilité de traiter les options ; cela signifie qu’une invocation comme mscore -S -reverse ne peut pas fonctionner car -
reverse est d’abord retiré par Qt.

Bugs

MuseScore Studio ne distingue pas /etc/papersize.

Potentiellement quelques autres ; voir l’outil de suivi des problèmes (cf. Voir aussi).

Tous les raccourcis clavier

Sur macOS, réalisez les substitutions suivantes :

Remplacer Ctrl par Cmd (ou ⌘)
Remplacer Alt par Option (ou ⌥)
Remplacer Début par Fn+←
Remplacer Fin par Fn+→
Remplacer Page haut par Fn+↑
Remplacer Page bas par Fn+↓
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Ajouter Fn aux touches de fonction

Schéma de clavier

Cliquez pour une résolution maximale. Imprimez une version PDF pratique

Navigation

Page entre pages

Action Windows/Linux macOS

Zoomer Ctrl+= Cmd+=

Dézoomer Ctrl+- Cmd+-

Zoomer à 100 % Ctrl+0 Cmd+0

Aller au premier élément de la partition Ctrl+Début Cmd+Fn+←

Aller au dernier élément de la partition Ctrl+Fin Cmd+Fn+→

Aller à l’écran suivant Page bas Fn+↓

Aller à l’écran précédent Page haut Fn+↑

Aller au haut de la première page Début Fn+←

Aller au bas de la dernière page Fin Fn+→

Aller à la page suivante Ctrl+Page bas Cmd+Fn+↓

Aller à la page précédente Ctrl+Page haut Cmd+Fn+↑

Rechercher / Aller à … Ctrl+F Cmd+F

Accessibilité : localiser Maj+L Maj+L

Montrer/masquer la timeline F12 Fn+F12

Score navigation

Action Windows/Linux macOS

Sélectionner l’accord suivant → →

Sélectionner l’accord précédent ← ←

Aller à la mesure suivante Ctrl+→ Cmd+→

Aller à la mesure précédente Ctrl+← Cmd+←

Sélectionner l’élément suivant dans la partition Alt+→ Option+→

Sélectionner l’élément précédent dans la partition Alt+← Option+←

Sélectionner l’élément suivant dans la portée Ctrl+Alt+Maj+→ Cmd+Option+Maj+→

Sélectionner l’élément précédent dans la portée Ctrl+Alt+Maj+← Cmd+Option+Maj+←

Sélectionner la note / le silence au-dessus Alt+↑ Option+↑

Sélectionner la note / le silence au-dessous Alt+↓ Option+↓

Sélectionner la note supérieure d’un accord Ctrl+Alt+↑ Cmd+Option+↑

Sélectionner la note inférieure d’un accord Ctrl+Alt+↓ Cmd+Option+↓

Aller à la portée du haut Alt+Maj+↑ Option+Maj+↑

Aller à la portée du bas Alt+Maj+↓ Option+Maj+↓

Saisie des notes

Général

Action Windows/Linux macOS

Saisie de notes : basculer en/hors mode de saisie des notes N N

Saisie de notes : basculer en/hors mode 'Hauteur des notes existantes' Ctrl+Maj+I Cmd+Maj+I

Saisie de notes : basculer en/hors mode 'Insérer' Ctrl+I Cmd+I

Afficher/cacher le clavier de piano P P

Utiliser la voix 1 Ctrl+Alt+1 Cmd+Option+1

Utiliser la voix 2 Ctrl+Alt+2 Cmd+Option+2

Utiliser la voix 3 Ctrl+Alt+3 Cmd+Option+3

Utiliser la voix 4 Ctrl+Alt+4 Cmd+Option+4

Durée des notes

Action Windows/Linux macOS

Définir la durée 1 – 9 1 – 9

Définir la durée = quadruple croche 1 1

Définir la durée = triple croche 2 2

Définir la durée = double croche 3 3

Définir la durée = croche 4 4

Définir la durée = noire 5 5

Définir la durée = blanche 6 6

Définir la durée = ronde 7 7

Définir la durée = carrée 8 8

Basculer en/hors note pointée . .

Saisir une division irrégulière Ctrl+2 – Ctrl+9 Cmd+2 – Cmd+9

Saisir un duolet Ctrl+2 Cmd+2

Saisir un triolet Ctrl+3 Cmd+3

Saisir un quartolet Ctrl+4 Cmd+4

Saisir un quintolet Ctrl+5 Cmd+5

Saisir un sextolet Ctrl+6 Cmd+6

Saisir un septolet Ctrl+7 Cmd+7

Saisir un octolet Ctrl+8 Cmd+8

Saisir un nonolet Ctrl+9 Cmd+9

Ajouter une liaison de prolongation T T

Réduire de moitié la durée de la sélection Q Q

Doubler la durée de la sélection W W

Réduire de moitié la durée de la sélection (y compris valeurs pointées) Maj+Q Maj+Q
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Action Windows/Linux macOS

Doubler la durée de la sélection (y compris valeurs pointées) Maj+W Maj+W

Insérer une pause de mesure Ctrl+Maj+Suppr Cmd+Maj+Suppr

Hauteur des notes

Action Windows/Linux macOS

Saisir une note A – G A – G

Saisir un La A A

Saisir un Si B B

Saisir un Do C C

Saisir un Ré D D

Saisir un Mi E E

Saisir un Fa F F

Saisir un Sol G G

Ajouter une note sur un accord Maj+A – Maj+G Maj+A – Maj+G

Ajouter un La sur un accord Maj+A Maj+A

Ajouter un Si sur un accord Maj+B Maj+B

Ajouter un Do sur un accord Maj+C Maj+C

Ajouter un Ré sur un accord Maj+D Maj+D

Ajouter un Mi sur un accord Maj+E Maj+E

Ajouter un Fa sur un accord Maj+F Maj+F

Ajouter un Sol sur un accord Maj+G Maj+G

Saisir un intervalle Alt+1 – Alt+9 Option+1 – Option+9

Saisir un intervalle : unisson Alt+1 Option+1

Saisir un intervalle : seconde ascendante Alt+2 Option+2

Saisir un intervalle : tierce ascendante Alt+3 Option+3

Saisir un intervalle : quarte ascendante Alt+4 Option+4

Saisir un intervalle : quinte ascendante Alt+5 Option+5

Saisir un intervalle : sixte ascendante Alt+6 Option+6

Saisir un intervalle : septième ascendante Alt+7 Option+7

Saisir un intervalle : octave ascendante Alt+8 Option+8

Saisir un intervalle : neuvième ascendante Alt+9 Option+9

Ajouter/supprimer une altération : bémol - -

Ajouter/supprimer une altération : bécarre = =

Ajouter/supprimer une altération : dièse + +

Saisir un silence 0 0

Ajouter une fioriture : acciaccatura / /

Tablature

Action Windows/Linux macOS

Définir la durée (TAB) Maj+1 – Maj+9 Maj+1 – Maj+9

Définir la durée = quadruple croche (TAB) Maj+1 Maj+1

Définir la durée = triple croche (TAB) Maj+2 Maj+2

Définir la durée = double croche (TAB) Maj+3 Maj+3

Définir la durée = croche (TAB) Maj+4 Maj+4

Définir la durée = noire (TAB) Maj+5 Maj+5

Définir la durée = blanche (TAB) Maj+6 Maj+6

Définir la durée = ronde (TAB) Maj+7 Maj+7

Saisir TAB : frette 0 – 9 0 – 9

Saisir TAB : frette A – K A – K

Saisir TAB : frette 0 0 0

Saisir TAB : frette 1 1 1

Saisir TAB : frette 2 2 2

Saisir TAB : frette 3 3 3

Saisir TAB : frette 4 4 4

Saisir TAB : frette 5 5 5

Saisir TAB : frette 6 6 6

Saisir TAB : frette 7 7 7

Saisir TAB : frette 8 8 8

Saisir TAB : frette 9 9 9

Saisir TAB : frette 0 A A

Saisir TAB : frette 1 B B

Saisir TAB : frette 2 C C

Saisir TAB : frette 3 D D

Saisir TAB : frette 4 E E

Saisir TAB : frette 5 F F

Saisir TAB : frette 6 G G

Saisir TAB : frette 7 H H

Saisir TAB : frette 8 J J

Saisir TAB : frette 9 K K

Aller à la corde du dessus (TAB) ↑ ↑

Aller à la corde du dessous (TAB) ↓ ↓

Bascule avec/sans note étouffée Maj+X Maj+X

Sélection

Action Windows/Linux macOS

Tout sélectionner Ctrl+A Cmd+A

Ajouter à la sélection : note/silence qui précède Maj+← Maj+←

Ajouter à la sélection : note/silence qui suit Maj+→ Maj+→

Ajouter à la sélection : portée du dessus Maj+↑ Maj+↑

Ajouter à la sélection : portée du dessous Maj+↓ Maj+↓

Sélectionner jusqu’au début de la mesure Ctrl+Maj+← Cmd+Maj+←

Sélectionner jusqu’à la fin de la mesure Ctrl+Maj+→ Cmd+Maj+→

Sélectionner jusqu’au début de la ligne Maj+Home Maj+Fn+←

Sélectionner jusqu’à la fin de la ligne Maj+End Maj+Fn+→

Sélectionner jusqu’au début de la partition Ctrl+Maj+Home Cmd+Maj+Fn+←

Sélectionner jusqu’à la fin de la partition Ctrl+Maj+End Cmd+Maj+Fn+→

Édition

Général

Action Windows/Linux macOS

Sortir Echap. Echap.

Annuler Ctrl+Z Cmd+Z

Rétablir Ctrl+Maj+Z Cmd+Maj+Z

Copier Ctrl+C Cmd+C

Couper Ctrl+X Cmd+X

Coller Ctrl+V Cmd+V

Copier/coller : échange avec le presse-papier Ctrl+Maj+X Cmd+Maj+X
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Action Windows/Linux macOS

Répéter la sélection R R

Insérer une mesure avant la sélection Ins Ins

Insérer des mesures avant la sélection Ctrl+Ins Cmd+Ins

Insérer une mesure à la fin de la partition Ctrl+B Cmd+B

Insérer des mesures à la fin de la partition Alt+Maj+B Option+Maj+B

Supprimer Suppr Suppr

Supprimer les mesures sélectionnées Ctrl+Suppr Cmd+Suppr

Afficher/cacher les propriétés F8 Fn+F8

Éditer l’élément F2 Fn+F2

Déplacer l’accord/silence vers la gauche Maj+← Maj+←

Déplacer l’accord/silence vers la droite Maj+→ Maj+→

Durée

Action Windows/Linux macOS

Définir la durée 1 – 9 1 – 9

Saisir une division irrégulière Ctrl+2 – Ctrl+9 Cmd+2 – Cmd+9

Ajouter une liaison de prolongation T T

Réduire de moitié la durée de la sélection Q Q

Doubler la durée de la sélection W W

Réduire de moitié la durée de la sélection (y compris valeurs pointées) Maj+Q Maj+Q

Doubler la durée de la sélection (y compris valeurs pointées) Maj+W Maj+W

Coller avec la moitié de la durée Ctrl+Maj+Q Cmd+Maj+Q

Coller avec le double de la durée Ctrl+Maj+W Cmd+Maj+W

Insérer un pause de mesure Ctrl+Maj+Suppr Cmd+Maj+Suppr

Hauteur

Action Windows/Linux macOS

Ajouter/supprimer un bémol - -

Ajouter/supprimer un bécarre = =

Ajouter/supprimer un dièse + +

Augmenter la hauteur de la sélection ↑ ↑

Diminuer la hauteur de la sélection ↓ ↓

Augmenter d’une octave Ctrl+↑ Cmd+↑

Diminuer d’une octave Ctrl+↓ Cmd+↓

Augmenter la hauteur de façon diatonique Alt+Maj+↑ Option+Maj+↑

Diminuer la hauteur de façon diatonique Alt+Maj+↓ Option+Maj+↓

Changer l’appellation enharmonique (tonalité écrite et réelle) J J

Changer l’appellation enharmonique (tonalité en cours seulement) Ctrl+J Cmd+J

Déplacer une note vers la corde du dessus (TAB) Ctrl+↑ Cmd+↑

Déplacer une note vers la corde du dessous (TAB) Ctrl+↓ Cmd+↓

Bascule avec/sans note étouffée (TAB) Maj+X Maj+X

Notation

Action Windows/Linux macOS

Renverser la direction des hampes de notes X X

Tête de note inversée Maj+X Maj+X

Utiliser la voix 1 Ctrl+Alt+1 Cmd+Option+1

Utiliser la voix 2 Ctrl+Alt+2 Cmd+Option+2

Utiliser la voix 3 Ctrl+Alt+3 Cmd+Option+3

Utiliser la voix 4 Ctrl+Alt+4 Cmd+Option+4

Déplacer les notes/silences sélectionnés dans la portée du dessus Ctrl+Maj+↑ Cmd+Maj+↑

Déplacer les notes/silences sélectionnés dans la portée du dessous Ctrl+Maj+↓ Cmd+Maj+↓

Activer/désactiver les pauses multimesures M M

Réglages manuels

Action Windows/Linux macOS

Déplacer le texte vers la gauche ← ←

Déplacer le texte vers la droite → →

Déplacer rapidement le texte vers la gauche Ctrl+← Cmd+←

Déplacer rapidement le texte vers la droite Ctrl+→ Cmd+→

Déplacer la sélection vers le haut ↑ ↑

Déplacer la sélection vers le bas ↓ ↓

Déplacer rapidement la sélection vers le haut Ctrl+↑ Cmd+↑

Déplacer rapidement la sélection vers le bas Ctrl+↓ Cmd+↓

Texte

Général

Action Windows/Linux macOS

Ajouter du texte : texte de portée Ctrl+T Cmd+T

Ajouter du texte : texte d’expression Ctrl+E Cmd+E

Ajouter du texte : texte de système Ctrl+Maj+T Cmd+Maj+T

Ajouter du texte : indications de tempo Alt+Maj+T Option+Maj+T

Ajouter du texte : repère Ctrl+M Cmd+M

Insérer des caractères spéciaux Maj+F2 Maj+Fn+F2

Mise en forme

Action Windows/Linux macOS

Mettre en forme le texte : gras Ctrl+B Cmd+B

Mettre en forme le texte : italique Ctrl+I Cmd+I

Mettre en forme le texte : souligné Ctrl+U Cmd+U

Insérer un bémol Ctrl+Maj+B Cmd+Maj+B

Insérer un bécarre Ctrl+Maj+H Cmd+Maj+H

Insérer un dièse Ctrl+Maj+# Cmd+Maj+#

Insérer un signe de nuance p Ctrl+Maj+P Cmd+Maj+P

Insérer un signe de nuance m Ctrl+Maj+M Cmd+Maj+M

Insérer un signe de nuance f Ctrl+Maj+F Cmd+Maj+F

Insérer un signe de nuance n Ctrl+Maj+N Cmd+Maj+N

Insérer un signe de nuance r Ctrl+Maj+R Cmd+Maj+R

Insérer un signe de nuance s Ctrl+Maj+S Cmd+Maj+S

Insérer un signe de nuance z Ctrl+Maj+Z Cmd+Maj+Z

Paroles

Action Windows/Linux macOS

Ajouter du texte : paroles Ctrl+L Cmd+L

Paroles : aller à la syllabe suivante Space Space

Paroles : aller à la syllabe précédente Maj+Space Maj+Space
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Action Windows/Linux macOS

Paroles : saisir un trait d’union - -

Paroles : saisir un mélisme _ _

Paroles : ajouter un couplet Return Return

Paroles : aller au couplet suivant ↓ ↓

Paroles : aller au couplet précédent ↑ ↑

Symboles d’accords, chiffres romains d'analyse, numéros Nashville, basse chiffrée

Action Windows/Linux macOS

Ajouter du texte : symbole d’accord Ctrl+K Cmd+K

Ajouter du texte : basse chiffrée Ctrl+G Cmd+G

Élément de texte suivant Space Space

Élément de texte précédent Maj+Space Maj+Space

Progression du curseur : temps suivant ; ;

Progression du curseur : temps précédent Maj+; Maj+;

Progression du curseur : durée Ctrl+1 – Ctrl+9 Cmd+1 – Cmd+9

Autres éléments de partition

Action Windows/Linux macOS

Afficher/cacher les palettes F9 Fn+F9

Rechercher des palettes Ctrl+F9 Cmd+Fn+F9

Ouvrir la palette principale Maj+F9 Maj+Fn+F9

Ajouter une liaison de phrasé S S

Ajouter une articulation : accent Maj+V Maj+V

Ajouter une articulation : marcato Maj+O Maj+O

Ajouter une articulation : staccato Maj+S Maj+S

Ajouter une articulation : tenuto Maj+N Maj+N

Ajouter une nuance : crescendo < <

Ajouter une nuance : diminuendo > >

Ajouter des parenthèses à un élément ( (

Paramétrage et mise en forme de la partition

Action Windows/Linux macOS

Ajouter/supprimer des instruments I I

Ouvrir la fenêtre de dialogue des instruments F7 Fn+F7

Rendre visible/invisible des éléments V V

Diminuer l’étirement de la mesure { {

Augmenter l’étirement de la mesure } }

Ajouter/supprimer un saut de système Return Return

Ajouter/supprimer un saut de page Ctrl+Return Cmd+Return

Réinitialiser les formes et positions Ctrl+R Cmd+R

Opérations sur les fichiers

Action Windows/Linux macOS

Nouveau Ctrl+N Cmd+N

Ouvrir Ctrl+O Cmd+O

Fermer Ctrl+W Cmd+W

Enregistrer Ctrl+S Cmd+S

Enregistrer sous Ctrl+Maj+S Cmd+Maj+S

Imprimer Ctrl+P Cmd+P

Quitter Ctrl+Q Cmd+Q

Interface utilisateur (UI)

Lecture

Action Windows/Linux macOS

Lire Space Space

Afficher/cacher le mélangeur F10 Fn+F10

Accessibilité

Action Windows/Linux macOS

Groupe UI suivant Tab Tab

Groupe UI précédent Maj+Tab Maj+Tab

Panneau/fenêtre UI suivante F6 Fn+F6

Panneau/fenêtre UI précédente Maj+F6 Maj+Fn+F6

Autres

Action Windows/Linux macOS

Multi-instances Ctrl+F3 Cmd+Fn+F3

Plein écran F11 Fn+F11

Known incompatibilities

Modifications des percussions MDL

[Avis aux lecteurs : Vous pouvez signaler les coquilles / erreurs trouvées dans ce manuel sur la page ‘Documentation’ du forum .]

Muse Drumline (MDL2) est une bibliothèque de sons gratuite de Muse Sounds, disponible pour MuseScore Studio. Elle est le successeur de MuseScore Drumline (MDL1), une extension optionnelle de MuseScore 3.

Si vous ouvrez une partition MuseScore 3 dans MuseScore Studio, une boîte de dialogue apparaît vous informant des modifications apportées à l'apparence de votre partition. À partir de MuseScore Studio 4.4, la boîte de dialogue de
migration inclut désormais une case à cocher pour activer notre nouvelle notation et notre nouveau mappage des sons des percussions MDL.
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Cette case à cocher doit être cochée pour que les instruments de percussion de défilé MDL1 sonnent correctement pendant la lecture avec MS Basic et Muse Sounds. Cette case à cocher n'a aucun effet sur les autres instruments en dehors
de ceux de MDL1.

Mappage des sons

MDL2 et MS Basic utilisent un ensemble particulier de presets MIDI pour représenter les sons de percussion. Cela signifie que les partitions créées avec MDL2 sont compatibles avec MS Basic, et vice versa.

Cependant, MDL1 utilisait un ensemble différent de presets MIDI pour représenter les sons de percussion, donc lors de l'ouverture d'une partition contenant des notes pour les instruments MDL1, il est nécessaire de les convertir en presets
MDL2, sinon, la lecture sonnera faux (vous pourriez entendre un rimshot au lieu d'un roulement, par exemple).

Certains sons de MDL1 n’ont pas de correspondance exacte dans MDL2. Dans quelques cas, plusieurs presets MDL1 sont mappées sur un seul preset dans MDL2. Cela signifie que certaines notes de percussion qui sonnaient différemment
dans MuseScore 3 peuvent désormais sonner de la même manière dans MuseScore Studio.

La conversion vers le nouveau mappage de sons est un processus à sens unique, et doit être fait lorsque vous ouvrez une partition MDL1 de MuseScore 3 pour la première fois dans MuseScore Studio v4.4. Comme toujours, nous vous
recommandons d’enregistrer la partition dans un nouveau fichier, en laissant le fichier original de MuseScore 3 inchangé.

Notation

En plus de quelques notes auparavant distinctes qui se ressemblent désormais, le processus de conversion applique également une nouvelle définition de batterie aux instruments de percussion MDL1. Cela modifie encore davantage la
notation de ces instruments, en changeant la forme de certaines têtes de notes et en les faisant apparaître plus bas ou plus haut sur la portée.

Contrairement au mappage des sons, qui est fixe, les changements de notation de batterie peuvent être modifiés via la boîte de dialogue Éditer le set de batterie une fois la partition chargée.

Mise à niveau depuis MuseScore 3.x

Vue d’ensemble

Vidéo en anglais, sous-titrée en français.

Raccourcis clavier

Voir Tous les raccourcis clavier pour MuseScore Studio. Voici les plus communs qui ont été modifiés ou qui sont nouveaux :

Action MuseScore 3 MuseScore Studio

Ajouter une liaison de prolongation + T

Aller à la mesure suivante (saisie de symbole d’accord) Tab Ctrl/Cmd+→

Aller à la mesure suivante (saisie de symbole d’accord) Shift+Tab Ctrl/Cmd+←

Ajouter/supprimer une altération : bémol None -

Ajouter/supprimer une altération : bécarre None =

Ajouter/supprimer une altération : dièse None +

Éditer l’élément Alt+Shift+E F2 or Alt+Shift+E

Insérer des caractères spéciaux F2 Shift+F2

Aller au panneau/fenêtre UI suivant None F6

Aller au panneau/fenêtre UI précédent None Shift+F6

Afficher/cacher le filtre de sélection F6 None

Autres modifications

L’Inspecteur  de MuseScore 3 a été remplacé par le panneau Propriétés dans MuseScore Studio.
L’outil pour basculer entre l’affichage par page et l‘affichage continu est maintenant situé en bas à droite de la fenêtre de MuseScore.
Même chose pour la commande de zoom.
Même chose pour la bascule entre tonalité écrite et tonalité réelle.
Pour modifier (temporairement) la vitesse de lecture il faut dorénavant détacher le panneau de lecture.
Le bouton "Activer l’entrée MIDI" est maintenant derrière la roue crantée du panneau de lecture.
Le point d’orgue est maintenant dans la palette Respiration et pauses palette
Masquer un instrument le rend désormais muet par défaut. Cependant, on peut maintenant masquer les portées individuelles de l’instrument, ce qui est plus souple.
L’outil texte  est maintenant dans les Propriétés de texte, partiellement 'masqué' derrière le bouton __Plus__.

Fonctionnalités manquantes

De fait de la nature de la mise à jour, certaines fonctionnalités présentes auparavant dans MuseScore 3 n’ont pas (encore) été implémentées. Voir la liste de ces éléments  dans le manuel du développeur .

Upgrade from MuseScore 2.x or 1.x
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Handbook for MuseScore 3.x

Handbook for MuseScore 2.x

Handbook for MuseScore 1.x

Glossaire

[Avis aux lecteurs : vous pouvez signaler les coquilles/erreurs trouvées dans ce manuel sur la page ‘documentation’ du forum .]

La liste ci-dessous est un glossaire des termes techniques et musicaux qui sont fréquemment utilisés dans le manuel de MuseScore Studio. Il précise les liens vers les chapitres concernés. Des images sont fournies pour aider les musiciens
qui sont capables de lire la notation mais ne connaissent pas le vocabulaire spécifique. Cette page n'a pas pour objet d'être un dictionnaire de tous les termes musicaux : voir les liens externes.
[Les différences entre termes américains et anglo-saxons ne sont pas reprises dans la version française].

A

Accent

L’accent ou martellato est une articulation symbolisée par un tiret écrit au-dessus (ou au-dessous) de la tête de note. Il indique que la note doit être jouée de façon "martelée", c’est à dire légèrement plus fort et decrescendo.

Acciaccatura

 C’est une courte fioriture qui se présente comme une petite note avec une barre traversant la hampe, le plus souvent une croche, placée devant une note de taille normale. Également appelée appogiature brève, elle est
rapidement exécutée au cours du temps de la note principale. MuseScore Studio en fait une lecture rapide dont la durée n'est pas affectée par la durée de la note parente.

Accolade

Voir Crochet de système

Accord

Un groupe de deux notes ou plus jouées en même temps.
2. Dans MuseScore Studio, seules les notes jouées ensemble qui ont la même durée dans une même Voix Musescore constituent un accord. Pour sélectionner un accord dans MuseScore Studio, tapez Maj et cliquez sur une note. Voir
le chapitre Travailler avec plusieurs voix.
3. Dans MuseScore Studio, un symbole d'accord. Voir le chapitre Symboles d'accord.

Altération

Une altération est un signe placé devant la note pour augmenter ou diminuer sa hauteur. Voir le chapitre Saisir des notes et des silences : Altérations. MuseScore Studio n'assure la lecture que des altérations les plus courantes dont
font partie dièse, bémol, bécarre, double dièse, double bémol et triple bémol. Pour créer des altérations microtonales comme les quarts de tons, voir le chapitre du manuel Musescore 3 Tuning systems, microtonal notation system,
and playback  [en anglais].
On distingue les altérations accidentelles — qui affectent toutes les notes de même hauteur dans la mesure où elles sont placées, si elles ne sont pas annulées par une autre altération — et les altérations de l’armure qui sont valables
pour toutes les notes de même nom rencontrées. Si l’altération porte sur une note liée par une liaison de prolongation entre deux mesures, l’altération perdure sur la durée de la note mais pas au-delà.

Ambitus

Étendue d'une mélodie, d'une voix ou d'un instrument, entre sa note la plus grave et sa note la plus élevée dans la portée. Voir le chapitre Ambitus.

Anacrouse

Première mesure incomplète d’une composition morceau ou d’une section d’un morceau de musique. Voir Anacrouse et notation non mesurée et Créer une nouvelle partition : Anacrouse.

Ancre

Point d'attache sur la partition d'objets comme Texte et Lignes. Quand l'objet est déplacé, l'ancre apparaît sous la forme d'un petit cercle marron connecté à l'objet par une ligne en pointillés. En fonction de l'objet sélectionné, l’ancre peut
être attachée à (1) une note (exemple : doigté), (2) une ligne de portée (exemple : texte de portée) ou bien (3) une barre de mesure (exemple : barre de reprise).

Appoggiature

C’est une fioriture qui se présente comme une petite note (noire, croche, etc.) placée devant une note principale. Également appelée appogiature longue, elle s’exécute dans la durée de la figure de(s) note(s). La durée de la note
principale est déduite de celle de l’appogiature. MuseScore Studio en crée la lecture de cette façon. Il est possible d'exécuter une appoggiature en acciaccatura de nos jours mais MuseScore Studio n'en assure pas la même lecture.

Armure

Ensemble d’altérations dièses ou bémols placés au début de la portée, après la clef. Elle donne une idée de la tonalité et évite d’avoir à répéter ces signes tout au long de la portée.
Par exemple, une armure avec un Si bémol indique une tonalité en Fa Majeur ou en Ré mineur. Voir Armures.

Armure de précaution

Quelquefois désignée sous les termes d'armure "de rappel" ou "de courtoisie", c’est une armure qui est disposée à la fin d’un système pour signaler le changement d'armure au départ du prochain système.

Arpège

Un arpège est une série de notes constituant un accord qui sont jouées successivement. Un symbole d’arpège placé devant un accord demande à l'interprète jouer les notes constitutives l’une après l'autre. La flèche sur le symbole
d'arpège indique la direction dans laquelle l'interprète doit jouer les notes de l'accord. Voir Arpèges et glissandos

Articulation

Marque ou symbole indiquant comment les notes doivent être jouées, en maîtrisant les attaques et le détachement entre les notes (silences d'articulations). Voir : accent, legato, mercato, [staccato](#staccato], tenuto. Voir Articulation.

B

Barre de mesure

Ligne verticale qui sépare deux mesures. Les barres de mesures peuvent traverser une ou plusieurs portées ou un système complet. Voir Barre de mesure.

Barres de reprise

Voir Reprise.

Bécarre

Un bécarre (♮) est un signe qui annule une altération précédente sur les notes de la même hauteur dans la mesure. Voir altérations et armure.

Bémol

Un bémol (♭) indique que la hauteur de la note doit être abaissée d’un demi-ton. Voir altérations et armure.

Blanche

Note dont la durée vaut la moitié de celle de la ronde.
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BPM

Unité de tempo qui n'est utilisée, dans MuseScore Studio, que dans la barre de menu Lecture. BPM (battements par minute) est la quantité de noires qui pourraient être jouées en une minute. Ce n'est pas le nombre utilisé dans
l'indication de métronome d'une partition. Voir Commandes de lecture.

C

Capodastre (texte de)

Texte pour indiquer le réglage du dispositif de transposition utilisé sur un instrument. Voir le chapitres Lecture avec capodastre (MS 4.0.2 et version précédentes) et Appliquer un capodastre.

Carrée ou brevis

Une note carrée est une note qui vaut 2 rondes ou 4 noires (etc.).

Cent

Intervalle correspondant au centième d’un demi-ton, utilisé par la propriété Réglage d'accord d'une note. Voir le chapitre Panneau des Propriétés.

Césure

Une césure (//) est une pause brève à l’intérieur d’un motif mélodique. Le temps n’est pas compté pour cette attente et la musique reprend au signal du chef d’orchestre. Voir Césure

Clef

Symbole musical utilisé pour indiquer quelles notes sont représentées par les lignes et interlignes sur une portée. Voir le chapitre Clef. Voir aussi Clef de précaution.

Clef de précaution

Quelquefois désignée sous les termes "de rappel" ou "de courtoisie", c'est une clef en format réduit qui est disposée à la fin d’un système pour signaler le changement de clef au départ du prochain système.

Coda

Passage qui conduit une pièce (ou un mouvement) musical à sa fin.

2.  Symbole de navigation en forme de croix réticulée. Il est utilisé lorsque la fin d'une section répétée est à l'intérieur de cette section plutôt que dans sa partie finale. Voir aussi le signe dal segno. Voir le chapitre Sauts et
repères.

Crescendo

Marque de nuance indiquant que l'intensité des notes jouées augmente progressivement. Symbolisé sous la forme d'un texte (cresc.) ou d'un "soufflet" ouvrant (<)

Croche

Note dont la durée vaut le huitième d’une ronde.

Crochet de note

Symbole (également nommé "durée") ajouté à la hampe d'une note (croche, double croche, etc.) pour en modifier la durée.

Crochet de système

Signe (crochet, accolade) réunissant deux portées jouées en même temps.
Voir système

D

Da capo (D.C.)

Symbole demandant de répéter la partie de musique précédente. Voir le chapitre Sauts et repères.

Decrescendo

Voir Diminuendo

Dièse

Un dièse (♯) est une altération qui indique que la hauteur de la note doit être augmentée d’un demi-ton. Voir altérations et armure.

Diminuendo

Marque de nuance indiquant que l'intensité des notes jouées diminue progressivement. Symbolisé sous la forme d'un texte (dim.) ou d'un "soufflet" qui se ferme (>)

Division irrégulière

Une division irrégulière, également appelée division artificielle, permet d'insérer un nombre de notes différent de celui prescrit par l'indication de mesure. Voir le chapitre Division irrégulière. Par exemple, un triolet divise la durée de la
note en trois parties plutôt qu’en deux. Il permet d’insérer un temps ternaire dans une composition de temps binaire. A l’inverse, le duolet est utilisé pour insérer une division binaire dans une composition de temps ternaire.
Les divisions irrégulières sont déclinées en triolet, duolets, quartolet, quintolet, etc.

Double bémol

Un double bémol (♭♭ ou �) est une altération qui indique que la hauteur de la note doit être baissée de 2 demi-tons.

Double dièse

Un double dièse (♯♯ ou �) est une altération qui indique que la hauteur de la note doit être augmentée de 2 demi-tons.

Duolet

Voir Division irrégulière.

E

Échanger les notes enharmoniques

Fonction qui tente de deviner les bonnes altérations pour la réécriture des notes enharmoniques pour l'ensemble de la partition (voir Altérations) et Échanger les notes enharmoniques / Recalculer les altérations.

Éclater
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Fonctionnalité qui permet à l’utilisateur de diviser (ou éclater) les accords d’un morceau de musique écrits sur une seule portée dans leur notes et voix constitutives. Voir Rassembler et éclater.
Voir aussi Rassembler

Enharmonie

Deux notes qui ont le même son mais pas le même nom sont dites enharmoniques. Par exemple : Fa est enharmonique de Mi dièse ; Sol dièse est enharmonique de La bémol.

F

Fioriture

Une fioriture, aussi appelée note d'agrément ou note d’ornement, se présente comme une petite note placée devant (ou derrière) une note de taille normale. Voir Acciaccatura et Appoggiature. Voir le chapitre Fioriture.

G

Ghost note

En musique, notamment en jazz, une ghost note (note fantôme) ou dead note (note morte) est une note de musique avec un valeur rythmique mais sans hauteur discernable quand elle est jouée. MuseScore Studio supporte les têtes de
notes en croix, en diamant (comme dans MuseScore 3), slash/slash diamant (nouveauté MuseScore Studio) et les ajouts de parenthèses/crochets à une note. Voir le chapitre Têtes de notes.

H

Hampe

Barre verticale dont sont dotées les notes de durée inférieure à la ronde. Celle des croches et notes inférieures portent un ou plusieurs crochets ou ligatures. Voir aussi Ligatures françaises. Voir le chapitre Hampe.

Hauteur des notes existantes

Un des modes de saisie de notes. Voir Hauteur des notes existantes.

I

Indication de mesure

L’indication de mesure (ou chiffrage de mesure) permet de définir les temps que contiennent une mesure à l’aide des chiffres indicateurs de mesure. Le chiffre du haut (numérateur) indique le nombre de temps dans une mesure et le
chiffre du bas (dénominateur) indique la durée de chaque temps (2 pour une blanche, 4 pour une noire, 8 pour une croche, etc.). Voir le chapitre Indication de mesure.

Indication de mesure de précaution

Quelquefois désignée sous les termes d'indication "de rappel" ou "de courtoisie", c’est une indication de mesure qui est disposée à la fin d’un système pour signaler le changement de tempo au départ du prochain système.

Indication de mesure locale

Appellation d’une indication de mesure d’une portée isolée, lorsqu’elle est différente de l’indication de mesure applicable au reste de la partition.
Voir Ajouter une indication de mesure locale.

Indication de métronome

Une façon d'indiquer le tempo. Voir Indications de tempo .

Instrument

Instrument Musescore : voir Configurer votre partition.
2. Instrument réel

Intercalé

Terme utilisé pour décrire deux jeux imbriqués de notes aux hampes inversées. Pour le créer, utiliser la fonction Voix et la palette Propriétés des ligatures.
Voir : Hampes et crochets de note

Interligne de portée

Voir Spatium.

Intervalle

Différence entre la hauteur de deux notes, exprimée en degrés (par exemple : seconde majeure, tierce mineure, quinte parfaite, etc.).
Voir Wikipedia .

L
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Legato

Le legato consiste à jouer les notes de façon liée (sans silence entre elles). C’est une articulation symbolisée par une liaison de phrasé.

Levée

Voir anacrouse.

Ligatures françaises

Ligatures où les hampes ne s'étendent que jusqu'à la première ligature, sans intersection avec les autres. Pour les créer, utiliser le plugin French Beams .

Ligne

Une ligne Musescore est un type d'objet qui peut s'attacher (s'ancrer) à une série d'au moins deux notes (ou silences) continues horizontales ou à une série de notes verticales (accord). Voir le chapitre Autres lignes.

Liaison de phrasé

Ligne courbe placée au-dessus ou au-dessous de deux notes ou davantage pour indiquer qu’elle font partie de la même phrase musicale, à jouer de façon coulée et liée (legato). Voir le chapitre Liaison de phrasé. Une liaison de phase
n'est pas une liaison de prolongation.

Liaison de prolongation

Ligne courbe placée entre deux notes adjacentes de même hauteur pour indiquer qu’il s’agit d’une même note de durée combinée. Voir le chapitre Liaison de prolongation. Une liaison de prolongation n'est pas une liaison de phrasé.

Noire + Liaison de prolongation + Noire = Blanche
Noire + Liaison de prolongation + Croche = Noire pointée
Noire + Liaison de prolongation + Croche + Liaison de prolongation + Double croche = Noire double pointée

Ligature

Les notes de durée inférieure à la noire (croches, double croches, etc.) portent un [crochet] (#flag) ou sont reliées par une ou plusieurs ligatures. Voir le chapitre Ligature. Les ligatures servent à grouper des notes.

Lignes supplémentaires

Ligne(s) qui sont ajoutées pour figurer les notes situées au-dessus ou au-dessous de la portée

Louré

Voir Tenuto

M

Marcato

Le marcato est une articulation symbolisée par un accent circonflexe écrit au-dessus (ou au-dessous) de la tête de note. Il indique que la note doit être jouée à la fois de façon accentuée et détachée (comme un staccato).

Martellato

Voir Accent

Mélisme

Syllabe chantée sur plusieurs notes. Le mélisme est figuré sur la ligne des paroles par une ligne de soulignement continu qui poursuit la syllabe sous les notes concernées.

Mesure

Segment de temps défini par un nombre donné de battements (défini par l'indication de mesure). La division de la musique en mesures d'égales durées permet de fournir des points de référence réguliers et de localiser facilement les
parties d’un morceau de musique.

Mode édition, mode édition de texte

Modes utilisés pour éditer le positionnement et le contenu de textes, au contraire du Mode normal et du Mode de saisie de notes. Voir les chapitres Ajuster directement les éléments et Saisir et éditer du texte : Éditer du texte.

Mode Normal

C’est le mode de fonctionnement de base de MuseScore Studio en dehors des modes saisie de notes ou édition : taper Echap pour y revenir. Dans le mode Normal on peut naviguer à travers la partition, sélectionner et déplacer des
éléments, ajuster leurs propriétés et modifier la hauteur des notes existantes.

Mode de saisie de notes

Mode du programme utilisé pour saisir la notation musicale à la différence des modes Normal et Édition. On y entre en tapant sur la touche N ou en cliquant sur l’icône crayon dans la barre d’outils de saisie des notes. Voir le chapitre
Mode de saisie de notes.

N

Noire

Note dont la durée est le quart de la ronde.

Notation entre portées

Phrase musicale qui s’étend sur deux portées voisines (portée aigüe et portée grave, par exemple).

Pour écrire , voir Notation entre portées.

Pour écrire , voir Comment étendre un accord ou une hampe à travers deux portées  (en anglais).

Notation slash

Forme de notation musicale utilisant des barres obliques ("slashs") comme marques placées sur/au-dessus/en dessous de la portée pour indiquer le rythme d’un accompagnement. Il est souvent trouvé en association avec des
symboles d’accord. Il en existe deux types : (1) la notation slash est composée de slashs à chaque battement — l’interprétation exacte est laissée à l’interprète (voir Remplir avec des slashs, en anglais) ; (2) la notation slash rythmique
indique le rythme précis à utiliser pour l’accompagnement (voir Basculer en notation slash rythmique , en anglais).
Voir aussi Notation d’accord slash.

Note d'agrément ou note d'ornement

Voir Fioriture

Notes enharmoniques

Voir Enharmonie.

Note fantôme ou note morte
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Voir ghost note.

Nuance (symbole de)

Symbole qui indique l’intensité relative d’une note ou d’une phrase musicale à jouer au départ de cette note. Exemples : mf (mezzoforte), p (piano), f (forte), cresc. (crescendo), dim. (diminuendo) ou leurs équivalents graphiques en
forme de "soufflet" (< et >). Voir le chapitre Nuances

O

OS (operating system)

Voir système d'exploitation

Ossia

C’est un passage musical alternatif pouvant être joué à la place de l'original. Le mot vient de l'italien « o sia » signifiant "alternativement" ou "ou celui-là". Voir le chapitre Ossia.

P

Partie

Fonction automatique d'extraction de portée(s) dans MuseScore Studio. Voir Parties. .
2. Ligne mélodique isolée dans une composition musicale polyphonique. MuseScore Studio n’utilise jamais cette définition, mais fournit une fonctionnalité similaire appelée Voix.
3. Instrument(s) ou leurs portées. MuseScore Studio utilise cette définition uniquement dans la fenêtre titre et dans un sous-titre dans les "Propriétés de portée/partie".

Partition

dans les forums de support et le Manuel de MuseScore, le terme partition fait généralement référence à un fichier informatique (de suffixe .mscz) ainsi qu'à sa représentation visuelle sur l'écran de l'ordinateur et à sa lecture audio.
2. Dans quelques chapitres du Manuel MuseScore, partition figure une Partie Musescore particulière.
3. Dans d'autres contextes (par exemple dans le site de partage de partition IMSLP https://imslp.org ), une partition évoque généralement un fichier PDF de la feuille de musique d'une œuvre particulière ou la copie papier d'une
véritable partition.

Pause multimesures

Voir le chapitre Pauses de mesures et pauses multimesures.

Piqué

Voir Staccato

Point d’arrêt

Voir Point d’orgue

Point d’orgue

Symbole placé au-dessus d'une note pour en augmenter la durée (arrêt du tempo). Lorsqu’il est placé au-dessus d'un silence, il est appelé "Point d’arrêt". Voir Point d’orgue.

Portée

Ensemble de lignes et d’interlignes, représentant chacune une hauteur de note, sur lequel la musique est écrite. Avant le 11e siècle, le nombre de lignes d’une portée n’était pas limité.

Portée de type piano

Portées liées par une accolade, utilisées pour noter la musique pour claviers et pour la harpe, avec une portée en clef de Sol et une portée en clef de Fa. Les anglo-saxons utilisent les termes Grand staff (US) ou Great stave (GB). Voir
Portée de type piano.

Précaution

Voir Armure de précaution, Clef de précaution, Indication de mesure de précaution

Propriétés

Panneau Propriétés
2. Paramétrages d'objets individuels dans une partition sur MuseScore Studio, contrairement au Style. Voir le chapitre Modèles and styles.

Q

Quadruple croche

Note dont la durée vaut le 64e de celle de la ronde

Quartolet

Voir Division irrégulière.

Quintolet

Voir Division irrégulière.

R

Rassembler

Fonctionnalité qui permet à l’utilisateur de combiner des voix de portées séparées en une seule. Voir Rassembler et éclater. Cela ressemble, mais pas tout à fait, à la [réduction d’une composition musicale](https://fr.wikipedia.org/wiki/
R%C3%A9duction_(musique)  (Wikipedia).
Voir aussi Éclater

Recalculer les altérations

Voir Échanger les notes enharmoniques

Répétition de mesure (symbole de)
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Un symbole de répétition de mesure ressemble au caractère "pourcentage" avec deux cercles pleins ou à une barre oblique avec un point de chaque côté. Voir le chapitre Répétition de mesure et répétitions multimesures.

Reprise (indication de)

Dans une section répétée de musique, il est habituel que les dernières mesures de la section diffèrent. Les indications de reprise sont utilisées pour indiquer comment la section doit se terminer à chaque fois. On se réfère souvent à ces
indications sous le simple terme barre de reprise. Voir le chapitre alternatives de reprise.

Respiration

Voir Pauses et respirations

Ronde

Note qui dure tout le temps d'une mesure à quatre quatre (4/4).

S

Saisie pas à pas

Mode de saisie de notes par défaut de MuseScore Studio. Voir le chapitre Saisir des notes et des silences.

Saut

Un objet Saut correspond à une notation comme "D.S. al Coda", trouvée dans la palette "Reprises". Voir le chapitre Sauts et repères.

On emploie également ce terme dans le cadre des "sauts de section" et des sauts de pages qui concernent la mise en page de la partition.

Section

Dans MuseScore Studio, zone de la partition comprise entre deux sauts de section ; également utilisé pour la partie du début de la partition jusqu’au premier saut de section ainsi que pour la partie qui suit le dernier saut de section
jusqu’à la fin de la partition.

Segno

 Symbole de navigation. Voir le chapitre Sauts et repères.

Séparateur de système

Systèmes séparés sur la même page. Peut être activé dans la partition via Format → Style → Système, voir le chapitre Mise en page. Également disponible dans la palette principale : voir le chapitre Autres symboles.

Sextolet

Voir Divisions irrégulières.

SF2

Format d’instrument virtuel développé par E-mu Systems et Creative Labs. Voir SoundFonts.

SF3

Format d’instrument virtuel inventé par Werner Schweer, développeur de Musescore (source ). Ce format supporte la compression des échantillons sonores. Voir SoundFonts.

Silence

Symbole musical qui indique un silence. Voir le chapitre Saisir des notes et des silences.

Slash (accord, tête de note)

Indique la façon de jouer un accord. Voir Que signifie la notation d’accord X/Y ?  (lien externe).

SND (Single note dynamics)

Utilisé dans les notes en langue anglaise de Musescore, ce sigle signifie "Nuance pour note seule".

Solmisation

Ce terme désigne l'emploi de syllabes pour nommer et chanter les sept notes de la gamme diatonique dans un objectif pédagogique. Le solfège classique, employé en France, repose sur les noms Do, Ré, Mi, Fa, Sol, La, Si. On
l'évoque quelques fois sous le terme de "Do fixe" (ou solmisation absolue) car le Do (donc les autres notes) est toujours affiché, pour clef donnée, à la même position sur une portée. D'autres appellations existent, anglo-saxonnes (A, B,
C, D, E, F, G) ou allemandes (A , H, C, D, E, F, G). Il existe également un système de "Do mobile" (ou solmisation relative), utilisé pour la formation musicale dans certains pays, où la position du Do varie en fonction de la tonalité
employée. Ce terme est employé par MuseScore pour certaines modalités d'écriture des têtes de notes. Voir aussi : https://www.thecanadianencyclopedia.ca/fr/article/solmisation  et https://musescore.org/fr/manuel/formes-de-tetes-
de-notes .

SoundFont

Instrument virtuel supporté par MuseScore Studio. Une SoundFont est un type spécial de fichier (extension .sf2, or .sf3 si compressé) qui contient des échantillons sonores (samples) d’un ou plusieurs instruments. Dans les faits, c’est
un synthétiseur virtuel qui agit comme une source sonore pour des fichiers MIDI. MuseScore Studio est fourni avec sa propre soundfont native : MS Basic. Voir le chapitre SoundFont.

sp.

Voir Spatium.

Spatium

Unité de mesure. Voir Notions de mise en page.

Staccato

Le staccato, ou piqué, est une articulation symbolisée par un point écrit au-dessus (ou au-dessous) de la tête de note. Il indique que les notes doivent être jouées de la façon détachée afin de laisser une suspension avant la note
suivante.

Style
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Le profil qui contient les paramétrages dans MuseScore Studio, à distinguer des Propriétés. Voir le chapitre Modèles et styles.

Système

Série de portées lues simultanément dans une partition. Voir le chapitre Notions de mise en page.
Voir aussi : Système d'exploitation.

Système d'exploitation

En anglais : operating system (OS). Programmation logicielle qui contrôle et dirige les dispositifs informatiques et les autres logiciels d’un ordinateur. Les plus populaires sont Microsoft Windows, macOS, et GNU/Linux.

T

Tempo

Vitesse d'exécution d'une œuvre (ou plus exactement la fréquence de la pulsation rythmique).
Son unité de mesure est le battement par minute (BPM). Voir aussi : indication de métronome.

Tenuto

Le tenuto, également appelé louré, est une articulation symbolisée par un tiret écrit au-dessous (ou au-dessous) de la tête de note. Elle indique que la note doit être jouée de façon plus soutenue mais détachée (comme un staccato).

Tête de note partagée

 Tête de note simple avec deux hampes — une vers le haut, l’autre vers le bas. Particulièrement commune en musique pour guitare, par exemple. Voir Têtes de notes

Texte

Un objet texte Musescore contient des caractères individuels qui peuvent être saisis et supprimés en utilisant un clavier d'ordinateur. Voir le chapitre Saisir et éditer du texte.

Tonalité écrite

Les instruments transpositeurs (comme la clarinette, le cor français, la trompette, etc.) ont des partitions écrites avec des hauteurs de notes (et avec une armure) qui sont différentes des sons réellement produits par l’instrument. La
hauteur notée sur la partition est appelée tonalité écrite alors que la hauteur jouée est appelée tonalité réelle. Voir Instrument transpositeur sur Wikipédia .

Tonalité réelle

Le son ou la hauteur réelle d’une note — contrairement à la tonalité écrite. Voir Travailler avec des instruments transpositeurs.
2. Un mode d’aperçu de partition dans MuseScore Studio. Voir Affichage de la tonalité réelle dans la barre de statut.
3. La fréquence du "La 440" (ou "La3" en notation française ou "A4" en notation anglo-saxonne), soit 440 Hz.

Transposition

Action de modifier la hauteur d’une ou plusieurs notes vers l’aigu ou vers le grave à l’aide d‘un intervalle constant. Voir le chapitre Transposition. Il peut exister plusieurs raisons pour transposer un morceau, par exemple :
1. Le ton est trop haut ou trop bas pour un chanteur. Dans ce cas, l’ensemble de l’orchestre devra être transposé de la même façon — ce qui est facile avec MuseScore Studio.
2. La partie est écrite pour un instrument particulier mais doit être joué par un autre.
3. La partition est écrite pour un orchestre et vous voulez écouter ce que cela donnerait avec des instruments individuels. Cela nécessite de modifier la partie d’un instrument transpositeur dans la tonalité réelle.
4. Une tonalité plus sombre ou plus brillante est souhaitée.

Trémolo

Répétition rapide d’une note/d’un accord ou alternance rapide entre deux notes/accords. Voir Trémolo.

Triolet

Voir Division irrégulière.

Triple croche

Une note qui représente le seizième de la durée d’une ronde.

V

Vélocité

Propriété d'objets internes à MuseScore Studio qui contrôle à quel volume la note est jouée, de 0 (silence) à 127 (maximum). La propriété Vélocité des notes est éditée dans le panneau Propriétés : onglet Lecture, voir le chapitre
Panneau des propriétés.

Voix

Dans MuseScore Studio, la voix est une fonctionnalité logicielle. On peut utiliser jusqu’à 4 voix par portée, voir Travailler avec plusieurs voix. Voir aussi portée.
2. Le terme musical "voix" fait référence à la ligne musicale ou à la partie qui peut avoir son propre rythme. MuseScore Studio n’a pas de fonctionnalité pour implémenter cette idée de façon exacte. Si la fonctionnalité voix ne répond pas
à vos besoins, essayez de travailler des instruments séparés à la place.

Liens externes

Glossaire théorique et technique de la musique occidentale
Présentation des durées en musique : figures de notes
Présentation des durées en musique : figures de silences

Table des matières

Éditer le manuel

Recommandations pour l’écriture d’articles

Structure – Principes généraux

Titres

Contenu

Utiliser des médias non écrits

Faire des liens vers d’autres pages

Syntaxe

Laisser un message de révision

Présentation de MuseScore 4

Téléchargement et installation

Windows

macOS

Linux

Créez votre première partition

Vue d'ensemble
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Créer rapidement une nouvelle partition

Saisir des informations sur la partition

Saisir des notes et des silences

Ajouter des objets à partir des palettes

Écouter le résultat

Réaliser des ajustements dans le panneau Propriétés

Insérer et supprimer des mesures

Enregistrer la partition

Exporter la partition

Nouvelles fonctionnalités de MuseScore Studio

Nouvelle interface utilisateur

Instruments et parties

Inspecteur

Nouveau support de lecture et d’instruments virtuels

Améliorations d’écriture

Enregistrement en ligne

Autres changements

Affichage et navigation

Accessibilité

Lecteurs d’écran

Accès clavier

Tutoriels vidéo

L'interface utilisateur

Barre de Menu

Onglet accueil

Onglet Partition

Onglet Publier

Menus contextuels

Naviguer dans votre partition

Défilement

Navigation entre éléments

Navigateur

Timeline

Affichages

Zoom

Chercher / Aller à

Timeline

Vue d’ensemble

Méta-éléments

Actions de base

Faire défiler la timeline

Actions sur les étiquettes

Zoomer

Braille

Vue d’ensemble

Voir le braille

Écrire en braille

Bases

Configurer votre partition

Vue d'ensemble

Instruments

Informations complémentaires sur la partition

Changer les instruments après la création de la partition

Saisir des notes et des silences

Vue d'ensemble

Saisir des notes

Saisir des accords

Saisir des silences

Saisir des altérations

Ajouter des liaisons de prolongation

Voir aussi
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Travailler avec plusieurs voix

Vue d'ensemble

Saisir des notes et des silences dans différentes voix

Éditer les notes et silences dans plusieurs voix

Voir aussi

Méthodes alternatives de saisie des notes

Accéder à des méthodes alternatives de saisie de notes

Saisir uniquement le rythme

Saisir uniquement la hauteur des notes

Saisir les notes en temps réel

Insérer des notes

Ajouter et supprimer des mesures

Ajouter des mesures

Supprimer des mesures

Voir aussi

Sélectionner des éléments

Sélectionner un seul élément

Créer une liste de sélections

Créer une Sélection groupée

Exclure des éléments d’une Sélection groupée

Éditer des notes et des silences

Vue d’ensemble

Effectuer des modifications dans le mode de saisie des notes

Effectuer des modifications dans le mode normal

Voir aussi

Copier et coller

Accéder aux commandes

Copier une Sélection groupée

Copier un élément individuel ou une Liste de sélections

Déplacer des éléments

Échanger une sélection avec le presse-papier

Répéter une sélection

Copier une Sélection groupée vers plusieurs portées

Coller avec une demi ou une double durée

Dupliquer des éléments individuels

Voir aussi

Utiliser les palettes

Vue d’ensemble

Accéder au panneau Palettes

Ajouter des objets palette dans la partition

Développer et réduire les palettes

Effectuer une recherche et naviguer dans les palettes

Accéder à davantage d’objets palette

Ajouter d’autres palettes

Voir aussi

Panneau des propriétés

Vue d'ensemble

Accéder au panneau Propriétés

Propriétés pour la partition

Propriétés pour les objets

Propriétés pour les caractères au sein des objets Texte

Sauvegarder et restaurer les paramètres par défaut

Ajuster directement les éléments

Modifier la position des éléments

Modifier la forme des éléments

Travailler avec les lignes

Voir aussi

Parties

Ouvrir une partie

Fermer une partie

Créer des parties personnalisées
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Appliquer des styles aux parties

Renommer, dupliquer et supprimer des parties

Exporter et imprimer des parties

Liens externes

Raccourcis clavier par défaut

Navigation

Saisie des notes

Sélection

Édition

Texte

Autres éléments de partition

Paramétrage et mise en forme de la partition

Opérations sur les fichiers

Interface utilisateur

Notation : Instruments, portées et systèmes

Travailler avec les instruments

Vue d’ensemble

Ajouter et ranger les instruments

Paramétrer les instruments

Ajouter et ranger les instruments

Ajouter et configurer des portées

Masquer une portée tout en conservant sa lecture

Supprimer des portées

N'afficher les portées que si nécessaire

Vue d'ensemble

Masquer une portée vide dans un système

Masquer des mesures vides

Rassembler et éclater

Rassembler

Éclater

Changer d'instrument en cours de partition

Ajouter un changement d’instrument

Travailler avec un changement d’instrument

Changer le type de portée

Vue d'ensemble

Ajouter un changement de style de portée

Régler les propriétés de la portée

Propriétés des Portées / Parties

Vue d’ensemble

Propriétés des portées

Propriétés avancées de style

Propriétés des parties

Crochets de systèmes

Vue d'ensemble

Ajouter un crochet

Éditer les crochets

Supprimer un crochet

Personnaliser l’apparence du crochet

Notation : Rythme, temps et mesures

Indications de mesure

Vue d’ensemble

Fixer l’indication de mesure initiale de votre partition

Ajouter un changement d’indication de mesure dans votre partition

Supprimer une indication de mesure

Paramétrez la visibilité des indications de mesure

Créer un indicateur de mesure personnalisé

Ajouter une indication de mesure locale dans une seule portéeh4>

Redimensionner une indication de mesure

Propriétés des indications de mesure

Style d’indications de mesure
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Hampes et crochets de notes

Direction de hampe

Modifier la longueur de hampe

Créer des notes sans hampe

Propriétés des hampes et crochets de notes

Styles des hampes et crochets de notes

Voir aussi

Ligatures

Paramétrer à quelles notes attribuer des ligatures

Paramétrer l’apparence des ligatures

Propriétés des ligatures

Style des ligatures

Regrouper les rythmes

Vue d’ensemble

Regrouper les rythmes

Voir aussi

Divisions irrégulières

Créer une division irrégulière

Modifier l’affichage des divisions irrégulières

Propriétés des divisions irrégulières

Style des divisions irrégulières

Barres de mesure

Vue d'ensemble

Modifier ou ajouter des barres de mesure

Modifier la longueur de la barre de mesure

Propriétés des barres de mesure

Style des barres de mesure

Voir aussi

Numérotation des mesures

Afficher et masquer la numérotation des mesures

Modifier la séquence de numérotation des mesures

Ajuster la position des numéros de mesure

Propriétés des numéros de mesure

Style de numérotation des mesures

Voir aussi

Pauses de mesures et pauses multimesures

Pauses de mesure

Pauses multimesures

Voir aussi

Anacrouse et notation non mesurée

Créer une anacrouse

Créer une notation non mesurée

Voir aussi

Propriétés de la mesure

Ouvrir et utiliser la fenêtre de dialogue

Portées

Durée de la mesure

Autre

Voir aussi

Notation : Hauteur de note et tonalité

Clefs

Aperçu

Définition de la clef initiale d'une portée

Ajouter ou modifier une clef

Supprimer

Contrôler la visibilité des clefs

Clefs et transposition

Propriétés des clefs

Style des clefs

Armures

Aperçu
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Définir l'armure initiale de la partition

Ajouter un changement d'armure à la partition

Ajouter une armure locale à une seule portée

Sélectionner une armure pour une seule portée

Remplacer une armure existante

Supprimer une armure

Contrôler la visibilité des armures

Armures et instruments transpositeurs

Créer une armure personnalisée

Propriétés des armures

Style des armures

Voir également

Transposition

Aperçu

Transposer avec des raccourcis clavier

Utiliser la fenêtre de dialogue de transposition

Travailler avec des instruments transpositeurs

Lignes d'octave

Vue d'ensemble

Ajouter une ligne d'octave à la partition

Propriétés des lignes d'octave

Style des lignes d'octave

Têtes de note

Vue d'ensemble

Modifier la forme des têtes de note

Ajouter des informations de hauteur aux notes

Modifier la direction d'une tête de note

Propriétés des têtes de note

Style et police des têtes de note

Partager des têtes de note entre les voix

Voir aussi

Liens externes

Ambitus

Ajouter un ambitus à votre partition

Modifier l'étendue d'un ambitus

Propriétés de l'ambitus

Recalculer les altérations

Modifier manuellement l'écriture enharmonique de certaines notes

Modifier automatiquement toutes les notes d'une sélection

Notation : Symboles d’expression

Articulations

Aperçu

Ajouter des articulations dans votre partition

Lecture des articulations

Propriétés des articulations

Style des articulations

Nuances

Ajouter une nuance à votre partition

Changer l'apparence des indicateurs de nuance

Modifier la façon de jouer les nuances

Propriétés des indicateurs de nuance

Style des indicateurs de nuance

Marques de crescendo et diminuendo

Types de marques

Ajouter des marques de crescendo/diminuendo dans la partition

Modifier l’apparence des marques de crescendo/diminuendo

Modifier la lecture des crescendos/diminuendos

Propriétés des marques de crescendo/diminuendo

Style des marques de crescendo/diminuendo

Liaisons de phrasé

Aperçu
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Ajouter une liaison de phrasé à votre partition

Créer des liaisons de phrasé multi-voix et inter-portées

Modifier l’apparence des liaisons de phrasé

Propriétés des liaisons de phrasé

Style des liaisons de phrasé

Respirations et pauses

Aperçu

Types de symboles de pauses

Ajouter un symbole de pause à la partition

Modifier la lecture des symboles de pause

Propriétés des symboles de pause

Pause style

Ornements

Aperçu

Ajouter un ornement à la partition

Ajouter des altérations aux ornements

Propriétés des ornements

Style des ornements

Arpèges et glissandos

Aperçu

Symboles d’arpège

Symboles de glissando

Symboles de Bend

Fioritures

Aperçu

Types de fioritures

Ajouter une fioriture à votre partition

Fioritures multiples

Éditer les fioritures

Style des fioritures

Trémolos et roulements

Types de trémolos et roulements

Ajouter un trémolo à une note seule

Ajouter un trémolo entre des notes/accords

Modifier l’apparence des symboles de trémolo

Autres lignes

Vue d’ensemble

Ajouter une ligne à la partition

Ajuster une ligne

Types de lignes

Propriétés des lignes

Style des lignes

Autres symboles

Vue d'ensemble

La palette Symboles

Ajouter des symboles à votre partition

Notation : Répétitions

Barres de répétition

Aperçu

Ajouter des barres de répétition à votre partition

Modifier la lecture des barres de répétition

Modifier l'apparence des barres de répétition

Propriétés des barres de répétitions

Style des barres de répétition

Alternatives de reprise

Aperçu

Ajouter une alternative de reprise à votre partition

Modifier l'apparence des alternatives de reprise

Modifier la lecture des alternatives de reprises

Propriétés d'une alternative de reprise

Style des alternatives de reprise
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Sauts et reprises

Aperçu

Types d'objets Sauts et Reprises

Ajouter un Saut ou une Reprise à votre partition

Modifier l'apparence des Sauts et Reprises

Modifier la lecture des Sauts et Reprises

Propriétés des sauts et Reprises

Style des Sauts et Reprises

Répétition de mesure et répétitions multimesures

Aperçu

Ajouter une répétition de mesure ou une répétition multimesures à votre partition

Propriétés des répétitions de mesure

Style des répétitions de mesure

Lecture des répétitions

Activer et désactiver la lecture des répétitions

Notation spécialisée : Clavier

Pédale

Types de marques de pédale

Ajouter une marque de pédale à la partition

Créer des changements de pédales

Propriétés de pédale

Style de pédale

Notation entre portées

Créer une notation entre portées

Changer l'apparence de la notation entre portées

Notation pour accordéon [VIDE]

Ajouter des symboles accordéon à votre partition

Notation spécialisée : Guitare

Diagrammes d'accord de guitare

Aperçu

Ajouter un diagramme d'accord à votre partition

Créer un diagramme d'accord personnalisé

Apparence du diagramme d'accord

Propriétés du diagramme d'accord

Style de diagramme d'accord

Voir également

Techniques de guitare

Ajouter un symbole de Bend à votre partition

Ajouter un symbole de Barre de trémolo à votre partition

Ajouter un Slide de guitare (Glissando) à votre partition

Ajouter une Ligne de capodastre (en V4.0.2) ou Ligne de barré (en V4.1) à votre partition

Ajouter des symboles de "hammer-on" (liaison ascendante) et de "pull-off" (liaison descendante) à votre partition

Notation des harmoniques

Notation du doigté de la guitare

Créer une portée de tablature

Aperçu

Types de portées de tablature

Ajouter une tablature à votre partition

Créer une combinaison de portées standard et tablature

Saisir et éditer la notation de tablature

Saisir avec le clavier de l'ordinateur

Saisir avec la souris de l'ordinateur

Sélectionner la durée de la note

Notation de tablature ancienne

Modifier la notation de la tablature

Personnaliser une portée de tablature

Modifier le réglage d'accord

Ajouter ou supprimer des cordes

Marquer la corde non frettée "à vide"

Changer le nombre de frettes de l'instrument
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Modifier le type de portée de tablature

Personnaliser l'apparence de la tablature

Appliquer un capodastre

Aperçu

Appliquer un capodastre à votre partition

Ajuster les paramètres du capodastre

Changer le réglage du capodastre en cours de partition

Bends de guitare

Ajouter des bends à votre partition

Remarques générales sur les bends dans MusScore

Appliquer un bend

Modifier des bends

Ajouter des bends à des accords

Personnaliser le style des bends

Réglages alternatifs d'accord des cordes

Appliquer des instructions d'accord des cordes

Spécifier les réglages d'accord de cordes

Les réglages d'accord alternatifs affectent les positions de frette

Lire les hauteurs transposées sur la portée standard

Notation spécialisée : Harpe

Vue d'ensemble

Ajouter un diagramme de pédales de harpe à votre partition

Lire des diagrammes de pédales de harpe

Notation spécialisée : Percussions

Saisie et modification de la notation des percussions

Vue d’ensemble

Saisir des notes et des silences dans des portées de percussions

Personnalisation du set de batterie

Introduction

Personnaliser la définition du set de batterie [PROJET]

Sauvegarder et charger les définitions du set de batterie [PROJET]

Autres notations des percussions

Coups doubles

Lignes de pédale

Roulements

Sticking (doigté de batterie)

Notation alternative

Notation pour musique ancienne et Mensurstrich

Ajouter une indication mesurée à votre partition

Travailler avec une musique non mesurée

Travailler avec une notation Mensurstrich

Afficher les valeurs de notes dépassant les frontières de mesure

Notation avec des Slashs

Remplir une sélection avec des slashs rythmiques

Créer une notation rythmique avec slashs

Types de portées personnalisées

Vue d'ensemble

Personnaliser l'apparence des lignes de portée

Personnaliser l'apparence d'éléments générés

Personnaliser l'apparence des notes

Modifier le type de portée en cours de partition

Liens externes

Texte

Saisir et éditer du texte

Vue d’ensemble

Types de textes

Ajouter du texte à une partition

Supprimer des objets texte d'une partition

Éditer le contenu d'un objet Texte

Mettre en forme du texte
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Vue d’ensemble

Modifier la mise en forme des caractères

Modifier la mise en forme d'un objet texte

Modifier les valeurs dans un style

Texte de portée, texte de système et texte d'expression

Vue d’ensemble

Ajouter un texte de portée à votre partition

Ajouter un texte d’expression à votre partition

Ajouter un texte de système à votre partition

Répéter un texte de système sur les autres portées

Propriétés

Style

Indications de tempo

Vue d’ensemble

Ajouter des indications de tempo à votre partition

Modifier l’apparence

Modifier la lecture

Répéter l’indication de tempo sur les autres portées

Propriétés des indications de tempo

Style de tempo

Liens externes

Paroles

Vue d’ensemble

Ajouter des paroles à votre partition

Éditer des paroles existantes

Supprimer des paroles

Saisir les paroles au-dessus de la portée

Modifier la numérotation des couplets

Copier des paroles

Propriétés des paroles

Style des paroles

Doigtés

Types de doigtés

Ajouter un doigté à votre partition

Ajuster la position du doigté

Modifier l’apparence des éléments de doigté

Propriétés des éléments de doigté

Style des éléments de doigté

Voir aussi

Symboles d'accord

Vue d’ensemble

Ajouter un symbole d’accord dans votre partition

Vue d'ensemble de l'apparence et de la fonction

Aligner les symboles d’accord

Transposer les symboles d’accord

Modifier la notation des symboles d’accord

Modifier l’apparence

Modifier la lecture des symboles d’accord

Propriétés des symboles d’accord

Style des symboles d’accord

Liens externes

Basse chiffrée

Vue d’ensemble

Ajouter une indication de basse figurée à votre partition

Propriétés des indications de basse chiffrée

Style des indications de basse chiffrée

Raccourcis clavier de basse chiffrée

Repères

Vue d’ensemble

Ajouter un repère à votre partition

Utiliser des numéros de mesure dans les repères
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Remettre les repères dans l’ordre

Rechercher des repères

Répéter les repères dans les autres portées

Modifier l’apparence des repères

Propriétés des repères

Style des repères

Liens externes

En-tête et pied de page

Vue d’ensemble

Ajouter un en-tête ou un pied de page dans votre partition

Utiliser des métadonnées

Modifier la façon dont les en-têtes et pieds de pages sont affichés

Propriétés des en-têtes et pieds de pages

Style des en-têtes et pieds de pages

Blocs de texte

Vue d’ensemble

Ajouter un bloc de texte à une partition

Modifier l’apparence des blocs de texte

Propriétés du bloc de texte

Style de bloc de texte

Voir aussi

Mise en page

Notions de mise en page

Aperçu

Définitions

Positionner les éléments

Aperçu

Position par défaut

Auto-placement

Ajustement manuel

Alignement manuel

Taille et espacement de la partition

Aperçu

Paramètres de page

Paramètres de style

Propriétés de portée/partie

Espacement horizontal des systèmes

Aperçu

Fonctionnalités

Utilisation pratique

Espacement vertical des pages

Fonctionnalités

Utilisation pratique

Utiliser des cadres pour ajouter du contenu

Vue d’ensemble

Usages des cadres

Ajouter des cadres avant, entre ou après un système

Ajouter des cadres entre des mesures

Voir aussi

Utiliser des images

Ajouter des images

Propriétés d'image

Voir aussi

Utiliser des sections pour séparer mouvements ou chansons

Vue d’ensemble

Ajouter un saut de section

Propriétés de saut de section

Son et lecture sonore de la partition

Commandes de lecture

Vue d'ensemble
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Commandes de lecture

Autres commandes

Liens externes

Mélangeur

Aperçu

Ouvrir le mélangeur

Contrôles du mélangeur

Son

FX Audio

Aux sends

Aux channels

Voir également

SoundFonts

Aperçu

Installer une SoundFont

Utiliser les sons d'une SoundFont

Éditer des SoundFonts

Désinstaller une SoundFont

Informations sur le lecteur Zerberus et les SFZ

Voir également

Installer les sons Muse Sounds

Installer les Muse Sounds via Muse Hub

Utiliser les Muse Sounds dans MuseScore

Sons disponibles dans Muse Sounds

Lien externe

Lecture avec capodastre

Aperçu

Ajouter une indication de capodastre à votre partition

Voir également

Lecture du swing

Aperçu

Ajouter une indication de jeu Swing ou Linéaire à votre partition

Modifier la lecture du swing

Working with MIDI [EN, PROJET]

Travailler avec les plugins VST et VSTi

Introduction aux VST

Installer des VST

Activer, désactiver, supprimer et remplacer les plugins VST

Gestion des fichiers

Ouvrir et enregistrer les partitions

Vue d’ensemble

Ouvrir une partition

Formats d’importation de fichiers

Enregistrer une partition

Lien externe

Exportation de fichiers

Vue d’ensemble

Exporter votre partition

Formats de fichier

MIDI import [EN, PROJET]

Travailler avec des fichiers MusicXML

Vue d'ensemble

Ouvrir un fichier MusicXML

Nettoyer une partition importée

Préparer l'export d'une partition

Backup and recovered files [EN, PROJET]

Propriétés des partitions

Vue d’ensemble

Modifier les propriétés de la partition

Ajouter de nouvelles propriétés
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Accéder aux propriétés de votre partition

Score comparison [EN, PROJET]

Publier sur musescore.com

Vue d’ensemble

Créer un compte MuseScore

Sauvegarder uniquement sur Musescore.comh4>

Publier les partitions enregistrées localement

Visibilité dans le gestionnaire de partitions

Gérer la création de mp3 pendant la sauvegarde

Partager sur Audio.com

Vue d’ensemble

Pour partager un fichier audio à partir de votre partition sur Audio.com

Personnalisation

Langue

Vue d'ensemble

Changer de langue

Mettre à jour les traductions

Voir aussi

Apparence

Vue d'ensemble

Thème et couleurs

Police de caractères

Barres d'outils et fenêtres

Espace de travail

Barres d’outils

Fenêtres et panneaux

Modèles et styles

Vue d’ensemble

Modèles

Fichiers de Style

Palettes

Aperçu

Ajouter des palettes

Masquer et supprimer des palettes

Changer l’ordre des palettes

Personnaliser le contenu des palettes

Sauvegarder et charger des palettes

Menu des palettes

Propriétés des palettes

Voir aussi

Espaces de travail

Vue d’ensemble

Créer un nouvel espace de travail

Supprimer un espace de travail

Changer d’espace de travail

Raccourcis clavier

Vue d'ensemble

Définir un raccourci

Réinitialiser et effacer les raccourcis

Importer et exporter des raccourcis

Préférences [PROJET]

Général

Apparence

Canevas

Saisie de notes

Commandes d'un périphérique MIDI

Partition

Entrée/Sortie

Importation

Raccourcis

Mise à jour
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Avancé

Plugins

Vue d’ensemble

Organiser les plugins

Démarrer un plugin [PROJET]

Plugins préinstallés

Créer un plugin

Voir aussi

Support

Getting help [EN, PROJET]

Overview

Learn

Forums

Issue tracker

GitHub

Mastering MuseScore

Revert to factory settings [EN, PROJET]

Overview

Reverting to factory settings from the menu

Reverting to factory settings from the command line

Troubleshooting [EN, PROJET]

Installation issues

Score issues

Display issues

Sound issues

Printing issues

Known incompatibilities [EN, PROJET]

Annexes

Utilisation de la ligne de commande

Known incompatibilities [EN, VIDE]

Tous les raccourcis clavier

Schéma de clavier

Navigation

Saisie des notes

Sélection

Édition

Texte

Autres éléments de partition

Paramétrage et mise en forme de la partition

Opérations sur les fichiers

Interface utilisateur (UI)

Mise à niveau depuis MuseScore 3.x

Vue d'ensemble

Raccourcis clavier

Autres modifications

Fonctionnalités manquantes

Glossaire

Table des matières
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